


Construction Estimating Using Excel



This page intentionally left blank 



Construction Estimating Using Excel
SECOND EDITION

Steven J. Peterson
MBA, PE

Prentice Hall
Boston Columbus Indianapolis New York San Francisco Upper Saddle River

Amsterdam Cape Town Dubai London Madrid Milan Munich Paris Montreal Toronto
Delhi Mexico City Sao Paulo Sydney Hong Kong Seoul Singapore Taipei Tokyo



Editor in Chief: Vernon Anthony
Acquisitions Editor: David Ploskonka
Editorial Assistant: Nancy Kesterson
Director of Marketing: David Gesell
Marketing Manager: Derril Trakalo
Senior Marketing Coordinator:

Alicia Wozniak
Marketing Assistant: Les Roberts
Project Manager: Holly Shufeldt

Senior Art Director: Jayne Conte
Cover Designer: Karen Salzbach
Cover Art: Shutterstock
Full-Service Project Management and 

Composition: Mohinder Singh/Aptara®, Inc.
Printer/Binder: Edwards Brothers
Cover Printer: Lehigh-Phoenix

Color/Hagerstown
Text Font: Minion

Credits and acknowledgments borrowed from other sources and reproduced, with permission, in
this textbook appear on appropriate page within the text.

Microsoft® and Windows® are registered trademarks of the Microsoft Corporation in the U.S.A.
and other countries. Screen shots and icons reprinted with permission from the Microsoft
Corporation. This book is not sponsored or endorsed by or affiliated with the Microsoft
Corporation.

Copyright © 2012, 2007. Pearson Education, Inc., publishing as Prentice Hall, Upper Saddle
River, New Jersey and Columbus, Ohio. All rights reserved. Manufactured in the United States of
America. This publication is protected by Copyright, and permission should be obtained from the
publisher prior to any prohibited reproduction, storage in a retrieval system, or transmission in any
form or by any means, electronic, mechanical, photocopying, recording, or likewise. To obtain
permission(s) to use material from this work, please submit a written request to Pearson Education,
Inc., Permissions Department, One Lake Street, Upper Saddle River, New Jersey 07458.

Many of the designations by manufacturers and seller to distinguish their products are claimed as
trademarks. Where those designations appear in this book, and the publisher was aware of a
trademark claim, the designations have been printed in initial caps or all caps.

Library of Congress Cataloging-in-Publication Data

Peterson, Steven J.
Construction estimating using excel / Steven J. Peterson. —2nd ed.

p. cm.
Includes bibliographical references and index.
ISBN-13: 978-0-13-800719-5
ISBN-10: 0-13-800719-5
1. Building—Estimates—Data processing. 2. Microsoft Excel (Computer file) I. Title.
TH437.P357 2012
692'.50285536—dc22

2010043121

10 9 8 7 6 5 4 3 2 1

ISBN 10: 0-13-800719-5
ISBN 13: 978-0-13-800719-5



DEDICATION

This book is dedicated to Bill Thiede, 
who taught me how to estimate.
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By working hard during the buyout process, I was able
to get the project back on budget. I did this by finding local
subcontractors and suppliers for the items I had bid myself
who would do the work for less than I had budgeted. In the
end, we made a fair profit on the job, but that does not
make up for the money we left on the table because of my
error.

The job of an estimator is to forecast as accurately as
possible the likely cost of a construction project, as well as
the required amounts of materials, labor, and equipment
necessary to complete the work. Because of the high degree
of uncertainty in estimating these items, estimating is more
of an art than a science.

There are three key pillars that support the success of an
estimator. The first is an understanding of the construction
process—how things are built and how the pieces are put to-
gether. The second is an understanding of the fundamental
principles of estimating. Estimates that are not based on
these fundamental principles are nothing more than wild
guesses. The third pillar is experience. For a person to be-
come a good estimator, it is required that he or she develop
good judgment on how to apply estimating principles. Rita
Mae Brown said, “Good judgment comes from experience,
and often experience comes from bad judgment.”1 The pillar
of experience can only be acquired through practice.

The purposes of this book are to (1) give beginning es-
timators an understanding of the fundamental principles of
estimating, (2) provide beginning estimators with practical
estimating experience, (3) give beginning estimators a basic
understanding of how to use spreadsheets, such as
Microsoft Excel2, to increase their estimating productivity
and reduce errors, and (4) give experienced estimators an-
other view on estimating and a chance to improve their
estimating skills.

The second hand of the clock swept rapidly toward
the 12, signifying that it was 15 minutes to 1.
Fifteen minutes until bid closing, when the bid I

was working on was due. I had 10 minutes until our secretary
would call for the final price, giving her just enough time to
write the number on the bid forms, seal the bid, and turn it
in. The bid had been tallied and was ready to go, with the
exception of one blank line. The words “Asphalt Paving”
along with the blank space to the right glared at me. I had yet
to receive a number from my asphalt contractor, who had
promised me he would get me a bid. I called his phone num-
ber. No answer! There was only one thing left for me to do. I
had to do an asphalt takeoff myself, and I had only 8 minutes
left. Quickly I grabbed my scale, turned it to match the scale
at the bottom of the drawing (1 8� � 1�), and began to de-
termine the quantity of asphalt needed for the parking lot.
Cutting corners where I could, scribbling numbers on a
piece of scratch paper, and punching the numbers on my
calculator, I arrived at the square footage of the asphalt. It
wasn’t exact, but it was close. I then multiplied the square
footage by the estimated cost per square foot for the asphalt.
The phone rang as I added my estimated cost for the asphalt
to the bid. It was our secretary calling for the bid. I gave her
the number, and she read it back to me.

I relaxed for the next 20 minutes, waiting for our secre-
tary to call back with the bid results. The phone rang again
and it was our secretary. We had won the bid. As I was enjoy-
ing the thrill of victory, I glanced at the plans and the words
“Warning: Half Size Drawings” jumped off the page. The
thrill of victory turned into a large lump in my stomach as I
realized why I had won the bid. I had forgotten to double all
my measurements as I measured the asphalt, so I had only
25% of the money I needed to purchase the asphalt for the
project. Quickly, and carefully this time, I took off the as-
phalt again. Indeed, I only had a quarter of the asphalt I
needed, and it would take all the profit in the job and then
some to pay for it.

>

PREFACE

1Rita Mae Brown, as posted on http://www.1famousquote.com/b/
ritamaebrown.htm; accessed October 7, 2003.
2Microsoft® Excel is a trademark of the Microsoft Corporation.

http://www.1famousquote.com/b/ritamaebrown.htm
http://www.1famousquote.com/b/ritamaebrown.htm


This book is divided into five sections. The first section
introduces the reader to estimating. The second section in-
troduces the quantity takeoff and teaches the reader how to
determine the quantity of materials needed to complete the
project. The third section shows how to put costs to the esti-
mate. The fourth section shows how to finalize the bid, in-
corporate the estimate into the schedule, and buy out the
project, and discusses bidding ethics. The fifth section
teaches how to tap into the power of computer spread-
sheets—specifically Microsoft® Excel—and demonstrates
how spreadsheets can be used to automate estimating func-
tions. To provide practice in estimating, three drawing sets
are included—a residential garage, a residence, and a retail
building.

I hope you will take the time to carefully read each
chapter, work the problems at the end of each chapter, and
prepare estimates for the projects at the end of the book.
Doing this will help you begin to gain the experience needed
to be a successful estimator.

I would like to thank the following people for providing
reviews of the manuscript: Barry M. Eager (Arizona State
University), Roger Killingsworth (Auburn University),
Huanqing Lu (East Carolina University), and Ihab M. H.
Saad, Ph.D. (East Carolina University).

NEW TO THIS EDITION
The following is a list of key changes that have been made to
this edition.

� The Excel contents have been updated to Excel 2007 and
2010.

� The equations have been stacked to make them easier to
read.

� A Fifth type of materials (quantity from quantity) has
been added. The types of materials now includes
counted items, linear components, sheet and roll goods,
volumetric goods, and quantity-from-quantity goods.

� A discussion of the modified-average-end method has
been added to Chapter 16.

� The social security tax rates have been updated.
� A section covering e-mail etiquette has been added to

Chapter 28.

DOWNLOAD INSTRUCTOR
RESOURCES FROM THE
INSTRUCTOR RESOURCE
CENTER
To access supplementary materials online, instructors
need to request an instructor access code. Go to www.
pearsonhighered.com/irc to register for an instructor ac-
cess code. Within 48 hours of registering, you will receive a
confirming e-mail including an instructor access code.
Once you have received your code, locate your text in the
online catalog and click on the Instructor Resources but-
ton on the left side of the catalog product page. Select a
supplement, and a login page will appear. Once you have
logged in, you can access instructor material for all
Prentice Hall textbooks. If you have any difficulties access-
ing the site or downloading a supplement, please contact
Customer Service at http://247.prenhall.com.

DISCLAIMER
The sample Excel spreadsheets in this book are to provide the
reader with examples of how Excel may be used in estimat-
ing, and as such, are designed for a limited number of esti-
mating situations. Before using the spreadsheets in this book,
the reader should understand the limits of the spreadsheet
and carefully verify that the spreadsheets (1) are applicable to
his or her estimating situation and (2) produce an acceptable
answer. The reader assumes all risks from the use and/or per-
formance of these spreadsheets.

viii PREFACEviii PREFACE
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Chapter 1 The Art of Estimating

Chapter 2 Overview of the Estimating and Bidding Process

Chapter 3 Introduction to Excel

I
n this section, you will be introduced to the art of estimating, the esti-
mating process, and Microsoft Excel 2010. These chapters will prepare
you for the rest of the book. For those of you who struggle with math or

just want to review the mathematical principles used in estimating, a review
of estimating math is given in Appendix A.

P A R T O N E

INTRODUCTION TO
ESTIMATING



2

In this chapter you will be introduced to the art of estimating.
You will learn what it takes to become a good estimator, the
components of a bid package, and the tools used by an estima-
tor. Finally, you will be introduced to computerized estimating.

Estimating is the process of determining the expected
quantities and costs of the materials, labor, and
equipment for a construction project. The goal of

the estimating process is to project, as accurately as possible,
the estimated costs for a construction project, as well as the
required amount of materials, labor, and equipment neces-
sary to complete the work. The American Institute of
Architects defines the work as “the construction and services
required by the Contract Documents . . . and includes all
other labor, materials, equipment and services provided . . .
by the Contractor to fulfill the Contractor’s obligations.”1

The work is often referred to as the scope of work.
Estimating plays a key role in the operation of construc-

tion companies. Accurate estimates are needed for a com-
pany to be successful in the bidding process while maintain-
ing a reasonable profit margin. If the estimates are too high,
the company may starve to death because of the lack of
work. If the estimates are too low, the company may lose
money and go bankrupt. The estimator is constantly walking
a fine line between bidding too low and too high.

THE ESTIMATOR
The estimator is the person responsible for preparing the cost
estimates. Large companies may employ an estimating de-
partment with one or more full-time estimators. The esti-
mating department is often charged with preparing all of the
company’s estimates. In smaller companies, the project man-
agers or the company’s owner may be responsible for prepar-
ing the estimates. Regardless of their job title, employees who
are responsible for preparing estimates are estimators. The

estimator is responsible for seeing that the estimate accu-
rately determines the quantity of materials, labor, and equip-
ment and incorporates the costs to complete the required
scope of work along with a reasonable profit while remaining
competitive with other firms in the market. Great skill is re-
quired to balance the need to be competitive with the need to
be profitable.

To be a good estimator a person must possess the fol-
lowing skills:

� An estimator must have a sound understanding of the con-
struction methods, materials, and the capacities of skilled
labor. Because of the great variety of work, it is impossible
for an estimator to be versed in all forms of construction.
Therefore, an estimator must specialize in one or more
areas of construction. An estimator may specialize in a
subcontractor trade such as electrical, mechanical, or ex-
cavation. An estimator may also specialize in an area of
construction such as residential, tenant finish, or highway
construction. Because the methods of construction, the
preferred materials of construction, and the skill of labor
vary from market to market, estimators must also special-
ize in a specific market area, such as a state or region.

� An estimator must possess the basic skills needed to de-
termine the quantities of materials, labor, and equipment
necessary to complete a project. This requires the estima-
tor to read blueprints, understand the design that the
architect or engineer has specified, and determine the
quantities needed to complete the project. Because much
of an estimator’s time is spent working with quantities,
estimators must have strong mathematical skills. A review
of estimating math is given in Appendix A.

� An estimator must be a good communicator, both verbally
and in written form. Part of an estimator’s job is to obtain
pricing from vendors and subcontractors. To do this, the
estimator must convince vendors and subcontractors to
bid on projects, communicate what pricing is needed,
and—when the company has won the job—communicate

THE ART OF

ESTIMATING

CHAPTER ONE



The Art of Estimating 3

the responsibilities of the vendors and subcontractors
in the form of purchase orders and subcontracts provided
to the vendor, subcontractor, superintendent, and so forth.
Estimators may also be required to present estimates to
owners—which requires good presentation skills—or pre-
pare proposals—which requires good writing skills.

� An estimator must possess strong computer skills. Much of
today’s estimating is performed using computer software
packages, such as Excel, takeoff packages such as On-Screen
Takeoff, and estimating software packages. Estimators also
need to be able to prepare contracts, proposals, and other
documents using a word processing program.

� An estimator must be detail-oriented. Estimators must
carefully and accurately determine the costs and quanti-
ties needed to complete the project. Simple mistakes—
such as forgetting that the drawings are half-scale or not
reading the specifications carefully enough to realize that
an unusual concrete mix has been specified—can quickly
turn a successful project into an unprofitable job and, in
extreme cases, bankrupt a company.

� An estimator must have the confidence to quickly prepare
takeoffs and make decisions under pressure. Bid days are
hectic. Many vendors and subcontractors wait until the
last hour to submit their bids. As the bid closing ap-
proaches, the estimator must compare and incorporate
new pricing as it is received and fill in missing pricing
with limited time and information at his or her disposal.
Making a bad decision or failing to make a decision under
pressure can cause the company to lose the bid or take an
unprofitable job.

� Finally, an estimator must have a desire for constant im-
provement. Much of a company’s success or failure rides
on the abilities of the estimator to obtain profitable work.

Because of the high degree of uncertainty in estimating
costs, estimating is more of an art than a science. As with any
art, only by practicing can one become a good estimator.
One would not expect to become a good pianist after a few
lessons. It takes practice. Likewise, becoming a good estima-
tor takes practice. But practice is not enough. Practicing bad
estimating skills will only turn a person into a bad estimator.
Truly, practice makes permanent. To be a good estimator, a
person must practice using good estimating skills; and for a
person to practice good estimating skills, he or she must
have a sound understanding of the fundamental principles
of estimating. This understanding can only be obtained by
studying the art of estimating.

If you want to become a good estimator, it is very im-
portant to study and practice estimating. The following is a
list of things that you can do as you read this book to become
a good estimator:

� Carefully read each chapter. The chapters provide you
with explanations of the basic principles of estimating.

� As you read each example problem, check the math with a
calculator. This will help you to gain a greater under-
standing of the estimating principles.

� When reading the example problems that are based upon
the garage drawings that accompany this book, refer to
these drawings and see if you can get a similar quantity of
materials. Minor differences will occur due to difference
in rounding.

� Complete all of the computer exercises and sidebars. Take
existing sidebars and customize them to your estimating
situation. This will help you to become proficient with
Excel.

� Work all of the problems at the end of the chapters. Have
your instructor or a fellow estimator look over your solu-
tions. These problems have been provided to give you
practice in solving simple estimating problems.

� Prepare complete estimates for the Johnson Residence
and West Street Video projects listed in Appendix F. Have
your instructor or a fellow estimator look over your esti-
mate. (The loose project drawings are provided in a sepa-
rate package shrink-wrapped to this text.)

In addition to these things, practice estimating when-
ever you get the chance. Volunteer to help an estimator with
his or her estimate. Ask questions of fellow estimators.
Remember, learning to estimate takes time.

TYPES OF ESTIMATES
There are three common types of estimates. They are the
conceptual estimate, preliminary estimate, and final or de-
tailed estimate.

The conceptual estimate is an estimate prepared while
the project is still in a conceptual state. The conceptual esti-
mate is used to study the feasibility of a project or to compare
two potential design alternatives (for example, a concrete
structure versus a steel structure or three stories versus four
stories). These estimates are based on a description of the
project or on very limited drawings and as such are the least
accurate type of estimate.

The preliminary estimate is an estimate prepared from a
partially completed set of drawings. A preliminary estimate
is often performed when the drawings are 35% to 50% com-
plete and is used to check to see if the proposed design is on
budget and to identify changes to the design that need to be
made to meet the budget. Preliminary estimates may be per-
formed any time before the bid. Preliminary estimates are
more accurate than conceptual estimates because more de-
sign information is available.

Final or detailed estimates are used to prepare bids and
change orders, order materials, and establish budgets for
construction projects. They are prepared from a complete or
nearly completed set of drawings and are the most accurate
type of estimate.

Sometimes shortcuts methods (methods which produce
a close, but less accurate answer) are used to prepare bids in
order to bid more projects in less time. This may save time
during the bidding process, but can cause cost-control prob-
lems for the company. When shortcut methods are used to
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order materials, the wrong materials or wrong quantities are
often delivered to the site, which results in delays and in-
creased construction costs. When a shortcut method pro-
duces a quantity within a few percent of the correct answer it
is hard to determine if a quantity overrun is due to poor ma-
terial use in the field or inaccuracy in the estimating process.
Similarly, when a quantity underrun occurs, it is unclear if it
is due to good material use in the field or inaccuracy in the
estimating process. For cost-control purposes, it is impor-
tant to have an accurate quantity and costs estimate for all
items, including an estimate for both unavoidable and
avoidable waste. Unavoidable waste is waste that is a result of
the difference between design dimensions and the size of
materials. For example, when carpeting a nine-foot by nine-
foot room with carpet that comes in 12-foot-wide rolls, you
will have a three-foot-wide strip of waste unless it can be
used elsewhere. Avoidable waste is waste that can be avoided
by good use of materials in the field. It is not uncommon to
have one framing crew use 5% more materials to frame the
same house as another crew. The extra materials used are
avoidable waste. Avoidable waste also includes materials that
are damaged or destroyed on the job.

The primary focus of this book is on preparing accurate
final or detail estimates, although many of these principles
apply to conceptual and preliminary estimates.

BID PACKAGE
Estimates are prepared from bid packages. The bid package
defines the scope of work for the construction project. Bid
packages range from a sketch on the back of a napkin to a
well-developed set of plans and specifications consisting of
hundreds of sheets of drawings and a multivolume project
manual. A well-developed bid package includes a set of plans
and a project manual.

The plans graphically show building dimensions and
where different materials are used. The process of converting
the building dimensions and details into estimated quanti-
ties is known as the quantity takeoff. The estimator will pre-
pare the bid from the quantity takeoff. Typically, the plans
are organized as follows: civil plans, architectural plans,
structural plans, mechanical and plumbing plans, and elec-
trical plans. The project manual provides a lot of informa-
tion for the bidder. The typical project manual includes the
following items:

Invitation to Bid: The purpose of the invitation to bid
is to invite bidders to bid on the project and give a
bidder enough information to decide whether he or
she wants to bid on the project. Often, public agen-
cies are required to invite all qualified bidders to bid
on the work. This is typically done by posting the in-
vitation to bid in a few predetermined locations (for
example, the local library and the public agency’s of-
fice) and by printing it in the local newspaper. The
invitation to bid is also placed at the front of the pro-
ject manual. The invitation to bid provides a project

description, contact information for the owner and
design professional (architect or engineer), bid date,
restrictions on bidders, expected price range, and the
expected duration of the project.

Bid Instructions: Bid instructions are instructions that
must be followed to prepare a complete bid. The goal
of the bid instructions is to help the bidders provide a
complete bid with all the necessary documents (for
example, bid bond and schedule of values). Bidders
may be disqualified for not following these instruc-
tions, which may result in a bidder losing the job even
though he or she was the low bidder.

Bid Documents: Public agencies and owners typically
use standard forms for the submission of the bid.
These forms may include bid forms, bid-bond forms,
a schedule of values, and contractor certifications. A
sample bid form is shown in Figure 1-1. The bid bond
is discussed in the next paragraph. The schedule of
values breaks the bid into smaller portions and is
used to determine and evaluate the amount of the
progress payments. A sample schedule of values is
shown in Figure 1-2. Estimators should read these
documents carefully and comply fully with their re-
quirements. Bidders can be disqualified for not sub-
mitting all of the required bid documents.

Bonds: Bonds include the bid bond, the payment
bond, and the performance bond. Bonds are issued
by sureties. Bid bonds are provided by the contractor
at the time of the bid. The bid bond guarantees that
the contractor—should he or she be the low bidder—
will sign the contract and provide the payment and
performance bonds. The payment and performance
bonds are provided when the contract for the work is
signed. The payment bond guarantees that the ven-
dors, subcontractors, and labor will be paid for the
work they perform on the project. In the event that
the vendors, subcontractors, and labor are not paid
on the project, the surety will step in and make the
necessary payments. The performance bond guaran-
tees that the contractor will complete the construc-
tion project. In the event that the contractor fails to
complete the project, the surety will step in and com-
plete the project. Providing payment and perfor-
mance bonds can increase the costs of the project by
1% to 2%.

Contract: Public agencies and owners often use stan-
dard contracts. Estimators should read the contract
carefully and include any costs associated with meet-
ing the terms of the contract in their bid.

General Conditions: Public agencies and owners often
use standard general conditions. General conditions
affect the cost to complete the work. The general
conditions identify the relationships among the
owner, design professionals, and the contractor and
addresses provisions that are common to the entire
project; for example, how changes in the scope of
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FIGURE 1-1 Bid Form

work are to be processed or the need for cleanup.
Estimators should read the general conditions care-
fully and include any costs associated with the general
conditions in their bid.

Special Conditions: Special conditions are additional
conditions that apply to this specific project. Like the
general conditions, the special conditions affect the
cost to complete the work. Estimators should read the
special conditions carefully and include any costs as-
sociated with the special conditions in their bid.

Technical Specifications: Technical specifications
identify the quality of materials, installation proce-
dures, and workmanship to be used on the project.
The specifications also specify the submittal and
testing requirements for individual building compo-
nents. Estimators must read these carefully and un-
derstand their implications. Bidding the wrong speci-
fication can lead to losing the bid unnecessarily or
winning a bid that you do not have sufficient funds to

complete. The specifications are typically organized
according to the MasterFormat.2 The 2004 edition
expanded the MasterFormat from 16 divisions to 50
divisions (00 to 49).3 The 2010 MasterFormat is orga-
nized as follows:

Division 00: Procurement and Contracting
Requirements

Division 01: General Requirements

Division 02: Existing Conditions

Division 03: Concrete

Division 04: Masonry

Division 05: Metals

Division 06: Wood, Plastics, and Composites

Division 07: Thermal and Moisture Protection

Division 08: Openings

Division 09: Finishes

Division 10: Specialties
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Division 11: Equipment

Division 12: Furnishings

Division 13: Special Construction

Division 14: Conveying Equipment

Division 21: Fire Suppression

Division 22: Plumbing

Division 23: Heating, Ventilating, and Air
Conditioning (HVAC)

Division 25: Integrated Automation

Division 26: Electrical

Division 27: Communications

Division 28: Electronic Safety and Security

Division 31: Earthwork

Division 32: Exterior Improvements

Division 33: Utilities

Division 34: Transportation

Division 35: Waterway and Marine Construction

Division 40: Process Integration

Division 41: Material Processing and Handling
Equipment

Division 42: Process Heating, Cooling, and Drying
Equipment

Division 43: Process Gas and Liquid Handling,
Purification, and Storage Equipment

Division 44: Pollution and Waste Control Equipment

Division 45: Industry-Specific Manufacturing
Equipment

Division 46: Water and Waste Equipment

Division 48: Electrical Power Generation

Other Inclusions: Other documents, such as a soils re-
port and environmental inspections, may be included
in the project manual. The soils report describes the
soil conditions and the water table at the construc-
tion site, which greatly affect the excavation costs.
Estimators should take this information into account
when preparing an estimate for a project.

Included by Reference: Other documents may be in-
cluded in the specifications by reference. Documents
included by reference are not physically attached to
the project manual but are treated as if they were.
Documents that are often included by reference in-
clude standard agency specifications and other readily
available standards (for example, American Society
for Testing and Materials [ASTM] and American
National Standards Institute [ANSI] standards).
Estimators need to understand the implication of

FIGURE 1-2 Schedule of Values
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FIGURE 1-3 Architect’s Scale (bottom) and Engineer’s
Scale (top)

FIGURE 1-4 Digital Plan Measurer

FIGURE 1-5 Digitizer

these standards because they affect how the work is
performed or are used to determine compliance with
a specification.

ESTIMATING TOOLS
The estimator has a number of tools at his or her disposal to
help prepare the estimate. They range from simple paper
forms to powerful estimating computer programs. An esti-
mator’s tools include the following:

Architect’s and Engineer’s Scales: Plans are prepared
at a reduced scale. Architect’s and engineer’s scales
allow the estimator to measure dimensions from the
plans. The architect’s scale typically includes the fol-
lowing scales: 1� � 1�, 1/2� � 1�, 1/4� � 1�, 1/8� � 1�,
3/16� � 1�, 3/32� � 1�, 3/4� � 1�, 3/8� � 1�, 11/2� � 1�,
and 3� � 1�. The engineer’s scale typically includes
the following scales: 1:10, 1:20, 1:30, 1:40, 1:50, and
1:60. Architect’s and engineer’s scales are shown in
Figure 1-3.

Plan Measurer: A plan measurer or wheel measures the
length of a line by rolling the wheel of the measurer
along the item to be measured. A plan measurer has
the advantage of being able to follow curved lines
more easily than an architect’s or engineer’s scale.
Analogue plan measurers have fixed scales, such as
1/2� � 1�, 1/4� � 1�, and 1/8� � 1�; digital plan mea-
surers have more scales available and often include
the ability to create custom scales. A digital plan mea-
surer is shown in Figure 1-4.

Digitizer: A digitizer consists of an electronic mat and
stylus or puck. The digitizer can measure distances
and areas. The digitizer may operate as a stand-alone
tool or be connected to a software package. Digitizers

have an unlimited number of scales and can perform
mathematical functions on distances and areas. A
digitizer is shown in Figure 1-5.

Takeoff Packages: The digitizer is being replaced by
takeoff packages, such as On Center Software’s On-
Screen Takeoff and Trimble’s Paydirt that allows the
user to determine the quantity of material needed
from a digital set of drawings. These software packages
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make determining the length, perimeter, area, and
volume quick and easy. On-Screen Takeoff will even
allow the user to determine the length of the perime-
ter, number of tiles, and length of grid needed for a
dropped acoustical ceiling by having the estimator
trace the perimeter of the ceiling. These software
packages can be integrated with spreadsheet or other
estimating packages.

Calculator and Paper Forms: In the days before com-
puters, most estimates were prepared by using paper
estimating forms and calculators. Some estimates are
still prepared in this way, particularly estimates that
are prepared in the field; however, with modern lap-
top computers and portable printers, even paper esti-
mates in the field are being replaced by computerized
estimates.

Spreadsheets: With the increased use of computers in
the construction industry and spreadsheet programs
such as Excel, many companies have converted their
estimating forms into computer spreadsheets.
Spreadsheets have the advantage of automating the
calculations and allowing the estimator to see the ef-
fects of minor changes in seconds. Developing
spreadsheets for use in estimating is the topic of Part
V of this book.

Estimating Software: Estimating software packages,
such as Timberline Precision Estimating, combines
the advantages of a computer spreadsheet with a data-
base. This automates the estimating even further.
Estimating software has the additional advantage of
being capable of taking off assemblies as a single item.
For example, an estimator can take off a wall assembly
that includes the top and bottom plates, the studs, in-
sulation inside the wall, and the finish material on both
sides of the wall as a single component. Estimating
software also allows the estimator to print the bid in-
formation in different formats for different uses with
little or no setup.

COMPUTERIZED ESTIMATING
Nothing has revolutionized estimating as much as the ad-
vent of computers along with spreadsheets, estimating soft-
ware, and takeoff packages. If used correctly, computers can
reduce the time needed to prepare an estimate and decrease
the errors in the estimate. If used improperly, they can in-
crease the number of errors in an estimate and decrease the
usefulness of the estimate. There are two dangerous mistakes
estimators make when using estimating packages.

The first mistake is to turn the thinking over to the com-
puter so the estimator becomes simply a means of entering
data into the software package. The estimator determines the
quantity of a given component and enters it into the com-
puter without giving any thought to job conditions and design
requirements that may require this component to be handled
in a different way than it is usually handled. For example, a

hollow-metal door frame for a pair of doors that must be de-
livered to the tenth floor of an office building up a small ele-
vator must be constructed in pieces and fabricated on site,
whereas most door frames are constructed as a single mem-
ber. Computers are good for performing repetitive tasks
quickly without error. They are good for handling the mind-
less and boring tasks such as totaling a column for the
umpteenth time. Estimators can make a minor change to an
estimate and the computer will calculate the changes to the
estimate almost instantaneously.

Another danger of just entering data into the computer is
that computer spreadsheets and formulas in estimating pack-
ages are developed for a limited number of circumstances
based on a set of assumptions made by the writer of the
spreadsheet or formula. Whenever the estimator uses the
spreadsheet or formula on a situation that is outside the condi-
tions anticipated by the developer, the estimator may get an in-
accurate estimate from the spreadsheet or formula. To protect
against this, the estimator must have an understanding of the
limits and design of the spreadsheet or formula and must make
sure the spreadsheet’s or formula’s response is reasonable.

The second mistake is to create a new spreadsheet or
formula and use it without properly testing it. After creating
a spreadsheet or formula, the developer should test the
spreadsheet or formula to make sure it is working properly,
not only on the situation that it was developed for, but on
other conceivable situations. In addition, the developer
should try to make the spreadsheet or formula mess up and
then build in ways to prevent other users from making the
same mistakes by building in error-checking procedures.

Excel is the most popular estimating package. In a sur-
vey performed by the American Society of Professional
Estimators, 29% of the respondents reported using Excel as
their estimating software, 22% reported using Timberline,
and 25% reported using another estimating software pack-
age such as WinEst (WinEstimator, Inc.) and HeavyBid
(Heavy Construction System Specialists, Inc.).4 Users of esti-
mating packages commonly augment the software package
with Excel worksheets to assist in the quantity takeoff and
other support functions.

Spreadsheets have the advantage of being inexpensive.
Spreadsheet software can be purchased for about $100 and is
often included along with other standard applications—
such as word processing—that are sold as a software package
for use in offices. In addition to being inexpensive, spread-
sheets are easily adapted to the existing style and estimating
procedures of the company. A company that uses paper
forms can easily create a look-alike form in the spreadsheet
and let the software perform the mundane and tedious cal-
culations. Finally, spreadsheets are easy to create. With a little
training and effort, anyone can develop spreadsheets for esti-
mating. Developing spreadsheets for estimating in Excel is
the topic of Part V of this book.

Estimating software packages are powerful computer
software applications that have been developed specifically
for estimating. There are a number of packages available,
with some packages having been designed for building
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construction and others for heavy and highway construction
that involves large amounts of earthwork. Estimating soft-
ware packages have the advantage of automating the takeoff
process and decreasing the time it takes to prepare an esti-
mate by combining a spreadsheet with a database. The data-
base contains a list of standard items along with their cost,
labor productivity, labor rates, equipment costs, and formu-
las used to calculate the quantities and costs of the individual
items. Estimating packages often allow the user to create as-
semblies—a group of items that are needed to create a com-
ponent such as a wall—and take off the assembly in a single
step. Another feature of estimating packages is that the data
can be easily manipulated and printed in different formats.

For example, one can print the costs by line item with the
sales tax appearing at the bottom of the report or one can
have the sales tax allocated to the individual line items. All
these features come at a price. Estimating software packages
are more expensive than spreadsheets—often costing thou-
sands of dollars. In addition to the dollar costs, they require
a large time investment to set up and maintain the database.
The pricing in the database must be kept current with mar-
ket pricing, materials must be set up, formulas must be writ-
ten and tested, and assemblies must be created. Companies
must perform large amounts of estimating to justify the cost
and time commitment involved in using an estimating soft-
ware package.

CONCLUSION
Successful estimates are the lifeblood of a construction com-
pany. Winning bids while maintaining a good profit margin
is necessary for a construction company to succeed. Accurate
quantities and costs are needed for strong cost controls. To
be a good estimator, a person must study and practice sound
principles of estimating. Computers have greatly changed
the way estimators prepare estimates. Computers and soft-
ware packages, if used properly, can increase the productiv-
ity of the estimator while decreasing errors. Estimating soft-
ware includes spreadsheet packages such as Excel, estimating
software such as Timberline, and takeoff packages, such as
On-Screen Takeoff.

PROBLEMS
1. Define estimating.

2. Define work or scope of work.

3. What role does estimating play in the success of a con-
struction company?

4. What is the role of an estimator?

5. What skills are required to be a good estimator?

6. Why is practice important for an estimator?

7. What role does the bid package play in estimating?

8. What tools are available to estimators?

9. What are the advantages and disadvantages of using
spreadsheets for estimating?

10. What are the advantages and disadvantages of using es-
timating packages, such as Timberline, for estimating?
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In this chapter you will be introduced to the estimating and
bidding process and gain an understanding of the steps needed
to complete an estimate. The purpose of this chapter is to give
you an overview of the process so that as you read the subse-
quent chapters you will have a better idea of how they fit into
the estimating and bidding process.

Once the bid package is complete, a detailed esti-
mate is needed to establish a budget for the project
and, in the case of competitive bidding, selection

of the contractor. This chapter looks at the process of
preparing a detailed estimate for a competitive bid project.
Preparing a preliminary estimate during the design process
or preparing an estimate for a change order follows a similar
process. Preparing an estimate for a competitive bid project
is divided into four phases: planning the bid, pre–bid-day
activities, bid-day activities, and post-bid activities. An
overview of these steps is shown in Figure 2-1.

PLANNING THE BID
Planning the bid consists of identifying the scope of work for
the project, preparing a schedule for the bidding process,
and assigning tasks to members of the estimating team.

Scope of Work: During the planning stage the estimator
needs to identify the general scope of work covered by
the bid package. Often, this is done by reviewing the
bid package and identifying which of the company’s
cost codes are needed for the project and what pric-
ing needs to be obtained to complete the estimate.
Many companies have standard summary sheets, like
the one shown in Figure 2-2, where the estimator
marks the cost codes in the left column that he or she
needs pricing for to complete the estimate. This pric-
ing may come from suppliers or subcontractors or
may be estimated in-house. In addition to identifying

the cost codes, the estimator needs to identify any
items that may be difficult to find a price for (for ex-
ample, an indoor pistol range and other specialty
equipment) and any special items (such as a bid
bond, submission of a prequalification package, or
attendance at a pre-bid meeting) that are required of
the bidders.

Scheduling the Bid: Once the scope of the project has
been determined, the estimator must schedule the
tasks necessary to complete the bid such that the bid
is completed in time to be submitted. If there is insuf-
ficient time to complete the bid, the estimator must
get additional help, eliminate some of the estimating
steps, or decide not to bid on the project.

Assigning Tasks: If the estimating team consists of
more than one person, once the scope of work has
been identified and a schedule prepared for the bid
package, the estimator must delegate the bidding
tasks to other members of the team and communi-
cate the deadlines for the completion of these tasks
to the team members. For example, for a bid that re-
quires the use of in-house crews and requires a
schedule to be submitted as part of the bid, the esti-
mator may assign the estimating of the in-house
work to the person responsible for the in-house
crews and the preparation of the schedule to the
company’s scheduler.

PRE–BID-DAY ACTIVITIES
The pre–bid-day activities are activities or tasks that should
be completed before the day of the bid. The activities include
ordering the bid bond, requesting quotes from subcontrac-
tors, completing the quantity takeoff, obtaining material
pricing from vendors, pricing in-house labor, pricing equip-
ment, determining project overhead, and preparing the bid
documents.

OVERVIEW OF THE ESTIMATING

AND BIDDING PROCESS

CHAPTER TWO
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FIGURE 2-1 The Estimating Process

Order Bond: One of the first activities that should be
done is to order a bid bond from the surety company.
This gives the surety time to prepare the bid bond,
obtain the necessary signatures on the bond, and mail
it to the contractor. By ordering the bond early the
contractor eliminates the need to make a special trip
to the surety’s office to pick up the bond. The estima-
tor also finds out early in the bidding process if there
will be any problem getting the bond before spending
a lot of time preparing the estimate. This is important
if the engineer’s or architect’s estimate is near the
contractor’s bonding limits.

Request Subcontractor Quotes: Another step that
must be completed early in the bid process is identi-
fying which subcontractors need to be invited to bid

on the project and requesting quotes from these
subcontractors. Starting this process early is impor-
tant because subcontractors need to find the time to
look at the plans and project manual and prepare
their estimate. When dealing with a limited number
of plan sets it can be quite a challenge to give all of the
subcontractors a chance to look at the plans within
the allowed time for the bid. When dealing with a
limited number of plan sets, the goal of the estimator
should be to get one subcontractor to bid in each cat-
egory of work before getting second and third bids.
By doing this the contractor has a bid for each cate-
gory of work rather than having multiple bids in one
category and no bid in another category. In addition,
the contractor should try to get bids on the high-dollar
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FIGURE 2-2a The Summary Worksheet

items first because these items carry the most risk
should the contactor have to bid these items himself
or herself. Preparing requests for subcontractor
quotes is discussed in Chapter 24.

Quantity Takeoff: After lining up subcontractors and
arranging for the bid bond, the next most important
task is to prepare a quantity takeoff for the work to
be performed in-house. The quantity takeoff is nec-
essary to prepare material, labor, and equipment
costs (unless the vendors are doing the quantity
takeoff for their work) for the estimate. If the ven-
dors are preparing quantity takeoffs for their work,
the estimator should request a quote from these
vendors at the same time he or she requests quotes
from subcontractors. Often vendors who prepare a
quantity takeoff for contractors do not guarantee

that their quantities are accurate, and the estimator
should prepare his or her own quantity takeoff to
make sure there are sufficient quantities of materials
to complete the work. If time allows, the estimator
should prepare quantity takeoffs for subcontractor
work where there is a concern that the subcontrac-
tor’s bid may not be received in time to complete the
bid. The quantity takeoff is discussed in Part II of
this book.

Materials Pricing: Estimators often send their quantity
takeoffs to vendors and request that the vendors pro-
vide pricing for the materials identified in the quan-
tity takeoff. This requires the quantity takeoff to be
completed in time to send the list of needed materials
to the vendors, have the vendors price the materials,
receive a quote from the vendors, and incorporate the
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pricing into the estimate. Materials pricing is dis-
cussed in Chapter 19.

Labor Pricing: Once the quantity takeoff has been
completed, the estimator can determine which crews
are to be used on the in-house work, the associated
productivity rates for the work, hourly crew costs, and
the cost of the labor to perform the in-house work.
Labor productivity is discussed in Chapter 20, and de-
termining labor rates is discussed in Chapter 21.

Equipment Pricing: Once the quantity takeoff has
been completed, the estimator can determine the

equipment needs of the project and determine the
cost of the equipment. This may include obtaining
rental pricing or pricing company-owned equip-
ment. Pricing equipment is discussed in Chapter 22.

Project Overhead: Before the bid day, the estimator
should prepare an estimate for project overhead.
Project overhead includes all costs that are associ-
ated with the project but cannot be identified with a
specific component of the project’s construction.
The project overhead should be prepared by prepar-
ing a quantity takeoff for the project overhead and

FIGURE 2-2b The Summary Worksheet
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putting costs to the quantities just as is done with
material estimates. An overhead checklist is shown
in Figure 2-3.

Prepare Bid Documents: Finally, the bid documents
need to be prepared and the appropriate signatures
need to be obtained. Any incomplete items that must
be filled in on the day of the bid, such as the bid price
and the prices for the schedule of values, should be
marked with Post-Its to minimize the possibility of
forgetting to fill in a blank on the day of the bid.

BID-DAY ACTIVITIES
The bid-day activities are activities or tasks that are performed
predominantly on the day of the bid, although some of these
activities may be started before the bid day. This is because
most subcontractors wait until a few hours before the bid
deadline to submit their bids. As a result, bid days can be quite
hectic. Bid-day activities include selecting subcontractors;

combining the labor, material, equipment, subcontractor, and
overhead pricing; incorporating markups; reviewing the bid
for errors; and submitting the bid.

Subcontractor Selection: When receiving bids from a
subcontractor, it is important for the estimator to
verify that the subcontractor has included the entire
scope of work for the items that the subcontractor is
bidding. Any items that are missing must be added to
the estimate for it to be complete and to avoid having
an incomplete estimate. In addition, the estimator
must make sure the bids from the subcontractors
used in the estimate do not include items that are in-
cluded in other subcontractor’s bids or their bids.
Including an item twice inflates the estimate, and the
contractor risks losing the bid because of poor esti-
mating practices. When bids for a bid item are avail-
able from more than one subcontractor, the best sub-
contractor must be selected. Selection may be made
based on completeness of the scope of work, price,

FIGURE 2-3a Overhead Checklist



and past experience with the subcontractor. When a
subcontractor phones in a quote, the estimator
should take careful notes as to what the subcontrac-
tor is bidding. This information should include the
bidder and contact information, project name, what
the bidder is bidding, addends received, specific exclu-
sions, whether freight and sales tax are included, bid
price, the date and time the bid was received, and who
took the bid. The best way to do this is to fill out a
phone quote sheet such as the one shown in Figure 2-4.
Today, most phone quotes have been replaced by
faxed or e-mailed quotes; however, they should contain
the same basic information. If any of this information
is missing, the subcontractor should be contacted and
the information obtained.

Combing Pricing: As the pricing becomes available,
the estimator should add the pricing to the bid. The
pricing includes pricing for labor, materials, equip-
ment, subcontractor, and overhead. The estimator
should exercise caution to be sure that all items neces-
sary to complete the bid are included in the bid and

none of the items have been included twice. Combining
the pricing should begin before bid day and often con-
tinues right up until the bid is submitted.

Add Markups: On the day of the bid, the estimator
should finalize the rates for the markups. Markups
are also known as add-ons. Markups include the
profit markup, overhead markup, building permit
costs, bonding costs, and sales tax. The profit markup
is used to provide the owners of the construction
company a return on their investment. Often, the
profit markup is adjusted based on the competition
bidding on the project. As the estimator finds out
which plan holders have dropped out of the bidding,
the profit margin is often adjusted. The overhead
markup is used to cover the company’s general over-
head costs. The project’s specific overhead should
not be included in the overhead markup but should
be bid as part of the project costs. The bonding
costs, and sometimes the building permit costs, are
based on the estimated construction costs, which are
not known until the bid is completed. This requires

Overview of the Estimating and Bidding Process 15

FIGURE 2-3b Overhead Checklist



the costs for these items to be calculated near the
completion of the bid. Sales tax may be added to the
individual material costs or to the material costs of
the bid as a whole. When added to the material costs
of the bid as a whole, the sales tax is treated as a
markup and is incorporated into the bid when the
material costs are totaled. For cost control purposes,
the sales tax must be added to the individual cost
codes when preparing the budget for the project.
Markups are discussed in Chapter 25.

Review Bid for Errors: As the bid approaches comple-
tion, the bid needs to be reviewed for errors. This in-
cludes making sure that there is pricing for all of the
bid items, comparing the bid to historical costs for
similar projects, and having someone else check the
estimate for errors. Avoiding errors in estimates is
discussed in Chapter 27.

Submit Bid: Finally, the price and other bid-day infor-
mation should be added to the bid documents, and
the bid should be submitted to the contracting office.

Care must be taken to accurately enter the pricing
and make sure all remaining blanks are filled in. It
would be a great waste of time to lose the bid because
you forgot to fill in a blank or you wrote the wrong
price on the bid document. Submitting the bid is dis-
cussed in Chapter 28.

POST-BID ACTIVITIES
The post-bid activities are different for jobs for which the
contractor is the low bidder than they are for jobs for which
the contractor is not. Here are some of the activities that may
occur after the submission of the bid.

Bid Review: After completing the bid, the estimator
should review the bid and the bidding process to
identify any mistakes that were made and try to
find ways to avoid these mistakes in the future.
Besides identifying mistakes, the estimator should
look at what works and identify ways to make sure
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that he or she does the same things on future bids.
One of the characteristics of a successful estimator
is that he or she is committed to continuous im-
provement. To do this, estimators must learn from
their mistakes and repeat those actions that made
them successful.

Project Buyout: If the estimator wins the bid, the esti-
mator must buyout the project. The project buyout is
the process of hiring subcontractors and procuring
materials and equipment for the construction pro-
ject. During the buyout the estimator must prepare
contracts for the subcontractor’s work and purchase
orders for the materials used on the project and com-
municate this information to the subcontractors,
suppliers, and the general contractor’s project man-
agement team (the superintendent, project manager,
and so forth). During the buyout process the estima-
tor should identify any errors in the estimate and
identify ways to avoid the errors in the future. The es-
timator should also update the pricing in the pricing

database as needed at this time. The project buyout is
discussed in Chapter 29.

Close-Out Audit: The project close-out audit consists
of reviewing all activities completed during the con-
struction process, including the estimating process,
after the project is complete. As part of this audit, the
estimator should review the actual costs to complete
the project and compare the costs against the original
estimate. The goal is to find ways to improve the accu-
racy of the estimate. The estimator should look at areas
where his or her pricing is too high or low so that his or
her future estimates will reflect the actual costs, updat-
ing the pricing in the pricing database as needed. For
the close-out audit to be useful, the actual costs must be
accounted for in the same cost categories as they were
included in the estimate. For this to happen a company
must have a set of standardized job cost codes that
identifies the job cost and spells out what is included in
each cost code. This needs to be done in a formal docu-
ment. Sample job cost codes are found in Appendix B.
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CONCLUSION
There are a number of activities that must be completed to
complete the bid. The first group of activities comprises
planning the bid. This includes defining the scope of work,
scheduling the bidding activities, and assigning the activities
to the members of the estimating team. The second group of
activities comprises the pre–bid-day activities. These include
ordering the bond; requesting subcontractor quotes; prepar-
ing the quantity takeoff; pricing materials, equipment, and
labor; preparing an overhead budget; and preparing the bid
documents. The third group of activities comprises the bid-
day activities. These include selecting the subcontractors,
combining all of the prices together into the bid, adding the
markups, reviewing the bid for errors, and submitting the
bid. The fourth group of activities comprises the post-bid
activities. These include reviewing the bid and, if one is suc-
cessful in winning the bid, buying the project out and per-
forming a project close-out audit at the end of the project.

PROBLEMS
1. What are some of the things you can do if there is insuffi-

cient time to complete the estimate before the bid is due?

2. Why should the bond be ordered early in the bid
process?

3. Why should subcontractor quotes be requested early in
the bidding process?

4. Why should you get one bid in each area you are going
to subcontract out before getting a second bid?

5. Why should you get a bid on the high-dollar subcon-
tractor items first?

6. Why should you prepare a quantity takeoff for mate-
rials even when the supplier is preparing a quantity
takeoff?

7. What is one way you can prevent the possibility of for-
getting to fill in a blank on the bid forms that needs to
be filled in on bid day?

8. Why is it important for an estimator to verify that a sub-
contractor’s bid has a complete scope of work?

9. What are some of the criteria that may be used to select
subcontractors?

10. What should be recorded when taking a telephone
quote from a subcontractor or material supplier?

11. Why should you use phone quote sheets?

12. Identify five different types of markups.

13. What is the overhead markup used for?

14. Define the term buyout.

15. At what two points in a project should an estimator up-
date the pricing database?
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In this chapter you will be introduced to the basic operation of
Excel. This includes managing workbooks and worksheets, enter-
ing data, formatting spreadsheets, writing formulas, using a few
of the basic functions, printing, and testing worksheets. Those
who are just learning Excel should carefully read this chapter and
complete all of the exercises, whereas those who are experienced
with Excel are encouraged to quickly skim this chapter and work
the exercises to pick up additional knowledge on how to get the
most out of Excel. Exercises 3-1 through 3-5, 3-8, and 3-9 are
used as the starting point for the exercises in Chapter 32.

Excel is a powerful spreadsheet program that can be
used to perform mathematical calculations. An Excel
file is known as a workbook and has an .xlsx or .xlsm

(for files that contain macros) extension at the end of the file
name indicating its file type. Files created with Excel 2003 or
older have an .xls extension. The Windows operating system
has the option not to display the file type, therefore, you may
not see the file type on your computer display.

The screenshot figures in this book are based on Excel
2010 running on Windows 7 with the Windows 7 Basic theme.
Figure 3-1 shows the typical layout for Excel 2010. Your layout
may look different based on the selected theme, version of the
operating system, version of Excel, width of your screen, and
settings used on your computer. As the width of excel de-
creases, large buttons are replaced with smaller buttons, which
are stacked on the ribbon; therefore, your ribbon may not
look the same as the screenshots used in this book. If you have
customized the ribbon it will look different.

CONVENTIONS USED
IN THIS BOOK
The following conventions are used in this book to describe
actions that must be performed to set up a worksheet or
change the settings for a worksheet:

Clicking, unless otherwise noted, means left clicking.

Bold words in the text represent buttons, tabs, icons,
radio buttons, items in dropdown boxes, and check
boxes that must be selected and keys that must be
typed to complete the exercises.

Italic words in the text represent text or numbers that
must be entered in a spreadsheet cell or text box to
complete the exercises.

The <> brackets signify that the user must enter data
represented by the text between the brackets, such as
a file name. The appropriate data rather than the text
should be entered between the brackets. For example,
if you are instructed to type <your name> and your
name is John Smith, you would type John Smith.

WORKBOOK MANAGEMENT
Workbook management consists of creating new work-
books, opening existing workbooks, and saving changes to
workbooks. Let’s look at creating new workbooks.

Creating Workbooks
A new workbook is created by clicking on the Excel icon
shown in Figure 3-2.

A new workbook can be created while working in an ex-
isting Excel workbook by typing Ctrl+N (typing the N key
while holding down the Ctrl key) to bring up a blank work-
book or by selecting the File tab (the Microsoft Office but-
ton for Excel 2007), clicking on New in the left pane to bring
up the New Workbook dialogue box (shown in Figure 3-3),
and double clicking on Blank Workbook.

Opening Workbooks
Existing workbooks can be opened by double clicking on the
file name in the Windows folder. Workbooks can also be
opened from Excel by typing Ctrl+O (typing the O key

INTRODUCTION

TO EXCEL

CHAPTER THREE
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FIGURE 3-1 Excel Layout

FIGURE 3-2 Excel Icon

FIGURE 3-3 Adding a New Workbook

while holding down the Ctrl key) or selecting the File tab
(the Microsoft Office button for Excel 2007), and clicking
on Open in the left pane to bring up the Open dialogue box
shown in Figure 3-4. From the Open dialogue box, the user
selects the folder where the file is stored in the left side of the
dialogue box (the Look in: dropdown box for Windows XP)
and opens the file by (1) double clicking on the file name or
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FIGURE 3-4 Open Dialogue Box

(2) clicking on the file name and clicking the Open button.
Recently used files may be opened by selecting the File tab
and selecting Recent (the Microsoft Office button for Excel
2007) to bring up the Recent Files dialogue box (shown in
Figure 3-5) and clicking on the file name in the list of re-
cently used documents in the right pane.

Saving Workbooks
Workbooks are saved by clicking on the Save button on the
Quick Access toolbar, by typing Ctrl+S (typing the S key
while holding down the Ctrl key), or by selecting the File tab
(the Microsoft Office button for Excel 2007), and clicking
on Save in the left pane. The first time a file is saved, any one
of these actions will bring up the Save As dialogue box
shown in Figure 3-6. From the Save As dialogue box the user
selects the folder where the file is to be stored on the left side
of the dialogue box (in the Save in: dropdown box for
Windows XP), types the file name in the File name: drop-
down box, and clicks on the Save button.

An existing workbook is saved under a different file
name by selecting the File tab (the Microsoft Office button
for Excel 2007) and clicking on Save As in the left pane to
bring up the Save As dialogue box. The workbook is saved
with a different file name in the same manner that the user
saved a workbook the first time.

Now that you know the basics of spreadsheet file man-
agement, you are ready to create your first spreadsheet. The

following exercise will take you step by step through the
process. You are encouraged to take the time to create the
spreadsheet on your computer. This spreadsheet is used as a
starting point for the subsequent exercises in this chapter
and the exercises in Chapter 32.

Exercise 3-1

First, you will create a folder where you will store the exer-
cises from this book using the following steps:

1. Open the Documents (My Documents in Windows XP)
folder on your hard drive. If you would like to store the
documents in another folder or drive, open the folder or
drive of your choice rather than the Documents folder.

2. Select the New Folder button (shown in Figure 3-7) to
create a new folder. For Windows XP, select File from
the Menu bar, then select New from the popup menu,
and select Folder from the subsequent popup menu to
create a new folder. The default name of the folder
should be “New Folder” and if there is a folder already
named “New Folder,” the new folder has a number in
parentheses included as part of its name.

3. The folder’s existing name should be highlighted. If it is
not, right click on the newly created folder and select
Rename from the popup menu to highlight the folder’s
name.
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FIGURE 3-5 Opening Recent Files

FIGURE 3-6 Save As Dialogue Box
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FIGURE 3-7 New Folder Button

4. Type Excel Exercises and press the Enter key to change
the name of the folder to Excel Exercises.

5. Double click on Excel Exercises to open the folder.

Next, create and save a workbook using the following steps:

6. Open a new workbook in Excel by clicking on the Excel
icon (shown in Figure 3-2) on your desktop or by select-
ing it from the Windows’ start menu.

7. Save the workbook by selecting the File tab (the
Microsoft Office button for Excel 2007), clicking on
Save in the left pane to bring up the Save As dialogue
box, selecting the Excel Exercises folder in the right pane
(Save in: dropdown box for Excel 2007), and typing

Chapter 03 in the File Name text box. The Save As dia-
logue box should appear as it does in Figure 3-6.

8. Click the Save button to save the workbook.

WORKING WITH WORKSHEETS
An Excel workbook contains one or more worksheets. The
worksheets are marked by tabs at the bottom of the screen.
You may move from one worksheet to another by clicking on
these tabs. By default new workbooks contain three work-
sheets named Sheet1, Sheet2, and Sheet3. You can add,
delete, rename, and change the order of the worksheets. Let’s
begin by looking at adding worksheets.

EXCEL QUICK TIP 3-1

Setting the Number of Worksheets in a New Workbook

The number of worksheets that appear when a new work-
book is created is changed by clicking on the File tab (the
Microsoft Office button for Excel 2007), clicking on

Options (Excel Options for Excel 2007) to bring up the
Excel Options dialogue box, selecting General (Popular for
Excel 2007) in the left pane, and under the When creating



FIGURE 3-8 Home: Insert Popup Menu

FIGURE 3-9 Popup Menu

Adding Worksheets
Blank worksheets are added to the workbook in three ways.
First, a blank worksheet may be added to the right of the ex-
isting sheets by clicking on the Insert Worksheet tab located
to the right of the sheet tabs (see Figure 3-1). Second, a blank
worksheet may be added to the left of the active worksheet
by selecting the Home menu tab, selecting the arrow below
the Insert button in the Cells group, and selecting Insert
Sheet from the popup menu as shown in Figure 3-8. If the
Home menu tab is already displayed you need not select it.

Third, a blank worksheet may be added to the left of a work-
sheet by right clicking on the tab to the right of the location
where the worksheet is to be inserted and selecting Insert...
from the popup menu (shown in Figure 3-9) to bring up the
Insert dialogue box (shown in Figure 3-10). From the Insert
dialogue box the user selects Worksheet and clicks the OK
button to insert the worksheet.
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new workbooks heading in the right pane choosing the
number of sheets to be included in the Include this many

sheets: list box. The General tab of the Excel Options dia-
logue box is shown in the figure below:



Copying Worksheets
A worksheet is copied by (1) right clicking on the worksheet
tab and selecting Move or Copy... from the popup menu
(shown in Figure 3-9) or (2) by selecting the Home menu
tab, selecting the arrow below the Format button in the Cell
group, and selecting Move or Copy Sheet... from the popup
menu as shown in Figure 3-11 to bring up the Move or Copy

dialogue box, shown in Figure 3-12. The user checks the
Create a copy check box and selects the location where the
new sheet is to be inserted in the Before sheet: list box. If
the worksheet is to be the last worksheet in the workbook,
the user must select (move to end) as the location of the
worksheet. The user can copy the worksheet to another
workbook or a new workbook by selecting the desired work-
book in the To book: dropdown box. To copy the worksheet
to an existing workbook, the workbook must be open so it
will appear in the To book: dropdown box.

Deleting Worksheets
Worksheets can be deleted by right clicking the tabs of the
unneeded worksheets and selecting Delete from the popup
menu (shown in Figure 3-9) or by selecting the Home
menu tab, selecting the arrow below the Delete button in
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FIGURE 3-10 Insert Dialogue Box

FIGURE 3-12 Move or Copy Dialogue Box

FIGURE 3-11 Home: Format Popup Menu



Renaming Worksheets
Worksheets are renamed in three ways: (1) by right clicking
the tab of the worksheet to be renamed and selecting
Rename from the popup menu shown in Figure 3-9, (2) by
double clicking on the tab, or (3) by selecting the Home
menu tab, selecting the arrow below the Format button in
the Cells group, and selecting Rename Sheet from the popup
menu as shown in Figure 3-11. The name of the tab will then
be highlighted and can be edited as one would edit text in a
word processor. After changing the name of the worksheet,
the user must click on any of the cells or press the Enter key
to save the name change.

Organizing Worksheets
The order of the worksheets tab can be changed by holding
down the left mouse button and dragging the worksheet to
its new location. When the user holds down the left mouse
button, a little black arrow will appear and show where the
worksheet’s tab will be located (as shown in Figure 3-15).
When the user releases the left mouse button, the worksheet
is moved to the new location.
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FIGURE 3-13 Home: Delete Popup Menu

FIGURE 3-14 Warning Dialogue Box

EXCEL QUICK TIP 3-2

Selecting Multiple Cells or Worksheets

The Shift and Ctrl keys are used to select multiple cells or
worksheets at a time.

The Shift key is used to select contiguous blocks of
cells or worksheets. For example, Cells A12 through B13
are selected by clicking on Cell A12, holding down the
Shift key, and clicking on Cell B13. Cells A12, A13, B12,
and B13 will now be selected. The user must hold down
the Shift key after he or she has selected Cell A12, because
the selection will begin at the cell the cursor is in when
the Shift key is held down.

The Ctrl key is used to select noncontiguous cells.
For example, Cells A15 and B16 are selected by clicking
on Cell A15, holding down the Ctrl key, and clicking on
Cell B16. Cells A15 and B16 are now selected.

Both the Shift and Ctrl keys may be used to select a
group of cells. For example, Cells A12 through B13, Cell
A15, and Cell B16 are selected by clicking on Cell A12,
holding down the Shift key, clicking on Cell B13, releas-
ing the Shift key, holding down the Ctrl key, and clicking
on Cells A15 and B16.

the Cells group, and selecting Delete Sheet from the popup
menu as shown in Figure 3-13. If the worksheet contains
data, a warning dialogue box (see Figure 3-14) will appear
warning you that data exists and giving you the opportunity
to cancel the delete. If you still want to delete the worksheet,
click on the Delete button. To cancel the delete, click on the
Cancel button.

FIGURE 3-15 Location Where Worksheet Will Be Inserted



Alternatively, a worksheet can be moved by (1) right
clicking on the worksheet tab and selecting Move or Copy . . .
from the popup menu (shown in Figure 3-9) or (2) by select-
ing the Home menu tab, selecting the arrow below the Format
button in the Cell group, and selecting Move or Copy Sheet...
from the popup menu, as shown in Figure 3-11, to bring up
the Move or Copy dialogue box, shown in Figure 3-12. The
user must select the location where the worksheet is to be in-
serted in the Before sheet: list box. If the worksheet is to be
the last worksheet in the workbook, the user must select
(move to end) as the location of the worksheet. The user can
move the worksheet to another workbook or a new work-
book by selecting the desired workbook in the To book:
dropdown box. To move the worksheet to an existing work-
book, the workbook must be open so it will appear in the To
book: dropdown box. If the user checks the Create a copy
check box, a copy of the worksheet is created rather than
moving the existing worksheet.

Exercise 3-2

In this exercise you will modify the file you created in
Exercise 3-1 to contain two worksheets named “Summary”
and “Detail.” Begin by changing the number of worksheets
to two, using the following steps:

1. Make sure that Chapter 3, the workbook created in
Exercise 3-1, is open. If it is not open, open it by selecting
the File tab (the Microsoft Office button for Excel 2007),
clicking on Open in the left pane to bring up the Open
dialogue box shown in Figure 3-4, selecting the folder
where the file is stored in the left side of the dialogue box
(the Look in: dropdown box for Windows XP), and
opening the file by double clicking on Chapter 3.

2. If there is more than one worksheet, delete all but one of
the worksheets by right clicking the tabs of the un-
needed worksheets and selecting Delete from the popup
menu (shown in Figure 3-9).

3. Insert an additional worksheet by clicking on the Insert
Worksheet tab located to the right of the sheet tab.

Next, change the names of the worksheets to “Summary”
and “Detail” using the following steps:

4. Change the name of the right worksheet to “Summary”
by double clicking on the tab and, with the worksheet
name highlighted, typing Summary.

5. Change the name of the left worksheet to “Detail” by
right clicking the tab of the worksheet, selecting
Rename from the popup menu (shown in Figure 3-9),
and, with the sheet name highlighted, typing Detail.

6. Move the cursor to Cell D1 by clicking on Cell D1.

Next, move the Detail worksheet so it is on the right (the end
of the workbook) and save the workbook using the follow-
ing steps:

7. Right click on the Detail worksheet tab and select Move
or Copy... from the popup menu (shown in Figure 3-9)
to bring up the Move or Copy dialogue box.

8. Select (move to end) in the Before sheet: list box.
The Move or Copy dialogue box should look like
Figure 3-12.

9. Click the OK button to complete the move. The Detail
worksheet should be on the right and the Summary
worksheet should be on the left.

10. Save the workbook by clicking on the Save button on
the Quick Access toolbar or typing Ctrl+S.

ENTERING DATA
Data is entered in the worksheet by clicking on the cell and
typing the data. When the Enter key is typed, the cursor will
move to the next cell. Data is moved from one cell or group
of cells to another cell or group of cells by cutting and past-
ing the data from one cell to another cell. When the same
data is used in multiple cells, the data may be copied and
pasted from one cell to a number of cells. Pictures can also
be added to worksheets. Let’s begin by looking at cutting and
pasting data.
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EXCEL QUICK TIP 3-3

Move after Typing Enter

After you press the Enter key, Excel moves to a neighboring
cell. The user can set Excel to move to the left, right, up, or
down when the Enter key is typed. The default direction is
down. To set the direction, select the File tab (the Microsoft
Office button for Excel 2007), click on the Options button
(Excel Options button for Excel 2007) to bring up the Excel
Options dialogue box, select Advanced in the left pane to

display the Advanced options for working with Excel in the
right pane, and under the Edit options selecting Left, Right,
Up, or Down in the Direction: dropdown box directly
under the After pressing Enter, move selection check box. To
prevent the cursor from moving, uncheck the After press-
ing Enter, move selection check box. The Excel Options di-
alogue box is shown in the figure below:



Cut and Paste
Data is moved by cutting the data from a cell or group of cells
to the clipboard and then pasting the data to a new cell. The
data is cut by selecting the cell or cells containing the data to
be cut and (1) selecting the Home menu tab, and clicking on
the Cut button in the clipboard group (shown in Figure 3-16),
(2) right clicking on one of the selected cells and selecting Cut
from the popup menu (shown in Figure 3-17), or (3) typing
Ctrl+X (typing the X key while holding down the Ctrl key). A
moving dashed line will then appear around the cells that have
been cut and placed on the clipboard.

The data must be pasted to the desired cells before you
perform any other action. If you perform another action
before pasting the data, the data on the clipboard is left in
the original cell and the user must cut the data again before

pasting. The data is pasted to a cell or cells by selecting the
upper-left cell of the paste location, selecting the Home
menu tab, and clicking on the Paste button (shown in
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FIGURE 3-16 Home: Cut Button FIGURE 3-17 Popup Menu
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Figure 3-18) or by typing Ctrl+V (typing the V key while
holding down the Ctrl key). Alternatively, the user may
right click on the upper-left cell and select the Paste button
from the popup menu (shown in Figure 3-17 below Paste
Options:). The data will then be moved from the original
cell or cells to the new cell or cells.

Copy and Paste
Data is copied from a cell or group of cells to multiple cells
or groups of cells by copying the data in a cell or cells to the
clipboard and pasting the data to new cells. The data is
copied by selecting the cell or cells containing the data to be
copied and (1) selecting the Home menu tab, and clicking
on the Copy button (shown in Figure 3-19), (2) right click-
ing on one of the selected cells and selecting Copy from the
popup menu (shown in Figure 3-17), or (3) by typing
Ctrl+C (typing the C key while holding down the Ctrl key).
A moving dashed line will then appear around the cells that
have been copied and placed on the clipboard.

The data must be pasted to the desired cells before per-
forming any other action. Once you have performed an-
other action, you cannot paste the data from the clipboard
to a cell. The data is pasted using the same process as was
used to paste data after cutting it from a cell with one ex-
ception: you may paste the data multiple times until you
perform another action.

When copying, the user has the option to use the paste
special command, which allows the user to copy only certain
properties of the cell. The paste special command is used by
right clicking on a cell and placing the cursor over Paste
Special... from the popup menu (shown in Figure 3-17) or
by selecting the Home menu tab and clicking on the arrow
below the Paste button to bring up the Paste Special popup
menu (shown in Figure 3-20) and selecting the attributes to

paste. From this popup menu, the user may Paste, Formulas,
Formulas & Number Formatting, Keep Source Formatting,
No Borders, Keep Source Column Widths, Transpose,
Values, Values & Number Formatting, Values & Source
Formatting, Formatting, Paste Link, Picture, and Linked
Picture.

Clicking on Paste Special... from the either of the
popup menus will open the Paste Special dialogue box
(shown in Figure 3-21). From the Paste Special dialogue
box the user may select to paste All (this performs the same
function as the paste command), Formulas, Values,
Formats, Comments, Validation, All using Source theme,
All except borders, Column widths, Formulas and number
formats, or Values and number formats. Once the user se-
lects the attributes that he or she wants to paste, the user
must click the OK button to complete the paste. For exam-
ple, if the user selects Values from the Paste Special dia-
logue box, only the values of the cell will be pasted instead
of any formulas; whereas, if All except borders is selected,
the contents of the cell and all of its attributes except the
borders will be copied.

FIGURE 3-18 Home: Paste Button

FIGURE 3-19 Home: Copy Button

FIGURE 3-20 Paste Special Popup Menu

FIGURE 3-21 Paste Special Dialogue Box
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In the next few exercises you will modify the Detail work-
sheet you created in Exercise 3-2 to look like Figure 3-24.

Exercise 3-3

In this exercise you will modify the file from Exercise 3-2 by
adding data to the cells. Begin by adding data to individual
cells using the following steps:

1. Make sure that Chapter 3, the workbook modified in
Exercise 3-2, is open. If it is not open, open it by select-
ing the File tab (the Microsoft Office button for Excel
2007), clicking on Open in the left pane to bring up the
Open dialogue box shown in Figure 3-4, selecting the
folder where the file is stored in left side of the dialogue
box (the Look in: dropdown box for Windows XP), and
opening the file by double clicking on Chapter 3.

2. Make sure the worksheet named Detail is the active
worksheet by clicking on the Detail tab.

3. Begin setting up the spreadsheet by typing MATERIALS
in Cell A1.

FIGURE 3-22 Insert: Picture Button

Adding Pictures
Pictures are added to the worksheet by selecting the Insert
menu tab and clicking on the Picture button in the
Illustrations group (shown in Figure 3-22) to bring up the
Insert Picture dialogue box (shown in Figure 3-23). From
the Insert Picture dialogue box, the user selects the folder
where the file is stored in the left pane (the Look in: drop-
down box for Windows XP) and opens the file by double
clicking on the file name or clicking on the file name and
clicking the Insert button.

FIGURE 3-23 Insert Picture Dialogue Box

FIGURE 3-24 Detail Worksheet

A B C D E F G H I J K L
1
2 $/UNIT COST LHR/UNIT LHR $/LHR COST $/LHR COST

EQUIPMENT
TOTALITEM QUANTITY

MATERIALS LABOR



30 CHAPTER THREE

cursor changes to a vertical line with arrows pointing to the
right and left. Place the cursor in the location shown in
Figure 3-25 to adjust the width of Column B. Second, the
user may double click on the right side of the column’s head-
ing to have Excel automatically change the width of the col-
umn to the minimum width necessary to show the data in
the widest cell within the column. Double clicking on the lo-
cation shown in Figure 3-25 will make this column width
adjustment to Column B. Third, the user may set the width
using the Column Width dialogue box shown in Figure 3-26.
To bring up the Column Width dialogue box, the user right
clicks on the heading for the column and selects Column
Width... from the popup menu (shown in Figure 3-27) or

TABLE 3-1 Data for Cells in Exercise 3-3

Cell Data Cell Data

G1 Labor F2 LHR/UNIT

J1 Equipment G2 LHR

A2 Item H2 $/LHR

B2 Quantity J2 $/LHR

D2 $/Unit L2 Total

E2 Cost

4. Type the text shown in Table 3-1 into the specified cells.

Next, move the data from Cell A1 to Cell D1 using the fol-
lowing steps:

5. Right click on Cell A1 and select Cut from the popup
menu (shown in Figure 3-17) to cut the contents of the
cell to the clipboard.

6. Right click on Cell D1 and select the Paste button
below Paste Options: from the popup menu (shown in
Figure 3-17) to paste the contents of the clipboard to
Cell D1. Cell A1 should now be blank and “MATERIALS”
should be in Cell D1.

Next, copy the data from Cell E2 to Cells I2 and K2 using the
following steps:

7. Right click on Cell E2 and select Copy from the popup
menu (shown in Figure 3-17) to copy the contents of
the cell to the clipboard.

8. Select Cell I2, select the Home menu tab, and click on
the Paste button (shown in Figure 3-18) to paste the
contents of the clipboard to Cell I2.

9. Select Cell K2 and type Ctrl+V to paste the contents of
the clipboard to Cell K2. “COST” should now appear in
Cells E2, I2, and K2.

10. Save the workbook by clicking on the Save button on
the Quick Access toolbar or typing Ctrl+S.

FORMATTING WORKSHEETS
Formatting allows the user to create a specific look for work-
sheets and makes the worksheets easier to read. Common
formatting includes setting the column widths, formatting
and aligning the data in the cells, adding borders around a
cell or group of cells, setting how much of the worksheet is
visible on the computer screen, and adding footers and
headers. Let’s begin by looking at the column widths.

Column Widths
The width of the columns can be changed in three ways.
First, the user may place the cursor over the right side of a
column’s heading and hold down the left mouse button to
drag the right side of the column to the desired width. When
the cursor is over the right side of the column heading, the

FIGURE 3-25 Changing the Width of Column B

FIGURE 3-26 Column Width Dialogue Box

FIGURE 3-27 Popup Menu
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selects the Home menu tab, selects the Format button in the
Cells group shown in Figure 3-28, and selects Column
Width... from the popup menu (shown in Figure 3-29) . The
column width is then entered into the Column width: text
box on the Column Width dialogue box and the OK button
is selected to change the width of the column.

Row Heights
Row heights are adjusted in the same way as column heights
except that the user selects row rather than column.

Cell Formatting
Data in the cells is divided into two types: text (alphanu-
meric) and numeric data. Both numeric and text data can be
aligned left, aligned right, or centered, and the font can be
changed. The data is aligned left by selecting the desired
cells, selecting the Home menu tab, and selecting the Align
Text Left button in the Alignment group. The Align Text Left
button is shown in Figure 3-30.

The data is centered by selecting the desired cells, se-
lecting the Home menu tab, selecting the Center button in

the Alignment group. The Center button is shown in
Figure 3-31.

The data is aligned right by selecting the desired cells,
selecting the Home menu tab, and selecting the Align Text
Right button in the Alignment group. The Align Text Right
button is shown in Figure 3-32.

The font style for the data is changed by selecting the
desired cells, selecting the Home menu tab, and then select-
ing the desired font from the Font dropdown box in the Font
group. The Font dropdown box is shown in Figure 3-33.

The font size for the data is changed by selecting the de-
sired cells, selecting the Home menu tab, and then selecting
the desired font size from the Font Size dropdown box in

FIGURE 3-28 Home: Format Button

FIGURE 3-29 Format Popup Menu

FIGURE 3-30 Home: Align Text Left Button

FIGURE 3-31 Home: Center Button

FIGURE 3-32 Home: Align Text Right Button

FIGURE 3-33 Home: Font Dropdown Box
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the Font group. The Font Size dropdown box is shown in
Figure 3-34.

The font is bolded by selecting the desired cells and (1)
selecting the Home menu tab, and clicking on the Bold but-
ton in the Font group or (2) by typing Ctrl+B (typing the B
key while holding down the Ctrl key). The Bold button is
shown in Figure 3-35.

Alternatively, both the font style and font size can be
changed and the font bolded from the Format Cells dialogue
box, shown in Figure 3-36, which is accessed by selecting the
desired cells and performing one of the following actions:
(1) by typing Ctrl+1 (typing the 1 key while holding down
the Ctrl key) and selecting the Font tab, (2) right clicking on
one of the selected cells, selecting Format Cells... from the
popup menu (shown in Figure 3-17), and selecting the Font
tab, or (3) selecting the Home menu tab and selecting the
Format Cells: Font Dialogue Box Launcher (shown in
Figure 3-37) located at the lower-right corner of the Font
group. From the Font: combo box, the user selects the font;
from the Font style: combo box, the user can bold the font;
and from the Size: combo box, the user selects the font size.
The user must complete the changes by clicking on the OK
box to close the Format Cells dialogue box.

FIGURE 3-34 Home: Font Size Dropdown Box

FIGURE 3-35 Home: Bold Button

FIGURE 3-36 Font Tab of the Format Cells Dialogue Box

FIGURE 3-37 Home: Format Cells: Font Dialogue Box
Launcher
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the thousands and hundreds. An easy way to do this is to se-
lect the desired cells, select the Home menu tab, and select
the Comma Style button in the Number group. The Comma
Style button is shown in Figure 3-41. The Comma Style but-
ton will format the data to an accounting style with two dec-
imal places shown, negative numbers will be placed in
parentheses, and zeros will be shown as a dash.

Numbers can be expressed as a percentage by selecting
the desired cells, selecting the Home menu tab, and selecting
the Percentage Style button in the Number group. The
Percentage Style button is shown in Figure 3-42.

The number of decimal places is increased by selecting
the desired cells, selecting the Home menu tab, and selecting
the Increase Decimal button in the Number group. The
Increase Decimal button is shown in Figure 3-43. The number
of decimal places is decreased by selecting the desired cells,

For very wide text, the text may be wrapped to allow
the text to occupy more than one line. This is done by se-
lecting the cells in which the text is to be wrapped, selecting
the Home menu tab, and selecting the Wrap Text button in
the Alignment group. The Wrap Text button is shown in
Figure 3-38.

At times the user may want to have text cover a number
of rows or columns, as is the case when creating headings.
This is done by selecting the cells to be combined, selecting
the Home menu tab, and selecting the Merge and Center
button in the Alignment group. The Merge and Center but-
ton is shown in Figure 3-39. In addition to merging the
cells, the Merge and Center button centers the data. For the
merge and center to be successful, the selected cells must be
in the shape of a rectangle. If more than one of the cells
contains data, only data from the upper-leftmost cell is re-
tained and the remaining data is lost. If data is to be lost,
Excel will provide the user with the warning dialogue box
shown in Figure 3-40 before proceeding. If the user wants to
continue, he or she must click on the OK button.

To unmerge cells, select the merged cells and click the
Merge and Center button. The data from the cells will be
placed in the upper-left cell.

With numeric data, the user often wants to control how
the data is displayed. For estimating the user often wants to
display the numbers as dollars and cents with commas between

FIGURE 3-38 Home: Wrap Text Button FIGURE 3-39 Home: Merge and Center Button

FIGURE 3-40 Warning Dialogue Box

FIGURE 3-41 Home: Comma Style Button

FIGURE 3-42 Home: Percentage Style Button

FIGURE 3-43 Home: Increase Decimal Button
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selecting the Home menu tab, and selecting the Decrease
Decimal button in the Number group. The Decrease Decimal
button is shown in Figure 3-44.

Other formatting styles, such as date and time, are se-
lected from the Number tab of the Format Cells dialogue
box (shown in Figure 3-45), which is open by (1) right click-
ing on one of the selected cells, selecting Format Cells...
from the popup menu (shown in Figure 3-17), and selecting
the Number tab or (2) selecting the Home menu tab and se-
lecting the Format Cells: Number Dialogue Box Launcher at
the lower-right corner of the Number group.

Borders
Borders are drawn around cells or groups of cells using the
Borders button, located in the Font group on the Home
menu tab. The Borders button is shown in Figure 3-46. The
user may use the most recently used border by clicking on
the left side of the button.

FIGURE 3-44 Home: Decrease Decimal Button

FIGURE 3-45 Number Tab of the Format Cells Dialogue Box

FIGURE 3-46 Home: Borders Button

The user can select from the twelve preset borders
shown in Figure 3-47 by selecting the small arrow on the
right side of the Borders button to bring up the Borders
popup menu. After selecting a preset border type, the popup
menu will disappear and the Border button will change to
show the most recently used preset border. To erase all bor-
ders associated with a cell, select the No Border from the
Borders popup menu shown in Figure 3-47.

Zooming
The extent of the spreadsheet shown on the computer screen
is controlled by the Zoom slider located in the lower-right
hand corner. The user may zoom in and out by sliding the
control knob as shown in Figure 3-48 or by clicking on the
Plus or Minus buttons located to the right and left of the
slider. When clicking on the Plus or Minus buttons the zoom
progresses in increments of 10%. From the Zoom dialogue
box (shown in Figure 3-49), the user can select from one of
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the Zoom button (shown in Figure 3-51). By selecting a num-
ber of rows or columns and selecting Fit selection from the
Zoom dialogue box the spreadsheet will zoom to match the
width of the selected columns or the height of the selected
rows. This may also be done by selecting the rows or columns,
selecting the View menu tab, and selecting the Zoom to
Selection button (shown in Figure 3-52). It is important to
understand that changing the zoom will not change the scale
at which the spreadsheet will be printed. This is done by set-
ting the print scale, which is discussed later in this chapter.

Exercise 3-4

In this exercise you will modify the file from Exercise 3-3 by
changing the column widths, merging and formatting cells,
and adding borders. Begin by changing the column widths
using the following steps:

1. Make sure that Chapter 3, the workbook modified in
Exercise 3-3, is open.

2. Change the width of Column A to 25 by right clicking
on the letter A at the top of Column A, selecting
Column Width... from the popup menu (shown in
Figure 3-27) to bring up the Column Width dialogue
box (shown in Figure 3-26), enter 25 in the Column
Width: text box, and click the OK button.

3. Change the width of Column B to 6, that of Column C to
4, and that of Columns D through L to 10 by using the

FIGURE 3-47 Borders Popup Menus

FIGURE 3-48 Zoom Slider

FIGURE 3-49 Zoom Dialogue Box

the standard zoom percentages, select a custom zoom per-
centage, or zoom to fit the width or height of a selected num-
ber of cells. The Zoom dialogue box is opened by clicking on
the Zoom level located to the right of the Status bar (shown in
Figure 3-50) or by selecting the View menu tab and selecting

FIGURE 3-50 Zoom Level

FIGURE 3-51 View: Zoom Button

FIGURE 3-52 View: Zoom to Selection Button
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same procedures. Hint: Columns D through L can be
changed at once by selecting Columns D through L using
the Shift key, right clicking on any one of the highlighted
columns, and selecting Column Width... from the popup
menu to bring up the Column Width dialogue box. You
can now change the width of all of the columns at once.

Next, format the cells using the following steps:

4. Center the text in Cells D2 through L2 by selecting Cells
D2 through L2 using the Shift key and clicking the
Center button (shown in Figure 3-31) in the Alignment
group on the Home menu tab.

5. Center the text in Column C by selecting Column C and
clicking the Center button.

6. Change the formatting for columns E, I, K, and L to the
accounting style by selecting Column E and holding
down the Ctrl key while selecting Columns I, K, and L to
highlight these columns. With the columns highlighted,
click the Comma Style button (shown in Figure 3-41) in
the Number group on the Home menu tab to change the
formatting to the accounting style and then reduce the
number of decimal points to zero by clicking on the
Decrease Decimal button (shown in Figure 3-44) in the
Number group on the Home menu tab twice.

7. Change the formatting for columns D, F, G, H, and J to
the comma style as done previously; however, do not
change the number of decimal points.

8. Merge Cells A1 and A2 by highlighting Cells A1 and A2
and clicking on the Merge and Center button (shown in
Figure 3-39) in the Alignment group on the Home
menu tab.

9. Left justify the text in the merged cells by clicking the
Align Text Left button (shown in Figure 3-30) in the
Alignment group on the Home menu tab.

10. Merge Cells B1 through C2 by highlighting Cells B1
through C2 and clicking on the Merge and Center but-
ton (shown in Figure 3-39) in the Alignment group on
the Home menu tab.

11. Merge Cells D1 and E1 in the same manner.

12. Merge Cells F1 through I1.

13. Merge Cells J1 and K1.

14. Merge Cells L1 and L2.

Next, you will underline the headings you have created using
the following steps:

15. Underline Row 2 by highlighting Cells A1 through L2
and clicking the Bottom Border button (shown in
Figure 3-46) in the Font group on the Home menu tab. If
another border is shown in the Borders button, select the
correct border by clicking on the small arrow to the right
of the Borders button and selecting the Bottom Border
from the Borders popup menu (shown in Figure 3-47).

Next, set the zoom so you can see Columns A through L
using the following steps:

16. Select Columns A through L by clicking on Column A
and hold down the Shift key while clicking on Column L.

17. Click on the Zoom level (shown in Figure 3-50) at the
left of the Status bar to bring up the Zoom dialogue box
(shown in Figure 3-49), select Fit selection, and click
the OK button to close the Zoom dialogue box.
Columns A through L should cover the entire width of
the spreadsheet.

18. Save the workbook by clicking on the Save button on
the Quick Access toolbar or typing Ctrl+S.

The first two rows of your spreadsheet should be the same as
the first two rows of the spreadsheet in Figure 3-24.

Headers and Footers
Custom headers and footers can be added to each spread-
sheet. The headers and footers may include text, data from
the workbook and computer, or graphics. To edit headers
and footers, the worksheet must be displayed in Page Layout
view. The Page Layout view is displayed by clicking on the
Page Layout button located on the Status bar (shown in
Figure 3-53) or by clicking on the View menu tab and click-
ing on the Page Layout button in the Workbook Views
group (shown in Figure 3-54). Once the spreadsheet is in
Page Layout view, the user can click on the header or footer
to edit the header or footer. Alternately, the user may click on
the Insert menu tab and click on the Header & Footer but-
ton in the Text group (shown in Figure 3-55) to switch to the
Page Layout view and open the header and footer for editing.

FIGURE 3-53 Page Layout Button

FIGURE 3-54 View: Page Layout Button

FIGURE 3-55 Insert: Header & Footer Button
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The headers and the footers are divided into three
areas: left (for left-justified elements), center (for centered
elements), and right (for right-justified elements). A sam-
ple header is shown in Figure 3-56. It is important to note
that elements in any of these areas are not limited to their
areas. They simply identify how the element is aligned.
Text is typed in the headers or footers and the font is
changed in the same manner as the font in the cells is
changed. When the header or footer has been selected, the
Header & Footer Tools: Design menu tab become visible.
Elements are added to the header and footers by clicking
on the Header & Footer Tools: Design tab and selecting
the appropriate element from the Header & Footer
Elements group. The elements of the Header & Footer
Elements group, along with an explanation of their use are
shown in Figure 3-57.

The Page Number button is used to automatically num-
ber the pages. The Number of Pages button is used to display
the total number of pages in the worksheet. This, along with
the Page Number button, allows the user to number the
pages “1 of 5,”“2 of 5,” and so forth. By numbering the pages
in this manner, it is easy to see if pages at the end of the doc-
ument are missing.

The Current Date button adds the current date from the
computer to the header or footer. The Current Time button
adds the current time from the computer to the header or
footer. The date and time will be automatically updated
when the worksheet is printed. By putting the date and time
on each worksheet, it is easy to determine which printed ver-
sion of the worksheet is the most current. This is very useful
when preparing bids and the user wants to make sure he or
she is using the most current worksheet.

The File Path button adds the file name and path (the
location of the folder) to the header or footer. This is useful
when trying to locate the computer file for a worksheet that
has been printed. The File Name button adds just the file
name to the header or footer. The Sheet Name button adds
the name on the worksheet tab to the header or footer.

The Insert Picture button brings up the Insert Picture
dialogue box, which allows the user to add a picture, such as
the company’s logo, to the worksheet. The Insert Picture dia-
logue box is shown in Figure 3-23. Pictures are added to the
headers and footers in the same manner as pictures are
added to the worksheet. The Format Picture button brings
up the Format Picture dialogue box, which allows inserted

FIGURE 3-56 Header

FIGURE 3-57 Elements Available to Headers and Footers

Icon Name Use

Page Number Adds the page number to each
page of the header or footer.

Number of
Pages

Adds the total number of pages
in the header or footer.

Current Date Adds the current date from
the computer to the header or
footer.

Current Time Adds the current time from
the computer to the header or
footer.

File Path Adds the file name and path
(location of the folder) to the
header or footer.

File Name Adds the file name to the
header or footer.

Sheet Name Adds the name on the
worksheet tab to the header 
or footer.

Picture Brings up the Picture dialogue
box that is shown in Figure 3-23,
which allows pictures to be
added to the header or footer.

Format Picture Allows inserted pictures to be
formatted.



pictures to be resized, rotated, and cropped. The Format
Picture dialogue box is shown in Figure 3-58.

The user may move from the header to the footer by
clicking on the Header & Footer Tools: Design menu tab and
clicking on the Go to Footer button (shown in Figure 3-59)
and from the footer to the header by clicking on the Header
& Footer Tools: Design menu tab and clicking on the Go to
Header button (shown in Figure 3-60).

Once the header and footers have been set up the user
clicks on a cell in the worksheet to close the header or footer
and return to editing the worksheet. The user may return to
the Normal view by clicking on the Normal button located
on the Status bar (shown in Figure 3-61) or by clicking on
the View menu tab and clicking on the Normal button in the
Workbook Views group (shown in Figure 3-62).
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FIGURE 3-58 Format Picture Dialogue Box

FIGURE 3-59 Header & Footer: Design: Navigation:
Go to Footer Button

FIGURE 3-60 Header & Footer: Design: Navigation:
Go to Header Button

FIGURE 3-61 Normal Button on the Status Bar

FIGURE 3-62 View: Normal Button

Exercise 3-5

In this exercise you will modify the file from Exercise 3-4 by
adding headers and footers to the Detail worksheet. In the
header you will add the sheet name. In the footer you will
add the date and time (which will record the date and time
the spreadsheet is printed), the file location, the page num-
ber, and a place for the preparer and reviewer to initial. Begin
by adding a header using the following steps:

1. Make sure that Chapter 03, the workbook created in
Exercise 3-1, is open.

2. Click on the Insert menu tab and click on the Header &
Footer button (shown in Figure 3-55) to edit the header.

3. Place the cursor in the center section and click the Sheet
Name button from the Header & Footer Elements
group. The Header should look like Figure 3-56. When
the cursor is moved from the center section of the
header, the &[Tab] will be replaced with the name of the
tab, in this case Detail.

Next, add a footer using the following steps:

4. Right click on the Go to Footer button from the
Navigation group (see Figure 3-59) to move to the footer.

5. Place the cursor in the right section and type Prepared
by: followed by pressing the Underline key ten times.

6. Press the Return key and type Checked by: followed by
pressing the Underline key ten times.

7. Place the cursor in the center section and click the Page
Number button from the Header & Footer Elements
group.

8. Following “&[Page]” type of, including a space before
and after the of.

9. Click the Number of Pages button from the Header &
Footer Elements group and press the Enter button to
move it up one line.



10. Place the cursor in the left section, click the Current
Date button from the Header & Footer Elements group,
type the Space bar, and click the Current Time button
from the Header & Footer Elements group.

11. Press the Enter key to move to the following line and
click the File Path button from the Header & Footer
Elements group.

12. The Footer should look like Figure 3-63. When the cur-
sor is moved from the left section of the footer, the
&[Date] &[Time] will be replaced with the current date
and time and the &[Path]&[File] will be replaced with
the path and file name.

13. Click on any cell to return to the worksheet.

14. Click on the View menu tab and click on the Normal
button (shown in Figure 3-62) to return to the Normal
view.

15. Save the workbook by clicking on the Save button on
the Quick Access toolbar or typing Ctrl+S.

WRITING FORMULAS
Formulas allow Excel to perform simple or complex calcula-
tions. The formulas may contain mathematical calculations
and functions. In this segment, the writing of formulas is
discussed. Formulas may consist of numbers, variables, and
operators. Numbers are typed in from the key board and do
not change. Cells within the worksheets that are referenced
by the formula are known as variables. Variables are entered
by typing the cell reference or by selecting the cell with the
mouse while writing the formula.

Operators
Excel allows the use of the following operators:

� Equals Sign

� Plus Sign

� Minus Sign

* Multiplication Sign or Asterisk

/ Division or Backslash

( Opening Parentheses

) Closing Parentheses

^ Caret

For Excel to recognize the data being entered into a cell as
a formula, the formula must begin with an equal sign, a plus
sign, or a minus sign. If the user enters a plus sign, Excel will
change the plus sign to an equal sign. If the user enters a
minus sign, Excel will add an equal sign before the minus sign.

For each opening parenthesis there must be a closing
parenthesis. As the formula is entered, Excel will color code
the parentheses in pairs. Should the user forget to have an
equal number of opening and closing parentheses, Excel will
warn the user of the problem and suggest a correction.

The caret character allows the user to raise a value to a
power. For example, the mathematical function XY is written
in Excel as follows:

X^Y

The formula 4^2 is equal to 4 squared or 16. To find the
square root of a number, raise the number to the 0.5 power
as follows:

X^0.5

Order of Operation
Excel performs the calculation of a formula in the following
order:

First, the calculations enclosed by the parentheses are
performed, starting with the innermost pair and
working out to the outermost pair of parentheses.

Second, the variable or number raised to a power is
performed.

Third, multiplication and division are performed.

Finally, addition and subtraction are performed.

When two calculations have the same priority, they are
performed left to right.

For example, Excel calculates the following formula by
adding 2 and 1 together to get 3, then squaring the 3 to get 9,
adding 7 to the 9 to get 16, dividing the 16 by 4 to get 4, and,
finally, adding 1 to get 5:

� 5

� 4 � 1

� 16>4 � 1

� (9 � 7)>4 � 1

� (3^2 � 7)>4 � 1

� ((2 � 1)^2 � 7)>4 � 1
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FIGURE 3-63 Footer
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Editing Formulas
Existing formulas are edited by selecting the cell (clicking on
the cell) and editing the formula in the Formula bar. When
building complex formulas, it is a good idea to build formu-
las in steps, making sure each step of the formula works be-
fore adding the next step.

Absolute and Relative References
By default, when a cell is copied into the cell to the right, all of
the cell references move one cell to the right. Likewise, when a
cell is copied to the cell to the left, to the cell above, or to the
cell below, all of the cell references move one cell left, up, or
down, respectively. This is known as a relative reference be-
cause the cells used in the formula maintain the same relative
position with cells containing the formula. Figure 3-64 shows
what happens when Cell B2 contains a relative reference and
is copied to Cells A1 through C3.

The dollar sign ($) used in conjunction with a cell refer-
ence allows the user to fix a portion of the cell’s reference as
it is copied. For example, the use of a cell reference of $H22
fixes the column portion of the reference to the H column as
it is copied to other columns, allowing only the row reference
to change as it is copied to different rows. The column por-
tion of the reference would then be an absolute reference
and the row portion would be relative. Figure 3-65 shows
what happens when Cell B2 contains an absolute-column,
relative-row reference and is copied to Cells A1 through C3.

Likewise, the use of a cell reference of H$22 fixes the
row portion of the reference to the twenty-second row as it is
copied to other rows, allowing only the column reference to
change as it is copied to different columns. The row portion
of the reference would then be an absolute reference and the
column portion would be relative. Figure 3-66 shows what
happens when Cell B2 contains a relative-column, absolute-
row reference and is copied to Cells A1 through C3.

The use of a cell reference of $H$22 would fix both the
row and the column, preventing the row and column refer-
ence from being changed as the cell is copied. The entire

reference would then be an absolute reference. Figure 3-67
shows what happens when Cell B2 contains an absolute ref-
erence and is copied to Cells A1 through C3.

The user may move between the absolute and relative
reference types by highlighting the reference to be changed
and pressing the F4 key. This cycles the reference from rela-
tive, to both the column and rows being absolute, to only the
row being absolute, to only the column being absolute, and
back again to a relative reference.

Exercise 3-6

In this exercise you will explore absolute and relative refer-
ences. Begin by completing the following steps:

1. Begin by opening a new workbook. If Excel is not open,
open it. If Excel is open, type ctrl�N to open a new
workbook.

2. Type the data shown in Table 3-2 into the indicated
cells.

Next, create a relative reference using the following steps.

3. Type � B2 into Cell B6.

4. Copy Cell B6 to Cells A5 through C7 by right clicking
on Cell B6 and selecting Copy from the popup menu
(shown in Figure 3-17), selecting Cells A5 through C7,
and clicking on the Paste button from the Home tab
(shown in Figure 3-18).

TABLE 3-2 Data for Example 3-6

Cell Data Cell Data Cell Data

A1 1 B1 4 C1 7

A2 2 B2 5 C2 8

A3 3 B3 6 C3 9

FIGURE 3-64 Copying a Relative Reference

FIGURE 3-65 Copying an Absolute Column, Relative Row
Reference

FIGURE 3-66 Copying a Relative Column, Absolute Row
Reference

FIGURE 3-67 Copying an Absolute Reference
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Cells A5 through A7 should contain the numbers shown in
Figure 3-68.

Next, create an absolute reference using the following steps:

5. Type � $B$2 into Cell B10.

6. Copy Cell B10 to Cells A9 through C11.

Because it is an absolute reference, the formula in all of the cells
is the same as the formula entered into Cell B10; therefore, the
value in all of the cells is the same as the value in Cell B2 or 5.
Cells A9 through C11 should appear as they do in Figure 3-68.

Next, create a formula with an absolute row reference
using the following steps:

7. Type � B$2 into Cell B14.

8. Copy Cell B14 to Cells A13 through C15.

Because the row portion of the reference is an absolute refer-
ence, it does not change. The value for Cells A13 through A15
should be 2, the value for Cells B13 through B15 should be 5,
and the value for Cells C13 through C15 should be 8. Cells
A13 through C15 should appear as they do in Figure 3-68.

Next, create a formula with an absolute column refer-
ence using the following steps:

9. Type � $B2 into Cell B18.

10. Copy Cell B18 to Cells A17 through C19.

Because the column portion of the reference is an absolute ref-
erence, it does not change. The value for Cells A17 through C17
should be 4, the value for Cells A18 through C18 should be 5,
and the value for Cells A19 through C19 should be 6. Cells A17
through C19 should appear as they do in Figure 3-68.

11. Close the workbook without saving it.

BASIC FUNCTIONS
In addition to mathematical equations, computer func-
tions can also be included in the formulas. Functions are
entered by (1) typing the functions, (2) selecting the
Formulas menu tab, selecting the function category from
the Function Library group, and selecting the function
from the popup menu, or (3) by clicking on the Insert
Function button (shown in Figure 3-69) on the formula
bar to bring up the Insert Function dialogue box (shown in
Figure 3-70). This section covers the rounding functions
(including the CEILING and FLOOR functions), the SUM
function, the AVERAGE function, and the IF function.
Additional functions are available from the Insert Function
dialogue box.

From the Function dialogue box the user may make a
function available for selection by selecting All or the func-
tion’s category from the Or select a category: dropdown box.
Alternatively, the user may perform a key word search by
typing key words in the Search for a function: text box and
clicking on the Go button. When the function is shown in
the Select a function: list box, the user double clicks on the
function or selects the function and clicks on the OK button
to bring up the Function Arguments dialogue box. The
Function Arguments dialogue box for the ROUND function
is shown in Figure 3-71. Each function has its own Function
Arguments dialogue box.

The Function Arguments dialogue box prompts the
user for the information necessary to complete the function.
The user enters the requested information and clicks the OK
button to close the Function Arguments dialogue box and
create the function.

FIGURE 3-69 Insert Function Button

FIGURE 3-68 Spreadsheet for Exercise 3-6

FIGURE 3-70 Insert Function Dialogue Box
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FIGURE 3-71 Function Arguments Dialogue Box for the ROUND Function

Rounding
Excel provides the user three standard rounding func-
tions: (1) ROUND, which rounds to the closest number;
(2) ROUNDDOWN, which rounds the number down;
and (3) ROUNDUP, which rounds the number up. Each
of these functions requires the user to indicate the number
or cell containing the number to be rounded (Number)
and the number of digits to round to (Num_digits), in the
following format:

=ROUND(<Number>,<Num_digits>)

The user does not need to capitalize the word “round” be-
cause Excel will automatically capitalize the word “round”
when the formula is completed. Rounding to a positive num-
ber of digits represents the number of digits on the right side
of the decimal point. For example, if the number of digits
equals 2, the function rounds to hundredths. The function

=ROUND(123.228,2)

rounds 123.228 to 123.23. Figure 3-71 shows how this func-
tion would be set up using the Function Arguments dialogue
box for the ROUND function. Rounding to a negative num-
ber of digits represents the number of digits on the left side
of the decimal point. The function

=ROUND(123.228,-2)

rounds 123.228 to 100.00. The ROUNDUP function always
rounds the number up and the ROUNDDOWN function al-
ways rounds the number down. The function

=ROUNDUP(123.228,2)

rounds 123.228 up to 123.23, whereas the function

=ROUNDDOWN(123.228,2)

rounds 123.228 down to 123.22.
The three standard rounding functions can only be used

to round to decimal places, such as the hundreds, tens, whole
numbers, tenths, hundredths, and so forth. The rounding

functions will not round to quarters of a yard. For this we
must use the CEILING or FLOOR functions.

Ceiling
The CEILING function may be used to round up a number
to the next multiple of a specified number (referred to by
Excel as significance). For example, if the significance is 0.25,
the CEILING function will round up to the next 0.25 incre-
ment. The CEILING function requires the user to indicate
the number or cell containing the number to be rounded
(Number) and the significance, in the following format:

=CEILING(<Number>,<significance>)

For example, the function

=CEILING(123.228,0.25)

rounds 123.228 to 123.25. Figure 3-72 shows how this func-
tion would be set up using the Function Arguments dialogue
box for the CEILING function.

Floor
The FLOOR function works in the same way as the CEILING
function except it rounds down. For example, the function

=FLOOR(123.228,0.25)

rounds 123.228 to 123.00.

EXCEL QUICK TIP 3-4

Rounding to Nearest Quarter Yards

Excel’s rounding, CEILING, and FLOOR functions do
not allow the user to automatically round to the nearest
quarter-cubic-yards because Excel’s rounding functions
will only round to decimal places (such as hundredths,
tenths, tens, hundreds, and whole numbers) and the
CEILING and FLOOR functions only round up or down,
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FIGURE 3-72 Function Arguments Dialogue Box for the CEILING Function

not to the nearest quarter-cubic-yard. However, the user
can round to the nearest quarter-cubic-yards by convert-
ing the units to quarter-cubic-yards, rounding the num-
ber to a whole number, and converting back to cubic
yards. The formula for rounding a number in cubic yards
to the nearest quarter-cubic-yard is written as follows:

=ROUND(<Number>*4,0)/4

For example, the following function is used to round
123.228 cubic yards to the nearest quarter-cubic-yard:

=ROUND(123.228*4,0)/4

The function first multiplies 123.228 cubic yards by 4 to
get 492.912 quarter-cubic-yards, rounds 492.912 quarter-
cubic-yards to 493 quarter-cubic-yards (the nearest whole
number), and then divides 493 quarter-cubic-yards by 4 to
get 123.25 cubic yards. Formulas can be written for other
fractions of a whole number by using the same concepts.

Sum
The SUM function adds a group of numbers. It is particu-
larly useful when adding a column, row, or block numbers,
inasmuch as only the cells containing the first and last num-
ber need to be included in the formula. The SUM function is
written as follows:

=SUM(<Beginning Cell>:<Ending Cell>)

In Excel, the formula

=SUM(C1:C5)

adds the numbers in Cells C1, C2, C3, C4, and C5.
Noncontiguous cells may be added by placing a comma be-
tween the cells references. The formula

=SUM(C1:C5,D17)

adds the numbers in Cells C1, C2, C3, C4, C5, and D17. The
SUM function is quickly inserted into a cell by clicking on the
Formula menu tab and clicking on the AutoSum button in
the Function Library group. The AutoSum button is shown in
Figure 3-73. The AutoSum will place a moving dashed line
around the cells that Excel thinks the user wants to sum. If the
user wants to include different cells, the user must select the
cells. The AutoSum is completed by pressing the Enter key.

Average Function
The AVERAGE function allows the computer to average the
values in a range of cells. Only the cells containing numbers
are included in the average. The AVERAGE function is writ-
ten as follows:

=Average(<Beginning Cell>:<Ending Cell>)

In Excel, the formula

=Average(C1:C5)

takes the average of the numbers in Cells C1, C2, C3, C4, and
C5, ignoring blank cells and cells with text. If Cell C1 is 3;

FIGURE 3-73 Formulas: AutoSum Button
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Cell C2 is blank; Cell C3 contains the text “Joe”; Cell C4 is
10; and Cell C5 is 17, the AVERAGE function ignores Cells
C2 and C3 and averages Cells C1, C4, and C5 to get 10. This
example is shown in Figure 3-74.

The AVERAGE function may be typed directly into a cell
or may be quickly inserted into a cell by clicking on the arrow
below the AutoSum button (shown in Figure 3-73) in the
Function Library group on the Formula menu tab to bring
up the popup menu (shown in Figure 3-75) and selecting
Average from this menu. When selecting Average from the
popup menu, Excel will place a moving dashed line around
the cells that Excel thinks the user wants to average. If the user
wants to include different cells, the user must select the cells.
The AVERAGE is completed by pressing the Enter key.

IF Function
The IF function allows the computer to select between two
responses based on the value found in a specified cell. If the
value in the specified cell meets the test requirements, then
Excel does one thing, and if it does not meet the test require-
ment, it does another. The IF function is written as follows:

=IF(<logical_test>,<value_if_true>,

<value_if_false>)

The logical test consists of any statement that is either true
or false. The logical test should consist of (1) the cell to be
tested, (2) a logical operator that identifies the type of test
to perform, and (3) a cell, function, or value to test

against. Excel allows for the use of the following logical
operators:

> Greater Than

< Less Than

� Equal to

>� Greater Than or Equal to

<� Less Than or Equal to

<> Not Equal to

For example, the formula

=IF(B10=B32,0,10)

is equal to 0 if Cell B10 is equal to Cell B32 and is equal to 10
if Cell B10 is not equal to Cell B32. Figure 3-76 shows how
this function would be set up using the Function Arguments
dialogue box for the IF function.

The value_if_true and the value_if_false may contain
numbers, cell references, functions, and text. For example,
the formula

=IF(B10=B32,B34*B35,SUM(C17:C28))

is equal to Cell B34 multiplied by Cell B35 if Cell B10 is
equal to B32, and is equal to the sum of Cells C17 through
C28 if Cell B10 is not equal to Cell B32.

When using text for the value_if_true or the
value_if_false, the text is placed between quotation marks.
For example, the formula

=IF(B10=B32,“True”,“False”)

FIGURE 3-74 Average Example
FIGURE 3-75 Popup Menu

FIGURE 3-76 Function Arguments Dialogue Box for the IF Function



Introduction to Excel 45

is equal to “True” if Cell B10 is equal to B32, and is equal to
“False” if Cell B10 is not equal to Cell B32.

The user can select among more than two options by
creating nested IF functions: placing one IF function inside
another IF function, as follows:

=IF(B10<B32,-10,IF(B10>B32,10,0))

The logic for this function is shown in Figure 3-77. This func-
tion will first test to see if Cell B10 is less than Cell B32. If Cell
B10 is less than Cell B32, the function is equal to –10. If Cell
B10 is not less than Cell B32, the function will test to see if
Cell B10 is greater than Cell B32. If Cell B10 is greater than
Cell B32, then the function is equal to 10. If Cell B10 is not
greater than Cell B32, then Cell B10 must be equal to B32 be-
cause we have already checked and know that Cell B10 is not
less than Cell B32, and the function is equal to zero.

These functions are used in the following exercise.

Exercise 3-7

In this exercise you will practice using the rounding func-
tions, the SUM function, the AVERAGE function, and the IF
function. At the completion of this exercise your spreadsheet
should look like Figure 3-78.

1. Begin by opening a new workbook. If Excel is not open,
open Excel. If Excel is open, type Ctrl+N to open a new
workbook.

FIGURE 3-77 Nested IF function

FIGURE 3-78 Spreadsheet for Exercise 3-7

TABLE 3-3 Data for ROUND Function

Cell Data

B1 �ROUND(A1,2)
B2 �ROUNDUP(A1,2)
B3 �ROUNDDOWN(A1,2)
B4 �ROUND(A1*4,0)/4
C1 �ROUND(A1,0)
C2 �ROUNDUP(A1,0)
C3 �ROUNDDOWN(A1,0)
C4 �ROUND(A1,-2)
D1 �CEILING(A1,0.25)
D2 �CEILING(A1,2)
D3 �FLOOR(A1,0.25)
D4 �FLOOR(A1,2)

TABLE 3-4 Results for 57.3333

Cell Value Explanation

B1 57.33 Rounded to nearest hundredth

B2 57.34 Rounded up to nearest hundredth

B3 57.33 Rounded down to nearest hundredth

B4 57.25 Rounded to nearest quarter

C1 57 Rounded to nearest whole number

C2 58 Rounded up to nearest whole number

C3 57 Rounded down to nearest whole number

C4 100 Rounded to nearest hundred

D1 57.5 Rounded up to nearest quarter

D2 58 Rounded up to nearest even number

D3 57.25 Rounded down to nearest quarter

D4 56 Rounded down to nearest even number

In the first section you will work with the rounding func-
tions using the following steps:

2. Enter the data in Table 3-3 into the indicated cells.

3. Type 57.3333 in Cell A1. Cells B1 through C4 should
have the values shown in Table 3-4.



46 CHAPTER THREE

4. Experiment with the rounding function by changing
Cell A1 to different numbers.

5. Now change Cell A1 back to 57.3333.

In this next section you will sum Cells B1 through C4 with
the SUM function using the following steps:

6. Select Cell C5, click on the Formula menu tab, click on
the AutoSum button in the Function Library group
(shown in Figure 3-73), select Cell B1, hold down the
left mouse button, and drag the cursor to Cell C4. A
dashed line should be around Cells B1 through C4, and
�SUM(B1:C4) will appear in Cell C5.

7. Press the Enter key to complete the function. Cell C5
should now contain 501.25.

In this next section you will average Cells B1 through C4
with the AVERAGE function using the following steps:

8. Select Cell B5 and type �AVERAGE(B1:C4).

9. Press the Enter key to complete the function. Cell B5
should now contain 62.65625 when five decimal places
are shown.

In this next section you will create an IF function and a
nested IF function using the following steps:

10. In Cell C10, type �IF(A10<A11, "Less Than","Equal to
or Greater Than"). If the value in Cell A10 is less than the
value in Cell A11, the words Less Than will appear in Cell
C10. If Cell A10 is equal to or greater than Cell A11, the
words Equal to or Greater Than will appear in Cell C10.

11. In Cell C11, type �IF(A10<A11,"Less Than",IF(A10�A11,
"Equal to","Greater Than")). If the value in Cell A10 is less
than the value in Cell A11, the words Less Than will appear
in Cell C11. If Cell A10 is equal to Cell A11, the words
Equal to will appear in Cell C11. If Cell A10 is greater than
Cell A11, the words Greater Than will appear in Cell C11.

12. In Cell A10, type 10 and in Cell A11 type 11. The words
Less Than should appear in Cells C10 and C11.

13. In Cell A10, type 11. The words Equal to or Greater Than
should appear in Cell C10 and the words Equal to
should appear in Cell C11.

14. In Cell A10, type 12. The words Equal to or Greater Than
should appear in Cell C10 and the words Greater Than
should appear in Cell C11.

15. Close the workbook without saving it.

PRINTING
A worksheet is printed by clicking on the Print button on
the Quick Access toolbar or by opening the Print dialogue
box. By clicking on the Print button on the Quick Access
toolbar (shown in Figure 3-79) , the worksheet is printed
without giving the user a chance to change the printing set-
tings—which printer, number of copies, range, and so forth.
If the Print button does not appear on the Quick Access
toolbar, the user may add it by clicking on the arrow at the

FIGURE 3-79 Print Button

FIGURE 3-80 Customize Quick Access Toolbar Popup Menu

right of the Quick Access toolbar and selecting Quick Print
from the popup menu shown in Figure 3-80.

To open the Print dialogue box, shown in Figure 3-81
(Figure 3-82 for Excel 2007), the user may (1) type Ctrl+P
(type the P key while holding down the Ctrl key) or (2) se-
lect the File tab (the Microsoft Office button for Excel 2007)
and click on Print in the left pane to bring up the Print dia-
logue box.

For Excel 2010, the user can select the printer to be used
under Printer and set the properties for the printer by click-
ing on Printer Properties to bring up a dialogue box for the
printer. The user can select to print the active sheet, the en-
tire workbook, or only the selected area (the highlighted
cells) from the first settings dropdown box.

For Excel 2007, the user can select the printer to be
used in the Name: dropdown box and set the properties for
the printer by clicking on the Properties... button to bring
up a dialogue box for the printer. By selecting the Entire
workbook radio button, the user can print all of the work-
sheets in the workbook. By selecting the Selection radio
button, the user can print the selected (highlighted) cells of
a worksheet.
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FIGURE 3-82 Excel 2007 Print Dialogue Box

FIGURE 3-81 Excel 2010 Print Dialogue Box

Page Orientation
The orientation of the page is selected by clicking on the
Page Layout menu tab, clicking on the Orientation button
in the Page Setup group (shown in Figure 3-83), and clicking
on Portrait or Landscape from the popup menu.

Repeating Row at the Top of Each Page
Rows from the spreadsheet can be repeated at the top of each
page to create column headings. This is done by clicking on
the Page Layout menu tab, clicking on the Print Titles

FIGURE 3-83 Page Layout: Orientation Button
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button in the Page Setup group (shown in Figure 3-84) to
bring up the Sheet tab of the Page Setup dialogue box
(shown in Figure 3-85), typing the beginning row followed
by a colon followed by the ending row in the Rows to repeat
at top: text box, and clicking on the OK button to close the
Page Setup dialogue box. The settings in Figure 3-85 would
repeat the first row of the worksheet on every page printed.

Printing Gridlines
To have the grid line of the workbook print, the user must
check the Gridlines check box on the Sheet tab of the Page
Setup dialogue box (shown in Figure 3-85). Alternately, the
user may click on the Page Layout menu tab and check the
Print check box (shown in Figure 3-86) under the Gridlines
heading in the Sheet Options group.

Setting Print Scale
The area of a worksheet that fits onto one page is changed by
adjusting the scale in the Scale to Fit group on the Page
Layout menu tab (shown in Figure 3-87) or from the Page
Break Preview.

The worksheet may be scaled fit on one to nine pages
wide by selecting the number of pages wide from the Width:

dropdown box from the Scale to Fit group shown in Fig-
ure 3-87. Similarly, the worksheet may be scaled fit on one to
nine pages high by selecting the number of pages high from
the Height: dropdown box from the Scale to Fit group. To
scale the workbook to more than nine pages high or wide,
the user must open the Page tab of the Page Setup dialogue
box (shown in Figure 3-88) by clicking on the Page Layout
menu tab and clicking on the Page Setup Dialogue Box
Launcher located at the bottom-right corner of the Scale to
Fit group. The page width and height are set by clicking Fit
to: radio button and entering the number of pages wide and
high the printout is to be scaled to. Excel will then adjust the

FIGURE 3-84 Page Layout: Print Titles Button

FIGURE 3-86 Printing Gridlines

FIGURE 3-87 Page Settings: Scale to Fit Group

FIGURE 3-88 Page Tab of the Page Setup Dialogue BoxFIGURE 3-85 Sheet Tab of the Page Setup Dialogue Box
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scale to match the number of pages specified by the user. The
user must click on the OK button to close the Page Setup di-
alogue box.

The printout of the worksheet may be set to a specific
scale by clicking on the Page Layout menu tab and selecting
the scale from the Scale: box. By default the print scale is set
to Adjust to: with a scale of 100% of the normal size.

Setting Page Breaks
The layout of the page breaks is viewed and adjusted from
the Page Break View (shown in Figure 3-89). The Page Break
view is displayed by clicking on the Page Break button lo-
cated on the Status bar (shown in Figure 3-90) or by clicking
on the View menu tab and clicking on the Page Break
Preview button in the Workbook Views group (shown in
Figure 3-91).

The page breaks are moved by placing the cursor over
the page-break line to be moved, holding down the left
mouse button while dragging the page-break line to the de-
sired location, and releasing the mouse button. When the
page breaks are moved they automatically change the scaling
shown on the Page tab of the Page Setup dialogue box. The
user may return to the Normal view by clicking on the
Normal button located on the Status bar (shown in Fig-
ure 3-61) or by clicking on the View menu tab and clicking
on the Normal button in the Workbook Views group
(shown in Figure 3-62).

Exercise 3-8

In this exercise you will prepare the file from Exercise 3-5 to
be printed by changing the orientation to landscape, repeat-
ing Row 1 at the top of each page, and changing the scaling
to one page wide using the following steps:

1. Make sure that Chapter 3, the workbook modified in
Exercise 3-5, is open.

Next, change the page orientation to landscape using the fol-
lowing steps:

2. Click on the Page Layout menu tab, click on the
Orientation button in the Page Setup group (shown in
Figure 3-83), and click on Landscape from the popup
menu.

Next, set Row 1 to be repeated at the top of each page using
the following steps:

3. Click on the Page Layout menu tab, click on the Print
Titles button in the Page Setup group (shown in Fig-
ure 3-84) to bring up the Sheet tab of the Page Setup di-
alogue box (shown in Figure 3-85), type 1:1 in the Rows
to repeat at top: text box, and click on the OK button to
close the Page Setup dialogue box.

Next, you are going to set the spreadsheet so its width
matches the width of a piece of paper using the Page Break
Preview view. This is done by completing the following steps:

4. Click on the View menu tab and click on the Page Break
Preview button in the Workbook Views group (shown
in Figure 3-91) to bring up the Page Break Preview view.
The spreadsheet should look similar to Figure 3-89,
with a dashed blue line between columns J and K.

5. Using the cursor, drag the dashed line to the right side of
column L. This will reduce the printing size of the detail
sheet to one page wide.

6. Click on the View menu tab and click on the Normal
button in the Workbook Views group (shown in Fig-
ure 3-62) to return to the Normal view.

7. Click the Save button on the Quick Access toolbar or
type Ctrl+S to save the workbook.

TESTING SPREADSHEETS
Before using any spreadsheet for estimating, the user must
carefully test the spreadsheet to make sure it is performing the
calculations correctly. The object is to make the spreadsheet

FIGURE 3-89 Page Break Preview

FIGURE 3-90 Page Break View Button on the Status Bar

FIGURE 3-91 View: Page Break View Button
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foolproof. This is very important when someone other than
the spreadsheet designer is going to use the spreadsheet.
Foolproofing a spreadsheet is done by trying to find ways to
mess up the spreadsheet and then finding ways to prevent
this from happening. This is not as easy as it sounds because
there is always someone out there who will come up with a
new and creative way to mess things up. No spreadsheet can
be completely foolproof; therefore, it is important that the
user understand what the spreadsheet does and the limita-
tions of the spreadsheet. It is best if you test the spreadsheet
as you go rather than waiting until the spreadsheet is com-
plete. It is much easier to make small changes to the work-
sheet, solving the problems as you go, than it is to find a
small error in a large worksheet.

Cell Data Cell Data

B1 Code C2 General Requirements

C1 Description C3 Supervision

D1 Materials C4 Temporary Utilities

E1 Labor C5 Temporary Phone

F1 Equipment C6 Temporary Facilities

G1 Subcontract C7 Cleanup

H1 Total C9 EXISTING CONDITIONS

B2 01-000 C10 Demolition

B3 01-300 C12 CONCRETE

B4 01-500 C13 Rebar

B5 01-510 C14 Footing and Foundation—Labor

B6 01-520 C15 Footing and Foundation—Concrete

B7 01-700 C16 Slab/Floor—Labor

B9 02-000 C17 Slab/Floor—Concrete

B10 02-400 C18 Concrete Pump

B12 03-000 C19 Pre-cast Concrete

B13 03-200 C20 Light-weight Concrete

B14 03-300 C22 MASONRY

B15 03-310 C23 Masonry

B16 03-320 C25 METALS

B17 03-330 C26 Structural Steel

B18 03-340 C27 Joist and Deck

B19 03-400 C28 Metal Fabrications

B20 03-500 C29 Erection

B22 04-000 C31 WOOD, PLASTICS, AND
COMPOSITES

B23 04-200 C32 Rough Carpentry

B25 05-000 C33 Lumber

B26 05-100 C34 Trusses

B27 05-200 C35 Finish Carpentry

Cell Data Cell Data

B28 05-500 C36 Wood Trim

B29 05-900 C37 Cabinetry and Counter Tops

B31 06-000 C38 Counter Tops

B32 06-100 C40 THERMAL AND MOISTURE
PROTECTION

B33 06-110 C41 Waterproofing

B34 06-120 C42 Insulation

B35 06-200 C43 Rigid Insulation

B36 06-210 C44 Stucco

B37 06-400 C45 Siding

B38 06-410 C46 Roofing

B40 07-000 C47 Sheet Metal

B41 07-100 C48 Roof Specialties

B42 07-200 C49 Rain Gutters

B43 07-210 C50 Fireproofing

B44 07-220 C51 Caulking and Sealants

B45 07-400 C53 OPENINGS

B46 07-500 C54 Metal Doors and Frames

B47 07-600 C55 Wood Doors

B48 07-700 C56 Overhead Doors

B49 07-710 C57 Store Fronts

B50 07-800 C58 Windows

B51 07-900 C59 Hardware

B53 08-000 C60 Glass and Glazing

B54 08-100 C61 FINISHES

B55 08-110 C62 Drywall

B56 08-300 C63 Metal Studs

B57 08-400 C64 Ceramic Tile

B58 08-500 C65 Acoustical Ceilings

B59 08-700 C66 Flooring

Exercise 3-9

This exercise, when completed, will be used as the starting
point for the exercises in Chapter 32. In this exercise you will
setup the Summary Worksheet in the file from Exercise 3-8
using the following steps:

1. Make sure that Chapter 3, the workbook modified in
Exercise 3-8, is open.

2. Select the Summary tab.

Begin by entering the data into the cells using the following
steps:

3. Type the text shown in Table 3-5 into the specified cells.

TABLE 3-5 Data for Cells in Exercise 3-9
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4. Save the workbook by clicking on the Save button on
the Quick Access toolbar or typing Ctrl+S.

Next, format the cells to match those in Figure 2-2 using the
following steps:

5. Change the width of column A to 4, that of column B to
8, that of column C to 36, and that of columns D
through H to 12.

6. Bold the data in the following Cells: B2, C2, B9, C9, B12,
C12, B22, C22, B25, C25, B31, C31, B40, C40, B53, C53,
B61, C61, B70, C70, B76, C76, B79, C79, B82, C82, B85,
C85, B88, C88, B91, C91, B94, C94, B97, C97, B100,
C100, B104, C104, B116, C116, C123, C126, and C129.
Hint. Use the ctrl key to select multiple cells before
changing them to bold.

7. Change the height of Rows 8, 11, 21, 24, 30, 39, 52, 69,
75, 78, 81, 84, 87, 90, 93, 96, 99, 103, and 115 to 5. Hint.

Use the ctrl key to select multiple rows before changing
their height.

8. Select columns A through H, click on the View menu
tab, and click on Zoom to Selection, so that Columns A
through H cover the entire width of the spreadsheet.

9. Change the formatting for Columns D through H to
the accounting style using the Comma Style button
in the Number group on the Home menu tab and then
reduce the number of decimal points to zero by click-
ing the Decrease Decimal button in the Number group
on the Home menu tab twice.

10. Center the text in Column A by selecting Column A,
clicking the Home menu tab, and clicking on the Center
button in the Alignment group.

11. Center the text in Column B.

12. Center the text in Cells D1 through H1.

Cell Data Cell Data

B94 26-000 C104 EXTERIOR IMPROVEMENTS

B95 26-100 C105 Asphalt

B97 27-000 C106 Site Concrete—Labor

B98 27-100 C107 Site Concrete—Concrete

B100 31-000 C108 Rebar

B101 31-100 C109 Fencing

B102 31-200 C110 Retaining Walls

B104 32-000 C111 Dumpster Enclosures

B105 32-100 C112 Signage

B106 32-110 C113 Outside Lighting

B107 32-120 C114 Landscaping

B108 32-130 C116 UTILITIES

B109 32-300 C117 Water Line

B110 32-310 C118 Sanitary Sewer

B111 32-320 C119 Storm Drain

B112 32-330 C120 Gas Lines

B113 32-340 C121 Power Lines

B114 32-900 C122 Telephone Lines

B116 33-000 C123 SUBTOTAL

B117 33-100 C124 Building Permit

B118 33-300 C125 Bond

B119 33-400 C126 SUBTOTAL

B120 33-500 C127 Profit and Overhead Markup

B121 33-700 C128 Profit and Overhead

B122 33-800 C129 TOTAL

TABLE 3-5 (Continued)

Cell Data Cell Data

B60 08-800 C67 Wall Coverings

B61 09-000 C68 Paint

B62 09-200 C70 SPECIALTIES

B63 09-210 C71 Signage

B64 09-300 C72 Toilet Partitions

B65 09-500 C73 Toilet and Bath Accessories

B66 09-600 C74 Fire Extinguishers and Cabinets

B67 09-700 C76 EQUIPMENT

B68 09-900 C77 Appliances

B70 10-000 C79 FURNISHINGS

B71 10-100 C80 Window Treatments

B72 10-200 C82 CONVEYING EQUIPMENT

B73 10-210 C83 Elevators

B74 10-400 C85 FIRE SUPPRESSION

B76 11-000 C86 Fire Sprinklers

B77 11-300 C88 PLUMBING

B79 12-000 C89 Plumbing

B80 12-200 C91 HVAC

B82 14-000 C92 HVAC

B83 14-200 C94 ELECTRICAL

B85 21-000 C95 Electrical

B86 21-100 C97 COMMUNICATIONS

B88 22-000 C98 Communications

B89 22-100 C100 EARTHWORK

B91 23-000 C101 Clearing and Grubbing

B92 23-100 C102 Grading and Excavation
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13. Change the formatting for Cells D127 through H127 to
percentage using the Percent Style button in the
Number group on the Home menu tab, and then in-
crease the number of decimal points to one by clicking
the Increase Decimal button in the Number group on
the Home menu tab.

14. Underline Row 1 by selecting Cells A1 through H1 and
clicking the Bottom Borders button in the Font group
on the Home menu tab. If another border is shown in
the Borders button, select the correct border by clicking
on the small arrow to the right of the Borders button
and selecting the Bottom Border from the popup
menu.

15. Underline Rows 122, 125, and 128 in the same manner.

16. Save the workbook by clicking on the Save button on
the Standard toolbar or typing Ctrl+S.

Next, change the font for Column A so a checkmark (✓) can
be placed in the column indicating that the associated cost
code is needed for the bid. This is done as follows:

17. Select Column A and select Webdings from the Font
dropdown box in the Font group on the Home menu
tab. If Webdings is not available, try to find another font
that has a check mark or replace the check marks with
another symbol, such as an X.

18. Type an a in Cell A2, and a check mark (✓) should ap-
pear in Cell A2.

19. Delete the contents of Cell A2.

Headers and footers must be set up for each individual sheet.
Next, add a header and footer to the Summary worksheet
using the following steps:

20. Click on the Insert menu tab and click on the Header &
Footer button to edit the header.

21. Place the cursor in the center section and click the
Sheet Name button from the Header & Footer
Elements group. The header should look like the
header of Figure 3-56. When the cursor is moved
from the center section of the header, the &[Tab] will
be replaced with the name of the tab, in this case
Summary.

22. Right click on the Go to Footer button from the
Navigation group to move to the footer.

23. Place the cursor in the right section and type Prepared
by: followed by pressing the Underline key ten times.

24. Press the Return key and type Checked by: followed by
pressing the Underline key ten times.

25. Place the cursor in the center section and click the Page
Number button from the Header & Footer Elements
group.

26. Following “&[Page]” type of, including a space before
and after the of.

27. Click the Number of Pages button from the Header &
Footer Elements group and press the Enter button to
move it up one line.

28. Place the cursor in the left section, click the Current
Date button from the Header & Footer Elements group,
press the Space bar, and click the Current Time button
from the Header & Footer Elements group.

29. Press the Enter key to move to the following line and
click the File Path button from the Header & Footer
Elements group.

30. The Footer should look like Figure 3-63. When the cur-
sor is moved from the left section of the footer, the
&[Date] &[Time] will be replaced with the current date
and time and the &[Path]&[File] will be replaced with
the path and file name.

31. Click on any cell in the workbook.

Next, prepare the worksheet to be printed by repeating the
first row on each page, adding gridlines, and setting the page
breaks using the following steps:

32. Click on the Page Layout menu tab, click on the Print
Titles button in the Page Setup group to bring up the
Sheet tab of the Page Setup dialogue box, type 1:1 in the
Rows to repeat at top: text box, and click on the OK but-
ton to close the Page Setup dialogue box.

33. Click on the Page Layout menu tab and check the Print
check box under the Gridlines heading in the Sheet
Options group.

34. Click on the View menu tab and click on the Page Break
Preview button in the Workbook Views group to bring
up the Page Break Preview view.

35. Using the cursor, drag the horizontal page-break line
(the dashed line) at the bottom of Page 1 between Rows
60 and 61.

36. Drag the horizontal page-break line for the bottom of
Page 2 below Row 129.

37. If there are any vertical page-break lines, drag the page
break to the right side of Column H. The Summary
Worksheet should now be on two pages.

38. Click on the View menu tab and click on the Normal
button in the Workbook Views group to return to the
Normal view.

39. Click the Save button on the Quick Access toolbar or
type Ctrl+S to save the workbook.

When you print the Summary Worksheet, the worksheet
should be the same as Figure 2-2.

When you set up the Summary Worksheet for your com-
pany, you should use your company’s cost codes rather than
the ones used here. The formulas are added to the Summary
and Detail Worksheets in Chapter 32.
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CONCLUSION
Excel allows the user many ways to customize the look of the
spreadsheet and perform calculations. This chapter covered
how to manage workbooks and worksheets; enter data; for-
mat spreadsheets; write formulas; round numbers using the
rounding functions (including CEILING and FLOOR func-
tions); use the SUM, the AVERAGE, and IF functions; set up
and print the worksheets; and test worksheets. These skills
are needed to complete the Sidebar worksheets found in the
following chapters.

PROBLEMS
1. What is the difference between a workbook and a

worksheet?

2. What three ways can be used to save a workbook?

3. How are worksheets added to a workbook?

4. How can a copy of a worksheet be created?

5. How are worksheets renamed?

6. If you were to cut the contents from Cell H15 and then
save the worksheet, what would happen to the contents
from Cell H15?

7. Besides using the Column Width dialogue box, what are
two other ways to change the width of a column?

8. What are two ways to change the font for a cell?

9. What does the Merge and Center button do?

10. How do you add the worksheet name to the header of
the worksheet?

11. How do you add the date the worksheet was printed to
the header of the worksheet?

12. What is the caret (^) used for?

13. List the calculation steps taken to solve the following
formula: (2^5+4/2)*2-1.

14. Cell C17 was copied to Cells B16 through D18, and the
content of Cell C17 is $B5. What are the contents of
Cells B16 through D18?

15. What value would Excel calculate for the formula
ROUND(122.568,-1)?

16. What value would Excel calculate for the formula
ROUNDUP(17.222,1)?

17. When A12 equals 17, what value would Excel calculate
for the formula IF(A12>10,"Error","OK")?

18. When A12 equals 25, what value would Excel calculate
for the formula IF(A12<0,"Error",IF(A12>20,"Error"
"OK"))?

19. How are rows of a spreadsheet repeated at the top of
every page?

20. What is the page break view used for?
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Chapter 4 Fundamentals of the Quantity Takeoff

Chapter 5 Concrete

Chapter 6 Masonry

Chapter 7 Metals

Chapter 8 Woods, Plastics, and Composites

Chapter 9 Thermal and Moisture Protection

Chapter 10 Openings

Chapter 11 Finishes

Chapter 12 Fire Suppression

Chapter 13 Plumbing

Chapter 14 Heating, Ventilation, and Air-Conditioning (HVAC)

Chapter 15 Electrical

Chapter 16 Earthwork

Chapter 17 Exterior Improvements

Chapter 18 Utilities

I
n this section, you will be introduced to the quantity takeoff. The purpose
of this section is not to provide an all-inclusive list of equations and tables
to determine the quantities of every conceivable component on a con-

struction project, but to provide basic quantity takeoff concepts and show
how these concepts can be applied to common estimating situations. The
basic concepts are covered in Chapter 4. Chapters 5 through 18 apply these
concepts to common estimating situations grouped by MasterFormat divi-
sion. The 2004 MasterFormat moved most of the site work previously located
in Division 2 to Divisions 31 to 35. This book covers Division 31—Earthwork
(Chapter 16), Division 32—Exterior Improvements (Chapter 17), and
Division 33—Utilities (Chapter 18). The 2004 MasterFormat also divided
Division 15—Mechanical into three divisions: Division 21—Fire
Suppression, Division 22—Plumbing, and Division 23—Heating, Ventilating,
and Air Conditioning. It also moved Division 16—Electrical to Division 26.
In this book the quantity takeoff topics are covered in the order in which they
appear in the 2004/2010 MasterFormat, beginning with concrete and ending
with utilities. If the reader is more comfortable learning about estimating
using the order of the old MasterFormat, then after completing Chapter 4, he
or she can complete Chapters 16 through 18 before starting Chapter 5. Not all
divisions of the MasterFormat are covered. For example, Divisions 10 through
14 are not covered because they are often a matter of counting the items.

P A R T T W O

THE QUANTITY 
TAKEOFF
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In this chapter you will be introduced to the process of com-
pleting the quantity takeoff and the basic methods of deter-
mining the quantities for counted items (both nonrepetitive
and repetitive members), linear components, sheet and roll
goods, volumetric goods, and quantity-from-quantity goods.
The purpose of this chapter is to introduce you to the basic
concepts used in the quantity takeoff, not to make you profi-
cient in them. As you complete Chapters 5 through 18 you
will see how these concepts apply to specific construction
components, and your understanding of these concepts will
be solidified.

The quantity takeoff is the process whereby the esti-
mator prepares a complete list of all building com-
ponents that need to be constructed to complete

the project. The quantity takeoff may also be called the
quantity survey. The quantity takeoff includes components
that are incorporated into the building (for example, foot-
ings, masonry walls, and windows) as well as jobsite or di-
rect overhead. Jobsite or direct overhead includes all items
that are needed to support construction that can be identi-
fied with a specific project, such as supervision and tempo-
rary facilities.

Commonly used units for the quantity takeoff include
feet or lineal feet, square feet, board feet, square yards, cubic
yards, acres, each, months, and lump sum. Months are used
when the quantity of an item is based on the duration of the
project, such as office trailer rental. Lump sum is used when
multiple items are combined into a single item for pricing,
such as all of the plumbing. The selection of takeoff units is
determined by the way the bid is to be priced. For a concrete
slab on grade, the concrete is priced in cubic yards, the
forming in lineal feet, the labor to pour the concrete in
cubic yards, and the labor to finish the slab in square feet or
square yards.

PERFORMING A QUANTITY
TAKEOFF
While performing the quantity takeoff the estimator needs
to determine all the materials, equipment, and labor tasks
needed to complete the construction of the project. The
most accurate method of doing this is for the estimator to
build the construction project in his or her mind while
recording the materials, equipment, and labor tasks needed
to complete the work.

To demonstrate this, let’s look at the construction of the
prehung door shown in Figure 4-1. To construct the door,
the worker would begin by cutting the two side jambs and
top jamb to length. Next, the worker would rabbet the top of
the side jambs to receive the top jamb, mortise one of the
side jambs for the hinges, mortise the other side jamb for the
bolt and strike, and staple the top and side jambs together to
complete the door frame. Next, the worker would cut stops
for the top and side jambs and staple the stops to the jambs.
The worker then would mortise the door slab for the hinges
and drill the holes for the door handle. Finally, the worker
would fasten the hinges to the door slab and the door frame
to complete the prehung door. The door is now ready to in-
stall or to be packaged for shipping to the jobsite.

The materials needed to complete the prehung door are
shown in Table 4-1. The materials are listed in the order they
were used to complete the prehung door.

The labor tasks required to complete the prehung door
are shown in Table 4-2. Again they are listed in the order in
which they are performed. Often on construction projects,
the estimator will combine a number of labor tasks into a sin-
gle task. In the case of the prehung door, the labor tasks could
be combined into a single task entitled assemble prehung door.

Finally, let’s look at the equipment needed to complete
the prehung door. To determine the equipment needed, the
estimator must determine the equipment that will be used

FUNDAMENTALS OF THE

QUANTITY TAKEOFF

CHAPTER FOUR
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FIGURE 4-1 Prehung Door

TABLE 4-1 Materials for a 2�6� � 6�8� Prehung Door

Quantity Item

2 ea 4 5/8� � 6�10� Jamb

1 ea 4 5/8� � 2�6 3/4� Jamb

2 ea 3/8� � 1 1/4� � 6�9� Stop

1 ea 3/8� � 1 1/4� � 2�6� Stop

1 ea 2�6� � 6�8� Door Slab

3 ea Hinges

TABLE 4-2 Labor Tasks and Equipment for a 
2�6� � 6�8� Prehung Door

Labor Task Equipment

Cut jambs Miter saw

Rabbet side jambs Router

Mortise side jambs Router

Staple jambs together Staple gun and compressor

Cut stops Miter saw

Staple stops to jambs Staple gun and compressor

Mortise door slab Router

Drill door slab for handles Drill

Fasten hinges to jamb and slab Drill

WORK PACKAGES
As the estimator performs the quantity takeoff the materials,
equipment, and labor tasks must be divided into work pack-
ages. A work package is a group of items that are related. At a
minimum the quantity takeoff should be broken down by
the job cost codes to be used on the job. Sample job cost
codes are shown in Appendix B. The job cost codes are used
to track the material, labor, and equipment costs on the job,
and, as such, a budget will need to be established for each of
the job cost codes.

A single job cost code may be broken down into multi-
ple work packages because the materials are ordered at dif-
ferent times. For example, the lumber for a three-story
building may be ordered in the following lumber packages:
first-floor walls, floor between the first and second floors,
second-floor walls, floor between the second and third
floors, third-floor walls, and roof. To facilitate the ordering
of these materials in lumber packages, the estimate must be
grouped by work packages that divide the work into the
first-floor walls, the floor between the first and second
floors, and so forth.

The work packages also should match the way the work
on the project is scheduled. The estimate for the labor hours
should be used to determine the durations for the schedule.
As a result, the work packages should also match the sched-
uling tasks.

As the estimator develops the work packages, he or she
must make sure everything needed for the work packages is
included in the work package at the point it will be first in-
stalled. For example, if the footing and foundation wall
shown in Figure 4-2 are to be included in separate work pack-
ages, the footing package would consist of the forms for the
footing, the four #4 continuous rebar, the #5 dowels, and the
concrete for the footing. The #5 dowels, even though they are
part of both the footing and foundation, will need to be in-
stalled with the footing; therefore, they are part of the footing
package. The foundation wall package would consist of the
forms for the foundation, the #4 rebar located at the top and

by the worker while completing the labor tasks. The equipment
needed to complete the labor tasks is shown in Table 4-2. To
complete the prehung door, the worker will need a miter saw to
cut the jambs and stop; a router with the appropriate bits to
rabbet the jambs and mortise the jambs and the door slab; a
staple gun and compressor to assemble the jambs and stops;
and a drill with the appropriate bits to drill the door slab and
attach the hinges. This equipment will vary based on the con-
struction techniques used by the worker. For example, if the
worker constructs the frame with nails rather than staples, he
or she would need a nail gun in place of a staple gun.

This same method is used on a large, complex building.
The estimator begins at the bottom of the building and con-
structs it from the ground up: first the excavation, then the
footings, the foundation, and so forth.
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bottom of the wall, the #4 rebar at 12 inches on center run-
ning vertical and horizontal, concrete for the walls, and the
anchor bolts. The anchor bolts, although they are often con-
sidered part of the lumber package, need to be included in the
foundation wall package because they will be installed at the
time the foundation wall is poured. The same is the case with
seismic straps that are poured into the foundation wall.

One of the great advantages of building the project in
the estimator’s mind is that he or she can organize the mate-
rial orders by work packages and collect the data needed to
prepare the schedule at the same time he or she prepares the
estimate.

COMMUNICATION
WITH THE FIELD
To eliminate many potential problems and delays, the esti-
mator must communicate to field employees the planned
method of construction and the usage of materials and
equipment. If the field employees use different construction
methods or different materials or equipment, the materials
and equipment ordered based on the estimator’s quantity
takeoff may be insufficient. This is shown in the following
case study.

A project contained a small, slab-on-grade office build-
ing with an attic. The construction between the office and the
attic consisted of 2×12 wood joists as shown in Figure 4-3.

To avoid the expense of ordering 22-foot-long joists, the
estimator planned to break the joists along the bearing walls
and ordered nine 8-foot joists, ten 10-foot joists, ten 12-foot
joists, and nine 14-foot joists. The estimator planned that the
carpenters would use the joists as shown in Figure 4-4.

The carpenters, not knowing how the estimator had bid
the materials, decided to add a header as shown in Figure 4-5.
The materials needed by the carpenters were nineteen 8-foot
joists and twenty-one 14-foot joists. As a result the carpenters
ran short of ten 8-foot joists (which they cut from 12-foot
joists), and twelve 14-foot joists had to be ordered from the
lumber yard, causing additional expense and construction
delays. These costs and delays could have been avoided had

FIGURE 4-2 Wall Section

FIGURE 4-3 Floor Design
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FIGURE 4-4 Estimator’s Material Order

FIGURE 4-5 Field Material Use

the estimator provided the carpenters a figure similar to
Figure 4-4 to show the planned material usage on the build-
ing. This can be accomplished by redlining the framing plan
in Figure 4-3.

As the estimator builds the project in his or her mind
the materials can be grouped into five broad categories:
counted items, linear components, sheet and roll goods, vol-
umetric goods, and quantity-from-quantity goods. The

principles for estimating each of these broad categories are
applied to many different materials. For example, the princi-
ples for estimating the number of rolls of building felt
needed for a roof are the same principles used to estimate
the number of rolls of wire mesh that are needed in a slab.
The remainder of this chapter looks at these general princi-
ples, which are applied to specific materials in Chapters 5
through 18.
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COUNTED ITEMS
The simplest way to determine the quantity of an item is to
count the number of items. There are shortcut methods that
may be used when the counted items are repetitive members
such as studs in a wall. The most common unit for the quan-
tity takeoff of counted items is each.

Items that may be estimated as counted items include
rebar in spot footings, dowels, anchor bolts, steel lintels, timber
brackets, metal stairs, steel beams and columns, steel joists, steel
trusses, joist headers, joist hangers, wood columns and beams,
wood joists, wood studs, wood trusses, wood rafters, cabinetry,
residential doors and windows, hollow-metal doors, hardware,
overhead doors, metal studs, many HVAC and plumbing com-
ponents, electrical fixtures, and landscaping plants.

When counting items it is important to mark the items
off as they are counted to avoid counting an item twice. Care
also must be exercised to ensure that all of the items are
counted. After counting the items one must review the draw-
ings to make sure that no items have been missed. When
counting items, care must be taken to avoid grouping similar
but different items together. For example, when counting
doors in a residence, closet doors, which have a simple pas-
sage lockset, must be kept separate from bedroom and bath-
room doors, which require a privacy lockset. This slight dif-
ference in items, a passage versus a privacy lockset, may only
amount to a few dollars in material costs, but can be very
costly in both labor costs and construction delays if the
wrong materials are delivered to the jobsite.

When counted items are repetitive, as with studs in a
wall, time is saved by using a mathematical equation to count
the number of studs needed. The following equation is used
to calculate the number of respective members over a speci-
fied distance and includes a repetitive member at both ends:

(4-1)

where

Number � Number of Counted Items

Distance � Distance over Which the Items Occur

Spacing � Spacing between the Items

The distance and spacing should be measured in the same
units (feet or inches), or a conversion factor needs to be in-
cluded in the equation. The 1 in this equation adds a repetitive
member to the beginning of the distance (hereafter referred to
as the end condition). This is shown in the following example.

EXAMPLE 4-1

Determine the number of studs needed for a 4-foot-long wall
where the studs are spaced at 1 foot on center.

Solution: The number of studs is calculated using Eq. (4-1) as
follows:

Number �
4 ft

1 ft
� 1 � 5

Number �
Distance

Spacing
� 1

Five studs allows for one stud at the left end, one at 1 foot from the
end, one at 2 feet from the end, one at 3 feet from the end, and one
at the right end, as shown in Figure 4-6. �

If a repetitive member is only needed at one end, then Eq. (4-1)
can be written as follows:

(4-2)

If a repetitive member is not needed at either end, then Eq. (4-1)
can be written as follows:

(4-3)

When calculating the number of repetitive members, one
must be careful to make sure that the distance and spacing
are converted to the same units; otherwise, the number will
be off by a significant amount.

When using Eqs. (4-1) through (4-3), one must round
up the quantity to the next whole number to have adequate
materials, as shown in the following example.

EXAMPLE 4-2

Determine the number of studs needed for a wall 3 feet 4 inches
long where the studs are spaced at 1 foot on center.

Solution: This example is the same as Example 4-1, except that the
wall is 8 inches shorter. The number of studs is calculated using
Eq. (4-1) as follows:

Using conventional rules of rounding, one would round this down
to 4, leaving the estimate 1 stud short of the needed number of
studs. Rounding this up, one gets 5 studs, the number of studs
needed to complete this wall. The stud placement for this wall is
shown in Figure 4-7.

Number �
3 ft!4 in

1 ft
� 1 � 4.33

Number �
Distance

Spacing
� 1

Number �
Distance

Spacing

FIGURE 4-6 Stud Placement

FIGURE 4-7 Stud Placement �
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FIGURE 4-8 Connection of Linear Components

LINEAR COMPONENTS
Linear components are components that are measured by
their length. When a linear component is composed of mul-
tiple pieces, the pieces may be attached by butting one piece
to another piece or overlapping the pieces as shown in
Figure 4-8. Common units for linear components include
lineal feet (often referred to as feet) or each when the compo-
nent is composed of pieces. Items that may be estimated as
linear components include footing forms, rebar for continu-
ous footings, steel handrails, wood sills, blocking, top and
bottom plates, fascia, soffit, cant strips, wood trim, sheet
metal, cabinetry, rubber base, and fencing.

The linear feet of a component is often measured di-
rectly off of the plans by using a scale, plan measurer, digi-
tizer, or computer takeoff package. The number of pieces
that are needed for a linear component is calculated using
the following equation:

(4-4)

where

Number � Number of Pieces Needed

Length � Length of Linear Component

Effective Length � Distance between the Start of the
Pieces

The effective length is shown in Figure 4-9.
The effective length is equal to the length of the pieces

that make up the component less the length of the lap and is
written as follows:

(4-5)

where

LengthPiece � Length of the Pieces That Make up the
Linear Component

Lap � Length of the Lapping of the Pieces

When calculating the number of linear components,
one must be careful to make sure that the length and spacing

Effective Length � LengthPiece � Lap

Number �
Length

Effective Length

are converted to the same units; otherwise, the number will
be off by a significant amount.

Substituting Eq. (4-5) into Eq. (4-4), we get the following:

(4-6)

When the pieces are butt jointed, the lap is zero, and we get
the following equation:

(4-7)

These equations ignore the end conditions, such as the
cover over the end of the rebar, and the fact that unless the
linear component makes a complete circle, there is one less
lap than there are pieces. In most cases, this provides a
slight increase in the materials calculated over the actual
materials needed. These effects are shown in the following
example.

EXAMPLE 4-3

Determine the number of 20-foot-long pieces of rebar that are
needed to complete a 40-foot-long footing. The pieces are spliced
with a lap of 2 feet and form a single bar running the length of the
footing. Three inches of cover over the rebar is required at each end
of the footing.

Solution: The number of pieces is calculated using Eq. (4-6) as
follows:

This is slightly more than the required amount. The first piece will
start 3 inches from the end of the footing and end 20 feet 3 inches
from the end of the footing. The second piece will start at 18 feet
3 inches, lapping the previous bar by 2 feet, and end at 38 feet
3 inches. The third, and final, piece will start at 36 feet 3 inches and
end at 39 feet 9 inches. The third piece is 3 feet 6 inches long or
0.175 (3.5 ft>20 ft) of a 20-foot-long bar.

Linear components should be rounded up to the next whole
number to make sure that there are adequate materials. �

SHEET AND ROLL GOODS
Sheet and roll goods are components that are measured by
their area. When sheet and roll goods are composed of mul-
tiple pieces, the pieces are attached by butting or lapping
them together in two directions, as shown in Figure 4-10. In

Number �
Length

LengthPiece � Lap
�

40 ft

20 ft � 2 ft
� 2.22 pieces

Number �
Length

LengthPiece

Number �
Length

LengthPiece � Lap

FIGURE 4-9 Effective Length



The laps at the end and sides of a roll or sheet may be
different or they may be the same.

The effective area for spaced pieces equals the effective
length times the effective width of the piece. The effective
length equals the length plus one-half of the spacing around
the piece as shown in Figure 4-11.

Therefore, the effective length equals the length plus
two times one-half of the spacing around the piece or the
length of the piece plus the width of one space. The effec-
tive width equals the width plus the width of one space.
The effective area for spaced pieces is calculated by the fol-
lowing equation:

(4-11)

Care must be taken when using the area method be-
cause it ignores edge conditions and may underestimate the
quantities needed to complete the work, as seen in the fol-
lowing example.

EXAMPLE 4-4

A 21-inch-high by 48-inch-long wall is constructed of 15 5>8-inch-
long by 7 5>8-inch-high block. The mortar joints between the
blocks are 3>8 inch thick. How many blocks are needed to construct
the wall?

Solution: Using Eq. (4-11), we calculate the effective area of one
block as follows:

The area of the wall is calculated as follows:

The number of blocks is calculated using Eq. (4-8) as follows:

Number �
1,008 in2

128 in2 � 7.87 blocks

Area � (Length)(Height) � (48 in)(21 in) � 1,008 in2

� (16 in)(8 in) � 128 in2

Effective Area � (15 5>8 in � 3>8 in)(7 5>8 in � 3>8 in)

� (Length � SpaceLength)(Width � SpaceWidth)
Effective Area
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other cases, such as with brick, a space is placed between the
pieces that is filled with another material, such as mortar.
Common units for sheet and roll goods include square feet,
square yards, squares (100 square feet), or each when the
component is composed of pieces.

The key difference between sheet goods and roll goods
is that the length of rolled goods is much greater than their
width. Items that may be estimated as sheet goods include
concrete wall forms, face brick, block and structural brick,
steel deck, tongue and groove sheeting, oriented strand
board (OSB) sheathing, wood decks, wood siding, building
paper, ridged insulation, asphalt shingles, membrane roof-
ing, siding, drywall, ceramic tile, acoustical tile, and vinyl
composition tile (VCT). Items that may be estimated as roll
goods include wire mesh, building paper, vinyl, and carpet.

The quantities for sheet and roll goods can be deter-
mined by one of two methods: the area method and the row
and column method.

Area Method
The area method determines the quantities of materials
needed by determining the area to be covered by the materi-
als and dividing it by the area covered by one sheet or roll of
the materials as shown in the following equation:

(4-8)

where

Number � Number of Pieces Needed

Area � Area to Be Covered

Effective Area � Area Covered by One Piece Including
Spacing or Lap

The effective area for butt-jointed pieces equals the
length times the width of the piece and is calculated by the
following equation:

(4-9)

The effective area for lapped pieces equals the effective
length times the effective width of the piece. The effective
length equals the length less one lap joint, just as it did with
linear components. The effective width equals the width less
one lap joint. The effective area for lapped pieces is calcu-
lated by the following equation:

(4-10)� (Length � LapLength)(Width � LapWidth)
Effective Area

Effective Area � (Length)(Width)

Number �
Area

Effective Area

FIGURE 4-10 Lapping of Sheet and Roll Goods

FIGURE 4-11 Effective Area for Spaced Pieces
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Using the area method, we would have ordered eight blocks. The
blocks would be laid out as shown in Figure 4-12. The first row
would require three blocks. The second row would require three
blocks, with one of the blocks being cut in half and each half placed
on either end of the row. The top row will require three blocks cut
to a height of about 5 inches. From this example we see that we
would need nine rather than eight blocks because the waste from
the cut blocks cannot be spliced together to form a new block. This
waste is unavoidable. �

Row and Column Method
Example 4-4 introduces us to the other method for calcu-
lating the quantities for sheet and roll goods: the row and
column method. With the row and column method, one
determines the number of rows and the number of
columns needed to construct the components. The number
of rows is calculated using Eq. (4-12) for lapped compo-
nents, Eq. (4-13) for butt-jointed components, and Eq. (4-14)
for spaced components:

(4-12)

(4-13)

(4-14)

These equations should be familiar because they are sim-
ilar to those used for linear components. When determining
the number of rows, one should always round up, unless the
fraction of a row is less than the lap. Rounding up should be to
the next whole number, 1>2, 1>3, 1>4, or 1>n (where n is a
whole number) fraction of a sheet or roll. Rounding up to 2>5,
for example, will give you the wrong quantity because 1>5 of
the material will be wasted when you take two pieces that are
2>5 of a sheet; therefore, 2/5 should be rounded up to 1>2,
which will properly take the waste into account.

The number of pieces per row (hereafter referred to as
columns) is calculated using Eq. (4-15) for lapped compo-
nents, Eq. (4-16) for butt-jointed components, and Eq. (4-17)
for spaced components:

(4-15)NumberColumns �
Length

LengthPiece � Lap

NumberRows �
Height

HeightPiece � Space

NumberRows �
Height

HeightPiece

NumberRows �
Height

HeightPiece � Lap

(4-16)

(4-17)

Width may be substituted for Height and WidthPiece for
HeightPiece in Eqs. (4-12) through (4-14) for horizontal sur-
faces such as slabs on grade.

The number of pieces is then determined by multiply-
ing the number of rows by the number of columns using the
following equation:

(4-18)

EXAMPLE 4-5

Solve Example 4-4 using the row and column method. How many
blocks are needed to construct the wall?

Solution: Using Eq. (4-14) to find the number of rows, we get the
following:

Three rows of blocks are needed. Using Eq. (4-17) to get the num-
ber of columns, we get the following:

Three columns of blocks are needed. Using Eq. (4-18), we calculate
the number of blocks needed as follows:

�

The row and column method calculates the correct
number of blocks needed to construct the wall, and it is
easy to see that the entire top row of blocks will need to be
cut. This allows the estimator to take this into account as
he or she calculates the labor for the installation of the
block.

VOLUMETRIC GOODS
Volumetric goods are commonly measured in cubic yards or
cubic feet. Items that may be estimated as volumetric goods
include concrete, excavation, and asphalt. The quantity of
rectangular column-shaped volumetric goods is calculated
by multiplying the height by the width by the length as ex-
pressed in the following equation:

(4-19)

Chapter 16 discusses four additional methods for cal-
culating the volume of excavation. These are the average-
width-length-depth method, average-end method, modified-
average-end method and cross-sectional method. Appendix A
has additional formulas that may be used to calculate the vol-
ume of a cylinder, prism, cone, and pyramid.

Volume � (Height)(Width)(Length)

Number � (3 rows)(3 columns) � 9 blocks

NumberColumns �
48 in

15 5>8 in � 3>8 in
�

48 in

16 in
� 3 columns

NumberRows �
21 in

7 5>8 in � 3>8 in
�

21 in

8 in
� 2.625 rows

Number � (NumberRows)(NumberColumns)

NumberColumns �
Length

LengthPiece � Space

NumberColumns �
Length

LengthPiece

FIGURE 4-12 Block Layout
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EXAMPLE 4-6

Determine the volume of a 100-foot by 100-foot concrete slab. The
slab is 4 inches thick. Express your answer in cubic yards.

Solution: The volume of the slab is determined by Eq. (4-19) as
follows:

�

QUANTITY-FROM-QUANTITY
GOODS
Quantity-from-quantity goods are estimated based upon the
quantity of another item. For example, the number of gallons
of paint may be estimated by dividing the area of the surface
to be painted by the coverage rate for a gallon of paint.
Alternately, roofing nails may be estimated by multiplying the
area of the roof in squares (100 square feet) by the average
number of nails used per square. Items that may be estimated
by the quantity-from-quantity method include mortar, per-
lite, fasteners, saw blades, waterproofing and dampproofing,
blown insulation, stucco, shims, drywall tape and mud, adhe-
sives, grout, tack strip and seaming tape for carpet, paint, and
electrical wiring. Quantity-from-quantity estimates are per-
formed using one of the following equations:

(4-20)

where

Quantity � Quantity of Material Needed

QuantityBase � Quantity of the Item that the Estimate
is Based Upon

Coverage � Coverage of the Material Needed

(4-21)

where

Quantity � Quantity of Material
Needed

QuantityBase � Quantity of the Item
that the Estimate is
Based Upon

Average Quantity Required � Average Quantity
Needed to Cover One
Unit of Base Material

The coverage and average quantity required may be obtained
from historical data, manufactures’ data, or reference books.
Estimating the quantity from quantity is shown in the fol-
lowing two examples:

EXAMPLE 4-7

Determine the quantity of paint needed to paint 5,000 square feet
of wall. One gallon of paint will cover 300 square feet of wall.

� (QuantityBase)(Average Quantity Required)

Quantity

Quantity �
QuantityBase

Coverage

Volume � (100 ft)(100 ft)a 4 in

12 in/ft
ba 1 yd3

27 ft3b � 123.5 yd3

Solution: Using Eq. (4-20), we get the follow quantity:

�

EXAMPLE 4-8

Determine the quantity of roofing nails needed for a 14 square
(square � 100 square foot) roof. Historically, 340 nails are needed
per square.

Solution: Using Eq. (4-21), we get the follow quantity:

�

WASTE
Ordering the foregoing quantities may not provide the quan-
tities necessary to complete the construction project because
some of the materials are lost because of waste. Unavoidable
waste is waste that is the result of not being able to use scrap
materials (as we saw in Examples 4-4 and 4-5). Avoidable
waste is waste that is due to improper use of materials, lost or
damaged materials, and the difference between the actual di-
mensions and the design dimensions. Where possible, un-
avoidable waste should be included in the original quantity
takeoff of the materials as it was in Example 4-5. This is neces-
sary to accurately track and control avoidable waste. A waste
factor is often added to the quantities to account for avoidable
waste, as well as unavoidable waste that has not already been
included. The waste factor is expressed as a percentage of the
calculated quantity. The quantity of material needed, includ-
ing the waste, is calculated using the following equation:

(4-22)

Volume, area, or number may be substituted into
Eq. (4-22) for the quantity. The inclusion of waste is shown
in the following example.

EXAMPLE 4-9

Determine the volume of concrete for the slab in Example 4-6.
Include 10% waste in the calculated volume.

Solution: From Example 4-6, the volume of the slab is 123.5 cubic
yards. Using Eq. (4-22), we add the waste as follows:

�

The waste factor should be determined from historical
data. Historical data is obtained by comparing the estimated
quantity without waste to the actual quantities used on the
project, using the following equation:

(4-23)Waste Percentage � 100 a QuantityUsed

QuantityEstimated
� 1b

� (123.5 yd3)(1.10) � 135.8 yd3

Volumewith Waste � (123.5 yd3)a1 �
10

100
b

� Quantitywithout Waste a1 �
Waste Percentage

100
b

Quantitywith Waste

Quantity � (14 sq)(340 nails>sq) � 4,760 nails

Quantity �
5,000 sf 2

300 ft2/gallon
� 16.7 gallons
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EXAMPLE 4-10

The slab in Example 4-6 required 138 cubic yards of concrete.
Determine the actual waste percentage for the slab.

Solution: From Example 4-6, the estimated volume of the slab was
123.5 cubic yards. The waste percentage is calculated using Eq. (4-21)
as follows:

�Waste Percentage � 100 a 138 yd3

123.5 yd3 � 1b � 11.74%

Data on the quantities used should be available from the
company’s accounting system.i When performing the quan-
tity takeoff, the estimator should keep an accurate estimate
of the quantities before adding avoidable waste. This quan-
tity is to be used to measure the actual quantity of waste. On
one apartment project the author reviewed, he found that
the number of studs needed to complete identical apartment
units varied by almost 10% because of differences in the use
of materials.

CONCLUSION
The quantity takeoff is best performed by the estimator
building the project in his or her mind, keeping track of the
materials, equipment, and labor tasks needed to complete
the project. The estimate should be broken down into work
packages that contain related materials and tasks, such as
materials that will be ordered together. The planned use of
materials, labor, and equipment must be communicated
with the field personnel.

The quantity takeoff for materials can be divided into
counted items (both repetitive and nonrepetitive), linear
components, sheet and roll goods, volumetric goods, and
quantity-from-quantity goods. Similar methods are used to
determine the quantities in each of these categories.

PROBLEMS
1. What is the best way of performing the quantity takeoff?

2. Why should the estimator communicate the planned
material use and construction methods to the field
personnel?

3. Determine the number of studs needed for a 75-foot-
long wall where the studs are spaced at 1 foot on center.

4. Determine the number of studs needed for a 120-foot-
long wall where the studs are spaced at 16 inches on
center.

5. Determine the number of 20-foot-long pieces of pipe
needed to complete 150 feet of pipe. The pipe is con-
nected with a butt joint.

6. Determine the number of 20-foot-long pieces of rebar
needed to complete a 240-foot-long footing. The pieces
are spliced with a lap of 18 inches and form a single bar
running the length of the footing.

7. An 8-foot-high by 50-foot-long wall is constructed of
15 5>8-inch-long by 7 5>8-inch-high blocks. The mortar
joints between the blocks are 3>8 inch thick. Using the
area method, determine the number of blocks needed to
construct the wall.

8. An 8-foot-high by 50-foot-long wall is faced with 7 1>2-
inch-long by 2 1>2-inch-high bricks. The mortar joints
between the bricks are 1>2-inch thick. Using the area
method, determine the number of bricks needed to face
the wall.

9. Use the row and column method to solve Problem 7.

10. Use the row and column method to solve Problem 8.

11. Determine the volume of a 200-foot by 75-foot concrete
slab. The slab is 6 inches thick. Express your answer in
cubic yards and include 10% waste.

12. Determine the volume of a 20-foot by 15-foot by 4-
foot-high concrete footing. Express your answer in
cubic yards and include 5% waste.

13. Determine the quantity of paint needed to paint 12,620
square feet of wall. One gallon of paint will cover 250
square feet of wall.

14. Determine the quantity of joint compound needed to
finish 3,000 square feet of gypsum-board wall. One
gallon of joint compound will cover 200 square feet of
wall.

15. Determine the quantity of roofing nails needed for a
27.65 square (square � 100 square foot) roof. Historically,
375 nails are needed per square.

16. Determine the quantity of shims needed to install 22
doors. Historically, 0.75 bundles of shims are needed
per door.

17. The slab in Problem 11 required 300 cubic yards of
concrete. Determine the actual waste percentage for
the slab.

18. The footing in Problem 12 required 47 cubic yards of
concrete. Determine the actual waste percentage for
the slab.

REFERENCE
1. For more information on construction accounting systems

and tracking quantities, see Steven J. Peterson, Construction
Accounting and Financial Management, Prentice Hall, Upper
Saddle River, NJ, 2005.
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In this chapter you will learn how to apply the principles in
Chapter 4 to concrete, forms, and reinforcing for continuous
and spread footings, walls, square and round columns, beams,
slab on grade, raised slab, and stairs. This chapter includes
sample worksheets that may be used in the quantity takeoff.
You are encouraged to set these worksheets up in Excel and
learn how to use them. This chapter also includes example
takeoffs from the residential garage drawings given in
Appendix F.

Concrete work consists of three tasks: installation
and removal of the forms, installation of the rein-
forcement (rebar and wire mesh), and placement

and finishing of the concrete. The installation of the forms
and rebar may occur in many different orders. For footings,
the forms are placed and then the rebar is placed inside the
forms; for columns, the rebar is placed and the forms are
placed around the rebar; and for walls, one side of the forms
is placed, the rebar is placed, and then the forms are finished.
After the rebar is placed and the forms are completed, the
concrete is placed and then finished. After the concrete has
cured, the forms are removed. With careful planning and
scheduling of the concrete work, the forms can be reused
many times on the same job.

FORMS
Forms or formwork may be bid by itemizing all of the com-
ponents of the forms, or they may be bid by the square foot,
the lineal foot, or set of forms. When bidding formwork by
itemizing all of the components of the forms, the estimator
must be familiar with the forming system to be used and
build the forms in his or her mind, counting the items as he
or she goes.

Estimators will often bid the formwork based on the
square footage, the lineal footage, or the set of forms, rather

than accounting for each of the items needed. To do this the
estimator must have historical data on the equipment, mate-
rials, and labor needed to complete a square foot, lineal foot,
or set of forms.

Beams, girders, walls, and tall footings (footings greater
than 12 inches high) are often bid based on the square
footage of forms needed to form the concrete member.
When figuring the area, the estimator must make sure to in-
clude forms on all sides and the bottom (if needed) of the
concrete member. For example, on a foundation wall the es-
timator will need to include both sides of the wall and the
ends of the wall. The area of the forms should be based on
the area of the forms, not the area of the wall. Wall forms
typically come in 2-, 4-, and 8-foot heights. When forming
an 18-inch-high footing or wall, a 2-foot-high form would
be used. In this case the forming height would be 2 feet
rather than the wall height of 18 inches.

Short footings (footings 12 inches high or less) can be
formed by using 2 � 10s and 2 � 12s; therefore, they are
often bid based on the lineal footage of forms. Just as in the
case of the walls, the estimator needs to be sure to include
forms on both sides and ends of the footings.

Columns are often bid based on the square footage
(square and rectangular columns only), lineal footage of
the column, or set of forms. When prefabricated forms or
Sonotube are used, they may be bid based on the set of
forms required.

Raised slabs are often bid based on the square footage of
the slab, often ignoring the small amount of forms needed
around the perimeter. When forming a raised slab, the bot-
tom forms of the slab need to be supported until the slab has
cured sufficiently to support its own weight.

When estimating forms, the estimator must determine
not only the quantity of forms to be installed, but also the
quantity of form material that must be purchased for the
project, as it affects the cost of the forms. The quantity of
forms that needs to be purchased for a project is based on
how many times the forms can be reused, whether the forms

CONCRETE

CHAPTER FIVE
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can be used on other projects, and the life of the forms. If the
concrete for a project can be poured in four separate pours
with sufficient time between the pours to allow the concrete
to cure, the project will take one-fourth of the forms it
would need if the concrete on the project was poured in a
single pour. If the forms are available from another project
or can be used on a subsequent project, the purchase of the
forms may be spread out over many projects, reducing the
cost of forms that need to be included in the estimate for the
project. However, if a project requires a custom form that
will not be reused, the entire purchase of the forms must be
included in the estimate. The final factor is how long the
forms will last before they wear out or are consumed as they
are cut to meet specific dimensions.

REINFORCING
Concrete reinforcing consists of rebar, welded wire fabric,
chairs to position the rebar, and so forth. Rebar is designated
by bar size, which represents the nominal diameter of the bar
in eighths of an inch. For example, a #7 bar has a nominal di-
ameter of 7>8 inch. Rebar is taken off by the lineal foot or by
the number of pieces. Small quantities of rebar are often
purchased by the piece or by the lineal foot, whereas large
quantities of rebar are often purchased by the pound or ton.
The weight per foot for common rebar sizes is shown in
Table 5-1.

Continuous rebar must be lapped. The lapping is speci-
fied by the structural engineer or other design professional.
In the event it is not specified by the design professional, the
contractor has to meet the lapping requirement in the build-
ing code of the jurisdiction where the building is being con-
structed. Lapping is specified by a minimum length or a
number of bar diameters or both. For example, the drawings
may require that the rebar be lapped 24 bar diameters or
1 foot, whichever is greater. For a #3 bar, 24 bar diameters is
9 inches (24 � 3>8 in). The bar would have to be lapped the
greater of 9 inches or 1 foot; therefore, the bar would have to
be lapped 1 foot. For a #6 bar, 24 bar diameters is 18 inches
(24 � 6>8 in), and the bar would have to be lapped the
greater of 18 inches or 1 foot.

On small jobs the rebar is often fabricated in the field
from straight bar. A common length for rebar is 20 feet;
however, lengths up to 60 feet are often available. For large

jobs, the rebar is often shop fabricated and shipped to the
jobsite ready for placement.

Many projects are now specifying epoxy-coated rebar.
Typically, epoxy-coated rebar is light green and is cut and
bent in a fabrication shop. Epoxy-coated rebar that has
been field cut and bent must have all cuts and bends re-
coated. This will require additional installation time in the
field and epoxy paint to coat the rebar. Field cuts and bends
should be noted in the estimate so they can be included in
the estimate.

Welded wire fabric (WWF), often called wire mesh, is
designated by the spacing of the wires and the wire size. For
example, WWF 6 � 6 10>10 is made up of #10 wires welded
at 6 inches on center in both ways. Welded wire fabric is
available in flat sheets or rolls 5 feet wide by 150 feet long.
Like continuous rebar, welded wire fabric must be lapped as
specified by the design profession or building code. A com-
mon lapping is the spacing between wires. In the case of
WWF 6 � 6 10>10 it is 6 inches.

CONCRETE
The specifications for concrete vary based on its use.
Concrete used for slabs often has a higher strength than con-
crete used for footings and foundations. The estimator must
read the specification to determine the different types of
concrete used on the project. When estimating concrete, the
quantities for different types of concrete must be kept sepa-
rate. Concrete specifications may be performance based, de-
sign based, or both. A performance-based specification sets
the requirements for the physical properties of the concrete,
such as strength and slump. A design-based specification sets
limits on the various components used to compose the con-
crete. Concrete is typically composed of cement, large aggre-
gate, fine aggregate, and water. Cement powder comes in five
types. Type I is normal cement, Type II is moderate-sulfate-
resistance cement, Type III is high-early-strength cement,
Type IV is low-heat-of-hydration cement, and Type V is
high-sulfate-resistance cement. In some concrete mixes, part
of the cement is replaced by fly ash, a pozzolan. Admixtures
may be added to achieve specific physical properties, such as
air entrainment. All of these affect the price of the concrete.
The estimator needs to carefully review the specifications to
make sure he or she understands what type of concrete is re-
quired to complete the job.

Pricing for concrete is best obtained from the concrete
suppliers. It is best to provide the supplier with a copy of
the specifications for use in pricing the concrete. Concrete
companies often charge extra for small or short loads.
Care should be taken to note any short loads during the
takeoff process.

During hot weather, ice or chilled water is often
added to keep the concrete from overheating. This in-
creases the cost of the concrete, and the estimator must
incorporate these costs into the concrete estimate. During
the quantity takeoff the estimator needs to identify the
need for ice or chilled water.

TABLE 5-1 Rebar Sizes and Weights (lb/ft)

Bar Size Weight Bar Size Weight

2 0.167 8 2.670

3 0.376 9 3.400

4 0.668 10 4.303

5 1.043 11 5.313

6 1.502 14 7.650

7 2.044 18 13.600
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When concrete is placed in cold weather, precautions
need to be taken to ensure that the concrete does not freeze.
During cold weather the water added to the concrete is usu-
ally heated, adding to the cost of the concrete. In addition,
the concrete is often protected by covering the concrete with
plastic, straw, or concrete blankets and by providing heat.
The need for hot water and concrete protection should be
included in the concrete takeoff.

The labor required to place the concrete consists of two
components: the placement of the concrete and the finishing
of the concrete. The placement of the concrete is bid by the
cubic yard; the finishing of the concrete is bid by the square
foot or square yard of the finished surface. Often the two
components are combined into a single cost for a concrete
component of a specified size.

A concrete pump is often used to place concrete that can-
not be discharged directly from the concrete truck into its
final place. Estimators need to be sure they understand what
access is available to the site so they can determine the amount
of concrete pumping that will be necessary to complete the
work. When pumping concrete, care must be taken to ensure
that the concrete mix has been designed for pumping. Not all
concrete mixes can be pumped with satisfactory results.

Concrete waste varies based on the type of member
being constructed. Beams, columns, walls, and other mem-
bers that have a small area of contact with the ground require
less waste than members that have a high area of contact with
the ground, such as slabs and curbs. A typical waste factor for
beams, columns, walls, and other members that have a small
area of contact with the ground is 5%. A typical waste factor
for slabs, curbs, footings, and other members that have a high
area of contact with the ground is 10%. Leaving an area
1>2 inch too low increases the amount of concrete needed to
construct a 4-inch concrete slab by 12.5%. Careful grading of
the subgrade is critical to controlling concrete waste. Actual

waste factors should be monitored and compared to estimated
quantities to ensure that an appropriate waste factor is being
used in the estimates. In addition, extra gravel is often pro-
vided to the concrete crew to be used to fill in low spots in an
effort to minimize concrete waste.

Let’s look at how the equations in Chapter 4 are used
to calculate the quantities for some common concrete
components.

SPREAD FOOTINGS
The work package for the spread footings (sometimes re-
ferred to as spot footings) includes the concrete for the foot-
ings, forms, the horizontal rebar in the footings, and the
dowels needed to connect the footings to columns. The ties
at the bottom of the column are often included in the rebar
order for the spread footings because they are used to prop-
erly space the dowels that run between the spread footing
and the column. The concrete is treated as a volumetric
good, the forms for short footings (12 inches thick or less)
are treated as a linear component, the form for tall footings
(thicker than 12 inches) are treated as sheet goods and are
measured by the square foot, and rebar is treated as a
counted item. The quantity takeoff for a spread footing is
shown in the following example.

EXAMPLE 5-1

Determine the volume of concrete in cubic yards, the lineal feet of
forms, and the rebar needed to complete 10 of the footings shown
in Figure 5-1. Provide 3 inches of cover for the rebar in the footings
and 2 inches of cover for the rebar in the columns. Include 10%
waste in the calculated volume of concrete, and express the volume
of concrete in quarter-yard increments. The ties are to be ordered
with the column rebar.

FIGURE 5-1 Footing and Column Details
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EXCEL QUICK TIP 5-1

Spread Footing

The volume of concrete and square footage of forms (for
footing greater than 12 inches thick) or lineal feet of
forms (for footings 12 inches thick or less) needed for a
spread footing is set up in a spreadsheet by entering the
data and formatting the cells as follows:

A B C
1 No. of Footings 10 ea
2 Width 1 3 ft
3 2 in
4 Width 2 3 ft
5 2 in
6 Thickness 1 ft
7 - in
8 Concrete Waste 10 %
9 Forms 126.67 ft

10 Volume 4.09 cyd

Solution: The volume of the concrete is determined as follows:

Add the waste using Eq. (4-22) as follows:

Rounding up to quarter-yard increments, we get 4.25 cubic yards.
The lineal feet of forms are calculated as follows:

Each footing will require eight #4 horizontal bars for a total of
80 bars (10 footings � 8 bars/footing). The length of the bars needs
to be 3 inches shorter on both ends of the bar than the width of the
footings. The bars will be 32 inches (3 ft 2 in � 2 � 3 in) long.

Each footing will require eight #5 dowels for a total of 80
dowels. The length of the long leg of the dowels is the height of the
footing less the cover at the bottom of the footing plus the height
of the dowel above the top of the footing, or 25 inches (1 ft � 3 in �
1 ft 4 in). The short leg of the dowels will begin 3 inches inside
the footing and run 2 inches inside the column. The distance
from the edge of the column to the edge of the footing is 11 inches
(3 ft 2 in>2 � 16 in>2). The length of the short leg is 10 inches
(11 in � 3 in � 2 in).

� (10 ea)(2) c3 ft �
2 in

12 in/ft
� 3 ft �

2 in

12 in/ft
d � 127 ft

� (No. of Footings)(2)(Width 1!� !Width 2)

� (No. of Footings)(Width 1 � Width 2 � Width 1 � Width 2)

Length

� (3.71 yd3)(1.10) � 4.08 yd3

Volumewith Waste � (3.71 yd3) a1!� !
10

100
b

� (100.3 ft3)a 1 yd3

27 ft3b � 3.71 yd3

� (10 ea) c 3 ft �
2 in

12 in/ft
d c 3 ft �

2 in

12 in/ft
d (1 ft)

Volume � (No. of Footings)(Width 1)(Width 2)(Thickness)

COLUMNS
The work package for the columns includes the concrete
for the columns, forms, the vertical rebar in columns, and
the ties. The dowels, and often the ties at the bottom of
the column, are included in the footing package. The con-
crete is treated as a volumetric good. The forms for square
and rectangular columns are estimated by the square foot,
lineal foot, or set of forms. The forms for round columns
are estimated by the lineal foot or set of forms. The rebar
is treated as a counted item. The quantity takeoff for a
square and round column is shown in the following
examples.

EXAMPLE 5-2

Determine the volume of concrete in cubic yards, the square feet of
forms, and the rebar needed to complete 10 of the columns shown
in Figure 5-1. Provide 2 inches of cover for the rebar in the
columns. The ties begin 3 inches from the bottom of the column
and end 3 inches from the top of the column. Include 5% waste in
the calculated volume of concrete and express the volume of con-
crete in quarter-yard increments.

Solution: The volume of the concrete is determined as follows:

� (10 ea)a 16 in

12 in/ft
ba 16 in

12 in/ft
b(8 ft)a 1 yd3

27 ft3b � 5.27 yd3

Volume � (No. of Columns)(Width 1)(Width 2)(Height)

The following formulas need to be entered into the
associated cells:

Cell Formula

B9 =IF((B6*12+B7)>12,2*B1*(B2+B3/
12+B4+B5/12)
*Roundup((B6+B7/12)/2,0)*2,2*B1
*(B2+B3/12+B4+B5/12))

B10 =B1*(B2+B3/12)*(B4+B5/12)*
(B6+B7/12)/27*(1+B8/100)

C9 =IF((B6*12+B7)>12,"sft","ft")

The formula in Cell B9 uses an IF function to select be-
tween square footage of forms for footings over 12 inches
thick and linear feet for footings 12 inches thick or less.
When calculating the area of forms, Cell B9 uses a
ROUNDUP function to round up the form height to 2-
foot increments. Cell C9 uses an IF function to select be-
tween the units of feet (ft) and square feet (sft).

The data for the spread footings are entered in Cells
B1 through B8. The data shown in the foregoing figure is
from Example 5-1 and is formatted using the comma
style, which replaces zeros with dashes.
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EXCEL QUICK TIP 5-2

Rectangular Column

The volume of concrete and area of forms needed for a
rectangular column is set up in a spreadsheet by entering
the data and formatting the cells as follows:

A B C
1 No. of Columns 10 ea
2 Width 1 - ft
3 16 in
4 Width 2 - ft
5 16 in
6 Height 8 ft
7 Concrete Waste 5 %
8 Forms 427 sft
9 Volume 5.53 cyd

Add the waste using Eq. (4-22) as follows:

Rounding to quarter-yard increments, we get 5.5 cubic yards. The
square feet of forms are calculated as follows:

Each column will require eight #6 vertical bars for a total of 80 bars
(10 columns � 8 bars/column). The length of the bars needs to be
3 inches shorter than the height of the column, or 7 foot 9 inches (8 ft
� 3 in) long.

The ties for the column are located in 6-inch increments start-
ing at 3 inches and ending at 7 foot 9 inches. The distance over
which the ties occur is 7 feet 6 inches (7 ft 9 in � 3 in). The number
of ties is calculated using Eq. (4-1) as follows:

Two additional ties are needed to meet the requirement for three
ties at 3 inches on center at the top and bottom of the column.
These ties are located at 6 inches from the bottom and top of the
column. The ties will be located at the following distances from the
bottom of the column: 3 in, 6 in, 9 in, 1 ft 3 in, 1 ft 9 in, 2 ft 3 in, 2 ft
9 in, 3 ft 3 in, 3 ft 9 in, 4 ft 3 in, 4 ft 9 in, 5 ft 3 in, 5 ft 9 in, 6 ft 3 in, 6
ft 9 in, 7 ft 3 in, 7 ft 6 in, and 7 ft 9 in.

The number of ties needed for each column is 18 (16 � 2),
and the number of ties needed for 10 columns is 180 (10 columns �
18 ties/column) ties. The width of the ties will be 2 inches shorter
on both sides of the column, or 12 inches (16 in � 2 in � 2 in)
square. �

Number �
7 ft 6 in

6 in
� 1 � 16 ties

� (10 ea)(2)a 16 in

12 in/ft
�

16 in

12 in/ft
b(8 ft) � 427 ft2

� (No. of Columns)(2)(Width 1!� !Width 2)(Height)

� (Height)

� (No. of Columns)(Width 1 � Width 2 � Width 1 � Width 2)

Area

Volumewith Waste � (5.27 yd3)a1 �
5

100
b � 5.53 yd3

EXAMPLE 5-3

Determine the volume of concrete in cubic yards, the lineal feet of
the sonotube, and the rebar needed to complete 10 of the columns
shown in Figure 5-2. Provide 2 inches of cover for the rebar in the
columns. The ties begin 3 inches from the bottom of the column
and end 3 inches from the top of the column. Include 5% waste in
the calculated volume of concrete, and express the volume of con-
crete in quarter-yard increments.

Solution: The volume of the concrete is determined as follows:

Add the waste using Eq. (4-22) as follows:

Rounding up to quarter-yard increments, we get 4.50 cubic yards.
The lineal feet of forms are calculated as follows:

Each column will require eight #6 vertical bars for a total of 80 bars
(10 columns � 8 bars/column). The length of the bars needs to be
3 inches shorter than the height of the column, or 7 feet 9 inches
(8 ft � 3 in) long.

The ties for the column are located at 6-inch increments start-
ing at 3 inches and ending at 7 feet 9 inches. The distance over
which the ties occur is 7 feet 6 inches (7 ft 9 in � 3 in). The number
of ties is calculated using Eq. (4-1) as follows:

Two additional ties are needed to meet the requirement for
three ties at 3 inches on center at the top and bottom of the column.
These ties are located at 6 inches from the bottom and top of the
column. The total number of ties needed for each column is 18
(16 � 2). The total number of ties needed for 10 columns is 180
(10 columns � 18 ties/column) ties. The width of the ties will be
2 inches smaller than the diameter of the column on both sides of the
column, or 12 inches (16 in � 2 in � 2 in) in diameter. �

Number �
7 ft 6 in

6 in
� 1 � 16 ties

Length � (No. of Columns)(Height) � (10 ea)(8 ft) � 80 ft

Volumewith Waste � (4.13 yd3)a1 �
5

100
b � 4.33 yd2

� (10 ea)(�)a 16 in

(12 in/ft)(2)
b2

(8 ft)a 1 yd3

27 ft3b � 4.13 yd3

Volume � (No. of Columns)(�)(Diameter>2)2(Height)

The following formulas need to be entered into the
associated cells:

Cell Formula

B8 =B1*2*(B2+B3/12+B4+B5/12)*B6

B9 =B1*(B2+B3/12)*(B4+B5/12)*(B6)/
27*(1+B7/100)

The data for the column footings is entered in Cells B1
through B7. The data shown in the foregoing figure is
from Example 5-2 and is formatted using the comma
style, which replaces zeros with dashes.
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FIGURE 5-2 Column Detail

CONTINUOUS FOOTINGS
The work package for the continuous footing includes the
concrete for the footing, forms, the horizontal rebar in the
footings, and the dowels needed to connect the footings to
columns. The concrete is treated as a volumetric good, the

forms for short footings (12 inches thick or less) are treated
as a linear component, the forms for tall footings (thicker
than 12 inches) are treated as sheet goods and are measured
by the square foot, the dowels are treated as a counted item,
and the continuous rebar is treated as a linear component.

Continuous footings are similar to spread footings except
that they are much longer than they are wide and they often
turn to follow the outline of the building. Continuous footings
are handled in a similar manner to spread footings with two
exceptions that are a result of the footing turning to follow the
outline of the building. First, when measuring the length of
continuous footings one must be careful not to count the cor-
ners twice. If one were to measure the outside of the footings,
the corners would be counted twice as shown in Figure 5-3.

To avoid counting the corners twice, one must begin the
measurement for L2 as shown in Figure 5-4.

Second, when calculating the number of dowels, a dowel
to account for the end condition must be included for each
straight segment of continuous footing. This ensures that
there is a dowel located at each corner, end, or intersection.

The quantity takeoff for a continuous footing is shown
in the following example.

EXCEL QUICK TIP 5-3

Round Column

The volume of concrete needed for a round column is set
up in a spreadsheet by entering the data and formatting
the cells as follows:

The following formula needs to be entered into
Cell B6:

=B1*(PI()*((B2+B3/12)/2)^2)*B4/27*

(1+B5/100)

In Excel, � (3.141592654) is written as follows: PI()
The data for the column is entered in Cells B1

through B5. The data shown in the foregoing figure is
from Example 5-3 and is formatted using the comma
style, which replaces zeros with dashes.

A B C
1 No. of Columns 10 ea
2 Diameter - ft
3 16 in
4 Height 8 ft
5 Concrete Waste 5 %
6 Volume 4.34 cyd

FIGURE 5-3 Double-Counted Corner
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FIGURE 5-4 Proper Way to Measure Corners

FIGURE 5-5 Foundation Plan

FIGURE 5-6 Foundation Section

EXAMPLE 5-4

Determine the volume of concrete in cubic yards, the lineal feet of
forms, and the rebar needed to complete the footings shown in
Figures 5-5 and 5-6. Include 8% waste in the calculated volume of
concrete, and express the volume of concrete in quarter-yard in-
crements. Provide 3 inches of cover for the rebar in the footings.
The continuous rebar is purchased in 20-foot lengths and is lapped
18 inches.

Solution: The first step is to find the length of the footings. We
begin by dividing the footings into segments as shown in Figure 5-7.

The length of the footing at the top of the foundation plan is
equal to the length of the foundation wall plus the length the foot-
ing extends beyond the foundation wall at both ends. The footing
extends half of the difference between the width of the footing
and the width of the wall, or 11 inches (30 in>2 � 8 in>2) beyond
the foundation wall as shown in Figure 5-8. The length of the
footing is 25 feet 10 inches (24 ft � 11 in � 11 in). Similarly, the
length of the footing at the bottom of the foundation plan is also
25 feet 10 inches.

The footing at the left side of the foundation plan begins at the
bottom of the top footing and ends at the top of the bottom footing
as shown in Figure 5-7. The distance from the exterior of the foun-
dation wall and the bottom of the top footing is 1 foot 7 inches
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FIGURE 5-7 Segments for Footings

FIGURE 5-8 Footing Distances

(8 inches � 11 inches) as shown in Figure 5-9. Similarly, the dis-
tance from the exterior of the foundation wall and the top of the
bottom footing is 1 foot 7 inches. The length of the footing is 18 feet
10 inches (22 ft � 1 ft 7 in � 1 ft 7 in).

Similarly, the length of the right footing is 18 feet 10 inches.
The length of the right-center footing is 11 feet 4 inches (12 ft � 1 ft
7 in � 11 in). The length of the top-center footing is 7 feet 10 inches

(11 ft � 1 ft 7 in � 1 ft 7 in). The lengths of the footings are shown
in Figure 5-10.

The total length of the footing is the sum of the individual
lengths and is calculated as follows:

The volume of the concrete is determined as follows:

Add the waste using Eq. (4-22) as follows:

Rounding up to quarter-yard increments, we get 11 cubic yards.
Using the same procedures that were used to determine the
length of the footing, we can determine the length of the indi-
vidual forms. The lengths of the individual forms are shown in
Figure 5-11.

The lineal feet of forms is the sum of the individual lengths
and is calculated as follows:

� 212 ft

� 8 ft 10 in � 7 ft 10 in

� 20 ft 10 in � 18 ft 10 in �  8 ft 10 in � 7 ft 10 in

� 9 ft 6 in � 10 ft 4 in � 11 ft 4 in � 8 ft 6 in

Length � 25 ft 10 in � 23 ft 10 in � 25 ft 10 in � 23 ft 10 in

Volumewith Waste � (10.04 yd3)a1 �
8

100
b � 10.84 yd3

� (108.5 ft)(2.5 ft)(1 ft)a 1 yd3

 27 ft3b � 10.04 yd3

Volume � (Length)(Width)(Thickness)

Length � 108 ft 6 in � 108.5 ft

� 11 ft 4 in � 7 ft 10 in

Length � 25 ft 10 in � 25 ft 10 in � 18 ft 10 in � 18 ft 10 in

FIGURE 5-9 Footing Distances
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There are four continuous bars in the footings with an average total
length of 108.5 feet per bar, for a total length of 434 feet. In addition
to this rebar, four 36-inch-long (twice the lap or 2 � 18 inches) L-
shaped bars are needed at each intersection for an additional 24
feet (2 intersections � 4 bars/intersection � 3 ft/bar). The L-
shaped bars are used to connect the rebar in the exterior footings to

the rebar in the interior footings. A total of 458 feet is needed. The
number of 20-foot bars is calculated using Eq. (4-6) as follows:

Number �
458 ft

(20 ft � 1.5 ft)
� 25 each

FIGURE 5-11 Lengths of the Footing Forms

FIGURE 5-10 Footing Lengths
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FIGURE 5-12 Measuring Corners

FIGURE 5-13 Measuring Intersections

The short leg of the #5 dowels will run from a point 3 inches inside
the footing to the center of the footing. The short leg will be
12 inches long (30 in>2 � 3 in). The long leg will run from a point
3 inches above the bottom of the footing to 18 inches (the required
lap) above the top of the footing. The long leg will be 27 inches long
(12 in � 3 in � 18 in). The number of dowels is calculated using
the following equation:

The 6 in this equation is to account for the end condition for all of
the six walls. �

Although it is time-consuming to calculate the length of
the footing and the length of the side of the footings, this can
be rapidly done by using a plan measurer, such as the one in
Figure 1-4, a digitizer, such as the one in Figure 1-5, or a
takeoff software package. The length of the forms can be ap-
proximated by multiplying the footing length by two. Using
this method for the preceding example gives the length of
the forms as 217 feet rather than the actual length of 212 feet.
This method of calculation can overstate or understate the
quantity of forms needed.

Another method used to determine the length of a foot-
ing is the centerline method. With the centerline method the
lengths of the footings are measured along the centerlines of
the footings. When measuring around corners, the center-
line method double counts one-fourth of the corner and ig-
nores one-fourth of the corner as shown in Figure 5-12. The
area double counted offsets the area ignored. When using
the centerline method at intersections, such as the one
shown in Figure 5-13, the measurement of the intersecting
footing must stop at the edge of the other footing to avoid
including an area twice. If you measure to the centerline, the
shaded area in Figure 5-13 will be measured twice.

Number �
Distance

Spacing
� 6 �

108.5 ft

1 ft
� 6 � 115 each

EXAMPLE 5-5

Determine the volume of concrete in cubic yards for the footing in
Example 5-4 using the centerline method.

Solution: The length of the centerline of the footing on the top of
the foundation plan is equal to the length of the foundation wall
less one-half of the thickness of the foundation wall on both ends,
or 23 feet 4 inches (24 ft � 8 in>2 � 8 in>2). The length of the cen-
terline of the footing on the bottom of the foundation plan is the
same as that at the top.

The length of the centerline of the footing on the left of the foun-
dation plan is equal to the length of the foundation wall less one-half of
the thickness of the foundation wall on both ends, or 21 feet 4 inches
(22 ft � 8 in>2 � 8 in>2). The length of the centerline of the footing on
the right of the foundation plan is the same as that on the left.

The length of the centerline of the right-center footing is equal
to the length of the foundation wall less one-half of the thickness of
the foundation wall on the left end less the distance from the outside
of the foundation wall to the inside of the footing on the right end.
This distance is 19 inches (11 in � 8 in) as shown in Figure 5-8. The
length of the footing is 10 feet 1 inch (12 ft � 8 in>2 � 19 in).

The length of the centerline of the top-center footing is calcu-
lated in the same way as the right-center footing. Its length is 9 feet
1 inch (11 ft � 8 in>2 � 19 in). The dimensions for the footings are
shown in Figure 5-14.

The total length of the footing is the sum of the individual
lengths and is calculated as follows:

The volume of the concrete is determined as follows:

Add the waste using Eq. (4-22) as follows:

Rounding up to quarter-yard increments, we get 11 cubic yards.
This is the same answer as we got for Example 5-4. �

Volumewith Waste � (10.04 yd3)a1 �
8

100
b � 10.84 yd3

� 108.5 ft(2.5 ft)(1 ft)a 1 yd3

27 ft3ˇˇb � 10.04 yd3

Volume � (Length)(Width)(Thickness)

� 108 ft 6 in � 108.5 ft

� 9 ft 1 in

� 23 ft 4 in � 23 ft 4 in � 21 ft 4 in � 21 ft 4 in � 10 ft 1 in
Length

EXCEL QUICK TIP 5-4

Continuous Footing

The volume of concrete needed for a continuous footing
is set up in a spreadsheet by entering the data and for-
matting the cells as follows:

A B C
1 Length 108 ft
2 6 in
3 Width 2 ft
4 6 in
5 Thickness 1 ft
6 - in
7 Concrete Waste 8 %
8 Volume 10.85 cyd
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FOUNDATION WALLS
The work package for the foundation walls includes the
concrete for the walls, forms, the vertical and horizontal
rebar in walls, and anchor bolts. The dowels are included in
the footing package. The concrete is treated as a volumetric
good. The forms are estimated by the square foot. The verti-
cal rebar is treated as a counted item; the horizontal rebar is
treated as a linear good. The same principles used for han-
dling corners of continuous footings apply to foundation
walls. Foundation walls may be thought of as narrow, tall,
continuous footings. The quantity takeoff for a foundation
wall is shown in the following example.

EXAMPLE 5-6

Determine the volume of concrete in cubic yards, the square feet of
forms, the rebar, and the anchor bolts needed to complete the

foundation wall in Figures 5-5 and 5-6. Include 5% waste in the
calculated volume of concrete, and express the volume of concrete
in quarter-yard increments. Provide 2 inches of cover for the rebar
in the wall and lap the continuous rebar 18 inches. The continuous
rebar will be ordered in 20-foot lengths.

Solution: The length of the wall is calculated in the same manner
as the lengths of the footings were calculated in Example 5-4. The
lengths of the walls are shown in Figure 5-15.

The total length of the wall is calculated as follows:

The volume of the concrete is determined as follows:

Add the waste using Eq. (4-22) as follows:

Rounding up to quarter-yard increments, we get 23 cubic yards.
The length of the individual forms can be determined using the
same procedures that were used to determine the length of the
footing forms. The lengths of the individual forms are shown in
Figure 5-16.

Volumewith Waste � (21.79 yd3)a1 �
5

100
b � 22.88 yd3

� 21.79 yd3

� (110.33 ft)(8 ft)
(8 in)

(˛˛12 in/ft)
a 1 yd3

ˇ

27 ft3b
Volume � (Length)(Width)(Thickness)

� 110!ft 4 in

� 24 ft � 20 ft 8 in � 24 ft � 20 ft 8 in � 9 ft 8 in � 11 ft 4 in

Length

The following formula needs to be entered into
Cell B8:

=(B1+B2/12)*(B3+B4/12)*(B5+B6/12)/

27*(1+B7/100)

The data for the footings is entered in Cells B1 through
B7. The data shown in the foregoing figure is from
Example 5-4 and is formatted using the comma style,
which replaces zeros with dashes.

FIGURE 5-14 Footing Dimensions
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FIGURE 5-15 Lengths of the Foundation Walls

FIGURE 5-16 Lengths of the Foundation Forms

The lineal feet of forms is the sum of the individual lengths
and is calculated as follows:

� 219 ft 4 in

� 10 ft 8 in � 9 ft 8 in � 10 ft 8 in � 9 ft 8 in

� 11 ft 4 in � 10 ft 4 in � 22 ft 8 in � 20 ft 8 in

Length � 24 ft � 22 ft � 24 ft � 22 ft � 11 ft 4 in � 10 ft 4 in

Alternatively, they may be measured using a plan measurer, digi-
tizer, or software takeoff package. The area of the forms is calcu-
lated as follows:

� 1,755 ft2

Area � (Length)(Height) � (219.33 ft)(8 ft)
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EXCEL QUICK TIP 5-5

Foundation Wall

The volume of concrete needed for a foundation wall is
set up by changing the Cell A5 of the worksheet in Excel
Quick Tip 5-4 to Height as follows:

The data for the foundation wall is entered in Cells B1
through B7. The data shown in the foregoing figure is
from Example 5-6 and is formatted using the comma
style, which replaces zeros with dashes.

A B C
1 Length 110 ft
2 4 in
3 Width - ft
4 8 in
5 Height 8 ft
6 - in
7 Concrete Waste 5 %
8 Volume 22.88 cyd

The number of continuous bar needed, for one bar every 12 inches
is calculated using Eq. (4-1) as follows:

Because the top and bottom bars are doubled, two additional bars
need to be added to the number of bars needed, for one bar every
12 inches. The number of continuous bars is 11 (9 ea � 2 ea). The av-
erage length of the continuous bars is 110.33 feet for a total length of
1,214 feet. As was done for the footings, eleven 36-inch L-shaped bars
need to be added at each intersection for an additional 66 feet of rebar
(2 intersections � 11 bars>intersection � 3 ft>bar). The L-shaped bars
are used to connect the rebar in the exterior walls to the rebar in the
interior walls. The total length of continuous rebar is 1,280 feet. The
number of 20 foot bars is calculated using Eq. (4-6) as follows:

The vertical bars run from the bottom of the wall to 2 inches below
the top of the wall, for a length of 7 feet 10 inches. The number of
vertical bars is calculated using the following equation:

The 6 in this equation is to account for the end condition for all of
the six walls. The number of anchor bolts is calculated as follows:

�� 48 each

Number �
Distance

Spacing
� 6 �

(110.33 ft)(12 in/ft)

(32 in)
� 6

Number �
Distance

Spacing
� 6 �

110.33 ft

1 ft
� 6 � 117 each

Number �
1,280 ft

(20 ft � 1.5 ft)
� 70 each

Number �
8 ft

1 ft
� 1 � 9 each

The key differences are that forms need to be included for
the bottom of the beam and the forms will need to be sup-
ported until the concrete has cured. The takeoff for a con-
crete beam is shown in the following example.

EXAMPLE 5-7

Determine the volume of concrete in cubic yards, the square feet of
forms, and rebar needed to complete the beam in Figure 5-17.
Only half of the beam is shown in Figure 5-17, with the other half
being a mirror image of the one shown. Include 5% waste in the
calculated volume of concrete, and express the volume of concrete
in quarter-yard increments. Provide 2 inches of cover for the rebar
in the beam.

Solution: The volume of the concrete is calculated as follows:

Add the waste using Eq. (4-22) as follows:

Rounding up to quarter-yard increments, we get 1 cubic yard.
Forms are needed on the bottom of the beam between the end
columns. The area of the forms is calculated as follows:

The #5 dowels should have been ordered with the column. Two #5
bars 5 feet 1 inch long are needed for each end of the beam, for a
total of four. Three #5 bars 8 feet 4 inches (4 ft 2 in � 2) are
needed for the center of the beam. Six stirrups are needed for each
end, for a total of 12. The stirrups will need to be 4 inches less
than the dimensions for the beam in order to provide 2 inches of
cover. The dimensions for the stirrups are 14 inches high by
8 inches wide. �

SLAB ON GRADE
The work package for a slab on grade includes the concrete
for the slab, the area to be finished, forms, and rebar or wire
mesh. The concrete is treated as a volumetric good, the
forms are treated as a linear component, rebar is treated as a
linear component, and wire mesh is treated as a sheet good.
The quantity takeoff for a slab on grade is shown in the fol-
lowing examples.

EXAMPLE 5-8

Determine the volume of concrete in cubic yards, the area to be
finished, the lineal feet of forms, and number of 20-foot bars of #4
rebar needed to complete a slab on grade 100 feet long by 40 feet
wide. The slab is reinforced with #4 rebar at 18 inches on center.

� 64.34 ft2

� (16 ft � 2 � 1 ft 4 in)(1 ft)

Area � 2(16 ft)(1.5 ft) � 2(1 ft)(1.5 ft)

Area � 2(Area of Side) � 2(Area of End) � Area of Bottom

Volumewith Waste � (0.89 yd3)a1 �
5

100
b � 0.93 yd3

Volume � 0.89 yd3

� (16 ft)(1.5 ft)(1 ft)a 1 yd3

27 ft3 ˛˛b
Volume � (Length)(Width)(Thickness)

BEAMS
The same principles that were used to determine the quan-
tity of concrete, forms, and rebar for footings, columns, and
walls can be used for determining the quantities for beams.
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FIGURE 5-17 Beam Section

EXCEL QUICK TIP 5-6

Slab on Grade with Rebar

The volume of concrete and the number of bars of rebar
needed for a slab on grade are set up in a spreadsheet by
entering the data and formatting the cells as follows:

A B C
1 Slab Length 100 ft
2 Slab Width 40 ft
3 Slab Thickness 4 in
4 Waste 12 %
5 Bar Spacing 18 in
6 Bar Size 4 #
7 Bar Length 20 ft
8 Lap 36 # of dia.
9

10 Area 4,000 sft
11 Volume 55.31 cyd
12 No. of Bars 299 each

Include 12% waste in the calculated volume of concrete, and
express the volume of concrete in quarter-yard increments.
Provide 36 bar diameters of lap on the rebar.

Solution: The volume of concrete is calculated as follows:

Add the waste using Eq. (4-22) as follows:

Rounding up to quarter-yard increments, we get 55.50 cubic yards.
The area to be finished is calculated as follows:

The length of the forms is calculated as follows:

The number of 100-foot-long bars needed to cover the slab in the
long direction is calculated using Eq. (4-1) as follows:

The number of 40-foot-long bars needed to cover the slab in the
short direction is calculated using Eq. (4-1) as follows:

Number �
100 ft

1.5 ft
� 1 � 68 bars

Number �
40 ft

1.5 ft
� 1 � 28 bars

� 280 ft

� 2(100 ft) � 2(40 ft)

Length � 2(Length of Side1) � 2(Length of Side2)

Area � (100 ft)(40 ft) � 4,000 ft2

Volumewith Waste � (49.38 yd3)a1 �
12

100
b � 55.31 yd3

� (100 ft)(40 ft)(4 in)a 1 ft

12 in
ba 1 yd3

27 ft3b � 49.38 yd3

Volume � (Length)(Width)(Thickness)

The total length of rebar is calculated as follows:

The lap is 18 inches (36 � 0.5 in) or 1.5 feet. The number of 20-foot
bars is calculated using Eq. (4-6) as follows:

�Number �
5,520 ft

(20 ft � 1.5 ft)
� 299 each

Length � 28 bars(100 ft/bar) � 68 bars(40 ft/bar) � 5,520 ft
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EXCEL QUICK TIP 5-7

Wire Mesh–Reinforced Slab on Grade

The volume of concrete and the number of rolls/sheets of
wire mesh needed for a slab on grade are set up in a
spreadsheet by entering the data and formatting the cells
as follows:

A B C
1 Slab Length 100 ft
2 Slab Width 40 ft
3 Slab Thickness 4 in
4 Waste 12 %
5 Wire Mesh Length 150 ft
6 Wire Mesh Width 5 ft
7 Wire Mesh Lap 6 in
8
9 Area 4,000 sft

10 Volume 55.31 cyd
11 Wire Mesh 7 each

EXAMPLE 5-9

Determine the number of 150-foot by 5-foot rolls of wire mesh that
would be needed for the slab in Example 5-8 if the #4 rebar were re-
placed by wire mesh. The wire mesh will need to be lapped 6 inches.

Solution: Run the rolls the long direction in the slab. Using the
row and column method, determine the number or rows of wire
mesh needed to cover the 40-foot width of the slab using Eq. (4-12)
as follows:

The number of columns is calculated using Eq. (4-15) as follows:

The number of rolls is calculated using Eq. (4-18) as follows:

�Number � (9 rows)(0.67 columns) � 6.03 rolls

NumberColumns �
100 ft

(150 ft � 0.5 ft)
� 0.67 columns

NumberRows �
40 ft

(5 ft � 0.5 ft)
� 9 rows

RAISED SLABS
The estimating of raised slabs is similar to the estimating of
slabs on grade, with two exceptions. First, the thickness of
the slab may vary because the bottom of the slab is poured
over an intentionally uneven surface (such as a metal deck)
and because the structure supporting the slab may sag under
the weight of the concrete, making the slab thicker at the
center of the spans than near the supports. To account for
the uneven surface of the deck, the average slab thickness
must be determined.

For the metal deck shown in Figure 5-18, the average
thickness is determined by the following equation:

(5.1)

where

T � Distance from Top of Slab to Top of Metal Deck

W1 � Width of the Metal Deck Cell at the Top

W2 � Width of the Metal Deck Cell at the Bottom

D � Depth of the Metal Deck Cell

S � Spacing of the Metal Deck Cells

TAve � T �
(W1 � W2)(D)

2S

FIGURE 5-18 Metal Deck

The following formulas need to be entered into the
associated cells:

Cell Formula

B10 =B1*B2

B11 =(B1*B2*(B3/12)/27)*(1+B4/100)

B12 =ROUNDUP((ROUNDUP(B1*12/B5+1,0)*
B2+ROUNDUP(B2*12/B5+1,0)*B1)/
(B7-B8*(B6/8)/12),0)

The data for the slab is entered in Cells B1 through B8. The
data shown in the foregoing figure is from Example 5-8.

The following formulas need to be entered into the
associated cells:

Cell Formula

B9 =B1*B2

B10 =(B1*B2*(B3/12)/27)*(1+B4/100)

B11 =ROUNDUP(ROUNDUP(2*B2/(B6-B7/
12),0)/2*B1/(B5-B7/12),0)

The formula for Cell B11 rounds the number of rows up
to the nearest half row. The data for the slab is entered in
Cells B1 through B7. The data shown in the foregoing
figure is from Example 5-9.
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FIGURE 5-19 Metal Deck Dimensions

EXAMPLE 5-10

A 100-foot by 50-foot by 3-inch-thick slab is poured over the metal
deck shown in Figure 5-19. The depth of the slab is measured from
the top of the slab to the top of the metal deck. Determine the aver-
age thickness of the slab and the number of yards of concrete
needed to pour the slab. Add 10% waste.

Solution: The average thickness is determined using Eq. (5-1) as
follows:

The volume of concrete is calculated as follows:

Add the waste using Eq. (4-22) as follows:

�Volumewith Waste � (59.80 yd3)a1 �
10

100
b � 65.78 yd3

� (100 ft)(50 ft)(3.875 in)a 1 ft

12 in
ba 1 yd3

27 ft3b � 59.80 yd3

Volume � (Length)(Width)(Thickness)

TAve � 3 in �
(4 1>2 in �  2 1>2 in)(1 1>2 in)

2 � 6 in
� 3.875 in

The amount of concrete needed to account for the sag is
a function of how much a structure deflects under the
weight of the concrete as it is being poured. This additional
concrete is treated in the same manner as waste; identify
the historical amount of concrete needed to account for the
sag as a percentage of the estimated volume of concrete.
Typically, sag adds 10% to 15% to the amount of concrete
needed to pour the slab.

The second way that estimating raised slabs differs
from estimating slabs on grade is that the bottom of the
slab must be formed. There are three basic ways to form
the bottom of the slab. The first is to form the bottom of the
slab with removable forms with a structural support that
are removed after the concrete has cured to the point that it
can support its own weight. In this case, the cost of the
forms and supporting structure is often based on the square
footage of the slab. A second way is to use a self-support-
ing metal deck as the form. In this case, the metal deck and
the building structure that supports it remain as part of the
building after the construction of the slab is complete. The
metal deck and supporting structure are included in the
materials needed for the construction of the building. The
third way is to use a metal deck that is not capable of sup-
porting the weight of the concrete, which must be sup-
ported until the concrete has cured to the point that it can
support its own weight, as is the case with composite slabs.
When the concrete has cured, the support structure is re-
moved, leaving the metal deck and concrete. In this case
the support structure is included in the forming, and the
metal deck is included in the materials needed for the con-
struction of the building.

STAIRS
The volume of concrete needed for stairs can be estimated by
determining the cross-sectional area of the stairs and multi-
plying the cross-sectional area by the width of the stairs as
shown in the following example.

EXAMPLE 5-11

Determine the volume of concrete needed to construct the stairs in
Figure 5-20.

Solution: The cross-sectional area of the stairs can be treated as a
parallelogram and seven triangles as shown in Figure 5-21.

The area of the parallelogram equals the length of two of the
parallel sides multiplied by the perpendicular distance between the
two sizes and is calculated as follows:

The area of the triangles is one-half the base times the height mul-
tiplied by the number of stairs. The area of the seven triangles is
calculated as follows:

Area � (7 ea)a1

2
b(10 in)(7 in)a 1 ft

12 in
b2

� 1.70 ft2

Area � (6.5 in)(5.25 ft)a 1 ft

12 in
b � 2.84 ft2

EXCEL QUICK TIP 5-8

Concrete Slab on Metal Deck

The volume of concrete needed for a concrete slab on a
metal deck similar to Figure 5-18 is set up in a spreadsheet
by entering the data and formatting the cells as follows:

The following formula needs to be entered into
Cell B9:

=B1*B2*((B3+(B5+B6)*B4/(2*B7))/12)/27*

(1+B8/100)

The data for the slab is entered in Cells B1 through B8. The
data shown in the foregoing figure is from Example 5-10.

A B C
1 Slab Length 100 ft
2 Slab Width 50 ft
3 T 3.00 in
4 D 1.50 in
5 W1 2.50 in
6 W2 4.50 in
7 S 6.00 in
8 Waste 10 %
9 Volume 65.78 cyd
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FIGURE 5-21 Stair Cross-Sectional Area

The cross-sectional area is 4.54 square feet (2.84 ft2 � 1.70 ft2). The
volume is calculated as follows:

�

SAMPLE TAKEOFF FOR
THE RESIDENTIAL GARAGE
A sample takeoff from a set of plans is shown in the follow-
ing example.

Volume � (4.54 ft2)(5 ft)a 1 yd3

27 ft3b � 0.84 yd3

EXAMPLE 5-12

Determine the concrete, rebar, and forms needed to pour the foot-
ings, foundation wall, and interior concrete slab for the residential
garage given in Appendix F. Add 5% waste for the footings and
foundation wall and 10% waste for the floor slab. The continuous
rebar is to be lapped 18 inches and is ordered in 20-foot lengths.

Solution: The dimensions for the concrete footing are shown in
Figure 5-22.

The footing length and volume of concrete needed to pour the
footing are calculated as follows:

Add the waste using Eq. (4-22) as follows:

The length of 10-inch-high forms needed for the footing is shown
in Figure 5-23.

The length of the forms needed to pour the footing is calcu-
lated as follows:

The footing requires three #4 continuous bars, for a total length of
247 feet (3 � 82.33 ft). The number of 20-foot bars is calculated
using Eq. (4-6) as follows:

Number �
247 ft

(20 ft � 1.5 ft)
� 14 each

� 168 ft

� 1 ft 8 in � 5 ft

� 23 ft 8 in � 21 ft 8 in � 23 ft 8 in � 3 ft 4 in

Length � 27 ft � 25 ft � 27 ft � 5 ft � 1 ft 8 in � 3 ft 4 in

Volumewith Waste � (4.24 yd3)a1 �
5

100
b � 4.45 yd3

� (82.33 ft)(10 in)(20 in)a 1 ft

12 in
b2a 1 yd3

27 ft3b � 4.24 yd3

Volume � (Length)(Width)(Thickness)

� 82 ft 3 in � 82.33 ft

Length � 3 ft 4 in � 27 ft � 21 ft 8 in � 27 ft � 3 ft 4 in

FIGURE 5-20 Stairs
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FIGURE 5-22 Length of Footings

FIGURE 5-23 Length of Footing Forms
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The short leg of the #5 dowels will run from a point 3 inches in-
side the footing to the center of the footing. The short leg will be
7 inches long (20 in>2 � 3 in). The long leg will run from a point
3 inches above the bottom of the footing to 2 inches below the
top of the 24-inch-high foundation wall. The long leg will be
29 inches long (10 in � 3 in � 24 in � 2 in). The dowels only
need to be located in the footing where there is a foundation wall
above the footing. The length of the foundation wall is calculated
as follows:

The number of dowels is calculated using the following equation:

The 5 in this equation is to account for the end condition for all five
of the wall segments. The foundation wall consists of the 2-foot-
high by 8-inch-wide wall around the perimeter of the garage and
the 14-inch-high by 8-inch-wide frost wall under the garage door.
The volume of concrete needed for the foundation wall is calcu-
lated as follows:

Add the waste using Eq. (4-22) as follows:

Two-foot-high forms are used to form both the foundation wall
and the frost wall. The length of the forms needed is calculated as
follows:

The area of the forms needed is calculated as follows:

Four #4 bars of rebar are needed in the foundation wall and frost
wall. The length of the rebar is calculated as follows:

The number of 20-foot-long bars needed is calculated using Eq. (4-6)
as follows:

Eighteen-inch by 18-inch L-shaped #4 dowels are needed between
the frost wall and the floor slab. The number of dowels is calculated
using Eq. (4-1) as follows:

Number �
(16 ft)(12 in/ft)

16 in
� 1 � 13 each

Number �
389.32 ft

(20 ft � 1.5 ft)
� 21 each

Length � 4(81.33 ft � 16 ft) � 389.32 ft

Length � (194 ft 8 in)(2 ft) � 390 ft2

� 194 ft 8 in

� 24 ft 8 in � 22 ft 8 in

Length � 26 ft � 24 ft � 26 ft � 24 ft � 24 ft 8 in � 22 ft 8 in

Volumewith Waste � (4.48 yd3)a1 �
5

100
b � 4.70 yd3

� (120.88 ft3)a 1 yd3

27 ft3b � 4.48 yd3

� (16 ft)(14 in)(8 in)a 1 ft

12 in
b2

� (81.33 ft)(2 ft)(8 in)a 1 ft

12 in
b

Volume � (Length)(Width)(Height)

Number �
Distance

Spacing
� 5 �

(81.33 ft)(12 in/ft)

16 in
� 5 � 66 each

� 81 ft 4 in � 81.33 ft

Length � 3 ft 4 in � 26 ft � 22 ft 8 in � 26 ft � 3 ft 4 in

The length of the wall that needs anchor bolts equals the length of
the wall less the width of the 3-foot-wide door. The number of an-
chor bolts with nuts and washers is calculated using the following
equation:

In addition, four HPAHD22 hold-downs are needed at the front
of the garage. The floor slab extends from the inside of the foun-
dation wall around the perimeter of the garage except at the over-
head door, where it extends to the exterior of the wall. At the over-
head door the floor slab is thickened. The concrete for the interior
slab without the concrete at the overhead door is calculated as
follows:

The cross-sectional area of the slab at the overhead door is shown
in Figure 5-24. The cross-sectional area is calculated as follows:

The volume of concrete at the overhead door is calculated as follows:

The volume of concrete without waste is 7.20 cubic yards (6.90 yd3

� 0.30 yd3). Add the waste using Eq. (4-22) as follows:

The area that needs to be finished is calculated as follows:

The quantities needed for the garage, grouped by the cost codes in
Appendix B, are shown in Table 5-2. �

Area � (24 ft 8 in)(22 ft 8 in) � (16 ft)(8 in) � 570 ft2

Volumewith Waste � (7.20 yd3)a1 �
10

100
b � 7.92 yd3

� 0.30 yd3

Volume � (Area)(Length) � (0.5 ft2)(16 ft)a 1 yd3

27 ft3b

� 72 in2a 1 ft

12 in
b2

� 0.5 ft2

Area � (8 in)(4 in) � 0.5(12 in � 8 in)(4 in)

� 6.90 yd3

� (24 ft 8 in)(22 ft 8 in)(4 in)a 1 ft

12 in
ba 1 yd3

27 ft3b
Volume � (Length)(Width)(Thickness)

Number �
Distance

Spacing
� 5 �

(81.33 ft � 3 ft)

2 ft
� 5 � 45 each

FIGURE 5-24 Cross Section at Overhead Door
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TABLE 5-2 Quantities for Residential Garage

03-200 Rebar

#4 � 20� rebar (footings) 14 ea

70 � 29� L-dowels (footings) 66 ea

#4 � 20� rebar (foundation) 21 ea

18� � 18� L-dowels (foundation) 13 ea

1/2� � 10� anchor bolt (foundation) 45 ea

1/2� nut (foundation) 45 ea

1/2� washer (foundation) 45 ea

HPAHD22 hold-downs 4 ea

03-300 Footings and Foundation—Labor

10�-high footing forms 168 ft

Install continuous rebar 20� 14 ea

Install dowels 66 ea

Pour footings 4.50 yd3

2�-high foundation forms 390 ft2

03-300 Footings and Foundation—Labor

Install continuous rebar 20� 21 ea

Install dowels 13 ea

Install anchor bolt 45 ea

Pour foundation 4.75 yd3

03-310 Footings and Foundation—Concrete

3,500-psi concrete (footings) 4.50 yd3

3,500-psi concrete (foundation) 4.75 yd3

03-320 Slab/Floor Labor

Pour slab 8.00 yd3

Finish slab 570 ft2

03-330 Slab/Floor Concrete

4,000-psi concrete (slab) 8.00 yd3

CONCLUSION
Concrete consists of the concrete materials, forms, and
rebar. The amount of concrete materials needed is deter-
mined by the cubic yard. The amount of forms needed
may be calculated by the lineal foot, square foot, or each.
Forms need to be included on both sides of the concrete
member. When calculating the square footage of forms,
the area should be based on the height of the forms
rather than the height of the concrete member. Short
pieces of rebar are determined by the number of pieces,
and continuous bars are determined by the number of
shorter bars of rebar.

PROBLEMS
1. How many cubic yards of concrete are required to con-

struct a 100-foot-long by 30-inch-wide by 12-inch-
thick continuous footing? Include 8% waste. Concrete
must be ordered in quarter-yard increments.

2. Determine the length of forms needed for Problem 1.

3. The footing in Problem 1 has four #4 continuous bars.
The rebar is lapped 18 inches. Determine the number
of 20-foot-long bars that needs to be ordered for the
footing.

4. How many cubic yards of concrete are required to con-
struct a 75-foot-long by 24-inch-wide by 10-inch-thick
continuous footing? Include 10% waste. Concrete must
be ordered in quarter-yard increments.

5. Determine the length of forms needed for Problem 4.

6. The footing in Problem 4 has three #4 continuous bars.
The rebar is lapped 21 inches. Determine the number
of 20-foot-long bars that needs to be ordered for the
footing.

7. How many cubic yards of concrete are required to con-
struct a 145-foot-long by 4-foot-wide by 18-inch-thick
continuous footing? Include 5% waste. Concrete must
be ordered in quarter-yard increments.

8. Determine the square footage of forms needed for
Problem 7.

9. How many cubic yards of concrete are required to con-
struct 11 each 36-inch by 36-inch by 18-inch-thick
spread footings? Include 5% waste. Concrete must be
ordered in quarter-yard increments.

10. Determine the square footage of forms needed for
Problem 9.

11. How many cubic yards of concrete are required to con-
struct 20 each 32-inch by 32-inch by 14-inch-thick
spread footings? Include 5% waste. Concrete must be
ordered in quarter-yard increments.

12. Determine the square footage of forms needed for
Problem 11.

13. How many cubic yards of concrete are required to con-
struct a 250-foot-long by 8-foot-high by 8-inch-thick
concrete wall? Include 5% waste. Concrete must be or-
dered in quarter-yard increments.

14. Determine the square footage of forms needed for
Problem 13.
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15. How many cubic yards of concrete are required to con-
struct a 59-foot-long by 4-foot-high by 6-inch-thick
concrete wall? Include 5% waste. Concrete must be or-
dered in quarter-yard increments.

16. Determine the square footage of forms needed for
Problem 15.

17. How many cubic yards of concrete are required to con-
struct 7 each 16-inch by 16-inch by 10-foot-high con-
crete columns? Include 5% waste. Concrete must be or-
dered in quarter-yard increments.

18. Determine the square footage of forms needed for
Problem 17.

19. How many cubic yards of concrete are required to
construct 5 each 24-inch by 12-inch by 8-foot-high
concrete columns? Include 5% waste. Concrete must
be ordered in quarter-yard increments.

20. Determine the square footage of forms needed for
Problem 19.

21. How many cubic yards of concrete are required to con-
struct 14 each 22-inch-diameter, 12-foot-high concrete
columns? Include 5% waste. Concrete must be ordered
in quarter-yard increments.

22. How many cubic yards of concrete are required to con-
struct 36 each 12-inch-diameter, 10-foot-high concrete
columns? Include 5% waste. Concrete must be ordered
in quarter-yard increments.

23. How many cubic yards of concrete are required to con-
struct a 100-foot by 50-foot by 4-inch-thick concrete
slab? Include 8% waste. Concrete must be ordered in
quarter-yard increments.

24. Determine the length of forms needed for Problem 23.

25. The slab in Problem 23 is reinforced with #4 rebar at 16
inches on center. The rebar is lapped 18 inches.
Determine the number of 20-foot-long bars of #4 rebar
needed to reinforce the slab.

26. The slab in Problem 23 is reinforced with wire mesh,
which is lapped 6 inches. Determine the number of 5-foot
by 150-foot rolls of wire mesh needed to reinforce the slab.

27. How many cubic yards of concrete are required to con-
struct a 75-foot by 40-foot by 5-inch-thick concrete
slab? Include 10% waste. Concrete must be ordered in
quarter-yard increments.

28. Determine the length of forms needed for Problem 27.

29. The slab in Problem 27 is reinforced with #4 rebar at 24
inches on center. The rebar is lapped 12 inches.
Determine the number of 20-foot-long bars of #4 rebar
needed to reinforce the slab.

30. The slab in Problem 27 is reinforced with wire mesh,
which is lapped 6 inches. Determine the number of 5-
foot by 10-foot sheets of wire mesh needed to reinforce
the slab.

31. A 75-foot by 75-foot by 4-inch-thick slab is poured over
the metal deck shown in Figure 5-25. The depth of the
slab is measured from the top of the slab to the top of
the metal deck. Determine the average thickness of the
slab and the number of yards of concrete needed to
pour the slab. Include 12% waste.

32. How many cubic yards of concrete are needed to con-
struct the continuous footing shown in Figures 5-26
and 5-27? Include 10% waste.

FIGURE 5-25 Metal Deck Dimensions

FIGURE 5-26 Footing Plan
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FIGURE 5-27 Wall Section

FIGURE 5-28 Column Detail

33. How many lineal feet of forms are needed to construct
the continuous footing shown in Figures 5-26 and 5-27?

34. Determine the rebar that needs to be ordered to con-
struct the continuous footing shown in Figures 5-26
and 5-27. The rebar is to be lapped 18 inches.

35. How many cubic yards of concrete are needed to con-
struct the spread footings shown in Figures 5-26 and
5-28? Include 10% waste.

36. How many lineal feet of forms are needed to construct
the spread footings shown in Figures 5-26 and 5-28?

37. Determine the rebar that needs to be ordered to con-
struct the spread footings shown in Figures 5-26 and 5-28.
Provide 3 inches of cover in the footing and 2 inches of
cover in the column. The ties are to be ordered with the
column rebar.

38. How many cubic yards of concrete are needed to con-
struct the wall shown in Figures 5-26 and 5-27? Add
10% waste.

39. How many square feet of forms are needed to construct
the wall shown in Figures 5-26 and 5-27?

40. Determine the rebar that needs to be ordered to con-
struct the wall shown in Figures 5-26 and 5-27? The
rebar is to be lapped 18 inches and 2 inches of cover is
required.

41. How many cubic yards of concrete are needed to con-
struct the columns shown in Figures 5-26 and 5-28?
Add 5% waste.

42. How many square feet of forms are needed to construct
the columns shown in Figures 5-26 and 5-28?

43. Determine the rebar that needs to be ordered to con-
struct the columns shown in Figures 5-26 and 5-28. Two
inches of cover is required on the ties.

44. Determine the concrete, rebar, and forms needed to
pour the footings, foundation wall, and interior con-
crete slab for the Johnson Residence given in Appendix
F. Add 5% waste for the footings and foundation wall
and 10% waste for the floor slab. The continuous rebar
is to be lapped 18 inches and will be ordered in 20-foot
lengths.

45. Determine the concrete, rebar, and forms needed to
pour the footings and interior concrete slab for the West
Street Video project given in Appendix F. Add 5% waste
for the footings and 10% waste for the floor slab. The
continuous rebar is to be lapped 18 inches and will be
ordered in 20 foot lengths.

46. Set up Excel Quick Tip 5-1 in Excel.
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47. Set up Excel Quick Tip 5-2 in Excel.

48. Set up Excel Quick Tip 5-3 in Excel.

49. Set up Excel Quick Tip 5-4 in Excel.

50. Set up Excel Quick Tip 5-5 in Excel.

51. Set up Excel Quick Tip 5-6 in Excel.

52. Set up Excel Quick Tip 5-7 in Excel.

53. Set up Excel Quick Tip 5-8 in Excel.

54. Modify Excel Quick Tip 5-3 to allow the height to be en-
tered in feet and inches.

55. Modify Excel Quick Tip 5-6 to allow the length and
width to be entered in feet and inches.

56. Modify Excel Quick Tip 5-7 to allow the length and
width to be entered in feet and inches.

57. Modify Excel Quick Tip 5-8 to allow the length and
width to be entered in feet and inches.



In this chapter you will learn how to apply the principles in
Chapter 4 to block and structural brick walls and brick veneer.
This chapter includes sample spreadsheets that may be used in
the quantity takeoff.

For this chapter we divide masonry into two cate-
gories: (1) block and structural brick and (2) brick
veneer.

Block and structural brick walls are characterized by
being self-supporting and are often used as structural walls.
The components of block and structural brick walls include
the block or brick, reinforcement, mortar, grout, imbeds, in-
sulation used to fill the ungrouted cells, and anchor bolts.
Commonly the wall is reinforced with rebar running in the
vertical and horizontal directions. The bars running in the
vertical direction are commonly spaced at 32 inches on cen-
ter, and additional bars are often added around openings.
This vertical rebar often consists of a single bar (often a #5
bar) placed in a column of cells that are grouted solid.
Because the rebar is placed in the cells of the blocks or
bricks, the rebar spacing must match the block or brick cell
spacing. When placing the blocks, they must be lifted over
the top of the rebar and then placed on the blocks in the
wall, or the rebar must be stabbed down the cells after the
block is placed. This requires that the rebar be ordered in
short lengths. One way to do this is to reinforce the walls in
4-foot increments with rebar that is 4 feet long plus the
length of the lap.

Bars running in the horizontal direction are placed in a
bond beam. The bond beam consists of a block with a channel
in the top of the block, similar to the one shown in Figure 6-1.
The rebar is placed in the channel, and the cells of the blocks
are grouted solid. A typical bond beam consists of two #4 bars.
The bond beams are commonly spaced 4 feet on center.
Additional bond beams are located at the top of the walls and
over openings. Like rebar in concrete, the rebar in the bond

beam must be lapped. The combination of the lapping and
the short lengths of rebar used to reinforce the wall vertically
greatly increases the amount of rebar needed to complete the
job. The estimator should read the specifications carefully and
fully understand the reinforcing requirements for the project
when preparing a bid.

Brick veneer is brick applied to the surface of a wood or
block wall as an architectural finish material. The compo-
nents of brick veneer include the brick, weather barrier
(when installed over wood walls), lintels, and ties. Wood
walls should be covered with a weather barrier, such as as-
phalt-impregnated felt or Tyvek, prior to installation of
brick veneer. The weather barrier may be installed by the
framers or the mason. The quantity takeoff of weather barri-
ers is covered in Chapter 9. Steel lintels must be used to sup-
port the brick wherever the brick is not supported by a con-
crete wall. The lintels consist of steel angles that are fastened
to a structural wall or imbedded in the brick veneer. The
brick veneer must be attached to the surface of the wood or
block wall. This is often done with masonry ties. The ma-
sonry ties are secured to wood walls with nails and are se-
cured to block and brick by placing the ties in the mortar
joints. In addition, masonry ties should be included at the
corners to strengthen the corners.

Let’s look at estimating block and structural brick walls.
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BLOCK AND STRUCTURAL
BRICK WALLS
The work package for block and structural brick walls in-
cludes the block or brick, reinforcement, mortar, grout, in-
sulation (such as perlite) used to fill the ungrouted block
cavities, and imbeds and anchor bolts used to connect the
building components to the wall. The block and brick walls
are treated as a sheet good. When calculating the number
of blocks, the estimator must separate standard blocks
from bond beam blocks and other specialty shapes. The
vertical rebar is treated as a counted item; the horizontal
rebar is treated as a linear good. The mortar and grout are
treated as quantity-from-quantity goods. The best way to
determine the quantities of mortar and grout is based on
past experience. Finally, anchor bolts and imbeds are
treated as counted items. Steel imbeds and anchor bolts
through structural steel are often provided by the struc-
tural steel supplier and need to be delivered before the
structural steel so they can be installed by the mason.
Anchor bolts not through the structural steel also need to
be provided so they can be installed by the mason. The
quantity takeoff for a block or structural brick wall is
shown in the following example.

EXAMPLE 6-1

Determine the number of blocks, the rebar, mortar, and grout
needed to construct a 100-foot-long by 10-foot-high block wall con-
structed of 7 5>8-inch-high by 7 5>8-inch-wide by 15 5>8-long
blocks. The mortar joint is 3>8 inch thick. The wall is horizontally
reinforced by bond beams at 4 feet on center containing two #4 bars.
The wall is vertically reinforced with #5 rebar at 32 inches on center.
All rebar is to be lapped 30 bar diameters. The rebar for the bond
beam is to be delivered to the site in 20-foot lengths, and the vertical
rebar is to be delivered cut to the required lengths. Allow 5 cubic feet
of mortar and 17 cubic feet of grout per 100 square feet of block
wall. Anchor bolts are placed in the top of the wall at 32 inches on
center. How many of the blocks need to be bond beam blocks?

Solution: Using Eq. (4-14) to find the number of rows, we get the
following:

Using Eq. (4-17) to get the number of columns, we get the following:

Using Eq. (4-18), we calculate the number of blocks as follows:

Three bond beams are required: one at 4 feet, one at 8 feet, and one
at 10 feet. The number of bond beam blocks is calculated using
Eq. (4-18) as follows:

The project requires a total of 1,125 blocks of which 225 are bond
beam blocks. For the bond beams, six 100-foot-long #4 bars are

Number � (3 rows)(75 columns) � 225 blocks

Number � (15 rows)(75 columns) � 1,125 blocks

NumberColumns �
(100 ft)(12 in/ft)

(15 5>8 in � 3>8 in)
� 75 columns

NumberRows �
(10 ft)(12 in/ft)

(7 5>8 in � 3>8 in)
� 15 rows

required for a total length of 600 feet. The lap for the #4 rebar is
30 bar diameters, or 15 inches (30 � 0.5 in). The number of 20-
foot bars is calculated using Eq. (4-6) as follows:

The number of vertical bars is calculated using Eq. (4-1) as follows:

The required lap on the vertical bar is 18.75 inches (30 � 0.625 in).
Each of these vertical bars will be ordered in the following incre-
ments: 5 feet 7 inches long for the first 4 feet of the wall and 5 feet
11 inches long for the remaining 6 feet of the wall. If we ordered
5-foot 7-inch-long bars for the second four feet of the wall and
1-foot 11-inch-long bars for the last two feet of the wall, the last
bar will lap the second to last bar 19 of its 23-inch length. It is
more economical and is just as easy to replace the last two bars
with a single bar. The wall will require 39 #5 rebar 5 feet 7 inches
long and 39 #5 rebar 5 feet 11 inches long. The area of the wall is
calculated as follows:

The number of cubic yards of mortar needed is calculated as follows:

The number of cubic yards of grout needed is calculated as follows:

The number of anchor bolts is calculated using Eq. (4-1) as follows:

�

The estimator must take openings into account when
estimating block walls. Openings reduce the number of
blocks needed and may require the use of special blocks
around the openings. Additional rebar is often placed
around the opening as shown in Figure 6-2. The blocks
above the opening are often supported by multiple bond
beams. To allow the bond beams to provide a finished sur-
face, a lintel block with a flat bottom, as shown in Figure 6-3,
may be used for the bottom bond beam. Other specialty
blocks, such as the bullnose block shown in Figure 6-3, may
be used on the sides of the opening.

When estimating block, the estimator must determine
the additional reinforcing for the opening, the specialty
blocks needed, and the quantity of standard block that can
be deducted for the opening. Block waste around the open-
ing is greater than for other areas of the wall; therefore, the
estimator cannot determine the number of standard blocks
to be deducted by simply deducting the area of the opening
and the specialty blocks. Many estimators do not deduct any
blocks for small openings and deduct only half of the area
for medium-sized openings. In addition to accounting for
the opening, support for the bond beam needs to be provided

Number �
(100 ft)(12 in/ft)

32 in
� 1 � 39 each

Volume � (1,000 ft2)a 17 ft3

100 ft2ba 1 yd3

27 ft3b � 6.3 yd3

Volume � (1,000 ft2)a 5 ft3

100 ft2ba 1 yd3

27 ft3b � 1.9 yd3

Area � (100 ft)(10 ft) � 1,000 ft2

Number �
(100 ft)(12 in/ft)

32 in
� 1 � 39 each

Number �
600 ft

(20 ft � 1.25 ft)
� 32 each
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FIGURE 6-2 Reinforcing around an Opening

FIGURE 6-3 Specialty Blocks

until the grout in the beam has cured. The following exam-
ple looks at how to take openings into account when esti-
mating block and structural brick walls.

EXAMPLE 6-2

Determine the number of specialty blocks needed, additional
rebar required, and the number of standard blocks that can be de-
ducted when building a wall with the opening shown in Figure 6-
2. The wall is constructed of 7 5>8-inch-high by 7 5>8-inch-wide
by 15 5>8-inch-long blocks with a 3>8-inch mortar joint. The
blocks at the top and bottom of the opening are to be the lintel
block shown in Figure 6-3, with the blocks at the bottom placed
upside down to provide a smooth surface. Bullnose blocks are to
be provided at the sides of the opening. A 2 � 8 wood frame with
a center support will be provided to support the bond beam until
the grout has cured.

Solution: Lintel blocks are needed at the top and bottom of the
opening. The number of lintel blocks needed for the top of the
opening is calculated by dividing the width of the opening by the
length of the block including one mortar joint as follows:

Blocks �
40 in

(15 5>8 in � 3>8 in)
� 2.5 blocks
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The number of blocks will be rounded up to three blocks. Three lintel
blocks are needed at the top and three at the bottom for a total of six.

Bullnose blocks are needed at both sides. The number of bull-
nose blocks needed for one of the sides of the opening is calculated
by dividing the height of the opening by the height of the block in-
cluding one mortar joint as follows:

Twelve bullnose blocks are needed.
The horizontal #6 rebar above and below the opening extends

about a block and a half (about 24 in) beyond the opening in both di-
rections; therefore, three #6 bars 7 foot 4 inches (2 ft � 3 ft 4 in � 2 ft)
long are needed. Bond beam blocks are needed for each of these
bars. The number of bond beam blocks that are needed for one bar
is calculated by dividing the length of the bar by the length of the
block including one mortar joint as follows:

Blocks �
88 in

(15 5>8 in � 3>8 in)
� 5.5 blocks

Blocks �
(4 ft)(12 in/ft)

(7 5>8 in � 3>8 in)
� 6 blocks

Six bond beam blocks are needed for each bar for a total of 18
blocks. Six of these blocks are replaced with lintel blocks; therefore,
12 bond beam blocks are needed.

The vertical rebar to the sides of the opening extends about
two blocks above and one block below the opening: therefore, six
#6 bars 6 feet (16 in � 4 ft � 8 in) long are needed.

The number of standard blocks that can be deducted for the
opening is determined by multiplying the number of full blocks
that can fit in the width of the opening and the number of full
blocks that can fit in the height of the opening. In this case two full
blocks can fit in the width of the opening and six full blocks can fit
in the height of the opening. The number of standard blocks that
can be deducted is 12 (6 � 2). The bond beam blocks, bullnose
blocks, and lintel blocks will replace standard blocks. A total of 42
(12 � 12 � 12 � 6) standard blocks may be deducted from the es-
timate for the opening.

Two 3-foot 4-inch-long 2 � 8s are needed for the top and bot-
tom of the opening. Three 3-foot 9-inch-long (4 ft � 1 1>2 in �
1 1>2 in) 2 � 8s are needed for the sides and center of the opening.
Order three 8-foot-long 2 � 8s. �

A B C
1 Wall Length 100 ft
2 - in
3 Wall Height 10 ft
4 - in
5 Block Length 15.625 in
6 Block Height 7.625 in
7 Joint Thickness 0.375 in
8 Bond Beam Spacing 48 in
9 Number of Horizontal Bars per Bond Beam 2 ea

10 Splice Length for Bond Beam Rebar 15.00 in
11 Order Length of Horizontal Rebar 20.00 ft
12 Vertical Rebar Spacing 32 in
13 Splice Length for Vertical Rebar 18.75 in
14 Mortar 5 cft/100 sft
15 Grout 17 cft/100 sft
16
17 Rows 15 ea
18 Columns 75 ea
19 Bond Beams 3 ea
20 Standard Blocks 900 ea
21 Bond Beam Blocks 225 ea
22 Horizontal Rebar 32 ea
23 Length of Vertical Rebar (1) 67 in
24 Vertical Rebar (1) 39 ea
25 Length of Vertical Rebar (2) 71 in
26 Vertical Rebar (2) 39 ea
27 Mortar 1.9 cyd
28 Grout 6.3 cyd

EXCEL QUICK TIP 6-1

Block Wall

The numbers of standard blocks, bond beam blocks, bars
of horizontal rebar, and bars of vertical rebar needed for a

block wall are set up in a spreadsheet by entering the data
and formatting the cells as follows:
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BRICK VENEER
The work package for brick veneer includes brick, weather
barrier, lintels, mortar, and ties. The brick is treated as sheet
goods, the ties are treated as a counted item, and the mortar
is treated as a quantity-from-quantity good. The best way to
determine the quantities of mortar is based on past experi-
ence. The brick veneer must bear on a footing, foundation
wall, or a steel ledger created by bolting a steel angle iron to
the wall. Steel angle iron is used as lintels over window and
door openings and must be bolted to the wall or bear on the
brick at the sides of the opening. A common bearing dis-
tance for steel lintels is 4 inches. The quantity takeoff for
brick walls is shown in the following example.

EXAMPLE 6-3

Determine the number of bricks, corrugated masonry ties, and
mortar needed to face a wall 50 feet long by 10 feet high. The brick is
2 1>2 inches high by 3 1>2 inches wide by 11 1>2 inches long. Allow
for a 1>2-inch mortar joint. The spacing between the ties is to be
18 inches measured vertically and 36 inches measured horizontally.
Historically, 10.2 cubic feet of mortar is required per 100 square feet
of brick.

Solution: Using Eq. (4-14) to find the number of rows of brick, we
get the following:

NumberRows �
(10 ft)(12 in/ft)

(2 1>2 in � 1>2 in)
� 40 rows

Using Eq. (4-17) to get the number of columns, we get the
following:

Using Eq. (4-18), we calculate the number of blocks needed as
follows:

The ties are laid out in rows and columns along the wall. A column
will occur every 3 feet along the wall. The columns will consist of
seven rows of ties, which are located at 1 foot 6 inches, 3 feet, 4 feet
6 inches, 6 feet, 7 feet 6 inches, 9 feet, and 9 feet 9 inches above the
base of the wall. A tie is not needed at the base of the wall because it
will bear on a footing, foundation, or steel lintel. Using Eq. (4-1) to
determine the number of vertical columns of ties, we get the fol-
lowing:

The number of ties is 126 (7 rows � 18 columns). The area of the
wall is calculated as follows:

The number of cubic yards of mortar needed is calculated as
follows:

�Volume � (500 ft2)a10.2 ft3

100 ft2 ba 1 yd3

27 ft3 ˛b � 1.9 yd3

Area � (50 ft)(10 ft) � 500 ft2

Number �
50 ft

3 ft
� 1 � 18 columns

Number � (40 rows)(50 columns) � 2,000 blocks

NumberColumns �
(50 ft)(12 in/ft)

(11 1>2 in � 1>2 in)
� 50 columns

In this spreadsheet, if the distance between the second-
to-last bond beam and the top of the wall is 24 inches or
less, the last vertical bar runs from the third-to-last bond
beam to 1 inch below the top of the wall. The Length of
Vertical Rebar (1) and the Vertical Rebar (1) are used to cal-
culate the vertical rebar for the wall from the bottom of the
wall to the second-to-last or third-to-last bond beam. The
Length of Vertical Rebar (2) and the Vertical Rebar (2) are
used to calculate the last vertical rebar for the wall, which
runs from the second-to-last or third-to-last bond beam to
1 inch below the top of the wall. The following formulas
need to be entered into the associated cells:

Cell Formula

B17 =ROUNDUP((B3*12+B4)/(B6+B7),0)

B18 =ROUNDUP((B1*12+B2)/(B5+B7),0)

B19 =ROUNDUP((B3*12+B4)/B8,0)

B20 =B17*B18-B21

B21 =B18*B19

B22 =ROUNDUP((B1+B2/12)*B19*B9/
(B11-B10/12),0)

B23 =ROUNDUP(B8+B13,0)

B24 =IF((B3*12+B4-(B19-1)*B8)>24,
(B19-1)*B26,(B19-2)*B26)

B25 =IF((B3*12+B4-(B19-1)*B8)>24,
B3*12+B4-(B19-1)*B8-1,B3*
12+B4-(B19-2)*B8-1)

B26 =ROUNDUP((B1*12+B2)/B12,0)+1

B27 =(B1+B2/12)*(B3+B4/12)*B14/
(100*27)

B28 =(B1+B2/12)*(B3+B4/12)*B15/(100*27)

The data for the block wall is entered in Cells B1 through
B15. Cell B20 determines the total number of blocks and
subtracts the number of bond beam blocks. Cell 23 deter-
mines the length of the vertical rebar for all of the wall except
the wall above the second-to-last or third-to-last bond beam
by adding the lap on the vertical rebar to the spacing be-
tween the bond beams. Cell C25 determines the length of the
last vertical rebar for the wall by determining the distance
between the second-to-last or third-to-last bond beam and
the top of the wall and subtracting 1 inch. An IF function is
used in Cells B24 and B25 to determine if the last vertical bar
runs from the second-to-last or third-to-last bond beam
based upon the distance between the second-to-last bond
beam and the top of the wall. The data shown in the forego-
ing figure is from Example 6-1 and is formatted using the
comma style, which replaces zeros with dashes.
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EXAMPLE 6-4

A 4-foot wide opening is placed in a brick wall. The top of the
opening is supported by an L3 � 3 � 3>8 steel lintel. Determine the
minimum length of the lintel.

Solution: Allow 4 inches of bearing on both sides of the lintel. The
lintel needs to be 4 feet 8 inches (4 in � 4 ft � 4 in) long. �

EXCEL QUICK TIP 6-2

Brick Wall

The numbers of bricks and brick ties needed for a brick
wall are set up in a spreadsheet by entering the data and
formatting the cells as follows:

The following formulas need to be entered into the asso-
ciated cells:

A B C
1 Wall Length 50 ft
2 - in
3 Wall Height 10 ft
4 - in
5 Brick Length 11.500 in
6 Brick Height 2.500 in
7 Joint Thickness 0.500 in
8 Vertical Tie Spacing 12 in
9 Horizontal Tie Spacing 24 in

10 Mortar 10.2 cft/100 sft
11
12 Rows of Brick 40 ea
13 Columns of Brick 50 ea
14 Bricks 2,000 ea
15 Rows of Ties 10 ea
16 Columns of Ties 26 ea
17 Ties 260 ea
18 Mortar 1.9 cyd

Cell Formula

B12 =ROUNDUP((B3*12+B4)/(B6+B7),0)

B13 =ROUNDUP((B1*12+B2)/(B5+B7),0)

B14 =B12*B13

B15 =ROUNDUP((B3*12+B4)/B8,0)

B16 =ROUNDUP((B1*12+B2)/B9,0)+1

B17 =B15*B16

B18 =(B1+B2/12)*(B3+B4/12)*B10/
(100*27)

The data for the brick wall is entered in Cells B1 through
B10. The data shown in the foregoing figure is from
Example 6-6 and is formatted using the comma style,
which replaces zeros with dashes.

CONCLUSION
Masonry consists of block, structural brick, and brick ve-
neer. The work package for a block or structural brick wall
includes the block or brick, reinforcement, mortar, grout, in-
sulation, and imbeds and anchor bolts used to connect the
building components to the wall. The block and brick are
treated as a sheet good. The vertical rebar is treated as a
counted item; the horizontal rebar is treated as a linear good.
The mortar and grout are treated as quantity-from-quantity
goods. The work package for brick veneer includes brick,
weather barrier, lintels, and ties. The brick is treated as a
sheet good, the ties are treated as a counted item, and the
mortar is treated as a quantity-from-quantity good.

PROBLEMS
1. Determine the number of 7 5>8-inch-high by 5 5>8-

inch-wide by 15 5>8-inch-long concrete blocks required
to complete a wall 80 feet long by 12 feet high. Allow for
a 3>8-inch mortar joint.

2. How many of the blocks in Problem 1 need to be bond
beam blocks if the bond beams are 4 feet on center?

3. Determine the number of 20-foot-long #4 bars needed
for the wall in Problem 1 if the wall is horizontally re-
inforced by bond beams at 4 feet on center. Each bond

beam has two each #4 bars. The rebar is to be lapped
18 inches.

4. Determine the quantity and length of vertical rebar
needed for the wall in Problem 1 if the wall is vertically
reinforced with #5 rebar at 32 inches on center. The
rebar is to be lapped 18 inches.

5. Determine the quantity of mortar needed for the wall in
Problem 1 if 4.5 cubic feet of mortar is required per 100
square feet of block.

6. Determine the quantity of grout needed for the wall
in Problem 1 if 18 cubic feet of grout is required per
100 square feet of block.

7. Determine the number of 7 5>8-inch-high by 5 5>8-inch-
wide by 15 5>8-inch-long concrete blocks required to
complete a wall 160 feet long by 8 feet high. Allow for a
3>8-inch mortar joint.

8. How many of the blocks in Problem 7 need to be bond
beam blocks if the bond beams are 4 feet on center?

9. Determine the number of 20-foot-long #4 bars needed
for the wall in Problem 7 if the wall is horizontally rein-
forced by bond beams at 4 feet on center. Each bond
beam has two #4 bars. The rebar is to be lapped 18 inches.

10. Determine the quantity and length of vertical rebar
needed for the wall in Problem 7 if the wall is vertically
reinforced with #5 rebar at 32 inches on center. The
rebar is to be lapped 18 inches.



11. Determine the quantity of mortar needed for the wall
in Problem 7 if 4.3 cubic feet of mortar is required per
100 square feet of block.

12. Determine the quantity of grout needed for the wall
in Problem 7 if 16 cubic feet of grout is required per
100 square feet of block.

13. Determine the number of specialty blocks needed, addi-
tional rebar required, and number of standard blocks
that can be deducted when building a wall with the
opening shown in Figure 6-4. The wall is constructed of
7 5>8-inch-high by 7 5>8-inch-wide by 15 5>8-inch-long
blocks with a 3>8-inch mortar joint. The blocks at the
top and bottom of the opening are to be the lintel block
shown in Figure 6-3, with the blocks at the bottom
placed upside down to provide a smooth surface.
Bullnose blocks are to be provided at the sides of the
opening. A 2 � 8 wood frame with a center support will
be provided to support the bond beam until the grout
has cured.

14. Determine the number of specialty blocks needed, addi-
tional rebar required, and number of standard blocks
that can be deducted when building a wall with the
openings shown in Figure 6-5. The wall is constructed of
7 5>8-inch-high by 7 5>8-inch-wide by 15 5>8-inch-long

blocks with a 3>8-inch mortar joint. The blocks at the
top and bottom of the openings are to be the lintel block
shown in Figure 6-3, with the blocks at the bottom
placed upside down to provide a smooth surface.
Bullnose blocks are to be provided at the sides of the
opening. A 2 � 8 wood frame will be provided to sup-
port the bond beam until the grout has cured.

15. Determine the number of 2 1>2-inch-high by 3 1>2-
inch-wide by 11 1>2-inch-long bricks that are required
to face a wall 80 feet long by 4 feet high. Allow for a 1>2-
inch mortar joint.

16. Determine the number of corrugated masonry ties that
are required to complete the wall in Problem 15. The
spacing between the ties is to be 12 inches measured
vertically and 24 inches measured horizontally.

17. Determine the quantity of mortar needed for the wall in
Problem 15 if 9.7 cubic feet of mortar is required per
100 square feet of brick.

18. Determine the number of 3 1>2-inch-high by 3 1>2-
inch-wide by 11 1>2-inch-long bricks that are required
to face a wall 40 feet long by 8 feet high. Allow for a 1>2-
inch mortar joint.

19. Determine the number of corrugated masonry ties that
are required to complete the wall in Problem 18. The

Masonry 95

FIGURE 6-4 Opening



spacing between the ties is to be 24 inches measured
vertically and 24 inches measured horizontally.

20. Determine the quantity of mortar needed for the wall in
Problem 18 if 7.5 cubic feet of mortar is required per
100 square feet of brick.

21. Determine the brick veneer and ties needed to complete
the Johnson Residence given in Appendix F.

22. Determine the block and rebar needed to complete the
West Street Video project given in Appendix F. The con-
tinuous rebar is to be lapped 18 inches and will be or-
dered in 20-foot lengths.

23. Set up Excel Quick Tip 6-1 in Excel.

24. Set up Excel Quick Tip 6-2 in Excel.
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FIGURE 6-5 Openings



In this chapter you will learn how to apply the principles in
Chapter 4 to steel beams and columns, joists, metal deck,
trusses, stairs and handrails, and miscellaneous steel. This
chapter includes sample spreadsheets that may be used in the
quantity takeoff.

The steel for a building is fabricated and primed at a
steel fabrication shop and shipped to the site for
erection, where it is bolted or field welded together.

Because it is fabricated off-site and assembled on-site, care-
ful dimensioning and fabrication of each piece must occur
for the steel to fit together when it is erected at the jobsite.
Many structural engineers leave the actual design of the con-
nections of the steel up to the fabricator, allowing fabricators
to use the connection type that is most economical for them.
When the design of the connectors is left up to the fabrica-
tor, the fabricator is required to submit shop drawings to the
structural engineer for approval. The engineer will check to
make sure the connections are adequate and approve the de-
sign or require changes to the shop drawings.

TYPES OF STRUCTURAL
STEEL
Buildings can be constructed of different types of steel.
The most common type of steel is A36 carbon steel. Other
types of steel include A529 carbon steel; A440 high-
strength steel; A441 high-strength, low-alloy steel; A572
high-strength, low-alloy steel; A242 corrosion-resistant,
high-strength, low-alloy steel; and A588 corrosion-resistant,
high-strength, low-alloy steel. The estimator needs to
make sure he or she knows what type of structural steel
the engineer is specifying.

COMMON SHAPES FOR
STRUCTURAL STEEL
There are a number of different shapes of structural steel
used in the construction of buildings. Common shapes are
shown in Figure 7-1.

The properties, dimensions, and weight per foot for
steel shapes can be found in the Manual of Steel Construction
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published by the American Institute of Steel Construction.
Commonly used shapes include the following:

Wide-Flange Beam: Wide-flange beams are used as
columns, girders, and beams. A wide-flange beam is
designated by a “W” followed by its nominal depth
and weight per foot. For example, a W12 � 40 beam
has a nominal depth of 12 inches and a weight of 40
pounds per foot. Its actual depth is 11.94 inches.

American Standard Beams: American standard beams
are sometimes used as girders and beams. An
American Standard beam is designated by an “S” fol-
lowed by its nominal depth and weight per foot. For
example, an S18 � 70 beam has a nominal depth of
18 inches and a weight of 70 pounds per foot. The ac-
tual depth of this beam is also 18 inches.

American Standard Channels: American standard
channels are used as beams and stair stringers. An
American Standard channel is designated by a “C”
followed by its nominal depth and weight per foot.
For example, a C12�30 channel has a nominal depth
of 12 inches and a weight of 30 pounds per foot. The
actual depth of this channel is also 12 inches.

Structural Tees: Structural tees are used in steel
trusses. Structural tees are created by cutting a beam
along the length of the beam’s web to create a “T”
shape. A structural tee cut from a wide-flange beam is
designated by “WT” followed by its nominal depth
and weight per foot. A structural tee cut from an
American standard beam is designated by “ST” fol-
lowed by its nominal depth and weight per foot. For
example, a WT4 � 29 structural tee has a nominal
depth of 4 inches and a weight of 29 pounds per foot.
Its actual depth is 4.375 inches.

Angles: Angles are used as cross-bracing, lintels,
ledgers, and connectors and in the construction of
steel trusses. Angles are designated by an “L” followed
by the length of its longest leg, the length of the other
leg, and the thickness of the angle. For example, an
L5 � 3 � 1>2 would have one leg with a length of
5 inches, one leg with a length of 3 inches, and a thick-
ness of 1>2 inch. The weight of this angle is 12.8 pounds
per foot.

Structural Tubing: Structural tubing is used as columns
and cross-bracing and in the construction of steel
trusses. Structural tubing is designated by the length
of its longest cross-sectional axis, the length of the
other axis, and the thickness of the wall of the tubing.
For example, a 4 � 4 � 1>2 tube steel would have a
cross section of 4 inches by 4 inches and would have a
wall thickness of 1>2 inch. Its weight is 21.63 pounds
per foot.

Pipe: Pipe is used for columns. Pipe is designated by
“Pipe” followed by the nominal diameter of the pipe
and the type of pipe. For example, Pipe 4 Std. has a
nominal diameter of 4 inches and is the standard

weight of pipe. This pipe has a wall thickness of
0.237 inches, a weight of 10.79 pounds per foot, an
inside diameter of 4.026 inches, and an outside di-
ameter of 4.500 inches.

Plate: Plate steel is used as base plates and connectors.
Plate steel is designated by the thickness. The weight
of plate steel is about 490 pounds per cubic foot.

EXAMPLE 7-1

Determine the weight in pounds for a 50-foot-long W30 � 90.

Solution: The W30 � 90 weighs 90 pounds per foot. The beam
weighs 4,500 pounds (50 ft � 90 lb/ft). �

BEAMS, GIRDERS,
AND COLUMNS
When estimating beams, girders, and columns, it is impor-
tant to estimate not only the number of structural steel
members needed, but also the weight of each member so the
crane can be properly sized. General contractors often esti-
mate beams, girders, and columns based on the weight of the
steel members and add a percentage to the cost to allow for
connectors and bolts because the design of the connector is
often left up to the steel fabricator. Estimates by steel fabrica-
tors must include the connectors and bolts. Let’s look at esti-
mating the structural steel members.

The length of a structural steel member depends on
how it is connected to the surrounding steel members.
Common connections are shown in Figure 7-2, along with
how the connection is drawn on the structural steel plan
view for all but the splice connections. The first type of
connection is a splice and is used to connect two shorter
beams or columns into a longer beam or column. The next
type of connection is a beam-to-beam (or beam-to-
girder) connection, in which the end of one beam is joined
to the web of another beam. In this case the beam being
connected must run to the web of the beam that it is being
connected to. The next three types of connections are con-
nections used to connect a beam to a column made from a
wide flange beam. In one type of connection the beam is
connected to the web of the column. In this case the beam
must run to the web of the column. In another type of
connection the beam is connected to the flange of the col-
umn. In this case the beam must run to the flange of the
column. In the third type of connection the beam rests on
a plate attached to the top of the column. In this case the
beam runs over the top of the column to the edge of the
building or the next column. Making a connection to a
tubular-steel column is similar to connecting the beam to
the flange of the column, with the beam running to the ex-
terior of the column or connecting the beam to a plate at-
tached to the top of the column.

The following example shows how the lengths of indi-
vidual structural steel members are calculated.
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FIGURE 7-2 Typical Connections

EXAMPLE 7-2

Prepare a structural steel materials list for the roof-framing plan
shown in Figure 7-3. The columns are 15 feet high. The flange
width for the W18 � 86 is 11 1>8 inches. The properties of the
columns are given in Table 7-1. How many pounds of steel need to
be purchased for the roof? What is the weight of the heaviest struc-
tural steel member needed to construct the roof?

Solution: One C12 � 30 is needed to the right of the opening. The
channel will run from the flange of the W12 � 45 beams and has a
length of approximately 10 feet. The weight of the channel is 300
pounds (10 ft � 30 lb/ft).

Four W12 � 45 beams are needed between the C1 and C2
columns. These beams will run from the flange of column C1 to the

flange of column C2. The length of the beam is 30 feet less the
depth of column C1 less half the depth of column C2, or 28.5 feet
(30 ft - 12 in - 12 in/2). The weight of one of these beams is 1,283
pounds (28.5 ft � 45 lb/ft).

FIGURE 7-3 Steel Framing Plan

TABLE 7-1 Column Properties

Flange

Column Size Width (in) Depth (in)

C1 W12 � 40 8.005 11.94

C2 W12 � 53 9.995 12.06
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Six W12 � 45 beams are needed between the W18 � 86 girders
and the W18 � 175 girder. These beams will run from the web of the
two girders. The web of the W8 � 86 will be set back 5 9>16 inches
(11.125 in/2) so that the flange of the W8 � 86 is flush with the
flange of the W12 � 40 column. The length of the beam is approx-
imately 30 feet less 5 inches, or 29 feet 7 inches. The weight of one
of these beams is 1,331 pounds (29.583 ft � 45 lb/ft).

Two W18 � 86 girders are needed to go between the C1
columns. These girders will run from the webs of the two columns.
The length of the girder is approximately 40 feet less the flange
width of the column, or 39 feet 4 inches (40 ft - 8 in). The weight of
one of these girders is 3,383 pounds (39.33 ft � 86 lb/ft).

One W18 � 175 girder is needed to go between the C2
columns. This girder will run from the webs of the two columns.

The length of the girder is approximately 40 feet less the flange
width of the column, or 39 feet 2 inches (40 ft - 10 in). The weight
of one of these girders is 6,854 pounds (39.167 ft � 175 lb/ft).

Four 15-foot-long C1 columns are needed and will weigh 600
pounds (15 ft � 40 lb/ft) each. Two 15-foot-long C2 columns are
needed and will weigh 795 pounds (15 ft � 53 lb/ft) each. The total
weight of the steel is calculated as follows:

The heaviest member is the W18 � 175 girder at 6,854 pounds. �

Weight � (31,028 lb)a 1 ton

2,000 lb
˛˛b � 15.514 tons

� 1(6,854 lb) � 4(600 lb) � 2(795 lb)

Weight � 1(300 lb) � 4(1,283 lb) � 6(1,331 lb) � 2(3,383 lb)

A B C D E F G
1
2 Feet Inches lb/ft Each Total
3 C12x30 1 10 - 30.0 300 300
4 W12x45 4 28 6 45.0 1,283 5,130
5 W12x45 6 29 7 45.0 1,331 7,988
6 W18x86 2 39 4 86.0 3,383 6,765
7 W18x175 1 39 2 175.0 6,854 6,854
8 W12x40 4 15 - 40.0 600 2,400
9 W12X53 2 15 - 53.0 795 1,590

10 31,027
11 15.51

Weight (lb)
Weight (tons)

Item
Length Weight

Quantity

EXCEL QUICK TIP

Structural Steel

Calculating the weight of structural steel is set up in a spreadsheet by entering the data and formatting the cells as follows:

The following formulas need to be entered into the as-
sociated cells:

Cell Formula

F3 =(C3+D3/12)*E3

G3 =F3*B3

G10 =SUM(G3:G9)

G11 =G10/2000

The formula in Cell F3 will need to be copied to Cells F4
through F9, and the formula in Cell G3 will need to be
copied to Cells G4 through G9. The data for the steel is en-
tered in Cells A3 through E9. The data shown in the fore-
going figure is from Example 7-2 and is formatted using
the comma style, which replaces zeros with dashes.

When estimating steel connections, the estimator must
account for the angles, plate steel, bolts, and welds that make
up most connectors. Estimating connectors is shown in the
following example.

EXAMPLE 7-3

Determine the items needed for the connection shown in Figure 7-4.

Solution: The connection will require 9 inches of L3 � 3 � 1>4
angle, 11 inches of 1>4 fillet weld, and three 1>2-inch-diameter
A325 bolts. �

JOISTS AND JOIST GIRDERS
Floor-framing systems are often made up of joists and joist
girders. The requirements for joists and joist girders are set
by the Steel Joist Institute. The most common joist in use is
the K-series joist, which is designated as shown in Figure 7-5.
The joist in Figure 7-5 is a 24-inch-deep K-series joist with a
section number of three. The larger the section number, the
stronger is the joist.

Joist girders are joists that are designed to support joists
just as girders support beams. Joist girders are designated as
shown in Figure 7-6. The number of spaces is one more
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than the number of joists that are supported by the joist
girder. The load on each panel point is the load applied by
each joist in kips, where 1 kip is 1,000 pounds. If the joist
girder supports two joists at each point, one on each side of
the joist girder, the load on each panel point is the com-
bined load applied by the pair of joists. The joist girder in
Figure 7-6 is a 24-inch-deep joist girder with five spaces
(supporting four joists), and each panel point supports 8 kips,
or 8,000 pounds.

When estimating joists and joist girders, the estimator
needs to determine the number of joist and joist girders,
their lengths, and their weights. The approximate weights for
joists and joist girders are given in the Catalogue of Standard
Specifications and Load Tables for Steel Joists and Joist Girders
published by the Steel Joist Institute. Estimating joists and
joist girders is shown in the following example.

EXAMPLE 7-4

Prepare a steel joist materials list for the roof-framing plan shown
in Figure 7-7. The approximate weights of the joists are given in
Table 7-2. What is the total number of pounds of steel joists that
need to be purchased for the roof? What is the weight of the heavi-
est steel joist needed to construct the roof?

FIGURE 7-4 Connection Details

FIGURE 7-5 Joist Designation

FIGURE 7-6 Joist Girder Designation

FIGURE 7-7 Joist Framing Plan

TABLE 7-2 Joist Weights

Joist Approximate Weight (lb/ft)

24K12 16.0

24G8N8K 47.0

36G8N16K 73.0
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Solution: Four 24K12 joists are needed to run between the columns.
The length of these joists is approximately 38 feet 6 inches (40 ft - 12 in
- 6 in). They weigh 616 pounds (38.5 ft � 16.0 lb/ft) each. The num-
ber of joists in one bay is calculated using Eq. (4-3) as follows:

Fourteen (2 bays � 7 joists/bay) 24K12 joists are needed to run be-
tween the joist girders. The length of these joists is approximately
40 feet, and each joist weighs 640 pounds (40 ft � 16.0 lb/ft). Two
24G8N8K joist girders are needed. The length of each of these joist
girders is 38 feet (40 ft - 12 in - 12 in). These girders weigh 1,786
pounds (38 ft � 47.0 lb/ft) each. One 36G8N16K is needed. The
length of this joist girder is 38 feet (40 ft - 12 in - 12 in). This girder
weighs 2,774 pounds (38 ft � 73.0 lb/ft). The total weight of the
steel is calculated as follows:

The heaviest member is the 36G8N16K joist girder at 2,774 pounds.
�

METAL DECK
Metal deck is often placed on top of the steel framing and steel
joists. The deck comes in sheets and is treated as a sheet good.
Estimating metal deck is shown in the following example.

EXAMPLE 7-5

Determine the amount of metal deck that needs to be purchased to
construct the floor shown in Figure 7-7. The deck comes in panels 4
feet wide by 40 feet long. The panels must be lapped 6 inches.

Solution: Each panel will run the entire width of the building;
therefore, the number of rows is one. Determine the number of
columns of metal deck that are needed using Eq. (4-15) as follows:

The number of sheets of metal deck needed is 23 (1 rows �
23 columns). �

NumberColumns �
80 ft

(4 ft � 0.5 ft)
� 23 columns

� (17,770 lb)a 1 ton

2,000 lb
˛b � 8.885 tons

Weight � 4(616 lb) � 14(640 lb) � 2(1,786 lb) � 1(2,774 lb)

Number �
40 ft

5 ft
� 1 � 7 each

STEEL TRUSSES
Like all other items constructed of steel, steel trusses are es-
timated by listing the steel components, including connec-
tors, needed to construct the steel truss. Estimating the
components needed to fabricate a steel truss is shown in the
following example.

EXAMPLE 7-6

Determine the items, including welds, needed to fabricate the steel
truss shown in Figure 7-8. The right side of the truss is the same as
the left side of the truss. What is the estimated weight of the truss if
an L3 � 3 � 1>2 weighs 9.4 pounds per foot?

Solution: Two 13-foot 5-inch-long WT4 � 20 (a tee cut from a
wide-flange beam) are needed for the top cord and one 24-foot-long
WT4 � 20 is needed for the bottom cord. Four 2-foot 9-inch-long
L3 � 3 � 1>2 (one pair on each side of the truss), four 6-foot 2-inch-
long L3 � 3 � 1>2 (one pair on each side of the truss), and two
5-foot 9-inch-long L3 � 3 � 1>2 (one pair at the center of the truss)
are needed for the truss. Two 20-inch-long V-welds (one on each
side of the truss) and one 3-inch-long V-weld are needed, for a total
of 43 inches of V-weld. Each L3 � 3 � 1>2 will need 7 inches (2 in
� 3 in � 2 in) of fillet weld on each end. There are 10 L3 � 3 �
1>2s; therefore, 140 inches (10 � 7 in/end � 2 ends) of fillet weld are
needed. The estimated weight of the truss is found by multiplying
the length of the steel members by their weights as follows:

�

STAIRS AND HANDRAIL
Like all other items constructed of steel, steel stairs and
handrail are estimated by listing the steel components, includ-
ing connectors, needed to construct the steel stairs and
handrail. Estimating the components needed to fabricate a
steel stairs and handrail is shown in the following example.

Weight � (2,477 lb)a 1 ton

2,000 lb
b � 1.24 tons

� 4 � 6 ft 2 in � 2 � 5 ft 9 in)(9.4 lb/ft)

Weight � (2 � 13 ft 5 in � 24 ft)(40 lb˛/˛ft) � (4 � 2 ft 9 in

EXCEL QUICK TIP 7-2

Metal Deck Floor or Roof

The number of sheets of metal deck needed for a floor or
roof is set up in a spreadsheet by entering the data and
formatting the cells as follows:

A B C
1 Length of Building 40 ft
2 Width of Building 80 ft
3 Length of Sheet 40 ft
4 Width of Sheet 4 ft
5 Lap at Ends of Sheet - in
6 Lap at Sides of Sheet 6 in
7
8 Number of Rows 1.00 ea
9 Number of Columns 23 ea

10 Number of Sheets 23 ea

The following formulas need to be entered into the
associated cells:

Cell Formula

B8 =B1/(B3-B5/12)

B9 =ROUNDUP(B2/(B4-B6/12),0)

B10 =ROUNDUP(B8*B9,0)

The data for the metal deck is entered in Cells B1
through B6. This spreadsheet assumes that the waste
from one column can be used on the next column and
that the lengths of the sheets are run parallel to the length
of the building. The data shown in the foregoing figure is
from Example 7-5 and is formatted using the comma
style, which replaces zeros with dashes.
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EXAMPLE 7-7

Determine the steel materials needed to fabricate the steel stairs
and handrail shown in Figure 7-9. The treads are 1.5 inches deep,
and the stairs are 4 feet wide. The depth of the flange on the chan-
nel is 3 inches, and the thickness of the web is 5>16 inch. The
handrail is on one side of the stairs only.

Solution: Two C12 � 20.7 are needed for the stair stringers
along with two 1>2-inch-diameter by 2-inch-long bolts and two
1>2-inch-diameter by 3-inch-long expansion bolts to fasten the
stringers. The half-inch plates will be 2 11>16 inches (3 in - 5>16 in)
wide. Two 19-inch by 2 11>16-inch by 1>2-inch plate, two 6-inch by
2 11>16-inch by 1>2-inch plate, and two 10-inch by 2 11>16-inch by

1>2-inch plate are needed at the ends of the channel. Six stair pans,
each bent from 15-inch (1.5 in � 12 in � 1.5 in) by 4-foot pieces of
1>8-inch-thick steel plate, are needed. Seven 6-inch by 4-foot pieces
of 1>8-inch-thick steel plate are needed for the risers. Two 42-inch-
long, two 11-inch-long, one 10-inch-long, and six 7 feet 5-inch-long
1 1>2-inch steel pipes and two 90° 1 1>2-inch elbows are needed for
the railing. �

MISCELLANEOUS STEEL
Miscellaneous items including imbeds, angles used to sup-
port the deck, timber brackets, and so forth are estimated in
the same manner as steel trusses and stairs.

FIGURE 7-8 Steel Truss

FIGURE 7-9 Steel Stairs
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CONCLUSION
The steel for a building is fabricated and primed at a steel
fabrication shop and shipped to the site for erection, where it
is bolted or field welded together. Common steel shapes used
in the construction industry include the wide-flange beam,
American standard beams, American standard channels,
structural tees, angles, structural tubing, pipe, and plate. The
estimator must determine the weight of the steel needed for
the construction of the building to price the steel and the
weight of each steel member to properly size the crane. This
is done by determining the weights of the individual compo-
nents and adding them together.

PROBLEMS
1. Determine the weight in pounds of the following struc-

tural steel members:

a. A 20-foot-long W16 � 40

b. A 15-foot-long S18 � 54.7

c. A 25-foot-long W21 � 62

d. A 20-foot-long C7 � 9.8

e. A 20-foot-long C15 � 50

2. Prepare a structural steel materials list for the roof-framing
plan shown in Figure 7-10. The columns are 18 feet high.
The flange width for the W16 � 77 is 10 1>4 inches. The
properties of the columns are given in Table 7-3.

3. Determine the number of pounds of steel that need to
be purchased for the roof in Problem 2.

4. What is the weight of the heaviest structural steel mem-
ber needed to construct the roof in Problem 2?

5. Prepare a structural steel materials list for the roof-framing
plan shown in Figure 7-11. The columns are 20 feet high.
The flange width for the W12 � 35 is 6 1>2 inches and
the flange width for the W12 � 72 is 12 inches. The
properties of the columns are given in Table 7-4.

FIGURE 7-10 Steel Framing Plan

TABLE 7-3 Column Properties for Problems 2 to 4

Flange

Column Size Width (in) Depth (in)

C1 W12 � 40 8.005 11.94

C2 W12 � 50 8.080 12.19

TABLE 7-4 Column Properties for Problems 5 to 7

Flange

Column Size Width (in) Depth (in)

C1 W8 � 28 6.535 8.06

C2 W12 � 40 8.005 11.94

C3 W12 � 53 9.995 12.06

6. Determine the number of pounds of steel that need to
be purchased for the roof in Problem 5.

7. What is the weight of the heaviest structural steel mem-
ber needed to construct the roof in Problem 5?

8. Prepare a steel joist materials list for the roof-framing
plan shown in Figure 7-12. The approximate weights of
the joists are given in Table 7-5.

9. Determine the total weight of the joists needed to com-
plete the roof-framing plan shown in Problem 8.

10. What is the weight of the heaviest joist needed to con-
struct the roof in Problem 8?

11. Prepare a steel joist materials list for the roof-framing
plan shown in Figure 7-13. The approximate weights of
the joists are given in Table 7-6.

12. Determine the total weight of the joists needed to com-
plete the roof-framing plan shown in Problem 11.
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TABLE 7-5 Joist Weights for Problems 8 to 10

Joist Approximate Weight (lb/ft)

24K10 13.1

32G8N5K 30.0

32G8N10K 57.0

13. What is the weight of the heaviest joist needed to con-
struct the roof in Problem 11?

14. Determine the amount of metal deck that needs to be
purchased to construct the floor shown in Figure 7-12.
The deck comes in panels 4 feet wide by 40 feet long.
The panels must be lapped 6 inches.

15. Determine the amount of metal deck that needs to be
purchased to construct the floor shown in Figure 7-13.
The deck comes in panels 4 feet wide by 40 feet long.
The panels must be lapped 6 inches at the sides and 12
inches at the ends.

FIGURE 7-11 Steel Framing Plan

FIGURE 7-12 Steel Joist Plan

TABLE 7-6 Joist Weights for Problems 11 to 13

Joist Approximate Weight (lb/ft)

18K9 10.2

24G6N6K 23.0

24G6N12K 45.0
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FIGURE 7-13 Steel Joist Plan

16. Determine the items, including welds, needed to fabri-
cate the steel truss shown in Figure 7-14. The right side
of the truss is the same as the left side of the truss.

17. What is the estimated weight of the truss in Figure 7-14
if an L3 � 2 � 1>2 weighs 7.7 pounds per foot?

18. Determine the items, including connectors, needed to
fabricate the steel truss shown in Figure 7-15. The right
side of the truss is the same as the left side of the truss.

19. What is the estimated weight of the truss in Figure 7-15
if an L3 � 3 � 1>2 weighs 9.4 pounds per foot, an

L4 � 4 � 1>2 weighs 12.8 pounds per foot, and the
plate weighs 20.4 pounds per square foot?

20. Determine the structural steel, steel joist, and metal
deck needed to complete the West Street Video project
given in Appendix F.

21. Set up Excel Quick Tip 7-1 in Excel.

22. Set up Excel Quick Tip 7-2 in Excel.

23. Modify Excel Quick Tip 7-2 to allow the length and
width to be entered in feet and inches.

FIGURE 7-14 Steel Truss
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FIGURE 7-15 Steel Truss
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In this chapter you will learn how to apply the principles in
Chapter 4 to wood floor systems (wood sills, columns, beams,
joists, joist headers, trimmer, blocking, joist hangers, tongue
and groove sheeting), walls (top and bottom plates, studs,
headers, blocking, sheathing), roof-framing (trusses, rafters,
fascia, soffit), wood trim, and cabinetry. This chapter includes
sample spreadsheets that may be used in the quantity takeoff. It
also includes example takeoffs from the residential garage
drawings given in Appendix F.

Rough carpentry consists of framing the floors, walls,
and roof of the structure. A typical wood structure
is shown in Figure 8-1. Finish carpentry consists of

installing finish material including wood trim, shelving, and
handrails. Cabinetry includes the installation of cabinets and
countertops. We begin by looking at framing the building’s
floor system.

FLOOR SYSTEMS
The floor system consists of joists covered with OSB or ply-
wood sheathing and bears on sills, walls, or girders sup-
ported by posts. Sometimes 2� or 3� material is substituted
for the sheathing as is the case with wood decks. Let’s look at
each of the components of the floor system beginning with
the sill.

Sills
When the floor system is supported by concrete walls, the
floor system must be placed on a naturally durable wood
(for example, redwood) or pressure-treated wood sill. A
sealing material, such as Sill Seal, is often required to be
placed below the sill to prevent air infiltration between

the concrete wall and the wood sill. This sealing material
is provided with the lumber package and installed by the
framer. Wood sills are bid as linear components. The
quantity takeoff for wood sill is shown in the following
example.

EXAMPLE 8-1

The perimeter of the floor system in Figure 8-2 sits on a redwood
sill. Determine the number of 16-foot-long pieces of redwood that
are needed to complete the floor system.

Solution: The perimeter of the building is 132 feet (40 ft � 26 ft �
40 ft � 26 ft). The number of pieces is calculated using Eq. (4-7) as
follows:

�

Large quantities of sill plate are often purchased in
random lengths. When lumber is purchased in random
lengths the pricing is quoted in board feet. The quantity
takeoff of random-length wood sill is shown in the follow-
ing example.

EXAMPLE 8-2

How many board feet of sill are needed to complete the floor
system in Figure 8-2 if the sill is constructed of random lengths of
2 � 4 redwood?

Solution: From Example 8-1 the perimeter of the building is 132
feet. The number of board feet (bft) is calculated as follows:

��
(2 in)(4 in)(132 ft)

(12 in/ft)
� 88 bft

Board Feet �
(Depth)(Width)(Length)

(12 in/ft)

Number �
132 ft

16 ft
� 9 each

WOODS, PLASTICS,

AND COMPOSITES

CHAPTER EIGHT
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FIGURE 8-1 Typical Wood Structure

FIGURE 8-2 Floor-Framing Plan
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FIGURE 8-3 Web Stiffener

Posts and Girders
Posts and girders may be used to support a floor system and
open up the space below. The girder may consist of a glue-
laminated beam (GLB) or two or three 2�s nailed together.
The posts should be secured to footing using a framing an-
chor, such as a Simpson post base (PB), and should be se-
cured to the girder using a framing anchor, such as a
Simpson post cap (BC). Posts and framing hardware are bid
as counted items and girders are bid as linear components or
as counted items. The quantity takeoff for posts and girders
is shown in the following example.

EXAMPLE 8-3

Determine the materials needed to complete the posts and girder
supporting the floor joists in Figure 8-2. The posts are connected to
footings using a Simpson PB66 post base and are connected to the
girder using a Simpson BC6 post cap. The distance between the top
of the footing and the bottom of the girder is 7 feet. The posts are
equally spaced along the girder.

Solution: The 6 � 6 posts come in 8-foot lengths. Two 8-foot-
long 6 � 6 posts, two Simpson PB66 post bases, and two
Simpson BC6 post caps are needed. The posts are 13 feet 4 inches
(40 ft/3) on center; therefore, 14-foot-long 2 � 12s will be used
for the girder. Nine (3 spaces � 3) 14-foot-long 2 � 12s are
needed for the girder. �

Floor Joists
Floors are constructed of floor joists that span from bearing
wall or girder to bearing wall or girder. The floor joists may
be constructed of 2 � 6, 2 � 8, 2 � 10, or 2 � 12 lumber or of
engineered wood I-joists.

Engineer I-joists are gaining in popularity because
they can produce a superior-quality floor system at prices
similar to that of standard wood joists. Engineered I-joists
are available in lengths of up to 60 feet, which allows a sin-
gle joist to span across many of the bearing walls or girders
in a building, which decreases the bending of the floor
joist. Engineered I-joists may require blocking and web
stiffeners (a piece of wood on either side of the flange in
the space between the webs). A web stiffener is shown in
Figure 8-3. Short pieces of I-joists are often used as block-
ing. The manufacturer’s data should be consulted to deter-
mine the need for blocking and web stiffeners.

Joist headers are required at the ends of the joists. Joist
headers around the perimeter of the floor are often referred
to as rim joist or rim board. When using 2� lumber the
header is constructed of 2� lumber with the same depth as
the joists. Manufacturers of engineered I-joists produce en-
gineered wood products for use as joist headers.

Joist headers and trimmers are used when openings
are required in the floor system. The framing for a typical
opening is shown in Figure 8-4. The joist header is con-
structed of the same material used for the joists or the joist
header at the edge of the building. The joist header and
joist trimmers are required to be doubled if the opening is
greater than 4 feet wide. When the opening is greater than
6 feet wide the joist header is to be connected to the joist
trimmers with framing anchors.1 The location of the joist
trimmers may or may not line up with the standard joist
spacing. If the trimmer joist does not line up with the stan-
dard joist spacing, as is the case in Figure 8-4, more joists
will be needed than if the trimmer joist lined up with the
standard joist spacing.

The joists are doubled under bearing walls running
parallel to the joist including perimeter walls and may be
doubled under nonbearing walls running parallel to the
joists. The estimator must take into account the doubled
joist when performing the takeoff. Joists are taken off as a
counted item.

The joists must be blocked at specified intervals to
prevent them from rolling onto their sides. The joists
must also be blocked when the joists pass over walls to

EXCEL QUICK TIP 8-1

Board Foot Worksheet

The conversion of lineal feet to board feet is set up in a
spreadsheet by entering the data and formatting the cells
as follows:

The following formula needs to be entered into
Cell B5:

=B1*B2*B3/12

The data for lumber is entered in Cells B1 through B3. The
data shown in the foregoing figure is from Example 8-2.

A B C
1 Board Depth 2 in
2 Board Width 4 in
3 Board Length 132 ft
4
5 Board Feet 88.0 bft
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FIGURE 8-4 Framing for Opening in Floor

prevent the spread of fire. The blocking is usually con-
structed of the same material used for the joists or joist
headers. Joist blocking is taken off as a linear component.
The takeoff of the joists for a floor system is shown in the
following example.

EXAMPLE 8-4

Determine the materials needed to construct the joists for the floor
system shown in Figure 8-2. The joists are blocked over the girder
and at the midpoint, between the girder and the exterior wall on
joists over 8 feet long. The joist headers at the opening are attached
to the trimmer joists with Simpson U210-2 hangers.

Solution: Beginning with the 13-foot-long joists, the number of
joists needed to meet the spacing of 16 inches on center for the top
half of the drawing is calculated using Eq. (4-1) as follows:

The number of joists needed to meet the spacing of 16 inches on
center for the bottom half of the drawing located to the left of the
opening is calculated using Eq. (4-1) as follows:

The number of joists needed to meet the spacing of 16 inches on
center for the bottom half of the drawing located to the right of the
opening is calculated using Eq. (4-1) as follows:

A total of 58 (31 � 14 � 13) joists are needed to meet the spac-
ing requirements. Seven additional joists are needed to double
up joists already included in this number (4 for the ends of the
building, 1 at each side of the stairs, and 1 for the double joist

Number �
(15 ft)(12 in/ft)

16 in
� 1 � 13

Number �
(17 ft)(12 in/ft)

16 in
� 1 � 14

Number �
(40 ft)(12 in/ft)

16 in
� 1 � 31

under the wall on the left of the drawing). Two additional joists
are needed for the double joist under the wall on the right be-
cause the wall is not located above the joists used to meet the
spacing requirements. This brings the total number of joists to
67 (58 � 7 � 2). Fourteen-foot-long 2 � 12s will be ordered for
these joists.

The number of joists needed on each side of the building for
the joist header is calculated using Eq. (4-7) as follows:

Three additional 14-foot-long joists are needed as joist headers on
each side of the building. Four 8-foot-long joists are needed as joist
headers around the opening.

The joists above the opening are 3 feet 6 inches long (13 ft
� 3 ft � 6 ft 6 in). The number of joists is calculated using Eq. (4-3)
as follows:

Two 3-foot 6-inch-long joists can be cut from one 8-foot-long 2 � 12;
therefore, three more 8-foot-long 2 � 12s are needed. Six 3-foot-long
joists are needed below the opening. Three of these joists can be cut
from a 10-foot-long 2 � 12; therefore, two more 10-foot-long 2 � 12s
are needed.

Three rows of blocking are needed. The top row is located
in the top half of the drawing and is 40 feet long. The second
row is located over the girder and is 40 feet long. The third row
is located in the bottom half of the drawing and is not needed in
the opening. The length of blocking needed for this row is
32 feet (17 ft � 15 ft). A total of 112 feet (40 ft � 40 ft � 32 ft)
of blocking is needed. Order twelve 10-foot-long 2 � 12s for the
blocking.

Four Simpson U210-2 hangers are needed to attach the joist
headers to the trimmer joists.

Order seventy-three (67 �2 � 3) 14-foot-long 2 � 12s, four-
teen 10-foot-long 2 � 12s, and seven 8-foot-long 2 � 12s for the
floor and four Simpson U210-2 hangers. �

Number �
(8 ft)(12 in/ft)

16 in
� 6

Number �
40 ft

14 ft
� 3
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EXCEL QUICK TIP 8-3

Floor Sheathing

The number of sheets of T&G floor sheathing for a rec-
tangular floor is set up in a spreadsheet by entering the
data and formatting the cells as follows:

A B C
1 Building Length 40 ft
2 Building Width 26 ft
3
4 No. of Rows 7.00 ea
5 No. of Columns 5.00 ea
6
7 Sheathing 35.00 ea

Floor Sheathing
Commonly 23>32-inch T&G (tongue and groove) OSB (ori-
ented-strand board) or plywood is used as floor sheathing.
The use of T&G sheathing provides for a stiffer flooring sys-
tem with less squeaking than sheathing without tongues and
grooves. When using T&G sheathing, the estimator must
make sure that the sheathing can be cut in such a manner that
there is a tongue and a groove for each joint that runs per-
pendicular to the joists. This often limits the use of waste ma-
terial even if it is of sufficient size, because it lacks the proper
tongue or groove. Sheathing should be placed with the
longest direction perpendicular to the joists, and the sheets
should span at least three joists. Floor sheathing is commonly
glued and nailed with a slip-resistant nail, such as a ring-
shank nail, to minimize squeaking. The takeoff of the sheath-
ing for a floor system is shown in the following example.

EXAMPLE 8-5

Determine the number of 4-foot by 8-foot sheets of 23>32-inch
T&G OSB sheathing needed to construct the floor system shown in
Figure 8-2.

Solution: The number of rows is calculated using Eq. (4-13) as
follows:

NumberRows �
26 ft

4 ft
� 6.5

Because the sheathing is tongue and groove, the leftover half-sheet
cannot be used; therefore, seven rows are needed. The number of
columns is calculated using Eq. (4-16) as follows:

The number of sheets is calculated using Eq. (4-18) as follows:

�Number � (7 rows)(5 columns) � 35 sheets

NumberColumns �
40 ft

8 ft
� 5 columns

A B C D E F G
1
2 Building Length 40 ft 17 ft 15 ft
3 Joist Spacing 16 in 16 in 16 in
4 End Condition 1 1 1
5
6 Joists 31 ea 14 ea 13 ea
7
8 Additional Joists 9
9

10 Total # of Joists 67

Area 1 Area 2 Area 3

EXCEL QUICK TIP 8-2

Joists

The number of joists needed for a floor is set up in a spreadsheet by entering the data and formatting the cells as follows:

The following formulas need to be entered into the as-
sociated cells:

Cell Formula

B6 =ROUNDUP(B2*12/B3,0)+B4

B10 =B6+D6+F6+B8

After entering the formulas, Cell B6 must be copied to
Cells D6 and F6. This spreadsheet is designed for three
separate building areas. The data for the floor is entered

in Cells B2 through B4, D2 through D4, and F2 through
F4. If a joist is required at both ends of the floor area, a
“1” is entered as the end condition. If a joist is required at
only one end of the floor area, a “0” is entered as the end
condition. If joists are not required at either ends of the
floor area, a “�1” is entered as the end condition. The
number of additional joists needed for joist trimmers,
doubled joists, and joists that do not fall on the standard
spacing are entered in Cell B8. The data shown in the
foregoing figure is from Example 8-4 for the 14-foot-
long joists.
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EXCEL QUICK TIP 8-4

Decking

The number of board feet needed for a deck is set up in a
spreadsheet by entering the data and formatting the cells
as follows:

The following formulas need to be entered into the
associated cells:

Cell Formula

B8 =ROUNDUP(B2*12/(B4+B6),0)*B1

B9 =B3*B5*B8/12

The data for deck and lumber is entered in Cells B1
through B6. The data shown in the foregoing figure is
from Example 8-6 and is formatted using the comma
style, which replaces zeros with dashes.

A B C
1 Deck Length 20 ft
2 Deck Width 20 ft
3 Nominal Width 6 in
4 Actual Width 5.50 in
5 Nominal Thickness 3 in
6 Spacing between Boards - in
7
8 Lineal Feet 880 ft
9 Board Feet 1,320 bft

Wood Decks
In heavy timber construction and on outdoor decks, 2�
and 3� lumber laid flat is often used as a decking material in
lieu of OSB or plywood. The lumber may be laid with a space
between the boards or laid right next to each other. Wood
decks are treated as a sheet good. When purchasing random
lengths of decking, the length of the decking is assumed to
run the entire length of the deck. The takeoff of wood deck-
ing is shown in the following example.

EXAMPLE 8-6

How many board feet of 3 � 6 redwood decking are needed to con-
struct a 20-foot by 20-foot deck? The boards are to be placed with-
out any space between them.

Solution: The width of a 3 � 6 is 5 1>2 inches; therefore, the
boards are spaced 5 1>2 inches apart. Begin by finding the number
of lineal feet of 3 � 6 redwood needed for the deck, using the row
and column method. Let the rows be made up of one 20-foot-long
board. The number of columns is calculated using Eq. (4-16) as
follows:

The number of lineal feet of 3 � 6 boards is calculated by multiply-
ing the number of columns by their length as follows:

The number of board feet is calculated as follows:

��
(3 in)(6 in)(880 ft)

12 in/ft
� 1,320 bft

Board Feet �
(Thickness)(Width)(Lineal Feet)

12 in/ft

Lineal Feet � (20 ft/column)(44 columns) � 880 ft

NumberColumns �
(20 ft)(12 in/ft)

5 1>2 in
� 44 columns

WALLS
Walls consist of top and bottom plates, studs, headers, hold-
downs, blocking, and sheathing. Let’s look at each of these
components.

Top and Bottom Plates
When the wall is placed on concrete or masonry, the bottom
plate must be a naturally durable wood (for example, red-
wood) or pressure-treated wood. A sealing material, such as
Sill Seal, is often placed below the bottom plate of exterior
walls when the walls bear on concrete or masonry. When the
wall is placed on a wood floor, the bottom plate is of the
same lumber as the studs. For the bottom plate, the door
openings are not deducted from the length because the bot-
tom plate is run through the opening and is cut out after the
framing is complete. This helps ensure that the walls are
framed straight.

Bearing walls require two top plates. Nonbearing walls
may be built with one top plate, but they are often built
with two top plates to allow the same length of studs to be
used for both the bearing and nonbearing walls. Top and
bottom plates are taken off in the same way that sills are
taken off.

The following formulas need to be entered into the
associated cells:

Cell Formula

B4 =ROUNDUP(B2/4,0)

B5 =CEILING(B1/8,1/3)

B7 =ROUNDUP(B4*B5,0)

The data for the floor is entered in Cells B1 and B2. The
spreadsheet assumes the sheets are 4 feet by 8 feet and the
long direction of the sheet is run parallel to the length of
the building. The number of rows is rounded up to the
next whole sheet, and the number of columns is rounded
up to the next one-third of a sheet using the CEILING
function, which equals the distance covered by three joists
when the joists are spaced at 16 inches on center. The data
shown in the foregoing figure is from Example 8-5.
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EXAMPLE 8-7

How many feet of treated plate and untreated plate are needed to
construct the walls shown in Figure 8-5? The walls are constructed
of 2 � 4s and the exterior walls are sheathed with 7>16-inch OSB.
The wall bears on a concrete floor.

Solution: The thickness of the exterior walls is 4 inches, and the
thickness of the interior walls is 3 1>2 inches. The total length of the
walls is calculated as follows:

Because the walls bear on a concrete floor, the bottom plate
needs to be constructed of treated plate; therefore, 142 feet of
treated plate are needed. The top requires a double top plate of
untreated lumber; therefore, 284 feet (2 � 142 ft) of untreated
plate are needed. �

Studs
Precut studs are available for 8- and 9-foot ceilings. Precut
studs for an 8-foot ceiling are 92 5>8 inches long, and when
used with a single bottom plate and double top plate, they
provide a rough ceiling height of 97 1>8 inches. The extra
1 1>8 inches allows for floor and ceiling finishes. Precut
studs for a 9-foot ceiling are 104 5>8 inches long, and when
used with a single bottom plate and double top plate, they
provide a rough ceiling height of 109 1>8 inches.

The number of studs in a wall is determined by the stud
spacing and the number of ends, corners, intersections,
openings, and hold-downs. The number of studs needed to
meet the spacing requirements is determined by Eq. (4-2).

When a wall ends without forming a corner, an additional
stud is needed, as was shown in Chapter 4. This is to take the

� 141 ft 11 inches

Length � 2(22 ft) � 3(24 ft 4 in) � 2(11 ft 5 in) � 2 ft 1 in

end conditions into account. When the wall forms a corner, the
end condition will be accounted for with the corner.

Two extra studs are needed at corners. One of these
studs provides for the end condition, and the other stud pro-
vides backing for the interior finish. Two methods of fram-
ing a corner are shown in Figure 8-6. The difference in these
two corners is how the backing stud is placed. In this book,
two additional studs are added for each corner.

FIGURE 8-5 Wall Layout

FIGURE 8-6 Framing of Corners



Woods, Plastics, and Composites 115

FIGURE 8-8 Framing of a Door Opening

When walls intersect, backing is needed for the interior
finish and to secure the intersecting walls together. Two
methods of framing an intersection are shown in Figure 8-7.
The top method requires two additional studs to be pro-
vided for each intersection. The bottom method requires a

wider stud (a 2 � 6 for a 2 � 4 wall or a 2 � 8 for a 2 � 6 wall)
be provided for each intersection. In this book, two addi-
tional studs are added for each intersection.

Each opening requires additional studs. A typical door
opening is shown in Figure 8-8. Narrow openings require a
jack stud and a king stud on both sides of the opening. The
jack studs are used to support the header. Wider openings
may need two or three jack studs on each side of the open-
ing to support the header, depending on the load sup-
ported by the header and the width of the opening. The
number of jack studs should be determined by the design
professional or the building code when it has not been
specified by the design professional. For the opening
shown in Figure 8-8, two additional studs are needed be-
cause two of the studs needed to meet the spacing require-
ments have been deleted and two king studs and two jack
studs have been added. The actual number of additional
studs will vary based on the location of the door. If the
opening in Figure 8-8 were moved a few inches to the right,
the right king stud would meet the stud spacing require-
ment, and only one additional stud would be needed. For
wider openings a greater number of studs will be replaced
by the openings; however, this is often offset by the need
for a greater number of jack studs. In this book, two addi-
tional studs are added for each doorway.

Window openings are similar to door openings except
that there is framing below the opening that reduces the
deletion of the regularly spaced studs. The framing of a win-

FIGURE 8-7 Framing for Wall Intersections
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dow opening is shown in Figure 8-9. Cripple studs and a sill are
used to frame the wall below the opening. A cripple stud is lo-
cated at each end of the sill, and cripple studs are placed under
the sill to maintain the regular spacing of the studs. The num-
ber of additional studs that are needed will change depending
on the location of the opening, the height of the opening, and
the width of the opening. If the opening in Figure 8-9 were
moved a few inches to the right, the right king stud would meet
the stud spacing requirement and reduce the number of addi-
tional studs by one. Less material is required for the cripple
studs in taller openings than in shorter openings. For example,
if the top of the sill in Figure 8-9 was below 49 inches, two crip-
ple studs could be cut from one 92 5>8-inch stud and two studs
would be required for the cripple studs. If the top of the sill
were above 49 inches, four studs would be required for the
cripple studs. Wider openings may need additional jack studs.
For an opening up to 8 feet wide with single jack studs, up to
seven additional studs may be needed to frame the opening. If
the opening required double jack studs, up to nine additional
studs may be needed to frame the opening. In this book six ad-
ditional studs are added for each window opening that requires
only two jack studs; eight additional studs are added for each
window opening that requires a pair of jack studs on each side.

Posts or doubled or tripled studs are needed wherever a
hold-down occurs. If the hold-down occurs at the edge of a
door or window, the hold-down may be attached to the jack
and king studs. When a hold-down occurs at a corner, an

additional stud is needed to form a solid blocked corner as
shown in Figure 8-10. When a hold-down occurs at other
places, up to three additional studs are needed. In this book
no studs are added when a hold-down occurs at the edge of a
door or window opening, one additional stud is added for
each hold-down located at a corner, and three additional
studs are added for all other hold-downs.

The quantity takeoff for studs is shown in the following
example.

EXAMPLE 8-8

How many studs are needed to frame the wall in Figure 8-5? The
stud spacing is 16 inches on center. Allow for one additional stud
for each wall that does not have a corner; two additional studs for

FIGURE 8-9 Framing of a Window Opening

FIGURE 8-10 Framing of Corners with Hold-downs
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each corner, intersection, or doorway; six additional studs for each
window less than 6 feet in width; eight additional studs for each
window 6 feet or more in width; and one additional stud for each
hold-down located at a corner. Do not add additional studs for
hold-downs located at the edge of windows or doors.

Solution: From Example 8-7 the length of the wall is 142 feet. The
number of studs needed for the standard spacing is calculated using
Eq. (4-2) as follows:

All four interior walls lack corners at both ends; therefore, four ad-
ditional studs are needed for these walls. There are 4 corners, 8 in-
tersections, and 5 doorways that will require 2 additional studs
each, for a total of 34 additional studs. There are 2 windows that
will require 6 additional studs each and 1 window that will require
8 additional studs for a total of 20 additional studs. There are 2
hold-downs located at corners that will require an additional stud
per hold-down for 2 additional studs. The total number of studs is
167 (107 � 4 � 34 � 20 � 2). �

Number �
(142 ft)(12 in/ft)

16 in
� 107 each

Headers in a 2 � 4 wall can be made from two pieces of 2�
material and a 1>2-inch plywood or 7>16-inch OSB spacer.
Headers in a 2 � 6 wall can be made from three pieces of 2�
material and two 1>2-inch or 7>16-inch spacers. The headers
must extend over all of the jack studs, requiring the header
to be 3 inches wider than the opening for openings with sin-
gle jack studs and 6 inches wider than the opening for open-
ings with double jack studs. Openings for doors with jambs
are typically framed 2 inches wider than the door size to
allow for the doorjamb and shimming. A 36-inch-wide door
with single jack studs would require a 41-inch-long header
(36 in � 3 in � 2 in). Window openings are typically framed
1>2 to 1 inch wider than the opening to allow for placement
of the window.

EXAMPLE 8-9

Prepare a materials list for the headers required to complete the
walls in Figure 8-5. All headers are made from 2 � 12s, and the wall
is made from 2 � 4s. The doors are 32 inches wide. Openings 6 feet
and wider require double jack studs.

Solution: Each header will consist of two 2 � 12s with a 7>16-inch
OSB spacer. The 32-inch-wide doors will require a 34-inch-wide
opening and a 37-inch (34 in � 3 in) header. Three 37-inch headers
are needed and can be cut from two 10-foot-long 2 � 12s.
Approximately 10 square feet of spacer are needed for these headers.

The 4-foot windows and closet doors will require 49-inch
openings and 52-inch (49 in � 3 in) headers. Because the bifold
closet doors do not have jambs, the opening only needs to be
framed 1 inch wider than the doors to allow for two layers of half-
inch drywall. Four 52-inch headers are needed and can be cut from
four 10-foot-long 2 � 12s. Approximately 20 square feet of spacer
are needed for these headers.

The 6-foot window will require a 73-inch-wide opening and a
79-inch (73 in � 6 in) header. This header can be cut from two
8-foot-long 2 � 12s. Approximately 7 square feet of spacer are
needed for this header. The total amount of spacer required is ap-
proximately 37 square feet (10 ft2 � 20 ft2 � 7 ft2) and can be cut
from two sheets of OSB.

Order six 10-foot-long 2 � 12s, two 8-foot-long 2 � 12s, and
two sheets of 7>16-inch OSB. �

Hold-downs
Shear panels are used to stiffen the building against lateral
forces generated by wind and earthquakes. Shear panels are
created by covering the wall framing with a rigid material
such as OSB or plywood. Wide shear panels may be tied to
the foundation with anchor bolts. Narrow shear panels re-
quire hold-downs. Hold-downs are specialty framing an-
chors that tie the shear panel to the foundation. Hold-downs
come in a variety of types and sizes.

Blocking
Blocking is used to strengthen load-bearing walls, prevent
the spread of fire, and provide backing for wall-mounted
items, such as grab bars. Blocking used to strengthen load-
bearing walls is placed between the studs near the midpoint

EXCEL QUICK TIP 8-5

Studs

The number of studs needed for walls is set up in a
spreadsheet by entering the data and formatting the cells
as follows:

The following formula needs to be entered into Cell B12:

=ROUNDUP(B1*12/B2,0)+B3+B4*2+B5*2+B6*2

+B7*6+B8*8+B9+B10*3

The data for walls is entered in Cells B1 through B10. The
data shown in the foregoing figure is from Example 8-8
and is formatted using the comma style, which replaces
zeros with dashes.

A B C
1 Wall Length 142 ft
2 Stud Spacing 16 in
3 Walls without Corners 4 ea
4 Corners 4 ea
5 Intersections 8 ea
6 Doorways 5 ea
7 Windows, Small 2 ea
8 Windows, Large 1 ea
9 Hold Downs at Corners 2 ea

10 Other Hold Downs - ea
11
12 Studs 165 ea

Headers
Headers are constructed of solid wood, laminated lumber, or
2� materials. Because of cost, most headers are constructed
of 2� material and require plywood or OSB spacers such
that the width of the header matches the width of the wall.
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of the studs as shown in Figure 8-11. Blocking used to pre-
vent the spread of fire is placed at points where walls inter-
sect with mechanical drops and parallel to stair stringers.
Blocking in walls is estimated using the same procedures as
estimating blocking in floors.

EXAMPLE 8-10

How many lineal feet of blocking are needed for the walls in
Figure 8-5 if the studs in the exterior walls are blocked at their
midpoints, as shown in Figure 8-11?

Solution: Only the perimeter wall will need to be blocked.
Blocking is not needed at openings for doors and windows. The
length of the wall that needs to be blocked is calculated as follows:

�

Sheathing
Wood-framed exterior walls are commonly sheathed with
7>16-inch OSB or 1>2-inch plywood. Interior walls may also
be sheeted with OSB or plywood to create a shear panel. The
wood sheathing is treated as a sheet good. When calculating
the number of rows, one must round the rows to a common

� 76 ft

Length � 2(22 ft) � 2(24 ft 4 in) � 2(4 ft) � 6 ft � 32 in

fraction of a sheet such as 1>8, 1>6, 1>5 1>4, 1>3, or 1>2.
Openings for doors and windows in the wall are commonly
ignored because the material cut from these openings usu-
ally cannot be used as wall sheathing, but it may be used for
headers built after the wall is sheathed. The quantity takeoff
of wall sheathing is shown in the following example.

EXAMPLE 8-11

How many 4-foot by 8-foot sheets of 7>16-inch OSB are needed to
sheet the outside of the exterior walls shown in Figure 8-5 if the
wall height is 9 feet?

Solution: The number of rows is calculated using Eq. (4-13) as
follows:

The number of rows is rounded up to the nearest 1>8 of a sheet.
The length of the outside surface of the exterior wall is calculated
as follows:

The number of columns is calculated using Eq. (4-16) as follows:

NumberColumns �
94 ft

4 ft
� 24 columns

Length � 2(22 ft) � 2(25 ft) � 94 ft

NumberRows �
9 ft

8 ft
� 1.125 rows

FIGURE 8-11 Blocking in Bearing Walls
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The number of sheets is calculated using Eq. (4-18) as follows:

�

When sheathing gable ends, the waste from the sheets
used near the peak of the gable ends can often be used for
the sheets near the eaves of the gable ends as shown in the
following example.

EXAMPLE 8-12

Determine the number of sheets of 7>16-inch OSB required for the
end of the building shown in Figure 8-12.

Solution: The rise for the gable end is calculated as follows:

The height of the wall at the peak is 14 foot 4 inches. The number of
rows of sheathing is calculated using Eq. (4-13) as follows:

The number of columns of sheathing is calculated using Eq. (4-16)
as follows:

The first row of sheathing will run from the bottom of the wall to a
height of 8 feet and will consist of eight sheets of sheathing. The
second row of sheathing will run from a height of 8 feet to the top

NumberColumns �
32 ft

4 ft
� 8 columns

NumberRows �
14.33 ft

8 ft
� 2 rows

Rise � a32 ft

2
ba 4

12
b � 5.33 ft � 5 ft 4 in

Number � (1.125 rows)(24 columns) � 27 sheets

of the wall, which is 1 foot at the eaves and 6 foot 4 inches (1 ft
� 5 ft 4 in) at the peak. Two pieces of sheathing can be cut from
one sheet on the top row; therefore, only four sheets are required.
The layout of the sheathing is shown in Figure 8-13. The number
on each piece of sheathing represents the sheet from which the
sheathing was cut.

Because the height at the eaves (1 ft) plus the height at the
peak (6 ft 4 in) is less than 8 feet, the scrap from the short side of the
gable end can be used at the peak as shown in Figure 8-14. A total of
12 sheets of sheathing are needed. �

ROOF SYSTEMS
Roof systems may be stick framed using rafters, ceiling joists,
and collar ties or may be constructed of manufactured
trusses. Complex roofs that use trusses often have stick-
framed overbuilds. Let’s look at using rafters to construct a
roof:

Rafters
A typical rafter is shown in Figure 8-15.

The length of the rafter must be measured parallel to the
rafter from the top corner of the rafter near the ridge to
the bottom corner of the rafter at the eaves. The length of
the rafter along the top or bottom edge may be determined
from the Pythagorean theorem using the rise and the run of
the rafter. To this length, we must add the length needed to
allow the ends of the rafter to be cut at an angle, which is
equal to the slope of the rafter times the width of the board

FIGURE 8-12 Building End Elevation

FIGURE 8-13 Sheathing Layout FIGURE 8-14 Layout for Sheet 9
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used for the rafter. The length of the rafter is calculated using
the following equation:

(8-1)

Letting the slope equal the rise over the run and substituting
the slope into Eq. (8-1), we get the following equation:

(8-2)

The slope may also be expressed as the relationship between
the rise and the run such as a 4:12 slope or a 6:12 slope.
Determining the length of a rafter is shown in the following
example.

EXAMPLE 8-13

What length of rafters needs to be ordered for the building shown
in Figure 8-16? The rafters are 2 � 8s with a slope of 4:12.

Solution: The thickness of a 2 � 8 is 7.25 inches. The run of the
rafter is calculated as follows:

The length of the rafter may be calculated using Eq. (8-2) as follows:

Length � (11 ft) c 1 � a 4

12
b2 d 0.5

�
(7.25 in)

(12 in/ft)
a 4

12
b � 11.8 ft

Run �
Span

2
� Overhang �

20 ft

2
� 1 ft � 11 ft

Length � (Run)(1 � Slope2)0.5 � (Thickness)(Slope)

Length � (Run2 � Rise2)0.5 � (Thickness)aRise

Run
b

Alternatively, it may be calculated by finding the rise as follows:

and then calculating the length of the rafter using Eq. (8-1) as follows:

Order 12-foot rafters. �

A hip roof is shown in Figure 8-17. The length of a hip
or valley rafter for a roof with the same slope on all surfaces
may be calculated by finding the run of the hip or valley
rafter using the Pythagorean theorem and using Eq. (8-1) or
Eq. (8-2) to find the length. Alternatively, the length of the
hip rafter may be determined from the run of the common
rafter using the following equation:

(8-3)

The hip and valley rafters have a flatter slope than the
common rafters because their run is 41% longer than the
run of the common rafters even though they have the same
rise. The slope of a hip and valley rafter for a roof of a con-
stant slope can be found by replacing the 12 in the slope of
the roof with 17. A roof with a 4:12 slope will require hip and

� (Thickness)(SlopeHip)

Length � (RunCommon)(2 � SlopeCommon
2 )0.5

� 11.8 ft

Length � c(11 ft)2 � (3.67 ft)2d 0.5

�
(7.25 in)

(12 in/ft)
a3.67 ft

11 ft
b

Rise � (Run)(Slope) � (11 ft)a 4

12
b � 3.67 ft

FIGURE 8-15 Rafter

FIGURE 8-16 Rafter Section
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valley rafters with a 4:17 slope. Similarly, a roof with a 6:12
slope will require hip and valley rafters with a 6:17 slope. The
length of hip and valley rafters is calculated in the same
manner as the length of common rafters.

For the roof in Figure 8-17, the king rafter is the same
length as the common rafters. The jack rafters will be
shorter. When ordering lumber for the jack rafters in a hip
roof, it is common practice to order lumber the same length
as the common rafters and cut two jack rafters from each
piece of lumber.

To prevent the wall from spreading apart due to the forces
on the rafters, collar ties spaced at no more than 4 feet on cen-
ter or ceiling joists connecting the walls must be used. Collar
ties are commonly 1 � 4s that connect rafters and are located
at least one-third of the rise below the peak of the rafters.

Ceiling joist may be used to prevent the spread of the
rafters in lieu of collar ties. Ceiling joists are taken off in the
same manner as floor joists.

The quantity takeoff for a hip roof is shown in the fol-
lowing example.

EXAMPLE 8-14

The hip roof shown in Figure 8-17 is constructed of 2 � 8 rafters
spaced 24 inches on center. The roof has a slope of 4:12. Determine
the quantities and lengths of 2 � 8s needed for the roof. Ceiling
joists will be used to prevent the walls from spreading. Do not in-
clude the ceiling joists in your estimate.

Solution: The roof is 10 feet longer than it is wide; therefore, the
common rafters must cover 10 feet on each side of the roof. The
number of common rafters on each side of the roof is calculated
from Eq. (4-1) as follows:

Number �
10 ft

2 ft
� 1 � 6 each

There are 6 common rafters on each side of the roof for a total of
12. There are also two king rafters, one on each end, that are the
same length as the common rafters. The run for the common and
king rafters is 12 feet (24 ft>2). The length of the common and king
rafters is calculated using Eq. (8-2) as follows:

Fourteen-foot-long 2 � 8s will be used for the common and king
rafters. There are four hip rafters. The length of the hip rafters is
calculated using Eq. (8-3) as follows:

Eighteen-foot-long 2 � 8s will be used for the hip rafters. Each of
the four corners consists of two jack rafters with the following runs:
2, 4, 6, 8, and 10 feet. The length of these rafters is calculated using
Eq. (8-2) as follows:

From one 14-foot-long 2 � 8, one can cut one 2.3-foot and one
10.7-foot-long rafters, or one 4.4-foot and one 8.6-foot-long rafter,
or two 6.5-foot-long rafters. Five 14-foot-long 2 � 8s will produce
two 2.3-foot-long rafters, two 4.4-foot-long rafters, two 6.5-foot-
long rafters, two 8.6-foot-long rafters, and two 10.7-foot-long

Length10 ft � (10 ft) c1 � a 4

12
b2 d 0.5

�
(7.25 in)

(12 in/ft)
a 4

12
b � 10.7 ft

Length8 ft � (8 ft) c1 � a 4

12
b2 d 0.5

�
(7.25 in)

(12 in/ft)
a 4

12
b � 8.6 ft

Length6 ft � (6 ft) c1 � a 4

12
b2 d 0.5

�
(7.25 in)

(12 in/ft)
a 4

12
b � 6.5 ft

Length4 ft � (4 ft) c1 � a 4

12
b2 d 0.5

�
(7.25 in)

(12 in/ft)
a 4

12
b � 4.4 ft

Length2ft � (2 ft) c1 � a 4

12
b2 d 0.5

�
(7.25 in)

(12 in/ft)
a 4

12
b � 2.3 ft

Length � (12 ft) c2 � a 4

12
b2 d 0.5

�
(7.25 in)

(12 in/ft)
a 4

17
b � 17.6 ft

Length � (12 ft) c1 � a 4

12
b2 d 0.5

�
(7.25 in)

(12 in/ft)
a 4

12
b � 12.9 ft

FIGURE 8-17 Roofing Plan for Hip Roof
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rafters; this is enough rafters to complete one corner. Twenty 14-foot-
long 2 � 8s are needed for the corners. A total of 34 (12 ea � 2 ea
� 20 ea) 14-foot-long 2 � 8s are needed. One 10-foot-long 2 � 8 is
needed for the ridge board.

The materials needed are as follows: one 10-foot-long, thirty-
four 14-foot-long, and four 18-foot-long 2 � 8s. �

the truss, and the length of the overhang (often referred to as
the length of the tails). A special kind of truss is a gable-end
truss, which is used at the ends of a building and anywhere
the walls extend up beyond the ceiling line, such as in the
case of firewalls. A gable-end truss is shown in Figure 8-18.
The purpose of the gable-end truss is to provide an easy-to-
frame-and-sheet end that matches the slope and dimension
of the trusses. As such, a gable-end truss must be supported
along its full length by a bearing wall. The gable-end truss
provides an alternative to stick framing the gable ends.

The quantity takeoff for a roof using trusses is shown in
the following example.

EXAMPLE 8-15

What size and number of trusses need to be ordered for the roof
shown in Figure 8-19? The gable ends of the building are to be con-
structed as part of the walls. The slope of the roof is 4:12. The
trusses are spaced 24 inches on center and are made of 2 � 4s. How
many 8-foot-long 2 � 4s need to be ordered if the lookouts are
constructed of 2 � 4s spaced 24 inches on center?

Solution: The trusses need to cover 26 feet (30 ft � 2 ft � 2 ft) of
roof. The number of trusses needed is calculated using Eq. (4-1) as
follows:

The trusses are to have a 4:12 slope, a 20-foot span, and 2-foot-long
tails. The lookouts are on the sloped end of the roof; therefore, the
sloped length of the roof from the eave of the roof to the peak of the
roof must be calculated using the Pythagorean theorem as follows:

Excluding the lookout at the peak and the lookout at the eave (the
lookout at the eave of the roof is part of the fascia), we calculate the
number of lookouts needed for the roof from the eave to the peak
using Eq. (4-3) as follows:

Adding 1 for the peak, the number of lookouts needed on each end
of the building is 13 (6 � 1 � 6) for a total of 26 4-foot-long look-
outs. Two lookouts can be cut from one 8-foot-long 2 � 4; there-
fore, 13 (26>2) 8-foot-long 2 � 4s are needed. �

Number �
12.7 ft

2 ft
� 1 � 6 ea

Length � c a24 ft

2
b2

� (4 ft)2 d 0.5

� 12.7 ft

Rise � a24 ft

2
b a 4

12
b � 4 ft

Number �
26 ft

2 ft
� 1 � 14 each

EXCEL QUICK TIP 8-6

Length of a Rafter

The calculation of the length of a rafter is set up in a
spreadsheet by entering the data and formatting the cells
as follows:

The following formulas need to be entered into the asso-
ciated cells:

Cell Formula

B6 =(B1/2+B2/12)*B3/12

B7 =(B1/2+B2/12)*(1+(B3/12)^2)^0.5

+B4*B3/(12*12)

B8 =(B1/2+B2/12)*(2+(B3/12)^2)^0.5

+B4*B3/(17*12)

The data for rafter is entered in Cells B1 through B4. The
data shown in the foregoing figure is from Example 8-14.

A B C
1 Span 20 ft
2 Overhang 24 in
3 Slope 4 :12
4 Thickness 7.25 in
5
6 Rise 4.00 ft
7 Common Rafter 12.9 ft
8 Hip Rafter 17.6 ft

FIGURE 8-18 Gable-End Truss

Trusses
Trusses are used to span larger distances using less lumber.
Trusses consist of a top cord, a bottom cord, and truss mem-
bers that are used to transfer the loads. Trusses are specified
based on the slope of the top and bottom cords, the span of
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Sheathing
The quantity takeoff for roof sheathing is done in the same
manner as floor sheathing. The sheathing for each surface of
the roof should be done separately because changes in the
surface of the roof increase the waste. Unlike floor sheathing,
roof sheathing is seldom T&G, which allows more of the
waste to be used. The takeoff for roof sheathing is shown in
the following example.

EXAMPLE 8-16

What is the area of the roof in Figure 8-19? How many sheets of
7>16-inch OSB are needed for the roof? What is the waste factor for
this roof?

Solution: The sloped area of one side of the roof is calculated
using the Pythagorean theorem to determine the slope length of the
roof, which is multiplied by the width of the roof. This area is mul-
tiplied by two to get the area of the roof. In Example 8-15, the
sloped length of the roof in Figure 8-19 is found to be 12.7 feet. The
area of the roof is calculated as follows:

The number of rows of sheathing needed for one side of the roof is
calculated using Eq. (4-13) as follows:

The number of rows is rounded to one-fifth of a sheet. The number
of columns is calculated using Eq. (4-16) as follows:

NumberColumns �
34 ft

8 ft
� 4.5 columns

NumberRows �
12.7 ft

4 ft
� 3.2 rows

Area � 2(12.7 ft)(34 ft) � 864 ft2

The number of columns is rounded to half of a sheet because the
sheet must span at least two trusses, or 4 feet. The number of sheets
needed for the roof is calculated using Eq. (4-18) as follows:

The area of the sheets is 928 square feet (29 sheets � 32 ft2/sheet).
The waste for the roof is 7.4% (928>864 � 1). �

Fascia
When fascia is being installed on the gable ends of a roof, the
length of the fascia is calculated in the same manner as the
length of the rafters is calculated using Eq. (8-1) or Eq. (8-2).
When fascia is installed on the eaves, the height of the fascia
is greater than the width of the framing member to which it
is being installed, as shown in Figure 8-20. For example, the
fascia being attached to a truss constructed of 2 � 4s will
need to be constructed from a 2 � 6.

Number � (2 sides)(3.2 rows/side)(4.5 columns) � 29 sheets

FIGURE 8-19 Roofing Plan

FIGURE 8-20 Fascia
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The size of the lumber needed to construct the fascia is
calculated using the following equation:

(8-4)

The quantity takeoff for fascia is shown in the following
example.

EXAMPLE 8-17

How many feet of 2� fascia are needed for the roof in Figure 8-19?
What size of fascia is needed?

Solution: The width of the fascia is calculated using Eq. (8-4) as
follows:

Use 2 � 6s for the fascia. The length of the fascia on the ends of the
roof is calculated using Eq. (8-2) as follows:

The 2 � 6 fascia needed to frame the perimeter of the roof (in-
cluding the lookouts at the eaves) is four 14-foot-long 2 � 6s for
the sloped ends of the building (whose length is 12.8 ft) and six
12-foot-long 2 � 6s for the side of the building (whose length is
34 ft). �

Soffit
Sometimes sheathing is used for the soffit. The quantity
takeoff for soffit is done using the row and column method,
where the number of rows of soffit is a fraction (1>2, 1>3,
1>4, 1>5, 1>6, 1>7, or 1>8) of a sheet. The quantity takeoff for
soffit is shown in the following example.

EXAMPLE 8-18

Determine the number of sheets of 4-foot by 8-foot by 7>16-inch
OSB that are needed for the soffit of the roof in Figure 8-19. The
soffit is installed parallel to the surface of the roof. The soffit is
held back the width of the fascia (1 1>2 inches) from the edge of
the roof.

Solution: The soffit will be divided into six areas: two 30-foot-long
areas on the sides of the building and four 12.7-foot-long by 2-
foot-wide areas at the ends of the building. First, we will look at the
two 30-foot-long areas. The width of these areas is determined by
the Pythagorean theorem as follows:

The number of rows for the sides is calculated using Eq. (4-13) as
follows:

NumberRows �
2.0 ft

8 ft
� 0.25 rows

Length � 3(1 ft 10 1>2 in)2 � (0.62 ft)2 40.5 � 2.0 ft

Rise � (1 ft 10 1>2 in)a 4

12
b � 0.62 ft

Length � (24 ft>2) c1 � a 4

12
b2 d 0.5

�
(5.5 in)

(12 in/ft)
a 4

12
b � 12.8 ft

WidthFascia � (3.5 in) c1 � a 4

12
b2 d 0.5

� (1.5 in)a 4

12
b � 4.2 in

� (ThicknessFascia)(Slope)

WidthFascia � (WidthRafter)(1 � Slope2)0.5

The number of columns for the sides is calculated using Eq. (4-16)
as follows:

The number of sheets needed for the sides of the roof is calculated
using Eq. (4-18) as follows:

The number of rows for the ends is calculated using Eq. (4-13) as
follows:

The number of columns for the ends is calculated using Eq. (4-16)
as follows:

The number of columns is rounded to the quarter-sheet increment,
which is 2 feet. The number of sheets needed for the side of the roof
is calculated using Eq. (4-18) as follows:

The number of sheets needed is 8 (4 � 3.5). �

FINISH CARPENTRY
Finish carpentry often includes the installation of trim,
wood shelving, and wood paneling. Trim and shelving is bid
by the lineal foot and paneling is bid by the sheet in the same
manner as sheathing is bid. The quantity takeoff of wood
trim is shown in the following example.

EXAMPLE 8-19

Determine the wood base and wood casing needed to complete the
rooms shown in Figure 8-5. The casing is only located around the
single-hung doors. The base comes in 8-, 12-, and 16-foot lengths and
the casing comes in 7-foot lengths. Minimize the number of joints.

Solution: Six 12-foot-long pieces of base are needed for the main
room. Three 12-foot-long pieces and one 8-foot-long piece of base
are needed for each of the bedrooms. One 8-foot-long piece of base
along with scraps left over from the door opening to the bedroom is
needed for each closet. The following base needs to be ordered:
twelve 12-foot-long and four 8-foot-long pieces of base.

Each side of a door requires 2 1>2 pieces of casing. Only the in-
side of the exterior door needs casing; therefore, 13 (5 � 2.5) pieces
of door casing are needed. �

CABINETRY AND
COUNTERTOPS
The type and size of each cabinet need to be quantified.
Countertops are bid by the lineal foot. For corners, the
length of the countertop is measured at the longest side of
the countertop. The quantity takeoff of cabinets and coun-
tertops is shown in the following example:

Number � (4 end)(0.5 rows/end)(1.75 columns) � 3.5 sheets

NumberColumns �
12.7 ft

8 ft
� 1.75 columns

NumberRows �
(1 ft 10 1>2 in)

4 ft
� 0.5 rows

Number � (2 sides)(0.25 rows/side)(7.5 columns) � 4 sheets

NumberColumns �
30 ft

4 ft
� 7.5 columns
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EXAMPLE 8-20

Determine the cabinets and lineal feet of countertop needed for the
cabinet layout shown in Figure 8-21.

Solution: Starting with the left, the following base cabinets are
needed: a 36-inch-wide by 36-inch-high sink base, an 18-inch-wide
by 36-inch-high four-drawer base, and a 36-inch-wide by 36-inch-
high standard base. Starting with the left, the following wall cabi-
nets are needed: two 36-inch-wide by 30-inch-high wall cabinets
and one 18-inch-wide by 30-inch-high wall cabinet. A plastic lami-
nated countertop with a 4-inch backsplash 7 feet 6 inches long is
needed. �

SAMPLE TAKEOFF FOR THE
RESIDENTIAL GARAGE
A sample takeoff for rough carpentry, lumber, trusses, finish
carpentry, and wood trim from a set of plans is shown in the
following example.

EXAMPLE 8-21

Determine the rough carpentry, lumber, trusses, finish carpentry,
and wood trim needed to complete the residential garage found in
Appendix F.

Solution: The thickness of the exterior wall is 4 inches (3 1>2-inch-
thick stud plus 1>2-inch-thick exterior sheathing). Find the length
of the wall as follows:

Eighty-three feet of wall with one opening for a single-hung door
and one opening for an overhead door need to be framed. An 8-
foot-long redwood plate is ordered for the west wall, a 12-foot-long

Length � 4 ft � 25 ft 4 in � 24 ft � 25 ft 4 in � 4 ft � 82 ft 8 in

and a 14-foot-long redwood plate are ordered for the north wall,
two 12-foot-long redwood plates are ordered for the east wall, and a
12-foot-long and a 14-foot-long redwood plate are ordered for the
south wall. Order one 8-foot-long, four 12-foot-long, and two 14-
foot-long redwood 2 � 4 plates.

Two 50-foot-long rolls of seal sill are needed under the bottom of
wall. Nine 10-feet-long Z-flashings are needed for the exterior walls.

The number of studs needed for a 16-inch on-center spacing
is calculated using Eq. (4-2) as follows:

Two additional studs are needed for each of the four corners,
2 for the doorway, 6 for the overhead door, and 1 for each of the
two hold-downs located at the corners, for a total of 80 studs (62 �
2 � 4 � 2 � 6 � 2 � 1).

The door header will require one 8-foot-long 2 � 6 and a
sheet of 7>16 OSB for a spacer. The garage header will require a
16-foot 6-inch-long 3 1>2-inch by 12-inch GLB.

The top plates for the north, east, and south walls need twice
the quantities needed for the bottom plate. For the west wall, four
12-foot-long plates are needed. Order twelve 12-foot-long and four
14-foot-long 2 � 4 plates.

The number of standard trusses needed is calculated using Eq.
(4-3) as follows:

Twelve 24-foot trusses with a 4:12 slope and 18-inch tails are
needed along with two 24-foot gable end trusses. Twenty-four hur-
ricane ties are needed to secure the standard trusses to the roof.

Next, the 2 � 4 framing for the soffit will be taken off begin-
ning with the north side. A 29-foot-long ledger is needed at the wall
and a 29-foot fascia board is needed at the edge of the roof. Sixteen
(one at each truss and one at both ends of the roof) 15-inch-long
pieces of blocking are needed between the ledger and the fascia
board. The same is needed for the south side of the roof.

Next, the 2 � 4 framing on the west end of the building will be
taken off. A 2 � 4 ledger is needed along the truss from the north
side of the building to the peak of the roof. The length is deter-
mined by Eq. (8-2) as follows:

The fascia board will run parallel to the truss from the edge of the roof
to the peak of the building. The length is determined by Eq. (8-2)
as follows:

Blocking is located at 24 inches on center on the sloped end of the
roof; therefore, the sloped length of the roof from the eave of the roof
to the peak of the roof must be calculated using the Pythagorean the-
orem as follows:

Excluding the blocking at the peak and the blocking at the eave (the
blocking at the eave of the roof is part of the fascia), we calculate

Length � c a27 ft

2
b2

� (4.5 ft)2 d 0.5

� 14.3 ft

Rise � a27 ft

2
b a 4

12
b � 4.5 ft

Length � a27 ft

2
b c1 � a 4

12
b2 d 0.5

�
3.5 in

(12 in/ft)
a 4

12
b � 14.3 ft

Length � a24 ft

2
b c1 � a 4

12
b2 d 0.5

�
(3.5 in)

(12 in/ft)
a 4

12
b � 12.8 ft

Number �
26 ft

2 ft
� 1 � 12 each

Number �
(82 ft 8 in)(12 in/ft)

16 in
� 62 each

FIGURE 8-21 Cabinet Elevation
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TABLE 8-1 Quantities for Residential Garage

06-100 Rough Carpentry

2 � 4 wall 83 ft

Single-hung door opening 1 ea

Overhead door opening 1 ea

Install trusses 14 ea

Install ledger 110 ft

Install fascia board 116 ft

Install 15� blocking 62 ea

Install ceiling blocking 48 ft

Install roof sheathing 829 sft

06-110 Lumber

Walls

2 � 4-8� redwood 1 ea

2 � 4-12� redwood 4 ea

2 � 4-14� redwood 2 ea

Seal sill 50� 2 ea

Z-flashing 10� long 9 ea

2 � 4-92 5>8� stud 80 ea

2 � 6-8� 1 ea

7>16��4� � 8� OSB 1 ea

3-1>2� � 12� GLB 16.5 ft

2 � 4-12� 12 ea

2 � 4-14� 4 ea

Roof

Hurricane ties 24 ea

2 � 4-8� 46 ea

7>16� � 4� � 8� OSB 32 ea

Plywood clips 78 ea

06-120 Trusses

24� 4:12 standard trusses w/18� tails 12 ea

24� 4:12 gable trusses w/18� tails 2 ea

06-200 Finish Carpentry

Install shaped fascia 116 ft

Install door casing 1 set

06-210 Wood Trim

1�6-10� cedar 6 ea

1�6-16� cedar 4 ea

7� casing 3 ea

the number of pieces of blocking needed for the roof from the eave
to the peak using Eq. (4-3) as follows:

Adding 1 for the peak, we find that the number of pieces of block-
ing needed on the west end of the building is 15 (7 � 1 � 7). Each
of these is 15 inches long. The same quantities are needed for the
east side.

The total length of ledger needed is 110 feet (29 � 12.8 � 12.8 �
29 � 12.8 � 12.8). Order fourteen 8-foot-long 2 � 4s for the
ledger. The total length of fascia is 116 feet (29 � 14.3 � 14.3 � 29 �
14.3 � 14.3). Order fifteen 8-foot-long 2 � 4s for the fascia. The
number of 15-inch-long blockings is 62 (16 � 15 � 16 � 15). Six
pieces 15 inches long can be cut from one 8-foot-long 2 � 4. Order
eleven 8-foot-long 2 � 4s for the blocking. A total of 40 (14 � 15 �
11) 8-foot-long 2 � 4s are needed for the soffit framing.

Two 24-foot-long pieces of blocking are needed for the ceiling
(see detail K5 on Sheet 7 in Appendix F). Order six 8-foot-long 2 � 4s
for the ceiling blocking. Order a total of forty-six 8-foot-long 2 � 4s,
to frame the soffit and block the ceiling.

Next, the roof sheathing will be taken off. The width of one
side of the roof is 14.3 feet. The area of the roof that needs to be
sheathed is calculated as follows:

The number of rows of sheathing needed for one side of the roof is
calculated using Eq. (4-13) as follows:

The number of columns is calculated using Eq. (4-16) as follows:

The number of sheets needed for the roof is calculated using
Eq. (4-18) as follows:

Three rows of plywood clips are needed on each side of the roof
with a plywood clip located between each pair of trusses; there-
fore, 13 (1 less than the number of trusses) columns of clips are
needed. The number of clips is calculated using Eq. (4-18) as
follows:

The finish carpentry includes the installation of the trim. The trim
consists of the fascia and the casing on the inside of the door. The
T1-11 siding, the soffit, and 1 � 4 cedar trim associated with the
siding are covered under siding in Chapter 9. The total length of
fascia is 116 feet (29 � 14.3 � 14.3 � 29 � 14.3 � 14.3). The
height of the fascia is calculated using Eq. (8-4) as follows:

The fascia is cut from 2 � 6s. Three 10-foot pieces of 1 � 6 trim are
needed for the north and south sides of the building. Two 16-foot
pieces of trim are needed for each gable end. Order six 10-foot-long
1 � 6 and four 16-foot-long 1 � 6 pieces of cedar for the fascia.

Three 7-foot pieces of casing are needed for the inside of the
single-hung door.

WidthFascia � (3.5 in) c1 � a 4

12
b2 d 0.5

� (1.5 in)a 4

12
b � 4.2 in

Number � (2 sides)(3 rows/side)(13 columns) � 78 each

Number � (2 sides)(4 rows/side)(4 columns) � 32 sheets

NumberColumns �
29 ft

8 ft
� 4 columns

NumberRows �
14.3 ft

4 ft
� 4 rows

Area � 2(14.3 ft)(29 ft) � 829 ft2

Number �
14.3 ft

2 ft
� 1 � 7 ea

The quantities needed for the garage, grouped by the cost
codes in Appendix B, are shown in Table 8-1. �
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CONCLUSION
Woods and plastics consist of rough carpentry, finish car-
pentry, and cabinets and countertops. Rough carpentry con-
sists of framing the floors, walls, and roof of the structure.
Finish carpentry consists of installing finish material includ-
ing wood trim, shelving, and handrails. Cabinetry includes
the installation of cabinets and countertops.

PROBLEMS
1. The floor system in Figure 8-22 sits on a redwood sill on

a concrete wall. Determine the number of 16-foot-long
pieces of redwood that are needed to complete the floor
system.

2. Determine the materials needed to complete the posts
and girder supporting the floor joists in Figure 8-22.
The posts are connected to footings using a Simpson
PB44 post base and are connected to the girder using a
Simpson BC4 post cap. The distance between the top of
the footing and the bottom of the girder is 7 feet. The
posts are spaced 12 feet apart.

3. Determine the materials needed to construct the
joists and joist headers for the floor system shown in
Figure 8-22.

4. For the floor system shown in Figure 8-22, the joists are
blocked over the girder, at the concrete wall at the over-
hang, and at the midpoint between the girder and the
exterior wall on the joists over 8 feet long. Determine
the materials needed for the blocking.

5. Determine the number of 4-foot by 8-foot sheets of
23>32-inch T&G OSB sheathing that are needed to con-
struct the floor system shown in Figure 8-22.

6. The perimeter of the floor system in Figure 8-23 sits on
a redwood sill. Determine the number of 16-foot-long
pieces of redwood that are needed to complete the floor
system.

7. Determine the materials needed to complete the posts
and girder supporting the floor joists in Figure 8-23.
The posts are connected to footings using a Simpson
PB46 post base and are connected to the girder using a
Simpson BC46 post cap. The distance between the top
of the footing and the bottom of the girder is 7 feet.
The posts are equally spaced along the glue-laminated
beam.

8. Determine the materials needed to construct the
joists and joist headers for the floor system shown in
Figure 8-23. An engineered rim board is used for the
joist headers.

9. For the floor system shown in Figure 8-23, the joists are
blocked over the girder and at the midpoint between the
girder and the exterior wall on the joists over 8 feet long.
I-joists are to be used for the blocking. How many feet
of I-joists are needed for the blocking?

10. Determine the number of 4-foot by 8-foot sheets of
23>32-inch T&G OSB sheathing that are needed to con-
struct the floor system shown in Figure 8-23.

11. How many board feet of 2�6 redwood decking are
needed to construct a 20-foot by 30-foot deck? The
boards are to be placed without any space between them.

12. How many board feet of 2�4 redwood decking are
needed to construct a 10-foot by 20-foot deck? The boards
are to be placed with a 1>2-inch space between them.

13. How many board feet of 2�4 treated and untreated
plate are needed to construct 100 feet of 2�4 wall? The
wall bears on a concrete floor.

FIGURE 8-22 Floor-Framing Plan
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14. How many board feet of 2 � 4 treated and untreated
plate are needed to construct 75 feet of 2 � 4 wall? The
wall bears on a wood floor.

15. How many studs are needed to construct 100 feet of 2
� 4 wall? The wall has one 8-foot-wide window, four
4-foot-wide windows, two 36-inch-wide doors, one
30-inch-wide door, four corners, two intersections,
and eight hold-downs located at corners. The stud
spacing is 16 inches on center. Allow for two addi-
tional studs for each corner, intersection, or doorway;
six additional studs for each window less than 6 feet in
width; eight additional studs for each window 6 feet
or more in width; and one additional stud for each
hold-down located at a corner.

16. Prepare a materials list for the headers required to com-
plete the wall in Problem 15. All headers are made from
2 � 12 materials and the wall is made from 2 � 4s.
Openings 6 feet or more in width require double jack
studs.

17. How many studs are needed to construct 180 feet of 2
� 6 wall? The wall has two 6-foot-wide windows, four
4-foot-wide windows, three 3-foot-wide windows,
one 60-inch-wide door, one 36-inch-wide door, one
30-inch-wide door, six corners, eight intersections,
and four hold-downs located at corners. The stud
spacing is 24 inches on center. Allow for two addi-
tional studs for each corner, intersection, or doorway;
six additional studs for each window less than 6 feet in
width; eight additional studs for each window 6 feet
or more in width; and one additional stud for each
hold-down located at a corner.

18. Prepare a materials list for the headers required to com-
plete the wall in Problem 17. All headers are made from 2
� 12 materials and the wall is made from 2 � 6s. Openings
6 feet or more in width require double jack studs.

19. How many sheets of 7>16-inch OSB are needed to con-
struct 100 feet of wall 8 feet high?

20. How many sheets of 7>16-inch OSB are needed to con-
struct 100 feet of wall 9 feet 3 inches high?

21. How many feet of treated and untreated plate are
needed to construct the walls shown in Figure 8-24? The
walls are constructed of 2�4s with the exterior walls
being sheathed with 7>16-inch OSB. The walls bear on a
concrete floor.

22. How many studs are needed to frame the wall in Fig-
ure 8-24? The stud spacing is 16 inches on center. Allow
for one additional stud for each wall that does not have a
corner; two additional studs for each corner, intersection,
or doorway; six additional studs for each window less
than 6 feet in width; and eight additional studs for each
window 6 feet or more in width. The closet doors are
6 feet wide and the single-hung doors are 30 inches wide.

23. Prepare a materials list for the headers required to com-
plete the walls in Figure 8-24. All headers are made from
2�12s and the wall is made from 2�4s. The single-
hung doors are 32 inches wide and the closet doors are 6
feet wide. Openings 6 feet or more in width require
double jack studs.

24. How many lineal feet of blocking are needed for the
walls in Figure 8-24 if the studs in the exterior walls are
blocked at their midpoints as shown in Figure 8-11?

FIGURE 8-23 Floor-Framing Plan
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FIGURE 8-24 Wall Layout

FIGURE 8-25 Wall Layout

25. How many 4-foot by 8-foot sheets of 7>16-inch OSB are
needed to sheet the outside of the exterior walls shown
in Figure 8-24 if the wall height is 9 feet?

26. How many feet of treated and untreated plate are
needed to construct the walls shown in Figure 8-25? The
walls are constructed of 2 � 4s with the exterior walls

being sheathed with 7>16-inch OSB. The walls bear on a
concrete floor.

27. How many studs are needed to frame the wall in
Figure 8-25? The stud spacing is 16 inches on center.
Allow for one additional stud for each wall that does
not have a corner; two additional studs for each corner,
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intersection, or doorway; six additional studs for each
window less than 6 feet in width; and eight additional
studs for each window 6 feet or more in width.

28. Prepare a materials list for the headers required to com-
plete the walls in Figure 8-25. All headers are made from
2 � 12s and the wall is made from 2 � 4s. The exterior
doors are 36 inches wide and the interior single-hung
doors are 32 inches wide. Openings 6 feet or more in
width require double jack studs.

29. How many lineal feet of blocking are needed for the
walls in Figure 8-25 if the studs in the exterior walls are
blocked at their midpoints as shown in Figure 8-11?

30. How many 4-foot by 8-foot sheets of 7>16-inch OSB are
needed to sheet the outside of the exterior walls shown
in Figure 8-25 if the wall height is 10 feet 4 inches?

31. A roof framed with 2 � 8 rafters has a span of 30 feet, an
overhang of 18 inches, and a slope of 6:12. What length
of common rafters needs to be ordered for the roof?

32. A roof framed with 2 � 6 rafters has a span of 18 feet, an
overhang of 12 inches, and a slope of 4:12. What length
of common rafters needs to be ordered for the roof?

33. The hip roof shown in Figure 8-26 is constructed of 2 � 8
rafters spaced 16 inches on center. The hip rafters are
1 1>2-inch-wide by 12-inch-high GLBs. The roof has a
slope of 6:12. Prepare a list of lengths and quantities for
the 2 � 8s and GLBs. Ceiling joists will be used to pre-
vent the walls from spreading. Do not include the ceil-
ing joists in your estimate.

34. The hip roof shown in Figure 8-27 is constructed of 2 � 6
rafters spaced 24 inches on center. The hip and valley
rafters are also constructed of 2 � 6s. The roof has a

slope of 4:12. Prepare a list of lengths and quantities for
the 2 � 6s. Hint: The lengths of the valley rafters are calcu-
lated in the same way as those for the hip rafters. Ceiling
joists will be used to prevent the walls from spreading. Do
not include the ceiling joists in your estimate.

35. What size of trusses needs to be ordered for the roof
shown in Figure 8-28? The gable ends of the building
are to be constructed as part of the walls. The slope of
the roof is 4:12. The trusses are spaced 24 inches on
center and are made of 2 � 4s. How many 8-foot-long
2 � 4s need to be ordered if the lookouts are con-
structed of 2 � 4s spaced 24 inches on center?

36. What size of trusses needs to be ordered for the roof shown
in Figure 8-29? The slope of the roof is 4:12. The trusses are
spaced 24 inches on center and are made of 2 � 4s.

37. What is the area of the roof in Figure 8-28? How many
sheets of 7>16-inch OSB are needed for the roof? What
is the waste factor for this roof?

38. What is the area of the roof in Figure 8-29? How many
sheets of 7>16-inch OSB are needed for the roof? What
is the waste factor for this roof?

39. How many feet of 2� fascia are needed for the roof in
Figure 8-28? What size of fascia is needed?

40. How many feet of 2� fascia are needed for the perimeter
of the roof in Figure 8-29? What size of fascia is needed?

41. Determine the number of sheets of 4-foot by 8-foot by
7>16-inch OSB that are needed for the soffit of the roof
in Figure 8-28. The soffit is installed parallel to the roof.

42. Determine the number of sheets of 4-foot by 8-foot by
7>16-inch OSB that are needed for the soffit of the roof
in Figure 8-29. The soffit is installed horizontally.

FIGURE 8-26 Roofing Plan for Hip Roof
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FIGURE 8-27 Roofing Plan for Hip Roof

FIGURE 8-28 Roofing Plan



43. Determine the wood base and wood casing needed to
complete the rooms shown in Figure 8-24. The casing is
only located around the single-hung doors. The base
comes in 8-, 12-, and 16-foot lengths and the casing
comes in 7-foot lengths.

44. Determine the wood base and wood casing needed to
complete the rooms shown in Figure 8-25. The casing is
only located around the single-hung doors. The base
comes in 8-, 12-, and 16-foot lengths and the casing
comes in 7-foot lengths.

45. Determine the cabinets and lineal feet of countertop
needed for the cabinet layout shown in Figure 8-30.

46. Determine the cabinets and lineal feet of countertop
needed for the cabinet layout shown in Figure 8-31.
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FIGURE 8-29 Roofing Plan

FIGURE 8-30 Cabinet Elevation

FIGURE 8-31 Cabinet Elevation



47. Determine the lumber needed to frame the Johnson
Residence given in Appendix F.

48. Determine the wood base and casing needed to com-
plete the Johnson Residence given in Appendix F.

49. Determine the cabinetry and countertops needed to
complete the Johnson Residence given in Appendix F.

50. Determine the lumber needed to complete the West
Street Video project given in Appendix F.

51. Determine the cabinetry and countertops needed to com-
plete the West Street Video project given in Appendix F.

52. Set up Excel Quick Tip 8-1 in Excel.

53. Set up Excel Quick Tip 8-2 in Excel.

54. Set up Excel Quick Tip 8-3 in Excel.

55. Set up Excel Quick Tip 8-4 in Excel.

56. Set up Excel Quick Tip 8-5 in Excel.

57. Set up Excel Quick Tip 8-6 in Excel.

58. Modify Excel Quick Tip 8-3 to allow the building length
and width to be entered in feet and inches.

59. Modify Excel Quick Tip 8-6 to allow the span to be en-
tered in feet and inches.

REFERENCE
1. International Building Code, International Code Council,

2009, Table 2308.8.3.
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In this chapter you will learn how to apply the principles in
Chapter 4 to waterproofing and dampproofing, building paper
and vapor barriers, insulation, exterior insulation finish sys-
tem (EIFS), shingles, siding, and membrane roofing. This
chapter includes sample spreadsheets that may be used in the
quantity takeoff. It also includes example takeoffs from the res-
idential garage drawings in Appendix F.

This chapter deals with the insulation and exterior
finishes that protect the building against heat loss
and the infiltration of water. Let’s begin by looking

at waterproofing and dampproofing.

WATERPROOFING AND
DAMPPROOFING
Waterproofing and dampproofing consist of a water-resistant
coat that is sprayed or brushed onto the exterior of the foun-
dation. Sometimes a waterproof membrane or layers of
building paper are included in the waterproofing system. To

increase the effectiveness of the waterproofing, a drain board
may be placed on the outside of the waterproof membrane.
The drain board allows water to travel freely in the vertical
direction, thus minimizing the chance that it will penetrate
the waterproof membrane. For a drain board to be effective,
there must be a drainage system at the bottom of the drain
board to prevent the accumulation of water.

Sprayed-on waterproofing is bid by the square foot or as
a quantity-from-quantity good. Waterproof membranes and
building paper is bid as a sheet or roll good. The quantity
takeoff for sprayed-on waterproofing is shown in the follow-
ing example.

EXAMPLE 9-1

Figure 9-1 shows the foundation plan and a wall section for a build-
ing. The entire exterior perimeter of the building is to be water-
proofed with a sprayed-on membrane starting 6 inches from the top
of the wall, continuing down the wall, and covering the top of the
footing. How many square feet of waterproofing are needed for the
building? If one gallon of waterproofing material covers 80 square
feet, how many gallons of waterproofing material are needed?

THERMAL AND MOISTURE

PROTECTION

CHAPTER NINE

FIGURE 9-1 Foundation Plan and Section
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FIGURE 9-2 Corners

Solution: The perimeter of the building is 100 feet (20 ft + 30 ft +
20 ft + 30 ft). The height of the waterproofing is the height of the
wall less 6 inches plus the width of the top of the footing on one
side of the wall, or 8.5 feet (8 ft - 0.5 ft + 1 ft). The area of the wa-
terproofing is 850 square feet (100 ft � 8.5 ft). To this, one needs to
add the four 1-foot by 1-foot corners (shown in Figure 9-2) on top
of the footing. The total area is 854 square feet. The number of gal-
lons of waterproofing is determined using Eq. (4-20) as follows:

�Quantity �
854!sft

80 sft/gallon
� 10.7!gallons

BUILDING PAPER AND
VAPOR BARRIERS
Building paper and vapor barriers are used behind masonry
or siding, under shingles, and between the insulation and the
inside finish of the exterior walls. Building paper and vapor
barriers are bid as a rolled good and must be lapped to be ef-
fective. The quantity takeoff for building paper behind ma-
sonry or siding is shown in the following example.

EXAMPLE 9-2

Determine the number of rolls of 30-pound asphalt-impregnated
felt needed to cover a wall 90 feet long by 8 feet high. The felt comes
in rolls 3 feet wide with 2 squares (200 ft2) per roll. The felt must be
lapped 12 inches on the ends and 6 inches on the sides.

Solution: The number of rows of felt is calculated using Eq. (4-12)
as follows:

NumberRows �
8!ft

(3!ft � 0.5!ft)
� 3.2!rows

EXCEL QUICK TIP 9-1

Waterproofing

The calculation of the area of the waterproofing is set up
in a spreadsheet by entering the data and formatting the
cells as follows:

A B C
1 Wall Length 1
2 Wall Length 2
3 Wall Length 3
4 Wall Length 4
5 Wall Length 5
6 Wall Length 6
7 Wall Height
8 Start __ Below Top of Wall
9 Width of Top of Footing

10 Extra Corners
Coverage11

12
13 Perimeter
14 Area of Waterproofing
15 Gallons of Waterproofing

8
6

4

30
20
30
20

-
-

12

80

100
854

10.6

ft
ft
ft
ft
ft
ft
ft
in
in
ea

sft/gal

ft
sft
gal

The following formulas need to be entered into the asso-
ciated cells:

The data for the foundation is entered in Cells B1
through B10. The data shown in the foregoing figure is
from Example 9-1 and is formatted using the comma
style, which replaces zeros with dashes.

Cell Formula

B13 =SUM(B1:B6)

B14 =B12*(B7-B8/12+B9/12)+B10*(B9/12)*

(B9/12)

B15 =B14/B11
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Because the partial row is equal to the lap, the number of rows can
be rounded down. Three rows of felt are needed. The first row will
run from the bottom of the wall to 3 feet high, the second row will
run from 2 feet 6 inches to 5 feet 6 inches, and the last row will run
from 5 feet to 8 feet, the top of the wall. The length of a roll is 66
feet 8 inches (200 ft2/3 ft). The number of columns is calculated
using Eq. (4-15) as follows:

The number of sheets needed for the wall is calculated using Eq.
(4-18) as follows:

�

When using asphalt-impregnated felt on roofs with a
slope greater than or equal to 2:12 and less than 4:12 the felt
must be lapped 19 inches. When using asphalt-impregnated
felt on roofs with a slope greater than or equal to 4:12, the
felt must be lapped 2 inches.1 In areas of the country where
there is the possibility of ice forming on the eaves, two layers
of felt cemented together or self-adhering bitumen sheet
such as Ice and Water Shield are required from the edge of

Number � (3!rows)(1.4!columns) � 5!rolls

NumberColumns �
90!ft

(66.67!ft � 1!ft)
� 1.4!columns

the roof to a point 24 inches inside the exterior face of the
exterior wall.2 Local codes may increase this distance.

When taking off roofs, distances that are perpendicular
to the slope of the roof can be measured directly off of the
plans, whereas distances that are parallel to the slope of the
roof must be converted from a plan view (horizontal) dis-
tance to a sloped distance. This is done using the following
equation:

(9-1)

The plan view area is substituted into Eq. (9-1) to get the fol-
lowing equation, which is used to convert the plan view area
into the actual surface area:

(9-2)

Hips and valleys on roofs increase the waste and the
amount of material needed to complete the roof. For the hip
roof in Figure 9-3, the felt layout for the trapezoidal areas is
shown in Figure 9-4. During installation, the dashed areas of
the felt are folded over onto the triangular areas of the roof.
A similar situation occurs on the triangular areas. This in-
creases the amount of material needed to complete the roof.

AreaSurface � AreaPlan View(1 � Slope2)0.5

LengthSloped � LengthPlan View(1 � Slope2)0.5

FIGURE 9-3 Roof Plan

FIGURE 9-4 Felt Layout
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To do a proper takeoff for a roof, each roof surface must
be taken off individually. The felt folded over onto the ad-
joining roof surfaces is taken into account by increasing the
width of the surface by the width of the roll of felt plus the
required end lap. In the case of a 36-inch-wide roll of felt
with a 12-inch end lap, the length of each row is increased by
4 feet (48 in). It is important to note that the increase in
width is perpendicular to the length of the roll (parallel to
the slope of the roof surface) rather than parallel to the hip
or valley.

Rather than calculate the length of each of the rows, one
can approximate the lengths by using the average length.
Unless the top row of felt has sufficient material to be folded
over the ridge and meet the lapping requirements, an addi-
tional piece of felt is needed for the ridge whose length
equals the length of the ridge plus twice the required edge
lap. The takeoff of felt is shown in the following example.

EXAMPLE 9-3

Determine the number of rolls of 15-pound asphalt-impregnated
felt needed for the roof in Figure 9-3. The felt is to be lapped 6
inches on the side and 12 inches on the ends. The felt is available in
rolls 3 feet wide with 4 squares (400 ft2) per roll. The slope on the
roof is 6:12.

Solution: The sloped length of the roof from the eaves to the ridge
is calculated using Eq. (9-1) as follows:

The number of rows is calculated using Eq. (4-12) as follows:

Because the width of the partial row is less than the width of the
lap, the number of rows is rounded down to 7. The rows will run
from the eave to 3 feet, from 2 feet 6 inches to 5 feet 6 inches, from
5 feet to 8 feet, from 7 feet 6 inches to 10 feet 6 inches, from 10 feet
to 13 feet, from 12 feet 6 inches to 15 feet 6 inches, and from 15 feet
to 18 feet, covering the side of the roof. The average length of a row
for trapezoidal areas is the average of the length of the ridge and the
eave plus the width of the felt plus the required end lap and is cal-
culated as follows:

The area of felt needed for a trapezoidal area is equal to the average
length multiplied by the number of rows multiplied by the width of
the felt and is calculated as follows:

The average length of a row for the triangular areas is calculated as
follows:

The area of felt needed for a triangular area is calculated as follows:

AreaTriangular � (20!ft)(7!rows)(3!ft˛/row) � 420!ft2

LengthTriangular �
(32!ft � 0!ft)

2
� 3!ft � 1!ft � 20!ft

AreaTrapezoidal � (32!ft)(7!rows)(3!ft˛/˛row) � 672!ft2

LengthTrapezoidal �
(44!ft � 12!ft)

2
� 3!ft � 1!ft � 32!ft

NumberRows �
17.89!ft

(3!ft � 0.5!ft)
� 7.156!rows

LengthSloped � (16!ft) c 1 � a 6

12
b2 d 0.5

� 17.89!ft

A 13-foot-long (12 ft � 2 � 0.5 ft) piece of felt is needed for the
ridge. The area of this felt is 39 square feet (13 ft � 3 ft). The area of
felt needed for the entire roof is calculated as follows:

The number of rolls of felt is calculated as follows:

�

Alternatively, the quantity of felt is approximated by the
following equation:

(9-3)

where

AreaFelt � Area of the Felt Needed for the Roof

AreaRoof � Area of the Roof in Plan View

Slope � Slope of the Roof (Rise/Run)

Width � Width of the Felt

LapSide � Required Lap at the Sides of the Felt

LengthHip/Valley � Length of the Hips and Valleys in
Plan View

LapEnd � Required Lap at the Ends of the Felt

LengthRidge � Length of Ridges

Ridges � Number of Ridges

The purposes of the various components of Eq. (9-3)
are shown in Table 9-1.

EXAMPLE 9-4

Solve Example 9-3 using Eq. (9-3).

Solution: The lengths of the hips in plan view are calculated using
the Pythagorean theorem as follows:

The total length of the hips is 91 feet (4 � 22.62 ft). The quantity of
felt needed is calculated as follows:

The number of rolls of felt is calculated as follows:

�Rolls �
2,276!ft2

(400!ft2
˛> ˛roll)

� 6!rolls

� 2,276!ft2

� !�12!ft � 2(1)(1!ft)�(3!ft)

� (91!ft) c (1 � (6>12)2)

2
d 0.5

(3!ft � 1!ft) c 3!ft

(3!ft � 0.5!ft)
d

AreaFelt � (44!ft)(32!ft)�1 � (6>12)2�0.5 c 3!ft

(3!ft � 0.5!ft)
d

Length � �(16!ft)2 � (16!ft)2�0.5 � 22.62!ft

� 3LengthRidge � 2(Ridges)(LapEnd) 4Width

� (Width � LapEnd) c Width

(Width � LapSide)
d

� LengthHip/Valley c (1 � Slope2)

2
d 0.5

AreaFelt �  AreaRoof(1 � Slope2)0.5 c Width

(Width � LapSide)
d

Rolls �
2,223!ft2

(400!ft2/˛roll)
� 6!rolls

� 2(672!ft2) � 2(420!ft2) � 39!ft2 � 2,223!ft2

Area � 2(AreaTrapezoidal) � 2(AreaTriangular) � AreaRidge
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When Ice and Water Shield is used at the eaves, the num-
ber of rows of Ice and Water Shield required is determined.
The Ice and Water Shield reduces the area covered by the felt.
The felt must cover the area not covered by the Ice and Water
Shield and must lap over the edge of the Ice and Water Shield.
The felt needed to cover the remaining area is calculated
using the procedures shown in Examples 9-3 and 9-4.

INSULATION
The two most common types of insulation are fiberglass batt
insulation and blown insulation. Batt insulation may be pa-
perbacked or unfaced. Paperbacked insulation is installed
with the paper on the interior side of the wall. Unfaced insu-
lation requires a vapor barrier, such as a plastic sheet, to be
placed on the interior side of exterior walls. Batt insulation is
available in rolls or precut blankets packaged in bundles.
Batt insulation comes in two common widths: 15 inches for
use in 2� framing with a spacing of 16 inches on center and
23 inches for a spacing of 24 inches on center. The quantity
of insulation needed for a wall or ceiling is bid as a sheet
good with a 1-inch spacing between the sheets; a sample cal-
culation is shown in the following example.

EXAMPLE 9-5

How many square feet of wall insulation are needed to insulate 90
feet of an 8-foot-high wall? The stud spacing is 16 inches on center.
How many rolls of insulation are needed if there are 40 square feet
per roll?

Solution: The number of rows is one row 8 feet high. The number
of columns is calculated using Eq. (4-17) as follows:

The number of sheets of 8-foot by 15-inch-wide insulation needed
is 68. The area of insulation needed is equal to number of sheets
multiplied by the area of the sheet, which is equal to the length of
the sheet multiplied by the width of the sheet:

The number of rolls is calculated as follows:

�

Alternatively, the square footage of insulation for an in-
sulated surface is approximated by the following equation:

(9-4)AreaInsulation � (AreaWall)a Width

Spacing
˛b

Number �
680!ft2

(40!ft2
˛> ˛roll)

� 17!rolls

Area � (68)(8!ft)(15!in)a 1!ft

12!in
b � 680!ft2

NumberColumns �
(90!ft)(12!in/ft)

(15!in � 1!in)
� 68!columns

TABLE 9-1 Components of Eq. (9-3)

Equation Component Purpose

(1 � Slope2)0.5 Converts the area from the plan view to the actual area of the roof
using Eq. (9-2)

c Width

(Width � LapSide)
d Takes into account the lap on the side of the rolls

c (1 � Slope2)

2
d 0.5 Converts the length of hips and valleys in the plan view to the

length along the roof surface as measured perpendicular to the felt

(Width � LapEnd) Takes into account the lap on the hips and valleys

2(Ridges)(LapEnd) Takes into account the lap at the ends of the ridges

EXCEL QUICK TIP 9-2

Roofing Felt

The calculation of the number of rolls of roofing felt
needed for a roof is set up in a spreadsheet by entering the
data and formatting the cells as follows:

The following formulas need to be entered into the asso-
ciated cells:

The data for roof is entered in Cells B1 through B10. The
data shown in the foregoing figure is from Example 9-4.

A B C
1 Roof Length (Plan View) 44 ft
2 Roof Width (Plan View) 32 ft
3 Slope 6 :12
4 Underlayment Width 3 ft
5 Squares Per Roll 4 squ
6 Side Lap 6 in
7 End Lap 12 in
8 Total Length of Hips/Valleys 91 ft
9 Total Length of Ridges 12 ft

10 Number of Ridges 1 ea
11
12 Area 2,276 sft
13 Rolls 6 ea

Cell Formula

B12 =B1*B2*(1+(B3/12)^2)^0.5*

(B4/(B4-B6/12))

+B8*((1+(B3/12)^2)/2)^0.5*(B4+B7/12)

*(B4/(B4-B6/12))+(B9+2*B10*B7/12)*B4

B13 =ROUNDUP(B12/(B5*100),0)
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where

Width � Width of the Insulation

Spacing � Spacing of the Framing Members

The width of the insulation should be 1 inch less than the
stud spacing. The use of this equation is shown in the fol-
lowing example:

EXAMPLE 9-6

Solve Example 9-5 using Eq. (9-4).

Solution: The area of the wall is calculated as follows:

The area of the insulation is calculated using Eq. (9-4) as follows:

The number of rolls is calculated as follows:

�Number �
675!ft2

(40!ft2/roll)
� 17!rolls

AreaInsulation � (720!ft2)a15!in˛

16!in
b � 675!ft2

AreaWalls � (90!ft)(8!ft) � 720!ft2

EXCEL QUICK TIP 9-3

Batt Insulation

The calculation of the number of rolls of insulation needed is set up in a spreadsheet by entering the data and formatting
the cells as follows:

The following formulas need to be entered into the associ-
ated cells:

Once these formulas have been entered, Cell B8 needs to be
copied to Cells D8 and F8, and Cell B13 needs to be copied
to Cells D13 and F13.

The data for insulation is entered in Cells B1 and B2,
and the data for the insulated surface is entered in Cells B5
through B7, D5 through D7, F5 through F7, B10 through
B12, D10 through D12, and F10 through F12. The data
shown in the foregoing figure is from Example 9-6 and is
formatted using the comma style, which replaces zeros
with dashes.

A B C D E F G
1 Insulation Width 15 in
2 Square Foot per Roll 40 sft
3
4
5 Number 1 ea ea ea
6 Width/Height 8 ft ft ft
7 Length 90 ft ft ft
8 Area 720 sft - sft - sft
9

10 Number ea ea ea
11 Base ft ft ft
12 Height ft ft ft
13 Area - sft - sft - sft
14
15 Total Area 720 sft
16 Area of Insulation 675 sft
17 Rolls 17 ea

Rectangular Areas

Triangular Areas

Cell Formula

B8 =B5*B6*B7

B13 =B10*B11*B12/2

B15 =B8+D8+F8+B13+D13+F13

B16 =B15*B1/(B1+1)

B17 =ROUNDUP(B16/B2,0)

Blown insulation may be made from fiberglass, shred-
ded newspaper, or spun rock. Blown insulation is bid as a
quantity-from-quantity good using historical data or data
from the manufacturer on how many bags of insulation are
required to cover 1,000 square feet. The quantity takeoff for
blown insulation is shown in the following example.

EXAMPLE 9-7

How many bags of blown insulation are needed to insulate a
1,250-square foot ceiling with R-38 insulation? The manufac-
turer’s recommended coverage rate is 58 bags per 1,000 square
feet.
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FIGURE 9-5 Building End

Solution: The quantity is calculated as follows:

�

EXTERIOR INSULATION
FINISH SYSTEM
Exterior insulation finish system (EIFS) consists of a ridged
insulation layer covered with a synthetic stucco system. The
stucco system includes a base coat, a reinforcing layer, a
brown coat, and a colored finish coat. The insulation is bid
as a sheet good using the same principles as for bidding
sheathing. The synthetic stucco system is bid as a quantity-
from-quantity good using historical data or coverage rates
from the manufacturer. Any specialty features, such as
raised areas or areas of a different color, need to be ac-
counted for. The quantity takeoff for EIFS is shown in the
following example.

EXAMPLE 9-8

Determine the quantities of insulation, mesh reinforcement, and
stucco needed to cover the end of the building shown in Figure 9-5.
The insulation comes in 4-foot by 8-foot sheets. The reinforcement
comes in rolls 100 feet long by 3 feet wide and needs to be lapped 3
inches. One cubic foot of base or brown coat will cover 75 square
feet of wall, and one bucket of finish coat will cover 130 square feet
of wall.

Bags � (1,250!ft2)a 58!bags

˛1,000!ft2 ˛b � 73!bags

Solution: The rise for the gable end is calculated as follows:

The height of the wall at the peak is 14 feet 4 inches. The number of
rows of insulation is calculated using Eq. (4-13) as follows:

The number of columns of insulation is calculated using Eq. (4-16)
as follows:

The first row of insulation will run from the bottom of the wall to a
height of 8 feet and will consist of eight sheets of insulation. The sec-
ond row of insulation will run from a height of 8 feet to the top of
the wall, which is 1 foot at the eaves and 6 feet 4 inches at the peak.
Because the height at the eaves (1 ft) plus the height at the peak (6 ft
4 in) is less than 8 feet, the scrap from the short side of the gable end
can be used at the peak, allowing two pieces of insulation to be cut
from one sheet on the top row. Four sheets are required for the top
row. The layout of the insulation is shown in Figure 9-6. The num-
ber on each piece of insulation represents the sheet from which the
insulation was cut. A total of 12 sheets of insulation are needed.

The number of rows of reinforcement is calculated using Eq.
(4-12) as follows:

NumberRows �
14.33!ft

(3!ft � 0.25!ft)
� 6!rows

NumberColumns �
32!ft

4!ft
� 8!columns

NumberRows �
14.33!ft

8!ft
� 2!rows

Rise � a32!ft

2
b a 4

12
b � 5.33!ft

FIGURE 9-6 Insulation Layout
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The first row will run from the bottom of the wall to 3 feet high, the
second row will run from 2 feet 9 inches to 5 feet 9 inches, the third
row will run from 5 feet 6 inches to 8 feet 6 inches, the fourth row
will run from 8 feet 3 inches to 11 feet 3 inches, the fifth row will
run from 11 feet to 14 feet, and the last row will run from 13 feet 9
inches to 14 feet 4 inches. The first four rows will need to be 32 feet
wide. For the gable ends, the rows are 3 feet shorter on each end for
every foot above the point where the gable end begins to slope. The
fifth row, which is 2 feet above the point where the roof begins to
slope, will need to be 20 feet wide (32 ft - 2 � 2 ft � 3 ft/ft). The
last row can be cut from the scraps. The length of reinforcement
needed is calculated as follows:

The number of rolls is calculated as follows:

The area of the wall, exclusive of the windows, is calculated as follows:

The quantity of the base coat is calculated using Eq. (4-20) as follows:

The quantity of the brown coat is calculated using Eq. (4-20) as
follows:

The quantity of the finish coat is calculated using Eq. (4-20) as
follows:

In addition, there are two trim pieces, which will require an addi-
tional bucket of finish coat that is a different color. �

SHINGLE ROOFS
Asphalt shingles are often specified by their expected life,
with 20-, 25-, and 30-year shingles being the most common.
Asphalt shingles may be three-tab or architectural-grade
shingles. Flashings are required at all penetrations (such as
vent pipes) and where the roof intersects a wall or chimney.
Drip edge is required at all edges of the roof, including edges
on a gable end.

Shingle roofs consist of underlayment (building paper
and Ice and Water Shield), a starter row of shingles located at
the eaves of the roof, standard shingles placed over most of
the surface of the roof, and cap shingles placed on the hips
and ridges. The standard exposure for shingles is 5 inches, or
in other words, the shingles are lapped so that the rows of
shingles are 5 inches apart. Shingles are bid by the square,
which equals the number of shingles needed to cover 100
square feet of roofing.

Starter rows of shingles consist of shingles with the area
of the shingle that is normally exposed cut off, and as a result

Quantity �
341!ft2

(130!ft2/bucket)
� 3!buckets

Quantity �
341!ft2

(75!ft2/ft3)
� 4.6!ft3

Quantity �
341!ft2

(75!ft2/ft3)
� 4.6!ft3

� 2(4!ft)(4!ft) � 341!ft2

Area � (32!ft)(9!ft) � 0.5(32!ft)(5.33!ft)

Rolls �
148!ft

(100!ft/roll)
� 2!rolls

Length � 4(32!ft) � 1(20!ft) � 148!ft

they are 5 inches narrower than a standard shingle and are
entirely covered by the next row of shingles. For some shin-
gle types, a special shingle is available for use as the starter
row. Starter rows are required for all roof edges that are par-
allel to the rows of shingles. The gable ends of gable roofs do
not require a starter row; however, all the edges of a hip roof
require a starter row. The quantity of shingles required for
the starter row is equal to the length of the edge multiplied
by the exposure of the shingle. This result is divided by 100
square feet to convert the quantity into squares. The quan-
tity of shingles is calculated using the following equation:

(9-5)

The quantity of field shingles for a gable roof is equal to
the area of the roof in squares (100 ft2). When determining
the area of the roof, the estimator must take the slope of the
roof into account as was done with sheathing. This is done
with the following equation:

(9-6)

where

Length � Length of the Roof in Plan View

Width � Width of the Roof in Plan View

Slope � Rise/Run (4>12 for a 4:12 slope)

Substituting the plan view area for length and width into
Eq. (9-6), we get the following equation:

(9-7)

The area of a hip roof is calculated using Eq. (9-6) or Eq.
(9-7) just as for the area of a gable roof. Although a hip roof
has the same area as a gable roof with the same slope and di-
mensions, the presence of hips and valleys increases the
amount of material needed to cover a roof because they are
required to overlap at the hips and valleys. Therefore, a
building covered with a hip roof will require more materials
than the same building covered with a gabled roof with the
same slope, even though the roof areas are the same. The
added material needed for the hips and valleys in a hip roof
is approximated by the following equation:

(9-8)

where

LengthHip/Valley � Length of the Hips and Valleys in
Plan View

Cap shingles are shingles 1 foot wide and are used to
cover hips and ridges. The quantity of cap shingles is equal
to the length of the hips and ridges times the width (1 ft)

�

LengthHip/Valley c (1 � Slope2)˛

2
d 0.5

(Exposure)

(100!ft2/square)
˛

SquaresHip/Valley

SquaresField �
(Area)(1 � Slope2)0.5

(100!ft2/square)

SquaresField �
(Length)(Width)(1 � Slope2)0.5

˛

(100 ft2/square)

SquaresStarter �
(Exposure)(Length)

(100!ft2/square)
˛˛
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divided by 100 square feet to convert the quantity into
squares. Ridges are horizontal and can be measured directly
from the plans. The quantity of ridge shingles needed for a
ridge is calculated using the following equation:

(9-9)

Because hips are sloped, the slope of the hip must be
taken into account when calculating the quantity of shingles
needed for the hip and is calculated using the following
equation:

(9-10)

where

LengthHip � Length of the Hip in Plan View

SlopeHip � Rise/Run (4>17 for a 4:12 slope)

Note that the slope is divided by 17 rather than 12 because
the slope of the hip rafter is flatter than the slope of the roof
as discussed in Chapter 8.

The amount of shingles needed is calculated by sum-
ming the shingles needed for the starter row, the field, the
waste at the hips and valleys, and the cap shingles placed on
the ridges and hips. The quantity takeoff for a hip roof is
shown in the following example.

EXAMPLE 9-9

Determine the number of squares of shingles needed for the hip
roof shown in Figure 9-3. The shingles have a 5-inch exposure and
the slope of the roof is 6:12. The cap and starter strip will be cut
from a standard shingle.

Solution: From Example 9-4, the length of the hips in plan view is
91 feet. The quantity of shingles needed for the starter row is calcu-
lated using Eq. (9-5) as follows:

The quantity of shingles needed for the field is calculated using Eq.
(9-6) as follows:

The quantity of shingles needed for the hips is calculated using Eq.
(9-8) as follows:

The quantity of cap shingles needed for the ridge is calculated using
Eq. (9-9) as follows:

SquaresRidge �
(12)(1!ft)

(100!ft2/square)
� 0.12!square

� 0.30!square

SquaresHip/Valley �

(91!ft) c (1 � (6>12)2)

2
d 0.5

(5!in)(1!ft/12!in)

(100!ft2/square)
˛

SquaresField �
(44!ft)(32!ft)(1 � (6>12)2)0.5

(100!ft2/square)
� 15.74!squares

� 0.63!square

SquaresStarter �
(5 in)(1 ft/12 in)(32 ft � 44 ft � 32 ft � 44 ft)

(100 ft2/square)
˛

SquaresHip �
(LengthHip)(1 � SlopeHip

2 )0.5(1!ft)

(100 ft2/square)

SquaresRidge �
(LengthRidge)(1!ft)

(100!ft2/square)
˛

The quantity of cap shingles needed for the hips is calculated using
Eq. (9-10) as follows:

The total number of squares is calculated as follows:

�� 17.76!squares

� !0.12!square � 0.97!square

Squares � 0.63!square � 15.74!squares � 0.30!square

SquaresHip �
(91!ft)�1 � (6>17)2�0.5(1!ft)

(100!ft2/square)
� 0.97!square

EXCEL QUICK TIP 9-4

Roofing

The calculation of the number of squares of shingles
needed for a roof is set up in a spreadsheet by entering the
data and formatting the cells as follows:

The following formulas need to be entered into the asso-
ciated cells:

The data for the roof is entered in Cells B1 and B7. The
data shown in the foregoing figure is from Example 9-9.

Cell Formula

B9 =(B4/12)*B5/100

B10 =B1*B2*(1+(B3/12)^2)^0.5/100

B11 =B6*((1+(B3/12)^2)/2)^0.5*(B4/12)/100

B12 =B7/100

B13 =B6*(1+(B3/17)^2)^0.5/100

B14 =SUM(B9:B13)

The drip edge is bid as a linear component. When calcu-
lating the lineal feet of drip edge needed for the roof, the
slope of the roof must be taken into account on all gable
ends. This is done using Eq. (9-1). The calculation of the lin-
eal feet of drip edge is shown in the following example.

A B C
1 Roof Length (Plan View) 44 ft
2 Roof Width (Plan View) 32 ft
3 Slope 6 :12
4 Shingle Exposure 5 in
5 Length of Starter Row 152 ft
6 Total Length of Hips/Valleys 91 ft
7 Total Length of Ridges 12 ft
8
9 Starter Strip 0.63 squ

10 Field Shingles 15.74 squ
11 Hip/Valley Shingles 0.30 squ
12 Ridge Cap Shingles 0.12 squ
13 Hip/Valley Cap Shingles 0.97 squ
14 Total Shingles 17.76 squ
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EXAMPLE 9-10

Determine the number of lineal feet of drip edge needed for the
roof in Figure 9-7. The slope of the roof is 4:12. The drip edge
comes in 10-foot lengths and needs to be lapped 2 inches.

Solution: The length of the gable ends of the roof is calculated
using Eq. (9-1) as follows:

The total length is calculated as follows:

The number of pieces of drip edge is calculated using Eq. (4-6) as
follows:

�

SIDING, SOFFIT, AND FASCIA
Siding includes vinyl and aluminum siding, wood board sid-
ing, and wood sheet siding (such as T1-11). Let’s begin by
looking at vinyl and aluminum siding.

Vinyl and aluminum siding consists of a starter strip lo-
cated at the bottom of the wall; outside corner pieces on the
outside corners; J-molding around windows and doors, on
the inside corners, and at the top of the wall; and long, nar-
row siding panels. Aluminum soffit and fascia consists of an
L-shaped piece of aluminum used for the fascia, a J-molding
located on the wall side of the soffit, and narrow soffit pan-
els, which may be vented or nonvented. The siding panels are
designated by their width of coverage; for example, a 10-inch
panel is wider than 10 inches because it includes the material
that goes under the next panel, but it covers a 10-inch wide
swath of wall. When performing the quantity takeoff, one

Number �
164!ft

�10!ft � (2!in)(1!ft/12!in)�
� 17!each

Length � 4(19!ft) � 2(44!ft) � 164!ft

LengthSloped � a36!ft

2
b c 1 � a 4

12
b2 d 0.5

� 19!ft

measures the starter strip, outside corners, and the J-mold-
ing off the plans. The number of squares of siding needed
for rectangular areas is the area of the rectangular. For trian-
gular and trapezoidal areas, additional siding needs to be
added to the width of the area to account for waste at the
ends. This is done by the following equation:

(9-11)

where

LengthTop � Length at the Top of the Area

LengthBottom � Length at the Bottom of the Area

Exposure � Exposure of the Siding

Slope � Slope (Rise/Run) of Triangular or Trapezoidal
Area (for example, 4>12)

Height � Height of the Area

The siding is taken off by the square foot using the same
procedures as for taking off shingles. Soffit and fascia are
taken off using the same procedures as for taking off sheath-
ing for soffit and fascia (see Chapter 8).

When the area of the openings, such as windows, is small
they are often ignored. To deduct an opening, the number of
rows of siding is calculated, and two rows are subtracted for
the top and bottom of the opening. The number of rows is
then multiplied by the width of the opening. The takeoff of
vinyl and aluminum siding is shown in the following example.

EXAMPLE 9-11

Determine the quantities of starter strip, outside corners, J-mold-
ings, and 10-inch-wide siding needed to cover the end of the
building shown in Figure 9-8. The starter strip, outside corners,
and J-moldings are available in 10-foot lengths. The siding comes

Area � caLengthTop � LengthBottom

2
b�

Exposure

Slope
˛ dHeight

FIGURE 9-7 Roof Plan
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in packages of 200 square feet. When calculating the siding, do not
deduct the area of the windows.

Solution: Four 10-foot lengths of starter strip and two 10-foot
lengths of outside corner are needed. J-molding is required around
the windows and at the top of the wall. The length of the J-molding
at the top of the wall is calculated using Eq. (9-1) as follows:

To minimize splicing, order two 10-foot lengths for each side of the
roof and two 10-foot lengths for each window, for a total of eight
10-foot lengths. The rise for the gable end is calculated as follows:

Rise � a32!ft

2
b a 4

12
b � 5.33!ft

LengthSloped � a32!ft

2
b c 1 � a 4

12
b2 d 0.5

� 16.9!ft

Divide the wall into two areas: a 32-foot-wide by 9-foot-high rec-
tangular area and a 32-foot-wide by 5.33-foot triangular area. The
area of the rectangular area is calculated as follows:

The siding has an exposure of 10 inches, or 0.833 ft. The triangular
area is calculated using Eq. (9-11) as follows:

The total area is 387 square feet (288 ft2 + 99 ft2). The number of
packages of siding is calculated as follows:

�Number �
387!ft2

(200!ft2/package)
� 2!packages

Area � c (0!ft � 32!ft)

2
�

(0.833!ft)

(4>12)
d (5.33!ft) � 99!ft2

Area � (32!ft)(9!ft) � 288!ft2

FIGURE 9-8 Building End

EXCEL QUICK TIP 9-5

Siding

The calculation of the number of square feet of siding needed for a wall is set up in a spreadsheet by entering the data and
formatting the cells as follows:

A B C D E F G
1 Exposure 10 in
2 Slope 4 :12
3
4
5 Number 1 ea ea ea
6 Width/Height 9.00 ft ft ft
7 Length 32.00 ft ft ft
8 Area 288 sft - sft - sft
9

10 Number 1 ea ea ea
11 Base 32.00 ft ft ft
12 Height 5.33 ft - ft - ft
13 Area 99 sft - sft - sft
14
15 Total Area 387 sft

Rectangular Areas

Triangular Areas
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must be accounted for by determining the length of the
boards before their ends are cut to match the slope. The av-
erage length of the boards can be approximated by using the
following equation:

(9-12)

where

LengthTop � Length at the Top of the Area

LengthBottom � Length at the Bottom of the Area

Exposure � Exposure of the Siding

Slope � Slope (Rise/Run) of Triangular or Trapezoidal
Area (for example, 4>12)

Openings are handled in the same way as they were for
vinyl and aluminum siding. Soffit and fascia are taken off
using the same procedure as for taking off sheathing for sof-
fit and fascia (see Chapter 8). The takeoff of wood board sid-
ing is shown in the following example.

EXAMPLE 9-12

Determine the quantities of starter strip, 1 � 4 trim, and 1 � 8
wood siding needed to cover the end of the building shown in
Figure 9-10. The siding is lapped 1 inch on the sides and the ends are
butt jointed. The starter strip and 1 � 4 trim are available in 8-, 10-,
and 12-foot lengths. The siding comes in 12-foot lengths. When cal-
culating the siding, do not deduct the area of the windows.

LengthAve �
(LengthTop � LengthBottom)

2
˛ �

Exposure

Slope
˛˛

FIGURE 9-9 Board Siding Section

The following formulas need to be entered into the associ-
ated cells:

Once these formulas have been entered, Cell B8 needs to be
copied to Cells D8 and F8; Cell B12 needs to be copied to
Cells D12 and F12; and Cell B13 needs to be copied to Cells
D13 and F13.

The exposure for the siding is entered in Cell B1, the
slope is entered into Cell B3, and the data for the wall is en-
tered in Cells B5 through B7, D5 through D7, F5 through
F7, B10, B11, D10, D11, F10, and F11. The data shown in
the foregoing figure is from Example 9-11 and is formatted
using the comma style, which replaces zeros with dashes.

Cell Formula

B8 =B5*B6*B7

B12 =(B11/2)*$B$2/12

B13 =B10*(B11/2+$B$1/$B$2)*B12

B15 =B8+D8+F8+B13+D13+F13

Board siding consists of wood boards (such as 1 � 8s) or en-
gineered siding (such as Hardiplank) that are shipped
lapped on the side of the building. A section for wood board
siding is shown in Figure 9-9.

Board siding requires a starter strip and wood trim on
the corners, around the doors and windows, and at the tops
of the wall. When estimating wood board siding, the ends
are butt jointed and the sides of the board are lapped, greatly
reducing the coverage of the board. For example, a 1 � 8
board siding that is lapped 1 inch has an exposure of 6.25
inches because the 1 � 8 is 7.25 inches wide and 1 inch is lost
because of lapping. When performing the quantity takeoff,
one measures the starter strip and trim off of the plans, as
discussed in Chapter 8. The siding is taken off as a sheet
good. In dealing with triangular and trapezoidal areas waste

FIGURE 9-10 Building End
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Solution: Four 8-foot lengths of starter strip are needed. The ex-
posure of the siding is 6.25 inches. The rise for the gable end is cal-
culated as follows:

The height at the peak of the gable end is 14.33 feet (9 ft + 5.33 ft).
The number of 32-foot-long rows needed for the rectangular area is
calculated using Eq. (4-12) as follows:

The number of columns is calculated using Eq. (4-16) as follows:

The number of pieces of siding needed for the rectangular area is
calculated using Eq. (4-18) as follows:

The average length of each of the rows in the triangular area is cal-
culated using Eq. (9-12) as follows:

The number of rows needed for the entire end is calculated using
Eq. (4-12) as follows:

Therefore, 10 rows (28 - 18) of siding are needed for the gable end.
The average number of columns is calculated using Eq. (4-16) as
follows:

The number of pieces of siding needed for the triangular area is cal-
culated using Eq. (4-18) as follows:

Order sixty-three (48 + 15) 12-foot-long 1 � 8s. Two 10-foot
lengths of 1 � 4s are needed for the corners. A 4-foot 7-inch piece
of trim is needed for the top of the window, two 4-foot 3.5-inch
pieces of trim are needed for the sides of the windows, and a 4-foot
piece of trim is needed for the bottom of the window. Order
three 10-foot and one 8-foot lengths of 1 � 4s for the windows.
The length of the top of the wall is calculated using Eq. (9-1) as
follows:

Order an 8-foot length and a 10-foot length for each side of the
roof. A total of seven 10-foot lengths and three 8-foot lengths of
1 � 4s are needed. �

Sheets of wood siding require wood trim on the corners,
around the windows and doors, and at the top of the wall. In
performing the quantity takeoff, trim is measured off of the
plans, the siding is taken off using the same procedure as for

LengthSloped � a32!ft

2
b c 1 � a 4

12
b2 d 0.5

� 16.9!ft

Number � (10!rows)(1.47!columns) � 15!each

NumberColumns �
17.6!ft

12!ft
� 1.47!columns

NumberRows �
(14.33!ft)(12!in/ft)

(7.25!in � 1!in)
� 28!rows

� 17.6!ft

LengthAve �
(0!ft � 32!ft)

2
�

(7.25!in � 1!in)(1!ft/12!in)

(4>12)

Number � (18!rows)(2.67!columns) � 48!each

NumberColumns �
32!ft

12!ft
� 2.67!columns

NumberRows �
(9!ft)(12!in/ft)

(7.25!in � 1!in)
� 18!rows

Rise � a32!ft

2
b a 4

12
b � 5.33!ft

taking off sheets of sheathing, and the soffit and fascia are
taken off using the same procedures as for taking off sheath-
ing for soffit and fascia (see Chapter 8).

MEMBRANE ROOFING
Membrane roofing consists of a single-ply polyvinyl chloride
(PVC), ethylene propylene diene monomer (EPDM), or
other type of membrane that is used to cover a roof.
Membrane roofing comes in sheets or rolls; for example, a
PVC membrane is available in 75-foot-wide by 300-foot-
long sheets folded up on a pallet. The sheets must be glued
or welded together to form a single membrane. The mem-
brane must be fastened at the edges of the roof using a bat-
ten strip and flashing to prevent water from getting between
the membrane and the wall. The membrane must be fas-
tened to the roof deck or held in place with rock ballast.
Flashings are required on all penetrations. The membrane is
taken off as a sheet or roll good, and the batten strip is taken
off as a linear good. The takeoff of membrane roofing is
shown in the following example.

EXAMPLE 9-13

Determine the number of 25-foot-wide by 100-foot-long sheets of
membrane roofing needed for a roof 110 feet wide by 210 feet long.
Allow 3 feet at the perimeter of the roof for the membrane to be at-
tached to the parapet wall. The roofing must be lapped 3 inches at
the sides and ends.

Solution: The membrane needs to cover an area 116 feet (110 ft +
2 � 3 ft) wide by 216 feet (210 ft + 2 � 3 ft) long. The number of
rows needed for the roof is calculated using Eq. (4-12) as follows:

The number of columns is calculated using Eq. (4-15) as follows:

The number of sheets of roofing needed is calculated using Eq. (4-18)
as follows:

SAMPLE TAKEOFF FOR THE
RESIDENTIAL GARAGE
A sample takeoff for insulation, wood siding, and roofing
from a set of plans is shown in the following example.

EXAMPLE 9-14

Determine the insulation, wood siding (including trim), and roof-
ing (including underlayment) needed to complete the residential
garage given in Appendix F.

Solution: From Example 8-21 there is 83 feet of 8-foot-high wall.
There is also 16 feet of 2-foot-high wall above the garage door, but

Number � (5!rows)(2.2!columns) � 11!sheets

NumberColumns �
216!ft

�100!ft � 3!in(1!ft>12!in)�
� 2.2!columns

NumberRows �
116!ft

�25!ft � 3!in(1!ft>12!in)�
� 5!rows
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only 1 foot can be insulated. For the 8-foot-high wall, there is one
8-foot-high row of insulation. The number of columns is calcu-
lated using Eq. (4-17) as follows:

The number of 1-foot-high columns needed above the garage is
calculated using Eq. (4-17) as follows:

Two columns of insulation 7 feet high (the height of the door and
header) can be deducted for the single-hung door. The area of insu-
lation can be calculated as follows:

The number of rolls is calculated as follows:

A vapor barrier is needed on the unfaced insulation. Use 8-foot by
12-foot sheets of 3-mil-thick plastic. One 8-foot-high row is
needed. The number of columns is calculated using Eq. (4-16) as
follows:

Seven sheets are needed for the walls, and one additional sheet is
needed above the garage door.

The area of the ceiling to be insulated is 26 feet wide by 24 feet
long, or 624 square feet. The insulation comes in 32-foot-long rolls.
The number of rows is calculated using Eq. (4-13) as follows:

The number of columns is calculated using Eq. (4-17) as follows:

The number of rolls of insulation needed for the ceiling is calcu-
lated using Eq. (4-18) as follows:

The area of insulation is calculated as follows:

Next, determine the number of sheets of T1-11 siding needed for
the garage. The siding will be broken down into three areas: the
8-foot-high walls, the 2-foot-high wall above the garage door, and
the gable ends. From Example 8-21 there is 83 feet of 8-foot-high
wall. The rise for the gable end is calculated as follows:

The area of siding needed to be installed is as follows:

� (8!ft)(83!ft) � (2!ft)(16!ft) � 2a (4!ft)(24!ft)

2
b � 792!ft2

Area � Area8-Foot Walls � AreaAbove Garage Door � 2(AreaGable End)

Rise � a24!ft

2
b a 4

12
b � 4!ft

Area � (13!columns)(23!in)(1!ft/12!in)(24!ft) � 598!ft2

Number � (0.75!row)(13!columns) � 10!rolls

NumberColumns �
(26!ft)(12!in/ft)

(23!in � 1!in)
� 13!columns

NumberRows �
24!ft

32!ft
� 0.75!row

NumberColumns �
83!ft

12!ft
� 7!columns

Number �
628!ft2

(40!ft2/roll)
� 16!rolls

Area � �63(8 ft) � 12(1 ft) � 2(7 ft)�(15 in)(1 ft˛> ˛12 in) � 628 ft2

NumberColumns �
(16!ft)(12!in/ft)

(15!in � 1!in)
� 12!columns

NumberColumns �
(83!ft)(12!in/ft)

(15!in � 1!in)
� 63!columns

The number of rows of T1-11 needed for the 8-foot-high walls is
one, and the number of columns is calculated using Eq. (4-16) as
follows:

Twenty-one sheets are needed for the 8-foot-high wall. Four 2-foot-
high by 4-foot-wide sheets are needed above the garage door and
can be cut from one sheet of T1-11. The number of columns on a
gable end is calculated using Eq. (4-16) as follows:

The three columns on each side of the peak can be cut from one
sheet; thus, four sheets are required. A total of 26 sheets (21 + 1 + 4)
of T1-11 are needed.

Next, the T1-11 for the soffit will be calculated. The soffit is
18 inches wide. Determine the length of the soffit, making sure
that the corners are not double counted. The sloped length of the
roof from the eave to the ridge is calculated using Eq. (9-1) as
follows:

The length of the soffit is calculated as follows:

Five 18-inch-wide by 4-foot-long pieces of soffit can be cut from
one sheet of T1-11. The number of sheets is calculated as follows:

The area of the soffit is calculated as follows:

In addition, 58 feet (2 � 29 ft) of 3-inch-wide screen and two 12-
inch-wide by 14-inch-high vents are needed.

The amount of 1 � 4 cedar trim needed, along with its use, is
shown in Table 9-2. The sloped trim will be cut in the field. The
trim will be ordered in 8-, 10-, and 12-foot lengths.

The total length of sloped trim that needs to be cut and in-
stalled is as follows:

The total length of unsloped trim that needs to be installed is as
follows:

The perimeter of the roof is calculated as follows:

The area of the roof is calculated as follows:

Determine the number of pieces of 10-foot-long drip edge, allow-
ing 0.2 foot for lap, using Eq. (4-6) as follows:

Number �
115!ft

(10.0!ft � 0.2!ft)
� 12!ea

Area � 2(14.2!ft)(29!ft) � 824!ft2

Perimeter � 4(14.2!ft) � 2(29!ft) � 115!ft

� 212!ft

Length � 8(9!ft) � 2(7!ft) � 2(7!ft) � 2(26!ft) � 4(13!ft) � 4(2!ft)

Length � 4!ft � 17!ft � 2(24!ft) � 2(2!ft) � 2(1!ft) � 75!ft

Area � (1.5!ft)(109!ft) � 164!ft2

Number �
109!ft

(5 � 4!ft)
� 6!sheets

Length � 4(14.2!ft) � 2(26!ft) � 109!ft

LengthSloped � a27!ft

2
b c 1 � a 4

12
b2 d 0.5

� 14.2!ft

NumberColumns �
24!ft

4!ft
� 6!columns

NumberColumns �
83!ft

4!ft
� 21!columns
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Determine the number of rolls of 15-pound felt. The number of
rows per side is calculated using Eq. (4-12) as follows:

Round to 6 rows, and use the extra to lap at the ridge, thus elimi-
nating the need for a row at the ridge. The area of felt needed for
the roof is calculated as follows:

The number of rolls of felt is calculated as follows:

The quantity of shingles needed for the starter row is calculated
using Eq. (9-5) as follows:

The quantity of shingles needed for the field is equal to the area of
the roof, which is 824 square feet, or 8.24 squares. The quantity of
cap shingles needed for the ridge is calculated using Eq. (9-9) as
follows:

The total number of squares is calculated as follows:

Each bundle of shingles is 1/3 square. Round to 9 squares. Twenty-
seven (3 � 9) bundles of shingles are needed.

The quantities needed for the garage, grouped by the cost
codes in Appendix B, are shown in Table 9-3. �

� 8.77!squares

Squares � 0.24!square � 8.24!squares � 0.29!square

SquaresRidge �
(29)(1!ft)

(100!ft2/square)
� 0.29!square

SquaresStarter �
(5!in)(1!ft/12!in)(29!ft � 29!ft)˛

(100!ft2/square)
� 0.24!square

Rolls �
1,044!ft2

(400!ft2/roll)
� 3!rolls

Area � (29!ft)(2!sides)(6!rows/side)(3!ft/row) � 1,044!ft2

NumberRows �
14.2!ft

(3!ft � 0.5!ft)
� 5.7!rows

TABLE 9-2 1 � 4 Cedar Trim

Actual Order

Quantity Length Quantity Length
Use (ea) (ft) (ea) (ft) Sloped

Corners 8 9 8 10 No

Single-hung door (sides) 2 7 2 8 No

Single-hung door (top) 1 4 0.5 8 Yes

Overhead door (sides) 2 7 2 8 No

Overhead door (top) 1 17 1 8 Yes

1 10

Top of side walls 2 26 4 8 No

2 10

Top of end walls 4 13 4 8 No

2 10

Gable ends at seam 2 24 4 12 Yes

Vents (tops) 2 2 0.5 8 Yes

Vents (sides) 4 2 1 8 No

Vents (bottoms) 2 1 0.5 8 Yes

TABLE 9-3 Quantities for Residential Garage

07-200 Insulation

R-13 15 32 unfaced¿�– 16 ea

3-mil plastic 8 12¿�¿ 8 ea

Install R-13 insulation 628 sft

R-25 23 32 unfaced¿�– 10 ea

Install R-25 insulation 598 sft

07-400 Siding

T1-11 26 ea

Install siding 792 sft

T1-11 soffit 6 ea

Install soffit 164 sft

3 -wide screen– 58 ft

12 14 vent–�– 2 ea

1 4 cedar 8¿� 16 ea

1 4 cedar 10¿� 13 ea

1 4 cedar 12¿� 4 ea

Cut and install trim 75 ft

Install trim 212 ft

07-500 Roofing

Drip edge 10¿ 12 ea

15-lb felt, 4-square roll 3 ea

20-yr three-tab shingles 9 sq

Install roofing 824 sft
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CONCLUSION
Thermal and moisture protection includes exterior finishes
(such as siding, stucco, and roofing) that protect the building
against moisture infiltration, and insulation that protects the
building against heat loss. Many of the components used for
thermal and moisture protection are bid as a sheet or roll
good.

PROBLEMS
1. How much waterproofing is needed to cover the foun-

dation walls of a 24-foot by 50-foot basement? The wall
is 8 feet high. The wall sits on a footing that is 12 inches
high and extends 16 inches beyond the wall on the exte-
rior side. Assume that the waterproofing starts 12 inches
below the top of the foundation wall and covers the top
surface of the footings. If one gallon of waterproofing
material covers 75 square feet, how many gallons of wa-
terproofing material are needed?

2. How much waterproofing is needed to cover the foun-
dation walls of a 32-foot by 48-foot basement? The wall
is 8 feet high. The wall sits on a footing that is 12 inches
high and extends 12 inches beyond the wall on the exte-
rior side. Assume that the waterproofing starts 24 inches
below the top of the foundation wall and covers the top
surface of the footings. If one gallon of waterproofing
material covers 90 square feet, how many gallons of wa-
terproofing material are needed?

3. Determine the number of rolls of 15-pound asphalt-
impregnated felt needed for the roof in Figure 9-11. The
felt is to be lapped 6 inches on the side and 12 inches on

the ends. The felt is available in rolls 3 feet wide with 4
squares (400 square feet) per roll. The slope on the roof
is 6:12.

4. Determine the number of rolls of 30-pound asphalt-
impregnated felt needed for the roof in Figure 9-12. The
felt is to be lapped 6 inches on the side and 12 inches on
the ends. The felt is available in rolls 3 feet wide with 2
squares (200 square feet) per roll. The slope on the roof
is 4:12.

5. How many square feet of wall insulation are needed to
insulate 25 feet of an 8-foot-high wall? The stud spacing
is 16 inches on center.

6. How many rolls of insulation are needed for Problem 5
if the insulation comes in rolls 15 inches wide and 32
feet long? Do not include a waste factor.

7. How many square feet of wall insulation are needed to
insulate 175 feet of a 10-foot-high wall? The stud spac-
ing is 24 inches on center.

8. How many rolls of insulation are needed for Problem
7 if the insulation comes in rolls 23 inches wide and
32 feet long? Do not include a waste factor.

9. How many bags of blown insulation are needed to in-
sulate a 1,835-square-foot ceiling with R-30 insula-
tion? The manufacturer’s recommended coverage rate
is 41 bags per 1,000 square feet.

10. How many bags of blown insulation are needed to in-
sulate a 1,120-square-foot ceiling with R-25 insula-
tion? The manufacturer’s recommended coverage rate
is 34 bags per 1,000 square feet

11. Determine the quantities of insulation, mesh reinforce-
ment, and stucco needed to cover the end of the building

FIGURE 9-11 Roof Plan
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shown in Figure 9-13. The insulation comes in 4-foot by
8-foot sheets. The reinforcement comes in rolls 100 feet
long by 3 feet wide and needs to be lapped 3 inches. One
cubic foot of base or brown coat will cover 75 square
feet of wall, and one bucket of finish coat will cover
130 square feet of wall.

12. Determine the quantities of insulation, mesh rein-
forcement, and stucco needed to cover the end of the
building shown in Figure 9-14. The insulation comes
in 4-foot by 8-foot sheets. The reinforcement comes in
rolls 100 feet long by 3 feet wide and needs to be lapped
3 inches. One cubic foot of base or brown coat will cover
60 square feet of wall, and one bucket of finish coat will
cover 120 square feet of wall.

13. How many squares of roofing are required to cover the
building in Figure 9-11? The shingles have a 5-inch ex-
posure, and the slope on the roof is 6:12. The cap and
starter strip will be cut from a standard shingle.

14. Drip edge is to be installed around the entire perimeter
of the roof in Figure 9-11. How many feet of drip edge
are needed for the roof?

15. How many pieces of drip edge are needed for Problem
14 if the drip edge comes in 10-foot lengths and needs
to be lapped 2 inches?

16. How many squares of roofing are required to cover the
building in Figure 9-12? The shingles have a 5-inch ex-
posure, and the slope on the roof is 4:12. The cap and
starter strip will be cut from a standard shingle.

17. Drip edge is to be installed around the entire perimeter
of the roof in Figure 9-12. How many feet of drip edge
are needed for the roof?

18. How many pieces of drip edge are needed for Problem
17 if the drip edge comes in 10-foot lengths and needs
to be lapped 2 inches?

19. Determine the quantities of starter strip, outside cor-
ners, J-moldings, and 10-inch-wide vinyl siding needed
to cover the end of the building shown in Figure 9-15.
The starter strip, outside corners, and J-moldings are
available in 10-foot lengths. The siding comes in pack-
ages of 200 square feet. When calculating the siding, do
not deduct the area of the windows.

FIGURE 9-12 Roof Plan

FIGURE 9-13 Building End
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20. Determine the quantities of starter strip, outside cor-
ners, J-moldings, and 10-inch-wide vinyl siding needed
to cover the end of the building shown in Figure 9-16.
The starter strip, outside corners, and J-moldings are
available in 10-foot lengths. The siding comes in pack-
ages of 200 square feet. When calculating the siding, do
not deduct the area of the windows and doors.

21. Determine the quantities of starter strip, 1 � 4 trim,
and 1 � 8 wood siding needed to cover the end of the

building shown in Figure 9-17. The siding is lapped 1
inch on the sides and butt jointed on the ends. The
starter strip and 1 � 4 trim are available in 8-, 10-, and
12-foot lengths. The siding comes in 12-foot lengths.
When calculating the siding, do not deduct the area of
the windows.

22. Determine the quantities of starter strip, 1 � 4 trim,
and 1 � 8 wood siding needed to cover the end of the
building shown in Figure 9-18. The siding is lapped

FIGURE 9-14 Building End

FIGURE 9-15 Building End

FIGURE 9-16 Building End
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FIGURE 9-17 Building End

1 inch on the sides and butt jointed on the ends. The
starter strip and 1 � 4 trim are available in 8-, 10-, and
12-foot lengths. The siding comes in 12-foot lengths.
When calculating the siding, do not deduct the area of
the windows and door.

23. Determine the number of 15-foot-wide by 200-foot-
long sheets of membrane roofing needed for a roof 80
feet wide by 90 feet long. Allow 3 feet per side at the
perimeter of the roof for the membrane to be attached
to the parapet wall. The roofing must be lapped 3 inches
at the sides and ends.

24. Determine the number of 25-foot-wide by 75-foot-long
sheets of membrane roofing needed for a roof 300 feet
wide by 400 feet long. Allow 4 feet per side at the
perimeter of the roof for the membrane to be attached
to the parapet wall. The roofing must be lapped 6 inches
at the sides and ends.

25. Determine the insulation needed to complete the
Johnson Residence given in Appendix F.

26. Determine the vinyl siding, soffit, and fascia needed to
complete the Johnson Residence given in Appendix F.

27. Determine the stucco needed to complete the Johnson
Residence given in Appendix F.

28. Determine the roofing, including underlayment, needed
to complete the Johnson Residence given in Appendix F.

29. Determine the insulation needed to complete the West
Street Video project given in Appendix F.

30. Determine the membrane roofing and sheet metal
needed to complete the West Street Video project given
in Appendix F.

31. Set up Excel Quick Tip 9-1 in Excel.

32. Set up Excel Quick Tip 9-2 in Excel.

33. Set up Excel Quick Tip 9-3 in Excel.

34. Set up Excel Quick Tip 9-4 in Excel.

35. Set up Excel Quick Tip 9-5 in Excel.

36. Modify Excel Quick Tip 9-1 to allow the wall lengths
and wall height to be entered in feet and inches.

37. Modify Excel Quick Tip 9-2 to allow the roof length and
width to be entered in feet and inches.

38. Modify Excel Quick Tip 9-4 to allow the length and
width to be entered in feet and inches.

REFERENCES
1. International Building Code, International Code Counsel,

2009, Section 1507.2.8.
2. International Building Code, International Code Counsel,

2009, Section 1507.2.8.2.

FIGURE 9-18 Building End



In this chapter you will learn how to apply the principles in
Chapter 4 to residential doors and windows, hollow metal
doors, overhead doors, storefronts, and hardware. This chapter
includes example takeoffs from the residential garage drawings.

Openings consist of the doors, frames, glazing, and
hardware to cover openings in both the interior
and exterior walls of buildings. Let’s begin by

looking at doors.

DOORS
Doors include residential prehung doors and commercial
wood and hollow metal doors. Most often doors are marked
with a numbered symbol that relates to a door schedule
found in the plans. In this book, the doors are marked with
numbers inside a hexagon (a six-sided polygon). Each door
may have its own unique identification, or each type of
door may have its own unique identification. Doors come
in four standard swings, which are shown in Figure 10-1.

The right-hand reverse and left-hand reverse swings are
used for exterior doors that swing out. The right-hand and
left-hand swings are used for all interior doors and exterior
doors that swing in. Residential sliding glass doors are pro-
vided by the window supplier and are included as windows.
Commercial glass doors are a part of commercial store-
fronts and are discussed under storefronts.

Doors are bid as a counted item. When bidding doors
the estimator locates the door on the floor plan and uses the
symbol next to the door along with the door schedule to de-
termine the size and type of door needed for the opening. In
addition, the estimator should identify any holes that need
to be predrilled or mortised in the door for the hardware and
the size of the doorjambs. The estimating of doors is shown
in the following example.

EXAMPLE 10-1

Using the door schedule in Figure 10-3, determine the number,
size, and type of doors needed to complete the building shown in
Figure 10-2.

Solution: The following prehung doors are needed: one right-
hand 6-foot 8-inch-high by 3-foot-wide by 1 3>8-inch-thick solid-
core wood exterior door, one right-hand 6-foot 8-inch-high by
2-foot 8-inch-wide by 1 3>8-inch-thick hollow-core birch interior
door, one left-hand 6-foot 8-inch-high by 2-foot 8-inch-wide by
1 3>8-inch-thick hollow-core birch interior door, and two pairs of
6-foot 8-inch-high by 2-foot wide by 1 3>8-inch-thick hollow-core
birch interior bifold doors. The prehung doors have 4 5>8-inch
jambs. The holes that need to be drilled in the doors are discussed
in Example 10-6 where hardware is discussed. �

WINDOWS
Windows include windows and sliding glass doors. Most
often windows are marked with a numbered or lettered sym-
bol that relates to a window schedule or a set of window
drawings found in the plans. In this book, the windows are
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FIGURE 10-1 Standard Door Swings
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FIGURE 10-3 Door Schedule

FIGURE 10-2 Floor Plan

FIGURE 10-4 Window Schedule

marked with a number inside a triangle. Each window may
have its own unique identification, or each type of window
may have its own unique identification. When bidding slid-
ing windows the estimator must note which panels are fixed
and which panels are operable. The estimator must also
identify any windows that require safety glazing (tempered
glass). With glass placed in hollow metal window frames, the
frames are bid with the hollow metal doors and the glass is
included as part of glazing.

Windows are bid as a counted item. When bidding win-
dows, the estimator locates the window on the floor plan and
uses the symbol next to the window along with the window
schedule or drawings to determine the size and type of win-
dow needed for the opening. The estimating of windows is
shown in the following example.

EXAMPLE 10-2

Using the window schedule in Figure 10-4, determine the number,
size, and type of windows needed to complete the building shown
in Figure 10-2.

Solution: The following windows are needed: one 4-foot-high by
4-foot-wide sliding window with the left panel fixed and the right
panel operable, one 4-foot-high by 4-foot-wide sliding window
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with the right panel fixed and the left panel operable, and one 4-
foot-high by 6-foot-wide sliding window with the center panel
fixed and the right and left panels operable. �

COMMERCIAL STOREFRONT
Commercial storefront is a glass wall that is made up of glass
together with metal tubing (commonly aluminum) and may
include doors. It is commonly used at the front of retail stores,
hence the name commercial storefront. Commercial store-
front is provided by the glazing contractor, who provides the
glass, metal tubing, and hardware (except for the cylinder) for
the doors. A cylinder to match the rest of the hardware is pro-
vided by the hardware supplier for the storefront doors.

Often, commercial storefront is bid based on the square
footage of the storefront and the hardware is bid as a
counted item. The estimating of storefront using the square-
footage method is shown in the following example.

EXAMPLE 10-3

Determine the square footage of storefront and hardware needed to
construct the storefront in Figure 10-5 using the hardware schedule
shown in Figure 10-6.

Solution: The area of the storefront is 112.5 square feet (9 ft �
12.5 ft). The hardware needed is 1 1>2 pairs (3 each) of hinges, a
single-keyed lock with the cylinder being provided by the hardware
supplier, panic hardware, one set (17 ft) of weather stripping, one
3-foot-wide threshold, and one floor-mounted doorstop. �

Glazing contractors should bid the storefront based on the
necessary components required to fabricate the storefront.
When bidding storefront based on the necessary components
required to fabricate the storefront, the estimator often uses
nominal dimensions for the storefront and glazing and then
verifies the required sizes by field measuring the opening. The
different components of a storefront are shown in Figure 10-7.

FIGURE 10-5 Storefront Elevation FIGURE 10-6 Hardware Schedule

FIGURE 10-7 Storefront
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The estimator must also identify any glazing that requires
safety glazing (tempered glass). The rules for safety glass are
found in Section 2406 of the International Building Code.1

Estimating commercial storefront by the components
needed to fabricate the storefront is shown in the following
example.

EXAMPLE 10-4

Determine the components and hardware needed to fabricate the
storefront in Figure 10-5 using the hardware schedule shown in
Figure 10-6. The glass in the door and the two panels on either side
of the door needs to be tempered glass.

Solution: The metal tubing needed for the door is shown in
Table 10-1, and the glazing needed is shown in Table 10-2.

The hardware needed is 1 1>2 pairs (3 each) of hinges, a sin-
gle-keyed lock with the cylinder being provided by the hardware
supplier, panic hardware, one set (17 ft) of weather stripping, one
3-foot-wide threshold, and one floor-mounted doorstop. �

GLAZING
Glazing includes installing glass in wood and hollow metal
frames. Glazing is bid as a counted item. The estimator
often uses nominal dimensions for the glazing when bid-
ding and then verifies the required sizes with the frame
manufacturer or by field measuring the frame. The estima-
tor must also identify any windows that require safety glaz-
ing (tempered glass). Estimating glazing is shown in the
following example.

EXAMPLE 10-5

Determine the glazing needed for the transom and sidelight shown
in Figure 10-8. The two panels on the side of the door need to be
tempered glass. Use nominal dimensions.

TABLE 10-1 Metal Tubing Required

Quantity Item Notes

18 ft Jamb Left and right ends

12 ft 6 in Head Top

9 ft 6 in Sill Bottom, except at door

14 ft Door mullion Left and right sides of door

3 ft Transom profile Above door

32 ft Intermediate mullion All other locations

TABLE 10-2 Glazing Required

Quantity Item

3 ea 2-0 � 3-0 glass

1 ea 4-0 � 3-0 glass

1 ea 4-0 � 3-0 tempered glass

1 ea 3-0 � 3-0 glass

1 ea 3-0 � 3-0 tempered glass

1 ea 7-0 � 3-0 tempered glass door

1 ea 2-0 � 3-6 glass

1 ea 4-0 � 3-6 tempered glass

1 ea 3-0 � 3-6 tempered glass

FIGURE 10-8 Door Elevation
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FIGURE 10-9 Hardware Schedule

Solution: The following panels of glass are needed: one 1 foot
10 inches high by 3 feet 3 inches wide, one 1 foot 10 inches high by
3 feet wide, one 4 feet 2 inches high by 3 feet wide tempered, and
one 3 feet high by 3 feet wide tempered. �

HARDWARE
Hardware is taken off as a counted item and includes
hinges (butts), locksets, cylinders, silencers, doorstops,
thresholds, weather stripping, closers, and panic hardware.
The hardware group for each door is shown on the door
schedule, and the hardware items included in each hard-
ware group is shown on the plans by the door schedule or
in the specifications. Frequently, some of the hardware
comes with the doors. For example, a prehung exterior
residential door includes the frame, the hinges, the
weather stripping, and the threshold. Hardware that
comes with the door is not included in the hardware take-
off because it has already been included in the quantity
takeoff with the door. Estimating hardware is shown in the
following example.

EXAMPLE 10-6

Using the hardware schedule shown in Figure 10-9, determine the
hardware needed for the doors in Figures 10-2 and 10-3.

Solution: The hinges, weather stripping, and threshold come with
the prehung doors. One single-keyed deadbolt, one key lockset, and
one wall-mounted doorstop are needed for Door 1. Door 1 should
be ordered predrilled for the deadbolt and lockset; otherwise, they
will have to be drilled in the field. Two privacy locksets and two
wall-mounted doorstops are needed for Doors 2 and 3. These doors
should be predrilled for a lockset. Four brass pulls are needed for
Doors 4 and 5. �

SAMPLE TAKEOFF FOR THE
RESIDENTIAL GARAGE
A sample takeoff from a set of plans is shown in the follow-
ing example:

EXAMPLE 10-7

Determine the doors, overhead doors, and hardware needed to
complete the residential garage given in Appendix F.

Solution: The garage needs one 3-foot by 6-foot 8-inch, six-
panel metal exterior prehung door with 4 5>8-inch wood jambs
and 1 1>2 pairs of hinges drilled for the deadbolt and lockset. A
prehung exterior door includes the hinges, weather stripping, and
threshold.

To complete the hardware for the door, one single-keyed dead-
bolt, one keyed lockset, and one floor-mounted doorstop are needed.

The garage needs one 16-foot by 7-foot prefinished, insulated,
sectional overhead door with one screw-drive opener, two remotes,
and one keyless entry.

The quantities needed for the garage, grouped by the cost
codes in Appendix B, are shown in Table 10-3. �

TABLE 10-3 Quantities for Residential Garage

08-100 Metal Doors

3-0 � 6-8, six-panel metal prehung door with
4 5>8 wood jambs, 1 1>2 pairs of hinges,
weather stripping, and threshold, drilled for
deadbolt and lockset 1 ea

08-300 Overhead Doors

16-ft � 7-ft prefinished, insulated, sectional
overhead door 1 ea

-hp screw-drive opener1>2 1 ea

Keyless entry 1 ea

Remotes 2 ea

08-700 Hardware

Single-keyed deadbolt 1 ea

Keyed lockset 1 ea

Floor-mounted doorstop 1 ea
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CONCLUSION
Doors and windows consist of the doors, frames, glazing,
and hardware to cover the opening in both the interior and
exterior walls of buildings. These items are bid as counted
items, with the exception of storefront, which is bid by the
square foot or lineal foot for the tubing.

PROBLEMS
1. Using the door schedule in Figure 10-11, determine the

number, size, and type of doors needed to complete the
building shown in Figure 10-10.

2. Using the door schedule in Figure 10-13, determine the
number, size, and type of doors needed to complete the
building shown in Figure 10-12.

3. Using the window schedule in Figure 10-14, determine
the number, size, and type of windows needed to com-
plete the building shown in Figure 10-10.

4. Using the window schedule in Figure 10-15, determine
the number, size, and type of windows needed to com-
plete the building shown in Figure 10-12.

5. Determine the square footage of storefront needed to
construct the storefront in Figure 10-16.

6. Determine the square footage of storefront needed to
construct the storefront in Figure 10-17.

FIGURE 10-11 Door Schedule

FIGURE 10-10 Floor Plan
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FIGURE 10-14 Window Schedule FIGURE 10-15 Window Schedule

FIGURE 10-13 Door Schedule

FIGURE 10-12 Floor Plan
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FIGURE 10-16 Storefront Elevation

FIGURE 10-17 Storefront Elevation

7. Determine the metal tubing needed to fabricate the
storefront in Figure 10-16.

8. Determine the glazing needed to fabricate the storefront
in Figure 10-16. The glass in the door and the two pan-
els on either side of the door needs to be tempered glass.
Use nominal dimensions.

9. Determine the metal tubing needed to fabricate the
storefront in Figure 10-17.

10. Determine the glazing needed to fabricate the storefront
in Figure 10-17. No tempered glass is needed. Use nom-
inal dimensions.

11. Determine the glazing needed for the transom and side-
light shown in Figure 10-18. The glass in the two panels
to the side of the door needs to be tempered glass. Use
nominal dimensions.

12. Determine the glazing needed for the transom and side-
light shown in Figure 10-19. The glass needs to be tem-
pered glass. Use nominal dimensions.

13. Using the hardware schedule shown in Figure 10-9, de-
termine the hardware needed for the doors in Figures
10-10 and 10-11.

14. Using the hardware schedule shown in Figure 10-9, de-
termine the hardware needed for the doors in Figures
10-12 and 10-13.

15. Determine the doors needed to complete the Johnson
Residence given in Appendix F.

FIGURE 10-18 Door Elevation



Openings 161

16. Determine the windows needed to complete the
Johnson Residence given in Appendix F.

17. Determine the hardware needed to complete the
Johnson Residence given in Appendix F.

18. Determine the doors and hardware needed to complete
the West Street Video project given in Appendix F.

19. Determine the storefront needed to complete the West
Street Video project given in Appendix F.

REFERENCE
1. International Building Code, International Code Counsel,

2009, Section 2406.FIGURE 10-19 Door Elevation
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In this chapter you will learn how to apply the principles in
Chapter 4 to metal studs, gypsum board, acoustical ceiling tile,
carpet and pad, ceramic tile, sheet vinyl, vinyl composition tile
(VCT), rubber base, and paint. This chapter includes sample
spreadsheets that may be used in the quantity takeoff. It also
includes example takeoffs from the residential garage drawings.

Finishes include interior partition (nonbearing) walls
and the finishes applied to floors, walls, and ceilings.
We begin by looking at metal stud partitions.

METAL STUD PARTITIONS
Nonbearing metal stud partitions consist of light-gage steel
studs set in a C-shaped runner at the top and bottom of the
partition. The studs are fastened to the runner with screws.
The bottom runner is fastened to the floor. The top runner
may be located at the bottom of the floor or roof deck above,
in which case it is fastened to the floor or roof deck, or it may
stop at the ceiling line, in which case the wall must be braced
to the floor or roof deck above. This bracing is done with
metal studs. Unlike wood-framed walls, where the wood
stud must be long enough to run from the top of the bottom
plate to the bottom of the lower top plate, the metal studs
must run from the floor to the top of the wall.

The number of studs needed to construct a metal stud
partition is calculated in the same manner as determining the
number of studs needed to construct a wood wall (see
Chapter 8). Because the partitions are nonbearing, the open-
ings are framed differently. Instead of a king stud and a jack
stud on either side of an opening, two king studs are placed
on either side of the opening and a piece of runner is screwed
between the king studs to act as the header. Each door open-
ing requires a piece of runner 6 inches longer than the width
of the opening. When installing wood-framed doors in metal
stud partitions, one of the king studs is replaced with a wood

stud or fire-treated wood stud to provide backing for the in-
stallation of the door frame. The quantity takeoff for a metal
stud partition is shown in the following example.

EXAMPLE 11-1

Determine the number of metal studs and feet of runner needed to
construct 125 feet of interior wall with four corners, six intersec-
tions, six walls without corners, and six 3-foot-wide doorways. Stud
spacing is 16 inches on center. Allow two extra studs for each cor-
ner, doorway, or intersection and one extra stud for each wall with-
out corners. How many pieces of runner are needed if the runner
comes in 10-foot lengths and is lapped 2 inches?

Solution: The number of studs needed for the standard spacing is
calculated using Eq. (4-2) as follows:

Six interior walls lack corners at both ends; therefore, six additional
studs are needed for these walls. There are four corners, six doorways,
and six intersections that will require 2 additional studs each, for
32 additional studs. The total number of studs is 132 (94 � 6 � 32).

Determine the number of pieces of runner using Eq. (4-6) as
follows:

For the door openings, six 3-foot 6-inch-long pieces of runner are
needed above the doors. Only 2 of these pieces can be cut from one
piece of runner; therefore, 3 additional pieces of runner are needed,
for a total of 29 pieces. �

GYPSUM BOARD
Gypsum board (drywall) consists of the gypsum board,
metal or plastic trim, fasteners, tape, and drywall compound
(mud). Gypsum board comes in different thicknesses with

being the most common sizes. The width1>2!and!5>8!inches

Number �
(125!ft � 125!ft)

(10!ft � 2!in)
� 26

Number �
(125!ft)(12!in/ft)

16!in
� 94!each

FINISHES

CHAPTER ELEVEN
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FIGURE 11-1 Wall Layout

of the sheets is 4 feet, and the length of the sheets varies from
8 to 16 feet. Gypsum board comes in three common types:
standard, Type-X (fire rated), and water resistant. Type-X is
used to create fire-rated partitions and ceilings, and their lo-
cation is identified on the plan. Water-resistant gypsum
board, which can be identified by its green color, is required
in wet locations. It is not uncommon for water-resistant
gypsum board to be used in entire bathrooms, laundry
rooms, and other rooms subject to continuous moisture.
Gypsum board is bid as a sheet good using the same proce-
dures as when bidding sheathing.

Trim includes corner molding on the outside corners
and J-molding on exposed ends of gypsum board. Trim is
bid by the linear foot or piece. Fasteners, tape, and drywall
compound are quantity-from-quantity goods and are bid
based on historical data or data from the manufacturer. The
quantity takeoff for gypsum board is shown in the following
example.

EXAMPLE 11-2

Determine the number of sheets of gypsum board, the number of
pieces of trim, the pounds of screws, boxes of joint compound, and
rolls of tape needed for the rooms in Figure 11-1. The ceiling height
is 8 feet, and the ceiling joists run north to south. The gypsum
board on the walls is to be run with the long direction of the board
running horizontal. The gypsum board may be ordered in 8-, 10-,
12-, 14-, or 16-foot-long sheets. The trim is available in 10-foot
lengths. Historical data indicates that 1.1 pounds of screws, 0.4 box
of joint compound, and 0.13 roll of tape are needed for 100 square
feet of drywall. The doors are 30 inches wide.

Solution: The gypsum board on the ceiling of the main room will
be run with the longest direction running east and west. Use one

14-foot-long and one 12-foot-long sheet for the columns for a total
length of 26 feet. The number of rows is determined by Eq. (4-13)
as follows:

Order two 12-foot-long sheets and three 14-foot-long sheets for
the ceiling. The gypsum board on the ceiling of the bedrooms will
be run with the long direction running east and west, perpendicu-
lar to the ceiling joists. Use one 12-foot-long sheet for the columns
in the bedrooms. The number of rows is determined by Eq. (4-13)
as follows:

Order three 12-foot-long sheets for each bedroom. In addition, one
8-foot-long sheet is needed for each closet.

The drywall on the walls will need to be two rows high. For
the top row of drywall for the north and south walls of the main
room, a 14-foot-long sheet and a 12-foot-long sheet are needed
for each wall. The bottom row of the north wall does not need to
run through the door; therefore, one 10-foot-long sheet and one
12-foot-long sheet are needed. For the bottom row of the south
wall, two 10-foot-long sheets are needed. Two 10-foot-long sheets
are needed for the east wall and two for the west wall. The walls of
each bedroom will require six 12-foot-long sheets and two 8-foot-
long sheets. The 8-foot-long sheets will be used for the bottom
row of the two walls with doors. Two 8-foot-long sheets will cover
the east and north walls of the closet, and two additional 8-foot-
long sheets will cover the south and west walls of the closet. Order
the following sheets of gypsum board: fourteen 8-foot-long,
seven 10-foot-long, twenty-five 12-foot-long, and five 14-foot-
long sheets.

A 4-foot piece of J-molding is needed above each closet
door. Four 7-foot-long pieces (sides) and one 4-foot-long piece

NumberRows �
(11 ft!5!in)

4!ft
� 3!rows

NumberRows �
9!ft!8!in

4!ft
� 2.5!rows
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(above) of corner are needed for each closet door opening. Order
one 10-foot-long piece of J-molding and nine 10-foot-long
pieces of corner molding.

To calculate the pounds of nails, boxes of joint compound,
and rolls of tape, one needs the area of gypsum board needed for
the ceiling and walls. The area of the ceiling is the length times the
width and is calculated as follows:

The area of the walls is their perimeter times their height and
is calculated as follows:

� 2(10!ft!10!in) � 2(11!ft 5!in) � 2(10!ft!10!in)

Area � [2(24!ft!4!in) � 2(9!ft!8!in) � 2(11!ft!5!in)

� 506!ft2

� (5 ft!6!in)(2!ft!1!in)

� (11 ft!5!in)(10!ft!10!in) � (5!ft!7!in)(2!ft!1!in)

� (24!ft!4!in)(9!ft!8!in) � (11!ft!5!in)(10!ft!10!in)

Area � (Length)(Width)

The total area is 2,006 square feet (506 ft2 � 1,500 ft2). The number
of pounds of screws needed is calculated using Eq. (4-21) as follows:

The number of boxes of joint compound needed is calculated using
Eq. (4-21) as follows:

The number of rolls of tape needed is calculated using Eq. (4-21) as
follows:

�Number � (2,006!ft2)a0.13!roll

100!ft2 b � 3!rolls

Number � (2,006!ft2)a0.4!box

100!ft2 b � 8!boxes

Number � (2,006!ft2)a 1.1!lb

100!ft2b � 22.1!lb

� 1,500!ft2

� 2(2!ft!1!in)](8!ft)

� 2(5!ft!7!in) � 2(2!ft!1!in) � 2(5!ft!6!in)

Cell Formula

B9 =(B2+B3/12)*(B4+B5/12)

B10 =(2*(B2+B3/12)+2*(B4+B5/12))*

(B6+B7/12)

B13 =B9+D9+F9+H9+J9

B14 =B10+D10+F10+H10+J10

EXCEL QUICK TIP 11-1

Drywall

The calculation of the square footage of drywall needed for a rectangular room is set up in a spreadsheet by entering the
data and formatting the cells as follows:

A B C D E F G H I J K
1
2 Room Length 24 ft 11 ft 11 ft 5 ft 5 ft
3 4 in 5 in 5 in 7 in 6 in
4 Room Width 9 ft 10 ft 10 ft 2 ft 2 ft
5 8 in 10 in 10 in 1 in 1 in
6 Room Height 8 ft 8 ft 8 ft 8 ft 8 ft
7 - in - in - in - in - in
8
9 Ceiling Area 235 sft 124 sft 124 sft 12 sft 11 sft

10 Wall Area 544 sft 356 sft 356 sft 123 sft 121 sft
11
12 Totals
13 Ceiling Area 506 sft
14 Wall Area 1,500 sft

Room 5Room 1 Room 2 Room 3 Room 4

The following formulas need to be entered into the associ-
ated cells:

The formulas in Cells B9 and B10 need to be copied to
Cells D9 and D10, F9 and F10, H9 and H10, and J9 and J10.
The data for the room is entered in Cells B2 through B7,
D2 through D7, F2 through F7, H2 through H7, and J2
through J7. The data shown in the foregoing figure is from
Example 11-1 and is formatted using the comma style,
which replaces zeros with dashes.

TILE
Tile comes in a variety of sizes. The number of tiles needed is
estimated using the row and column method. If backing board,
such as Hardibacker, is required it is estimated using the same

procedures used to estimate sheathing (see Chapter 8).
Thickset mortar, thinset glue, and grout are quantity-from-
quantity goods and are bid based on historical data or the es-
timated coverage rate provided by the manufacturer. When
estimating the materials needed for tile, the estimator must
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take into account any layout requirements set by the archi-
tect, such as a minimum size of tile. Tile estimating is shown
in the following example.

EXAMPLE 11-3

Determine the number of by tiles needed to
tile a 30-inch by 48-inch entry. The tile is to have grout
joints. Where possible the tiles should be centered in the space with
at least one-half of a tile at the edge of the space.

Solution: The number of rows is calculated using Eq. (4-14) as
follows:

The number of columns is calculated using Eq. (4-17) as follows:

The total number of tiles is calculated using Eq. (4-18) as follows:

The entry is laid out as shown in Figure 11-2 with the minimum
size of tile being about 7 inches wide. �

Number � (4!rows)(6!columns) � 24!each

Number �
48!in

(7.75!in � 0.25!in)
� 6!columns

Number �
30!in

(7.75!in � 0.25!in)
� 4!rows

1>4-inch
7!3>4-inch7!3>4-inch

SUSPENDED ACOUSTICAL
CEILINGS
Suspended acoustical ceilings consist of ceiling tiles sus-
pended in a metal grid. The metal grid consists of wall
moldings, main tees, 4-foot cross tees, and 2-foot cross
tees. The ceiling grid is suspended from the structure by
wire. Wall molding is required around the entire perimeter
of the room, and the main tees are run at 4 feet on center
throughout the room. The main tees have a connection on
both ends that allow them to be connected end to end to
form continuous tees long enough to span the room.
Four-foot cross tees are run between the main tees and be-
tween the main tees and the walls. The 4-foot cross tees are
run perpendicular to the main runners such that a 4-foot
by 2-foot grid is created. To achieve a 2-foot by 2-foot
grid, 2-foot cross tees are run between the 4-foot cross
tees. Two-foot cross tees can also be used between the
main runners and the walls. Each end of a cross tee has a
connection that allows it to be connected to a main or
cross tee. When using leftover pieces of tees, one must
make sure the piece has the connection needed to connect
to the main and cross tees. At the edge of the ceiling, the
main and cross tees are cut to length and riveted to the
wall molding.

Suspended acoustical ceilings often are bid by the
square foot; however, this does not provide the necessary
information to order the correct materials for the ceiling.
The tiles in the acoustical ceiling are bid based on the row
and column method deducting any tiles that are being re-
placed by lighting fixtures, diffusers, registers, and grilles.
The wall moldings and main tees are bid as linear compo-
nents. The cross tees are bid as a counted item. When esti-
mating the materials needed for an acoustical ceiling, the
estimator must take into account any layout requirements
set by the architect, such as a minimum size of tile. When
dealing with odd-shaped rooms, often the easiest way to
determine the components needed for the grid is to pre-
pare a layout for the room. The estimate of materials
needed for an acoustical ceiling is shown in the following
example.

FIGURE 11-2 Tile Layout

EXCEL QUICK TIP 11-2

Ceramic Tile

The calculation of the number of ceramic tiles needed for
a rectangular room is set up in a spreadsheet by entering
the data and formatting the cells as follows:

The following formula needs to be entered into Cell C8.

=ROUNDUP((B3*12+B4)/(B5+B6),0)*

ROUNDUP((B1*12+B2)/(B5+B6),0)

The data for the room and tile is entered in Cells B1
through B6. Both the row and the column are rounded
up to the next full tile to ensure that at least a 1/2 of tile is
located around the perimeter of the room. The data
shown in the foregoing figure is from Example 11-3 and
is formatted using the comma style, which replaces zeros
with dashes.

A B C
1 Length - ft
2 48 in
3 Width - ft
4 30 in
5 Tile Size 7.75 in
6 Joint Width 0.25 in
7
8 Tiles 24 ea
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EXAMPLE 11-4

A 13-foot-wide by 15-foot-long ceiling is to receive a 2-foot by
2-foot acoustical ceiling. The ceiling includes four 2-foot by 2-foot
fluorescent light fixtures and one 2-foot by 2-foot mechanical regis-
ter. Determine the number of 12-foot-long wall moldings, 12-foot-
long main runners, 4-foot cross tees, 2-foot cross tees, and 2-foot by
2-foot tiles needed for the ceiling. The tiles should be centered in the
room, and, where possible, there should be at least half a tile at the
edge of the room.

Solution: Use the row and column method to calculate the number
of tiles. The number of rows is calculated using Eq. (4-13) as follows:

To center the rows, the following widths of rows are needed (from bot-
tom to top): one at 18 inches, five at 24 inches, and one at 18 inches.
The number of columns is calculated using Eq. (4-16) as follows:

To center the columns, the following widths of columns are
needed (from left to right): one at 18 inches, six at 24 inches, and
one at 18 inches. The total number of squares in the grid is calcu-
lated using Eq. (4-18) as follows:

Five of these squares are filled with light fixtures and a mechanical
register; therefore, 51 (56 – 5) tiles are needed.

The number of wall moldings can be calculated using Eq. (4-7)
as follows:

The main tees will be run in the long direction. A 15-foot-long
main tee is needed between every two rows of tiles. The main tees

Number �
(13!ft � 15!ft � 13!ft � 15!ft)

12!ft
� 5!each

Number � (7!rows)(8!columns) � 56!each

Number �
15!ft

2!ft
� 8!columns

Number �
13!ft

2!ft
� 7!rows

are located between the second and third rows, the fourth and fifth
rows, and the sixth and seventh rows. Three main tees are required
and are 15 feet long. The number of 12-foot-long main tees needed
is calculated as follows:

Ordering four main tees will require the first main tee to be a
12-foot piece and a 3-foot piece, the second main tee to be the
leftover 9-foot piece and a 6-foot piece, and the last main tee to be
the leftover 6-foot piece and a 9-foot piece because only two
pieces can be cut from a 12-foot-long main tee while maintaining
the required end connections. If the ceiling was constructed by
starting each of the main tees with a full-length 12-foot-long
piece, 1 1/2 full-length pieces will be needed for each main tee, for
a total of five 12-foot-long pieces.

The main runners divide the ceiling into four 15-foot-long
rectangles with the following widths: 3.5, 4, 4, and 1.5 feet. These
rectangles are subdivided by cross tees running the width of the
room. For each of the first three rectangles, seven (one less than the
number of tiles required for the length of the rectangle) 4-foot
cross tees are needed, for a total of twenty-one 4-foot cross tees.
Each of these rectangles is further subdivided into 2-foot by 2-foot
or smaller squares using 2-foot cross tees. Eight (the number of tiles
required for the length of the rectangle) 2-foot cross tees are needed
for each of these rectangles, for a total of 24. For the 1.5-foot-wide
rectangle, seven 2-foot cross tees are needed, bringing the total
number of 2-foot cross tees to 31. The layout for the ceiling is
shown in Figure 11-3. �

WOOD AND LAMINATE
FLOORS
Laminate floors, such as Pergo, and many wood floors are not
fastened to the underlying floor but float over it. A gap is left
at all edges of the floor. The gap and the floating nature of the

Number �
(3)(15!ft)

12!ft
� 4!each

FIGURE 11-3 Ceiling Layout
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floor allow the flooring to move, expand, and contract. To
protect the flooring against moisture, a vapor barrier may be
required in certain applications. The flooring comes in
planks and is bid using the row and column method. Because
the flooring is connected using a form of tongue and groove,
waste from one row may only be used when it has the neces-
sary tongue or groove. In addition, the pieces must be stag-
gered, which may also increase the waste.

A sound-deadening underlayment is often used directly
below the flooring. There are different types of underlay-
ment that provide differing levels of cushioning and sound
attenuation. The underlayment is bid as a rolled good.

Trim must be provided at all edges of the flooring to
cover the gap between the floor and the wall. Trim pieces
may include stair nosing for use on stairs; base and shoe
molding to terminate the flooring at walls; end molding to
terminate the flooring where base or shoe molding will not
work, such as around a raised fireplace hearth; T-molding as
a transition between floors of the same height; and reducer
strips as a transition between floors of different heights.
Trim pieces are bid as a counted item or a linear good de-
pending on where it is used.

EXAMPLE 11-5

Determine the number of 7.3-inch by 50.6-inch pieces of laminate
flooring and rolls of underlayment that are needed for a 10-foot by
10-foot floor. The flooring must be staggered at least 24 inches and
comes eight pieces per package. The underlayment comes in rolls 3
feet wide by 50 feet long.

Solution: Determine the number of rolls of underlayment. The
number of rows is calculated using Eq. (4-13) as follows:

The number of columns is calculated using Eq. (4-16) as follows:

The total number of rolls of underlayment is calculated using
Eq. (4-18) as follows:

Determine the required number of pieces of flooring. The number
of rows is calculated using Eq. (4-13) as follows:

The number of rows is rounded to one half of a piece of flooring to
ensure proper staggering. The number of columns is calculated
using Eq. (4-16) as follows:

The total number of pieces of flooring is calculated using Eq. (4-18)
as follows:

Number � (2.5!rows)(17!columns) � 43!each

Number �
(10!ft)(12!in/ft)

7.3!in
� 17!columns

Number �
(10!ft)(12!in/ft)

50.6!in
� 2.5!rows

Number � (4!rows)(0.2!columns) � 1!each

Number �
10!ft

50!ft
� 0.20!columns

Number �
10!ft

3!ft
� 4!rows

The number of packages of flooring is calculated as follows:

�

SHEET VINYL
Sheet vinyl is available in 12-foot widths. Vinyl must be in-
stalled in one direction, and the pattern must be matched.
When the room is wider than 12 feet, the vinyl must be
seamed. This may be done by installing one large piece and
a number of smaller pieces of vinyl as shown in Figure 11-4
or by installing two large pieces as shown in Figure 11-5.
The advantage of installing the vinyl as shown in Figure 11-4
is that less material is required. The advantage of installing
the vinyl as shown in Figure 11-5 is there are fewer seams,
which improves the aesthetics of the installation and the
wear of the vinyl because it wears out at the seams faster
than elsewhere.

To calculate the quantity of vinyl using the seaming plan
in Figure 11-4, one calculates the number of rows of vinyl
using Eq. (4-13). The number of rows is rounded up to the
twelfth, sixth, quarter, third, or half of a row. The number in
the denominator of the fraction of a row represents the
number of smaller pieces of vinyl that are used. For example,
if the fraction of a row is then 12 smaller pieces will be
used. The length of the room is multiplied by the fraction of
a row (or divided by the number of pieces) to determine the
length of vinyl needed for the small pieces. The length of

1>12,

Number �
43!each

(8!each/package)
� 6!packages

FIGURE 11-4 Vinyl Seaming Plan

FIGURE 11-5 Vinyl Seaming Plan



168 CHAPTER ELEVEN

vinyl needed for the large pieces equals the number of large
pieces times the length of the room. To ensure that the pat-
tern matches, the length of the vinyl needs to be rounded up
to whole increments of the pattern. For example, if the pat-
tern in the vinyl repeats every 16 inches, the length would be
rounded up to increments of 16 inches. In Excel, the CEIL-
ING function would be used to round to increments of 16
inches. The calculation of vinyl using this method is shown
in the following example.

EXAMPLE 11-6

How many yards of vinyl need to be ordered for a 13-foot-long by
14-foot 6-inch-wide room? The pattern repeats every 12 inches.

Solution: The number of rows is calculated using Eq. (4-13) as
follows:

Round the number of rows up to 1.25. The additional length
needed for the small pieces is 4 feet ( ). The length of
vinyl needed is 17 feet (13 ft � 4 ft). The number of yards of vinyl is
calculated as follows:

�

To calculate the quantity of vinyl using the seaming
plan in Figure 11-5, one calculates the number of rows of
vinyl using Eq. (4-13) and rounds up to the whole number of
rows. The length of vinyl needed equals the number of rows
times the length of the room. The calculation of vinyl is
shown in the following example.

EXAMPLE 11-7

How many yards of vinyl need to be ordered for a 13-foot-long by
14-foot 6-inch-wide room? The pattern repeats every 12 inches. Lay
the vinyl out to minimize the seams.

Solution: The number of rows needed is calculated using Eq. (4-13)
as follows:

Round the number of rows up to 2. The length of vinyl needed is
26 feet (2 � 13 ft). The number of yards of vinyl is calculated as
follows:

�

VINYL COMPOSITION TILE
Vinyl composition tile (VCT) is available in 12-inch by 12-inch
squares. The number of tiles is estimated in the same manner
as for ceramic tile, with one exception: there is no space be-
tween the tiles, which eliminates the need for grout. The tiles
are glued down and the glue is bid as a quantity-from-quantity

Area � (26!ft)(12!ft)a1!yd2

9!ft2 b � 34.7!yd2

NumberRows �
(14.5!ft)

(12!ft)
� 1.21

Area � (17!ft)(12!ft)a1!yd2

9!ft2 b � 22.7!yd2

13!ft � 1>4

NumberRows �
14.5!ft

12!ft
� 1.21

good. The coverage for a gallon of glue can be obtained from
the manufacturer or from historical data.

RUBBER BASE
Rubber base comes in rolls or pieces and is bid as a linear
good. The rubber base may be bent around corners, or the
architect may require that manufactured corners be used.
Base is bid as a linear good, and manufactured corners are
bid as a counted item.

CARPET AND PAD
Carpet is handled in the same manner as sheet vinyl. In resi-
dential applications, the carpet is laid over a pad. Tackless fas-
tening strips are required around the perimeter of the carpet,
and trim is required anytime the carpet transitions to vinyl.
The pad is bid as a sheet good using the same procedure as in
estimating underlayment (pad) for wood and laminate floors.
The tackless fastening strips and trim are bid as linear goods.

In commercial applications the carpet is glued down.
The glue is bid as a quantity-from-quantity good. The
amount of glue needed for the carpet is based on historical
or manufacturer’s data.

PAINT
Paint is bid based on the square footage for walls, ceilings,
and floors. Trim is bid based on the lineal foot when the trim
is a separate color or a different type of paint than the sur-
rounding area. When the trim is painted with the same paint
as the surrounding area, it is bid as part of the surrounding
area. Doors are bid as counted items. The amount of paint
needed depends on the type of paint being used and the
surface that is being painted. The paint usage is bid as a
quantity-from-quantity good based on historical data or
coverage rates from the manufacturer. Sometimes residential
painters bid painting based on the square footage of floor
space. The bidding of paint is shown in the following example.

EXAMPLE 11-8

How much paint is needed to paint 100 lineal feet of an 8-foot-high
block wall with one coat of primer and two coats of latex paint?
From historical data, 1 gallon of primer will cover 250 square feet of
wall and 1 gallon of latex paint will cover 400 square feet of wall
with a single coat.

Solution: The area of the wall is calculated as follows:

The amount of primer and paint needed is calculated using Eq. (4-20)
as follows:

�VolumePaint �
(2!coats)(800!ft2)

(400!ft2/gal)
� 4!gal

VolumePrimer �
800!ft2

(250!ft2/gal)
� 4!gal

Area � (100!ft)(8!ft) � 800!ft2
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SAMPLE TAKEOFF FOR THE
RESIDENTIAL GARAGE
A sample takeoff for gypsum board and paint from a set of
plans is shown in the following example.

EXAMPLE 11-9

Determine the number of sheets of gypsum board, the number
of pieces of trim, the pounds of screws, boxes of joint com-
pound, rolls of tape, gallons of primer, and gallons of paint
needed for the residential garage given in Appendix F. The gyp-
sum board on the walls is to be run with the long direction of the
board running horizontal. The gypsum board may be ordered in
8-, 10-, 12-, 14-, or 16-foot-long sheets. Historical data indicates
that 1.1 pounds of screws, 0.4 box of joint compound, and 0.13
roll of tape are needed for 100 square feet of drywall. From his-
torical data, 1 gallon of PVA primer will cover 300 square feet of
drywall, 1 gallon of interior latex paint will cover 400 square feet
of drywall with a single coat, 1 gallon of oil base primer will
cover 250 square feet of T1-11 siding, and 1 gallon of exterior
latex paint will cover 375 square feet of siding with a single coat
or four single-hung doors with two coats.

Solution: The gypsum board on the ceiling will be run east-west,
perpendicular to the trusses. Use one 14-foot-long sheet and one
12-foot-long sheet for the columns, for a total length of 26 feet. The
number of rows is determined by Eq. (4-13) as follows:

The drywall on the walls will need to be two rows high. The num-
ber of sheets needed for the north wall is two 14-foot-long sheets
and two 12-foot-long sheets. The number of sheets needed for the
south wall is one 14-foot-long sheet and three 12-foot-long sheets
because the single-hung door will allow us to use two 12-foot-long
sheets on the bottom row. The number of sheets needed for the east
wall is two rows and two columns of 12-foot-long sheets, for a total
of four sheets. For the west wall two 12-foot-long sheets are needed
for the top row, and one 8-foot-long sheet is needed for the bottom
row. Order one 8-foot-long, seventeen 12-foot-long, and nine
14-foot-long sheets.

The area of gypsum board is needed to calculate the
pounds of nails, boxes of joint compound, and rolls of tape. The

NumberRows �
(23!ft!4!in)

4!ft
� 6!rows

area of the ceiling is the length times the width and is calculated
as follows:

The area of the walls is their perimeter times their height less the
openings, and is calculated as follows:

The total area is 1,238 square feet (591 ft2 � 647 ft2). The number of
pounds of screws needed is calculated using Eq. (4-21) as follows:

The number of boxes of joint compound needed is calculated using
Eq. (4-21) as follows:

The number of rolls of tape needed is calculated using Eq. (4-21) as
follows:

Now we will look at the paint. The area of drywall to be painted is
1,238 square feet. The amount of primer and paint needed is calcu-
lated using Eq. (4-20) as follows:

From Example 9-14, the area of T1-11 to be painted is 956 square
feet (792 ft2 � 164 ft2). The amount of primer and paint needed is
calculated using Eq. (4-20) as follows:

One quart is needed for the single-hung door.
The quantities needed for the garage, grouped by the cost

codes in Appendix B, are shown in Table 11-1. �

VolumePaint �
(2!coats)(956!ft2)

(375!ft2/gal)
� 6!gal

VolumePrimer �
956!ft2

(250!ft2/gal)
� 4!gal

VolumePaint �
(2!coats)(1,238!ft2)

(400!ft2/gal)
� 7!gal

VolumePrimer �
1,238!ft2

(300!ft2/gal)
� 5!gal

Number � (1,238!ft2)a0.13!roll

100!ft2 b � 2!rolls

Number � (1,238!ft2)a0.4!box

100!ft2 b � 5!boxes

Number � (1,238!ft2)a 1.1!lb

100!ft2b � 14!lb

� 647!ft2

� (16!ft)(7!ft) � (3!ft)(6!ft!8!in)

Area � [2(25!ft!4!in) � 2(23!ft!4!in)]8

Area � (25!ft!4!in)(23!ft!4!in) � 591!ft2

TABLE 11-1 Quantities for Residential Garage

09-200 Drywall 09-900 Paint

Hang and finish drywall 1238 sft Interior primer 5 gal

4¿ � 8¿ � 1>2– gypsum!board 1 ea Interior latex 7 gal

4¿ � 12¿ � 1>2–!gypsum!board 17 ea Paint drywall with 3 coats 1238 sft

4¿ � 14¿ � 1>2– gypsum board 9 ea Exterior primer 4 gal

1 5>8– screws 14 lbs Exterior latex 6 gal

Joint compound 5 box Paint T1-11 with 3 coats 956 sft

Joint tape 2 rolls Exterior latex 0.25 gal

Paint single-hung door 1 Ea
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CONCLUSION
Finishes include interior partition (nonbearing) walls and the
finishes applied to the floors, walls, and ceilings. Metal stud
walls are bid by using the same procedures as for wood stud
walls. Drywall, tile, acoustical ceiling tile, wood and laminate
floors, vinyl, carpet, pad, and vinyl composition tile are all bid
using the row and column method. Painting is bid by the square
foot or lineal foot. Fasteners, drywall tape and mud, adhesives,
grout, primer, and paint are quantity-from-quantity goods and
are bid based on historical data or data from the manufacturer.

PROBLEMS
1. Determine the number of metal studs needed to con-

struct 83 feet of interior wall with six corners, eight in-
tersections, and four 3-foot-wide doorways. Stud spac-
ing is 16 inches on center. Allow two extra studs for each
corner, intersection, or doorway.

2. How many pieces of runner are needed for Problem 1 if
the runner comes in 10-foot-long lengths and is lapped
2 inches?

3. How many 4-foot-wide by 8-foot-high sheets of drywall
are needed for the wall in Problem 1 if the wall is 8 feet
high and drywall is placed on both sides?

4. Determine the pounds of screws, boxes of joint com-
pound, and rolls of tape needed for the wall in Problem 1.
Historical data indicates that 1.1 pounds of screws, 0.4 box
of joint compound, and 0.13 roll of tape are needed for
100 square feet of drywall.

5. Determine the number of metal studs needed to con-
struct the walls for the tenant finish in Figure 11-6. The
studs for the perimeter walls are already in place, but dry-
wall has not been installed on the walls. Stud spacing is 16
inches on center. Allow two extra studs for each corner or
intersection and four extra studs for each doorway.

6. How many pieces of runner are needed for the walls of
the tenant finish in Figure 11-6 if the runner comes in

10-foot-long lengths and is lapped 2 inches? The
perimeter walls are already in place.

7. How many 4-foot-wide by 9-foot-high sheets of drywall
are needed for the walls of the tenant finish in Figure
11-6 if the walls are 9 feet high? The perimeter walls
need to be drywalled on the tenant’s side only.

8. Determine the number of pieces of trim, the pounds of
screws, boxes of joint compound, and rolls of tape
needed for the walls of the tenant finish in Figure 11-6.
The ceiling height is 9 feet. The trim is available in 10-
foot lengths. Historical data indicates that 1.2 pounds of
screws, 0.45 box of joint compound, and 0.15 roll of
tape are needed for 100 square feet of drywall.

9. Determine the number of by
tiles needed to tile a 10-foot 4-inch by 12-foot floor. The
tile is to have grout joints. Where possible, the
tiles should be centered in the room with at least one-
half of a tile at the edge of the room.

10. Determine the number of by tiles
needed for the floor in Figure 11-7. The tile is to have

grout joints. Where possible, the tiles should
be centered in the room with at least one-half of a tile at
the edge of the room.

11. A 21-foot-wide by 23-foot-long ceiling is to receive a 2-foot
by 2-foot acoustical ceiling. The ceiling includes twelve
4-foot by 2-foot fluorescent light fixtures and five 2-foot
by 2-foot mechanical diffusers. Determine the number of
12-foot-long wall moldings, 12-foot-long main runners,
4-foot cross tees, 2-foot cross tees, and 2-foot by 2-foot
tiles needed for the ceiling. Where possible, the tiles
should be centered in the room with at least one-half of a
tile at the edge of the room.

12. The room in Figure 11-8 is to receive a 2-foot by 2-foot
acoustical ceiling. The ceiling includes five 2-foot by
2-foot fluorescent light fixtures and two 2-foot by 2-foot
mechanical diffusers. Determine the number of 12-foot-
long wall moldings, 12-foot-long main runners, 4-foot
cross tees, 2-foot cross tees, and 2-foot by 2-foot tiles

1>4-inch

7!3>4-inch7!3>4-inch

1>4-inch

11!3>4-inch11!3>4-inch

FIGURE 11-6 Wall Layout
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needed for the ceiling. Where possible, the tiles should
be centered in the room with at least one-half of a tile at
the edge of the room.

13. Determine the number of 7.3-inch by 50.6-inch pieces
of laminate flooring and rolls of underlayment needed
for a 22-foot by 24-foot floor. The flooring must be
staggered at least 24 inches and comes eight pieces per
package. The underlayment comes in rolls 3 feet wide by
50 feet long. Run the long direction of the flooring par-
allel to the short direction of the room.

14. Determine the number of 7.3-inch by 50.6-inch pieces
of laminate flooring and rolls of underlayment needed
for the room in Figure 11-8. The flooring must be stag-
gered at least 24 inches and comes eight pieces per pack-
age. The underlayment comes in rolls 3 feet wide by
50 feet long. Run the long direction of the flooring par-
allel to the short direction of the room.

15. How many yards of vinyl need to be ordered for a 17-foot-
long by 22-foot-wide room?

16. How many yards of vinyl need to be ordered for the
room in Figure 11-8?

17. How many 12-inch by 12-inch vinyl composition tiles
(VCT) need to be ordered for a 17-foot-long by 22-foot-
wide room?

18. How many 12-inch by 12-inch vinyl composition tiles
(VCT) need to be ordered for the room in Figure 11-8?

19. How many feet of rubber base need to be ordered for a
17-foot-long by 22-foot 6-inch-wide room?

20. How many feet of rubber base need to be ordered for
the room in Figure 11-8?

21. How many yards of carpet need to be ordered for a 17-foot-
long by 22-foot-wide room? The carpet is 12 feet wide.

22. How many yards of carpet need to be ordered for the
room in Figure 11-8? The carpet is 12 feet wide.

23. How many rolls of pad need to be ordered for a 17-foot-
long by 22-foot-wide room? The pad comes in rolls 6
feet wide by 50 feet long.

24. How many rolls of pad need to be ordered for the room in
Figure 11-8? The pad comes in rolls 6 feet wide by 50 feet
long.

25. How much paint is needed to paint 75 lineal feet of a
12-foot-high block wall with one coat of primer and two
coats of latex paint? From historical data, 1 gallon of
primer will cover 250 square feet of wall and 1 gallon of
latex paint will cover 400 square feet of wall with a single
coat. Only one side of the wall is painted.

26. How much paint is needed to paint the walls in Figure 11-
8 with one coat of primer and two coats of latex paint? The
ceiling is 8 feet 6 inches high. From historical data, 1 gallon
of primer will cover 300 square feet of wall and 1 gallon of
latex paint will cover 400 square feet of wall with a single
coat. Only one side of the wall is painted.

27. Determine the drywall needed to complete the Johnson
Residence given in Appendix F.

28. Determine the ceramic tile needed to complete the
Johnson Residence given in Appendix F.

29. Determine the laminate flooring and underlayment
(pad) needed to complete the Johnson Residence given
in Appendix F.

30. Determine the carpet and pad needed to complete the
Johnson Residence given in Appendix F.

31. Determine the paint needed to complete the Johnson
Residence given in Appendix F.

32. Determine the metal stud and track needed to complete
the West Street Video project given in Appendix F.

33. Determine the drywall needed to complete the West
Street Video project given in Appendix F.

34. Determine the acoustical ceiling components needed to
complete the West Street Video project given in Appendix F.

35. Determine the ceramic tile needed to complete the West
Street Video project given in Appendix F.

36. Determine the carpet needed to complete the West
Street Video project given in Appendix F.

37. Determine the paint needed to complete the West Street
Video project given in Appendix F.

38. Set up Excel Quick Tip 11-1 in Excel.

39. Set up Excel Quick Tip 11-2 in Excel.

FIGURE 11-7 Bathroom Floor Plan

FIGURE 11-8 Room Layout
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In this chapter you will learn how to apply the principles in
Chapter 4 to fire sprinkler systems.

The design drawings and specifications may provide a
complete fire sprinkler design or they may identify
the requirements that the systems must meet. In the

latter case, the fire sprinkler system is built under a design-
build subcontract, which precludes the general contractor
from identifying and quantifying the components, leaving
the estimator to rely on average square foot pricing or bids
from the subcontractor. When the fire sprinkler system has
been designed, the estimator can identify the components
and provide an accurate bid for the sprinkler system.

Fire sprinkler systems consist of the underground ser-
vice, the valve assembly, fire department connections, the
riser pipe, main lines, branch lines, and the sprinkler heads.
The underground service provides water from the utility’s
pipeline to the building. The portion of the service provided
by the fire sprinkler subcontractor usually stops 5 feet out-
side the building, with the remaining portion of the under-
ground service being provided by the site utility contractor.
A valve assembly (which includes check valves, drain valves,
and a flow alarm) is located where the fire sprinkler system
enters the building. A typical valve assembly for a wet pipe
system is shown in Figure 12-1. The valve assembly allows
the system to be serviced and sets off an alarm when the
water flows.

FIRE SUPPRESSION

CHAPTER TWELVE

FIGURE 12-1 Valve Assembly
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FIGURE 12-2 Main and Branch Lines

FIGURE 12-3 Pipe Hanger

The fire department connection allows the fire depart-
ment to connect their hoses to the fire sprinkler system. In
Figure 12-1, a fire department Siamese connection is pro-
vided as part of the valve assembly. The riser pipe runs verti-
cally through the building delivering water to the different
levels of the building. In addition, valves and drains may be
provided along the riser pipe at each floor, allowing the indi-
vidual floors to be isolated. The main line runs horizontally
through the building supplying water to the branch lines.
The branch lines run horizontally providing water to the in-
dividual sprinkler heads. A layout of a main line and branch
lines is shown in Figure 12-2.

The main and branch lines are supported from the roof
or floor above by pipe hangers. Typically, steel pipe is sup-
ported at 12 feet on center, and pipes 4 inches in diameter
and larger require sway bracing anytime they have a change
in direction greater than 45 degrees. In addition, pipe hang-
ers are required within 1 foot of all changes in direction. A

typical pipe hanger is shown in Figure 12-3. The main and
branch lines are hung so they slope to a drain; therefore, the
pipe hangers will vary in length.

The final components of the fire sprinkler system are the
sprinkler head and the piece of pipe, known as a drop, that
connects the head to the branch line. Like the pipe hanger, the
drop will vary in length to allow the lines to be sloped so the
system can be drained. A typical head is shown in Figure 12-4.

Fire sprinkler systems, where there is sufficient design,
are bid as counted items. Long runs of pipe are bid as a linear
component. The bid of a fire sprinkler is shown in the fol-
lowing example.

EXAMPLE 12-1

Determine the fire sprinkler components needed to complete the
fire sprinkler system shown in Figure 12-2. The drops range from
1 to 2 feet in length.
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TABLE 12-1 Sprinkler System Components

Quantity Item

12 ea Heads with fusible link

12 ea 1 dia. 1- to 2-ft drop�–
12 ea Escutcheon

4 ea 1 elbow–
4 ea 1 1 1 tee�–�–�–
4 ea 1 1>4 1 1 tee–�–�–
1 ea 1 1>4 elbow–
1 ea 2 1 1>4 1 1>4 tee–�–�–
1 ea 2 2 1 1>4 tee–�–�–
1 ea 2 1>2 2 1 1>4 tee–�–�–
8 ea 1 dia. 14-ft pipe�–
4 ea 1 dia. 7-ft pipe�–
1 ea 1 1>4 dia. 8-ft pipe�–
2 ea 2 dia. 8-ft pipe�–
1 ea 2 1>2 dia. 5-ft pipe�–
20 ea Pipe hangers

Solution: There are 12 sprinkler heads, each of which requires a
sprinkler head with a fusible link, an escutcheon, and a 1-inch-
diameter pipe 1 to 2 feet long for the drop. There are four branch
lines. The components for each branch line, from right to left, are as
follows: a 1 elbow, a 14-foot-long 1-inch-diameter pipe, a 1 1
� 1 tee, a 14-foot-long 1-inch-diameter pipe, a 1 1>4 � 1 � 1
tee, and a 7-foot-long 1 1>4-inch-diameter pipe. The components
for a main line, from top to bottom, are as follows: a 1 1>4 elbow,
an 8-foot-long 1 1>4-inch-diameter pipe, a 2 � 1 1>4 � 1 1>4
tee, an 8-foot-long 2-inch-diameter pipe, a 2 � 2 � 1 1>4 tee,
an 8-foot-long 2-inch-diameter pipe, a 2 1>2 � 2 � 1 1>4 tee,
and a 5-foot-long 2 1>2-inch-diameter pipe. The actual lengths of
pipe are slightly shorter to account for the length of the fitting.

Pipe hangers are required every 12 feet. The number of pipe
hangers required for a branch line is calculated using Eq. (4-1) as
follows:

Number �
(7!ft � 14!ft � 14!ft)˛

12!ft
� 1 � 4

–––
–––
–––

–

––––
–�––

The number of pipe hangers required for the main line is calculated
using Eq. (4-1) as follows:

A total of 20 hangers (4 ea/branch � 4 branches � 4 ea for the
main line) are required. The components for the sprinkler system
are shown in Table 12-1. �

Number �
(8!ft � 8!ft � 8!ft � 5!ft)

12!ft
� 1 � 4

FIGURE 12-4 Sprinkler Head

CONCLUSION
A typical fire sprinkler system consists of the underground
service, the valve assembly, the fire department connections,
the riser pipe, main lines, branch lines, and the sprinkler
heads. The pipes are supported by pipe hangers. Fire sprin-
kler systems are bid as a counted item. Long runs of pipe are
bid as a linear component.

PROBLEMS
1. Determine the components needed to complete the fire

sprinkler system shown in Figure 12-5. The drops range
from 1 to 2 feet in length.

2. Determine the components needed to complete the fire
sprinkler system shown in Figure 12-6. The drops range
from 2 to 3 feet in length.

3. Determine the components needed to complete the fire
sprinkler system for the West Street Video project given
in Appendix F.
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FIGURE 12-5 Fire Sprinkler Layout

FIGURE 12-6 Fire Sprinkler Layout
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In this chapter you will learn how to apply the principles in
Chapter 4 to plumbing systems. Whole books have been written
on estimating plumbing; therefore, this chapter will limit its
scope to the basics of estimating plumbing.

Plumbing systems consist of the water supply, the fix-
tures and equipment, and the drain-waste-and-vent
(DWV) piping. Most plumbing is bid as a counted

item. Long runs of pipe are bid as a linear good. We begin by
looking at the water supply.

WATER SUPPLY
The water supply provides potable water to the plumbing
fixtures and equipment. A pressure-reducing valve (PRV)
and shutoff valve are required at the point where the water
supply enters the building. The water is supplied to the vari-
ous plumbing fixtures and equipment by copper or plastic
(Pex or CPVC) pipes of varying sizes. For fixtures that use
both hot and cold water, a cold water pipe must be run from
the water supply and a hot water pipe must be run from the
water heater. Copper pipe is connected with copper fittings
that are sweated (soldered) to the pipe. Pex is coupled with
compression fittings, and CPVC is coupled with CPVC fit-
tings solvent welded to the pipe. Water lines are bid using the
same procedure as for fire sprinkler systems. New water sys-
tems must be capped at the fixture to allow the system to be
pressure tested. Stub-out fittings for fixtures come pre-
capped. The bidding of water supply is shown in the follow-
ing example.

EXAMPLE 13-1

Determine the water line components needed to complete the cop-
per water supply for the bathroom shown in Figures 13-1 and 13-2.

Solution: We begin with the hot water line. Approximately 19 feet
of 3/4-inch pipe are needed. Beginning with the left side of the
bathroom, the following fittings are needed: four 3>4– � 3>4– �
1>2– tees (one at each lavatory), four 1>2– � 6– stub-out fittings
(one at each lavatory), one 3>4– � 1>2– 90-degree elbow (near the
air chamber), and one 1/2–� 12– air chamber.

For the cold water line, a 1 1>4-inch water line runs to the mid-
dle pair of water closets (approximately 8 feet), a 1-inch water line
runs from the middle pair of water closets to the urinal (approxi-
mately 3 feet), and a 3>4-inch water line runs from the urinal to the
air chamber (approximately 8 feet). Five 1>2-inch risers are needed
for the water closets (allow 18 inches each), and one 1>2-inch riser
is needed for the urinal (allow 30 inches). The pipe needed for the
cold water is 8 feet of 1 1>4-inch, 3 feet of 1-inch, 8 feet of 3>4-inch,
and 10 feet of 1>2-inch pipe. Beginning with the left side of the
bathroom, the following fittings are needed: three 1 1>4– � 1 1>4–
� 1>2– tees (water closets), one 1 1>4– � 1– � 1>2– tee (water
closet), one 1–� 1–� 1>2– tee (water closet), one 1–� 3>4–� 1>2–
tee (urinal), four 3>4– � 3>4– � 1>2– tees (lavatories), one 3>4– �
1>2– 90-degree elbow (near the air chamber), one 1>2– � 12– air
chamber, six 1>2– � 1>2– 90-degree elbows (one per riser), and ten
1>2–� 6– stub-out fittings (one at each fixture). �

DRAIN-WASTE-AND-VENT
SYSTEM
The drain-waste-and-vent (DWV) is used to carry soiled
water from the building and consists of three types of com-
ponents: drain, waste, and vent. The drain piping and waste
piping are used to carry waste water from the building. The
distinction between drain piping and waste piping is that
waste piping includes water with solid waste from water
closets (toilets) and drain piping does not. P-traps are re-
quired at each fixture to prevent sewer gas from leaving the
DWV system and entering the room. This is accomplished
by creating a water barrier in the fixture or DWV system
near the point where the fixture connects to the DWV sys-
tem. For the p-trap to work properly, the DWV system must

PLUMBING

CHAPTER THIRTEEN
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FIGURE 13-1 Water Supply Plan

FIGURE 13-2 Water Supply Isometric

be vented near it. This venting must occur before the top of
the DWV pipe falls below the elevation of the flow line of the
pipe as it leaves the p-trap. If this does not occur, the water
will be siphoned from the p-trap and allow gasses to enter
the building. Figure 13-3 shows the design of the p-trap.

The vent piping must be vented outside the building. A
flashing must be provided for the vent pipe where it leaves
the building. Cleanouts must be provided to allow block-
ages in the drain and waste piping to be cleaned out. The
quantity takeoff for the DWV system is shown in the fol-
lowing example. FIGURE 13-3 P-trap
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FIGURE 13-4 DWV Plan

FIGURE 13-5 DWV Isometric

Solution: The DWV piping will be taken off in three steps: the
main (horizontal) waste, the vertical waste servicing the fixtures,
and the vent. Beginning with the cleanout, the lengths of pipe
needed for the main waste line are as follows: 4 feet of 2-inch
pipe run vertically, 8 feet of 2-inch pipe run horizontally, and
12 feet of 4-inch pipe. The following fittings are needed: one 2–
cleanout plug, one 2– cleanout adapter, two 2– 90-degree elbows,

EXAMPLE 13-2

Determine the DWV components needed to complete the DWV
system for the bathroom shown in Figures 13-4 and 13-5. The hor-
izontal waste piping is 2 feet below the finished floor, the horizontal
vent piping is 9 feet above the finished floor, and the vent termi-
nates 14 feet above the finished floor.
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one 2– sanitary tee, one 4– � 2– bushing, one 4– � 4– � 2– re-
ducing sanitary tee, two 4– � 4– � 3– reducing sanitary tees, one
4– � 4– � 2– reducing sanitary tee, and one 4– � 4– � 3– reduc-
ing sanitary tee.

Each of the pair of lavatory risers will require 4 feet of 2-inch
pipe, one double 2– sanitary tee, two 6-inch-long 2-inch pieces of
pipe, and two male adapters. The risers for the urinal and water
closet require 1 foot of 3-inch pipe, one 3– sanitary tee, 2 feet of
3-inch pipe, a 3– 90-degree elbow, and a 3– toilet flange servicing
the water closet, one 3– � 2– bushing, 3 feet of 2-inch pipe, one 2–
sanitary tee, and one 6-inch-long 2-inch piece of pipe servicing
the urinal. Each of the pairs of water closets will require 1 foot of
3-inch pipe, one 3– double sanitary tee, one 3– � 2– bushing, two
2-foot-long 3-inch pipes, two 3– 90-degree elbows, and two 3– toi-
let flanges. The pair of floor drains will require 1 foot of 2-inch
pipe, one 2– double sanitary tee, two 4-foot-long 2-inch pipes, two
2– p-traps, and two 2– floor drains.

For the vertical venting pipe, beginning at the lavatories, three
7-foot-long 2-inch pipes, one 5-foot-long 3-inch pipe, and three 10-
foot-long 2-inch pipes are needed. Fifteen feet of 2-inch pipe are
needed for the horizontal vent pipe. The following fittings are needed
for the vent pipe: two 2– 90-degree elbows, four 2– tees, one 3– tee,
and two 3–� 2– bushings.

In addition, seven 2– test caps, five 3– test caps, one 3– thermo-
plastic roof flashing, and one decorative cleanout cover are needed.

FIXTURES AND EQUIPMENT
Fixtures are bid as a counted item. When bidding fixtures,
the estimator must include shut-off valves for each fixture at
the water supply, supply lines from the shut-off valve to the
fixture, and a waste line (including the p-trap, if needed)
from the fixtures to the DWV system. A shut-off valve is re-
quired for both the hot and cold water pipes at each fixture.
All of these components are installed as part of the finish
plumbing package. The quantity takeoff for plumbing fix-
tures is shown in the following example.

EXAMPLE 13-3

Determine the fixtures needed for the bathroom in Figures 13-1,
13-2, 13-4, and 13-5.

Solution: The bathroom requires five water closets (toilets), one
urinal, and four lavatories (sinks). Each toilet will require a shut-off
valve and a supply line to connect the water closet to the shut-off
valve. The p-trap is built into the water closet. The urinal will re-
quire a flush valve assembly. Each lavatory will require two shut-off
valves, two supply lines, a faucet with a drain assembly, and a 1 1>2–
p-trap. �

CONCLUSION
Plumbing consists of the water supply lines, the drain-waste-
vent (DWV) lines, and the fixtures. Plumbing components,
pipe, fittings, and fixtures, are bid as counted items. Long
runs of pipe are bid as a linear good.

PROBLEMS
1. Determine the water line components needed to com-

plete the water supply for the bathroom shown in
Figures 13-6 and 13-7.

2. Determine the DWV components needed to complete
the DWV system for the bathroom shown in Figures 13-8
and 13-9. The horizontal waste piping is 2 feet below the
finished floor, the horizontal vent piping is 9 feet above
the finished floor, and the vent terminates 14 feet above
the finished floor.

3. Determine the plumbing components needed to com-
plete the Johnson Residence given in Appendix F.

4. Determine the plumbing components needed to com-
plete the West Street Video project given in Appendix F.

FIGURE 13-6 Water Supply Plan
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FIGURE 13-9 DWV Isometric

FIGURE 13-7 Water Supply Isometric

FIGURE 13-8 DWV Plan



In this chapter you will learn how to apply the principles in
Chapter 4 to HVAC systems. Whole books have been written on
estimating HVAC systems; therefore, this chapter will limit its
scope to the basics of estimating HVAC.

Heating, ventilation, and air-conditioning (HVAC)
systems consist of equipment, ductwork, and pip-
ing used to heat and ventilate buildings and to con-

dition (cool and dry) the air. Many components are bid as a
counted item, including short runs of duct and pipe. Longer
runs of duct and pipe are bid as a linear good. Residential
and commercial HVAC systems are discussed separately.
Let’s begin with two common residential systems.

RESIDENTIAL HVAC SYSTEMS
Central heating and air-conditioning, the most common
residential HVAC system, consists of a forced air furnace
supplying heated air through metal ductwork located under
the floor or above the ceiling. The supply duct, the duct that
provides heated air, may consist of a main trunk line of rec-
tangular duct running almost the entire length of the build-
ing with individual supply lines running from the trunk line
to the registers (vents) in the individual rooms. Figures 14-1
and 14-2 show a heating system with a main trunk line.
When the supply duct is run in the attic or crawl space, the
trunk line may be eliminated by running the supply lines
from the furnace to the individual rooms. For bathrooms
and kitchens, the supply line may be run into the bottom of
a base cabinet, and a register is placed in the base cabinet to
supply the kitchen or bathroom with air, thereby using the
bottom of the cabinet as part of the supply line as shown in
Figure 14-3. The return air duct, which returns the air from
the rooms to the furnace, usually draws air from the hallways
and uses the natural space between framing members (joists
and studs) as well as metal duct to transport the air as shown

in Figure 14-4. Gas- and oil-fired furnaces must be vented to
the outside to allow combustion gases to escape. The furnace
may be equipped with a split air-conditioning unit consist-
ing of a coil in the ductwork leaving the furnace and a con-
denser located outside the building. The coil is connected to
the condenser using two flexible copper pipes known as a
line set. Central heating may also include humidifying or de-
humidifying equipment and air filtration equipment.

The takeoff of a residential central HVAC system is
shown in the following example.

EXAMPLE 14-1

Determine the HVAC components needed for the residence in
Figures 14-1 and 14-2. The furnace includes an air conditioner. A
2–� 12– register is required at each of the base cabinets and a 6–�
18– grille is needed at the beginning of each return air. The distance
from the top of the furnace to the roof is 20 feet. The vent pipe is
4 inches in diameter.

Solution: The equipment needed is a furnace, an air-conditioning
coil, and an air-conditioning compressor. A plenum is needed be-
tween the furnace and the supply trunk line. For the supply trunk
line, 16 feet of 8– � 12– rectangular duct, two 8– � 12– to 8– � 8–
transitions, 17 feet of 8– � 8– square duct, and two 8– � 8– end
caps are needed. For the individual supply lines, the following items
are needed: nine 6-inch 90-degree elbows to connect to the trunk
line, 90 feet (17 ft � 17 ft � 2 ft � 19 ft � 19 ft � 4 ft � 3 ft � 3 ft
�6 ft) of 6-inch-diameter duct, three 6-inch 90-degree elbows to
connect to the base cabinets, three 2– � 12– registers, six 4– � 12–
boots, and six 4–� 12– registers.

The following items are needed for the return air: two 6– �
18– grilles, 15 feet (1 ft � 4 ft � 1 ft � 1 ft � 7 ft � 1 ft) of 18-inch-
wide sheet metal to create return air chases between the joists, two
8–� 12– end caps, 12 feet of 8–� 12– duct, and 8 feet of 12–� 18–
duct to run from the trunk line to the bottom of the furnace.

The venting needs to run from the furnace to a point at least
2 feet above the roof, and 4 feet of pipe is allowed to enter the chase.
The pipe in the chase will need to be double walled. For the venting,
the following items are needed: two 4-inch 90-degree single-wall
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FIGURE 14-1 Plan View of Residential System

FIGURE 14-2 Isometric View of a Residential System

FIGURE 14-3 Supply Air in a Base Cabinet FIGURE 14-4 Return Air Using Framing Members
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elbows, 4 feet of 4-inch-diameter single-wall pipe, 22 feet of 4-inch-
diameter double-wall pipe, one 4-inch roof flashing, and one
4-inch termination cap.

Other items needed for the furnace include one box of line set
to connect the condenser to the coil, one thermostat, and one roll of
low-voltage wiring. In addition, the electrician will need to provide
power and a switch at the furnace, and a gas line will need to be
provided from the gas source. �

Another type of residential heating is radiant heating.
Radiant heating uses hot water circulating in flexible plastic
tubing located in the floor to warm the floor, which in turn

warms the living space. A typical tubing layout for a room is
shown in Figure 14-5. This tubing is often embedded in con-
crete or gypcrete. In snowy climates, radiant heat located in
driveways and sidewalks may be used to melt snow on these
surfaces. The water used by radiant heat is heated by a boiler
and is recirculated by a pump. Like furnaces, gas- and oil-
fired boilers must be vented. To prevent damage to the sys-
tem, an expansion tank and an air ejector are located on the
supply side of the boiler. A supply manifold with valves and
return manifold allow the boiler to provide water for multi-
ple heating circuits. The temperature of each circuit may be

FIGURE 14-5 Radiant Heating Pipe Layout

FIGURE 14-6 Equipment for Radiant Heating
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FIGURE 14-7 Pipe Spacing for Example 14-2

individually controlled. The equipment for a typical radiant
heating system is shown in Figure 14-6. Radiant heating sys-
tems cannot be used to cool the space; therefore, a separate
cooling system must be included if cooling is required.

The takeoff of a radiant heating system uses the same
principles as that for plumbing and is shown in the following
examples.

EXAMPLE 14-2

Determine the piping needed for a radiant heating system for a
10-foot by 10-foot room. The pipe spacing is shown in Figure 14-7.
Allow 40 feet of pipe to connect the pipe in the room to the boiler.

Solution: The radius on the bends will be one-half of the pipe
spacing, or 6 (12>2) inches. The pipe along the south wall will begin
its turn 1 foot from the wall, which equals the distance of the west
pipe from the west wall (6 inches) plus the radius of the turn
(6 inches). Nine feet of pipe will be needed for this pipe.

The pipe along the west wall will begin 1 foot from the south
wall and will begin its turn 9 inches from the north wall. Eight feet
3 inches (8.25 ft) of pipe will be needed for this pipe.

The remaining pipes running north-south will begin their turn
18 inches from the south wall and will begin their turn 9 inches from
the north wall. Each of these pipes will require 7 feet 9 inches (7.75 ft)
of pipe. The distance from the pipe along the west wall to the pipe
along the east wall is 9 feet (10 feet - 6 inches - 6 inches). Because we
have already accounted for the pipe at the west end, we will use
Eq. (4-2) to determine the number of pipes as follows:

The number of pipes running north-south must be an even
number for the supply and return to enter the room at the same
point. We have 10 pipes (9 � 1).

Number �
!9!ft

1!ft
� 9

The length of pipe needed for a 180-degree turn is 1.6 feet
Nine 180-degree turns are needed. The length of pipe

needed for a 90-degree turn is 0.8 feet Two 90-degree
turns are needed. The total length of pipe (including the 40 feet
needed to connect to the boiler) is calculated as follows:

�

EXAMPLE 14-3

Determine the HVAC equipment needed for a radiant heat system
for a residence with six heating circuits.

Solution: The following equipment is needed: one boiler, one ex-
pansion tank, one air ejector, one pump, two manifolds with six
outlets, and six valves. �

Other types of heating and cooling used in residences in-
clude through-the-wall heat pumps, heat pumps that include
ductwork, electric baseboard heaters, and swamp coolers.

In addition to heating and cooling equipment, resi-
dences may include gas fireplaces, gas piping, exhaust fans,
and temperature controls. Gas piping is bid using the proce-
dures used to bid pipe in Chapters 12 and 13.

COMMERCIAL HVAC
SYSTEMS
Small commercial buildings (such as buildings in strip malls)
and churches, often use HVAC systems similar to that of the
residential system shown in Figures 14-1 and 14-2, using
multiple units as the building gets larger. Larger single-story
buildings often use a roof-top unit (sometimes referred to as

Length � 143!ft

Length � 9!ft � 8.25!ft � 9(7.75!ft) � 9(1.6!ft) � 2(0.8!ft) � 40!ft

(� � 0.5!ft>2).
(� � 0.5!ft).
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a package unit) that heats or cools the air and then distributes
it through the building using ductwork. A package unit is
similar to a central heating and air-conditioning system,
except that it combines the heating and air-conditioning
equipment into a single unit. As buildings get taller it be-
comes impractical to use ductwork for all of the air require-
ments because the duct would take up an enormous amount
of space. In these cases, the heating and cooling is accom-
plished by heating or cooling water at a central point, distrib-
uting the water to the point where heating and cooling is
needed, transferring heat from the water to air (or air to the
water when cooling is needed) by use of a heat exchanger,
and, finally, distributing the air to the needed areas, often by
blowing the air through ductwork using a fan. An air handler
combines a heat exchanger and fan to perform this function.
In each of these cases, the heating and cooling equipment and
ductwork are bid using the same procedure as for a residen-
tial system, and the water piping is bid using the procedures
in Chapter 13. Often a commercial HVAC system uses the
plenum, the space between a dropped ceiling and the roof or
floor above, as the return air pathway. When this is done, re-
turn-air grilles are provided in the ceiling. Commercial sys-
tems may include a wide variety of equipment including
chillers, boilers, dampers, fans, and variable-air-volume
(VAV) boxes. The takeoff of a commercial HVAC system is
shown in the following example.

EXAMPLE 14-4

Determine the HVAC components needed for the commercial ten-
ant finish shown in Figure 14-8. Two feet of 6-inch-diameter flexi-
ble duct is used to connect the diffuser to the ductwork. The
plenum is used for return air. The existing supply and return lines
are made of copper.

Solution: The HVAC system requires one air handler and two
VAV boxes. Beginning with the air handler, the following duct is
needed: 6 feet of 12-inch-diameter duct with one 45-degree, 8-inch-
diameter boot attached; one 45-degree, 8-inch-diameter elbow;
9 feet of 8-inch-diameter duct with one 6-inch-diameter boot at-
tached; one 8-inch-diameter to 6-inch-diamter reducer; 11 feet of
6-inch-diameter duct; one 90-degree, 6-inch-diameter elbow; one
12-inch-diameter to 10-inch-diameter reducer; 6 feet of 10-inch-
diameter duct; one 90-degree, 10-inch-diameter elbow; 6 feet of
10-inch-diameter duct with a 6-inch-diameter boot attached; one
10-inch-diameter to 8-inch-diameter reducer; 10 feet of 8-inch-
diameter duct with a 6-inch-diameter boot attached; one 8-inch-
diameter to 6-inch-diameter reducer; 6 feet of 6-inch-diameter
duct; one 90-degree, 6-inch-diameter elbow; five 2-foot-long 6-inch-
diameter flexible duct with two clamps each; and five diffusers. In
addition, two thermostats with wiring are needed. The calculation
of wiring is covered in Chapter 15. To connect the air handler to the
supply and return lines two 2– � 2– � 1– copper tees and two
4-foot-long pieces of copper pipe are needed. �

Many commercial buildings use fin-tube convectors
along the exterior walls of the building below the windows to
assist in heating the building. The fin-tube convector uses a
fin-tube to transfer heat from a pipe carrying hot water to
the surrounding air. Convection, the rising of hot air and the
falling of cool air, is used to move air past the fin-tube con-
vector. A fin-tube convector is shown in Figure 14-9.

The takeoff of for fin-tube convectors uses the same
principles as those for plumbing and is shown in the follow-
ing example.

EXAMPLE 14-5

Determine the HVAC components needed for the fin-tube convec-
tors shown in Figure 14-10. The supply lines are run into the bot-
tom of the fin-tube convectors from the floor below.

FIGURE 14-8 HVAC for Example 14-4
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CONCLUSION
Heating, ventilation, and air-conditioning (HVAC) systems
consist of equipment, ductwork, and piping used to heat and
ventilate buildings and to condition (cool and dry) the air.
Many components are bid as a counted item, including short
runs of duct and pipe. Longer runs of duct and pipe are bid
as a linear good.

PROBLEMS
1. Determine the HVAC components needed for the resi-

dence in Figure 14-11. The furnace includes an air condi-
tioner. A 2– � 12– register is required at each of the base
cabinets and a 6–� 18– grille is needed at the beginning of
each return air. The distance from the top of the furnace to
the roof is 22 feet. The vent pipe is 4 inches in diameter.

FIGURE 14-9 Fin-Tube Convector

FIGURE 14-10 HVAC for Example 14-5

Solution: The supply line (beginning at the exiting line) requires
one 2– � 2– � 1– copper tee, one piece of 1-inch-diameter pipe
approximately 26 feet long to connect (from supply to interior
wall), one 1– 90-degree elbow, one piece of 1-inch-diameter pipe
1 foot long, one 1– � 1– � 1– copper tee, one piece of 1-inch-
diameter pipe 11 feet long, one 1– � 1– � 1– copper tee, one piece
of 1-inch-diameter pipe 11 feet long, one 90-degree elbow, and
three pieces of 1-inch-diameter pipe 2 feet long to connect the fin-
tube convectors to the tees and elbow.

The return line (beginning at the exiting line) requires one
2– � 2– � 1– copper tee, one piece of 1-inch-diameter pipe ap-
proximately 26 feet long to connect (from supply to interior wall),
one 1– 90-degree elbow, one piece of 1-inch-diameter pipe 11 feet
long, one 1– � 1– � 1– copper tee, one piece of 1-inch-diameter
pipe 11 feet long, one 1–� 1–� 1– copper tee, one piece of 1– pipe
11 feet long, one 90-degree elbow, and three pieces of 1-inch-diameter
pipe 2 feet long to connect the fin-tube convectors to the tees and
elbow.

Three 10-foot 10-inch-long fin-tube convectors will be
needed. �



2. Determine the piping needed for a radiant heating sys-
tem for an 11-foot by 14-foot room. The pipe spacing is
shown in Figure 14-7. Allow 65 feet of pipe to connect
the pipe in the room to the boiler.

3. Determine the HVAC components needed for the com-
mercial tenant finish shown in Figure 14-12. Two feet
of 6-inch-diameter flexible duct is used to connect the
diffuser to the ductwork. The plenum is used for return
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FIGURE 14-11 HVAC for Problem 1

FIGURE 14-12 HAVC for Problem 3



FIGURE 14-13 HVAC for Problem 4

5. Determine the HVAC components needed to complete
the Johnson Residence given in Appendix F. The furnace
includes an air conditioner.

6. Determine the HVAC components needed to complete
the West Street Video project given in Appendix F.
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air. The existing supply and return lines are made of
copper.

4. Determine the HVAC components needed for the fin-
tube convectors shown in Figure 14-13. The supply lines
are run into the bottom of the fin-tube convectors from
the floor below.



In this chapter you will learn how to apply the principles in
Chapter 4 to electrical systems. Whole books have been written
on estimating electrical systems; therefore, this chapter will
limit its scope to the basics of estimating electrical systems. This
chapter includes example takeoffs from the residential garage
drawings.

The electrical system can be divided into two parts:
(1) electrical devices such as light fixtures, outlets,
panels, transformers, starters, motors, motor con-

trols, and so forth and (2) the wiring that connects the de-
vices. Electrical devices are typically bid as counted items;
therefore, estimating the electrical devices is simply a matter
of locating them and counting them up. Estimating the
wiring is more difficult. For the wiring the estimator must
determine the length of wiring and, if included, the conduit
carrying the wire. To simplify the preparation of an estimate,
sometimes the wiring is bid as a quantity-from-quantity
good. Let’s look how to estimate the wiring.

RESIDENTIAL WIRING
The most common wiring used in residential wiring is
Romex, in which two or three conductors and a ground wire
are sheathed in a plastic sheathing. Wiring for duplex outlets
and lights consists of two #12 or #14 wires and a ground,
with three #12 or #14 wires and a ground being run between
three-way switches. Most dryers, ranges, cook tops, air con-
ditioners, and electrical heaters run on 220 volts and require
three conductors and a ground wire. Typically a range or an
oven requires a 40-ampere breaker with #8 copper wires, and
air conditioners and dryers require a 30-ampere breaker
with #10 copper wires. All electrical equipment must be
sized by the required volt-amp rating for the appliance and
per code requirements.

Residential wiring is run horizontally or vertically in the
walls and diagonally through ceiling spaces. When calculat-
ing the needed length of wiring, the estimator must not only
take into account the horizontal distance between electrical
devices, but must take into account the length of wire
needed to run the wire vertically within the walls and make
connections to the electrical devices. Many residential esti-
mators include a standard length of wire for each duplex
outlet, light fixture, and switch rather than determine the
needed length of wire. When this is done, the wiring is being
bid as a quantity-from-quantity good. Estimating the wire
length is shown in the following example.

EXAMPLE 15-1

Determine the number of devices and wiring needed to complete
the lighting shown in Figure 15-1. The light fixtures are to be re-
cessed-can fixtures. The outlet is existing and will be used to supply
the power to the lighting. Use Romex with #12 wires. The ceiling
height is 9 feet.

189

ELECTRICAL

CHAPTER FIFTEEN

FIGURE 15-1 Electrical Plan



190 CHAPTER FIFTEEN

FIGURE 15-2 Distances between Electrical Devices

Solution: The lighting will require four can lights with trim and
light bulbs and two three-way switches with single-gang boxes and
covers. The outlet is already there. The distances between the elec-
trical devices are shown in Figure 15-2. When preparing an esti-
mate, these distances would be taken off using a scale, a plan mea-
surer, or software takeoff package.

The wiring between the right switch and the lights and outlet
is to be two #12 copper wires with a ground. When figuring this
wiring we add 1 foot to each end of the wire to allow the wiring to
be secured to the framing and connected to the electrical device.
The wiring between lights can be run in the ceiling spaces. The
length of wiring between the light fixtures is calculated as follows:

The wiring between the switch and the light will need to run 6 ver-
tical feet in the wall to go from the switch to the ceiling space. The
length of wiring between the switch and the light fixture is 12 feet
(4 ft � 6 ft � 2 ft). The wiring from the outlet to the switch will
need to run 3 feet vertically and 2 feet horizontally. The length of

� (6.33!ft � 2!ft) � 23!ft
Length � (6.33!ft � 2!ft) � (4.33!ft � 2!ft)

wiring between the outlet and the switch is 7 ft (2 ft � 3 ft � 2 ft).
The lighting will require 42 feet (23 ft � 12 ft � 7 ft) of wire with
two #12 wires and a ground. The wiring between switches will re-
quire three #12 copper wires with a ground and must be run
through the wall rising over the door frame or must be run in the
ceiling space. If the wire is run through the ceiling space, it will
need to be run 6 vertical feet in the wall to go from the switch to the
ceiling space at both ends. The lighting will require 25 feet (6 ft �
11 ft � 6 ft � 2 ft) of wire with three #12 copper wires and a
ground. In addition, wire nuts are needed to connect the wires, and
staples are needed to secure the wires to the framing. �

COMMERCIAL WIRING
From an estimator’s point of view, commercial wiring differs
from residential wiring in a number of key ways, including the
following: (1) all commercial wiring must be run in conduit
or raceways (except for low-voltage wiring), (2) the wiring is
usually run parallel to the side of the building or structure
within the ceiling spaces, increasing the length of the wire
needed, (3) the design of the wiring is better defined, (4) com-
mercial wiring is more extensive and services more equip-
ment, and (5) commercial wiring includes multiple electrical
panels. When estimating commercial wiring, the estimator
must include the conduit, boxes, connector between the con-
duit and boxes, electrical devices, and wiring. The conduit
may be ridged or flexible. As is the case with residential wiring,
the estimator must take into account not only the horizontal
distance between electrical devices, but also the length of wire
needed to run the wire vertically within the walls and make
connections to the electrical devices.

Figure 15-3 shows the typical wiring for a fluorescent
light fixture in a dropped acoustical ceiling. To complete this
light fixture, not only do the conduit and wiring need to be
run to the fixture, but at each fixture the following items are
needed: a junction box with a cover, two set-screw/threaded
connectors to connect the ridged conduit to the box, two

FIGURE 15-3 Wiring for a Fluorescent Light Fixture
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FIGURE 15-4 Electrical Plan

set-screw/threaded connectors to connect the flexible conduit,
and a length of flexible conduit whose length will depend on
the difference in elevation between the ridged conduit and the
dropped ceiling. Estimating commercial electrical compo-
nents and wiring is shown in the following examples.

EXAMPLE 15-2

Determine the number of electrical devices, conduit, and wiring
needed to complete the lighting shown in Figure 15-4. The light fix-
tures are to be 120-volt, 4-foot by 2-foot fluorescent light fixtures
with three bulbs. The power will be provided to the light switch on
the left. Use #12 copper wires in a 1>2-inch conduit. The ceiling
height is 9 feet, and the conduit will be run at a height of 12 feet.

Solution: The lighting will require two 120-volt, 4-foot by 2-foot
fluorescent light fixtures, six fluorescent light bulbs, two junction
boxes with covers, and two three-way switches with single-gang
boxes and covers. Two hot wires will need to be run between the
switches, a hot wire will need to be run between the right light
switch and the two light fixtures, a common wire will need to be
run between the two light fixtures and the left light switch, and a
ground wire will need to be run to the switches and fixtures. The
wiring diagram for the lights is shown in Figure 15-5.

Ridged conduit will be run from the switch at one end of the
hall to the switch at the other end of the hall, passing through two
junction boxes. The conduit can be bent in a radius to change direc-
tions. Nine feet of conduit is required at both switches to go from
the switch to the height of 12 feet. Thirty-eight feet of conduit are
needed (9 ft � 20 ft � 9 ft) as well as 6 set-screw/threaded connec-
tors, which are used to connect the ridged conduit to the junction
boxes and single-gang boxes. Two 5-foot lengths of flexible conduit
are needed to run from the junction boxes to the light fixtures and

are used to center the fixtures in the hall. Four set-screw/threaded
connectors are needed to connect the flexible conduit to the junc-
tion boxes and the light fixtures. In addition, fasteners to secure the
conduit in place are needed. The material the conduit is being fas-
tened to will determine the type of fastener used.

Allow for an extra foot of wire on both ends of each wire. Forty
feet (38 ft � 2 ft) of red wire are needed to connect the switches.
Similarly, 40 feet of black wire are needed to connect the switches.
Sixteen feet (9 ft � 5 ft � 2 ft) of black wire are needed to connect the
right switch to the junction box above the right light fixture. Twelve
feet (10 ft � 2 ft) of black wire are needed to connect the junction
boxes together, and 7 feet (5 ft � 2 ft) of black wire are needed at each
light fixture to connect the junction boxes to the light fixtures. A total
of 82 feet (40 ft � 16 ft � 12 ft � 7 ft � 7 ft) of black wire is needed.
For the white wire, 16 feet is needed to connect the left switch to the
junction box above the left light fixture, 12 feet is needed to connect
the junction boxes, and 7 feet is needed at each light fixture to con-
nect the junction boxes to the light fixtures, for a total of 42 feet (16 ft
� 12 ft � 7 ft � 7 ft). For the green ground wire, 16 feet is needed at
each end to connect the switches to the junction boxes, 12 feet is
needed to connect the junction boxes, and 7 feet is needed at each
light fixture to connect the junction boxes to the light fixtures, for a
total of 58 feet (16 ft � 16 ft � 12 ft � 7 ft � 7 ft). �

EXAMPLE 15-3

Determine the electrical components needed to complete the elec-
trical distribution system (excluding wire from the panelboards)
for the schematic shown in Figure 15-6. The distance to the meter is
60 feet through a 3 1>2-inch conduit that includes three 90-degree
elbows. The wireway is 5 feet long, and the three panels are
mounted 1 foot above the wireway. The panelboard schedules are
shown in Figures 15-7 through 15-9.

FIGURE 15-5 Wiring Diagram
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Solution: Beginning at the meter, 60 feet of 3 1>2-inch conduit,
three 3 1>2-inch 90-degree elbows, two 3 1>2-inch set-screw/threaded
connectors (to connect the conduit to the meter and wireway), and
one 5-foot wireway are needed to house the wiring from the meter
to the panelboards.

The information for the panelboards, wiring size servicing the
panelboards, and conduit sizes are found at the top of each panel
schedule. For Panel P, a 120>208 three-phase 225-ampere panel-
board with 30 spaces is needed. The panel is serviced by three #4/0
(0000) wires and one #12 wire. Each of these wires will need to be
approximately 70 feet long to allow 2 feet for connection in the
panelboard and meter, wire in the conduits, and wireway. The pan-
elboard is connected to the wireway by 1 foot of 2-inch conduit
with two 2-inch set-screw/threaded connectors. The rated amps
and number of poles for the circuit breakers are specified in the
“CB A-P” column of the panel schedules. The following breakers
are needed for Panel P: two 90-ampere three-pole, one 35-ampere
three-pole, one 30-ampere three-pole, three 30-ampere single-pole,
two 25-ampere single-pole, one 20-ampere single-pole, and three
30-ampere double-pole breakers.

For Panel L, a 120>208 three-phase 150-ampere panelboard
with 30 spaces is needed. The panelboard is connected to the wire-
way by 1 foot of 1 1>2-inch conduit with two 1 1>2-inch set-
screw/threaded connectors. The panel is serviced by four #1>0 (0)

FIGURE 15-6 Distribution Schematic

FIGURE 15-7 Panel P Schedule
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FIGURE 15-8 Panel L Schedule

wires approximately 70 feet long. The panel requires twenty 20-
ampere single-pole circuit breakers.

For Panel D, a 120>208 three-phase 150-ampere panelboard
with 30 spaces is needed. The panelboard is connected to the wire-
way by 1 foot of 1 1>2-inch conduit with two 1 1>2-inch set-
screw/threaded connectors. The panel is serviced by four #1>0 (0)
wires approximately 70 feet long. The panel requires twenty-three
20-ampere single-pole circuit breakers. �

SAMPLE TAKEOFF FOR THE
RESIDENTIAL GARAGE
A sample takeoff from a set of plans is shown in the follow-
ing example.

EXAMPLE 15-4

Prepare a quantity takeoff for the electrical system for the residen-
tial garage given in Appendix F.

Solution: We begin with the service from the house to the garage.
To install this service we need to run a metal conduit down the side
of the house, run PVC conduit from the house to the garage, and
install the panel with breakers in the garage. From the site plan, the
horizontal distance between the panel at the house and the panel at
the garage is 33 feet. The wire will need to be buried 18 inches in the
ground, and the boxes are mounted about 4 feet off of the ground,
requiring at least 6 additional feet of wire at each end. To be safe we
will order 50 feet of wire. The quantity takeoff for the service is as
shown in Table 15-1. The conduit stops at the bottom of the garage
wall and the wire will be run exposed through the wall to the panel
in the garage. Next, we prepare the quantity takeoff for the electrical
devices in the garage, exclusive of wiring. The items needed are
shown in Table 15-2. Next, we prepare the quantity takeoff for the
electrical wiring. The wire is to be Romex with two #12 copper
wires and a ground. The wiring distances for the outlets are shown
in Figure 15-10. There are two outlet circuits; therefore, the outlet
for the overhead door and two wall outlets are connected on one
circuit and the remaining two wall outlets are connected on the
other circuit.
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FIGURE 15-9 Panel D Schedule

TABLE 15-1 Quantity Takeoff for Service

Quantity Item Use

1 ea Meter tap Connect wire to existing meter

1 ea 1 1>4– set-screw/threaded connector Connect conduit to existing meter

10 ft 1 1>4– conduit Comes in 10-ft lengths

1 ea 1 1>4– compression/male threaded coupling Connect ridged conduit to PVC conduit

1 ea 1 1>4– slip/female threaded PVC coupling Connect ridged conduit to PVC conduit

2 ea 1 1>4– PVC 90-degree sweep Turn from horizontal to vertical at both ends

40 ft 1 1>4– PVC conduit Run wire underground

50 ft 3 ea #4 copper wire with ground Wire from meter to panel

1 ea 70-ampere single-phase panel with main breaker slot Panel for garage

1 ea 70-ampere main breaker Main breaker for panel

1 ea 20-ampere breaker Breaker for lighting

2 ea 20-ampere GFCI breaker Breakers for outlets

1 ea 6� copper ground rod Ground rod per plan
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FIGURE 15-10 Horizontal Wiring Distances for Outlets

FIGURE 15-11 Horizontal Wiring Distances for Lights

One foot of wire is allowed for each connection and 2 feet of
wire is allowed at the panel. The wire from the panel to the over-
head door outlet will need to be run 5 feet up the wall and 13 feet
across the ceiling and will require 3 feet for connections at the
panel and outlet, for a total of 21 feet. The wire from the overhead
door outlet to the outlet on the east wall will need to be run 18 feet
across the ceiling and 7 feet down the wall and will require 2 feet
for connections at the outlets, for a total of 27 feet. The wire from
the outlet on the east wall to the outlet on the north wall will need

to be run 7 feet up the wall, 17 feet across the ceiling, and 7 feet
down the wall, and it will require 2 feet for connections at the out-
lets, for a total of 33 feet. The wire from the panel to the outlet on
the inside of the south wall will need to be run 3 feet down the
wall, and 10 feet along the wall, and it will require 3 feet for connec-
tions at the panel and outlet, for a total of 16 feet. The wire from the
outlet on the inside of the south wall to the outside outlet will need
to be run 9 feet along the wall and 2 feet up the wall and it will re-
quire 2 feet for connections at the outlets, for a total of 13 feet. The
total length of wire needed for the outlets is 110 feet (21 ft � 27 ft
� 33 ft � 16 ft � 13 ft).

The wiring distances for the lights are shown in Figure 15-11.
One foot of wire is allowed for each connection and 2 feet of wire is
allowed at the panel. The wire from the panel to the switches is run

TABLE 15-2 Quantity Takeoff for Electrical
Devices

Quantity Item Use

3 ea Octagon box Exterior lights

2 ea Single-gang box Fluorescent lights

5 ea Single-gang box Outlets

5 ea Duplex outlets Outlets

4 ea Outlet covers Interior outlets

1 ea Weatherproof outlet
cover

Exterior outlet

1 ea Quad-gang box Switches

1 ea Quad-gang switch cover Switches

4 ea Single-pole switches Switches

2 ea Four-tube fluorescent
fixtures

Interior light fixtures

8 ea 4 fluorescent light bulbs¿ Interior light fixtures

3 ea Brass coach lights Exterior light fixtures

3 ea 100-w light bulbs Exterior light fixtures
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TABLE 15-3 Quantities for Residential Garage

26-100 Electrical

Meter tap 1 ea Duplex outlets 5 ea

1 1>4– set-screw/threaded connector 1 ea Outlet covers 4 ea

1 1>4– conduit 10 ft Weatherproof outlet cover 1 ea

1 1>4– compression/male threaded coupling 1 ea Quad-gang box 1 ea

1 1>4– slip/female threaded PVC coupling 1 ea Quad-gang switch cover 1 ea

1 1>4– PVC 90-degree sweep 2 ea Single-pole switches 4 ea

1 1>4– PVC conduit 40 ft Four-tube fluorescent fixtures 2 ea

Install conduit 40 ft 4 fluorescent light bulbs¿ 8 ea

3 ea #4 copper wire with ground 50 ft Brass coach lights 3 ea

70-ampere single-phase panel with main 1 ea 100-w light bulbs 3 ea

70-ampere main breaker 1 ea 250 roll 2 #12 with ground Romex¿ 1 ea

20-ampere breaker 1 ea NM/SE cable connectors 3 ea

20-ampere GFCI breaker 2 ea Electrical staples 1 box

6� copper ground rod 1 ea Red wire nuts 1 bag

Install panel 1 ea Install light fixture 5 ea

Octagon box 3 ea Install outlet 5 ea

Single-gang box 7 ea Install switch 4 ea

20 feet and will require 3 feet for connections at the panel and out-
let, for a total of 23 feet. The wire from the switch to the north inte-
rior light will need to be run 5 feet up the wall and 17 feet across the
ceiling and will require 2 feet for connections at ends, for a total of
24 feet. The wire from the switch to the south interior light will
need to be run 5 feet up the wall and 8 feet across the ceiling and
will require 2 feet for connections at ends, for a total of 15 feet. The
wire from the switch to the light on the south side of the overhead
door will need to be run 5 feet up the wall, 21 feet across the ceiling,
and 2 feet down the wall and will require 2 feet for connections at
ends, for a total of 30 feet. The wire from the light on the south side
of the overhead door to the light on the north side of the overhead
door will need to be run 2 feet up the wall, 20 feet across the ceiling,

and 2 feet down the wall and will require 2 feet for connections at
ends, for a total of 26 feet. The wire from the switch to the light on
the south exterior wall of the garage will need to be run 4 feet up
the wall and will require 2 feet for connections at ends, for a total of
6 feet. The total length for wire needed of the lighting is 124 feet
(23 ft � 24 ft � 15 ft � 30 ft � 26 ft � 6 ft). Six feet of wire are
needed to connect the panel to the ground rod.

A 250-foot roll of Romex is needed for the wiring. In addition,
three NM/SE cable connectors to secure the Romex to the panel, a
box of electrical staples to secure the Romex to the framing, and a
bag of red wire nuts to connect the wires are needed.

The quantities needed for the garage, grouped by the cost
codes in Appendix B, are shown in Table 15-3. �

CONCLUSION
The electrical system consists of electrical devices such as
light fixtures, outlets, panels, transformers, starters, motors,
motor controls, and so forth and the wiring that connects
the devices. Electrical devices are typically bid as counted
items. For the wiring the estimator must determine the
length of wiring and the conduit, including connectors, car-
rying the wire. The estimator must also include fasteners
used to secure the wire or conduit and wire nuts used to con-
nect the wires.

PROBLEMS
1. Determine the number of electrical devices needed to

complete the electrical system in Figure 15-12. The light
fixtures are to be 9-inch mushroom light fixtures.

2. Determine the wiring needed to complete the electrical
system shown in Figure 15-12. Forty feet of wire are
needed to run from the top-right corner of the room to
the panel. All wiring in the room is to be run on the
same circuit and is to be run with #12 Romex. The ceil-
ing height is 8 feet.
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3. Determine the number of electrical devices needed to
complete the lighting shown in Figure 15-13. The light
fixtures are to be 120-volt, 4-foot by 2-foot fluorescent
light fixtures with three bulbs.

4. Determine the conduit and wiring needed to complete
the lighting shown in Figure 15-13. Assume that power
will be provided to the light switches and #12 wires will
be used. The ceiling height is 9 feet and the conduit will
be run at a height of 12 feet.

5. Determine the electrical components needed to com-
plete the electrical distribution system (excluding wire

from the panelboards) for the schematic shown in
Figure 15-6. The distance to the meter is 35 feet through
a 2 1>2-inch conduit that includes three 90-degree el-
bows. The wireway is 5 feet long, and the three panels
are mounted 2 feet above the wireway. The panelboard
schedules are shown in Figures 15-14 through 15-16.

6. Determine electrical devices and wiring needed for the
Johnson Residence given in Appendix F.

7. Determine the electrical devices, conduit, and wiring
needed for the West Street Video project given in
Appendix F.

FIGURE 15-12 Electrical Plan

FIGURE 15-13 Electrical Plan
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FIGURE 15-14 Panel P Schedule

FIGURE 15-15 Panel L Schedule
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FIGURE 15-16 Panel D Schedule



200

In this chapter you will learn about the characteristics of soils
as they relate to excavation and how to estimate excavation
using the geometric method, average-width-length-depth
method, average-end method, modified-average-end method,
and cross-sectional method. It also includes example takeoffs
from the residential garage drawings.

Before we can learn about estimating excavation
quantities, we must first understand the basic char-
acteristics of soils.

CHARACTERISTICS OF SOILS
Soils are made up of three basic components: solids, water,
and air. The composition of a soil may be described by four
terms: wet unit weight (or wet density), dry unit weight (or
dry density), unit weight of water, and water content.

The wet unit weight describes the density of the soil,
both the solids and the water. The wet unit weight is calcu-
lated by dividing the total weight of the soil (solids and
water) by the total volume of the soil and is expressed in
pounds per cubic foot or pounds per cubic yard.

The dry unit weight describes the density of the solid
portion of the soil. The dry unit weight is calculated by di-
viding the weight of the solids by the total volume of the soil
and is expressed in pounds per cubic foot or pounds per
cubic yard. The dry unit weight is used to measure how well
the soil is compacted.

The unit weight of water is the weight of the water in the
soil and is expressed in pounds per cubic foot. The unit
weight of water equals the wet unit weight less the dry unit
weight.

The water content describes the relationship between
the solids and the water in the soils and is the weight of the
water (not volume) expressed as a percentage of the weight
of the solids.

The water content of the soils is important to the estima-
tor because the soils must meet specific water content re-
quirements for the soils to properly compact. Soils that are
too wet will need to be dried out before compaction, whereas
soils that are too dry will require the addition of moisture.

The dry unit weight is important to the estimator be-
cause it can be used to describe how the volume of the soil
changes as it is excavated, transported, and compacted.

SWELL AND SHRINKAGE
During the excavation and placement process, the volume of
the soils changes. The volume of the soils can be described in
three conditions: bank (or in situ), loose, and compacted.
These conditions are shown in Figure 16-1. The bank or in
situ condition describes the conditions of the soil before it
has been excavated.

When soils are excavated they swell, their volume in-
creases, and their density decreases. Soils that have been ex-
cavated and have not been placed are described as being in a
loose condition. Soils are transported in the loose condition.

The relationship between the bank and loose conditions
is described as the swell percentage. The swell, or the amount
the volume increases as the soils are excavated, is calculated
using the following equation:

(16-1)

where

DB � Bank Dry Density (Unit Weight)

DL � Loose Dry Density (Unit Weight)

Another way of describing the swell percentage is to
imagine that we dig a hole and loosely place the excavated
soil back in the hole, only to find that we have more soil than
fits in the hole. This additional soil is due to swell. This ex-
ample is shown in Figure 16-2.

Swell!% � aDB

DL
� 1b100

EARTHWORK

CHAPTER SIXTEEN
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FIGURE 16-1 Volumes of Soils

FIGURE 16-2 Swell Percentage

FIGURE 16-3 Shrinkage Percentage

When soils are placed and compacted, their volume de-
creases and their density increases. This decrease in volume
is measured against the original volume of the soils in the
bank condition. Soils that have been placed as backfill are
described as being in the compacted condition.

The relationship between the bank and compacted con-
ditions is described as the shrinkage percentage. The shrink-
age percentage is calculated using the following equation:

(16-2)

where

DB � Bank Dry Density (Unit Weight)

DC � Compact Dry Density (Unit Weight)

Another way of describing the shrinkage percentage is
to imagine that we dig a hole and place the excavated soil
back in the hole, compacting as we go. When all of the soil is
placed in the hole we might find that the hole is not com-
pletely filled because we packed the soil at a higher level of
compaction than when it was in its bank condition. The un-
filled volume is due to shrinkage. This example is shown in
Figure 16-3.

The calculation of the swell percentage and the shrink-
age percentage is shown in the following example.

Shrinkage!% � a1 �
DB

DC
b100

EXAMPLE 16-1

A soil has a bank dry density of 110 pounds per cubic foot, a loose
dry density of 80 pounds per cubic foot, and a compacted dry den-
sity of 115 pounds per cubic foot. Determine the swell percentage
and shrinkage percentage for the soil.

Solution: The swell percentage is calculated using Eq. (16-1) as
follows:

The shrinkage percentage is calculated using Eq. (16-2) as follows:

�

The relationships between the bank volume (VB), the
loose volume (VL), and the compacted volume (VC) are
shown in Table 16-1. The relationships between the bank dry
density (DB), the loose dry density (DL), and the compacted
dry density (DC) of a soil are also shown in Table 16-1.

The use of these equations is shown in the following
example.

EXAMPLE 16-2

A construction project needs 1,000 cubic yards of compacted fill.
Soil with a swell percentage of 37.5% and a shrinkage percentage of
4.3% is to be used for the fill. How many cubic yards of soil must be
excavated? How many cubic yards of soil must be transported?

Shrinkage!% � a1 �
110!lb/ft3

115!lb/ft3b100 � 4.3%

Swell!% � a110!lb/ft3

80!lb/ft3 � 1b100 � 37.5%
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Solution: To determine the soil excavated, we need to convert the
compacted volume to a bank volume. Compacted cubic yards (VC)
are converted to bank cubic yards (VB) using Eq. (16-6) as follows:

VB �
(1,000!yd3)

a1 �
4.3

100
b

� 1,045!yd3

To determine the volume of soil transported, we need to determine
the loose volume. Compacted cubic yards (VC) are converted to
loose cubic yards (VL) using Eq. (16-4) as follows:

Alternatively, the loose cubic yards (VL) can be calculated from the
previously determined bank cubic yards (VB) using Eq. (16-3) as
follows:

�

Determining the volume of excavation is only an ap-
proximation or estimate of the actual volume of soils that
needs to be excavated because of variations in the surface of
the area to be excavated and the inability of excavation equip-
ment to quickly excavate exact geometric shapes. In spite of
this, some methods of calculating excavation quantities are
more accurate than others. Let’s begin by looking at the most
accurate of the methods, the geometric method.

GEOMETRIC METHOD
The geometric method breaks the excavation into geomet-
ric shapes and calculates the volume for each of the shapes.
The use of the geometric method is shown in the following
example.

EXAMPLE 16-3

A contractor needs to install a 16-foot by 26-foot by 8-foot-high
footing for a bridge. The bottom of the footing is to be 10 feet
below grade. The sides of the excavation need to be sloped 1:1
(horizontal:vertical). A 2-foot space between the footing and the sides
of the excavation must be provided to form the footing. Determine
the volume of the excavation using the geometric method.

Solution: The width of the excavation at the bottom is 20 feet (2 ft
� 16 ft � 2 ft), and the length of the excavation at the bottom is
30 feet (2 ft � 26 ft � 2 ft). The width of the excavation is 20 feet

VL � (1,045!yd3)a1 �
37.5

100
b � 1,437!yd3

VL � (1,000!yd3)

a1 �
37.5

100
b

a1 �
4.3

100
b

� 1,437!yd3

TABLE 16-1 Volume and Density Conversion
Equations

To Find From Use

VL VB VL � VBa1 �
Swell!%

100
b (16-3)

VL VC VL � VC

a1 �
Swell!%

100
b

a1 �
Shrinkage!%

100
b

(16-4)

VB VL VB �
VL

a1 �
Swell!%

100
b

(16-5)

VB VC VB �
VC

a1 �
Shrinkage!%

100
b

(16-6)

VC VL VC � VL

a1 �
Shrinkage!%

100
b

a1 �
Swell!%

100
b

(16-7)

VC VB VC � VB a1 �
Shrinkage!%

100
b (16-8)

DL DB DL �
DB

a1 �
Swell!%

100
b

(16-9)

DL DC DL � DC

a1 �
Shrinkage!%

100
b

a1 �
Swell!%

100
b

(16-10)

DB DL DB � DL a1 �
Swell!%

100
b (16-11)

DB DC DB � DC a1 �
Shrinkage!%

100
b (16-12)

DC DL DC � DL

a1 �
Swell!%

100
b

a1 �
Shrinkage!%

100
b

(16-13)

DC DB DC �
DB

a1 �
Shrinkage!%

100
b

(16-14)

FIGURE 16-4 Excavation Cross Sections
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AVERAGE-WIDTH-LENGTH-
DEPTH METHOD
The average-width-length-depth method calculates the vol-
ume of excavation by multiplying the average width of the
excavation by the average length of the excavation by the av-
erage depth of the excavation using the following equation:

(16-15)

The average depth of the excavation is measured at the
bottom of the excavation and does not include the side
slopes. This method produces an approximate volume and
is less accurate than the geometric method. The use of the
average-width-length-depth method is shown in the fol-
lowing example.

EXAMPLE 16-4

Determine the excavation volume for Example 16-3 using the aver-
age-width-length-depth method.

Solution: The average depth is 10 feet. Using the dimensions
from Figure 16-5, the average width and length are calculated as
follows:

The volume is calculated using Eq. (16-15) as follows:

�

AVERAGE-END METHOD
The average-end method calculates the volume by cutting
cross sections through the excavation and determining the
area of cut and fill for each of the cross sections. The vol-
ume of cut or fill between two cross sections is equal to the
average of the two cross-sectional areas of the cut or fill
multiplied by the perpendicular distance between the cross
sections:

(16-16)

where

L = Perpendicular Distance between the Cross
Sections

A1 = Area of Cross Section 1

A2 = Area of Cross Section 2

When more than two cross sections are taken and the
distances between them are the same, the following equation
may be used to calculate the volume:

(16-17)
Volume � L(0.5A1 � A2 � A3 � p � An�1 � 0.5An)

Volume � L
(A1 � A2)

2

Volume � (30!ft)(40!ft)(10!ft)a 1!yd3

27!ft3b � 444!yd3

Lave �
(30!ft � 50!ft)

2
� 40!ft

Wave �
(20!ft � 40!ft)

2
� 30!ft

Volume � (Wave)(Lave)(Dave)

FIGURE 16-5 Excavation for Footing

FIGURE 16-6 Excavation for Footing

wider at the top than at the base. Cross sections of the excavation
are shown in Figure 16-4. A three-dimensional representation of
the excavation is shown in Figure 16-5. This excavation can be di-
vided into a column, four prisms, and four pyramids as shown in
Figure 16-6. The volume of the column is calculated as follows:

There are two different sizes of prisms. Their volumes are calcu-
lated as follows:

The volume of the pyramids is calculated as follows:

The total volume is calculated as follows:

�� 456!yd3

Volume � 222!yd3 � 2(56!yd3) � 2(37!yd3) � 4(12!yd3)

VolumePyramid �
(10!ft)(10!ft)(10!ft)

3
a 1!yd3

27!ft3b � 12!yd3

VolumePrism!2 �
(20!ft)(10!ft)(10!ft)

2
a 1!yd3

27!ft3b � 37!yd3

VolumePrism!1 �
(30!ft)(10!ft)(10!ft)

2
a 1!yd3

27!ft3b � 56!yd3

VolumeColumn � (30!ft)(20!ft)(10!ft)a 1!yd3

27!ft3b � 222!yd3
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where

L = Perpendicular Distance between the Cross
Sections

A1 = Area of Cross Section 1

A2 = Area of Cross Section 2

A3 = Area of Cross Section 3

An = Area of Cross Section n

The average-end method produces an approximate vol-
ume and is less accurate than the geometric method. The ac-
curacy is improved by increasing the number of cross
sections and locating cross sections at major changes in
grades. Historically, this method has been used for road con-
struction by cutting the cross sections perpendicular to the
centerline of the road as shown in the following example.

EXAMPLE 16-5

Using the average-end method, determine the required excavation
for a new road giving the stations and their associated cuts shown
in Table 16-2.

Solution: The distance between Stations 5+00 and 5+50 is 50 feet.
The distance between Stations 5+50 and 6+00 is 50 feet. The dis-
tance between Stations 6+00 and 6+20 is 20 feet. The volumes of
the cuts are calculated using Eq. (16-16) as follows:

The total volume is calculated as follows:

�

The average-end method may also be used to calculate
the volume of a basement excavation. When using this
method to calculate excavation volumes, a cross section
should be cut at each horizontal step on the excavation. The
use of the average-end method to calculate basement excava-
tion is shown in the following example.

EXAMPLE 16-6

Determine the excavation volume for Example 16-3 using the
average-end method.

Volume � 69!yd3 � 171!yd3 � 41!yd3 � 281!yd3

Volume6�00!to!6�20 � (20!ft)
(110!ft2 � 0!ft2)

2
a 1!yd3

27!ft3b� 41!yd3

Volume5�50!to!6�00 � (50!ft)
(75!ft2 � 110!ft2)

2
a 1!yd3

27!ft3b� 171!yd3

Volume5�00!to!5�50 � (50!ft)
(0!ft2 � 75!ft2)

2
a 1!yd3

27!ft3b� 69!yd3

Solution: The cross sections will be cut at the top and bottom of
the excavation. Using the dimensions from Figure 16-5, the areas of
the top and bottom of the excavation are calculated as follows:

The volume is calculated using Eq. (16-16) as follows:

�

MODIFIED-AVERAGE-END
METHOD
Equation (16-16) may be modified as follows:

(16-18)

where

L = Perpendicular Distance between the Cross
Sections

A1 = Area of Cross Section 1

A2 = Area of Cross Section 2

Equation (16-18) gives an answer closer to the answer
provided by the geometric method, although not mathemat-
ically identical. The use of the modified-average-end method
to calculate basement excavation is shown in the following
example.

EXAMPLE 16-7

Determine the excavation volume for Example 16-3 using the mod-
ified-average-end method.

Solution: From Example 16-6, the area of the top is 2,000 ft2 and
the area of the bottom is 600 ft2. The volume is calculated using Eq.
(16-16) as follows:

�

CROSS-SECTIONAL METHOD
The cross-sectional method is most commonly used for cal-
culation of site excavation on sites where the grade around
the building changes dramatically. Like the average-width-
length-depth method, the average-end method, and the
modified-average-end method, the cross-sectional method
produces an approximate volume and is less accurate than
the geometric method. The following steps need to be com-
pleted to calculate the volume using the cross-sectional
method:

Step 1: Divide the site into grids.

Step 2: Calculate the cut or fill at each grid intersection.

Volume � 456!yd2

10!ft a600!ft2 � 2,000!ft2 � 2(600!ft2)(2,000!ft2)

3
b a 1!yd3

27!ft3b
Volume �

Volume � L!aA1 � A2 � 1A1A2

3
b

Volume � (10!ft)
(2,000!ft2 � 600!ft2)

2
a 1!yd3

27!ft3b � 481!yd3

AreaBottom � (20!ft)(30!ft) � 600!ft2

AreaTop � (40!ft)(50!ft) � 2,000!ft2

TABLE 16-2 Area of Cuts

Station Cut (ft2)

5 00� 0

5 50� 75

6 00� 110

6 20� 0
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Step 3: Separate the cuts and fills with a zero line.

Step 4: Calculate the volume of the cuts and fills.

Let’s look at each of these steps.

Step 1: Divide the Site into Grids
The first step is to divide the proposed area or site into grids.
The grids may be evenly spaced or aligned with site features.
Figure 16-7 shows a site plan for the construction of a build-
ing, with the existing grades to be changed drawn as dashed
lines and the proposed final grades drawn as solid lines. The

site is divided into twelve 50-foot by 50-foot squares as
shown in Figure 16-8.

Step 2: Calculate Cut or Fill at Each
Grid Intersection
The next step is to calculate the cut or fill at each grid inter-
section where the grades are going to change. Often the
grades around the perimeter of the site are not going to
change; therefore, there is neither a cut nor a fill at these in-
tersections. The cut or fill is calculated by subtracting the

FIGURE 16-8 Grids

FIGURE 16-7 Site Plan
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existing grade from the proposed grade using the following
equation:

(16-19)

If the result of Eq. (16-19) is positive, a fill (the adding
of soil) is required; if the result is negative, a cut (the removal
of soil) is required. The existing and proposed grades are de-
termined by estimating the existing or proposed elevation
from the contours or other information (for example, slab
elevation) on the drawings. When an intersection falls be-
tween two grade lines, the grade at the intersection of the
grid lines is estimated by interpolating between two adjacent
contour lines using the following equation:

(16-20)

where

GradeP = Grade at Intersection

Grade1 = Grade of First Contour Line

Grade2 = Grade of Second Contour Line

DistP-1 = Distance between the Intersection and the
First Contour Line

Dist2-1 = Distance between the Second and First
Contour Lines

This step is shown in the following example.

EXAMPLE 16-8

Determine the cuts and fills for the site plan shown in Figures 16-7
and 16-8. The bottom of the building excavation is at 99.00 feet.

GradeP � (Grade2 � Grade1)
(DistP�1)

(Dist2�1)
� Grade1

Cut>Fill � GradeProposed � GradeExisting

Solution: For the intersection at B2, the existing grade is 100.0
and the proposed grade is 99.0. The cut or fill is calculated using
Eq. (16-19) as follows:

Because the answer is negative, there is a cut of 1.0 foot at B2. For B3
the existing grade is 101.0 and the proposed grade is 99.0. For B4 the
existing grade is 102.0 and the proposed grade is 99.0. For C2 the
existing grade is 98.0 and the proposed grade is 99.0. For C3 the ex-
isting grade is 101.0 and the proposed grade is 99.0. For C4 the
existing grade must be interpolated using Eq. (16-20). The distance
between the 101.0 contour line and the intersection is 50 feet, and
the distance between the 101.0 and 102.0 contour lines is about
75 feet. The grade at the intersection is calculated as follows:

The proposed grade at C4 is 99.0. The cuts and fills for the intersec-
tions are calculated using Eq. (16-19) as follows:

�

The existing grades, proposed grades, and cut or fill for each
intersection are shown in Figure 16-9. The existing grades
are above and left of the intersection, the proposed grades
are below and left of the intersection, and the cuts or fills are
below and right of the intersections. The fills begin with the
letter “F” and the cuts begin with the letter “C.”

Cut>FillC4 � 99.0 � 101.7 � �2.7

Cut>FillC3 � 99.0 � 101.0 � �2.0

Cut>FillC2 � 99.0 � 98.0 � 1.0

Cut>FillB4 � 99.0 � 102.0 � �3.0

Cut>FillB3 � 99.0 � 101.0 � �2.0

GradeP � (102.0 � 101.0)
(50!ft)

(75!ft)
� 101.0 � 101.7

Cut>FillB2 � 99.0 � 100.0 � �1.0

FIGURE 16-9 Cuts and Fills
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Step 3: Separate the Cuts and Fills
with a Zero Line
The next step is to draw a line between the cuts and fills. This is
referred to as a zero line because it represents the location
where there is neither a cut nor a fill. Before drawing the zero
line, one needs to determine the points where cuts change into
fills. A change will occur any time there is a cut and a fill next to
each other on the grid. For the site plan in Figure 16-9, this will
occur between points B2 and C2 and between points C2 and
C3. The location of the zero is determined by interpolating be-
tween two adjacent intersections using the following equation:

(16-21)

where

DistC–0 � Distance from the Intersection with a Cut to
the Zero Line

DistC–F � Distance from the Intersection with a Cut to
the Intersection with a Fill

Cut � Cut at the Intersection with a Cut (must be
positive)

Fill � Fill at the Intersection with a Fill

DistC�0 � (DistC�F)
(Cut)

(Cut � Fill)

When the rectangle on a grid has three zeros, as is the
case with rectangles 5 and 10 in Figure 16-9, the zero line is
drawn as shown in Figure 16-10. This condition often occurs
at boundaries.

Locating the zero line is shown in the following example.

EXAMPLE 16-9

Determine the location of the zero line for the site plan shown in
Figure 16-9.

Solution: The distance from B2 to the zero line in the direction of
C2 is calculated using Eq. (16-21) as follows:

The distance from C3 to the zero line in the direction of C2 is cal-
culated using Eq. (16-21) as follows:

The zero line for Figure 16-9 is drawn as shown in Figure 16-11. �

Step 4: Calculate the Volume of the Cuts
and Fills
The next step is to calculate the volume of the cuts and the
fills. The volume of the cuts is calculated separately from
that for the fills. When a rectangle contains both cuts and
fills, the rectangle is divided into separate areas (a cut area
and a fill area) by the zero line as shown in Figure 16-11.
The volume of the cut for a rectangle equals the average of
the cuts and zeros surrounding the cut area within the

DistC2�0 � (50!ft)
(2.0)

(2.0 � 1.0)
� 33!ft

DistC2�0 � (50!ft)
(1.0)

(1.0 � 1.0)
� 25!ft

FIGURE 16-10 Zero Lines at Boundaries

FIGURE 16-11 The Zero Line
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rectangle multiplied by the area of the cut area of the rectan-
gle. Similarly, the volume of the fill for a rectangle equals the
average of the fills and zeros surrounding the fill area within
the rectangle multiplied by the area of the fill area of the rec-
tangle. These calculations are shown in the following example.

EXAMPLE 16-10

Determine the cuts and fills for each of the 12 rectangles shown in
Figure 16-11. What is the total cut for all of the areas? What is the
total fill for all of the areas?

Solution: First we will calculate the cuts. All of rectangle 1 is a cut
comprising zero cuts at three corners and a cut of 1.0 foot at the
fourth. The cut volume is calculated as follows:

The cut volumes for rectangles 2 through 4 are calculated in a sim-
ilar manner. They are as follows:

For rectangle 5, the area must be divided into three areas: a cut area,
a fill area, and an area that is neither a cut nor a fill. From Example
16-9, the area of the cut is a triangle with a base of 25 feet and a
height of 50 feet. The triangle is surrounded by two zeros and a cut
of 1.0 foot. The cut volume is calculated as follows:

For rectangle 6, the area must be divided into two areas: a cut area and
a fill area. From Example 16-9, the area of the fill is a triangle with a
base of 25 feet (50 ft - 25 ft) and a height of 17 feet (50 ft - 33 ft). The
area of the cut is the area of the rectangle (50 ft × 50 ft) less the area of
the triangle. The cut area is surrounded by two zeros, a cut of 1.0 foot,
and two cuts of 2.0 feet. The cut volume is calculated as follows:

The cut volumes for rectangles 7 and 8 are as follows:

� (50!ft)(50!ft)a 1!yd3

27!ft3b � 225!yd3

Volume7 � a2.0!ft � 2.0!ft � 3.0!ft � 2.7!ft

4
b

� 85!yd3

!� a5!ft

5
b c (50!ft)(50!ft) �

(17!ft)(25!ft)

2
d a 1!yd3

27!ft3b
� c (50!ft)(50!ft) �

(17!ft)(25!ft)

2
d

Volume6 � a0!ft � 0!ft � 1.0!ft � 2.0!ft � 2.0!ft

5
b

� 8!yd3

Volume5 � a0!ft � 0!ft � 1.0!ft

3
b c (50!ft)(25!ft)

2
d a 1!yd3

27!ft3b

� 69!yd3

Volume4 � a0!ft � 0!ft � 0!ft � 3.0!ft

4
b(50!ft)(50!ft)a 1!yd3

27!ft3b
� 116!yd3

Volume3 � a0!ft � 0!ft � 2.0!ft � 3.0!ft

4
b(50!ft)(50!ft)a 1!yd3

27!ft3b
� 69!yd3

Volume2 � a0!ft � 0!ft � 2.0!ft � 1.0!ft

4
b(50!ft)(50!ft)a 1!yd3

27!ft3b

� 23!yd3

Volume1 � a0!ft � 0!ft � 0!ft � 1.0!ft

4
b(50!ft)(50!ft)a 1!yd3

27!ft3b

Rectangle 9 does not have any cuts. The cut volume for rectangle 10
is calculated in the same manner as for rectangle 5 and is calculated
as follows:

The cut volumes for rectangles 11 and 12 are as follows:

The total volume of the cut is calculated by summing the individual
cut volumes as follows:

The volume of the fills is calculated as follows:

The total fill volume is calculated by summing the individual fill
volumes as follows:

�

The cross-sectional method may be used on building
excavation even when contours do not exist, as long as cuts
and fills can be calculated. The use of the cross-sectional
method is shown in the following example.

EXAMPLE 16-11

Determine the excavation volume for Example 16-3 using the
cross-sectional method.

Solution: The grids are aligned with the top and bottom of the
slopes. The grids and the cuts are shown in Figure 16-12. The cuts

Volume � 8!yd3 � 3!yd3 � 23!yd3 � 5!yd3 � 39!yd3

� 5!yd3

Volume10 � a0!ft � 0!ft � 1.0!ft

3
b c (50!ft)(17!ft)

2
d a 1!yd3

27!ft3b
� 23!yd3

Volume9 � a0!ft � 0!ft � 0!ft � 1.0!ft

4
b(50!ft)(50!ft)a 1!yd3

27!ft3b
� 3!yd3

Volume6 � a0!ft � 0!ft � 1.0!ft

3
b c (17!ft)(25!ft)

2
d a 1!yd3

27!ft3b
� 8!yd3

Volume5 � a0!ft � 0!ft � 1.0!ft

3
b c (50!ft)(25!ft)

2
d a 1!yd3

27!ft3b

� 919!yd3

� 225!yd3 � 132!yd3 � 20!yd3 � 109!yd3 � 63!yd3

Volume � 23!yd3 � 69!yd3 � 116!yd3 � 69!yd3 � 8!yd3 � 85!yd3

� 63!yd3

Volume12 � a0!ft � 0!ft � 0!ft � 2.7!ft

4
b(50!ft)(50!ft)a 1!yd3

27!ft3b
� 109!yd3

Volume11 � a0!ft � 0!ft � 2.0!ft � 2.7!ft

4
b(50!ft)(50!ft)a 1!yd3

27!ft3b

� 20!yd3

Volume10 � a0!ft � 0!ft � 2.0!ft

3
b c (50!ft)(33!ft)

2
d a 1!yd3

27!ft3b

� 132!yd3

Volume8 � a0!ft � 0!ft � 2.7!ft � 3.0!ft

4
b(50!ft)(50!ft)a 1!yd3

27!ft3b
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are shown below and to the right of each intersection. The cuts for
each of the rectangles are calculated as follows:

� 9!yd3

Volume9 � a0!ft � 0!ft � 0!ft � 10!ft

4
b(10!ft)(10!ft)a 1!yd3

27!ft3b
� 56!yd3

Volume8 � a0!ft � 0!ft � 10!ft � 10!ft

4
b(10!ft)(30!ft)a 1!yd3

27!ft3b
� 9!yd3

Volume7 � a0!ft � 0!ft � 0!ft � 10!ft

4
b(10!ft)(10!ft)a 1!yd3

27!ft3b
� 37!yd3

Volume6 � a0!ft � 0!ft � 10!ft � 10!ft

4
b(10!ft)(20!ft)a 1!yd3

27!ft3b
� 222!yd3

Volume5 � a10!ft � 10!ft � 10!ft � 10!ft

4
b(30!ft)(20!ft)a 1!yd3

27!ft3b
� 37!yd3

Volume4 � a0!ft � 0!ft � 10!ft � 10!ft

4
b(10!ft)(20!ft)a 1!yd3

27!ft3b
� 9!yd3

Volume3 � a0!ft � 0!ft � 0!ft � 10!ft

4
b(10!ft)(10!ft)a 1!yd3

27!ft3b
� 56!yd3

Volume2 � a0!ft � 0!ft � 10!ft � 10!ft

4
b(10!ft)(30!ft)a 1!yd3

27!ft3b
� 9!yd3

Volume1 � a0!ft � 0!ft � 0!ft � 10!ft

4
b(10!ft)(10!ft)a 1!yd3

27!ft3b

The total cut is calculated as follows:

�

COMPARISON OF METHODS
The excavation in Example 16-3 has been calculated using
the five methods presented in this chapter. The geometric
method produces an exact quantity for the excavation. A
comparison among the methods is shown in Table 16-3.
Although the geometric method and the modified-average-
end method both produce 456 cubic yards, when the calcu-
lations are done without rounding, there is a 0.1% difference
in their answers. In some cases, these two methods can
produce vastly different numbers. With four methods for
calculating volume, it can be hard to know which method is
best. The most accurate method is the geometric method,

Volume � 444!yd3

� 37!yd3 � 9!yd3 � 56!yd3 � 9!yd3

Volume � 9!yd3 � 56!yd3 � 9!yd3 � 37!yd3 � 222!yd3

TABLE 16-3 Comparison of Volumes

Method Volume (yd3) Error (%)

Geometric 456 0

Average-width-length-depth 444 -2.6

Average-end 481 +5.5

Modified-average-end 456 -0.1

Cross-sectional 444 -2.6

FIGURE 16-12 Grid and Cuts for Example 16-11
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but in many cases it will be very hard, if not impossible, to
use. The method most often used is the method that is easi-
est to use based on the grading and excavation data available.

BACKFILL
The easiest way to calculate the quantity of backfill for foot-
ing, foundations, and so forth is to determine the volume of
excavation and subtract the volume of the footing or foun-
dation. This is shown in the following example.

EXAMPLE 16-12

The footing in Example 16-3 supports a 2-foot by 12-foot column.
Using the quantity of excavation from Example 16-3, determine the
volume of backfill that needs to be placed after the footing has been
constructed.

Solution: The volume of excavation from Example 16-3 is 456
cubic yards. The entire footing and the bottom 2 feet (10 ft - 8 ft) of
the column are below the finished grade. The volume of the footing
and column that displaces soil is calculated as follows:

The volume of backfill is calculated as follows:

�

Once the quantities of excavation and backfill have been
calculated, these quantities along with the quantity of soil im-
ported or exported need to be related to each other. If the ex-
cavated material is suitable, it may be used for the fill. If it is
unsuitable for fill, it must be hauled off (exported) and an ac-
ceptable fill material brought in (imported). The calculation
of soil import and export is shown in the following example.

EXAMPLE 16-13

The soils in Example 16-12 have a swell percentage of 30% and a
shrinkage percentage of 5%. The excavated soils may be used as back-
fill. Determine the volume of the soils that needs to be exported.

Solution: From Example 16-12 the volume of excavation is 456
cubic yards and the volume of backfill is 331 cubic yards. The com-
pacted volume of the backfill is converted to a bank quantity using
Eq. (16-6) as follows:

Three hundred and forty-eight yards of the excavated material are
needed for the backfill. The quantity exported is 108 bank cubic
yards (456 yd3 - 348 yd3). The loose volume of the exported soils is
converted from a bank quantity to a loose quantity using Eq. (16-3)
as follows:

VL � (108!yd3)a1 �
30

100
b � 140!yd3

VB �
(331!yd3)

a1 �
5

100
b

� 348!yd3

Volume � 456!yd3 � 123!yd3 � 2!yd3 � 331!yd3

VolumeColumn � (2!ft)(12!ft)(2!ft)a 1!yd3

27!ft3b � 2!yd3

VolumeFooting � (16!ft)(26!ft)(8!ft)a 1!yd3

27!ft3b � 123!yd3

One hundred and forty cubic yards of soil will need to be
exported. �

SOILS REPORT
Estimators should read soils report carefully. A soils report
provides valuable information, such as the presence of
groundwater or rocky soil. Both of these conditions increase
the cost of excavation. If a soils report is not provided with
the bid documents, the estimator should contact the design
professionals to see if a copy is available.

SAMPLE TAKEOFF FOR THE
RESIDENTIAL GARAGE
A sample takeoff for excavation from a set of plans is shown
in the following example.

EXAMPLE 16-14

Determine the excavation, under-slab gravel, and backfill needed to
complete the residential garage given in Appendix F. The excavated
soils may be used as backfill.

Solution: The excavation will consist of excavating the entire foot-
print of the building, the sidewalk, and the driveway and excavating
and backfilling the footings. The pad excavation will extend 1 foot
beyond the sidewalk and driveway and 2 feet beyond the building.
The excavation quantities are calculated using the cross-sectional
method. Begin by calculating the excavation for the building, includ-
ing 2 feet beyond in all directions. The excavation grade is 8 inches
(0.67 ft) below the grade of the building slab shown on the floor plan.
The cuts for the building corners and total cut volume are as follows:

Next, the volume of the driveway is calculated. The east side of the
drive has already been excavated to a point 2 feet west of the garage.
At the west end, the drive will need to match the grade of the exist-
ing driveway. The cuts for the slab corners and total cut volume are
as follows:

� 12.7!yd3

� (20!ft)(24.58!ft)a 1!yd3

27!ft3b
Volume � a0.67!ft � 0.67!ft � 0.72!ft � 0.74!ft

4
b

CutSE!Corner � 99.52!ft � 98.78!ft � 0.74!ft

CutNE!Corner � 99.50!ft � 98.78!ft � !0.72!ft

CutSW!Corner � 98.70!ft � 98.03!ft � 0.67!ft

CutNW!Corner � 98.60!ft � 97.93!ft � 0.67!ft

� 20.3!yd3

� (28!ft)(30!ft)a 1!yd3

27!ft3b
Volume � a0.68!ft � 0.64!ft � 0.62!ft � 0.67!ft

4
b

CutNE!Corner � 100.00!ft � 99.33!ft � 0.67!ft

CutSE!Corner � 99.95!ft � 99.33!ft � 0.62!ft

CutSW!Corner � 99.47!ft � 98.83!ft � 0.64!ft

CutNW!Corner � 99.51!ft � 98.83!ft � 0.68!ft
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Next, the volume of the sidewalk is calculated. The width of the
sidewalk to be excavated is 4 feet plus the 1 foot over-excavation less
the 2 feet of over-excavation already accomplished when excavating
the garage. The length of the sidewalk to the south of the building is
32 feet (1 ft � 4 ft � 26 ft � 1 ft), which includes 1 foot over-exca-
vation at both ends. The length of sidewalk to the west is 5 feet (3 ft
� 2 ft). For the grades of the sidewalk we use the cut of the south-
east building corner and southeast corner of the driveway. The total
cut volume is calculated as follows:

Next, the excavation for the foundation wall is calculated. The cuts
to the bottom of the foundation in the four corners of the building
are as follows:

Allow for a 4-foot-wide trench for the footings. Extend the trench
out 1 foot beyond the outside of the footings. The north and south
trenches are 29 feet (1 ft � 0.5 ft � 26 ft � 0.5 ft � 1 ft) long and
include the corners. The east and west trenches are 19 feet long and
will run from the inside of the north trench to the inside of the
south trench. Because the excavations are shallow, the wall can be
vertical. The excavation is calculated using the average-width-
length-depth method as follows:

The total excavation is calculated as follows:

Backfill is needed around the footings and in the areas over-excavated
during the excavation of the pad. The backfill of the footings is calcu-
lated by determining the volume of the concrete in the excavation and
subtracting it from the volume of excavation. The height of the wall
below the excavation level on the west side is 0.34 feet (1.17 ft - 10 in)
and on the east side is 0.83 feet (1.67 ft - 10 in). The west wall includes
the wall on the footing and the frost wall. The footing volume is calcu-
lated as follows:

� 14.0!ft3a 1!yd3

27!ft3b � 0.52!yd3

� (16!ft)(1.17!ft)(0.67!ft)]

VolumeWest!Wall � [2(3.33!ft)(0.34!ft)(0.67!ft)

VolumeFooting � (82.33!ft)
(10!in)(20!in)

(12!in>ft)2 a 1!yd3

27!ft3b � 4.24!yd3

� 82!ft!3!in � 82.33!ft

LengthFooting � 3!ft!4!in � 27!ft � 21!ft!8!in � 27!ft � 3!ft!4!in

Volume � 20.3!yd3 � 12.7!yd3 � 2.9!yd3 � 20.2!yd3 � 56!yd3

Volume � 6.1!yd3 � 4.7!yd3 � 6.1!yd3 � 3.3!yd3 � 20.2!yd3

VolumeW � (19!ft)a1.17!ft � 1.17!ft

2
b(4)a 1!yd3

27!ft3b � 3.3!yd3

VolumeS � (29!ft)a1.67!ft � 1.17!ft

2
b(4)a 1!yd3

27!ft3b � 6.1!yd3

VolumeE � (19!ft)a1.67!ft � 1.67!ft

2
b(4)a 1!yd3

27!ft3b � 4.7!yd3

VolumeN � (29!ft)a1.67!ft � 1.17!ft

2
b(4)a 1!yd3

27!ft3b � 6.1!yd3

CutNE!Corner � 99.33!ft � 97.66!ft � 1.67!ft

CutSE!Corner � 99.33!ft � 97.66!ft � 1.67!ft

CutSW!Corner � 98.83!ft � 97.66!ft � 1.17!ft

CutNW!Corner � 98.83!ft � 97.66!ft � 1.17!ft

� 2.9!yd3

Volume � a0.74!ft � 0.62!ft

2
b(32!ft � 7!ft)(3!ft)a 1!yd3

27!ft3b

The volume of backfill needed for the over-excavation is calculated
as follows:

The total backfill is 19.2 cubic yards (14.2 yd3 � 5.0 yd3). Assuming
a shrinkage percentage of 5%, we calculate the quantity of exca-
vated material needed for the fill using Eq. (16-6) as follows:

The amount of export is 36 bank cubic yards (56 yd3 - 20 yd3).
The last item to calculate is the volume of gravel needed under

the concrete slab, driveway, and sidewalk. The volume is calculated
as follows:

The quantities needed for the garage, grouped by the cost codes in
Appendix B, are shown in Table 16-4. �

Volume � (1,181!ft2)
(4!in)

(12!in/ft)
a 1!yd3

27!ft3b � 14.6!yd3

Area � 570!ft2 � 479!ft2 � 132!ft2 � 1,181!ft

AreaSidewalk � (33!ft)(4!ft) � 132!ft2

AreaDrive � (18!ft)(26!ft!7!in) � 479!ft2

AreaSlab � (24!ft!8!in)(22!ft!8!in) � (16!ft)(8!in) � 570!ft2

VB �
(19.2!yd3)

a1 �
5

100
b

� 20.2!yd3

� 5.0!yd3

� (1!ft)(7!ft) � (1!ft)(21.58!ft)](0.67!ft)(1!yd3/27!ft3)

� (2!ft)(24!ft) � (1!ft)(4!ft) � (1!ft)(32!ft)

Volume � [(1!ft)(24.58!ft) � (2!ft)(3!ft) � (2!ft)(30!ft)

VolumeBackfill � 20.2!yd3 � 6.0!yd3 � 14.2!yd3

� 6.0!yd3

� 0.47!yd3 � 0.38!yd3

VolumeConcrete � 4.24!yd3 � 0.52!yd3 � 0.38!yd3

� 0.38!yd3

VolumeSouth!Wall � (26!ft)a0.34!ft � 0.83

2
b(0.67!ft)a 1!yd3

27!ft3b
VolumeEast!Wall � (22.66!ft)(0.83)(0.67!ft)a 1!yd3

27!ft3b � 0.47!yd3

� 0.38!yd3

VolumeNorth!Wall � (26!ft)a0.34!ft � 0.83

2
b(0.67!ft)a 1!yd3

27!ft3b

TABLE 16-4 Quantities for Residential Garage

31-200 Grading and Excavation

Excavation 56 bank cyd

Backfill 19 bank cyd

Export 36 bank cyd

3>4 gravel– 15 compacted
cyd
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CONCLUSION
The volume of excavation can be calculated in a number of
ways including the geometric method, the average-width-
length-depth method, the average-end method, the modi-
fied-average-end method, and the cross-sectional method.
Because of variation in the surface area to be excavated and
the inability of excavating equipment to quickly excavate
exact geometric shapes, any calculation of the volume of ex-
cavation is only an approximation.

When soils are excavated their volume increases. This is
known as swell. When soils are compacted their volume de-
creases to a volume less than their volume before they were
excavated. This is known as shrink. Swell and shrink must be
taken into account when determining the volume of soil that
needs to be transported and placed as compacted fill.

PROBLEMS
1. A soil has a bank dry density of 108 pounds per cubic

foot, a loose dry density of 85 pounds per cubic foot,
and a compacted dry density of 120 pounds per cubic
foot. Determine the swell percentage and shrinkage per-
centage for the soils.

2. A soil has a bank dry density of 100 pounds per cubic
foot, a loose dry density of 90 pounds per cubic foot,
and a compacted dry density of 105 pounds per cubic
foot. Determine the swell percentage and shrinkage per-
centage for the soils.

3. Using the geometric method, determine the amount of
excavation required for a 24-foot by 50-foot basement.
The measurements are from the outside of the founda-
tion walls. The depth of the excavation is 7 feet. The
footings extend 1 foot outside of the foundation walls,
and a 3-foot space between the footing and the sides of
the excavation must be provided to form the footings.
The soil is excavated at a 1:1 (horizontal:vertical) slope.
Express your answer in cubic yards.

4. Using the geometric method, determine the amount of
excavation required for the basement in Figure 16-13.
The basement measurements are from the outside of
the foundation walls. The average depth of the excava-
tion is 6 feet. The footings extend 1 foot outside of the
foundation walls, and a 2-foot space between the foot-
ing and the sides of the excavation must be provided to
form the footings. The soil is excavated at a 1.5:1 (hori-
zontal:vertical) slope. Express your answer in cubic
yards.

5. Solve Problem 3 using the average-width-length-depth
method.

6. Solve Problem 4 using the average-width-length-depth
method.

7. Solve Problem 3 using the average-end method.

8. Solve Problem 4 using the average-end method.

9. Solve Problem 3 using the modified-average-end method.

10. Solve Problem 4 using the modified-average-end
method.

11. Solve Problem 3 using the cross-sectional method.

12. Solve Problem 4 using the cross-sectional method.

13. Using the average-end area method, determine the re-
quired excavation for a new road given the stations and
their associated cut areas shown in Table 16-5. Express
your answer in cubic yards.

14. Using the average-end area method, determine the re-
quired volume of the cuts and fills for a new road given
the stations and their associated cut and fill areas shown
in Table 16-6. Express your answer in cubic yards.

15. Determine the volume of backfill needed for the base-
ment in Problem 3. The footing height is 12 inches. Use
the excavation quantities from Problem 3.

16. Determine the volume of backfill needed for the base-
ment in Problem 4. The footing height is 12 inches. Use
the excavation quantities from Problem 4.

17. The soils in Problem 15 have a bank dry unit weight of
105 pounds per cubic foot, a loose dry unit weight of 80
pounds per cubic foot, and a compacted dry unit weight
of 110 pounds per cubic foot. Determine the volume of
the soils that needs to be exported.

TABLE 16-5 Cuts for Problem 11

Station Cut (ft2)

0 00� 0

0 50� 235

1 00� 475

1 50� 232

2 00� 52

2 25� 0

FIGURE 16-13 Basement Plan
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18. The soils in Problem 16 have a swell percentage of 25%
and a shrinkage percentage of 8%. Determine the vol-
ume of the soils that needs to be exported.

19. For the site plan in Figure 16-14, determine the total vol-
ume of the cuts, the total volume of the fills, and the vol-
ume of the import or export using the cross-sectional

method. The grids are 50 feet apart in both directions.
The existing grade appears above the proposed grade.
Express your answer in cubic yards. The shrinkage per-
centage is 5% and the swell percentage is 28%.

20. Determine the excavation and backfill needed for the
Johnson Residence given in Appendix F. Assume that a
3-foot space between the footing and the sides of the ex-
cavation must be provided to form the footings. The
sides are excavated at a 1:1 (horizontal:vertical) slope.

21. Determine the excavation and backfill needed for the
West Street Video project given in Appendix F. Assume
that a 1-foot space between the footing and the sides of
the excavation must be provided to form the footings.
The sides are excavated at a 0.5:1 (horizontal:vertical)
slope.

22. Determine the under-slab gravel needed for the West
Street Video project given in Appendix F.

TABLE 16-6 Cuts and Fills for Problem 12

Station Cut (ft2) Fill (ft2)

0 00� 0 0

0 50� 175 10

1 00� 250 45

1 50� 75 225

2 00� 0 450

2 25� 0 0

FIGURE 16-14 Site Plan
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In this chapter you will learn how to apply the principles in
Chapter 4 to exterior improvements including asphalt, site con-
crete, and landscaping. This chapter includes a sample spread-
sheet that may be used in the quantity takeoff.

Exterior improvements includes base, flexible and
ridged paving, curbs and gutters, fences, athletic sur-
faces, retaining walls, bridges, irrigation systems, and

landscaping. In this chapter we limit the discussion of exte-
rior improvements to asphalt and base, site concrete, and
landscaping. We begin by looking at asphalt and base.

ASPHALT AND BASE
Asphalt and base are bid by the ton. The volume of asphalt
and base is determined by multiplying the area of the asphalt
or base by the depth of the asphalt or base. The density of the
asphalt or base is used to convert the volume to tons as
shown in the following example.

EXAMPLE 17-1

Determine the tons of asphalt and base required to complete the
parking lot in Figure 17-1. The base has an average thickness of
8 inches and a density of 125 pounds per cubic foot. The asphalt
has an average thickness of 3.5 inches and a density of 150 pounds
per cubic foot. The curb and gutter is 30 inches wide and has an in-
side radius of 5 feet.

Solution: The area of the parking lot will be divided into four
areas: the large main area, the drive, and the two small pieces next
to the radius of the curb and gutter. The main area is 151 feet long
(156 ft � 30 in � 30 in) by 62 feet wide (67 ft � 30 in � 30 in). The
drive is 25 feet wide by 13.5 feet long (11 ft � 30 in). The outside
radius (R) of curb and gutter is 7.5 feet (5 ft � 30 in). The small
areas next to the radius of the curbs are each equal to a square less a
quarter circle. The areas are calculated as follows:

AreaTotal � 9,362!ft2 � 338!ft2 � 24!ft2 � 9,724!ft2

AreaCurves � 2 cR2a1 �
�

4
b d � 2 c (7.5!ft)2a1!�

�

4
b d � 24!ft2

AreaDirve � (25!ft)(13.5!ft) � 338!ft2

AreaMain � (151!ft)(62!ft) � 9,362!ft2

EXTERIOR

IMPROVEMENTS

CHAPTER SEVENTEEN

FIGURE 17-1 Parking Lot Layout
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FIGURE 17-2 Curb Cross Section

The volume of base and asphalt needed is calculated as follows:

The tons of base and asphalt needed are calculated as follows:

�WeightAsphalt � (2,836!ft3)a150!lb

ft3 ba 1!ton

2,000!lb
b � 213!tons

WeightBase � (6,483!ft3)a125!lb

ft3 ba 1!ton

2,000!lb
b � 405!tons

VolumeAsphalt � (9,724!ft2)(3.5!in)a 1 ft

12!in
b � 2,836!ft3

VolumeBase � (9,724!ft)(8!in)a 1!ft

12!in
b � 6,483!ft3

Solution: The length of curb and gutter needed for each side of the
entry is equal to 11 feet minus the inside radius (5 ft) of the curb and
gutter, or 6 feet. The length of the curb and gutter on the north and
south sides is 156 feet. The length of the curb and gutter on the east
end is 67 feet less twice the width of the curb and gutter, or 62 feet
(67 ft � 30 in � 30 in). This reduction in length is necessary to
avoid double counting the corners. The length of the curb and gut-
ter needed on the west ends is 13.5 feet less the width of the curb and
gutter, or 11 feet each. The length of the curved portion of the gutter
is based on the radius (R) of the centerline (average of the inside and
outside radius), or 6.25 feet (5 ft>2 � 7.5 ft>2). The length of one of
the curved portions of the curb and gutter is calculated as follows:

The total length of curve (clockwise from the driveway) is calcu-
lated as follows:

The cross-sectional area of the curb is calculated as follows:

The volume of concrete is calculated as follows:

The lengths of the forms needed to form the outside and the inside
of the curb and gutter are calculated as follows:

�

LANDSCAPING
Landscaping includes providing and grading topsoil; provid-
ing an underground sprinkler system; and planting seed, sod,
and plants. Providing topsoil is bid by the cubic yard, with the
volume of topsoil being determined by the area times the
thickness. The finish grading of the topsoil is bid based on
the area. The underground sprinkler system is most often
placed using a trenching machine to dig a narrow trench in
which the pipe is placed. The trenching is bid based on the
length of the trench, and the sprinkler system is bid based on
the same principles used to determine the components of a
plumbing system. Sod and seed are bid based on the area, and

LengthInside � 422!ft

� 151!ft � 11!ft!�
2�(7.5!ft)

4
� 6!ft

LengthInside � 6!ft �
2�(7.5!ft)

4
� 11!ft � 151!ft � 62!ft

LengthOutside � 434!ft

� 156!ft � 13.5!ft �
2�(5!ft)

4
� 6!ft

LengthOutside � 6!ft �
2�(5!ft)

4
� 13.5!ft � 156!ft � 67!ft

Volume � (428!ft)(1.58!ft2)a 1!yd3

27!ft2b � 25.0!yd3

� 1.58!ft2

Area � c (6!in)(12!in) � (24!in)
(6!in � 7!in)

2
d a 1!ft2

144!in2b

Length � 428!ft

� 11!ft � 10!ft � 6!ft

Length � 6!ft � 10!ft � 11!ft � 156!ft � 62!ft � 156!ft

Length �
2�R

4
�

2�(6.25)

4
� 10 ft

EXCEL QUICK TIP 17-1

Asphalt or Base

The tons of asphalt or base needed for an area is set up in
a spreadsheet by entering the data and formatting the
cells as follows:

The following formula needs to be entered in Cell B5:

=B1*(B2/12)*B3/2000

The data for asphalt or base is entered in Cells B1 through
B3. The data shown in the foregoing figure is for the as-
phalt from Example 17-1.

A B C
1 Area 9,723 sft
2 Thickness 3.50 in
3 Density 150 lb/cft
4
5 Weight 212.69 tons

SITE CONCRETE
Site concrete is bid using the same principles as for building
concrete. The quantity takeoff of site concrete is shown in
the following example.

EXAMPLE 17-2

Determine the quantity of concrete and lineal footage of form
needed for the parking lot in Figure 17-1. The cross section of the
curb is shown in Figure 17-2.



TABLE 17-1 Quantities for Residential Garage

32-110 Site
Concrete—Labor

32-120 Site
Concrete—Concrete

32-900
Landscaping

Form driveway 54 ft

Screed 27 ft

Pour driveway 5.9 cyd

Finish driveway 479 sft

Form sidewalk 37 ft

Pour sidewalk 1.6 cyd

Finish sidewalk 132 sft

10� expansion joint 5 ea

Driveway 5.9 cyd

Sidewalk 1.6 cyd

Sod Repair 291 sft
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plants are bid as a counted item. The quantity takeoff for
landscaping is shown in the following example.

EXAMPLE 17-3

The planter shown in Figure 17-3 requires 2 inches of topsoil.
Determine the topsoil and landscaping plants required to complete
the planter. The dimensions are measured to the outside of a 6-inch-
wide curb.

Solution: The area of the planter consists of one rectangle 124 feet
(130 ft � 2 � 3 ft) long and 5 feet (6 ft � 2 � 6 in) wide and two
half circles with a radius of 2.5 feet (3 ft � 6 in). The area is calcu-
lated as follows:

The volume of topsoil is calculated as follows:

The number of flowering dogwood trees is five. The number of
Boston ivy is calculated as follows:

�

SAMPLE TAKEOFF FOR THE
RESIDENTIAL GARAGE
A sample takeoff for site improvements from a set of plans is
shown in the following example.

EXAMPLE 17-4

Determine the site concrete and landscaping needed to complete
the residential garage in Appendix F.

Solution: The site concrete consists of the driveway and the side-
walk. The area and volume of concrete needed for the driveway are
calculated as follows:

Volume � (479!ft2)
(4!in)

(12!in\ft)
a 1!yd2

27!ft2b � 5.9!yd3

Area � (18!ft)(26!ft!7!in) � 479!ft2

Number � (640 ft2)a 1 ea

4 ft2b � 160 each

Volume � (640 ft2)
(2 in)

(12!in/ft)
a 1 yd3

27 ft3b � 4 yd3

Area � (124 ft)(5 ft) �
2�(2.5 ft)2

2
� 640 ft2

The driveway will require forms on the north and south side for a
total of 54 feet of forms. In addition, a 27-foot-long screed will
need to be set up in the middle of the driveway. There is 33 feet
(26 ft � 4 ft � 3 ft) of 4-foot-wide sidewalk. The area and volume
of concrete needed for the sidewalk are calculated as follows:

The sidewalk will require 37 feet (26 ft � 4 ft � 4 ft � 3 ft) of
forms. Expansion joints are required between the driveway and the
garage and the sidewalk and the garage, requiring 47 feet (18 ft � 3 ft
� 26 ft) of expansion joint, or five 10-foot-long pieces.

The landscaping will consist of landscape repair around the
garage. For this we allow for an area 2 feet wide to be repaired.
Beginning at the top left and going clockwise around the garage, we
calculate the area of landscape repair as follows:

The quantities needed for the garage, grouped by the cost codes in
Appendix B, are shown in Table 17-1. �

� 291!ft2

� 4!ft � 26!ft � 4!ft � 7!ft � 24!ft!7!in)

Area � (2!ft)(26!ft!7!in � 3!ft � 26!ft � 24!ft

Volume � (132!ft2)
(4!in)

(12!in\ft)
a 1!yd2

27!ft2b � 1.6!yd3

Area � (33!ft)(4!ft) � 132!ft2

FIGURE 17-3 Landscaping Plan
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CONCLUSION
Asphalt and base are bid by the ton, which is determined by
calculating the volume and multiplying it by the density of
the asphalt or base. Site concrete is bid in the same way as
building concrete. Topsoil is bid by the cubic yard; grading,
seeding, and sod are bid by the square foot; plants are bid as
a counted item; trenching is bid by the foot; and a sprinkler
system is bid using the same principles used to bid plumbing
systems.

PROBLEMS
1. Determine the number of tons of base required to com-

plete 1,000 feet of road 22 feet wide. The base has a
compacted weight of 125 pounds per cubic foot and is
12 inches thick.

2. Determine the number of tons of asphalt required to
complete 1,000 feet of road 22 feet wide. The asphalt has
a compacted weight of 145 pounds per cubic foot and
is 4 inches thick.

3. How many cubic yards of concrete are required to con-
struct an 80-foot by 5-foot by 4-inch-thick concrete
sidewalk? Include 8% waste. Concrete must be ordered
in quarter-yard increments.

4. Determine the number of tons of base required to com-
plete the parking lot in Figure 17-4. The base has an av-
erage thickness of 8 inches and a density of 115 pounds
per cubic foot. The curb is 6 inches wide and has an in-
side radius of 5 feet.

5. Determine the number of tons of asphalt required to
complete the parking lot in Figure 17-4. The asphalt has
an average thickness of 3 inches and a density of 145
pounds per cubic foot. The curb is 6 inches wide and
has an inside radius of 5 feet.

6. Determine the volume of concrete needed to complete
the curb in Figure 17-4. The curb is 6 inches wide by
18 inches high. Include 10% waste. Concrete must be
ordered in quarter-yard increments.

7. Determine the number of tons of base required to com-
plete the parking lot in Figure 17-5. The base has an av-
erage thickness of 6 inches and a density of 120 pounds
per cubic foot. The curb is 6 inches wide and has an in-
side radius of 5 feet.

8. Determine the number of tons of asphalt required to
complete the parking lot in Figure 17-5. The asphalt
has an average thickness of 2.5 inches and a density of
150 pounds per cubic foot. The curb is 6 inches wide
and has an inside radius of 5 feet.

9. Determine the volume of concrete needed to complete
the curb in Figure 17-5. The curb is 6 inches wide by
18 inches high. Include 6% waste. Concrete must be
ordered in quarter-yard increments.

10. The site shown in Figure 17-6 requires 4 inches of top-
soil. The bark is 2 inches thick. Determine the topsoil,
bark, and landscaping plants required to complete the
planter.

11. The site shown in Figure 17-7 requires 2 inches of top-
soil. Forty-five percent of the planter is covered with
pansies. Determine the topsoil and landscaping plants
required to complete the planter.

FIGURE 17-4 Parking Lot Layout
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FIGURE 17-6 Landscaping Plan

FIGURE 17-5 Parking Lot Layout

12. Determine the number of tons of asphalt and base re-
quired to complete the West Street Video project given
in Appendix F. The asphalt has a density of 145 pounds
per cubic foot and the base has a density of 130 pounds
per cubic foot.

13. Determine the site concrete needed to complete the
West Street Video project given in Appendix F.

14. Determine the landscaping needed to complete the
West Street Video project given in Appendix F.

15. Set up Excel Quick Tip 17-1 in Excel.
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FIGURE 17-7 Landscaping Plan
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UTILITIES

CHAPTER EIGHTEEN

In this chapter you will learn how to apply the principles in
Chapter 4 to utilities including sanitary sewers, water lines,
storm drains, gas lines, underground power lines, and tele-
phone lines. This chapter includes sample spreadsheets that
may be used in the quantity takeoff.

Underground utilities are often placed in a similar
manner, whether they are sanitary sewers, water
lines, storm drains, gas lines, underground power

lines, or telephone lines. They all consist of piping or cable
placed in an underground trench. The lines may also include
such features as manholes, boxes, and so forth. The work of
placing underground utilities may be divided into four basic
components: excavation, placement of bedding material (if
required), placement of the utility line, and backfill. Let’s
begin by looking at excavation.

EXCAVATION
Excavation for manholes, boxes, and other such items is cal-
culated in the same manner as excavation for a footing.

A typical utility trench is shown in Figure 18-1. The
sides of utility trenches often consist of a vertical component
(in this case with a constant height of dv) and a sloped com-
ponent with a slope of S horizontal feet per vertical foot. The
sides of the trench are sloped to prevent cave-in and to meet
safety regulations. The height of the sloped component of
the sides of the trench varies as the depth of the trench
varies. The height dv and the slope of the sidewalls S are set
by safety regulations and the soil conditions.

The volume of excavation may be estimated by the
average-end method or the modified-average-end method
presented in Chapter 16. As previously stated, the average-
end method often understates the volume. The use of the
average-end method to calculate the volume of excavation is
shown in the following example.

EXAMPLE 18-1

A utility contractor is to install the sewer line whose plan and pro-
file are shown in Figure 18-2. The trench is to have the cross section
shown in Figure 18-3. Using the average-end method, determine
the volume of excavation in cubic yards needed to install the sewer
line. The excavation for the manhole is to be 6 feet by 6 feet and
2 feet deeper than the flow line at the manhole.

Solution: The depth of excavation at either manhole equals the el-
evation of the rim less the flow line (FL) of the sewer line plus the
distance between the flow line and the bottom of the trench. The
depth of excavation (d1) at Station 14�30.20 and the depth of ex-
cavation (d2) at Station 15�80.20 are calculated as follows:

At Station 14�30.20 the trench wall begins to slope at 4.82 feet
(7.82 ft � 3 ft) below the top of the trench and widens each side of
the trench by 3.62 feet (0.75 � 4.82 ft). At Station 15�80.20 the
trench wall begins to slope at 0.33 feet (3.33 ft � 3 ft) below the
top of the trench and widens each side of the trench by 0.25 feet

d2 � 1,146.71!ft � 1,143.88!ft � 0.50!ft � 3.33!ft

d1 � 1,148.20!ft � 1,140.88!ft � 0.50!ft � 7.82!ft

FIGURE 18-1 Typical Trench
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FIGURE 18-2 Sewer Line Plan and Profile

FIGURE 18-3 Sewer Line Cross Section

FIGURE 18-4 Trench Cross Sections

(0.75 0.33 ft). The cross sections for the end of the trenches are
shown in Figure 18-4.

The area of the end of the trench (Area1) at Station 14�30.20
and the area of the end of the trench (Area2) at Station 15�80.20

�

are calculated as follows:

The volume of excavation required for the trench is calculated
using Eq. (16-16) as follows:

The depth of the manhole is calculated as follows:

The volume of manhole excavation is calculated using the volume
of column as follows:

A small amount of the calculated quantity of excavation for the
manhole is also included in the calculated quantity for the trench.
The total excavation is 117 cubic yards (111 YD3 � 6 YD3). �

Volume � (6!ft)(6!ft)(4.83!ft)a 1!yd3

27!ft3b � 6!yd3

d � 1,146.71!ft � 1,143.88!ft � 2.00!ft � 4.83!ft

Volume � (150!ft) c (33.1!ft2 � 6.7!ft2)

2
d a 1!yd3

27!ft3b � 111!yd3

Area2 � (2!ft)(3.33!ft) �
2(0.33!ft)(0.25!ft)

2
� 6.7!ft2

Area1 � (2!ft)(7.82!ft) �
2(4.82!ft)(3.62!ft)

2
� 33.1!ft2
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The modified-average-end method often produces a more
accurate answer but may also overstate the quantity. The use
of the modified-average-end method to calculate the volume
of excavation is shown in the following example.

EXAMPLE 18-2

Solve Example 18-1 using the modified-average-end method.

Solution: From Example 18-1, excavation volume for the manhole is
6 cy3 and the end areas are 33.1 ft2 and 6.7 ft2. The volume of excava-
tion required for the trench is calculated using Eq. (16-18) as follows:

A small amount of the calculated quantity of excavation for the
manhole is also included in the calculated quantity for the trench.
The total excavation is 107 cubic yards (101 yd3 � 6 yd3). �

Volume � 101!yd3

� a 1!yd3

27!ft3b
Volume � (150!ft)a33.1!ft2 � 6.7!ft2 � 2(33.1!ft2)(6.7!ft2)

3
b

A more accurate volume may be obtained by determin-
ing the volume of the geometric shape of the trench. This is
done for the trench in Figure 18-1 by using the following
equation:

(18-1)

where

L � Length of the Trench

W � Width of the Trench at the Bottom

d1 � Depth at One End of the Trench

d2 � Depth at the Other End of the Trench

dv � Depth of the Vertical Trench Wall

S � Slope of the Trench Walls

This equation is based on five assumptions. First, the
width at the bottom of the trench is constant. Second, the
height of the vertical sidewall of the trench is constant.
Third, the height of the vertical sidewall is less than or equal
to the depth at both ends (dv d1 and dv d2). Fourth, the
slope of the sloped sidewalls is constant and, as a result, as
the trench gets deeper, the width of the trench at the surface
increases. Fifth, the change in depth of the trench is uniform
over the length of the trench; therefore, the depth may be ex-
pressed as a linear function of the distance from one end of
the trench to the other. The use of Eq. (18-1) is shown in the
following example.

EXAMPLE 18-3

Solve Example 18-1 using Eq. (18-1).

		

L cW (d1 � d2)

2
� S

(d2
1 � d1d2 � d2

2 � 3d2
v � 3d1dv � 3d2dv)

3
d

Volume �

EXCEL QUICK TIP 18-2

Trench Excavation Using
Modified-Average-End Method

The volume of trench excavation using the modified-
average-end method is set up in a spreadsheet by enter-
ing the data and formatting the cells as follows:

The following formula needs to be entered in Cell B8:

=B1*(B2*B3+IF(B5>B3,0,B6*(B3-B5)^2)

+B2*B4+IF(B5>B4,0,B6*(B4-B5)^2)

+((B2*B3+IF(B5>B3,0,B6*(B3

-B5)^2))*(B2*B4+IF(B5>B4,0,B6*

(B4-B5)^2)))^0.5)/(3*27)

The data for the trench is entered in Cells B1 through
B6. The data shown in the foregoing figure is from
Example 18-2.

A B C
1 Length of Trench 150 ft
2 Width of Trench Bottom 2.00 ft
3 Depth at One End 7.82 ft
4 Depth at Other End 3.33 ft
5 Depth of Vertical Wall 3.00 ft
6 Slope of Trench Walls 0.75 ft:ft
7
8 Volume 101 cyd

EXCEL QUICK TIP 18-1

Trench Excavation Using Average-End Method

The volume of trench excavation using the average-end
method is set up in a spreadsheet by entering the data and
formatting the cells as follows:

The following formula needs to be entered in Cell B8:

=B1*(B2*B3+IF(B5>B3,0,B6*(B3-B5)^2)

+B2*B4+IF(B5>B4,0,B6*(B4-B5)^2))/

(2*27)

The data for the trench is entered in Cells B1 through
B6. The data shown in the foregoing figure is from
Example 18-1.

A B C
1 Length of Trench 150 ft
2 Width of Trench Bottom 2.00 ft
3 Depth at One End 7.82 ft
4 Depth at Other End 3.33 ft
5 Depth of Vertical Wall 3.00 ft
6 Slope of Trench Walls 0.75 ft:ft
7
8 Volume 111 cyd
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Solution: From Example 18-1 the depths of excavation at the
manholes are 7.82 feet and 3.33 feet. The volume of excavation re-
quired for the trench is calculated using Eq. (18-1) as follows:

From Example 18-1, the volume of excavation for the manhole is
6 cubic yards, bringing the total excavation volume to 103 cubic
yards (97 yd3 � 6 yd3). �

� 97!yd3

� 3(7.82!ft)(3!ft) � 3(3.33!ft)(3!ft) d ^3 f a 1!yd3

27!ft3b
� (7.82!ft)(3.33!ft) � (3.33!ft)2 � 3(3!ft)2!

Volume � (150!ft) e(2!ft)
(7.82!ft � 3.33!ft)

2
� 0.75 c (7.82!ft)2

BEDDING
Often underground pipes are placed on a bedding material,
such as gravel or sand, which provides a place for the pipe to
rest in and may even surround the pipe. These two conditions
are shown in Figure 18-5. The volume of bedding material is
determined by calculating the cross-sectional area of the bed-
ding material and multiplying it by the length of the pipe.
Bedding material is also placed below manholes and boxes.

For pipe sitting on the bedding material, the angle a is
determined by the following equation:

(18-2)

where

Y � Depth of the Pipe in the Bedding

DP � Outside Diameter of the Pipe

The quantity of bedding is estimated using Eq. (18-3) if
the angle a is measured in radians and Eq. (18-4) if the angle
a is measured in degrees:

(18-3)

(18-4)

where

W � Width of the Trench at the Bottom

DB � Depth of the Bedding

a � Angle from Eq. (18-2)

DP � Outside Diameter of the Pipe

L � Length of the Trench

For pipes barely in the bedding material, the area of the
pipe is often ignored. The calculation of bedding material
for a pipe partially buried in the bedding material is shown
in the following example.

Volume � eW(DB) �
32�a>360 � (sin a)(cos a)4

4
(DP)2fL

Volume � eW(DB) �
3a � (sin!a)(cos!a) 4

4
(DP)2 fL

a � cos�1 a1 �
2Y

DP
b

FIGURE 18-5 Bedding Conditions

EXCEL QUICK TIP 18-3

Trench Excavation Using Eq. (18-1)

The volume of trench excavation using Eq. (18-1) is set
up in a spreadsheet by entering the data and formatting
the cells as follows:

The following formula needs to be entered in Cell B8:

=IF(B5>B3,“ERROR”,IF(B5>B4,“ERROR”,

B1*(B2*(B3+B4)/2+B6*(B3^2+B3*B4+B4^2

+3*B5^2-3*B3*B5-3*B4*B5)/3)/27))

The use of the nested IF statements will display the word
“ERROR” in Cell B8 should the depth of the vertical wall
be greater than the depth at one of the ends. The data for
the trench is entered in Cells B1 through B6. The data
shown in the foregoing figure is from Example 18-3.

A B C
1 Length of Trench 150 ft
2 Width of Trench Bottom 2.00 ft
3 Depth at One End 7.82 ft
4 Depth at Other End 3.33 ft
5 Depth of Vertical Wall 3.00 ft
6 Slope of Trench Walls 0.75 ft:ft
7
8 Volume 97 cyd
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EXAMPLE 18-4

The pipe in Example 18-1 is bedded in gravel. The depth of the
gravel is 1 foot, and the pipe is bedded into the gravel 6 inches. The
outside diameter of the sewer pipe is 11 inches. Ignoring the man-
hole, determine the quantity of gravel needed for the sewer line.

Solution: Find the angle a in radians using Eq. (18-2) as follows:

The volume of bedding needed for the pipe is calculated using
Eq. (18-4) as follows:

�� 9!yd3

� c 11!in

(12!in/ft)
d 2 f (150!ft)a 1!yd3

27!ft3b
Volume � e(2!ft)(1!ft) �

31.66 � (sin 1.66)(cos 1.66) 4
4

a � cos�1 c 1 �
2(6!in)

11!in
d � 1.66!radians

DP � Outside Diameter of the Pipe

L � Length of the Trench

For bedding below manholes and boxes, the quantity of
bedding is calculated using one of the excavation methods
from Chapter 16. The calculation of bedding material is
shown in the following example.

EXAMPLE 18-5

The pipe in Example 18-1 is surrounded by gravel. The depth of the
gravel is 2 feet. The outside diameter of the sewer pipe is 11 inches.
Twelve inches of bedding is also placed below the manhole.
Determine the quantity of gravel needed for the sewer line.

Solution: The volume of bedding needed for the pipe is calculated
using Eq. (18-5) as follows:

The volume of bedding needed for the manhole is calculated using
the volume of a column as follows:

The total volume needed is 20 cubic yards. �

Volume � (6!ft)(6!ft)(1!ft)a 1!yd3

27!ft3b � 1.3!yd3

� 18.6!yd3

Volume � e(2!ft)(2!ft) �
�

4
c 11!in

(12!in/ft)
d 2 f (150!ft)a 1!yd3

27!ft3b

EXCEL QUICK TIP 18-4

Bedding Volume for Pipe Resting on Bedding

The volume of bedding using Eqs. (18-2) and (18-3) is set
up in a spreadsheet by entering the data and formatting
the cells as follows:

The following formulas need to be entered in the associ-
ated cells:

A B C
1 Width of Trench 2.00 ft
2 Depth of Bedding 1.00 ft
3 Depth of Pipe in Bedding 6.00 in
4 Diameter of Pipe 11.00 in
5 Length of Pipe 150 ft
6
7 Angle a 1.66 rad
8 Volume 9.1 cyd

Cell Formula

B7 =ACOS(1-2*B3/B4)

B8 =(B1*B2–(B7–SIN(B7)*COS(B7))*

(B4/12)^2/4)*B5/27

The data for the pipe and bedding is entered in Cells B1
through B5. The data shown in the foregoing figure is
from Example 18-4.

For pipe surrounded by bedding material, the quantity of
bedding material is estimated using the following equation:

(18.5)

where

W � Width of Trench at the Bottom

DB � Depth of the Bedding

Volume � cW(DB) �
�

4
(DP)2 dL

EXCEL QUICK TIP 18-5

Bedding Volume for Pipe Surrounded by Bedding

The volume of bedding using Eq. (18-5) is set up in a
spreadsheet by entering the data and formatting the cells
as follows:

The following formula needs to be entered in Cell B6:

=IF(B3/12>B1, “ERROR”,IF(B3/12>B2,

“ERROR”,

(B1*B2-PI()*(B3/12)^2/4)*B4/27))

The use of the nested IF statements will display the word
“ERROR” in Cell B6 should the diameter of the pipe ex-
ceed the width of the trench or the depth of bedding. The
data for pipe and bedding is entered in Cells B1 through
B4. The data shown in the foregoing figure is from

A B C
1 Width of Trench 2.00 ft
2 Depth of Bedding 2.00 ft
3 Diameter of Pipe 11.00 in
4 Length of Pipe 150 ft
5
6 Volume 18.6 cyd

UTILITY LINES
The quantities of utility components (such as pipe, man-
holes, valves, conduit, wire, and so forth) needed for the
utility line are calculated in the same manner as plumbing
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CONCLUSION
Underground utilities consist of the excavation, placement
of bedding material (if required), placement of the utility
line, and backfill. The quantity of excavation may be calcu-
lated by the average-end method, the modified-average-end
method, or Eq. (18-1). The quantity of bedding for pipes
partially surrounded by bedding is calculated using Eq. (18-2)
through (18-4), and the quantity of bedding for pipe fully
surrounded by bedding is calculated using Eq. (18-5). The
components of the utility lines are calculated in the same
manner as plumbing and electrical components are calcu-
lated. The quantity of backfill needed equals the quantity of
excavation less the quantity of backfill less the volume of the
utility lines.

PROBLEMS
1. An 18-inch-wide by 3-foot-deep trench is dug in the

ground and a water line with a 3.5 inch outside diame-
ter is placed in the trench. The water line is placed on
6 inches of bedding, and bedding surrounds the pipe to
a height of 2.5 inches above the water line. The length of
the trench is 500 feet. Determine the volume of excava-
tion needed for the water line.

2. How much bedding is needed for Problem 1?

3. The water line in Problem 1 is constructed of 20-foot-
long pipes with a bell and gasket on one end. How many
pieces of pipe are needed?

4. How much backfill is needed for the water line in
Problem 1?

5. A utility contractor is to install the sewer line whose
plan and profile are shown in Figure 18-6. The trench is
to have the cross section shown in Figure 18-7. Using
the average-end method, determine the volume of exca-
vation in cubic yards needed to install the sewer line.
The excavation for the manhole is to be 6 feet by 6 feet
and 2 feet deeper than the flow line at the manhole.

6. Solve Problem 5 using the modified-average-end method.

7. Solve Problem 5 using Eq. (18-1).

8. The pipe in Problem 5 is bedded in gravel. The depth of
the gravel is 1 foot, and the pipe is bedded into the
gravel 3 inches. The outside diameter of the sewer pipe
is 9 inches. Ignoring the manhole, determine the quan-
tity of gravel needed for the sewer line.

9. The pipe in Problem 5 is surrounded by gravel. The
depth of the gravel is 18 inches. The outside diameter of
the sewer pipe is 9 inches. Twelve inches of bedding is
also placed below the manhole. Determine the quantity
of gravel needed for the sewer line.

10. Determine the utility components needed for the sewer
line in Problem 5. The pipe is available in 20-foot
lengths and includes a bell with a gasket at one end.

11. Using the excavation volume from Problem 7 and the
bedding quantity from Problem 9, determine the vol-
ume of backfill for the sewer line in Problem 5. The
manhole has an outside diameter of 4 feet and its bot-
tom is 1 foot below the flow line.

and electrical components were calculated. The quantity
takeoff for utility components is shown in the following
example.

EXAMPLE 18-6

Determine the utility components needed for the sewer line in
Example 18-1. The pipe is available in 20-foot lengths and includes
a bell with a gasket at one end.

Solution: The new manhole will require a 3-foot-high manhole
base with a hole and gasket for the sewer pipe, a flat manhole top, a
metal ring, and a manhole cover. Eight ( ) sections of
20-foot-long pipe are needed. The existing manhole will need to be
core drilled for the new pipe, and the pipe will need to be sealed
with a gasket or concrete. �

BACKFILL
The quantity of backfill is determined by subtracting the
volume of bedding and the volume of the utility compo-
nents from the excavation volume. When determining the
quantity of material that must be exported or imported, the
estimator must take into account shrink and swell, as dis-

150!ft>20!ft

cussed in Chapter 16, and whether the excavated material
can be used as backfill. The volume of backfill is shown in
the following example.

EXAMPLE 18-7

Using the excavation volume from Example 18-3 and the bedding
quantity from Example 18-5, determine the volume of backfill for
the sewer line in Example 18-1. The manhole has an outside diam-
eter of 4 feet and its bottom is 1 foot below the flow line.

Solution: From Example 18-3, the volume of excavation is 103
cubic yards. From Example 18-4, the volume of bedding is 20 cubic
yards. The volume of the pipe is calculated as follows:

The height of the manhole is 3.83 feet, and it has a radius of 2 feet.
The volume of the manhole is calculated as follows:

The volume of the backfill is calculated as follows:

�Volume � 103!yd3 � (20!yd3 � 4!yd3 � 2!yd3) � 77!yd3

Volume � �(2!ft)2(3.83!ft)a 1!yd3

27!ft3b � 2!yd3

Volume �
�

4
c 11!in

(12!in/ft)
d 2(150!ft)a 1!yd3

27!ft3b � 4!yd3
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12. Determine the quantities of excavation, bedding mater-
ial, utility components, and backfill needed for the
Johnson Residence given in Appendix F.

13. Determine the quantities of excavation, bedding mater-
ial, utility components, and backfill needed for the West
Street Video project given in Appendix F.

14. Set up Excel Quick Tip 18-1 in Excel.

15. Set up Excel Quick Tip 18-2 in Excel.

16. Set up Excel Quick Tip 18-3 in Excel.

17. Set up Excel Quick Tip 18-4 in Excel.

18. Set up Excel Quick Tip 18-5 in Excel.

FIGURE 18-7 Sewer Line Cross Section

FIGURE 18-6 Sewer Line Plan and Profile
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I
n this section, you will learn how to put costs to the estimate, including
how to price materials, labor, and equipment. You will also learn to calcu-
late markups and how to check for errors in the estimate. In Chapter 26

you will see how to apply these principles to the residential garage given in
Appendix F.
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PUTTING COSTS 
TO THE ESTIMATE
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In this chapter you will learn how to determine material pric-
ing. Material costs include the cost of the materials, shipping
costs, sales tax, storage costs, and escalation allowance.
Material pricing can be obtained from suppliers, historical
data, and national reference books.

The best way to determine pricing for materials is to
obtain current pricing from suppliers. This is done
by sending information on the quantity of materials

needed to the supplier for pricing. Sometimes the supplier
will do the quantity takeoff for you; however, when you have
the supplier perform the quantity takeoff, you must make
sure that the supplier is guaranteeing that there are sufficient
quantities to perform the work. If the supplier does not
guarantee that there are sufficient quantities, you should
perform your own quantity takeoff to verify that there are
sufficient quantities of materials to complete the work.
Supplier pricing can be obtained by sending the supplier a
Request for Materials Quote, such as the one shown in
Figure 19-1, or by calling for pricing. It is usually better to
get written pricing than a telephone quote because there is
less of a chance that there will be a misunderstanding. When
you receive a telephone quote, you should document it on a
phone quote sheet such as the one shown in Figure 2-4.

In Figure 19-1, two columns are used for the quantity.
The left column is used for the numeric portion of quantity
(for example, 23, 56, and so forth) and the right column is
used for units (for example, ft, cyd, miles, and so forth). The
total cost for each item equals the numeric portion of the
quantity multiplied by the cost per unit. This calculation is
expressed by the following equation:

(19-1)

Another way to obtain current pricing from suppliers is
to set up contracts for materials with them. For example, you
may set up an annual contract with a hardware supplier to

Cost � (Quantity)(Cost!per!Unit)

supply residential door and bathroom hardware at a set unit
price for a period of one year. You may then use these prices
on all jobs that you bid during the year. One advantage of
annual contracts is that suppliers often give better pricing
because the contractor is committing to buy a large quantity
of materials over the course of the year.

The next best way to determine pricing is to price ma-
terials based on historical costs. Historical costs may be
obtained by determining past costs from the accounting
system or by looking at previous materials invoices.
Determining historical costs based on data from the ac-
counting system is done by determining the material cost
for a certain quantity of work and dividing it by the quan-
tity of work performed. This calculation is performed by
solving Eq. (19-1) for cost per unit and is expressed by the
following equation:

(19-2)

EXAMPLE 19-1

A recent project included 1,235 square feet of 4-inch-thick side-
walk. The cost of the concrete materials for the sidewalk was
$1,372. Determine the material cost for 1 square foot of sidewalk.

Solution: The material cost per square foot is determined by using
Eq. (19-2) as follows:

�

For historical data to be accurate, the actual project
costs and quantities must be accurately tracked in the ac-
counting system. Poor tracking of costs or failure to update
changes in the quantities will render the data useless.

The other method of determining historical cost is to
look at previous invoices to see what prices the company has
been paying. When looking at previous invoices one should

Material!Cost �
$1,372

1,235!ft2 � $1.111˛/˛ft2

Cost!per!Unit �
Cost

˛Quantity
˛

MATERIAL PRICING

CHAPTER NINTEEN
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FIGURE 19-1 Request for Materials Quote

use the most current invoices from a job with equivalent
specifications and similar quantities.

The least accurate source of data is national standards
books. Material prices vary greatly around the country. As a
result, national standard books should only be used as a last
resort for material pricing when supplier quotes or historical
data are not available.

In addition to the cost of the materials, material pricing
needs to include shipping costs, sales tax, and storage costs.
When material prices are not guaranteed or materials are
purchased over a long period of time, changes in the mater-
ial prices (escalation) need to be included in the pricing.
Let’s look at these costs.

SHIPPING COSTS
Material prices are often quoted FOB the factory, FOB the
supplier’s warehouse, or FOB the jobsite. The term “FOB” is
short for “free on board,” which identifies the point where the
supplier relinquishes responsibility for shipping and protec-
tion of the materials against loss to the purchaser of the ma-
terials. For example, if the price for a HVAC unit is quoted
FOB the factory, the purchaser is responsible for paying for

the shipping from the factory to the jobsite, and should the
unit be damaged during shipping, the purchaser would be re-
sponsible for the cost of the damage. However, if the price for
the HVAC unit is quoted FOB the jobsite, the supplier is re-
sponsible for shipping the unit to the jobsite, and should the
unit be damaged during shipping, the supplier, not the pur-
chaser, would be responsible for the cost of the damage.

Prices for shipping should be obtained from the sup-
plier or a shipper. Shipping charges from local suppliers are
often a flat rate per delivery or by the hour. For example, a
lumber supplier may charge $25 per delivery and an aggre-
gate supplier may charge $65 per hour for delivery. Long-
distance shipping by truck is often charged by the hundred-
weight (cwt) or fraction thereof. One hundredweight equals
100 pounds. Shipping rates may also be based upon the size
of the item being shipped. Long-distance shipping charges
are calculated as shown in the following example.

EXAMPLE 19-2

The price for an 11,225-pound HVAC unit has been quoted FOB
the factory. You have obtained a shipping price of to
ship the unit from the factory to the jobsite. Determine the cost of
shipping the HVAC unit.

$25.65/cwt
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Solution: The weight, in hundredweight, of the unit is calculated
as follows:

The shipper will charge for 113 cwt. The shipping cost is calculated
as follows:

�

SALES TAX
States often charge sales tax on material purchases. Some
states may charge sales tax on permanent materials (materi-
als incorporated into the finish project such as doors and
windows) but not charge sales tax on construction materials
(materials used in the construction process but not incorpo-
rated into the finished project, such as saw blades). The sales
tax rate is expressed as a percentage of the sales price of the
taxable materials. Some states allow counties and cities to
levy additional sales tax. As a result, the sales tax rate may
vary by city and county as well as by state. In addition, some
public projects are exempt from sales tax. If this is the case, it
will be identified in the construction documents. Because
the sales tax rate can vary by project, city, county, and state, it
is important for the estimator to determine the local sales tax
rate for each project.

When purchasing materials from an in-state supplier,
the supplier often collects the sales tax along with the cost of
the materials. When purchasing materials from an out-of-
state supplier, the supplier often does not pay sales tax on the
materials, leaving purchasers to pay their local sales tax di-
rectly to the state. When getting prices from suppliers, the es-
timator must find out whether a supplier has included sales
tax in the pricing or if sales tax needs to be added.

The cost of the sales tax is determined by multiplying
the cost of the taxable materials by the sales tax rate. This
calculation is expressed by the following equation:

(19-3)

EXAMPLE 19-3

You have been quoted $125,236.23 for an order of lumber, all of
which is subject to sales tax. The price does not include sales tax.
The local sales tax rate is 5.25%. How much sales tax must be paid
on the lumber?

Solution: The sales tax is calculated using Eq. (19-3) as follows:

�

STORAGE COSTS
When purchasing large quantities of materials, large equip-
ment, or materials before they are needed, the contractor
may have to provide a place to store the materials and equip-
ment until they are installed. The storage can take place on

Sales!Tax � ($125,236.23)(0.0525) � $6,574.90

Sales!Tax � (Taxable!Materials)(Sales!Tax!Rate)

Shipping!Cost � (113!cwt)($25.65/cwt) � $2,898.45

Weight �
11,225!lb

100!lb/cwt
� 112.25!cwt

the project, in which case the material must be stored in an
out-of-the-way place and protected against theft and dam-
age. Storage costs for on-site storage may include temporary
fencing or containers in which to store the material or secu-
rity to protect the material and equipment from theft.
Alternatively, the materials can be stored off-site. When the
materials are stored off-site, secure storage space for the ma-
terials may need to be rented, and the materials are shipped
to the site as they are needed, all of which adds to the cost of
the materials.

ESCALATION
Sometimes material suppliers will not guarantee the mater-
ial prices for the duration of the construction project, as is
often the case with lumber. When the material prices are ex-
pected to increase over the duration of their use on the con-
struction project, the estimator needs to include an escala-
tion allowance in the material prices to cover the anticipated
increases. When dealing with annual contracts or material
suppliers that raise their prices annually, it is easy to antici-
pate price changes and incorporate these changes into the
bids. With pricing that fluctuates with market prices, such as
lumber, escalation is impossible to accurately predict, but es-
calation still needs to be included in the bid. Trade maga-
zines, which report on the trends in the industry, can give a
contractor insight into factors within the economy and in-
dustry that may lead to escalation of material costs. Material
pricing can be adjusted for escalation using the following
equation:

(19-4)

where

CostEscalated � Escalated Material Cost

Cost � Quoted Cost of Materials

f � Expected Escalation or Inflation Rate (in
decimal format)

If material prices are expected to decline, a negative es-
calation rate may be used in this equation. The calculation of
the escalated cost is shown in the following example.

EXAMPLE 19-4

You have been quoted $88,325 for an order of lumber. You expect
lumber prices to increase by 3.5% between now and the time you
place the order. How much should you include in your bid to cover
the cost of the lumber?

Solution: The expected escalation rate is 3.5%, or 0.035. The esca-
lated cost is calculated using Eq. (19-4) as follows:

�

To protect against material price increases, some con-
tractors may purchase large quantities of materials at the be-
ginning of the construction project and store the materials
and pay the storage costs rather than risk price increases.

CostEscalated � ($88,325)(1 � 0.035) � $91,416

CostEscalated � Cost(1 � f )



CONCLUSION
Material costs include the cost of the materials, shipping
costs, sales tax, storage costs, and escalation allowance.
Material pricing may be obtained from suppliers, historical
data, and national reference books.

PROBLEMS
1. A recent project included 11,000 square feet of 5-inch-

thick concrete slab. The cost of the concrete material for
the sidewalk was $15,950. Determine the material cost
for 1 square foot of sidewalk.
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EXCEL QUICK TIP 19-1

Request for Materials Quote

The request for materials quote shown in Figure 19-1 is set up in a spreadsheet by entering the data and formatting the cells
as follows:

A B C D E

1

2
3
4
5
6
7
8
9

10
11 DESCRIPTION $/UNIT COST

12 -
13 -
14 -
15 -
16 -
17 -
18 -
19 -
20 -
21 -
22 -
23 -
24 -
25 -
26 -
27 -
28 -
29 -
30 -
31 -
32 SUBTOTAL -
33 DELIVERY -
34 SUBTOTAL -
35 SALES TAX 0.00% -
36 TOTAL -
37

38
39
40 By: Date:
41

The supplier agrees to supply the materials in a timely manner and for the prices stated above.  This 
quote is good for 60 days.

QUANTITY

REQUEST FOR MATERIALS QUOTE
To:

From:

Project:

The following formulas need to be entered into the asso-
ciated cells:

After entering the formula in Cell E12, copy the formula
in Cell E12 to Cells E13 through E31. One assumption in
this spreadsheet is that all material costs (except for the
delivery cost) are subject to sales tax. The cells containing
the costs are formatted using the comma style, which re-
places zeros with dashes.

Cell Formula

E12 =A12*D12

E32 =SUM(E12:E31)

E33 =E32*D33

E34 =E32+E33

E36 =E34+E35



2. A recent project included 6,450 square feet of painting.
The cost of the paint for the painting was $609.10.
Determine the material cost for 1 square foot of painting.

3. The price for a 5,595-pound HVAC unit has been quoted
FOB the factory. You have obtained a shipping price of

to ship the unit from the factory to the job-
site. Determine the cost of shipping the HVAC unit.

4. The price for a 3,023-pound transformer has been quoted
FOB the factory. You have obtained a shipping price of

to ship the unit from the factory to the jobsite.
Determine the cost of shipping the transformer.

5. You have been quoted $13,568.22 for an order of lum-
ber, all of which is subject to sales tax. The price does
not include sales tax. The local sales tax rate is 4.25%.
How much sales tax must be paid on the lumber?

$21.29/cwt

$15.75/cwt

6. You have been quoted $27,569.65 for electrical
switchgear, which is subject to sales tax. The price does
not include sales tax. The local sales tax rate is 7.60%.
How much sales tax must be paid on the switchgear?

7. You have been quoted $165,665 for an order of lumber.
You expect lumber prices to increase by 7.0% between
now and the time you place the order. How much
should you include in your bid to cover the cost of the
lumber?

8. You have been quoted $2,359 for an order of drywall.
You expect drywall prices to increase by 4.25% between
now and the time you place the order. How much
should you include in your bid to cover the cost of the
drywall?

9. Set up Excel Quick Tip 19-1 in Excel.
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LABOR PRODUCTIVITY

AND HOURS

CHAPTER TWENTY

In this chapter you will learn what factors affect labor pro-
ductivity and how to calculate labor productivity using his-
torical data, field observations, and national reference books.
You will also learn how to calculate labor hours from labor
productivity.

Labor productivity is a measure of how fast construc-
tion tasks can be performed. Productivity can be re-
ported as the number of units performed during a

labor hour1 or crew day, which is often referred to as output.
For example, the productivity for a two-person framing crew
installing sheathing may be 1,600 square feet of sheathing
per 8-hour day. It also may be expressed as 100 square feet of
sheathing per labor hour (lhr). When measuring output, the
larger the number, the greater is the productivity.

Alternatively, it can be expressed as the number of labor
hours required to complete one unit of work. For example,
the productivity to install the sheathing may be expressed as
0.010 labor hour per square foot. In most estimating, labor
hours per unit are used rather than output. When measuring
productivity in labor hours per unit, the smaller the number,
the greater is the productivity.

Daily output per crew day is converted to labor hours
per unit by dividing the number of labor hours performed
by the crew per day by the output, using the following
equation:

(20-1)

EXAMPLE 20-1

Convert the output of 1,600 square feet of sheathing per 8-hour day
for a two-person framing crew to labor hours per square foot.

Solution: The number of labor hours per square foot is calculated
using Eq. (20-1) as follows:

Labor Hours/Unit �
Labor Hours

Output

�

Output per labor hour is converted to labor hours per
unit by dividing 1 by the output, using the following equation:

(20-2)

EXAMPLE 20-2

Convert the output of 100 square feet of sheathing per labor hour
to labor hours per square foot.

Solution: The number of labor hours per square foot is calculated
using Eq. (20-2) as follows:

�

FACTORS AFFECTING LABOR
PRODUCTIVITY
Productivity is affected by many factors, including project
size, overtime, size of crew, delays, interruptions, weather,
project layout, safety, and so forth. Because these factors vary
from project to project, it is impossible to assign one pro-
ductivity rate to a given task. Each time an estimator bids a
project, he or she must look at these factors and determine
whether to expect a higher or lower productivity than on
previous projects and adjust the productivity accordingly.
Let’s look at some of these factors.

Project Size
Larger projects tend to have higher productivities, which is
particularly true for projects that are highly repetitive. This is

Labor Hours/Unit �
1

(100!ft2/lhr)
� 0.010!lhr/ft2

Labor Hours/Unit �
1

Output

� 0.010!lhr/ft2

 Labor Hours/Unit �
(2!persons)(8!hr/person-day)

(1,600!ft2/day)
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because of a number of factors, including the spreading out
of the fixed time over a greater number of units, workers
learning to do the task faster, and specialization among the
crew.

The time it takes to complete a task can be divided into
a fixed component and a variable component. The fixed
component includes things that must be done regardless of
the number of units of work completed. Daily setup takes a
fixed amount of time each day, regardless of the daily pro-
duction. The variable component includes things that are a
function of the number of units of work completed. To
demonstrate fixed and variable time, let’s look at an example
of installing entry doors on a residence. To install one entry
door, the carpenter needs to go to the residence, familiarize
himself or herself with the plans, set up the equipment, in-
stall the door, clean up, and leave. Although the installation
of the door by itself may only take 1 hour, the total process
may take 4 hours. In this case, the fixed time is 3 hours and
the variable time is 1 hour (the time actually used to install
the door), with the fixed time being spread over one door.
This results in a productivity of 4 labor hours per door.
Should the carpenter install a second door at the same time,
both doors could be installed in 5 hours, resulting in a pro-
ductivity of labor hours per door, spreading the fixed
time over two doors. Three doors would result in a produc-
tivity of 2 labor hours per door.

As a person performs a task over and over, he or she
should become more proficient in performing the task. This
is often referred to as moving down the learning curve. An
example of this is an electrician wiring hotel rooms. On the
first room he or she has to consult the plans often to deter-
mine the location of the outlets, switches, and fixtures,
which increases the time it takes to wire the room. On the
second room, the electrician needs to consult the plans less
than he or she did on the first room. By the time the electri-
cian has done a dozen or so rooms, he or she can complete
the rooms without consulting the plans, further increasing
his or her productivity.

As the projects get larger, the crew can specialize in per-
forming certain tasks. For example, one framing crew may
frame the walls while another frames the floors and yet an-
other frames the roof. This specialization moves the crews
down the learning curve faster than if all three crews framed
walls, floors, and roofs.

Overtime
Increasing the amount of time workers work each week de-
creases the productivity of the workers. The longer this goes
on, the greater is the decrease in productivity. For example,
workers may easily work an extra Saturday one week to
complete a project with little or no loss in production.
However, if the workers work every Saturday for 2 months,
they will begin to tire and will need a rest. As a result, a
greater loss in productivity will occur than it did when they
only worked one Saturday. Because of the loss in productiv-
ity and the higher labor costs, it is uneconomical to use
overtime to solve long-term labor problems. Overtime

2!1>2

should only be used to solve short-term labor problems. If a
long-term solution is needed, additional workers or crews
need to be added.

Size of Crew
The size of the crew has a great effect on productivity.
Having a crew that is too large or too small will lead to a de-
crease in productivity. With crews that are too large, mem-
bers of the crew are often in each other’s way, or there may
not be sufficient work to keep all of the members of the crew
busy. Crews that are too small often lack enough members to
complete the tasks. For example, a two-person framing crew
will find it difficult to stand walls because they lack a suffi-
cient number of workers to lift all but the smallest walls in
place. Because of this, there is an optimum size of crew,
which is different for different projects.

Delays
One of the greatest enemies to productivity comes from de-
lays on the construction project. For work to proceed on the
project, the right materials, equipment, labor, and design in-
formation must be on the project when the project is ready
for it. If the right materials and equipment are not available
when they are needed, time must be spent obtaining them or
the crews must leave the project until they have been obtained.
This wastes time and decreases productivity. When the
wrong class of labor is on the project, work may stop on the
project until the right class of labor is available. If work pro-
ceeds with the wrong class of labor, it is often less productive
than if it was performed by the correct class of labor. When
the necessary design information is not available or is incor-
rect, work must stop until the correct design information is
obtained, decreasing the productivity of the work.

Interruptions
Interruptions in work flow decrease productivity. When a
worker is jumping from task to task, he or she is less produc-
tive than if he or she is allowed to work on a single task until
it is complete because time is being wasted moving in from
task to task.

Weather
Weather has a great affect on productivity. Hot weather tires
workers out and drains their strength, requiring them to take
frequent breaks for rest and to drink fluids, thus decreasing
their productivity. Cold weather requires workers to wear
weather protection that decreases their mobility and ability to
handle small items (such as nails) and in turn decreases their
productivity. In cold weather, workers tire easily and must
take frequent breaks for rest and to warm up. Wet weather
makes the site muddy and working surfaces slippery, decreas-
ing productivity. Snow requires workers to remove the snow
from the work area before beginning to work and covers up
materials, making them harder to find. This results in a de-
crease in productivity. In addition, adverse weather requires
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that workers protect their work against the weather. For ex-
ample, concrete must be protected against drying too quickly
on hot days and freezing on cold days. Protecting construc-
tion work from weather also decreases productivity.

Project Layout
The location where materials can be delivered and stored in
relationship to the construction project affects productivity.
On sites where materials cannot be delivered or stored near
the location at which they will be used, the time it takes to
move the materials will increase and the productivity will
decrease.

Safety
The setup and use of safety equipment often decreases pro-
ductivity. In spite of the time it takes to set up and use safety
equipment, safety should never be sacrificed for production.
Estimators need to incorporate the time it takes to set up and
use safety equipment into the productivity rates.

Production can be estimated using historical data, field
observations, and national standards.

HISTORICAL DATA
The best source for labor productivity is historical data.
Historical labor productivity is obtained by determining the
number of labor hours required to complete a certain quan-
tity of work on past jobs. This information is obtained from
the accounting system. The productivity is calculated by di-
viding the number of labor hours by the quantity of work
performed as expressed by the following equation:

(20-3)

EXAMPLE 20-3

A recent project included 1,235 square feet of 4-inch-thick sidewalk.
It took 11 labor hours to complete the sidewalk. Determine the pro-
ductivity in labor hours per square foot based on this historical data.

Solution: The number of labor hours per square foot is calculated
using Eq. (20-3) as follows:

�

For historical data to be accurate, the actual labor hours
must be accurately tracked in the accounting system and an
accurate record of the quantities of work performed must be
kept. Poor tracking of labor hours or failure to update
changes in the quantities of work performed will render the
data useless.

FIELD OBSERVATIONS
Labor productivity from field observations can be calculated
in three ways: cycle time, rate of progress, and daily produc-
tion. Let’s look at each of these ways.

Labor Hours/Unit �
11!lhr

1,235!ft2 � 0.0089!lhr/ft2

Labor Hours/Unit �
Labor Hours

Quantity

Cycle Time
Cycle time is used for repetitive tasks. Repetitive tasks are
tasks that repeat over and over, such as installing sheathing
on a floor. In the case of sheathing, the process of placing
one piece of sheathing is known as a cycle. The cycle consists
of picking up a sheet of sheathing from the stock pile, mov-
ing it to where it is going to be used, placing and fastening
the sheathing, and returning to the stock pile. The produc-
tivity of repetitive tasks is determined by measuring the time
it takes to complete a cycle, which is known as the cycle time.
Because the time it takes to complete a cycle varies from
cycle to cycle, at least 30 cycles should be measured when
determining the cycle time. The average cycle time is deter-
mined by summing the cycle times and dividing by the num-
ber of observations, using the following equation:

(20-4)

where

CT � Cycle Time

n � Number of Observations

EXAMPLE 20-4

The cycle times in Table 20-1 were observed for the process of in-
stalling plywood sheathing. Determine the average cycle time.

Solution: The average cycle time is calculated using Eq. (20-4) as
follows:

�

To convert the average cycle time to labor hours per
unit, one must take into account how the observed condi-
tions compare to typical conditions, size of the crew, system
efficiency, and the units constructed per cycle.

Often the observations are taken over a short period of
time, and, as a result, they are not representative of the aver-
age conditions under which the work is performed. To ac-
count for this, an adjustment factor is used. If the cycle times
were measured at a time when productivity was higher than
average because of favorable conditions, an adjustment factor
that is less than 1 is used. If the cycle times were measured at
a time when productivity was lower than average because of
unfavorable conditions, an adjustment factor that is greater
than 1 is used. The adjustment factor must be estimated by
the person making the observations, which is a judgment call.

No systems or processes are 100% efficient, and people
are not always working on those items measured during a
cycle time. During an hour the workers may only be spending
50 minutes working on tasks measured in the cycle time.

�
(344.32!min/cycle)

30
� 11.48!min/cycle

� 8.08 � 9.35) min/cycle]/30

� 12.41 � 16.45 � 11.47 � 10.01 � 13.91

� 12.22 � 13.82 � 14.10 � 10.25 � 15.60 � 10.25

� 10.48 � 10.34 � 10.53 � 8.98 � 7.99

� 10.48 � 8.32 � 11.84 � 15.42 � 10.11 � 11.09

Average CT � [(10.34 � 12.27 � 10.90 � 17.67 � 8.74 � 10.90

CTAve �
(CT1 � CT2 � p � CTn)

n
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TABLE 20-1 Cycle Times (CTs) for Example 20-4

Observation CT (min) Observation CT (min) Observation CT (min)

1 10.34 11 10.11 21 10.25

2 12.27 12 11.09 22 15.60

3 10.90 13 10.48 23 10.25

4 17.67 14 10.34 24 12.41

5 8.74 15 10.53 25 16.45

6 10.90 16 8.98 26 11.47

7 10.48 17 7.99 27 10.01

8 8.32 18 12.22 28 13.91

9 11.84 19 13.82 29 8.08

10 15.42 20 14.10 30 9.35

During the remaining 10 minutes the workers may be taking
breaks or engaged in other nonproductive tasks, such as
going to the bathroom. The system efficiency is the number
of productive minutes per hour. Typical system efficiencies
are 45 to 50 minutes per hour.

When measuring the cycle time the number of workers
that were required to complete one cycle was not taken into
account. A one-hour cycle using two crew members will re-
quire twice the number of labor hours as a one-hour cycle
using a single crew member. The size of the crew takes this
into account.

Finally, one needs to account for the number of units
produced during a single cycle because production is mea-
sured by the number of units produced.

All of these factors are accounted for in the following
equation:

(20-5)Labor Hours/Unit �
(CTAve)(AF)(Size)

(SE)(Units)

where

CTAve� Average Cycle Time in Minutes per Cycle

AF � Adjustment Factor

Size � Size of Crew

SE � System Efficiency (Minutes per 60-Minute Hour)

Units � Number of Units Produced per Cycle

EXAMPLE 20-5

Using the average cycle time from Example 20-4, a system efficiency
of 50 minutes per hour, an adjustment factor of 0.90, and a crew
size of two, determine the productivity in labor hours per square
foot of sheathing.

Solution: One sheet is 32 square feet. The productivity is calcu-
lated using Eq. (20-5) as follows:

�� 0.0129!lhr/ft2

Labor Hours/Unit �
(11.48!min/cycle)(0.9)(2)

(50!min/hr)(32!ft2/cycle)

EXCEL QUICK TIP 20-1

Cycle Time Worksheet

The spreadsheet shown in the following figure can be used to calculate the average cycle time and the labor hours per unit.

A B C D E F G H

1
2 OBS. CT (min) OBS. CT (min) Adjustment Factor 0.90
3 1 10.34 16 8.98 Crew Size 2
4 2 12.27 17 7.99 System Efficiency 50
5 3 10.90 18 12.22 Units 32.00
6 4 17.67 19 13.82
7 5 8.74 20 14.10 Average Cycle Time 11.48
8 6 10.90 21 10.25 Labor-Hour/Unit 0.01291
9 7 10.48 22 15.60

10 8 8.32 23 10.25
11 9 11.84 24 12.41
12 10 15.42 25 16.45
13 11 10.11 26 11.47
14 12 11.09 27 10.01
15 13 10.48 28 13.91
16 14 10.34 29 8.08
17 15 10.53 30 9.35

Cycle Time Calculator
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Rate of Progress
Rate of progress is used for linear tasks. Linear tasks are tasks
that progress along a line rather than in a cyclical motion.
Linear tasks include paving roads, installing pipes, painting
striping on roads, installing curbs, and so forth. The produc-
tivity for linear tasks is measured by the rate the task proceeds
or rate of progress. Linear tasks consist of two components:
production time and travel time. Production time includes
the time spent producing the finished product. In the case of
an employee operating a pavement-striping machine to paint
parking stalls, this time includes the time the employee is
painting the lines in the parking lot. The second component
of a linear task is the travel time. In the case of the employee
painting the parking stalls, the travel time is the time spent
moving the striping machine from the end of one line to the
beginning of the next line. The travel time represents breaks
in the work and must be included in the production rate. As
with repetitive tasks, when calculating the productivity of lin-
ear tasks, one must include the system efficiency. The produc-
tivity is calculated from the following equation:

(20-6)

where

Quantity � Quantity of Work to Be Performed

RoP � Rate of Progress Measured in Units per
Minute

TT � Travel Time (Minutes)

Size � Size of Crew

SE � System Efficiency (Minutes per 60-Minute
Hour)

EXAMPLE 20-6

An operator of a paint-striping machine is painting parking stalls
in a parking lot. The work consists of 4 lines 440 feet long, 200
lines 40 feet long, and 100 lines 20 feet long. When striping, the
operator can paint 40 feet of line per minute. The travel time be-
tween lines is 0.5 minute. Using a system efficiency of 50 minutes
per hour, determine the productivity for striping of the parking lot
in labor hours per foot.

Solution: The quantity of work is calculated as follows:

Labor Hours/Unit �

aQuantity

RoP
� TTb(Size)

(Quantity)(SE)

The number of times the operator needs to travel is one less than
the number of lines. The number of lines and travel time are calcu-
lated as follows:

The productivity is calculated using Eq. (20-6) as follows:

�Labor Hours/Unit � 0.000758!lhr/ft

Labor Hours/Unit �

a 11,760!ft

40!ft/min
� 151.5!minb(1)

(11,760!ft)(50!min/hr)

TT � (303!ea)(0.5!min/ea) � 151.5!min

Number!of!Lines � 4!ea � 200!ea � 100!ea � 304!ea

� 11,760!ft

� (100!ea)(20!ft/ea)

Quantity � (4!ea)(440!ft/ea) � (200!ea)(40!ft/ea)

To complete this spreadsheet, enter the data and format the
cells as shown in the figure. The following formulas need to
be entered into the associated cells:

The data is entered into Cells B3 through B17, E3 through
E17, and H2 through H5. The data shown in the foregoing
figure is from Examples 20-4 and 20-5.

Cell Formula

H7 =AVERAGE(B3:B17,E3:E17)

H8 =H7*H2*H3/(H4*H5)

EXCEL QUICK TIP 20-2

Rate of Progress Worksheet

The spreadsheet shown in the following figure can be
used to calculate the labor hours per unit using the rate of
progress:

To complete this spreadsheet, enter the data and format
the cells as shown in the figure. The following formula
needs to be entered into Cell B8:

=(B2/B3+B4*B5)*B6/(B2*B7)

In this equation the travel time is broken down into two
components: number of moves and the time per move.
The travel time is calculated by multiplying the number of
moves (Cell B4) by the time per move (Cell B5).

The data is entered into Cells B2 through B7. The data
shown in the foregoing figure is from Example 20-6.

A B C

1
2 Quantity 11,760 units
3 Rate of Progress 40 units per min
4 No. of Moves 303 ea
5 Time per Moves 0.5 min
6 Crew Size 1 persons
7 System Efficiency 50 per 60 min hr
8 Labor-Hour/Unit 0.000758 lhr/unit

Rate of Progress Calculator
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Daily Production
Alternatively, the production for all tasks can be determined
by measuring the quantity of work performed during a day
and dividing it into the number of labor hours required to
complete the work. The productivity is determined by Eq.
(20-3) in the same manner the productivity was determined
from historical data. Because the whole day is used, the sys-
tem efficiency is already incorporated in the calculation.

EXAMPLE 20-7

The measured output for a crew is 1,696 square feet of sheathing in
1 day. The crew consists of two crew members, who work 8 hours
each during the day. Determine the productivity of the crew in
labor hours per square foot of sheathing.

Solution: The number of labor hours per square foot is calculated
using Eq. (20-3) as follows:

�

NATIONAL STANDARDS
The least accurate source of data is that from national stan-
dards books. Labor productivity varies greatly around the
country. As a result, national standard books should only be

� 0.0094!lhr/ft2

Labor Hours/Unit �
(2!persons)(8!hr/person � day)

(1,696!ft2/day)

used when historical data or field observations are not avail-
able or as a check of the calculated productivity. When using
national standards, the labor productivity should be ad-
justed for area, project size, time of year, and so forth.
Sample labor productivity rates for many tasks in Part II of
this book are given in Appendix C.

LABOR HOURS
The number of labor hours required to complete a task is
calculated by multiplying the labor productivity ( )
by the quantity of work and is expressed by the following
equation:

(20-7)

EXAMPLE 20-8

A crew needs to install 100 square feet of ceramic tile. The esti-
mated productivity is . Determine the number of labor
hours required to install the ceramic tile.

Solution: The number of labor hours needed is calculated using
Eq. (20-7) as follows:

�Labor Hours � (100!ft2)(0.2!lhr/ft2) � 20!lhr

0.2!lhr
sft

Labor!Hours � (Quantity)(Labor Hours/Unit)

lhr
unit

CONCLUSION
Productivity is affected by a number of factors, including
project size, overtime, size of crew, delays, interruptions,
weather, project layout, and safety. On each estimate, the es-
timator must take these factors into account when estimat-
ing labor productivity. Labor productivity can be calculated
from historical data, field operations, and national stan-
dards. Field observations can be based on measured cycle
times, rate of progress, or daily production.

PROBLEMS
1. Convert the output of 3,000 square feet of 6-inch-thick

blown fiberglass insulation per 8-hour day for a three-
person crew to labor hours per square foot.

2. Convert the output of 165 square feet of brick veneer
per 8-hour day for a five-person crew to labor hours per
square foot.

3. Convert the output of 9.9 square feet of concrete ma-
sonry unit per labor hour to labor hours per square
foot.

4. Convert the output of 35 lineal feet of trim per labor
hour to labor hours per lineal foot.

5. A recent project included 40 lineal feet of counter top. It
took 12.5 labor hours to complete the installation of the

counter top. Determine the productivity in labor hours
per linear foot based on this historical data.

6. A recent project included 2,015 square feet of sus-
pended acoustical ceiling. It took 26 labor hours to
complete the ceiling. Determine the productivity in
labor hours per square foot based on this historical data.

7. The cycle times in Table 20-2 were observed for the in-
stallation of 8-foot by 15-inch batts of fiberglass insula-
tion. Determine the average cycle time.

8. The cycle times in Table 20-3 were observed for the in-
stallation of residential windows. Determine the average
cycle time.

9. Using the average cycle time from Problem 7, a system
efficiency of 50 minutes per hour, an adjustment factor
of 1.10, and a crew size of one, determine the productiv-
ity in labor hours per square foot of insulation.

10. Using the average cycle time from Problem 8, a system
efficiency of 45 minutes per hour, an adjustment factor
of 0.95, and a crew size of two, determine the productiv-
ity in labor hours per window.

11. An operator of a paint-striping machine is painting the
centerline of a road. The road is 5 miles long and in-
cludes 30 intersections. Each intersection is 50 feet wide,
and the centerline is not painted in the intersections.
When striping, the operator can paint 50 feet of line per
minute. The average time it takes to get through the
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intersection is 2 minutes. Using a system efficiency of
45 minutes per hour, determine the productivity for
striping the road in labor hours per mile.

12. An asphalt-paving crew is paving a 36-foot-wide section
of road 12 miles long. The road will be paved in widths
of 12 feet, requiring the paving crew to make three
passes along the road. At the end of each pass, it will take
the paving crew 2 hours to move to the start of the road
in preparation for the next pass. The paving crew con-
sists of 11 persons. When paving, the paving crew can
pave 12 feet of 12-foot-wide road per minute. Using a
system efficiency of 50 minutes per 60-minute hour, de-
termine the productivity for paving the road in labor
hours per square yard.

13. The measured output for a crew finishing concrete is
2,050 square feet per day. The crew consists of three
crew members, who work 8 hours each during the day.
Determine the productivity of the crew in labor hours
per square foot of concrete finished.

14. The measured output for a plumbing crew is 115 feet of
-inch steel pipe per day. The crew consists of a1!1>2

plumber and an apprentice, who work 10 hours each
during the day. Determine the productivity of the crew
in labor hours per foot of pipe.

15. A crew needs to install 3,200 square feet of sheathing.
The estimated productivity is . Determine
the number of labor hours required to install the
sheathing.

16. A crew needs to paint 11,625 feet of parking lot striping.
The estimated productivity is 0.8 labor hour per 1,000
feet. Determine the number of labor hours required to
paint the striping.

17. Set up Excel Quick Tip 20-1 in Excel.

18. Set up Excel Quick Tip 20-2 in Excel.

REFERENCE
1. Labor hours are often referred to as man hours. A labor hour

is defined as one person working for 1 hour. This book uses
the term labor hour in lieu of man hour.

0.011!lhr/sft

TABLE 20-3 Cycle Times for Problem 8

Observation CT (min) Observation CT (min) Observation CT (min)

1 37.26 11 56.55 21 39.57

2 28.55 12 37.90 22 29.82

3 52.57 13 55.91 23 46.70

4 34.85 14 38.51 24 30.95

5 42.27 15 41.47 25 35.41

6 42.41 16 27.97 26 61.83

7 30.87 17 32.15 27 31.12

8 46.36 18 60.10 28 33.37

9 36.77 19 36.27 29 50.72

10 32.89 20 39.33 30 37.64

TABLE 20-2 Cycle Times for Problem 7

Observation CT (min) Observation CT (min) Observation CT (min)

1 2.47 11 4.26 21 3.85

2 3.00 12 2.70 22 2.50

3 2.67 13 2.39 23 3.58

4 3.11 14 2.64 24 2.11

5 3.18 15 3.11 25 3.60

6 3.08 16 2.59 26 2.69

7 3.89 17 3.00 27 2.54

8 3.10 18 4.90 28 2.70

9 4.38 19 3.72 29 2.88

10 4.62 20 2.93 30 2.77
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In this chapter you will learn how to determine hourly labor
rates for a given class of employees. This chapter includes how
to determine wage rates and labor burden, including cash
equivalents and allowances, payroll taxes, unemployment in-
surance, workers’ compensation insurance, general liability in-
surance, insurance benefits, retirement contributions, union
payments, and other benefits.

The hourly wage rate for a given employee class in-
cludes the wages paid to the employee plus labor
burden. Labor burden includes cash equivalents and

allowances paid to the employee, payroll taxes, unemploy-
ment insurance, workers’ compensation insurance, general
liability insurance, insurance benefits, retirement contribu-
tions, union payments, vacation, sick leave, and other bene-
fits paid by the employer. The average wage rate paid during
the year is calculated by determining the annual costs of an
employee and dividing it by the number of billable hours as
shown in the following equation:

(21-1)

Let’s look at how to calculate the average hourly wage
rate for an employee class.

BILLABLE HOURS
Billable hours are the number of hours an employee can be
billed to projects during a year, which is different than the
number of hours an employee is paid during the year. Often
employees are paid for holidays, vacation, and sick leave,
which are not billable to a project. The costs of holidays, va-
cation, and sick leave should be accrued throughout the year
by billing it to the jobs as a burden cost and paid from the ac-
cruals at the time the holidays, vacation, and sick leave are
taken.1 In addition to holidays, vacation, and sick leave,

Labor Rate �
Annual Costs

Billable Hours

travel time to, between, and from a job that is paid by the
company may not be billable to the job.

WAGES
The annual wages should include the wages paid to employ-
ees including all bonuses and any anticipated raises that may
occur during the project. Employees may be separated into
two groups based on how their wages are calculated.

The first group includes all employees who are paid an
hourly wage based on the number of hours they work during
the pay period. These employees are often referred to as
hourly employees. To estimate the wages for hourly employ-
ees, one must first estimate the number of hours each em-
ployee will work during an average pay period. Remember
that pay rates for hourly employees may be different for
overtime, holidays, and weekends. The number of hours
worked may vary during different times of the year.

The wage rates for hourly employees and the rules gov-
erning overtime are set forth by union contracts or govern-
ment regulatory agencies. Federal Davis-Bacon wages—wage
rates that must be used on contracts with federal funding—
vary by state, county, and type of work being performed; for
example, road work has different wages than residential con-
struction. These rates are published as General Decisions by
the U.S. Department of Labor. A sample General Decision is
given in Figure 21-1. To ensure that you are using the correct
General Decision for a specific project, you should obtain the
decision from the contracting officer for the project. The total
wages for an employee or group of employees is calculated by
multiplying the number of hours by the wage rate for these
hours and adding any anticipated bonuses.

EXAMPLE 21-1

A typical laborer works 50 hours per week for 20 weeks of the year
and 40 hours per week for 29 weeks of the year, and the remaining
3 weeks per year comprises holiday leave, vacation, and sick leave,

LABOR RATES

CHAPTER TWENTY–ONE
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FIGURE 21-1a General Decision FIGURE 21-1b General Decision

for which the laborers are paid for 40 hours per week. Laborers are
paid $10.50 per hour and are paid time and a half on any hours
worked over 40 hours per week. In the past the laborers received a
$100 Christmas bonus. Determine the wages paid to the typical la-
borer and the number of billable hours during a one-year period.
Assume that all hours are billable except holidays, vacation, and
sick leave.

Solution: The typical laborer is paid $10.50 per hour for 40 hours
per week for 52 weeks a year and is paid $15.75 ($10.50 � 1.5) for
10 hours per week for 20 weeks. The wages, including bonus, are
calculated as follows:

The number of billable hours per year is calculated as follows:

�

The second group includes all employees who are paid a
flat rate per pay period and are known as salaried or exempt
employees. To estimate the wages for salaried employees, you
do not need to know how many hours each employee works.

� 2,160 hr/yr

Billable Hours � (50 hr/wk)(20 wk/yr) � (40 hr/wk)(29 wk/yr)

� $25,090/yr

� ($15.75/hr)(10 hr/wk)(20 wk/yr) � $100/yr

Wages � ($10.50/hr)(40 hr/wk)(52 wk/yr)

The total wages for an employee or group of employees is
calculated by summing the salaries of the employees and
adding any anticipated bonuses. The costs for salaried em-
ployees are calculated by the week or month rather than by
the hour.

Burden includes all payroll taxes, unemployment insur-
ance, workers’ compensation insurance, general liability in-
surance, and fringe benefits or their cash equivalent paid for
by the employer. Holidays, vacation, and sick leave are also
part of labor burden; however, they have already been ac-
counted for by not including these hours in the billable
hours. Let’s look at how labor burden is calculated.

CASH EQUIVALENTS AND
ALLOWANCES
Cash equivalents and allowances include cash paid in lieu of
providing fringe benefits or cash paid as an allowance. In
some cases where a company is required to provide fringe
benefits, the employer may be allowed to pay the cash equiv-
alent of those benefits and let employees use the money to
purchase their own benefits if they so desire. Allowances are
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used to help the employee cover out-of-pocket expenses as-
sociated with their job. For example, a company located in
an out-of-the-way place or a company that requires their
employees to use their personal vehicles during work hours
may pay employees a vehicle allowance. An allowance is dif-
ferent than reimbursing the employee for expenses or
mileage because it is not based on the actual cost or mileage.
Reimbursements are not considered part of the labor wages
and burden but are costs that can be billed to the appropriate
project.

Cash equivalents and allowances are treated as regular
wages for the purpose of payroll taxes, unemployment in-
surance, workers’ compensation insurance, and general lia-
bility insurance.

EXAMPLE 21-2

The typical laborer in Example 21-1 is paid a tool allowance of $20
per month. Determine the annual wages including allowances paid
to the typical laborer during a one-year period.

Solution: From Example 21-1, the typical laborer is paid $25,090 per
year plus allowances. The wages, including allowances, are calculated
as follows:

�

PAYROLL TAXES
The Federal Insurance Contributions Act (FICA) requires
employers to pay Social Security and Medicare taxes for each
employee. For the year 2010, the employer pays a Social
Security tax of 6.2% of each employee’s first $106,800 in
wages.2 Although the tax rate has not changed for many
years, the amount of wages on which the Social Security tax
is paid increases almost every year. Be sure to check with
your tax advisor or the Internal Revenue Service for the cur-
rent rates. For the year 2010, the employer pays a Medicare
tax of 1.45% of the employee’s entire wages.3 The employee
is required to match these payments. The Social Security and
Medicare taxes paid by an employee are deducted from his
or her wages and are not a cost to the employer. Cash equiv-
alents and allowances must be included when calculating
these taxes; however, in some cases the amount the employee
pays for his or her benefits may be excluded.

EXAMPLE 21-3

Determine the Social Security and Medicare taxes paid by the em-
ployer during the year for the typical laborer in Example 21-2. The
typical laborer pays $150 per month for health insurance, which is
not subject to Social Security and Medicare taxes. Use the tax rates
for the year 2010.

Solution: The wages used in calculating the Social Security and
Medicare tax must include the allowances paid to the typical la-
borer and exclude the $150 per month paid by the employee for
health insurance. From Example 21-2 the annual wages, including
allowances, for the typical laborer are $25,330. This is reduced by
the $1,800 ($150/mo � 12 mo/yr) per year the typical laborer pays
for health insurance. The typical laborer’s wages that are subject to
Social Security and Medicare taxes are $23,530 ($25,330 – $1,800).
Because the typical laborer’s wages are less than $106,800, the em-
ployer must pay 6.2% for Social Security tax on all of his or her
wages. The Social Security tax is calculated as follows:

The Medicare tax is 1.45% of the laborer’s wages and is calculated
as follows:

These same amounts are deducted from the laborer’s paychecks. �

UNEMPLOYMENT INSURANCE
By law, employers are required to pay federal unemployment
tax (FUTA) and, if a state program exists, state unemploy-
ment tax (SUTA).

For the year 2010 the federal unemployment tax rate is
6.2% on the first $7,000 of each employee’s wages paid

Medicare Tax � (0.0145)($23,530/yr) � $341.18/yr

Social Security Tax � (0.062)($23,530/yr) � $1,458.86/yr

� $25,330/yr

Wages and Allowances � $25,090/yr � $240/yr

Allowances � ($20/mo)(12 mo/yr) � $240/yr

FIGURE 21-1c General Decision
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during the year.4 If a company pays into a state unemploy-
ment program, the company may reduce its FUTA liability
by the amount paid into the program. This reduction is
limited to 5.4% of first $7,000 of each employee’s wages. To
receive the entire 5.4%, the company must pay its state un-
employment tax on time. When a company is eligible for
the full credit, its federal unemployment tax rate is reduced
to 0.8% (6.2% - 5.4%) of the first $7,000 of each em-
ployee’s wages paid during the year.

A company’s state unemployment tax rate is based in
part on its claims history and must be obtained from the
state agency that administers the state unemployment tax.
The maximum rate a state charges and the amount of the
employees’ wages that are subject to tax vary from state to
state. For example, for the year 2006, Texas’ minimum rate
was 0.40%, the maximum rate was 7.64%, and companies
paid SUTA on the first $9,000 of each employee’s wages paid
during the year. Arizona’s minimum rate was 0.02%, the
maximum rate was 5.40%, and companies paid SUTA on the
first $7,000 of each employee’s wages paid during the year.
Utah’s minimum rate was 0.40%, the maximum rate was
9.4%, and companies paid SUTA on the first $24,000 of each
employee’s wages paid during the year.

EXAMPLE 21-4

Determine the state unemployment and federal unemployment
taxes paid by the employer during the 2010 year for the typical la-
borer in Example 21-2. The company’s state unemployment rate is
2.0% on the first $9,000 of the employee’s wages. The company can
take the full 5.4% credit against its federal unemployment tax.

Solution: The wages used in calculating the unemployment taxes
must include the allowances paid to the laborer. From Example 21-2
the annual wages, including allowances, for the laborer are $25,330.
Because the laborer’s wages are more than $9,000, the employer
must pay 2.0% on $9,000 for state unemployment tax. The state un-
employment tax is calculated as follows:

The federal unemployment tax is calculated as follows:

The total unemployment tax paid is $236.00 ($180.00 � $56.00).
�

The underlying assumption in the calculations for
Example 21-4 is that the same person fills the laborer posi-
tion for the entire year. This is seldom the case. If more than
one person fills the laborer position during the year because
of employee turnover, the company must pay FUTA on the
first $7,000 of wages from each employee as shown by the fol-
lowing example.

EXAMPLE 21-5

During the year, a laborer’s position is filled by three different la-
borers, two of whom left the company during the year. For the year,

FUTA � 0.008($7,000/yr) � $56.00/yr

SUTA � 0.02($9,000/yr) � $180.00/yr

the first laborer was paid $5,130, the second laborer was paid
$11,000, and the third laborer was paid $9,200. Determine the fed-
eral unemployment taxes paid by the employer on this laborer po-
sition. The company can take the full 5.4% credit against its federal
unemployment tax.

Solution: The employer must pay 0.8% on the first $7,000 paid
to each employee. The federal unemployment tax is calculated as
follows:

�

Here employee turnover increased the costs of FUTA by
273%. The same situation occurs with SUTA. One way to take
this into account is to determine the average FUTA and SUTA
paid during the last year as a percentage of labor costs based on
data from the company’s accounting system. These percentages
then can be applied to all labor costs when determining labor
burden. The calculations are shown in the following example:

EXAMPLE 21-6

Last year your company paid $1,191,300 in wages, $2,486 in FUTA,
and $7,992 in SUTA. Determine the company’s FUTA and SUTA
rate as a percentage of wages paid. Also determine the state unem-
ployment and federal unemployment taxes paid by the employer
for the typical laborer in Example 21-2 based on these rates.

Solution: The FUTA rate as a percentage of wages is calculated as
follows:

The FUTA paid on a typical laborer is calculated as follows:

The SUTA rate as a percentage of wages is calculated as follows:

The SUTA paid on a typical laborer is calculated as follows:

The total unemployment tax is $222.90 ($52.94 � $169.96). �

Looking at Examples 21-4 and 21-6, one notices that the
amount calculated by Example 21-6 is less than the legally re-
quired amount calculated by Example 21-4. This is because the
method used in Example 21-6 uses an average percentage for
the FUTA and SUTA calculations and bases these calculations
on the total wages paid. As a result it understates the FUTA and
SUTA on lower-cost employees (such as laborers) and over-
states the cost on higher-paid employees. For all of the field
employees, the company in the foregoing examples paid 20%
more FUTA and SUTA in Example 21-6 than would have been
calculated using the procedures used to calculate FUTA and
SUTA in Example 21-4 because of employee turnover.

SUTA � ($25,330/yr)(0.00671) � $169.96/yr

SUTA Percentage �
$7,992/yr

$1,191,300/yr
� 0.00671 or 0.671%

FUTA � ($25,330/yr)(0.00209) � $52.94/yr

FUTA Percentage �
$2,486/yr

$1,191,300/yr
� 0.00209 or 0.209%

� $153.04/yr

� ($7,000/yr)(0.008)

FUTA � ($5,130/yr)(0.008) � ($7,000/yr)(0.008)
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WORKERS’ COMPENSATION
INSURANCE
By law all employers are required to provide their employees
with workers’ compensation insurance. Workers’ compensa-
tion insurance is governed by the individual states, and the
requirements vary from state to state.

Workers’ compensation insurance covers reasonable
medical costs as well as some of the lost wages for employees
who are injured on the job or who contract an occupational
illness. For employees who are killed on the job, workers’
compensation insurance may pay part of the burial expense
and may provide surviving family members a weekly or
monthly benefit.

The cost of the insurance is to be paid entirely by the em-
ployer. The premium is based on the gross payroll, the type of
work performed by the employees, the company’s accident
history, and other factors. Employees are grouped into a stan-
dard set of classifications established by the National Council
on Compensation Insurance (NCCI) based on the type of
work they do. The NCCI sets a standard lost cost factor for
each job classification, which is modified by the individual
states to take into account local variances in losses and regu-
lations. The premium rate is based on the lost cost factor and
is expressed in dollars per $100 of payroll.

The premium rate may be modified by multiplying the
premium rate by a so-called experience modifier. Experience
modifiers are calculated by NCCI and reflect the relationship
between the company’s actual losses and the expected losses
for similar companies. An experience modifier greater than 1
indicates that a company had higher-than-expected losses,
whereas an experience modifier of less than 1 indicates that a
company had lower-than-expected losses. The experience
modifiers are based on the past three years of losses, not in-
cluding the most recent policy year. For example, the experi-
ence modifier for the year 2011 would be based on the years
2007, 2008, and 2009. For companies to receive an experi-
ence modification they must meet a minimum level of pre-
miums, and thus companies with small payrolls are often
not given experience modifiers. Experience modifiers may
be as low as 0.6 and as high as 2.0.

The workers’ compensation insurance premiums may
also be adjusted based on the safety practices of the com-
pany. Other discounts may be offered for such items as
policy size.

Throughout the year, companies pay workers’ compensa-
tion insurance premiums based on the estimated payroll. At
the end of the year or more frequently the insurance carrier
will audit the payroll of the company and make adjustments
in the premiums to reflect the actual payroll. It is important to
note that this is an adjustment in the total premium, not the
premium rate.

EXAMPLE 21-7

Determine the cost of workers’ compensation insurance for the
typical laborer in Example 21-2. The company’s workers’ com-

pensation insurance rate for laborers is $6.25 per $100.00 in
wages.

Solution: The wages used in calculating the workers’ compensa-
tion insurance must include the allowances paid to the laborer.
From Example 21-2 the annual wages, including allowances, for the
typical laborer are $25,330 per year. The workers’ compensation in-
surance cost is calculated as follows:

�

GENERAL LIABILITY
INSURANCE
General liability insurance protects the company against
claims because of negligent business activities and failure to
use reasonable care. The types of claims include bodily in-
jury, property damage or loss, and other personal injury
such as slander or damage to reputation. Like workers’ com-
pensation insurance, the cost of the insurance is based on
gross revenues and varies by worker class.

Throughout the year, companies pay general liability in-
surance premiums based on the estimated payroll. At the
end of the year or more frequently the insurance carrier will
audit the payroll of the company and make adjustments in
the premiums to reflect the actual payroll. This is an adjust-
ment to the total premium and not the premium rates.

EXAMPLE 21-8

Determine the cost of general liability insurance for the typical la-
borer in Example 21-2. The company’s workers’ compensation in-
surance rate for laborers is 0.97% of wages.

Solution: The wages used in calculating the general liability insur-
ance must include the allowances paid to the typical laborer. From
Example 21-2 the annual wages, including allowances, for the typi-
cal laborer are $25,330 per year. The general liability insurance cost
is calculated as follows:

�

INSURANCE BENEFITS
As part of the employee benefit package, the employer may
provide health, dental, life, and disability insurance for
which the employee and their families are beneficiaries.
The employer may pay the entire cost of the benefits, split
the cost with the employee, or require the employee to pay
the entire amount. The amount the employees pay is de-
ducted from their wages and does not represent a cost to the
employer. The part of the cost that is paid by the employer is
a real cost to the employer and needs to be included in the
cost of the benefits.

EXAMPLE 21-9

Determine the cost of health insurance for the typical laborer in
Example 21-2. The company pays $100 per month toward health

Liability Insurance � (0.0097)($25,330/yr) � $245.70/yr

� $1.583.12/yr

Workers’ Compensation � ($6.25/$100)($25,330/yr)
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insurance for its employees. An additional $150 is deducted from
the employee’s paycheck.

Solution: The cost of the health insurance includes only those
costs paid by the employer and is calculated as follows:

�

RETIREMENT
CONTRIBUTIONS
As part of the employee benefit package, the employer may
provide traditional pension plans, pay funds to a union to
provide pension benefits, or participate in a profit-sharing
plan such as a 401(k). Like insurance benefits, the employer
may pay all, part, or none of the cost of the retirement. The
amount the employees pay is deducted from their wages and
does not represent a cost to the employer. The part of the
cost that is paid by the employer is a real cost to the employer
and needs to be included in the cost of the benefits.

EXAMPLE 21-10

Determine the cost of retirement for the typical laborer in Example
21-2. For retirement, the company has provided the employee with
access to a 401(k) plan and matches the employee’s contributions
to the plan at a rate of $0.50 per $1.00 contributed by the employee
on the first 6% of the employee’s wages—including allowances—
for a maximum matching contribution of 3% of the employee’s
wages. The typical laborer is expected to contribute at least 6% of
his or her wages to the 401(k) plan.

Solution: From Example 21-2 the annual wages, including al-
lowances, for the typical laborer are $25,330. The cost of retirement
is calculated as follows:

�

UNION PAYMENTS
Employee unions often require the employer to make
payments directly to the union for the union to provide ben-
efits to the employees. Payments to unions are governed by
the contract between the company and the union. Union
costs paid by the employer should be included in the cost of
the benefits. Unions may also require the employer to deduct
union dues from the employees’ paycheck. The amounts the
employees pay do not represent a cost to the employer and
should not be included in the cost of the benefits.

OTHER BENEFITS
The employer may provide other benefits not covered in one
of the foregoing categories. Where possible the costs of these
benefits should be included.

Retirement � a$0.50

$1.00
b(0.06)($25,330/yr) � $759.90/yr

Health Insurance � ($100/mo)(12 mo/yr) � $1,200.00/yr

ANNUAL COSTS AND
BURDEN MARKUP
The annual cost of the employee is determined by summing
the individual burden items and adding the wages paid to
the employee. The burden markup is calculated as follows:

(21-2)

where the wages include only those wages paid for billable
hours and should include allowances. By doing this the
wages paid on unbillable hours, vacation, and sick leave are
included as part of the burden.

EXAMPLE 21-11

Determine the annual cost, average hourly cost, and burden
markup for the typical laborer in Example 21-1 using Examples 21-2
through 21-4 and 21-7 through 21-10. Assume that the same per-
son fills the position during the entire year.

Solution: From Examples 21-1 through 21-4, and 21-7 through
21-10 the following costs were calculated:

Burden Markup �
Annual Cost

WagesBillable Hours
� 1

Wages and Allowances � $25,330/yr

Social Security Tax � $1,458.86/yr

Medicare Tax � $341.18/yr

SUTA � $180.00/yr

FUTA � $56.00/yr

Workers Compensation � $1,583.12/yr

Liability Insurance � $245.70/yr

Health Insurance � $1,200.00/yr

Retirement � $759.90/yr

The annual cost is calculated as follows:

Using the billable hours from Example 21-1, we calculate the aver-
age hourly wage rate using Eq. (21-1) as follows:

The burden markup is calculated using Eq. (21-2) as follows:

�

It is important to note that one cannot take the base hourly
rate of $10.50 and add the burden markup to get the hourly
cost because some of the employee’s hours are paid at time-
and-a-half.

� 0.2943 or 29.43%

Burden Markup �
$31,154.76/yr

($25,330/yr � $1,260/yr)
� 1

Average Hourly Wage Rate �
$31,154.76/yr

2,160 hr/yr
� $14.42/hr

Annual Cost � $31,154.76/yr

� $245.70/yr � $1,200/yr � $759.90/yr

� $180.00/yr � $56.00/yr � $1,583.12/yr

Annual Cost � $25,330/yr � $1,458.86/yr � $341.18/yr
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EXCEL QUICK TIP 20-1

Labor Rate Worksheet

The spreadsheet shown in the following figure can be used to calculate the average hourly wage and labor burden for a class
of employees.

To complete this spreadsheet, enter the data and format the cells as shown in the figure. The following formulas need to be
entered into the associated cells:

A B C D E F

1
2 Hours per Weeks Base
3 Week per Year Rate Wages
4 Week Type 1 50.00 20.00 10.50 11,550
5 Week Type 2 40.00 29.00 10.50 12,180
6 Week Type 3 -
7 Week Type 4 -
8 Vacation & Sick Leave 40.00 3.00 10.50 1,260
9 Bonus 100

10 Billable Hours 2,160
11 Wages 25,090
12 Allowances 20.00 per mo 12 mo 240
13 Employee Paid Health Ins. 150.00 per mo 12 mo 1,800
14 Social Security/Med. Wages 23,530
15
16 Wages and Allowances 25,330
17 Social Security 6.20% on first 106,800 of wages 1,459
18 Medicare 1.45% on first of wages 341
19 SUTA 2.00% on first 9,000 of wages 180
20 FUTA 0.80% on first 7,000 of wages 56
21 Workers' Compensation 6.25 $/$100 of wages 1,583
22 General Liability 0.97% of wages 246
23 Employer Paid Health Ins. 100.00 per mo 12 mo 1,200
24 Retirement 50.00% match on 6.00% of wages 760
25 Union Payments 0.00% of wages -
26 31,155
27 14.42
28 29.43%

Annual Cost of Employee
Average Hourly Wage Rate

Labor Burden Markup

Wage Calculation Worksheet

Cell Formula

E4 =IF(B4>40 ,40*D4+(B4-40)*D4*1.5,B4*D4)*C4
F10 =B4*C4+B5*C5+B6*C6+B7*C7

F11 =SUM(E4:E9)

F12 =B12*D12

F13 =B13*D13

F14 =F11+F12-F13

F16 =F11+F12

F17 =IF(D17="",F14*B17,IF(F14<D17,F14*B17,D17*B17))

F18 =IF(D18="",F14*B18,IF(F14<D18,F14*B18,D18*B18))

F19 =IF(D19="",F16*B19,IF(F16<D19,F16*B19,D19*B19))

F20 =IF(D20="",F16*B20,IF(F16<D20,F16*B20,D20*B20))

F21 =(B21/100)*F16

F22 =B22*F16

F23 =B23*D23

F24 =B24*D24*F16

F25 =F16*B25

F26 =SUM(F16:F25)

F27 =F26/F10

F28 =F26/(F16–E8)-1
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An IF statement is used in cell E4 to calculate the weekly
wages while including time-and-a-half for hours worked in
excess of 40 hours per week. The IF statement checks to see if
the hours worked is greater than 40 hours per week. If this is
the case, the weekly wages equal the hours over 40 hours per
week multiplied by 1.5 times the wage rate plus 40 hours at
the wage rate. If the hours worked are less than or equal to
40 hours, the weekly wages are equal to the hours per week
times the wage rate. The weekly wages are then multiplied by
the number of weeks per year to get total wages.

Cells F17 through F20 use a nested IF statement,
which works as follows for Row 17. If Cell D17 is blank, the
wages in Cell F14 are multiplied by the FICA rate in Cell
B17; if the cell is not blank, the next IF statement checks to

see if the wages in Cell F14 are less than the wage limit in
Cell D17. If this is true, the wages in Cell F14 are multiplied
by the FICA rate in Cell B17; if the wages are greater than
the limit, the FICA limit in D17 is multiplied by the FICA
rate in Cell B17. If there is not a limit, then this equation
applies the FICA rate to all of the wages.

After entering these formulas, one needs to copy Cell
E4 into Cells E5 through E8. The data for the employee
class is entered into Cells B4 through D8, E9, B12, B13,
D12, D13, B17 through B25, D17 through D20, D23, and
D24. The data shown in the foregoing figure is from
Examples 21-1 through 21-4 and 21-7 through 21-11and is
formatted using the comma style, which replaces zeros
with dashes.

Item Cost

Wages $12/hr
Bonus $500
Allowances None
Social Security 6.2% of wages to $106,800
Medicare 1.45% of wages
FUTA 0.8% of wages to $7,000
SUTA 1.85% of wages to $20,000
Workers’ Compensation $7.85 per $100 of wages
General Liability 0.65% of wages
401(k) 50% match up to 6% of wages
Health Insurance $200/month

Item Cost

Wages $15/hr
Bonus $1,000
Allowances $25/month
Social Security 6.2% of wages to $106,800
Medicare 1.45% of wages
FUTA 0.8% of wages to $7,000
SUTA 2.85% of wages to $12,000
Workers’ Compensation $4.60 per $100 of wages
General Liability 1.05% of wages
401(k) 50% match up to 6% of wages
Health Insurance $100/month

CONCLUSION
When projecting costs that include labor, it is important to
include all of the costs associated with the employee. The
cost of an employee includes wages and the associated labor
burden. The employee’s wages may be determined by market
rates, union contracts, or federal Davis-Bacon wage deci-
sions. Labor burden includes cash equivalents and al-
lowances paid to the employee, payroll taxes, unemployment
insurance, workers’ compensation insurance, general liabil-
ity insurance, insurance benefits, retirement contributions,
union dues, and other benefits.

PROBLEMS
1. During the year, the average carpenter works 50 hours

per week for 30 weeks, 40 hours per week for 15 weeks,
and 30 hours per week for 5 weeks. He or she is paid
time-and-a-half for any hours over 40 hours per week
and receives 10 paid days off per year in the form of va-
cation, sick leave, and holidays. The employee’s health
insurance is paid for entirely by the employer. Assuming
that the employee takes full advantage of the 401(k)
benefit, determine the average hourly cost and burden
markup for the average carpenter given the following
information:

2. During the year, the average equipment operator works
50 hours per week for 35 weeks, 40 hours per week for
5 weeks, and 20 hours per week for 9 weeks. He or she is
paid time-and-a-half for any hours over 40 hours per
week and receives 15 paid days off per year in the form
of vacation, sick leave, and holidays. The employee pays
$200 per month for health insurance, which is not sub-
ject to Social Security and Medicare taxes. Assuming
that the employee takes full advantage of the 401(k)
benefit, determine the average hourly cost and burden
markup for the average equipment operator given the
following information:

3. Set up the worksheet in Excel Quick Tip 21-1 in Excel.

REFERENCES
1. For more information on how to accrue vacation and sick

leave costs, see Steven J. Peterson, Construction Accounting and
Financial Management, Prentice Hall, Upper Saddle River, NJ,
2009.

2. Internal Revenue Service, Circular E, Employer’s Tax Guide,
Publication 15, 2010, p. 18.

3. Internal Revenue Service, Circular E, Employer’s Tax Guide,
Publication 15, 2010, p. 18.

4. Internal Revenue Service, Circular E, Employer’s Tax Guide,
Publication 15, 2010, p. 31.
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tax, transportation cost, set up of the equipment, and any
other costs the equipment dealer charges in conjunction with
its purchase. Tires and other wear items, such as cutting
edges, are considered operation costs and are often excluded
from the purchase price and treated as a separate item. The
salvage value for a piece of equipment should include all ex-
pected revenues from its sale or disposal. The depreciation
discussed here should not be confused with depreciation for
tax purposes, which is handled in a different manner.

By investing in equipment a company in effect takes out
a loan at a specified interest rate or forgoes the opportunity
to invest its capital in other opportunities that would in-
crease the value of its invested funds. In either case, there is
an interest cost (either paid or lost) that the company must
recoup as part of the cost of the equipment.

The annual cost of depreciation and interest is incorpo-
rated into the equipment costs by the following equation:

(22-1)

where

CostD&I � Annual Depreciation and Interest Costs

P � Purchase Price

F � Salvage Value

i � Interest Rate Expressed in Decimal Format

n � Life of the Equipment in Years

EXAMPLE 22-1

The purchase price of a front-end loader, including the tires, sales
tax, and all other costs associated with its purchase, is $135,000. The
life of the loader is 7 years, at which time it will have an estimated
salvage value of $20,000. The replacement cost of the tires is $5,000
for all tires on the loader and is not included in the depreciation
and interest cost. Determine the annual depreciation and interest
cost of the loader using an interest rate of 9%.

CostD&I �
[P(1 � i)n � F]i

[(1 � i)n � 1]

EQUIPMENT COSTS

CHAPTER TWENTY-TWO

In this chapter you will learn how to determine equipment
costs for owned, leased, and rented equipment. The cost of
equipment includes depreciation and interest, taxes and
licenses, insurance, storage, tires and other wear items, fuel,
lubricants and filters, and repair reserves.

The equipment used on construction projects can be
divided into three types of equipment: owned,
leased, and rented. Let’s begin by looking at deter-

mining the cost of owned equipment.
Equipment costs for owned equipment can be divided

into two categories: ownership costs and operating costs.
Ownership costs are those costs that are most closely related
to how long a piece of equipment is owned rather than how
much a piece of equipment is used. Ownership costs include
depreciation and interest, taxes and licensing, insurance, and
storage. Operation costs are those costs that are more closely
related to how long a piece of equipment is operated rather
than how long it has been owned. Operation costs include
tires and other wear items, fuel, lubricants and filters, and re-
pair reserves. During the life of a piece of equipment, the
ownership costs tend to decrease, whereas the operation
costs increase. For the purpose of estimating, the costs are
often equally spread throughout the expected life of the
piece of equipment.

DEPRECIATION AND
INTEREST
One of the costs the company must recoup on equipment is
its loss in value over its useful life. This is known as deprecia-
tion. Depreciation over the useful life of a piece of equipment
equals the purchase price less the salvage value. When work-
ing with equipment, the purchase price of a piece of equip-
ment should include the cost of the piece of equipment, sales
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Solution: The purchase price for the loader must be reduced by
the cost of the tires, for a cost of $130,000 ($135,000 – $5,000). The
annual depreciation and interest cost of the loader is determined by
Eq. (22-1) as follows:

�

TAXES AND LICENSING
Taxes and licensing includes all taxes and licensing fees as-
sessed by government agencies. Companies that own equip-
ment usually have to pay a property tax based on the value of
the equipment. These property taxes are often calculated by
multiplying an assessed value for the equipment by a speci-
fied tax rate. The property tax due each year is the same for a
piece of equipment that sits in the equipment yard all year as
for a piece of equipment that is used for most of the year;
therefore, it is considered an ownership cost. Additional li-
censing fees are often required for vehicles that travel over
public roads.

Taxes and licensing can be incorporated into the cost of
the equipment in two ways. The first uses the actual cost of
the taxes and licensing, which is obtained from the com-
pany’s accountant or estimated from the previous year’s tax
and licensing bills. The second way is to add the tax rate to
the interest rate used in Eq. (22-1) to cover the cost of taxes.

INSURANCE
Insurance is based on potential loss because of damage to
the insured equipment and potential loss because of damage
to other equipment and to people caused by the equipment.
The potential loss because of damage to the insured equip-
ment is a function of the value of the equipment. The loss of
a $10,000 dump truck in an accident is less than the loss of a
$60,000 dump truck. The potential loss because of damage
to other equipment and to people caused by the equipment
is independent of the cost of the equipment. A $10,000
dump truck can cause the same amount of damage as a
$60,000 dump truck.

Insurance costs can be incorporated into the cost of the
equipment in two ways. The first uses the actual cost of the
insurance, which is obtained from the company’s insurance
agent or estimated from the previous year’s insurance bills.
The second way is to add a percentage to the interest rate
used in Eq. (22-1) to cover the cost of insurance.

STORAGE
Companies often include equipment storage in the cost of
the equipment. Storage costs include the cost of property
used to store equipment, security for the property, and so
forth. Storage costs can be incorporated into the cost of the

CostD&I �
[$130,000(1 � 0.09)7 � $20,000](0.09)

[(1 � 0.09)7 � 1]
� $23,656/yr

equipment in two ways. The first uses actual cost of the
storage, which is done by allocating the storage costs to all of
the pieces of equipment owned by the company. The second
way is to add a percentage to the interest rate used in Eq.
(22-1) to cover the cost of storage.

HOURLY OWNERSHIP
COST
Thus far the ownership cost of the piece of equipment has
been determined on an annual basis. Because most equip-
ment is not used on a project for an entire year, the costs
must be converted to an hourly, weekly, or monthly cost.
This is done by estimating the number of billable hours,
weeks, or months the equipment will be used during the year
and dividing the annual cost by the billable number of
hours, weeks, or months. The hourly cost is determined by
the following equation:

(22-2)

where

CostHourly � Hourly Cost

CostAnnually � Annual Cost

Hours � Billable Hours

The weekly and monthly costs are determined by sub-
stituting billable weeks or billable months for hours into
Eq. (22-2), respectively. Because the ownership costs are the
same regardless of the number of hours the equipment is
used each year, the hourly, weekly, and monthly costs are
highly sensitive to the number of hours, weeks, and months
the equipment is used. If the usage of the equipment dou-
bles, the ownership costs are cut in half.

EXAMPLE 22-2

For the front-end loader in Example 22-1, the annual taxes and
licensing are $2,600, the annual insurance is $2,100, and the stor-
age cost is $1,200. It is estimated that the loader will operate 1,200
hours per year. Determine the hourly ownership cost of the
loader.

Solution: From Example 22-1, the annual depreciation and inter-
est cost is $23,656. The annual ownership cost is as follows:

The hourly ownership cost of the loader is determined by Eq. (22-2)
as follows:

�CostOwnership �
($29,556/yr)

(1,200!hr/yr)
� $24.63/hr

� $29,556/yr

� $23,656/yr � $2,600/yr � $2,100/yr � $1,200/yr

� CostStorage

CostOwnership � CostD&I � CostTaxes!&!Licensing � CostInsurance

CostHourly �
CostAnnually

Hours
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TIRES AND OTHER
WEAR ITEMS
Wear items include tires, cutting edges, bucket teeth, and
other items that frequently wear out. The cost of tires and
other wear items includes all costs associated with the pur-
chase or replacement of the item. Because the costs of tires
and other wear items are operating costs and their consump-
tion is more closely based on the hours of operation than the
duration of ownership, their life is often expressed in operat-
ing hours.

If the life of the tires and wear items is one year or less,
the hourly cost is determined by dividing the cost of the tires
or wear items by their life. The hourly cost is calculated by
the following equation:

(22-3)

where

CostTires/Wear � Hourly Cost of Tires or Wear Items

Cost � Cost of the Tires or Wear Items

Life � Useful Life of the Tires or Wear Items
in Hours

When the useful life of the tires or wear items is greater
than one year, the costs associated with these items are then
spread out over the life of the items, just as the price of a
piece of equipment is spread over the life of the piece of
equipment. The annual costs of the tires or wear items are
calculated using Eq. (22-1) and substituting the life of the
tires or wear items for the life of the equipment. The hourly
cost is then determined by using Eq. (22-2). Because the tires
and other wear items have a different useful life than the
equipment, they cannot simply be included in the deprecia-
tion and interest costs.

Although the life of the tires and other wear items is
based on operating hours, their life varies based on the
conditions under which the equipment operates. For ex-
ample, a bucket tooth digging in hard, blasted rock will
wear out faster than the same bucket tooth digging in
clay. When determining the life of tires and other wear
items, the operation conditions must be taken into ac-
count. The equipment manufacturer is a good source of
information on costs and life of tires and other wear
items.

Tire repair is included in the cost of the tires by using
the following equation:

(22-4)

where

CostTire Repair � Hourly Cost of Tire Repair

CostTires � Cost of the Tires

Life � Useful Life of the Tires in Hours

The repair multiplier is the historical repair cost of the
tire as a percentage of the cost of the tires and is calculated by

CostTire!Repair �
(Repair!Multiplier)(CostTires)

Life

CostTires/Wear �
Cost

Life

the following equation:

(22-5)

A common repair multiplier is 15%.

EXAMPLE 22-3

For the front-end loader in Example 22-1, the estimated life of the
tires is 3,000 hours and the repair multiplier is 15%. Determine the
hourly cost of the tires, including tire repair.

Solution: From Example 22-1, the cost of the tires is $5,000. The
life of the tires in years is calculated as follows:

The annual cost of the tires is calculated using Eq. (22-1) as follows:

The hourly cost of the tires is calculated using Eq. (22-2) as follows:

The hourly repair cost is calculated using Eq. (22-4) as follows:

The total hourly cost of tires and tire repair is $2.19 per hour
($1.94/hr � $0.25/hr). �

FUEL
Fuel consumption is a function of the number of hours of
operation. Like tires and other wear items, the consumption
of fuel varies based on the conditions under which the
equipment operates. For example, an excavator digging in
hard-to-dig shale will consume more fuel per hour than will
the same piece of equipment digging in easy-to-dig sand.
When determining fuel consumption, the operation condi-
tions must be taken into account. The equipment manufac-
turer is a good source of information on the rate of fuel con-
sumption. The cost of fuel is calculated by multiplying the
fuel consumption by the estimated fuel cost per gallon.

EXAMPLE 22-4

For the front-end loader in Example 22-1, it is estimated that under
normal conditions it will consume 3 gallons of diesel per hour.
Using a cost of $1.95 per gallon of diesel, determine the fuel cost for
the front-end loader.

Solution: The cost of the fuel is calculated as follows:

�

LUBRICANTS AND FILTERS
Lubricants and filters include oils for use in the engine,
transmission, and final drives; hydraulic fluids; grease; air fil-
ters; oil filters; hydraulic filters; transmission filters; and fuel

CostFuel � (3!gal/hr)($1.95/gal) � $5.85/hr

CostTire!Repair �
(0.15)($5,000)

(3,000!hr)
� $0.25/hr

CostHourly �
($2,322/yr)

(1,200!hr/yr)
� $1.94/hr

CostAnnual �
[$5,000(1 � 0.09)2.5 � $0](0.09)

[(1 � 0.09)2.5 � 1]
� $2,322/yr

n �
(3,000!hr)

(1,200!hr/yr)
� 2.5!yr

Repair!Multiplier �
Repair!Cost

CostTires
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filters. Lubricant consumption includes the replacement of
the lubricants at regular intervals and the loss of lubricants
because of leaks. The cost of lubricants and filters is a func-
tion of the number of hours of operation. Like other oper-
ating costs, the cost of lubricants and filters varies based on
the conditions under which the equipment operates. For
example, a truck working in a dusty, off-road environment
will require more frequent changing of the air filter than
would a truck operating on a paved highway. The opera-
tion conditions must be taken into account when deter-
mining the cost of lubricants and filters. Equipment manu-
facturers often provide information on the rate of
consumption of lubricants and filters, which, combined
with local pricing, can be used to estimate the cost of lubri-
cants and filters.

EXAMPLE 22-5

For the front-end loader in Example 22-1, it is estimated that under
normal conditions its hourly lubricant consumptions are as fol-
lows: crankcase, transmission, final dri-
ves including differential, and hydraulic controls,

A tube of grease is used during each 8-hour day to lu-
bricate the grease fittings. The local costs of lubricants are as fol-
lows: oil for the crankcase, transmission fluid,
oil for the final drives, hydraulic fluid, and
grease, The filters for the loader cost $0.18 per hour of
operation including the labor to install them. Determine the cost of
lubricants and filters for the loader.

Solution: The cost of lubricants and filters is calculated as follows:

�

REPAIR RESERVE
Repairs include all operation costs not included in one of the
foregoing items and including preventative maintenance
(not included in lubricants and filters), repairs from damage
and wear (not included in tires and other wear items), and
overhauls. As a piece of equipment gets older, the need for
repairs and the associated costs increase, resulting in the
need to increase the operational cost over the life of the piece
of equipment. Rather than increasing the cost over time, the
average hourly cost over the life of the equipment is used.
Using the average hourly cost produces excess funds during

� $0.90/hr

� (1!tube/8!hr)($4.24/tube) � $0.18/hr

� (0.006!gal/hr)($9.34/gal) � (0.007!gal/hr)($3.61/gal)

CostL&F � (0.010!gal/hr)($7.43/gal) � (0.006!gal/hr)($5.83/gal)

$4.24/tube.
$3.61/gal;$9.34/gal;

$5.83/gal;$7.43/gal;

0.007!gal/hr.
0.006!gal/hr;

0.006!gal/hr;0.010!gal/hr;

the early life of the piece of the equipment, which is placed in
reserve to cover the higher cost of maintenance during the
latter part of a piece of equipment’s life. These excess funds
are known as a repair reserve. Equipment manufacturers
often provide information on the repair reserve required for
a piece of equipment.

EXAMPLE 22-6

For the front-end loader in Example 22-1, the repair reserve is
$6.50 per hour. Determine the hourly operation cost and hourly
ownership and operation cost of the loader.

Solution: Using data from Examples 22-3 through 22-5, we calcu-
late the hourly operation cost as follows:

Using the hourly cost of ownership from Example 22-2, we calcu-
late the hourly ownership and operation cost as follows:

�

LEASED EQUIPMENT
With leased equipment the depreciation and interest costs
are replaced with the lease payment. With a typical lease, the
company leasing the equipment is still responsible for pay-
ing the cost of the taxes and licenses, insurance, storage, tires
and wear items, fuel, lubricants and filters, and repairs.
These costs are calculated in the same manner as they are
calculated for owned equipment.

RENTED EQUIPMENT
With most rented equipment the depreciation and interest,
taxes and licenses, insurance, storage, tires and wear items,
lubricants and filters, and repairs are covered by the com-
pany that rents the equipment. This leaves the contractor to
pay the rental cost and the cost of fuel. However, rental
agreements may vary, and the estimator should verify which
costs are covered by the rental cost. The cost of the equip-
ment equals the rental cost plus any costs not covered by the
rental agreement. The costs not covered by the rental agree-
ment are calculated in the same manner as they are calcu-
lated for owned equipment.

� $40.07/hr

Cost � CostOwnership � CostOperation � $24.63/hr � $15.44/hr

� $15.44/hr

� $2.19/hr � $5.85/hr � $0.90/hr � $6.50/hr

CostOperation � CostTire � CostFuel � CostL&F � CostRepair!Reserve

EXCEL QUICK TIP 22-1

Equipment Cost Worksheet

A spreadsheet can be set up to calculate the ownership and
operation cost for equipment. The spreadsheet shown in
the following figure allows the user to account for tires; al-

ternatively, the user may replace the tires with another wear
item. This spreadsheet assumes that the tires have a life of
greater than one year.
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and is formatted using the comma style, which replaces
zeros with dashes.

The data for the equipment is entered into Cells B2
through B9 and Cells E2 through E18. The data shown in
the foregoing figure is from Examples 22-1 through 22-6

To complete this spreadsheet, enter the data and format the cells as shown in the figure. The following formulas need to be
entered into the associated cells:

A B C D E
1
2 Purchase Price ($) 135,000 Tires ($) 5,000
3 Salvage Value ($) 20,000 Tire Life (hr) 3,000
4 Equipment Life (yr) 7 Repair Multiplier 15.00%
5 Billable Hours (hr/yr) 1,200 Fuel Consumption (gal/hr) 3.00
6 Interest Rate 9.00% Fuel Cost ($/gal) 1.95
7 Taxes & Licensing ($/yr) 2,600 Crankcase (gal/hr) 0.010
8 Insurance ($/yr) 2,100 Transmission (gal/hr) 0.006
9 Storage ($/yr) 1,200 Final Drives (gal/hr) 0.006

10 Ownership Cost ($/hr) 24.63 Hydraulic Controls (gal/hr) 0.007
11 Grease (tubes/hr) 0.125
12 Total ($/hr) 40.07 Filters ($/hr) 0.18
13 Crankcase Oil ($/gal) 7.43
14 Transmission Fluid ($/gal) 5.83
15 Final Drive Oil ($/gal) 9.34
16 Hydraulic Fluid ($/gal) 3.61
17 Grease ($/tube) 4.24
18 Repair Reserve ($/hr) 6.50
19
20 Tires ($/hr) 2.18
21 Fuel ($/hr) 5.85
22 Lubricants and Filters ($/hr) 0.90
23 Operation Cost ($/hr) 15.44

Ownership Cost Operation Cost

Cell Formula

B10 =(((B2-E2)*(1+B6)^B4–B3)*B6/((1+B6)^B4-1)+B7+B8+B9)/B5
B12 =B10+E23

E20 =E2*(1+B6)^(E3/B5)*B6/((1+B6)^(E3/B5)-1)/B5+E4*E2/E3
E21 =E5*E6

E22 =E7*E13+E8*E14+E9*E15+E10*E16+E11*E17+E12

E23 =E18+E20+E21+E22

CONCLUSION
Equipment costs include the ownership costs of deprecia-
tion and interest, taxes and licenses, insurance, and storage;
and the operation costs of tires and other wear items, fuel,
lubricants and filters, and repair reserves. Data to calculate
these costs are available from historical data and the equip-
ment manufacturer.

PROBLEMS
1. The purchase price of a loader including the tires, sales

tax, and all other costs associated with its purchase is
$210,000. The life of the loader is 9 years, at which time
it will have an estimated salvage value of $23,000. The
replacement cost of the tires is $11,000 for all tires on

the loader. The life of the tires is estimated to be 3,600
hours. Tire repairs are expected to be 15% of the cost of
the tires. The interest rate is 7.5%. The company adds to
the interest rate 1.5% for property taxes, 2.0% for insur-
ance, and 1.0% for storage. The fuel consumption is es-
timated to be at an estimated cost of

It is estimated that under normal conditions
its hourly lubricant consumptions are as follows:
crankcase, transmission, final
drives including differential, and hydraulic
controls, Two tubes of grease are used dur-
ing each 8-hour day to lubricate the grease fittings. The
local costs of lubricants are as follows: oil for the
crankcase, transmission fluid, oil
for the final drives, hydraulic fluid,
and grease, The filters for the loader cost$3.89/tube.

$3.41/gal;$8.79/gal;
$5.49/gal;$6.99/gal;

0.035!gal/hr.
0.039!gal/hr;

0.018!gal/hr;0.064!gal/hr;

$2.10/gal.
10.75!gal/hr,
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of operation, including the labor to install
them. The estimated repair reserve is Using
1,500 billable hours per year, determine the hourly own-
ership and operation cost of the loader.

2. The purchase price of the hydraulic excavator, including
sales tax and all other costs associated with its purchase,
is $150,000. The life of the excavator is 6 years, at which
time it will have an estimated salvage value of $20,000.
The interest rate is 8.25%. The taxes and licensing costs
are the insurance costs are and the
storage costs are The fuel consumption is
estimated to be at an estimated cost of

It is estimated that under normal conditions,$1.85/gal.
3.0!gal/hr,
$2,110/yr.

$2,930/yr,$3,220/yr,

$14.40/hr.
$0.44/hr its hourly lubricant consumptions are as follows:

crankcase, final drives, and
hydraulic controls, One tube of grease is
used during each 8-hour day to lubricate the grease fit-
tings. The local costs of lubricants are as follows: oil for
the crankcase, oil for the final drives,

hydraulic fluid, and grease,
The filters for the excavator cost of

operation, including the labor to install them. The esti-
mated repair reserve is Using 1,400 billable
hours per year, determine the hourly ownership and op-
eration cost of the excavator.

3. Set up Excel Quick Tip 22-1 in Excel.

$4.20/hr.

$0.25/hr$4.01/tube.
$3.56/gal;$8.99/gal;

$7.43/gal;

0.021!gal/hr.
0.001!gal/hr;0.008!gal/hr;
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In this chapter you will learn how to calculate crew labor and
equipment rates, the average cost of labor per labor hour, and
the equipment cost per labor hour.

Most work on a construction project requires the
use of more than one class of employee and may
involve multiple pieces of equipment. For exam-

ple, the framing of a building often requires a lead carpenter
or foreperson, journeyman carpenters, apprentice carpen-
ters, and laborers, as well as compressors, nail guns, and a
forklift. An estimator needs to be able to calculate the aver-
age cost of labor per labor hour for a specific crew and the
equipment cost per labor hour. This is because the produc-
tivity is based on the number of labor hours needed to per-
form a unit of work.

The average labor cost is calculated by summing the cost
of labor for the entire crew for one day and then dividing it
by the number of labor hours performed by the crew during
one day. The labor cost is determined by multiplying the
number of workers in the class by the labor rate for the class
by the number of hours worked per day, as shown in the fol-
lowing equation:

(23-1)

Determining the labor rate is discussed in Chapter 21.
The equipment cost per labor hour is determined by

summing the cost of all of the equipment for one day and
then dividing it by the number of labor hours performed by
the crew during one day. The equipment cost is calculated
from hourly rates by multiplying the number of pieces of the
same type of equipment by the equipment cost by the number
of hours worked per day, as shown in the following equation:

(23-2)� (Hours!Worked!per!Day)

CostEquipment � (No.!of!Pieces)(Equipment!Cost)

CostLabor� (Workers)(Labor!Rate)(Hours!Worked!per!Day)

Alternatively, the equipment cost may be determined
from daily rates by multiplying the number of pieces of the
same type of equipment by the equipment cost, as shown in
the following equation:

(23-3)

Determining the equipment cost is discussed in
Chapter 22. Determining the average cost of labor per labor
hour and equipment cost per labor hour is shown in the fol-
lowing example.

EXAMPLE 23-1

A pipe-laying crew consists of two hydraulic excavators, a front-end
loader, a trench box, a gravel box, a foreperson, a pipe layer, two
equipment operators, and a laborer. The cost of a hydraulic excavator
is $90.00 per hour, a front-end loader is $75.00 per hour, a trench box
is $25.00 per day, and a gravel box is $18.00 per day. The foreman
costs $25.00 per hour, an operator costs $18.00 per hour, the pipe
layer costs $16.50 per hour, and the laborer costs $12.00 an hour.
Labor costs include labor burdens. All employees work an 8-hour day
except the foreperson, who works a 9-hour day. Determine the aver-
age cost of labor per labor hour and the equipment cost per labor
hour for the pipe-laying crew.

Solution: The daily labor costs for each class of worker are calcu-
lated using Eq. (23-1) as follows:

The daily labor cost for the entire crew is calculated as follows:

� $741.00/day

� $96.00/day

CostLabor � $225.00/day � $132.00/day � $288.00/day

CostLaborer � (1)($12.00/hr)(8!hr/day) � $96.00/day

CostOperators � (2)($18.00/hr)(8!hr/day) � $288.00/day

CostPipe!Layer � (1)($16.50/hr)(8!hr/day) � $132.00/day

CostForeperson � (1)($25.00/hr)(9!hr/day) � $225.00/day

CostEquipment � (No.!of!Pieces)(Equipment!Cost)

CREW RATES

CHAPTER TWENTY-THREE
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The number of labor hours (lhr) worked in one day is calculated as
follows:

The average cost per labor hour is calculated as follows:

The daily equipment costs for each type of equipment are calcu-
lated using Eq. (23-2) and (23-3) as follows:

CostGravel!Box � (1)($18.00/day) � $18.00/day

CostTrench!Box � (1)($25.00/day) � $25.00/day

CostLoader � (1)($75.00/hr)(8!hr/day) � $600.00/day

CostExcavators � (2)($90.00/hr)(8!hr/day) � $1,440.00/day

CostLabor Hour �
($741.00/day)

(41!lhr/day)
� $18.07/lhr

� 41!lhr/day

� (1)(8!hr/day)

Hours � (1)(9!hr/day) � (1)(8!hr/day) � (2)(8!hr/day)

The daily equipment cost for the entire crew is calculated as follows:

The equipment cost per labor hour (lhr) is calculated as follows:

�

The crew makeup can be determined by a number of
factors. Sometimes, limits on the crew makeup are set by con-
tract or government regulations. For example, state law may
require there be at least one journeyman plumber for every
two apprentice plumbers on a job. Crew makeup is also de-
termined by the size of the job. A small framing job may only
require a journeyman carpenter and a laborer, whereas a
large job may require a lead carpenter, three journeyman car-
penters, four apprentice carpenters, and three laborers.

CostEquipment �
($2,083.00/day)

(41!lhr/day)
� $50.80/lhr

� $2,083.00/day

� $25.00/day � $18.00/day

CostEquipment � $1,440.00/day � $600.00/day

EXCEL QUICK TIP 23-1

Crew Rates Worksheet

The following spreadsheet can be used to calculate the average cost of labor per labor hour and the equipment cost per
labor hour for a crew.

To complete this spreadsheet, enter the data and format the cells as shown in the figure. The following formulas need to be
entered into the associated cells:

A B C D E F

1
2
3
4 Foreperson 1 25.00 9.00 225.00
5 Pipe Layer 1 16.50 8.00 132.00
6 Operators 2 18.00 8.00 288.00
7 Labor 1 12.00 8.00 96.00
8 -
9 -

10 41.00 741.00
11
12 18.07
13

14
15
16
17 Excavator 2 90.00 8.00 1,440
18 Loader 1 75.00 8.00 600
19 Trench Box 1 25.00 25
20 Gravel Box 1 18.00 18
21 -
22 -
23 2,083
24
25 50.80

Cost Per Labor Hour

Labor

Class Number Rate Hr/Day
Daily

Wages

Cost Per Labor Hour

Equipment

Number
Hourly
Rate Hr/Day Daily Rate

Daily
WagesClass
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After entering these formulas, copy Cell E4 to Cells E5
through E9 and copy Cell F17 to Cells F18 through F22.

The data for the labor and equipment is entered into
Cells A4 through E9 and Cells A17 through F22. Costs for
equipment should only be entered in Column D (the
hourly rate) or Column E (the daily rate) but not both. The
data shown in the foregoing figure is from Example 23-1
and is formatted using the comma style, which replaces
zeros with dashes.

Cell Formula

E4 =B4*C4*D4

D10 =B4*D4+B5*D5+B6*D6+B7*D7+B8*D8+B9*D9

E10 =SUM(E4:E9)

E12 =E10/D10

F17 =B17*C17*D17+B17*E17

F23 =SUM(F17:F22)

F25 =F23/D10

CONCLUSION
The average labor rate per labor hour for a crew is deter-
mined by calculating the daily cost of the crew and dividing
it by the labor hours performed by the crew. The equipment
cost per labor hour is determined by calculating the daily
cost of the equipment and dividing it by the number of labor
hours worked by the crew.

PROBLEMS
1. An excavation crew consists of a hydraulic excavator,

three dump trucks, a foreperson, and three truck dri-
vers. The foreperson operates the hydraulic excavator.
The cost of a hydraulic excavator is and a
truck costs The foreperson costs
and a truck driver costs Labor costs include$15.00/hr.

$25.00/hr$55.00/hr.
$90.00/hr

labor burdens. All employees work an 8-hour day.
Determine the average cost per labor hour and the
equipment cost per labor hour for the excavation crew.

2. A carpentry crew consists of a lead carpenter, three
journeyman carpenters, four apprentice carpenters, and
three laborers. The lead carpenter costs a
journeyman carpenter costs an apprentice
carpenter costs and a laborer costs
Labor costs include labor burdens. All employees work an
8-hour day, except the foreperson, who works a 9-hour
day. The equipment to support the carpenters includes
six nail guns, three saws, two compressors, and a forklift.
A nail gun costs a saw costs a compressor
costs and a forklift costs Determine
the average cost per labor hour and the equipment cost
per labor hour for the carpentry crew.

3. Set up Excel Quick Tip 23-1 in Excel.

$35.00/hr.$10/day,
$4/day,$5/day,

$11.52/hr.$15.75/hr,
$19.59/hr,

$24.00/hr,



In this chapter you will learn how to obtain subcontract pric-
ing, including how to prepare a request for a quote and a scope
of work, as well as how to select the best bid.

Subcontractors provide labor and often materials
and equipment to the project for a fixed price or for
a unit price. The best source of subcontractor pricing

is the subcontractor. When pricing from the subcontractor is
not available, the subcontractor pricing can be estimated
from historical data.

When obtaining pricing from the subcontractor, it is
important for the subcontractor and the contractor to
clearly communicate the work that is to be performed, the
price for the work, and any other conditions associated with
the work. This is best done by communicating these parame-
ters in writing in the form of a Request for Quote (RFQ) and
having the subcontractor respond with a written proposal.
The Request for Quote, sometimes referred to as a Request
for Proposal (RFP), is sent to the subcontractor. The prepa-
ration and submission of quotes is discussed in Chapter 28.

REQUEST FOR QUOTE
Prior to preparing the RFQ, the estimator needs to break the
project down into work packages. Each work package should
consist of work that would be done by a specific class of sub-
contractor or in-house crew. For example, a project may
contain an electrical work package that consists of the elec-
trical work needed to complete the project. Once the work
packages have been identified, the estimator needs to iden-
tify which subcontractors he or she wants to bid on each of
the work packages to be subcontracted out. Next, the estima-
tor needs to contact each of the subcontractors and obtain a
commitment that the subcontractor will provide a bid for
the project. Finally, the estimator should send each subcon-
tractor the RFQ for the work package that the subcontractor

has agreed to bid. This is done to prevent miscommunica-
tions as to the project, its bid time, and the scope of the work
needed to be performed to complete the work package. The
RFQ should contain the name of the subcontractor from
whom the quote is being requested, the name of the contrac-
tor requesting the quote, the project for which the quote is
being requested, the bid date and time for the project, and
the scope of the work included in the work package. A sam-
ple RFQ is shown in Figure 24-1.
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FIGURE 24-1 Request for Quote



FIGURE 24-2 Sample Scope of Work

WRITING A SCOPE OF WORK
For the RFQ to be useful it must clearly define the scope or
limits of work to be performed; it will become the basis of
the contract. Writing contracts is discussed in Chapter 29.
The scope of work should clearly delineate what work is in-
cluded in the work package and what is excluded. The scope
of work should include any clarifications, exclusions, and
other assumptions necessary to clearly define the scope of
the work package.

The different scopes of work should cover all materials,
labor, and equipment needed to complete the project. There
should be no gaps among different scopes of work, other-
wise the contractor might leave some costs out of the pricing
and be open to a change order. Care must also be taken to
ensure that there are no overlaps between multiple scopes of
work. This would not only create confusion by duplicating
work in two different scopes of work, but might lead the
contractor to pay for the work twice if the duplication goes
unnoticed. If an overlap between scopes of work is identi-
fied, the contractor must issue a change order or have
changes made to the quotes to rectify the mistake.

Well-prepared scopes of work are particularly important
when the lines delineating the work performed by two sub-
contractors are not clearly defined. This often occurs when
there are two subcontractors working on a piece of equip-
ment. For example, when installing a gas-fired hot-water
heater provided by the plumbing subcontractor and a gas-

fired furnace provided by the HVAC subcontractor, which
subcontractor is responsible for providing the gas lines? If the
HVAC subcontractor provides the gas lines, is the HVAC sub-
contractor responsible for connecting the gas lines to the hot-
water heater, or does the HVAC subcontractor just provide a
valve next to the hot-water heater, with the plumbing sub-
contractor responsible for connecting the hot-water heater to
the gas lines? The reverse is true for the furnace when the
plumbing subcontractor is providing the gas lines.

The scope of work can be prepared by referencing all or
part of a set of contract documents, for example, the plans
and project manual. When referencing a set of contract doc-
uments, the reference should include the title of the project,
the architect or engineer who prepared the documents, and
the document dates. It is very important to include the date
for the drawings because the drawings may be revised dur-
ing the bidding process and it is important to know on
which drawings the scope of work is based. This may require
that a table of drawings, with their dates, be included in the
scope of work. A scope of work based on the contract docu-
ment may be written as shown in Figure 24-1

Alternatively, the scope of work can be prepared by
specifically spelling out what is included and what is ex-
cluded, as shown in Figure 24-2. In this scope of work the
framing subcontractor provides the labor, equipment, and
some of the materials to construct a home and the general
contractor provides the rest of the materials.
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Sample scopes of work are given in Appendix D and
may be used as the basis of writing your own scopes of work.

HISTORICAL
In the absence of subcontractor pricing for the project, the es-
timated subcontractor cost can be calculated from historical
data. Historical costs are determined by obtaining past costs
from the accounting system or contracts for a certain quantity
of work and dividing it by the quantity of work performed.
This calculation is expressed by the following equation:

(24-1)

EXAMPLE 24-1

A recent project included 1,235 square feet of wood-framed build-
ing. The framing was subcontracted out for $5,700. Determine the
framing cost per square foot of building.

Solution: The framing cost per square foot is calculated using
Eq. (24-1) as follows:

�

The historical cost is then multiplied by the quantity of
work that needs to be performed on the project to obtain an
estimate of the cost of the subcontract work. This calcula-
tion is expressed by the following equation:

(24-2)

EXAMPLE 24-2

Using the data from Example 24-1, estimate the cost to subcontract
out the framing for a 2,200-square foot building. The framing of
the building in Example 24-1 is similar to this building.

Solution: The estimated framing cost is calculated using Eq. (24-2)
as follows:

�

With materials, one is able to determine accurate quan-
tities for each component. With subcontracting, it is impos-

Costs � ($4.62/ft2)(2,200!ft2) � $10,164

Cost � (Quantity)(Cost!per!Unit)

Cost!per!Unit �
($5,700)

(1,235!ft2)
� $4.62/ft2

Cost!per!Unit �
Cost

Quantity

sible to do this because the pricing data is often a single
price for an entire work package. Because of this, the esti-
mator must make sure that the historical data used in esti-
mating subcontractor work is for a project that is very simi-
lar to the project he or she is bidding; otherwise, there could
be a big discrepancy between the actual cost of the work and
the cost used in the estimate. The comparison should be
based on the size of the project, complexity of the work, and
materials used.

BID SELECTION
When receiving bids from multiple subcontractors, the esti-
mator must select the subcontractor with the best quote.
Selection should be based on completeness of the scope of
work, price, schedule, quality, and performance of the sub-
contractor.

The most important thing to do when one receives a
quote from a subcontractor is to verify that the subcontrac-
tor has bid a complete work package without any extras. If
the subcontractor has not bid a complete work package, the
estimator needs to fill in the missing items or have the sub-
contractor provide costs for the missing items. If the subcon-
tractor has extra items in the bid, the estimator needs to have
the subcontractor deduct them.

Historically, contractor and subcontractor selection has
been based on price alone. Many owners and contractors are
beginning to select their contractors and subcontractors
based on which subcontractor provides the best bid based
on price, the ability of the subcontractor to meet the sched-
ule and quality standards, and the past performance of the
subcontractor. It may well be worth the extra cost to pay
more for a subcontractor who can shorten the schedule and
meet the quality standards the first time. Failure to meet the
quality standards increases the duration of a project because
it takes time to rework the materials. It also increases costs
because the employees who are to perform these tasks have
to wait for the quality defect to be repaired before proceed-
ing. Scheduling delays, either because of poor schedule per-
formance or poor quality, increase the duration of the pro-
ject, which increases the project’s overhead cost. The best
way to judge the quality and schedule performance of sub-
contractors is based on their past performance.

CONCLUSION

Subcontractor pricing is best obtained from the subcontrac-
tors who are interested in performing the work on the pro-
ject. When getting bids from subcontractors it is important
that the estimator clearly communicate the work package
that he or she wants the subcontractor to bid, the project to
be bid, and the bid date and time. This is best done by send-
ing a Request for Quote (RFQ) to the subcontractor. The
RFQ should contain a complete scope of work for the work
package. The scope of work should clearly delineate what

work is included in the work package and what is excluded.
The scope of work should be clearly defined including any
clarifications, exclusions, and other assumptions. When
pricing from the subcontractor is not available, the esti-
mated subcontractor cost can be calculated from historical
data. Historical costs are determined by obtaining past costs
from the accounting system or contracts for a certain quan-
tity of work and dividing it by the quantity of work per-
formed. When selecting among subcontractors, selection
should be based on completeness of the scope of work, price,
schedule, quality, and performance.



260 CHAPTER TWENTY-FOUR

PROBLEMS
1. A recent project included a 21,000-square foot ware-

house with tilt-up concrete panel exterior. The con-
struction of the tilt-up panels was subcontracted for
$74,000. Determine the cost of the tilt-up panels per
square foot of warehouse.

2. In a recent project, a 2,200-square foot, single-story of-
fice building was constructed with a 30-year architec-
tural shingle. The roofing was subcontracted for $3,900.
Determine the cost of the roofing per square foot of of-
fice building.

3. Using the data from Problem 1, estimate the cost to
subcontract out the tilt-up concrete panels for an

18,000-square foot warehouse. The warehouse design is
similar to that of the warehouse in Problem 1.

4. Using the data from Problem 2, estimate the cost to sub-
contract out the roofing for a 2,800-square foot office
building. The roofing and roof design are similar to
those of the office building in Problem 2.

5. Prepare scope of works for the drawings of the residen-
tial garage given in Appendix F.

6. Prepare scope of works for the drawings of the Johnson
Residence given in Appendix F.

7. Prepare scope of works for the drawings of the West
Street Video given in Appendix F.



In this chapter you will learn how to determine markups for the
building permit, payment and performance bonds, and profit
and overhead.

Markups are costs that are added to the cost of the
bid. The most common markups include a build-
ing permit, payment and performance bonds,

and profit and overhead. Let’s begin by looking at the build-
ing permit costs.

BUILDING PERMITS
Building permits are required on many construction pro-
jects. Highway and federal projects do not require building

permits nor do many state and municipal projects. Building
permits are used to cover the costs of inspections to verify
that the project is being built in accordance with the applica-
ble building codes. The cost of the building permit is based
on the valuation of the project, which may be based on the
actual bid for the project or a standardized cost per square
foot established by the code enforcement agency. Sample
building permit costs are shown in Table 25-1. The estimator
should check with the contracting officer or code enforce-
ment agency to determine (1) if a building permit is re-
quired, (2) how the valuation of the building is established,
and (3) the building permit cost schedule used by the code
enforcement agency.

The building permit costs are calculated by selecting the
appropriate range for the valuation of the project in the left
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TABLE 25-1 Sample Building Permit Costs

Total Valuation ($) Rate

1.00 to 500.00 $23.50

501.00 to 2,000.00 $23.50 for first $500.00 plus $3.05 for each additional $100.00 or fraction thereof, to and
including $2,000.00

2,001.00 to 25,000.00 $69.25 for first $2,000.00 plus $14.00 for each additional $1,000.00 or fraction thereof, to and
including $25,000.00

25,001.00 to 50,000.00 $391.25 for first $25,000.00 plus $10.10 for each additional $1,000.00 or fraction thereof, to
and including $50,000.00

50,001.00 to 100,000.00 $643.75 for first $50,000.00 plus $7.00 for each additional $1,000.00 or fraction thereof, to and
including $100,000.00

100,001.00 to 500,000.00 $993.75 for first $100,000.00 plus $5.60 for each additional $1,000.00 or fraction thereof, to
and including $500,000.00

500,001.00 to 1,000,000.00 $3,233.75 for first $500,000.00 plus $4.75 for each additional $1,000.00 or fraction thereof, to
and including $1,000,000.00

1,000,000.00 and up $5,608.75 for first $1,000,000.00 plus $3.15 for each additional $1,000.00 or fraction thereof

1997 Uniform Building Code. Copyright 2003. Falls Church, Virginia: International Code Council, Inc. Reproduced with permission.
All Rights Reserved.



column and determining the cost in accordance with the
right column. These calculations are shown in the following
example.

EXAMPLE 25-1

Using the building permit costs in Table 25-1, determine the build-
ing permit cost for a project valued at $250,061.

Solution: The valuation falls between $100,001 and $500,000;
therefore, the cost of the building permit is $993.75 for the first
$100,000 plus $5.60 for each additional $1,000 or fraction thereof.
The valuation exceeds $100,000 by $150,061, or 151 additional
$1,000s. The building permit cost is calculated as follows:

�Building!Permit!Cost � $993.75 � (151)($5.60) � $1,839.35

In this example, it was assumed that the building permit
valuation was known and did not change when the cost of
the building permit was added to the bid. This is the case
when the valuation is based on a standardized cost per
square foot established by the code enforcement agency
rather than the bid. When the cost of the building permit is
based on the bid, the cost of the building permit will increase
the cost of the bid, which will in turn change the cost of the
building permit, which will increase the cost of the bid, and
so on until the changes are insignificant. When this is the
case, either a rough estimate for the cost of the building per-
mit must be included in the bid prior to the calculation of
the cost of the building permit or the cost of the building
permit must be calculated by iteration. Chapter 32 will look
at using iteration in a spreadsheet.
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EXCEL QUICK TIP 25-1

Building Permit Cost Worksheet

The following spreadsheet can be used to calculate the cost of the building permit:

To complete this spreadsheet, enter the data and format the cells as shown in the above figure. The following formulas need
to be entered into the associated cells:

After entering these formulas, copy Cell B2 to Cells B3 through B6 and Cell E2 to Cells E3 through E7. Cell E10 uses the
ROUNDUP function to round up the valuation to the nearest $1,000 increment. Cell E11 uses nested IF functions to cal-
culate the permit cost.

The building permit cost data is entered into Cells A2 through A7, C2 through C7, and F2 through F7, and the valua-
tion is entered in Cell F9. The data shown in the foregoing figure is from Table 25-1 (excluding permits under $2,000) and
Example 25-1.

A B C D E F

1 From To

Per
Additional

$1,000
2 2,001 25,000 69.25 for first 2,000 14.00
3 25,001 50,000 391.25 for first 25,000 10.10
4 50,001 100,000 643.75 for first 50,000 7.00
5 100,001 500,000 993.75 for first 100,000 5.60
6 500,001 1,000,000 3,233.75 for first 500,000 4.75
7 1,000,001 5,608.75 for first 1,000,000 3.15
8
9 250,061

10 251,000
11 1,839.35Buiding Permit Cost

Base Rate

Valuation Rounded
Input Valuation

Cell Formula

B2 =A3-1

E2 =A2-1

E10 =ROUNDUP(E9,-3)

E11 =IF(E10<A2,C2,

IF(E10<A3,C2+(E10-E2)*F2/1000,

IF(E10<A4,C3+(E10-E3)*F3/1000,

IF(E10<A5,C4+(E10-E4)*F4/1000,

IF(E10<A6,C5+(E10-E5)*F5/1000,

IF(E10<A7,C6+(E10-E6)*F6/1000,C7+(E10-E7)*F7/1000))))))
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TABLE 25-2 Sample Bond Schedule

Total Estimate ($) Bond Rate (%)

0 to 50,000 1.50

50,001 to 100,000 1.25

100,001 to 250,000 1.00

250,001 to 500,000 0.90

500,001 to 1,000,000 0.80

1,000,001 PLUS 0.75

PAYMENT AND
PERFORMANCE BONDS
Many jobs require payment and performance bonds. The
cost of the bond is based on the total bid. The bonding
schedule is divided into different brackets with a different
bonding rate being applied to each bracket. A sample bond-
ing schedule is shown in Table 25-2. A contractor using the
bonding schedule in Table 25-2 would pay 1.5% on the first
$50,000 of a bid, 1.25% on the next $50,000 ($100,000 �
$50,000), 1% on the next $150,000 ($250,000 � $100,000),
and so forth.

EXAMPLE 25-2

Using the bond costs in Table 25-2, determine the bonding cost for
a project bid at $458,265.

Solution: The company will pay 1.5% on the first $50,000, 1.25%
on the next $50,000, 1% on the next $150,000, and 0.9% on the re-
maining $208,265. The bonding cost is calculated as follows:

�

Because the cost of the bonds is based on the bid, the
cost of the bonds will increase the bid, which will in turn in-
crease the cost of the bonds, which will increase the cost of
the bid, and so on until the changes are insignificant. To deal
with this, either a rough estimate for the cost of the bonds
must be included in the bid prior to the calculation of the
cost of the bonds or the cost of the bonds must be calculated
by iteration. Chapter 32 will look at using iteration in a
spreadsheet to determine the cost of the bonds.

Bond!Cost � $4,749.39

� ($150,000)(0.01) � ($208,265)(0.009)

Bond!Cost � ($50,000)(0.015) � ($50,000)(0.0125)

EXCEL QUICK TIP 25-2

Bond Cost Worksheet

The following spreadsheet can be used to calculate the
cost of a bond:

A B C
1 From To Rate(%)
2 - 50,000 1.50%
3 50,001 100,000 1.25%
4 100,001 250,000 1.00%
5 250,001 500,000 0.90%
6 500,001 1,000,000 0.80%
7 1,000,001 0.75%
8
9 Bid 458,265

10 Bond 4,749

After entering these formulas, copy Cell B2 to Cells B3
through B6. Cell C10 uses nested IF functions to calculate
the cost of the bond.

The bond ranges and rates are entered into Cells A3
through A7 and C2 through C7. The bid is entered into
Cell C9. The data shown in the foregoing figure is from
Table 25-2 and Example 25-2.

To complete this spreadsheet, enter the data and format
the cells as shown. The following formulas need to be en-
tered into the associated cells:

Cell Formula

B2 =A3-1

C10 =IF(C9<=B2,C9*C2,

IF(C9<=B3,(C9-B2)*C3+B2*C2,

IF(C9<=B4,(C9-B3)*C4+(B3-B2)*

C3+B2*C2,

IF(C9<=B5,(C9-B4)*C5+(B4-B3)*C4+

(B3-B2)*C3+B2*C2,

IF(C9<=B6,(C9-B5)*C6+(B5-B4)*C5+

(B4-B3)*C4+(B3-B2)*C3+B2*C2,

(C9–B6)*C7+(B6-B5)*C6+

(B5-B4)*C5+(B4-B3)*

C4+(B3-B2)*C3+B2*C2)))))

PROFIT AND OVERHEAD
The profit and overhead (P&O) markup is used to cover the
general overhead required by the main office and to provide
a profit to the company owners. The profit and overhead
markup is expressed as a percentage of the construction cost,
which often includes the cost of the building permit and
bond. The profit and overhead markup is determined by
multiplying the construction cost by the profit and overhead
markup rate as shown in the following equation:

(25-1)

P&O!Markup �
(Construction!Cost)(P&O!Markup!%)

100%
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EXAMPLE 25-3

The estimated construction cost for a project is $452,632. The com-
pany’s profit and overhead markup is 5% of construction cost.
Determine the profit and overhead markup.

Solution: The profit and overhead markup is determined as fol-
lows using Eq. (25-1):

�

Not all projects can or should be bid at the same profit
and overhead markup. A company should set a minimum
profit and overhead markup and then increase the markup
when conditions warrant1. The difficult part is to determine
when the conditions warrant an increase. The following are
some common reasons for increasing the profit and over-
head markup.

First, the company is submitting a bid as a courtesy to
the customer but really doesn’t want the project unless it is
very profitable. This may happen when a company is asked
to bid on a project that is outside its geographical area or
area of specialization or when it already has plenty of work.

Second, the project is a difficult project, has a high de-
gree of risk, or the project owners are difficult to work with.
The level of risk is increased by poor document (plans and
project manual) quality, short construction schedules, high
liquid damages, and uncertainty that may lead to cost or
schedule overruns. In this case the risk and headaches of the
project are acceptable to the construction company only if
there is a higher level of profit.

Third, the company is bidding on the project to check
their prices but really doesn’t want the project unless it is
profitable. When starting to bid after not bidding for a few
months or bidding in a new market, it is wise to bid on two
or three projects to get a feel for the market and to get back
into a bidding rhythm. This gives the company’s manage-
ment a chance to get a feel for the level of profit and over-
head markup that they can add to their bids, as well as give
their estimators a chance to warm up. Should they win the
job by accident, the project usually has a good profit margin.

Fourth, the other companies bidding on the project are
expected to be charging a higher profit and overhead
markup or they have higher construction costs. When com-
petition in the market is stiff, companies can seldom charge

P&O!Markup �
($452,632)(5%)

100%
� $22,631.60

more than their minimum profit and overhead markup;
however, when competition is meager, companies can often
increase their profit and overhead markup. To assist in deter-
mining when to charge a higher profit and overhead
markup, a company must track how its competitor’s prices
compare to its own. The easiest way to do this is to keep a
record of all of the competitors who have bid against your
company along with each of their bids and the profit and
overhead markup that your company would have had to add
to your construction costs for your bid to equal the competi-
tors’ bids. This is done by using the following equation:

(25-2)

EXAMPLE 25-4

Your construction company recently bid against ABC Construction
Company. Your construction costs were $157,260 and you added a
15% profit and overhead markup for a total bid of $180,849. ABC’s
bid was $179,249. What profit and overhead markup would you
need to add to your construction costs to match ABC’s bid?

Solution: The profit and overhead markup is determined as fol-
lows using Eq. (25-2):

�

When tracking the competitors’ bids it is important to
keep track of the name of the project and the bid date as well
as the competitor’s bid and your construction costs.
Competitors may be tracked using the simple spreadsheet
format shown in Figure 25-1.

When deciding whether to increase the profit and over-
head markup, you need to take into account the size of the
project, type of project, and bid date. It is important to take
size into account because as the project’s size increases, the
profit and overhead markup tends to decrease. It is impor-
tant to take the type of project into account because some
companies may bid different types of projects at different
profit and overhead markups. Finally, it is important to take
the bid date into account because projects bid in the
spring—when companies are looking for the year’s work—
are often bid at a lower rate than projects later in the year
when contractors begin filling up.

P&O!Markup �
$179,249

$157,260
� 1 � 0.1398!or!13.98%

P&O!Markup �
Bid

Construction!Costs
!� !1

FIGURE 25-1 Spreadsheet for Tracking Competitors’ Bids
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EXAMPLE 25-5

Your construction company is bidding against the two construction
companies shown in Figure 25-1 on a municipal project with an en-
gineer’s estimate of $750,000 to $850,000. Your company’s minimum
profit and overhead markup is 8%. What are the chances of increas-
ing your profit and overhead markup above the minimum 8%?

Solution: Your company bid against ABC Construction on the
West City Park—a municipal project of similar size—where their
bid was 7.57% above your costs. It is unlikely that you will be able to
raise your profit and overhead markup and still be competitive with
ABC Construction. You also bid against ABBCO on the same pro-
ject, where their bid was 9.55% above your costs. If ABC
Construction were not to bid, you might be able to raise your profit
and overhead a little. �

The construction bidding market is constantly chang-
ing. Contractors who are winning work and feeling less
pressure to get work may raise their profit and overhead
markups, whereas other contractors who are completing
projects and need more work may lower their profit and
overhead markups to get this work. At the same time, other
contractors may be adjusting the profit and overhead on
courtesy bids or when they perceive that a project has a
higher degree of risk. All of this makes it difficult to predict
where contractors are going to bid. By tracking your
competitors you increase your odds of reading the market
right.

EXCEL QUICK TIP 25-3

Competitor Tracking Worksheet

The competitor-tracking worksheet in Figure 25-1 is set up as a spreadsheet by entering the data and formatting the cell as
follows:

The following formula needs to be entered into Cell E3:

=(C3/D3-1)

This formula will need to be copied to all other applicable
rows in Column E. In the foregoing example Cell E3 needs

to be copied to Cells E4, E9, E10, and E11. Data for the bids
is entered in Columns A through D. The data shown in the
foregoing figure is from Figure 25-1.

A B C D E
1 ABBCO
2 Project Date Bid Costs P&O
3 West City Park 6/24/02 875,256$ 798,952$ 9.55%
4 Platt Park Restrooms 8/14/02 52,326$ 42,165$ 24.10%
5
6
7 ABC Construction
8 Project Date Bid Costs P&O
9 South Street Improvements 3/15/02 179,249$ 157,260$ 13.98%

10 West City Park 6/24/02 859,462$ 798,952$ 7.57%
11 East Side Community Center 7/22/02 $ 1,152,634 $ 1,092,215 5.53%

CONCLUSION
Common markups include building permits, bonds, and the
profit and overhead markup. The building permit may be
based on the bid or a standardized cost per square foot estab-
lished by the code enforcement agency. The bond is based on
the bid and a bond schedule. The profit and overhead markup
is added to construction costs and may be added to the cost of
the building permit and bond. Estimators should track the
bidding history of their competitors to identify where it may
be possible to increase their profit and overhead markup.

PROBLEMS
1. Using the building permit costs in Table 25-1, deter-

mine the building permit cost for a project valued at
$1,102,365.

2. Using the building permit costs in Table 25-1, deter-
mine the building permit cost for a project valued at
$55,268.

3. Using the bond costs in Table 25-2, determine the bond-
ing cost for a project bid at $1,102,365.
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4. Using the bond costs in Table 25-2, determine the bond-
ing cost for a project bid at $55,268.

5. The estimated construction cost for a project is
$875,264. The company’s profit and overhead markup is
8% of construction cost. Determine the profit and over-
head markup.

6. The estimated construction cost for a project is $25,654.
The company’s profit and overhead markup is 20% of
construction cost. Determine the profit and overhead
markup.

7. Your construction company recently bid against ABC
Construction Company. Your construction costs were
$265,815, and you added an 11% profit and overhead
markup for a total bid of $295,055. ABC’s bid was
$301,251. What profit and overhead markup would
you need to add to your construction costs to match
ABC’s bid?

8. Your construction company recently bid against ABC
Construction Company. Your construction costs were
$1,125,572, and you added a 6% profit and overhead
markup for a total bid of $1,193,106. ABC’s bid was
$1,179,999. What profit and overhead markup would
you need to add to your construction costs to match
ABC’s bid?

9. Set up Excel Quick Tip 25-1 in Excel.

10. Set up Excel Quick Tip 25-2 in Excel.

11. Set up Excel Quick Tip 25-3 in Excel.

REFERENCE
1. For information on how to set the profit and overhead

markup, see Steven J. Peterson, Construction Accounting and
Financial Management, Prentice Hall, Upper Saddle River,
NJ, 2009.



EXAMPLE 26-1

A project requires the installation of 150 feet of water line. The
work includes 70 cubic yards of excavation, 23 cubic yards of bed-
ding to be placed around the pipe, and 42 cubic yards of compacted
backfill. The cost of the pipe is $12.46 per foot, and the cost of the
bedding is $19.78 per cubic yard. The sales tax rate is 5% and is paid
only on materials. No materials are needed for the excavation, and
the excavated materials are used for the compacted backfill. Excess
materials from the excavation may be left on site. Determine the
material costs for the installation of the water line.

Solution: The material costs are calculated using Eq. (26-1) as
follows:

The sales tax is calculated using Eq. (19-3) as follows:

The total cost is calculated as follows:

�

This can also be done by entering the unit costs in
Column D of the Detail worksheet created in Chapter 3. The
material cost in Column E equals the quantity in Column B
multiplied by the unit costs in Column D. These calculations
are shown in Figure 26-1. The cells are formatted using the
comma style, which replaces zeros with dashes.

Material!CostTotal � $2,324 � $116 � $2,440

Sales!Tax � ($2,324)(0.05) � $116

Material!CostSubtotal � $455 � $1,869 � $2,324

Material!CostPipe � (150!ft)($12.46/ft) � $1,869

Material!CostBedding � (23!yd3)($19.78/yd3!) � $455
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In this chapter you will learn how to calculate the price for each
takeoff item and the total cost for the bid.

The previous chapters covered how to determine ma-
terial pricing, labor productivity, labor hours, labor
rates, equipment costs, crew rates, subcontractor

pricing, and markups. It is now time to combine all of these
concepts into preparing a total cost for the estimate. This is
done by using the Detail worksheet created in the exercises
in Chapter 3 and the Summary worksheet (Figure 2-2) in
Chapter 2.

DETAIL WORKSHEET
The Detail worksheet is used for performing detailed esti-
mates of the materials, labor, and equipment needed to com-
plete the work in a cost code. Let’s look at each of these costs.

MATERIAL COSTS
Material costs are calculated by multiplying material unit
costs by the quantity of materials needed to get the cost of
the materials, as expressed by the following equation:

(26-1)

The material unit cost should include shipping costs,
sales tax, storage costs, and escalation. These calculations are
shown in the following example.

Material!Cost � (Material!Unit!Cost)(Quantity)

FIGURE 26-1 Detail Worksheet for Example 26-1

A B C D E F G H I J K L
1
2 $/UNIT COST LHR/UNIT LHR $/LHR COST $/LHR COST
3 33-100 Water Line
4 Trench excavation 70 cyd - -
5 Bedding 23 cyd 19.78 455
6 10" water line 150 ft 12.46 1,869
7 Backfill 42 cyd - -
8   Subtotal 2,324
9 Sales Tax 116

10   Total 2,440

EQUIPMENT
TOTALITEM QUANTITY

MATERIALS LABOR



Alternatively, the Request for Materials Quote form
discussed in Chapter 19 could be used to calculate the mate-
rials costs.

LABOR COSTS
Labor costs are obtained by multiplying the productivity
by the quantity to get the number of labor hours using
Eq. (20-7). The number of labor hours is then multiplied
by the average labor rate for the crew performing the task
as expressed by the following equation:

(26-2)

Labor productivity is discussed in Chapter 20, and the
average labor rate for a crew is discussed in Chapter 23.
These calculations are shown in the following example.

EXAMPLE 26-2

Using the average labor rate per labor hour from Example 23-1,
determine the labor costs for the installation of the water line in
Example 26-1. For excavation of the trench the productivity is
0.50 labor hour per cubic yard, for the placement of bedding the
productivity is 0.30 labor hour per cubic yard, for the placement
of the pipe the productivity is 0.26 labor hour per foot, and for
the backfill of the trench the productivity is 3.20 labor hour per
cubic yard.

Solution: The number of labor hours for excavation is calculated
using Eq. (20-7) as follows:

The labor cost for the excavation is calculated using Eq. (26-2) as
follows:

The labor hours and labor costs for the remaining items are calcu-
lated as follows:

Labor!CostBackfill � (134.4!lhr)($18.07/lhr) � $2,429

Labor!HoursBackfill � (3.20!lhr/yd3)(42!yd3) � 134.4!lhr

Labor!CostPipe � (39!lhr)($18.07/lhr) � $705

Labor!HoursPipe � (0.26!lhr/ft)(150!ft) � 39!lhr

Labor!CostBedding � (6.9!lhr)($18.07/lhr) � $125

Labor!HoursBedding � (0.30!lhr/yd3)(23!yd3) � 6.9!lhr

Labor!CostExcavation � (35!lhr)($18.07/lhr) � $632

Labor!HoursExcavation � (0.50!lhr/yd3)(70!yd3) � 35!lhr

Labor!Cost � (Labor!Hours)(Labor!Rate)

The total labor cost is calculated as follows:

�

This can also be done by entering the productivity in
labor hours per unit in Column F and the average labor rate
for the crew in Column H of the Detail worksheet created in
Chapter 3. The labor hours in Column G equals the quantity
in Column B multiplied by the productivity in Column F.
The labor cost in Column I equals the labor hours in
Column G multiplied by the average labor rate for the crew
in Column H. These calculations are shown in Figure 26-2.
The difference in the total labor cost in Example 26-2 and
Figure 26-2 is because of rounding.

EQUIPMENT COSTS
Equipment costs are obtained by multiplying equipment
cost per labor hour by the number of labor hours as ex-
pressed by the following equation:

(26-3)

The labor hours used in this equation are the labor
hours calculated from Eq. (20-7). Determining the equip-
ment cost per labor hour is discussed in Chapter 23. These
calculations are shown in the following example.

EXAMPLE 26-3

Using the equipment cost per labor hour from Example 23-1 and
the labor hours from Example 26-2, determine the equipment costs
for the installation of the water line in Examples 26-1 and 26-2.

Solution: The equipment costs are calculated using Eq. (26-3) as
follows:

The total equipment cost is calculated as follows:

�� $10,938

Labor!CostTotal � $1,778 � $351 � $1,981 � $6,828

Equipment!CostBackfill � (134.4!lhr)($50.80/lhr) � $6,828

Equipment!CostPipe � (39!lhr)($50.80/lhr) � $1,981

Equipment!CostBedding � (6.9!lhr)($50.80/lhr) � $351

Equipment!CostExcavation � (35!lhr)($50.80/lhr) � $1,778

� (Labor!Hours)

Equipment!Cost � (Equipment!Cost!per!Labor!Hour)

Labor!CostTotal � $632 � $125 � $705 � $2,429 � $3,891
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A B C D E F G H I J K L
1
2 $/UNIT COST LHR/UNIT LHR $/LHR COST $/LHR COST
3 33-100 Water Line
4 Trench excavation 70 cyd - - 0.50 35.00 18.07 632
5 Bedding 23 cyd 19.78 455 0.30 6.90 18.07 125
6 10" water line 150 ft 12.46 1,869 0.26 39.00 18.07 705
7 Backfill 42 cyd - - 3.20 134.40 18.07 2,429
8   Subtotal 2,324 3,890
9 Sales Tax 116 -

10   Total 2,440 3,890

EQUIPMENT
TOTALITEM QUANTITY

MATERIALS LABOR

FIGURE 26-2 Detail Worksheet for Example 26-2
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This can also be done by entering the equipment cost
per labor hour in Column J of the Detail worksheet created
in Chapter 3. The equipment cost in Column K equals the
quantity in Column G multiplied by the equipment cost per
labor hour in Column J. These calculations are shown in
Figure 26-3. The difference in the total labor cost in Example
26-3 and Figure 26-3 is because of rounding.

TOTAL COST
The total cost for each bid item equals the material cost plus
the labor cost plus the equipment cost, as shown in the fol-
lowing example.

EXAMPLE 26-4

Using the costs for Examples 26-1 through 26-3, determine the
total cost for each bid item and for the installation of the water line
in Examples 26-1 through 26-3.

Solution: The total cost for each bid item is calculated as follows:

The total cost of the water line is calculated as follows:

�

This can also be done by summing Columns E, I, and K
of the Detail worksheet created in Chapter 3. These calcula-
tions are shown in Figure 26-4. The difference in the total
cost in Example 26-4 and Figure 26-4 is because of rounding.

� $17,269

Total!CostTotal � $2,410 � $931 � $4,555 � $9,257 � $116

Total!CostSales!Tax � $116 � $0 � $0 � $0 � $116

Total!CostBackfill � $0 � $2,429 � $6,828 � $9,257

Total!CostPipe � $1,869 � $705 � $1,981 � $4,555

Total!CostBedding � $455 � $125 � $351 � $931

Total!CostExcavation � $0 � $632 � $1,778 � $2,410

SUMMARY WORKSHEET
The Summary worksheet is used to record costs from the
Request for Material Quotes, the Detail worksheet, and sub-
contractor bids. The costs from the material quote sheet are

FIGURE 26-3 Detail Worksheet for Example 26-3

A B C D E F G H I J K L
1
2 $/UNIT COST LHR/UNIT LHR $/LHR COST $/LHR COST
3 33-100 Water Line
4 Trench excavation 70 cyd - - 0.50 35.00 18.07 632 50.80 1,778
5 Bedding 23 cyd 19.78 455 0.30 6.90 18.07 125 50.80 351
6 10" water line 150 ft 12.46 1,869 0.26 39.00 18.07 705 50.80 1,981
7 Backfill 42 cyd - - 3.20 134.40 18.07 2,429 50.80 6,828
8   Subtotal 2,324 3,890 10,937
9 Sales Tax 116 - -

10   Total 2,440 3,890 10,937

EQUIPMENT
TOTALITEM QUANTITY

MATERIALS LABOR

A B C D E F G H I J K L
1
2 $/UNIT COST LHR/UNIT LHR $/LHR COST $/LHR COST
3 33-100 Water Line
4 Trench excavation 70 cyd - - 0.50 35.00 18.07 632 50.80 1,778 2,410
5 Bedding 23 cyd 19.78 455 0.30 6.90 18.07 125 50.80 351 930
6 10" water line 150 ft 12.46 1,869 0.26 39.00 18.07 705 50.80 1,981 4,555
7 Backfill 42 cyd - - 3.20 134.40 18.07 2,429 50.80 6,828 9,256
8   Subtotal 2,324 3,890 10,937 17,152
9 Sales Tax 116 - - 116

10   Total 2,440 3,890 10,937 17,268

EQUIPMENT
TOTALITEM QUANTITY

MATERIALS LABOR

FIGURE 26-4 Detail Worksheet for Examples 26-1 through 26-3

EXCEL QUICK TIP 26-1

Detail Worksheet

The calculations for the Detail worksheet from Chapter 3,
the worksheet shown in Figure 26-4, is set up by entering
the data and formatting the cells as shown in that figure.
The following formulas need to be entered into the asso-
ciated cells:

The formula in Cell E4 will need to be copied to all other
applicable rows in Column E, which in the case of the
foregoing example are Cells E5 through E7. The same is
true of Columns G, I, K, and L. The formula in Cell L8
needs to be copied to Cells E8, I8, and K8. Chapter 32
looks at automating the writing of the formulas for Row 4
using a macro.

Data for the costs are entered in Columns A through
D, F, H, and J.

Cell Formula

E4 =B4*D4

G4 =F4*B4

I4 =G4*H4

K4 =G4*J4

L4 =E4+I4+K4

L8 =SUM(L4:L7)
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entered into the materials column next to their respective
cost codes. The costs from the Detail worksheet are entered
into the materials, labor, and equipment columns next to
their respective cost codes. Subcontract pricing is entered
into the subcontract column next to the respective cost
codes. The total of each cost code is then summed. The ma-
terials, labor, equipment, subcontract, and total cost for each
cost code are then totaled to get the total construction cost
for the project. The markups (building permit, bond, and
profit and overhead) will need to be added to these costs.

EXAMPLE 26-5

Using the Summary worksheet from Example 3-9 and the costs
from Figure 26-4, determine the construction costs for a site im-
provement project consisting of the water line, asphalt paving, and
concrete sidewalk and curb. In addition to the cost of the water line
from Examples 26-1 through 26-4, you have received a bid to com-
plete the asphalt for $25,256 and a bid to form, pour, finish, and
protect the concrete site work for $11,999. Your company will need

to provide the concrete for the site work, for which you have a ma-
terial quote from a local concrete supplier to supply the specified
quantities of concrete for $10,234.

Solution: The Summary worksheet is filled out and the columns
are totaled as shown in Figure 26-5. �

Once the construction costs have been totaled, the cost
of the building permit, the bonds, and the profit and over-
head markup can be added to them. This is shown by the fol-
lowing example.

EXAMPLE 26-6

Determine the bid for the project in Example 26-5. A building per-
mit is not required, and the cost of the bond is $1,025, which is
treated as a material cost. The profit and overhead markup on ma-
terials, labor, and equipment costs is 15%, and the profit and over-
head markup on subcontracted items is 5%.

Solution: The Summary worksheet is filled out and the columns
are totaled as shown in Figure 26-6.

FIGURE 26-5 Summary Worksheet for Example 26-5

FIGURE 26-6 Summary Worksheet for Example 26-6
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The profit and overhead markups are calculated using
Eq. (25-1) as follows:

P&O!MarkupEqupment �
($10,937)(15%)

100%
� $1,641

P&O!MarkupLabor �
($3,890)(15%)

100%
� $584

P&O!MarkupMaterials �
($13,699)(15%)

100%
� $2,055

The difference in the total cost in Example 26-6 and Figure 26-6 is
because of rounding. �

� $6,143

P&O!MarkupTotal � $2,055 � $584 � $1,641 � $1,863

P&O!MarkupSubcontract �
($37,255)(5%)

100%
� $1,863

EXCEL QUICK TIP 26-2

Summary Worksheet

The Summary worksheet in Figure 26-6 is set up as a spreadsheet by completing Example 3-9. The Summary worksheet is
as follows:

In this figure, Rows 2 through 103 have been hidden. The
following formulas need to be entered into the associated
cells:

Cell D123 needs to be copied to Cells E123 through H123.
Cell D126 needs to be copied to Cells E126 through H126.
Cell D128 needs to be copied to Cells E128 through G128.
Cell D129 needs to be copied to Cells E129 through H129.
Cells H129 and H130 should be the same value and are
used as a check for errors. The data shown in the foregoing
figure is from Example 26-6 and Figure 26-6. The data is
formatted using the comma style, which replaces zeros
with dashes.

Cell Formula

D123 =SUM(D2:D122)

H124 =SUM(D124:G124)

H125 =SUM(D125:G125)

D126 =SUM(D123:D125)

D128 =D126*D127

H128 =SUM(D128:G128)

D129 =D126+D128

H130 =SUM(D129:G129)



SAMPLE ESTIMATE: THE
RESIDENTIAL GARAGE
A sample estimate for the residential garage drawings
given in Appendix F is shown in Figures 26-7 and 26-8.
The small differences in the numbers in Figures 26-7 and
26-8 are due to rounding. This estimate uses the quantities
from Chapters 5, 8 through 11, and 15 through 17 and the
burdened labor rates in Table 26-1.
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FIGURE 26-7 Costs for Residential Garage

$/UNIT COST LHR/UNIT LHR $/LHR COST $/LHR COST

03-200 Rebar
#4x20' rebar (footings) 14 ea 5.75 81 - - 19.00 - - - 81
7"x29" L-dowels (footings) 66 ea 1.12 74 - - 19.00 - - - 74
#4x20' rebar (found.) 21 ea 5.75 121 - - 19.00 - - - 121
18"x18" L-dowels (found.) 13 ea 1.53 20 - - 19.00 - - - 20
1/2"x10" anchor bolt (found.) 45 ea 0.40 18 - - 19.00 - - - 18
1/2" nut (found.) 45 ea 0.80 36 - - 19.00 - - - 36
1/2" washer (found.) 45 ea 0.07 3 - - 19.00 - - - 3
HPAHD22 holddowns 4 ea 6.25 25 - - 19.00 - - - 25

377 - - - 377
Sales Tax 6.50 25 25

402 - - - 402

03-300 Footings and 
Foundation--Labor
10" high footing forms 168 ft - - 0.08 13.44 19.00 255 10.00 134 390
Install continuous rebar 20' 14 ea - - 0.25 3.50 19.00 67 10.00 35 102
Install dowel 66 ea - - 0.06 3.96 19.00 75 10.00 40 115
Pour footings 4.50 cyd - - 0.50 2.25 19.00 43 1.50 3 46
2' high foundation forms 390 sft - - 0.15 58.50 19.00 1,112 15.00 878 1,989
Install continuous rebar 20' 21 ea - - 0.25 5.25 19.00 100 15.00 79 179
Install dowel 13 ea - - 0.06 0.78 19.00 15 15.00 12 27
Install anchor bolt 45 ea - - 0.08 3.60 19.00 68 15.00 54 122
Pour foundation 4.75 cyd - - 0.50 2.38 19.00 45 1.50 4 49

- 94 1,779 1,238 3,017

03-310 Footings and 
Foundation--Concrete
3500 psi concrete (footings) 4.50 cyd 79.00 356 - - 19.00 - - - 356
3500 psi concrete (found.) 4.75 cyd 79.00 375 - - 19.00 - - - 375

731 - - - 731
Sales Tax 6.50 47 47

778 - - - 778

03-320 Slab/Floor--Labor
Pour slab 8.00 cyd - - 0.50 4.00 19.00 76 1.50 6 82
Finish slab 570 sft - - 0.01 5.70 19.00 108 1.50 9 117

- 10 184 15 199

03-330 Slab/Floor--Concrete
4000 psi concrete (slab) 8.00 cyd 82.00 656 - - 19.00 - - - 656

656 - - - 656
Sales Tax 6.50 43 43

699 - - - 699

06-100 Rough Carpentry
2x4 wall 83 ft - - 0.15 12.45 22.00 274 1.28 16 290
Single-hung door opening 1 ea - - 0.40 0.40 22.00 9 1.28 1 9
Overhead door opening 1 ea - - 1.50 1.50 22.00 33 1.28 2 35
Install trusses 14 ea - - 1.00 14.00 22.00 308 1.28 18 326
Install ledger 110 ft - - 0.05 5.50 22.00 121 1.28 7 128
Install fascia board 116 ft - - 0.06 6.96 22.00 153 1.28 9 162
Install 15" blocking/outlooks 62 ea - - 0.05 3.10 22.00 68 1.28 4 72
Install ceiling blocking 48 ft - - 0.04 1.92 22.00 42 1.28 2 45
Install roof sheathing 829 sft - - 0.014 11.61 22.00 255 1.28 15 270

- 57 1,264 74 1,337

06-110 Lumber
Walls
2x4-8 redwood 1 ea 6.25 6 - - 22.00 - - - 6
2x4-12 redwood 4 ea 9.40 38 - - 22.00 - - - 38
2x4-14 redwood 2 ea 11.55 23 - - 22.00 - - - 23
Seal sill 50' 2 ea 3.60 7 - - 22.00 - - - 7
Z-flashing 10' long 9 ea 3.00 27 - - 22.00 - - - 27
2x4-92 5/8" stud 80 ea 2.79 223 - - 22.00 - - - 223
2x6-8' 1 ea 5.02 5 - - 22.00 - - - 5
7/16"x4'x8' OSB 1 ea 9.90 10 - - 22.00 - - - 10
3-1/2"x12" GLB 16.5 ft 7.95 131 - - 22.00 - - - 131
2x4-12 12 ea 5.16 62 - - 22.00 - - - 62
2x4-14 4 ea 6.00 24 - - 22.00 - - - 24

EQUIPMENT
TOTALITEM QUANTITY

MATERIALS LABOR

03-000 CONCRETE

06-000 WOODS AND PLASTICS

Roof
Hurricane ties 24 ea 0.58 14 - - 22.00 - - - 14
2x4-8 46 ea 3.37 155 - - 22.00 - - - 155
7/16"x4'x8' OSB 32 ea 9.90 317 - - 22.00 - - - 317
Plywood clips 78 ea 0.12 9 - 22.00 - - - 9

1,051 - - - 1,051
Sales Tax 6.50 68 68

1,120 - - - 1,120

TABLE 26-1 Labor Rates for Residential Garage

Cost Code Rate ($/lhr)

03-000 19.00

06-100 to 06-120 22.00

06-200 to 06-210 26.00

07-000 22.00

08-000 26.00

09-200 24.00

09-900 24.50

26-100 29.00

31-200 25.00

32-000 19.00
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06-120 Trusses
24' 4:12 standard trusses w/18" 
tails 12 ea 57.00 684 - - 22.00 - - - 684
24' 4:12 gable end trusses w/18" 
tails 2 ea 62.00 124 - - 22.00 - - - 124

808 - - - 808
Sales Tax 6.50 53 53

861 - - - 861

06-200 Finish Carpentry
Install shaped fascia 116 ft - - 0.10 11.60 26.00 302 2.50 29 331
Install door casing-set 1 ea - - 0.50 0.50 26.00 13 1.28 1 14

- 12 315 30 344

06-210 Wood Trim
1x6-10' cedar 6 ea 6.70 40 0.30 1.80 26.00 47 1.28 2 89
1x6-16' cedar 4 ea 11.95 48 0.48 1.92 26.00 50 1.28 2 100
7' foot casing 3 ea 6.00 18 0.21 0.63 26.00 16 1.28 1 35

106 4 113 6 225
Sales Tax 6.50 7 7

113 4 113 6 232

07-200 Insulation
R-13 15"x32' unfaced 16 ea 13.25 212 - - 22.00 - - - 212
3 mil plastic 8' by 12' 8 ea 3.00 24 - - 22.00 - - - 24
install R-13 insulation 628 sft - - 0.007 4.40 22.00 97 - - 97
R-25 23"x32' unfaced 22 ea 17.75 391 - - 22.00 - - - 391
Install R-25 insulation 598 sft - - 0.006 3.59 22.00 79 - - 79

627 8 176 - 802
Sales Tax 6.50 41 41

667 8 176 - 843

07-400 Siding
T1-11 26 ea 21.50 559 - - 22.00 - 1.28 - 559
Install siding 792 sft - - 0.020 15.84 22.00 348 1.28 20 369
T1-11 sofit 6 ea 21.50 129 - - 22.00 - 1.28 - 129
Install soffit 164 sft - - 0.06 9.84 22.00 216 1.28 13 229
3" wide screen 58 ft 1.00 58 0.06 3.48 22.00 77 1.28 4 139
12x14 vent 2 ea 28.00 56 0.50 1.00 22.00 22 1.28 1 79
1x4 cedar 8' 16 ea 3.25 52 - - 22.00 - 1.28 - 52
1x4 cedar 10' 13 ea 4.50 59 - - 22.00 - 1.28 - 59
1x4 cedar 12' 4 ea 5.72 23 - - 22.00 - 1.28 - 23
Cut and install trim 75 ft - - 0.10 7.50 22.00 165 1.28 10 175
Install trim 212 ft - - 0.03 6.36 22.00 140 1.28 8 148

935 44 968 56 1,960
Sales Tax 6.50 61 61

996 44 968 56 2,021

07-500 Roofing
Drip edge 10' 12 ea 3.75 45 0.03 0.36 22.00 8 4.95 2 55
15 pound felt, 4 square roll 3 ea 16.00 48 1.20 3.60 22.00 79 4.95 18 145
20 yr 3-tab shingles 9 sq 32.00 288 2.00 18.00 22.00 396 4.95 89 773

381 22 483 109 973
Sales Tax 6.50 25 25

406 22 483 109 998

08-100 Metal Doors

07-000 THERMAL & MOISTURE PROTECTION

08-000 DOORS & WINDOWS

3-0x6-8 6-panel metal  prehung 
door w/4-5/8 wood jambs, 1-1/2 
pair hinges, weather stripping, 
and threshold, drilled for deadbolt 
and lockset 1 ea 135.00 135 2.00 2.00 26.00 52 1.28 3 190

135 2 52 3 190
Sales Tax 6.50 9 9

144 2 52 3 198

08-300 Overhead Doors
16'x7' pre finished, insulated, 
sectional overhead door 1 ea 475.00 475 4.00 4.00 26.00 104 1.28 5 584
1/2 hp screw-drive opener 1 ea 183.00 183 1.00 1.00 26.00 26 1.28 1 210
Keyless entry 1 ea 30.00 30 1.00 1.00 26.00 26 1.28 1 57
Remotes 2 ea - - - - 26.00 - 1.28 - -

688 6 156 8 852
Sales Tax 6.50 45 45

733 6 156 8 896

08-700  Hardware
Single-keyed deadbolt 1 ea 20.00 20 1.00 1.00 26.00 26 1.28 1 47
Keyed lockset 1 ea 17.00 17 1.00 1.00 26.00 26 1.28 1 44
Floor mounted doorstop 1 ea 1.00 1 0.25 0.25 26.00 7 1.28 0 8

38 2 59 3 99
Sales Tax 6.50 2 2

40 2 59 3 102

09-200 Drywall
Hang and finish drywall 1238 sft - - 0.020 24.76 24.00 594 1.28 32 626
4'x8'x1/2" gypsum board 1 ea 6.50 7 - - 24.00 - 1.28 - 7
4'x12'x1/2" gypsum board 17 ea 7.65 130 - - 24.00 - 1.28 - 130
4'x14'x1/2" gypsum board 9 ea 11.25 101 - - 24.00 - 1.28 - 101
1-5/8" screws 14 lbs 18.00 252 - - 24.00 - 1.28 - 252
Joint compound 5 box 7.00 35 - - 24.00 - 1.28 - 35
Joint tape rolls 2 ea 3.00 6 - - 24.00 - 1.28 - 6

531 25 594 32 1,157
Sales Tax 6.50 35 35

565 25 594 32 1,191

09-900 Paint
Interior primer 5 gal 8.50 43 - - 24.50 - 1.50 - 43
Interior latex 7 gal 13.50 95 - - 24.50 - 1.50 - 95
Paint drywall w/3 coats 1238 sft - - 0.020 24.76 24.50 607 1.50 37 644
Exterior primer 4 gal 15.00 60 - - 24.50 - 1.50 - 60
Exterior latex 6 gal 15.00 90 - - 24.50 - 1.50 - 90
Paint T1-11 w/3 coats 956 sft - - 0.020 19.12 24.50 468 1.50 29 497
Exterior latex 0.25 gal 20.00 5 - - 24.50 - 1.50 - 5
Paint single hung door 1 ea - - 2.00 2.00 24.50 49 1.50 3 52

292 46 1,124 69 1,485
Sales Tax 6.50 19 19

311 46 1,124 69 1,504

09-000 FINISHES

$/UNIT COST LHR/UNIT LHR $/LHR COST $/LHR COST
EQUIPMENT

TOTALITEM QUANTITY
MATERIALS LABOR

FIGURE 26-7 continued
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26-100 Electrical
Meter tap 1 ea 5.00 5 - - 29.00 - 1.28 - 5
1-1/4” set screw/threaded 
connector 1 ea 2.00 2 - - 29.00 - 1.28 - 2
1-1/4” conduit 10 ft 14.00 140 - - 29.00 - 1.28 - 140
1-1/4” comp./male threaded 
coupling 1 ea 2.00 2 - - 29.00 - 1.28 - 2
1-1/4” slip/female threaded PVC 
cup. 1 ea 2.00 2 - - 29.00 - 1.28 - 2

1-1/4” PVC 90  sweep 2 ea 2.40 5 - - 29.00 - 1.28 - 5
1-1/4” PVC conduit 40 ft 4.00 160 - - 29.00 - 1.28 - 160
Install Conduit 40 ft - - 0.14 5.60 29.00 162 1.28 7 170

3 ea #4 copper wire with ground 50 ft 1.75 88 0.03 1.50 29.00 44 1.28 2 133
70 amp single-phase panel 
w/main 1 ea 20.00 20 - - 29.00 - 1.28 - 20
70 amp main breaker 1 ea 15.60 16 - - 29.00 - 1.28 - 16

26-000 ELECTRICAL

20 amp breaker 1 ea 8.00 8 - - 29.00 - 1.28 - 8
20 amp GFI breaker 2 ea 31.00 62 - - 29.00 - 1.28 - 62
6’ copper ground rod 1 ea 14.00 14 - - 29.00 - 1.28 - 14
Install panel 1 ea - - 8.00 8.00 29.00 232 1.28 10 242
Octagon box 3 ea 1.25 4 - - 29.00 - 1.28 - 4
Single gang box 7 ea 0.25 2 - - 29.00 - 1.28 - 2
Duplex outlets 5 ea 0.50 3 - - 29.00 - 1.28 - 3
Outlet covers 4 ea 0.60 2 - - 29.00 - 1.28 - 2
Weather proof outlet cover 1 ea 4.25 4 - - 29.00 - 1.28 - 4
Quad-gang box 1 ea 4.00 4 - - 29.00 - 1.28 - 4
Quad-gang switch cover 1 ea 2.50 3 - - 29.00 - 1.28 - 3
Single-pole switches 4 ea 0.60 2 - - 29.00 - 1.28 - 2
4-tube fluorescent fixtures 2 ea 60.00 120 - - 29.00 - 1.28 - 120
4’ fluorescent light bulbs 8 ea 2.00 16 - - 29.00 - 1.28 - 16
Brass coach lights 3 ea 18.00 54 - - 29.00 - 1.28 - 54
100 watt light bulbs 3 ea 0.75 2 - - 29.00 - 1.28 - 2

250’ roll 2-#12 w/ground Romex 1 ea 32.00 32 - - 29.00 - 1.28 - 32
NM/SE cable connectors 3 ea 0.50 2 - - 29.00 - 1.28 - 2
Electrical staples 1 box 1.00 1 - - 29.00 - 1.28 - 1
Red wire nuts 1 bg 2.07 2 - - 29.00 - 1.28 - 2
Install light fixture 5 ea - - 1.00 5.00 29.00 145 1.28 6 151
Install outlet 5 ea - - 0.60 3.00 29.00 87 1.28 4 91
Install Switch 4 ea - - 0.60 2.40 29.00 70 1.28 3 73

775 26 740 33 1,547
Sales Tax 6.50 50 50

826 26 740 33 1,598

31-200 Grading and Excavation
Excavation 56 cyd - - 0.10 5.60 25.00 140 85.00 476 616
Backfill 19 cyd - - 0.20 3.80 25.00 95 85.00 323 418
Export 36 cyd - - 0.10 3.60 25.00 90 65.00 234 324
3/4” gravel 15 cyd 25.5 383 0.20 3.00 25.00 75 5.00 15 473

383 16 400 1,048 1,831
Sales Tax 6.50 25 25

407 16 400 1,048 1,855

32-110  Site Concrete-Labor
Form driveway 54 ft - - 0.09 4.86 19.00 92 5.00 24 117
Screed 27 ft - - 0.09 2.43 19.00 46 5.00 12 58
Pour driveway 5.9 cyd - - 0.60 3.54 19.00 67 1.50 5 73
Finish driveway 479 sft - - 0.03 14.37 19.00 273 1.50 22 295
Form sidewalk 37 ft - - 0.09 3.33 19.00 63 5.00 17 80
Pour sidewalk 1.6 cyd - - 0.60 0.96 19.00 18 1.50 1 20
Finish sidewalk 132 sft - - 0.03 3.96 19.00 75 1.50 6 81
10' expansion joint 5 ea - - 0.10 0.50 19.00 10 1.50 1 10

- 34 645 88 733

32-120  Site Concrete-Concrete
Driveway 5.9 cyd 82.00 484 - - 19.00 - - - 484
Sidewalk 1.6 cyd 82.00 131 - - 19.00 - - - 131

615 - - - 615
Sales Tax 6.50 40 40

655 - - - 655

32-900 Landscaping
Sod Repair 291 sft 0.30 87 0.02 5.82 19.00 111 1.50 9 207

87 6 111 9 207
Sales Tax 6.50 6 6

93 6 111 9 212

31-000 Earthwork

32-000 Exterior Improvements

$/UNIT COST LHR/UNIT LHR $/LHR COST $/LHR COST
EQUIPMENT

TOTALITEM QUANTITY
MATERIALS LABOR

FIGURE 26-7 continued



Pricing Extensions 275

FIGURE 26-8 Summary of Costs for Residential Garage
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latoTtcartnocbuStnempiuqErobaLslairetaMnoitpircseDedoC
09-000 FINISHES

✔ 565llawyrD002-90 594 32 - 1,191
-sdutSlateM012-90 - - - -
-eliTcimareC003-90 - - - -
-sgnilieClacitsuocA005-90 - - - -
-gniroolF006-90 - - - -
-sgnirevoCllaW007-90 - - - -

✔ 113tniaP009-90 1,124 69 - 1,504

10-000 SPECIALTIES
-egangiS001-01 - - - -
-snoititraPtelioT002-01 - - - -
-seirosseccAhtaB&telioT012-01 - - - -
-stenibaC&srehsiugnitxEeriF004-01 - - - -

11-000 EQUIPMENT
-secnailppA003-11 - - - -

12-000 FURNISHINGS
-stnemtaerTwodniW002-21 - - - -

14-000 CONVEYING EQUIPMENT
-srotavelE002-41 - - - -

21-000 FIRE SUPPRESSION
-srelknirpSeriF001-12 - - - -

22-000 PLUMBING
-gnibmulP001-22 - - - -

23-000 HVAC
-CAVH001-32 - - - -

26-000 ELECTRICAL
✔ 628lacirtcelE001-62 740 33 - 1,599

27-000 COMMUNICATIONS
-snoitacinummoC001-72 - - - -

31-000 EARTHWORK
-gnibburGdnagniraelC001-13 - - - -

✔ 704noitavacxEdnagnidarG002-13 400 1,048 - 1,855

32-000 EXTERIOR IMPROVEMENTS
-tlahpsA001-23 - - - -

✔ -robaL—etercnoCetiS011-23 645 88 - 733
✔ 556etercnoC—etercnoCetiS021-23 - - - 655

-rabeR031-23 - - - -
-gnicneF003-23 - - - -
-sllaWgniniateR013-23 - - - -
-serusolcnEretspmuD023-23 - - - -
-egangiS033-23 - - - -
-gnithgiLedistuO043-23 - - - -

✔ 39gnipacsdnaL009-23 111 9 - 213

33-000 UTILITIES
-eniLretaW001-33 - - - -
-reweSyratinaS003-33 - - - -
-niarDmrotS004-33 - - - -
-seniLsaG005-33 - - - -
-seniLrewoP007-33 - - - -
-seniLenohpeleT008-33 - - - -

SUBTOTAL 9,816 10,163 2,821 - 22,800
✔ 244timrePgnidliuB 244
✔ 444dnoB 444

SUBTOTAL 10,702 10,163 2,821 - 23,686
✔ Profit and Overhead Markup 25.0% 25.0% 25.0% 25.0%

676,2daehrevOdnatiforP 2,541 705 - 5,922
TOTAL 13,378 12,704 3,526 - 29,608

29,608

FIGURE 26-8 continued

CONCLUSION
The Detail worksheet is used for performing detailed esti-
mates of the materials, labor, and equipment needed to com-
plete the work in a cost code. The Summary worksheet is
used to total the costs for materials quotes, the Detail work-
sheet, and subcontractor bids and to include the markups
into the bid.

PROBLEMS
1. Prepare a detailed estimate and a total estimate for the

residential plans given in Appendix F.

2. Prepare a detailed estimate and a total estimate for the
West Street Video plans given in Appendix F.

3. Set up Excel Quick Tip 26-2 in Excel.



In this chapter you will learn how to check the bid for errors
and learn the difference between accuracy and completeness.
Estimating is the lifeblood of any construction company.
Produce good competitive estimates and the company thrives.
Produce bad estimates and the company loses work or, worse,
wins work that it cannot afford to complete. Errors are the
greatest threat to producing good estimates.

Nothing can ruin a construction company faster
than bad estimating. Bad estimating will either
lose the company work or win work for the com-

pany that it cannot complete while making a reasonable
profit. The opposite of a bad estimate is a good estimate.
Good estimates have two characteristics: they are accurate
and complete.

The accuracy of an estimate is a measure of how accu-
rate or correct the numbers in the estimate are. Problems in
accuracy can occur in the quantity takeoff (the quantity is
wrong), productivity (too high or too low), labor rates (the
wrong labor rates have been used), or pricing (the wrong
prices have been used).

The completeness of an estimate is a measure of
whether the bid has all the items needed for the project
without duplicating items. Problems in completeness in-
clude failing to include all items needed to complete the
project (for example, forgetting to add the cost of a bond to
the bid) or duplicating items (for example, including the
cost of the gas lines for the project in both the HVAC and
plumbing costs).

Bad estimates are estimates that contain excessive
errors in accuracy or completeness. It is impossible to elim-
inate all errors from bids; however, there are a number of
ways errors can be minimized. Let’s look at some of these
ways.

LIST COST CODES
Before preparing the estimate make a list of all cost codes to
be included in the estimate. This is best done by marking off
the needed cost codes on a standardized form, such as the
form given in Figure 2-2. If a checked item on Figure 2-2
does not have pricing, it is easy for the estimator to see that
the estimate is incomplete, which helps to ensure the com-
pleteness of the estimate.

SPEND MORE TIME ON
LARGE COSTS
Large costs carry more risk of error than small costs. For ex-
ample, guessing the price for a large HVAC unit is riskier
than guessing the price of a bathroom faucet. Being off by
10% on the cost of the HVAC unit will create a larger cost
error than would being off by 300% on the cost of the faucet.
Similarly, you should spend more time on small-dollar items
that are used frequently in the building than on small-dollar
items that are seldom used because the total cost of the fre-
quently used items can be large. Underbidding a faucet by
$10 becomes a big error when there are a few hundred
faucets, as there would be in a hotel. This helps to ensure the
accuracy of the estimate.

PREPARE DETAILED
ESTIMATES
Broad estimates, such as bidding HVAC based on the square
footage of a building, carry more risk of error than prepar-
ing a detailed estimate for the HVAC system. This is because
the errors in the detailed estimate have the tendency to can-
cel each other out. For example, if one were to take a single
item with an estimated cost of $300,000 and an estimated
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error of plus or minus 10% (±$30,000) and break it down
into three items with an estimated cost of $100,000 each
with the same estimated error of plus or minus 10%
(±$10,000) each, on average the combined error for all three
items would be plus or minus $17,320 or 5.77%. This is be-
cause the errors will tend to cancel each other out. When one
item is priced too high, it is likely that another item is priced
too low, reducing the overall total error. Estimators should
not rely on errors canceling each other out as justification to
ignore known errors. Preparing detailed estimates only
works when you have sufficient data to prepare the estimate.
Preparing detailed estimates helps to ensure their accuracy.

MARK ITEMS COUNTED
DURING THE QUANTITY
TAKEOFF
One of the hardest things for an estimator to do is to remem-
ber which items have been taken off and which items still need
to be taken off. On a complex set of plans it is easy to miss
items unless they are marked off as they are taken off. The best
way to do this is with a light-colored highlighter through
which the blueprints can still be read. As items are taken off
they are marked off. When all items in a detail are taken off,
the detail should be marked off by marking the title of the de-
tail with the highlighter. When all items on a page are ac-
counted for, the page should be marked off by marking the
page number with the highlighter. At the end of the estimate,
all pages in the plans should be marked off, which is easy for
the estimator to check. Takeoff software packages mark the
items as they are taken off. Marking off items and pages en-
sures both completeness (none of the construction details
have been left out) and accuracy (the quantities are correct).

DOUBLE-CHECK ALL
TAKEOFFS
It is easy for an estimator to lose count or miscount items.
For this reason it is important to double-check all takeoff
quantities by performing all takeoffs at least twice until the
same quantity is obtained on two separate takeoffs. Any dif-
ference in the numbers should be because of rounding. In a
pinch, a quick-and-dirty takeoff can be used to double-
check complex takeoffs. Double-checking takeoffs helps to
ensure the accuracy of the quantity takeoffs.

INCLUDE UNITS IN
CALCULATIONS
A number of common mistakes can be avoided by including
the units in the calculations. They include (1) failing to con-
vert the quantities to the proper units, (2) using the im-
proper conversion factor, and (3) dividing when one should
be multiplying, or multiplying when one should be dividing.
By including the units in the calculations, you can cancel

them out and verify that you end up with the desired units.
For example, if you end up with cubic feet and you needed
cubic yards, you know you forgot to convert from cubic feet
to cubic yards. Consider another example of how including
the units can avoid an error: if an estimator mistakenly di-
vided by to convert from cubic feet to cubic yards,
he or she would find that the units after the conversion were
ft-yd2, indicating that he or she used the wrong conversion
factor. This is shown in the following equation:

Similarly, if the estimator was converting cubic feet to cubic
yards and multiplied by rather than dividing, he
or she would end up with indicating that there were
problems with the conversion. This is shown in the following
equation:

Including the units in the calculations helps to ensure the ac-
curacy of the estimate, as shown in the following equation:

AUTOMATE WITH
SPREADSHEETS
Another source of error is use of the wrong formula. The
best way to avoid this problem is to set up standard formulas
in spreadsheets and macros (computer functions that auto-
mate processes) to be used in the bidding process rather than
using hand calculations or writing new spreadsheet formulas
each time. For this to be successful, the formulas, spread-
sheets, and macros must be carefully tested for errors. This
helps to ensure the accuracy of the estimate.

USE WELL-TESTED AND
CHECKED FORMULAS
Formulas used in spreadsheets and macros must be well
tested to ensure that they do not contain errors. An error in a
spreadsheet can promulgate the error to a number of bids
before it is found, increasing rather than decreasing the
number of errors. The formulas should be tested under a va-
riety of conditions. It is not uncommon for a formula to
produce errors only in some conditions. Testing spread-
sheets and formulas is discussed further in Chapter 32.

When a new formula is written that will only be used
once, it is important to verify that it is free of error and that
it references the correct cells. A common mistake is to insert
a row for an item at the top or bottom of a group of items
that are summed without having the row included in the
sum. In this case, the item is left out of the bid. Testing and

27!ft3 �
(27!ft3)

(27!ft3/yd3)
� 1!yd3

27!ft3 � (27!ft3)(27!ft3/yd3) � 729
ft6

yd3

ft6/yd3,
27!ft3/yd3

27!ft3 �
27!ft3

(9!ft2/yd2)
� 3!ft-yd2

9!ft2/yd2
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checking formulas is needed to ensure the accuracy and
completeness of the bid.

DOUBLE-CHECK ALL
CALCULATIONS
It is easy for an estimator to make a mistake when entering a
number into a calculator. For this reason, it is important to
double-check all calculations by entering the numbers into
the calculator at least twice until you get the same answer.
Some estimators like to use a different calculator when
double-checking calculations. This helps to ensure the accu-
racy of the estimate.

PERFORM CALCULATIONS
IN TWO WAYS
Where possible, perform spreadsheet calculations in two
ways. For example, the total construction cost for a project
can be obtained by summing the total cost for each cost
code, or the total can be obtained by summing the totals
for material, labor, equipment, subcontract, and other costs
and then summing these totals. Performing the calcula-
tions in both of these ways should result in the same an-
swer. When the totals are different it is an indication that
there is an error in the spreadsheet and it is likely a number
has been left out of one of the totals. Performing calcula-
tions in two ways helps to ensure the completeness of the
estimate.

DROP THE PENNIES
Another common error is to inadvertently leave out a deci-
mal point when adding costs consisting of dollars and cents.
For this reason, pennies should be dropped from all costs
where dropping the pennies will not make a significant dif-
ference on the cost of the project. Pennies should be
dropped from the material cost, labor cost, equipment cost,
and total columns of Figure 26-4 . Pennies and fractions
thereof (if desired) should be included on unit costs and
labor rates because dropping the pennies on these items will
have a significant effect on the cost of the work. Dropping
pennies, where appropriate, helps to ensure the accuracy of
the estimate.

HAVE SOMEONE REVIEW
THE ESTIMATE
Before submitting an estimate it should be reviewed by a
peer or boss. As a person works intensively on a project over
a long period of time he or she begins to see what he or she
expects to see. Often, when someone else reviews the esti-
mate he or she will spot problems that the estimator has
missed. This helps to ensure both the accuracy and the com-
pleteness of the estimate.

REVIEW EACH COST CODE
AS A PERCENTAGE OF THE
TOTAL COST
Another way to prevent errors is to calculate the cost for each
cost code as a percentage of the total cost of the estimate and
review these percentages to see whether any of the percent-
ages are higher or lower than expected. As one does this he or
she will become familiar with the expected range for each
cost code (for example, electrical costs may run between 6%
and 9% of the bid) and the relationships among the percent-
ages (for example, electrical costs may be about the same per-
centage as the HVAC and plumbing costs combined) for the
type of work the company typically bids. Reviewing the per-
centages does not identify errors but may point to areas in the
bid where one might find errors. For example, if framing is
5% of the bid and lumber is 20% of the bid, one may suspect
there is an error in either the framing or lumber costs or
both. Reviewing the percentages of the bid for each cost code
helps to ensure the accuracy and completeness of the bid.

CHECK UNIT COSTS FOR
EACH COST CODE
Another way to prevent errors is to calculate and review the
unit costs for each cost code. The unit cost can be based on
the cost per square foot, cost per parking space, cost per
apartment unit, or any other relevant unit of measure. As in
calculating the percentages, over time one becomes familiar
with the expected range for each cost code and the relation-
ships among the costs. Reviewing the unit costs of the bid
helps to ensure the accuracy and completeness of the bid.

COMPARE COSTS TO THOSE
FOR ANOTHER PROJECT
Another way to prevent errors is to compare the cost of the
estimate to the cost of other similar projects that have been
bid to see if the costs are similar. For example, if a company
recently bid a 10,000-square-foot warehouse for $195,000
and they are bidding on a 9,500-square-foot warehouse of
similar design, one would expect the costs for the warehouse
they are bidding to be slightly less than those for the 10,000-
square-foot warehouse. If they are vastly different, either
higher or lower, the estimator should check the bid carefully
for errors. The costs can be compared based on the total cost
or by the cost code. Comparing the costs to another project
helps to ensure the accuracy and completeness of the bid.

ALLOW PLENTY OF TIME
One of the most important things an estimator can do is
allow plenty of time to complete the estimate, especially on
bid day. Bid days can be quite hectic. It is better to be over-
prepared than to scramble to fill in missing prices at the last
minute. This helps to ensure both the accuracy and the com-
pleteness of the bid.
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CONCLUSION
It is impossible to eliminate all errors from a bid; however,
with careful procedures you can greatly reduce the number
and size of errors. Errors can be reduced by listing all of the
needed cost codes on a standardized form at the start of the
estimating process, spending more time on the larger-cost
items, preparing more detailed estimates, marking off items
on the drawings as they are taken off, double-checking all
takeoffs, including units in calculations, automating the esti-
mating process with spreadsheets, using well-tested formu-
las, double-checking all calculations, performing calcula-
tions in two ways, dropping pennies from numbers where it
will make little difference in the total bid, having someone
review the estimate, reviewing each cost code as a percentage
of the total cost, checking the unit cost for each cost code,
comparing the bid to bids from other projects, and allowing
plenty of time to complete the bid.

PROBLEMS
1. Define accuracy and completeness. What is the differ-

ence between accuracy and completeness?

2. Why is it important to use a bid summary form similar
to the one shown in Figure 2-2?

3. Why should you spend more time on items with large
costs than on items with small costs?

4. Why are detailed estimates more accurate than square-
footage estimates?

5. Why should items on the drawings be marked off as
they are taken off?

6. Why should you perform takeoffs twice?

7. Why should you include units in all calculations?

8. What are the advantages of using formulas and macros
in spreadsheets?

9. Why must spreadsheet formulas be tested?

10. Why should you always double-check your calculations?

11. Why should calculations, where possible, be performed
in two different ways?

12. Why should pennies be dropped from the material cost,
labor cost, equipment cost, and total columns from
Figure 26-4?

13. Why should the estimate be reviewed by a peer or boss?

14. Why is it important to check the percentage of the total
bid for each cost code?

15. Why is it important to check the unit cost for each cost
code?

16. Why should one compare the costs of the bid to the
costs of other, similar projects?

17. Why is it important to allow plenty of time to prepare
the bid?



Chapter 28 Submitting the Bid

Chapter 29 Project Buyout

Chapter 30 The Estimate as the Basis of the Schedule

Chapter 31 Ethics

I
n this section, you will learn how to complete and submit the bid, pur-
chase the materials and hire subcontractors to complete the work, and
incorporate data from the bid into the schedule. This section also in-

cludes a discussion of ethics as it relates to bidding.

P A R T F O U R

FINALIZING THE BID
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In this chapter you will learn how to submit a bid using stan-
dardized bid documents and also how to write a proposal letter.

One of the most important things to do when sub-
mitting a bid is to have the bid in on time. For
some owners, particularly public agencies, bids

that are late, even by 1 minute, are not considered. The types
of bids submitted may be divided into two broad categories:
submitting the bid using standardized bid documents pro-
vided by the design professional and owner, or submitting a
proposal. Let’s first look at submitting the bid with standard-
ized bid documents.

BID SUBMISSION WITH
STANDARDIZED DOCUMENTS
Many owners or design professionals have a set of standardized
bid documents that they use on all projects. The documents
may include a bid form (such as the one shown in Figure 1-1),
a schedule of values (such as the one shown in Figure 1-2), a
bid bond, certifications, and so forth. When bidding using
standardized bid forms, it is important to make sure that the
form is completely filled out and that the pricing is accurate.
For many municipalities, incomplete or missing forms result in
the bid being classified as a nonresponsive bid, and the bid
ends up being discarded. It would be unfortunate for the esti-
mator to spend days preparing a bid and having the low price
only to have the bid discarded because a form was missing or a
line had been left blank on a form. Before submitting a bid, the
estimator should carefully check the bid documents to make
sure they are complete and accurate. Any blank items that must
be filled in just before the bid is submitted, such as the price,
should be marked with Post-Its to minimize the possibility of
forgetting to fill in a blank on the day of the bid. It is also a good
idea to use a checklist to make sure that nothing is forgotten. A
sample checklist is shown in Figure 28-1.

WRITING A PROPOSAL
The second category is submitting a proposal. With a pro-
posal, rather than using documents provided by the owner
or the design professional, the estimator must prepare his
or her own proposal. The owner may specify what needs to
be included in the documents, but the actual format and
organization of the documents is left up to the company
submitting the bid. The documents may include a proposal
letter, breakdown of the bid price, bid bonds, schedule, cat-
alogue cut sheets, samples, and so forth.

SUBMITTING THE BID

CHAPTER TWENTY-EIGHT

FIGURE 28-1 Sample Bid Submission Checklist
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One of the most important documents in the proposal is
the proposal letter. The proposal letter should identify the
price for the work, payment terms, the scope of the work being
bid, work that is excluded from the bid, any clarifications that
need to be made, the latest date the proposal may be accepted,
the schedule for the start and completion of the work, sug-
gested alternatives, severe-weather clauses, and other items
that help to clarify the proposal. The proposal letter should be
kept to under five or six pages. When all of this information
cannot be contained in a short letter, these items should be in-
cluded as attachments to the proposal. All attachments to the
proposal should be referenced in the proposal letter. Let’s look
at the specific components of the proposal letter.

Price: The proposal letter must clearly communicate to
the client the price to complete all or a specified por-
tion of a construction project. The letter should con-
tain a price or price range. Price ranges are often used
when dealing with preliminary bids when the design of
the project is still being established to indicate that the
price is not a hard-and-fast number. If the price is to be
broken down into a number of items, then the break-
down of the pricing should be submitted on a schedule
of value form (similar to Figure 1-2) that is attached to
the letter. When a schedule of values is included, the es-
timator must make sure that the costs on the schedule

of values add up to the total bid price. Any backup to
the pricing required by the owner, such as bids from
subcontractors, should also be attached. In the letter in
Figure 28-2, the price for the work is $956,250.

Payment Terms: Along with the price, the terms of
payment (for example, retention rate and when pay-
ments are due) should be included in the letter. In the
letter in Figure 28-2, the payments terms are that the
owner will be billed progress payments at the end of
each month, and payment is due from the owner 25
days after receipt of the bill.

Scope of Work: The proposal letter should clearly state
the scope of work being bid. Often, with a proposal
there is some flexibility to specify or modify the scope
of work. Some owners may allow the contractor to
bid on all or part of the work, may leave the specify-
ing of materials up to the contractor, or leave design
of all or part of the project to the contractor, as is the
case in a design-build project. The scope of work
should be prepared as discussed in Chapter 24 and
should identify work that is included in the bid, work
that is excluded from the bid, and any clarifications
that need to be made. This may require the attach-
ment of a sample specification (such as the one
shown in Figure 28-3), catalogue cut sheets, and so

FIGURE 28-2 Sample Proposal Letter
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FIGURE 28-3 Sample Specifications
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forth. In the letter in Figure 28-2, the work will be
completed as per the plans and specification pre-
pared by John Lake, AIA, and dated April 26, 2006.
Included in the price is the cost of the building per-
mit, and all other fees assessed by the local munici-
pality are excluded.

Time Frame: The proposal letter should identify how
long the client has to accept the proposal and the an-
ticipated start and completion of the work. Because
bids that have not been rejected can tie up the bond-
ing capacity for a company and leave the company
wondering whether they are going to do the work, a
company needs to include a time frame for accepting
the bid in the proposal letter. Because the time of the
year the work is being done can greatly affect the
price, the time frame for starting and completing
the work should be included in the proposal letter.
In the letter in Figure 28-2, the owner has 60 days
from the date of the proposal to accept the proposal,
and the proposal is based on the project being started
before August 15, 2006, and being completed in 160
calendar days.

Alternatives: The proposal letter may also include a list
of suggested alternatives for consideration by the
owner. For example, the contractor may be able to
obtain a piece of equipment that has not been ap-
proved but is similar to the equipment specified at a
lower price. In this case the contractor should include
the specified piece of equipment in the company’s bid
and offer the owner the opportunity to reduce the bid
by changing to the proposed piece of equipment.

Other: The proposal should contain any severe-
weather clauses or other items that help to clarify the
proposal.

Contact Information: Finally, the proposal should
contain the name of the person to contact and how
to get a hold of him or her should the client have
any questions or desire to make any changes to the
proposal.

WRITING A BUSINESS LETTER
The proposal should be written in a standard business letter
format. All business letters should leave the client with a
good impression of the company. This is done by preparing
a clearly written letter free of spelling and typographical er-
rors and written in a standard business format. When work-
ing for a company, one should determine whether the com-
pany has a standard format or template for business letters,
and if so, it should be used. The following is an overview of
the parts and layout of a standard business letter.

Sender’s Address: The sender’s address should include
the company name, street address, city, state, and zip
code. The senders address may appear at the top of
the letter as shown in Figure 28-2 or be included as a
footer to the first page of the letter. When the letter is

printed on letterhead that includes the sender’s ad-
dress, the sender’s address is not included in the letter.

Date: The date of the letter should be the date the letter
was written. When writing a letter that takes a num-
ber of days to complete, the completion date of the
letter is used instead of the date the letter was started
to avoid the appearance that the letter has been sitting
around for a long time before someone got around to
mailing it. The date should contain the month (writ-
ten out completely), the day of the month, and the
year. A comma should separate the day of the month
and the year. The date should be directly below the
sender’s address, if there is one.

Inside Address: The inside address is the address of the
person to whom the letter is being sent. Every letter
should be addressed to a person and not just a com-
pany. The inside address should include the name,
personal title (Miss, Mrs., Mr., or Dr.), and job title
(for example, president). If one is not sure of the
spelling of a person’s name, preferred personal title,
or job title, one should call his or her secretary or the
company’s receptionist and find out this information.
When the sender’s address is above the date in the let-
ter, there should be one blank line between the date
and the inside address. When the sender’s address is
not above the date in the letter, the inside address
should be 1 inch below the date.

Subject Line: Every letter should have a subject line.
The subject line allows the reader of the letter to
quickly identify the main topic of the letter. A subject
line is very useful when trying to locate an old letter
about a certain subject when one is not sure of the
date the letter was sent. During the course of a pro-
ject, hundreds of letters may be written between the
contractor and the owner. Without a subject line, it
can take hours to locate old correspondence related
to a specific topic. Subject lines often begin with RE:,
short for regarding. Most often the subject line is not
a complete sentence; therefore, it should not end with
a period. The subject of the letter in Figure 28-2 is the
submission of the bid for the West 10th Street Office
Complex. There should be one blank line between the
inside address and the subject line.

Salutation: The salutation is the greeting to the per-
son to whom the letter is being written. The saluta-
tion should begin with the word Dear and end with
a colon. The person who is greeted in the salutation
is the person whose name appears in the inside ad-
dress. Unless the writer is a close personal business
acquaintance or friend, the person should be ad-
dressed by personal title and last name. If the writer
is a close business acquaintance or friend, he or she
may choose to address the recipient of the letter in a
less formal manner, such as Dear Bob. There should
be one blank line between the subject line and the
salutation.
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Body: The body of the letter should be written in a
clear, concise, and orderly manner. For the proposal
letter, the body of the letter should identify the price
of the work, payment terms, and so forth. The first
paragraph should contain a friendly opening, such
as “Thank you for giving us the opportunity to bid
on the West 10th Street Office Complex.” Next, the
body of the letter should state the main point of the
letter. This is done in the first or second paragraph.
After stating the main point, the body of the letter
should continue to logically justify or clarify the
main point of the letter. These justifications and
clarifications should be organized in the order of
importance, with the most important points first
and the least important points last. Near the end of
the body of the letter, the main points may be re-
stated, and, if desired, the writer of the letter should
urge the recipient to take some specific action.
Finally, the writer of the letter should identify who
to contact and how to contact him or her for an-
swers to questions or for more information. This is
very important because often letters are signed by
someone other than the person who prepared the
letter. There should be one blank line between the
salutation and the body of the letter. The paragraphs
of the letter should be single spaced with a space be-
tween the paragraphs.

Closing: The closing of a letter contains a closing
statement (such as “Sincerely” or “Best regards”), a
space for the signature, and the name and title of the
person who signed the letter. There should be a
blank line between the body of the letter and the
closing statement. Only the first word of the closing
statement should be capitalized, and the closing
statement should be followed by a comma. Three
blank lines should be provided for the signature be-
fore the name and title of the person who signs the
letter. The name and title of the person who signs
the letter follows the same rules as the name and
title of the recipient.

Enclosures: If documents are included with the letter,
the word Enclosure (for a single document) or
Enclosures (for multiple documents) is included
after the closing. There should be one blank line be-
tween the closing and the enclosure. If desired, the
writer of the letter may list the documents enclosed
with the letter.

Copies: Next, the letter should identify who received
copies of the letter. This is done by typing CC: (short
for carbon copies) followed by the name of the recip-
ients. In Figure 28-2 a copy of the letter was sent to
the file. There should be one blank line between the
copies and the enclosure or closing if there are not
any enclosures.

Writer’s and Typist’s Initials: If the letter was written
or typed by someone other than the signer of the letter,

the writer’s initials and the typist’s initials are often
included after the copies. The writer’s initials are cap-
italized and the typist’s initials are written in lower-
case. When both sets of initials are included, a colon
separates the initials. There should be a blank line be-
tween the initials and the text that appears directly
above the initials.

File Name and Location: With the advent of the com-
puter, people often want to locate an electronic copy
of a document. To make letters easier to find, the
writer often includes the file name and file location
(folder) at the end of the letter. There should be a
blank line between the file name and location and the
text that appears directly above it.

Letters Longer Than One Page: Two things must be
done for letters longer than one page. First, the clos-
ing should not begin at the top of the page. The page
breaks of the letter should be changed so that there
are at least two lines of body on the page before the
closing. Second, in case the pages of the letter get sep-
arated from each other, the pages need to be individ-
ually identified so they can be reunited. This is done
by including a header on the second through last
pages of the letter. The header should include the
page number, whom the letter was written to, and the
date of the letter.

LETTER FORMATS
There are three common formats for letters: block, modified
block, and semiblock. In the block format, all contents in the
letter are left justified and the first line of each paragraph is
not indented. The letter in Figure 28-2 is written in the block
format. For a letter written in the modified block format, the
sender’s address, date, and closing (signature block) begin at
the center of the page (not centered), whereas all other items
of the letter are left justified. Figure 28-4 shows a letter writ-
ten in modified block format. The semiblock format is the
same as the modified format except that the first line of each
paragraph is indented. Figure 28-5 shows a letter written in
the semiblock format.

WRITING E-MAILS
E-mail is widely used by contractors to communicate with
design professionals, subcontractors, and suppliers, as well
as with the company’s own personnel. E-mail is often used to
invite subcontractors to bid on a project, obtain pricing
from suppliers, and submit bids to the general contractor.
During both the bidding process and the construction of the
project, e-mail is often used to request additional informa-
tion and obtain clarifications regarding the drawings and the
project manual.

It is important that e-mails leave the client, design pro-
fessional, subcontractor, or supplier with a good impression
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FIGURE 28-4 Modified Block Letter

FIGURE 28-5 Semiblock Letter



CONCLUSION
It is important for bids to be submitted on time because
owners may reject late bids. Sometimes bids are submitted
on standard bid documents that may include the bid form,
a schedule of values, a bid bond, certifications, and so
forth. Other times, the contractor may be required to sub-
mit a proposal that may include a proposal letter, break-
down of the bid price, bid bonds, schedule, catalogue cut
sheets, samples, and so forth. The proposal letter should
include the price for the work, payment terms, the scope
of the work being bid, work that is excluded from the bid,
any clarifications that need to be made, the latest date the
proposal may be accepted, the schedule for the start and
completion of the work, suggested alternatives, severe-
weather clauses, and other items that help to clarify the
proposal.

PROBLEMS
1. Why is it important to submit the bid on time?

2. Why is it important to make sure a complete bid pack-
age has been submitted?

3. Why should the proposal letter include the anticipated
start and completion of the work?

4. Why should a letter or e-mail have a subject line?

5. Why should a letter contain the person to contact and
how to get a hold of him or her should the recipient
have questions?

6. Why should letters longer than one page have a header
containing the page number, recipient’s name, and date?

7. What is the difference between the block, modified
block, and semiblock formats?

8. What are the rules for writing a good e-mail?
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of the company. As with letters, this is done by preparing a
clearly written e-mail, free from spelling and typographical
errors. A sample e-mail is shown in Figure 28-6. E-mails
should abide by the following rules:

� E-mails should only be sent to the parties that need the
information. Sending e-mails to a large number of people
to cover your bases wastes their time and leaves them with
a bad impression. Junk e-mails, cute stories, and other
similar e-mails should not be forwarded unless you have
permission from those you are sending them to.

� E-mails should have a subject line so that it can be quickly
found. A common mistake is to reply to an e-mail with an
e-mail that discusses a different topic without changing

the subject line. If the topic changes, the subject line
should change to reflect the change. If an e-mail is impor-
tant enough to send, it is important enough to have a well
written subject line. E-mails with poor subject lines are
often placed in the trash without even being opened. In
Figure 28-6, the subject of the e-mail is “Lumber Pricing
for West 10th Street Office Complex.”

� E-mails should be brief and to the point. They should
clearly state the desired action the sender wants the recip-
ient to take. The e-mail should not leave them wondering
why it was sent. In Figure 28-6, the desired action is for
the lumber supplier to provide ABC Construction a lum-
ber quote for the West 10th Street Office Complex by
10:00 am on September 1, 2009.

� E-mails should be checked for proper spelling, punctua-
tion, and capitalization. If your e-mail software does not
check for spelling and grammar, the e-mail should be
written in a word processer that does and copied to the
e-mail software. E-mails should not be written using all
capital letters.

� Emotion icons should not be used in business communi-
cation. Too often they do not come across as expected.

� The signature block should contain the contact informa-
tion for the sender, such as his or her phone number(s)
and fax number.

FIGURE 28-6 Sample E-mail

From: ABC Construction
To: XYZ Lumber
Date: 8/22/2009  10:55 AM
Subject: Lumber Pricing for West 10th Street Office Complex 

Attached is the list of the lumber needed to construction 
the West 10th Street Office Complex. Please provide 
us with a quote for this lumber by 10:00 am on 
September 1, 2009. 

Steven Peterson, MBA, PE 
Phone 801-626-0000 
Fax 801-626-0001
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Parties to the Contract: The subcontract is a legal
agreement between the contractor and the subcon-
tractor, or a subcontractor and a second-tier subcon-
tractor (a subcontractor to a subcontractor). The par-
ties to the contract should be clearly identified at the
beginning of the contract. After identifying the par-
ties, the parties to the contract are referred to as the
“Contractor” and “Subcontractor.” The contract
should address the procedures for the assignment
(the subcontracting) of part of or the entire subcon-
tract to another party. If one or more of the parties
are persons rather than corporations, what happens
in the event of the death of one of the parties should
be addressed.

Project Identification: The project name and loca-
tion of the project should be clearly identified in the
contract.

Scope of Work: The contract should include the scope
of work covered by the subcontract. The scope of
work is different for each subcontract. The scope of
work should be written in accordance with Chapter
24 and should be tied to a set of construction docu-
ments along with their dates. This may be done by
attaching a list of construction documents, such as
the one given in Appendix F, to the contract and ref-
erencing the attachment in the subcontract.

Schedule of Values: The subcontract should clearly es-
tablish the price to be paid for the completion of the
scope of the work. When work is done in phases, such
as rough and finish electrical, the price for each phase
needs to be established to avoid billing disputes dur-
ing the construction process. When unit prices are in-
cluded in the subcontract, the unit prices, as well as
how the quantities will be determined, need to be in-
cluded in the subcontract. If the contractor has the
right to accept an alternative, such as constructing an

CHAPTER TWENTY-NINE

PROJECT BUYOUT

In this chapter you will learn how to write subcontracts and
purchase orders.

The buyout is the process of hiring subcontractors
and procuring materials and equipment for a con-
struction project. Subcontractors are hired by writ-

ing a subcontract between the contractor and the subcon-
tractor. Materials and equipment are procured by issuing
purchase orders or contracts to the materials and equipment
suppliers. The estimator should write the subcontracts and
the majority of the purchase orders before construction be-
gins or during the early stages of construction. Let’s begin by
looking at subcontracts.

SUBCONTRACTS
Subcontracts are issued to subcontractors who provide labor
at the construction site. These subcontractors may also pro-
vide materials and equipment. If a subcontractor does not
provide labor at the construction site, a purchase order or
material contract should be issued rather than a subcontract.
During the buyout process, the estimator should prepare all
of the subcontracts. The owner or designee should review
and sign the contracts.

Many companies have standard subcontracts they use.
Standard subcontracts are also available from the American
Institute of Architects (AIA) and the Associated General
Contractors of America (AGC). Construction companies
should make sure that the subcontracts that they use meet
their needs rather than assume that standard subcontracts
are right for them. If contractors write their own subcon-
tracts or make changes to a standard subcontract, the con-
tract and changes should be reviewed by an attorney. When
selecting or writing a subcontract to use, the contractor
should consider the following issues:
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additional building, during the construction of the
project, the terms for acceptance and pricing need
to be addressed in the contract. For example, the
contractor may have the right to build a second
identical building for the same price as the first
building provided the construction of the second
building is started within 6 months of the start of
the first building.

Schedule: The subcontract should require the subcon-
tractor to meet the schedule set by the general con-
tractor. Often a preliminary schedule is attached to the
subcontract. The number of days the subcontractor
has to begin the work after receiving notice to pro-
ceed, the number of days the subcontractor has to
complete the work, the minimum crew size the sub-
contractor agrees to maintain at the site during the
period the work is being performed, and a require-
ment for the subcontractor to work overtime may be
included in the subcontract. The subcontract should
identify any coordination meetings the subcontractor
is required to attend and any special coordination
needed between the subcontractor and other trades.
For example, if the mechanical subcontractor needs
to coordinate the delivery of the roof-top units with
the contractor so the contractor’s crane is available to
place the units, these requirements should be spelled
out in the contract. The penalties for missing coordi-
nation meetings and missing deadlines should also be
included in the subcontract.

Submittals: The subcontract should identify the sub-
mittals required, the process for their approval, and
their due dates. If these requirements are included in
the project’s specifications, the specifications can sim-
ply be referenced in the subcontract.

Quality: The subcontract should identify the level of
quality required along with any required testing and
inspections. If these requirements are included in the
project’s specifications, the specifications can simply
be referenced in the subcontract. The penalties for
unacceptable quality and the procedures and time al-
lowed for correcting the work need to be included in
the subcontract.

Payment: The subcontract should clearly identify
when and how payments will be made. The subcon-
tract should include (1) when invoices are due and
when they will be paid, (2) whether partial or
progress payment will be made versus payment on
completion, (3) whether retention will be withheld
from the payment, (4) whether the work is required
to be billed within a specified number of days of its
completion, (5) whether the payment will be held
until payment is received from the owner (a paid-
when-paid clause), (6) whether payment will be
made for materials ordered or delivered to the site
that have not been incorporated into the building,
and (7) the requirements for final payment and

release of retention. The subcontract should give the
contractor the right to withhold payments for defec-
tive work; failure to meet contractual requirements,
including providing lien waivers, insurance certifi-
cates, certified payrolls, as-built drawings, operation
and maintenance manuals, and so forth; claims
against the subcontractor; failure to pay for materials;
and liens against the project caused by the subcon-
tractor. The contractor should have the right to
backcharge the subcontractor for damage to the work
of other trades done by the subcontractor and charge
the subcontractor the penalties set forth in the sub-
contract. The contractor should have the right to
issue a joint check to the subcontractor and the sub-
contractor’s suppliers if the contractor has concerns
about the suppliers getting paid.

Change Orders: The subcontract should clearly iden-
tify the process for issuing change orders and indicate
that payment will not be made for unauthorized
change orders.

Insurance, License, and Bond Requirements: The sub-
contract should require the subcontractor to maintain
specified insurance limits and name the general con-
tractor as an additional insured on their insurance
policy. It should also require the subcontractor to sub-
mit proof that they have workers’ compensation in-
surance and a copy of their contractor’s license (if
licensing is required) and notify the contractor in the
event either of these changes. The subcontract should
identify any bonds required, and require the subcon-
tractor to indemnify the contractor against any suits
that are a result of the subcontractor’s actions.

Warranty: The subcontract should identify the war-
ranty requirements and spell out response times for
different classes of warranty issues. For example,
problems with heating systems should be handled
within hours, whereas problems with paint should be
handled within days.

Protection of Work: The subcontract should require
the subcontractor to protect the work of other trades
from damage caused by the subcontractor’s work,
protect their own work against weather, and protect
their materials and equipment against theft and
vandalism. It should also identify the subcontractor’s
rights and responsibility for using the existing or
newly constructed facilities. For example, can the
subcontractor park on the new parking lot? If so,
what must the subcontractor do to protect the
facilities?

Safety: The subcontract should require the subcontrac-
tor to comply with Occupational Safety and Health
Act (OSHA) and other state and federal safety regula-
tions, comply with the contractor’s safety plan, attend
or hold safety meetings, and provide Material Safety
Data Sheets (MSDS). A copy of the contractor’s safety
plan should be attached to the subcontract.



Project Buyout 291

Cleanup: The subcontract should require subcontrac-
tors to clean up after themselves on a daily basis and
should identify the penalties for not cleaning up.

Termination: The subcontract should set the proce-
dures for terminating the contract for nonperfor-
mance of the subcontractor or in the event the con-
tractor’s contract with the owner is canceled.

Dispute Resolution: The subcontract should set the
procedures for dispute resolution. They may include
mediation, arbitration, and going to court. The pay-
ment of attorney’s fees in the event of a dispute
should be addressed. If any of the parties to the con-
tract are located in a different state than the state
where the project is located, the jurisdiction under
which the contract will be interpreted and where dis-
putes will be resolved should be identified.

General Clauses: General provisions include how the
contract is administered. They include (1) stating the
contractor’s right to waive a provision without hav-
ing to waive the provision in the future or without
voiding the contract, (2) allowing unenforceable pro-
visions thrown out by the courts to be severed from
the contract, (3) describing under which state’s law
the contract will be enforced, (4) making sure that the
entire agreement is contained within the contract,
and (5) stipulating that the agreement supersedes all
previous agreements. All attachments to the contract
should be identified in the contract.

PURCHASE ORDERS
Purchase orders are written to material and equipment sup-
pliers. If these suppliers are providing labor at the construc-
tion site, a subcontract should be written rather than a pur-
chase order. During the buyout process, the estimator should
write the majority of purchase orders. The project manager
and superintendent will write additional purchase orders as
materials not purchased by the estimator are ordered.

The purchase orders are based on the Request for
Materials Quote and should contain the following informa-
tion: the number of the purchase order; the cost code to
which the purchase order will be charged; the contractor’s
name, address, and contact information; the supplier’s
name, address, and contact information; the project’s name,
address, and contact information; the quantities, descrip-
tion, and pricing for the materials or equipment being or-
dered; delivery costs; sales tax; a total price for the purchase
order; payment terms; the signature of the contractor’s em-
ployee ordering the materials; and the date the purchase
order was signed. A sample purchase order is shown in
Figure 29-1.

Purchase orders should be sequentially numbered and
recorded in a purchase order log when they are issued. The
purchase order log should contain the following informa-
tion: the purchase order number, the project the purchase
order was issued for, to whom the purchase order was issued,
and a brief description of the materials or equipment or-
dered. A sample purchase order log is shown in Figure 29-2.

FIGURE 29-1 Sample Purchase Order

Cost Code

DESCRIPTION $/UNIT COST

SUBTOTAL
SALES TAX 0.00%
SUBTOTAL
DELIVERY

TOTAL

By: Date:

PO #

Project:

1001 PURCHASE ORDER
To:

Invoices received by the 25th day of the month will be paid on the 25th of the following month.  Any 
application for payment received sixty (60) days or more after materials have been delivered shall not be 
honored.  All invoices must be submitted to the contractor's office.

QUANTITY

From:
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FIGURE 29-2 Sample Purchase Order Log

CONTRACTS FOR MATERIALS
When materials are purchased over a long period of time
or annual agreements are made for materials, a contract for
materials may be written rather than a purchase order.
Material contracts differ from subcontracts in two ways.
First, the contract may not be tied to a specific project as in

the case of an annual contract for materials. Second, mate-
rial suppliers do not perform work on the jobsite.
Contracts for materials should be similar to subcontracts
with the nonapplicable clauses eliminated. For example,
material suppliers do not need to attend the weekly safety
meetings.

CONCLUSION
The buyout is the process of hiring subcontractors and
procuring materials and equipment for a construction pro-
ject. Subcontractors are hired by writing a subcontract be-
tween the contractor and the subcontractor. Materials and
equipment are procured by issuing purchase orders or con-
tracts to the materials and equipment suppliers. The estima-
tor should prepare the subcontracts and the majority of the
purchase orders before construction begins or during the
early stages of construction.

PROBLEMS
For Problems 1 through 12, obtain a copy of a subcontract
used by a local contractor or a standard AIA or AGC subcon-
tract.

1. How does the subcontract address scheduling issues?

2. How does the subcontract address quality issues?

3. What payment terms are established by the subcontract?

4. Under what circumstances can the contractor backcharge
the subcontractor?

5. What are the procedures for processing a change order?

6. What are the insurance requirements?

7. What are the bonding requirements?

8. How does the subcontract address warranty issues?

9. How does the subcontract address protection of work?

10. How does the subcontract address safety?

11. Under what conditions can the subcontract be termi-
nated?

12. What are the procedures for dispute resolution?

13. Prepare subcontracts and purchase orders for the Johnson
Residence given in Appendix F.

14. Prepare subcontracts and purchase orders for the West
Street Video project given in Appendix F.



In this chapter you will learn how the data from the estimate
relates to the project’s schedule.

During the process of estimating the project, the esti-
mator should have collected much of the data
needed to prepare the schedule. For a task on the

project to be completed, the proper labor, materials, and
equipment must come together on the project at the same
time the project is ready for the work to be done. For exam-
ple, for a roof-top HVAC unit to be placed, the materials (the
roof-top unit), the labor (the HVAC subcontractor), and the
equipment (a crane) must come together when the building
is ready for the roof-top unit. If the materials, labor, or
equipment is not available or if the building is not ready for
the work to be performed, the work cannot be performed.
The following information from the estimate is needed to
prepare the schedule.

Task Relationships: In preparing the estimate, the esti-
mator should identify what tasks will need to be done
before a task or group of tasks can be completed and
what tasks must be done concurrently. Often, these
relationships are very obvious; at other times they are
not. For example, realizing that the footing must be
placed before foundation walls and columns is obvi-
ous, whereas realizing that the HVAC unit must be
placed as the trusses are placed, because there is lim-
ited access, is not obvious. It is such unobvious rela-
tionships that the estimator needs to pay particular
attention to and should have identified as he or she
builds the project in his or her mind.

Method of Construction: The method of construction
affects the work flow. For example, if the estimator
bid the project planning to reuse the foundation
forms on the project four times, the schedule will
need to reflect that the foundation will be poured in
four phases.

Materials Required: The materials required to com-
plete a task come from the estimate. Often, the pur-
chase orders are written to coincide with the tasks on
the schedule. For example, the purchase orders for
lumber on a building may be divided into a wall
package coinciding with the task of framing the walls
and a roof package coinciding with the task of fram-
ing the roof.

Labor Required: The crew makeup and the number of
labor hours to complete a task come from the estimate.

Equipment Required: The equipment required to com-
plete a task comes from the estimate and is based on the
method of construction used to determine the costs.

Subcontractor Required: The plans to use subcontrac-
tors to supply the labor for a task and possibly some
of the equipment and materials are identified in the
estimate.

Special Coordination, Inspections, and Long-Lead
Items: In preparing the estimate, the estimator
should identify special coordination, special inspec-
tions, and long-lead items that are needed to complete
the project. It is vital that the estimator pass the infor-
mation along to the persons responsible for preparing
the schedule and completing the construction.

This information can be recorded on the form in
Figure 30-1.

ESTIMATING DURATIONS
The estimated duration of a task should be related to the
number of labor hours required to complete the task and the
size of the crew assigned to it. The duration is estimated by
dividing the number of labor hours from the estimate by the
crew size, using the following equation:

(30-1)Duration �
(Labor!Hours)

(Crew!Size)
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FIGURE 30-1 Task Planning Form

TABLE 30-1 Durations for the Residential Garage

Labor
Hours

Crew
Size Duration

Footings and foundation 94 3 4

Slab/floor 10 2 1

Rough carpentry 57 3 3

Finish carpentry 12 1 2

Wood trim 4 1 1

Insulation 8 1 1

Siding 44 2 3

Roofing 22 2 2

Metal doors 2 1 1

Overhead doors 6 2 1

Hardware 2 1 1

Drywall 25 2 2

Paint 46 2 3

Electrical 26 2 2

Grading and excavation 16 1 2

Site concrete 34 2 3

Landscaping 6 1 1The schedule duration may need to be longer to reflect
curing time and other time it takes to complete a task where
labor is not working on the project. The calculation of dura-
tion is shown in the following example.

EXAMPLE 30-1

It is estimated it will take 475 labor hours to frame the interior par-
titions of an office building. How long will it take a five-person
crew to complete the framing if they work 8 hours per day?

Solution: The duration is calculated using Eq. (30-1) as follows:

�Duration �
(475!lhr)

(5!persons)
� (95!hr)a1!day

8!hr
b � 12!days

SAMPLE DURATIONS:
THE RESIDENTIAL GARAGE
The estimated crew sizes and the durations for the residen-
tial garage drawings given in Appendix F are shown in
Table 30-1. The labor hours are from Figure 26-7. These
durations are based upon an eight-hour day and are
rounded up to the next full day.

CONCLUSION
The estimate forms the basis of the schedule. The following
information is obtained from the estimate: the order in
which tasks need to take place; the method of construction;
the required materials, labor, equipment, and subcontrac-
tors; special coordination and inspections; and long-lead
items. The duration is estimated by dividing the number of
labor hours from the estimate by the crew size.

PROBLEMS
1. It is estimated that it will take 265 labor hours to frame

the interior partitions of an office building. How long

will it take a three-person crew to complete the framing
if they work 8 hours per day?

2. It is estimated that it will take 88 labor hours to set the
tile in a residence. How long will it take a two-person
crew to complete the tile if they work 9 hours per day?

3. Prepare task-planning forms for the residence given in
Appendix F.

4. Prepare task-planning forms for the West Street Video
project given in Appendix F.
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In this chapter you will be introduced to ethics as it relates to
estimating.

Ethics as it relates to estimating may be defined by two
broad definitions: (1) a set of principles or rules that
members of a group agree to abide by and (2) a set of

values or a guiding philosophy of the individual.
Professional groups, such as the American Society of

Professional Estimators,1 have established a set of ethics by
which their members agree to abide. These ethical princi-
ples, also known as canons, are shown in Figure 31-1.
Principles such as these set minimum standards of behavior
for members of the profession. Members of the industry
help to improve the image and trustworthiness of the profes-
sion by following these standards.

Besides the ethical principles established by professional
groups, each person has his or her set of ethical values or
guiding philosophy that affects how he or she behaves in a
given situation. Let’s look at a few of these.

WORK ETHIC
Work ethic relates to issues of how the estimator views the
work he or she does and includes (1) the completeness and
accuracy of bids he or she prepares, (2) the quality of his or
her work, (3) the commitment to expanding his or her skills,
and (4) how hard he or she works.

Each estimator should commit to preparing an estimate
that is as complete and as accurate as permitted by the time
allowed and the quality of the construction documents.
When there is insufficient time to prepare a complete and
accurate bid for a project, the estimator has the duty to dis-
cuss with his or her supervisor the situation and how the
time and document limitations will affect the bid.

Each estimator should commit to preparing work that
positively reflects on the estimating profession. Work should

be neat, with spelling and grammatical errors kept to a min-
imum. Estimates should be carefully documented and kept
in an organized manner.

Each estimator should commit to expanding his or her
area of expertise and keeping current with updates. This is
done by attending classes and conferences, reading trade
journals and publications, discussing estimating issues with
other members of the profession, and discussing advances in
materials and construction methods with field personnel,
subcontractors, and suppliers.

Each estimator should commit to spending the time he
or she is at work to promoting the goals of the company. In

ETHICS
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FIGURE 31-1 ASPE Canon of Ethics (Courtesy of American
Society of Professional Estimators)
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short, the employer should expect that the person will work
hard to complete his or her duties as an estimator.

BIDDING PRACTICES
Bidding practices relate to how the estimator handles bids.
When bids are handled in a manner that is fair to the client
and all subcontractors and suppliers, relationships of trust
are established among the parties. This trust results in better
working relationships among the parties and often results in
obtaining more work. When bids are handled in an unfair
manner, or when it appears that bids were handled in an un-
fair manner even if they were handled fairly, mistrust is cre-
ated among parties, and working relations are strained.

The best way to ensure that bids are handled in a fair
manner is to establish a policy regarding how bids are han-
dled and follow it. In addition, the criteria for bid selection
should be made available to all subcontractors and suppliers
so they have an understanding of what they must do to be
the selected bidder. The practices of bid rigging and bid
shopping must be avoided.

LOYALTY TO EMPLOYER
Each estimator has the duty to be loyal to his or her employer,
as long as the employer is behaving in an ethical manner.
Estimators are not obligated to support or be involved in ille-
gal or unethical behavior in the name of loyalty. Being loyal
to an employer includes keeping the employer’s proprietary
information (such as bidding practices and historical cost

data) confidential and making decisions that are in the best
interest of the employer rather than of oneself.

When there is a potential conflict of interest that may
lead to the estimator making a decision that is not in the best
interest of the employer (for example, the estimator is pur-
chasing materials from a family member), the estimator has
the duty to disclose this conflict of interest and allow his or
her work and decisions to be reviewed by someone else in
the company. Conflicts of interest occur whenever an esti-
mator does business with a family relation or a business he
or she has an interest in or when he or she accepts gifts or fa-
vors from a company with which the estimator’s company
does business. It is not unethical to be in a situation in which
a conflict of interest occurs provided everything is handled
in an open, honest manner and the company’s interests are
held above the interest of the estimator. For the conflict of
interest to be handled in an open manner, the potential con-
flict must be disclosed.

Employers should be able to expect that their employees
are honest. Employers who expect an employee to steal, cheat,
and lie for them should also expect the employee to steal from,
lie to, and cheat them. Honesty is truly the best policy.

ETHICAL DILEMMAS
Ethical dilemmas occur when the company’s and one’s per-
sonal ethics conflict or when one’s personal ethics as they re-
late to a specific situation are in conflict. Each person must
decide how he or she will act when confronted with an ethi-
cal dilemma.

CONCLUSION
Ethics is both a set of principles or rules that members of a
group agree to abide by and a set of values or a guiding phi-
losophy of the individual. The personal ethics of the estima-
tor include his or her work ethic (how he or she views the
work), bidding practices (how bids are handled), and loyalty
to the employer.

PROBLEMS
1. A long-time supplier or subcontractor asks you to share

a competitor’s pricing or quantities before he or she
submits a bid or before the bid closes. What do you do?

2. A long-time supplier or subcontractor asks you what
price they have to beat to get the work. What do you do?

3. A salesperson offers you a gift in order to influence your
purchasing decision. What do you do?

4. A long-time subcontractor is the second-lowest bidder,
whereas an unknown subcontractor is the low bidder.
Whom do you choose? Why?

5. A long-time subcontractor is the second-lowest bidder,
whereas an unknown subcontractor is the low bidder.
Your boss asks you to call the long-time subcontractor
and ask him or her to meet the price of the low bidder.
What do you do? How would having a company policy
that established the procedure for selecting subcontrac-
tors affect your decision?

6. You are responsible for the budget on a cost-plus con-
struction project. A supplier or subcontractor offers to
overbill the client and split the difference with your
company. What do you do?

7. You work for a subcontractor and are responsible for
preparing the subcontractor’s bids. A general contractor
has a small project and asks you how much you would
charge to do the work on the side. What do you do?

REFERENCE
1. For more information on the American Society of Professional

Estimators, visit www.ASPEnational.org.

www.ASPEnational.org


Chapter 32 Converting Existing Forms

Chapter 33 Creating New Forms

Chapter 34 Proposals and Beyond

I
n this section, you will learn how to take advantage of the full features of
Excel, including how to convert existing forms to Excel, create new forms
in Excel, prepare proposals using Excel, and incorporate error checking

in your spreadsheets.

P A R T F I V E

ADVANCED ESTIMATING
WITH EXCEL



298

In this chapter you will learn the procedures for converting ex-
isting paper forms to spreadsheets, how to automate a series of
commands or steps using macros, and three methods of adding
error protections to a worksheet. The chapter will take you step
by step through the process of converting two paper forms (the
Detail worksheet from Figure 3-24 and the Summary work-
sheet from Figure 2-2) into computer spreadsheets and the cre-
ation of a macro.

The easiest way to create a computerized estimating
form is to create it from an existing paper form. This
is because the user already has established a layout

for the form and understands how to perform the calcula-
tions. There are five steps needed to convert existing forms.
First, create the form’s layout in Excel. Second, add the for-
mulas into Excel. Third, automate the worksheets with
macros. Fourth, test the spreadsheets to ensure that they are
free of errors. Fifth, add protection against errors. The
process is shown in Figure 32-1.

CREATING THE LAYOUT
The first step is to create the form’s layout in Excel. For
both the Detail and the Summary worksheets, this was
done in Chapter 3, and they were saved as Chapter 03.xlsx
in the Excel Exercise folder. If you have not completed
Exercises 3-1 through 3-5, 3-8, and 3-9 from Chapter 3, you
should do so now.

ADDING FORMULAS
The second step is to add formulas into the Excel worksheet.
If you have completed Exercise 3-7 and the sidebars found in
some of the preceding chapters, you have already had an op-
portunity to create some formulas. In the next exercise, you
will add formulas to the Summary worksheet created in
Chapter 3. The formulas for the Detail worksheet are added
using macros. Macros are discussed in the next section.

Exercise 32-1

In this exercise you will add formulas to the Summary work-
sheet created in Chapter 3. Many of the formulas discussed in
the individual steps of this exercise are shown in Figure 32-2.

The formulas are set up using the following steps:

1. Open Chapter 03, the workbook you created in Chapter 3.

2. Save the workbook as Chapter 32.xlsx by selecting the
File tab (the Microsoft Office button for Excel 2007),
clicking on Save As in the left pane to bring up the Save
As dialogue box, selecting the Excel Exercises folder in
the left pane (Save in: dropdown box for Excel 2007),
typing Chapter 32 in the File Name text box, and click-
ing on the Save button.

3. Make sure the spreadsheet is open to the Summary
worksheet. If not, click on the Summary tab to open the
Summary worksheet.

CONVERTING EXISTING FORMS
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FIGURE 32-1 Process for Converting Forms to Excel
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Next, total the rows using the following steps:

4. Type =Sum(D3:G3) in Cell H3, and press the Enter key
to sum Row 3. A dash will appear indicating that the
sum is zero.

5. Copy Cell H3 to Cells H4 through H7, H10, H13
through H20, H23, H26 through H29, H32 through
H38, H41 through H51, H54 through H60, H62
through H68, H71 through H74, H77, H80, H83, H86,
H89, H92, H95, H98, H101, H102, H105 through H114,
H117 through H122, H124, H125, and H128 to sum the
total for each of these rows.

6. When you copied Cell H3 to Cells H122, H125, and
H128, the borders under these cells was erased.
Underline Cells H122, H125, and H128 by highlighting
the cells and clicking the Bottom Border button (shown
in Figure 3-46) in the Font group on the Home menu
tab. If another border is shown in the Borders button,
select the correct border by clicking on the small arrow
to the right of the Borders button and selecting the
Bottom Border from the Borders popup menu.

Next, enter the formulas used to calculate the subtotals
found in Row 123 using the following steps:

7. Type =Sum(D2:D122) in Cell D123, and press the Enter
key to sum the materials column.

8. Copy Cell D123 to Cells E123 through H123 to sum the
labor, equipment, subcontract, and total columns.

Next, enter the formulas used to calculate the subtotals
found in Row 126 using the following steps:

9. Type =Sum(D123:D125) in Cell D126, and press the
Enter key to calculate the subtotal.

10. Copy Cell D126 to Cells E126 through H126 to calculate
the subtotal for the labor, equipment, subcontract, and
total columns.

Next, enter the formulas used to calculate the profit and over-
head markup found in Row 128 using the following steps:

11. Type =D126*D127 in Cell D128, and press the Enter key
to calculate the profit and overhead for the materials
column.

12. Copy Cell D128 to Cells E128 through G128 to calculate
the profit and overhead for the labor, equipment, and
subcontract columns. Do not copy Cell D128 to Cell
H128.

Next, you will enter the formulas used to calculate the total
found in Row 129 using the following steps:

13. Type =D126+D128 in Cell D129, and press the Enter
key to calculate the total for the materials column.

14. Copy Cell D129 to Cells E129 through H129 to calculate
the total for the labor, equipment, subcontract, and total
columns.

15. As a check of the totals, type =Sum(D129:G129) in Cell
H130, and press the Enter key to calculate the total.
Cells H129 and H130 should contain the same value.

16. Save the workbook by clicking on the Save button on
the Quick Access toolbar or by typing Ctrl+S.

Chapter 25 looked at basing the building permit and
bond costs on the total estimate of the bid using iteration.
Because the building permit and bond costs are based on the
total estimate and the total estimate is based on the building
permit and bond costs, a circular reference is created. To
solve a circular reference, Excel must be allowed to perform
the calculations a number of times, each time getting closer
to the correct answer. This is known as iteration. To allow
Excel to use iteration to solve circular references, the user
clicks on the File tab (the Microsoft Office button for Excel
2007), clicks on Options (Excel Options for Excel 2007) to
bring up the Excel Options dialogue box, selects Formulas

FIGURE 32-2 Formulas for Summary Worksheet

A B C D E F G H
1 Code Description Materials Labor Equipment Subcontract Total
2 01-000 GENERAL REQUIREMENTS
3 01-300 Supervision =SUM(D3:G3)
4 01-500 Temporary Utilities =SUM(D4:G4)
5 01-510 Temporary Phone =SUM(D5:G5)
6 01-520 Temporary Facilities =SUM(D6:G6)
7 01-700 Clean-Up =SUM(D7:G7)8
9 02-000 EXISTING CONDITIONS
10 02-400 Demolition =SUM(D10:G10)11

116 33-000 UTILITIES
117 33-100 Water Line =SUM(D117:G117)
118 33-300 Sanitary Sewer =SUM(D118:G118)
119 33-400 Storm Drain =SUM(D119:G119)
120 33-500 Gas Lines =SUM(D120:G120)
121 33-700 Power Lines =SUM(D121:G121)
122 33-800 Telephone Lines =SUM(D122:G122)
123 SUBTOTAL =SUM(D2:D122) =SUM(E2:E122) =SUM(F2:F122) =SUM(G2:G122) =SUM(H2:H122)
124 Building Permit =SUM(D124:G124)
125 Bond =SUM(D125:G125)
126 SUBTOTAL =SUM(D123:D125) =SUM(E123:E125) =SUM(F123:F125) =SUM(G123:G125) =SUM(H123:H125)
127 Profit and Overhead Markup
128 Profit and Overhead =D126*D127 =E126*E127 =F126*F127 =G126*G127 =SUM(D128:G128)
129 TOTAL =D126+D128 =E126+E128 =F126+F128 =G126+G128 =H126+H128
130 =SUM(D129:G129)
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in the left pane to display the Change options related to for-
mulas calculation, performance, and error handling in the
right pane (shown in Figure 32-3), and under the Calculation
options heading checks the Enable Iterative calculation
check box. The maximum number of iterations is set in the
Maximum iterations: text box and the maximum change in
the Maximum change: text box. For example, if the maxi-
mum iterations is set to five and the maximum change is set
to one, Excel will stop performing calculations after five itera-
tions or after the change in values resulting from the last iter-
ation was less than one, whichever comes first. For use on the
summary sheet, five iterations and a maximum change of one
is generally adequate for bids under $1,000,000. Setting the
number of iterations higher and the maximum change lower
will result in longer calculation times. In the next exercise you
will incorporate the bond cost into the Summary worksheet.

Exercise 32-2

In this exercise you will add the bond rates from Table 25-2 to
the Summary worksheet modified in Example 32-1. To simplify
the calculations, Table 25-2 is rewritten as shown in Table 32-1.

The table was generated using Table 25-2 and calculating
the bonding costs for the upper end of the previous range. For
example, a $500,000 bond costs $5,125 ($50,000 � 0.015 �
$50,000 � 0.0125 � $150,000 � 0.01 � $250,000 � 0.009);
therefore, the cost of a bond in the range of $500,001 to
$1,000,000 is 0.80% on any amount over $500,000 plus
$5,125 (the rate on the first $500,000).

This exercise is completed by the following steps:

1. Make sure that Chapter 32, the workbook created in
Exercise 32-1, is open.

2. Make sure that the spreadsheet is open to the Summary
worksheet.

Next, Excel needs to be set to allow it to perform iterations
using the following step:

3. Click on the File tab (the Microsoft Office button for
Excel 2007), click on Options (Excel Options for Excel
2007) to bring up the Excel Options dialogue box, select
Formulas in the left pane to display the Change options
related to formulas calculation, performance, and error
handling in the right pane, under the Calculation op-
tions heading check the Enable Iterative calculation

FIGURE 32-3 Change Options Related to Formulas Calculation, Performance, and Error Handling Tab

TABLE 32-1 Sample Bond Schedule

Total Estimate ($) Bond Rate

0 to 50,000 1.50

50,001 to 100,000 1.25% on amount over $50,000 plus $750

100,001 to 250,000 1.00% on amount over $100,000 plus $1,375

250,001 to 500,000 0.90% on amount over $250,000 plus $2,875

500,001 to 1,000,000 0.80% on amount over $500,000 plus $5,125

1,000,001 plus 0.75% on amount over $1,000,000 plus $9,125
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check box, type 5 in the Maximum iterations: text box,
type 1 in the Maximum change: text box, and click the
OK button to close the Options dialogue box. This set-
ting will need to be changed on any computer that runs
this worksheet or when you get a circular reference
warning.

The logic used to calculate the bond is shown in Figure 32-4.

Next, you will enter the bond formula as follows:

4. Type the following formula into Cell D125:

=IF(H129<50000,H129*0.015,

IF(H129<100000,(H129-50000)*0.0125+750,

IF(H129<250000,(H129-100000)*0.01+1375,

IF(H129<500000,(H129-250000)*0.009+2875,

IF(H129<1000000,(H129-500000)*0.008+5125,

(H129-1000000)*0.0075+9125)))))

5. Save the workbook by clicking on the Save button on
the Quick Access toolbar or by typing Ctrl+S.

AUTOMATING WITH MACROS
The third step is to automate the spreadsheets with macros.
As we saw in Chapter 26, the following mathematical rela-
tionships exist on the Detail worksheet:

Each time the user adds a row to the Detail worksheet,
he or she will need to add these formulas to Columns E, G, I,
K, and L. Not only would this be time consuming, but would
also require the user to test each formula. Alternatively, the
user could copy the formulas from one row to another row.
Although this is less time consuming, it is still slower than
using a macro and is prone to errors. Macros greatly reduce
the possibility of errors and increase efficiency.

When the user records a macro, he or she creates an ex-
ecutable code that can be infected by computer viruses.
Running a macro with a virus can spread the viruses and
their damage to other files on the user’s computer. To mini-
mize the risk of infection, the user should only run macros
he or she creates or macros from a trusted source.

Excel allows the user to set the security level for macros
so that Excel (1) disables all macros without notifying the
user, (2) disables all macros but notifies the user and gives
him or her the option to run the macro, (3) disables all
macros except those digitally signed, or (4) enables all
macros. When Excel is set to disable all macros with notifi-
cation given to the user, a Security Warning indicating that
the macro has been disabled appears below the menu rib-
bon. This warning is shown in Figure 32-5 (Figure 32-6 for
Excel 2007). To enable the macro in Excel 2010, the user
clicks on Enable Content. Once you have enabled a docu-
ment, Excel 2010 will remember it and you will not have to
enable it again.

To enable the macro in Excel 2007, the user clicks on the
Options... button next to the warning to bring up the
Microsoft Office Security Options dialogue box (shown in

Column!L � Column!E � Column!I � Column!K

Column!K � Column!G � Column!J

Column!I � Column!G � Column!H

Column!G � Column!B � Column!F

Column!E � Column!B � Column!D

FIGURE 32-4 Logic for the Bond Formula

FIGURE 32-5 Excel 2010 Security Warning
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Figure 32-7). From the Microsoft Office Security Options di-
alogue box, the user may select Help protect me from un-
known content (recommended) to keep the macro disabled
or select Enable this content to enable the macro. The user
must click on the OK button to close the Microsoft Office
Security Options dialogue box.

To set the level of security, the user clicks on the File tab
(the Microsoft Office button for Excel 2007), clicks on
Options (Excel Options for Excel 2007) to bring up the
Excel Options dialogue box, selects Trust Center in the left
pane to display the Help keep your documents safe and your
computer secure and healthy in the right pane, and under
the Microsoft Office Excel Trust Center clicks on the Trust
Center Settings . . . button to bring up the Trust Center dia-
logue box. From the Trust Center dialogue box, the user
clicks on Macro Settings in the left pane to view the macro

settings in the right pane, where he or she can select to (1)
Disable all macros without notification, (2) Disable all
macros with notification, (3) Disable all macros except digi-
tally signed macros, or (4) Enable all macros (not recom-
mended; potentially dangerous code can run). The Trust
Center dialogue box is shown in Figure 32-8. The user closes
the Trust Center dialogue box by clicking on the OK button.

Macros are written in a complex programming lan-
guage; however, macros can be recorded as you would record
your voice on a tape recorder, eliminating the need to learn a
programming language. When recording a macro, you
record the actions (key strokes, cursor movements, and so
forth) taken while recording the macro. These actions can be
repeated by playing back the macro.

The actions recorded by macros can be absolute or rela-
tive. Absolute macros are always executed in the same location

FIGURE 32-6 Excel 2007 Security Warning

FIGURE 32-7 Microsoft Office Security Options Dialogue Box
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on the spreadsheet, regardless of the location of the cursor
when the macro is executed. For example, if an absolute
macro was recorded starting in Cell A1, it will always move to
Cell A1 before executing the macro. Relative macros are exe-
cuted relative to the current position of the cursor. For exam-
ple, if a relative macro was recorded with a start point in Cell
A1 and then immediately moved the cursor to Cell A2, when-
ever the macro was executed it would start by moving the cur-
sor one cell below the active cell. If the active cell were G17, the
macro would move the active cell to G18. To select between
absolute and relative references, the user clicks on the View
menu tab, clicks on the arrow below the Macros button
(shown in Figure 32-9), and selects Use Relative References
from the popup menu (shown in Figure 32-10). When the Use

Relative References is shaded, macros will be recorded with
relative references. Relative references are turned off the same
way they are turned on.

To record a macro, the user clicks on the View menu tab,
clicks on the arrow below the Macros button (shown in Figure
32-9), and selects Record Macro... from the popup menu
(shown in Figure 32-10) to bring up the Record Macro dia-
logue box shown in Figure 32-11. The name of the macro is
typed into the Macro name: text box. Each macro must have a
unique name. Spaces may not be used in the name. A shortcut
key can be assigned to a macro by typing a key into the
Shortcut key: Ctrl+ text box. The macro can be stored in one
of three places—this workbook (the workbook you are work-
ing on), a new workbook, or a personal macro workbook—by
selecting the place to store the macro in the Store macro in:
dropdown box. Macros that are used for a single workbook
should be stored in the workbook, whereas macros that are
used in multiple workbooks, such as inserting your name and
title, should be stored in a personal workbook. A description
of the macro is entered in the Description text box.

After completing the information on the record dia-
logue box, the user begins recording the macro by clicking

FIGURE 32-8 Trust Center Dialogue Box

FIGURE 32-9 View: Macros Button

FIGURE 32-10 Use Relative References Button
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the OK button. The user then enters the keystrokes, cursor
movements, and so forth that are to be recorded. The user
stops the recording of the macro by clicking on the View
menu tab, clicking on the arrow below the Macros button
(shown in Figure 32-9), and selects Stop Recording from the
popup menu (shown in Figure 32-12).

Workbooks containing macros must be saved as an
Excel macro-enable workbook. This is done by selecting the
File tab (the Microsoft Office button for Excel 2007), click-
ing on Save As in the left pane to bring up the Save As dia-
logue box, and selecting Excel Macro-Enabled Workbook
(.xlsm) from the Save as Type dropdown box. The Save As
dialogue box is shown in Figure 32-13.

The following exercise shows how to record a macro.

Exercise 32-3

In this exercise you will record a macro to add the formulas
to a row on the Detail worksheet and assign it to the Ctrl+E
keys so that it can be executed from the keyboard. Because
this macro needs to work on all rows in the spreadsheet, the
macro will need to be a relative macro. The macro is to be
executed from Column D and will move the cursor down a
row every time it is executed, so it can be executed over and
over without the user having to move the cursor down a
row. In addition, the macro will set the default labor rate to

FIGURE 32-12 Stop Recording

FIGURE 32-13 Save As Dialogue Box

FIGURE 32-11 Record Macro Dialogue Box
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$18.00 per hour. The macro is created using the following
steps:

1. Make sure that Chapter 32, the workbook modified in
Exercise 32-2, is open.

2. Click on the Detail tab to move to the Detail worksheet
and place the cursor on Cell D4.

3. Make sure that the macro is set to use relative references
by clicking on the View menu tab, clicking on the arrow
below the Macros button (shown in Figure 32-9), and
making sure that Use Relative References is highlighted
as shown in Figure 32-10. If it is not highlighted, click
on Use Relative Reference to highlight it.

4. Click on the arrow below the Macros button (shown in
Figure 32-9) and select Record Macro... from the
popup menu (shown in Figure 32-10) to bring up the
Record Macro dialogue box.

5. Type Extension in the Macro name: text box and e in the
Shortcut key: Ctrl+ text box.

6. Type This macro adds the formulas for an individual line
on the Detail worksheet. in the Description: text box.
The Record Macro dialogue box should be similar to
Figure 32-11.

7. Click the OK button to start recording the macro.

You will now record the key strokes and cursor movements
that make up the macro.

8. Enter the formulas in Table 32-2 into the specified cells.
After entering the formula for a cell, press the Enter key
to complete the formula.

9. After completing the entries in Table 32-2, move the
cursor to Cell D5.

10. Click on the View menu tab, click on the arrow below
the Macros button (shown in Figure 32-9), and select
Stop Recording from the popup menu (shown in
Figure 32-12) to end the macro.

11. With the cursor on Cell D5, type Ctrl+E, and the for-
mulas typed on Row 4 should be repeated on Row 5,
except that they should reference Row 5 rather than
Row 4. For example, the formula in Cell E5 will read
=B5*D5 rather than =B4*D4. The cursor should have
moved to Cell D6. The formulas for this example are
shown in Figure 32-14. The formulas on Row 4 were en-
tered while creating the macro; whereas the formulas on
Row 5 were entered by executing the macro.

12. Save the workbook as a macro-enabled workbook by se-
lecting the File tab (the Microsoft Office button for
Excel 2007), clicking on Save As in the left pane to bring
up the Save As dialogue box, and selecting Excel Macro-
Enabled Workbook (.xlsm) from the Save as Type drop-
down box. Do not change the name or location of the
workbook. Click on OK to save the file.

Macros are deleted by clicking on the View menu tab
and (1) clicking on the Macros button (shown in Figure 32-9)
or (2) clicking on the arrow below the Macros button (shown
in Figure 32-9) and selecting View Macros from the popup
menu (shown in Figure 32-10) to bring up the Macro dia-
logue box shown in Figure 32-15. The user selects the macro
to be deleted and clicks on the Delete button. The user is
asked if he or she wants to delete the macro. The macro is
deleted by clicking on the Yes button.

TABLE 32-2 Data for Cells

E4 =B4*D4

G4 =B4*F4

H4 18

I4 =G4*H4

K4 =G4*J4

L4 =E4+I4+K4

FIGURE 32-14 Formulas for Exercise 32-3

A B C D E F G H I J K L
1
2 $/UNIT COST LHR/UNIT LHR $/LHR COST $/LHR COST
3
4 =B4*D4 =B4*F4 18.00 =G4*H4 =G4*J4 =E4+I4+K4
5 =B5*D5 =B5*F5 18.00 =G5*H5 =G5*J5 =E5+I5+K5

EQUIPMENT
TOTALITEM QUANTITY

MATERIALS LABOR

FIGURE 32-15 Macro Dialogue Box
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TESTING THE WORKSHEETS
After creating formulas and macros, the user needs to test
the formulas to verify that they are working correctly. To do
this, the user enters data with a known result into the for-
mula or macro to verify that it is producing the correct re-
sults. One at a time, each cell should be changed to verify
that the formula works under all circumstances. This is
shown in the following examples.

Exercise 32-4

In this exercise you will verify the formulas entered into the
Summary worksheet in Exercises 32-1 and 32-2. For this
worksheet, the formula created to sum the rows, the formula
created to sum the material, labor, equipment, subcontract,
and equipment columns, and the formulas created to total
the bid are verified. The verification process is done with the
following steps.

1. Make sure that macro-enabled version of Chapter 32
(Chapter 32.xlsm), the workbook modified in Exercise
32-3, is open. If the file extensions are not displayed, hold
your cursor over the file names and a popup box (similar
to Figure 32-16) will appear that identifies the file type.

2. If the Security Warning appears, click on the Enable
Content button. For Excel 2007, click on the Option...
button to open the Microsoft Office Security Options
dialogue box (shown in Figure 32-7), select the Enable
this content radio button, and click on the OK button
to enable the macros written in Exercise 32-3.

3. Click on the Summary tab.

4. Hide rows 9 through 115 by selecting (highlighting) the
rows, right clicking on the selected rows, and selecting
Hide from the popup menu shown in Figure 32-17.

First, verify the totals in Column H and Row 123 using the
following steps:

5. Type 10 in Cell D3. Cells H3, D123, and H123 should all
equal 10.

6. Type 20 in Cell E3. Cells H3 and H123 should equal
30, Cell D123 should equal 10, and Cell E123 should
equal 20.

7. Type 30 in Cell F3. Cells H3 and H123 should equal 60,
Cell D123 should equal 10, Cell E123 should equal 20,
and Cell F123 should equal 30.

8. Type 40 in Cell G3. Cells H3 and H123 should equal
100, Cell D123 should equal 10, Cell E123 should equal
20, Cell F123 should equal 30, and Cell G123 should
equal 40.

9. Type 100 in Cells D122 through G122. Cell H3 should
equal 100, Cell H122 should equal 400, Cell D123
should equal 110, Cell E123 should equal 120, Cell F123
should equal 130, Cell G123 should equal 140, and Cell
H123 should equal 500.

By completing these actions we have verified the original
formula that summed the rows and one of the copied for-
mulas. We have also verified the formulas that summed the
column by entering data in the top and bottom of the for-
mula. Next, verify the formulas that create the total bid.

10. Type 150 in Cell D124. This will enter the cost of the
building permit.

11. Type 40 in Cell D127, 30 in Cell E127, 20 in Cell F127,
and 10 in Cell G 127. This will enter the profit markup
for materials, labor, equipment, and subcontract.

12. Verify that the cells in the Summary worksheet have the
same values shown in Figure 32-18.

13. Exit the workbook without saving the changes.

FIGURE 32-16 Popup Box

FIGURE 32-17 Popup Menu FIGURE 32-18 Results for Example 32-4

A B C D E F G H
1 Code Description Materials Labor Equipment Subcontract Total
2 01-000 GENERAL REQUIREMENTS
3 01-300 Supervision 10 20 30 40 100
4 01-500 Temporary Utilities -
5 01-510 Temporary Phone -
6 01-520 Temporary Facilities -
7 01-700 Clean-Up -

116 33-000 UTILITIES
117 33-100 Water Line -
118 33-300 Sanitary Sewer -
119 33-400 Storm Drain -
120 33-500 Gas Lines -
121 33-700 Power Lines -
122 33-800 Telephone Lines 100 100 100 100 400
123 SUBTOTAL 110 120 130 140 500
124 Building Permit 150 150
125 Bond 13 13
126 SUBTOTAL 273 120 130 140 663
127 Profit and Overhead Markup 40.0% 30.0% 20.0% 10.0%
128 Profit and Overhead 109 36 26 14 185
129 TOTAL 382 156 156 154 848
130 848
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FIGURE 32-19 Results for Exercise 32-5

FIGURE 32-20 Home: Conditional Formatting Button

A B C D E F G H I J K L
1
2 $/UNIT COST LHR/UNIT LHR $/LHR COST $/LHR COST
3 33-100 Water Line
4 Bedding 23 cyd 19.78 455 0.30 6.90 18.07 125 50.80 351 930
5 10" water line 150 ft 12.46 1,869 0.26 39.00 18.07 705 50.80 1,981 4,555

EQUIPMENT
TOTALITEM QUANTITY

MATERIALS LABOR

Exercise 32-5

In this exercise you will verify the macro created for the
Detail worksheet in Exercise 32-2 using the following steps:

1. Open Chapter 32.xlsm, the workbook modified in
Exercise 32-3.

2. Click on the Detail tab to move to the Detail worksheet.

3. Enter the data shown in Table 32-3 into the specified
cells.

After you complete the entries in Table 32-3, the spreadsheet
should look like Figure 32-19.

4. Exit the workbook without saving the changes.

ADDING ERROR PROTECTION
This chapter looks at three ways of adding error protection.
They are conditional formatting, data validation, and pro-
tecting the worksheet. Let’s look at conditional formatting.

Conditional Formatting
Conditional formatting allows the user to set the font,
border, color, and pattern for a cell by comparing the value
or formula in a cell to a value, range of values, or other
cells. Conditional formatting is very useful for marking
cells that have unexpected values. For example, in the
Summary worksheet, Cell H123 should equal the sum of
Cells D123 through G123. If this is not the case, it would
be very helpful to change the background color of Cell
H123 to make it very apparent that the cells are not equal
to each other.

The user sets the conditional formatting for a cell by
placing the cursor in the cell or cells to be conditionally
formatted, clicks on the Home menu tab, clicks on the
Conditional Formatting button in the Styles group
(shown in Figure 32-20), places the cursor over the
Highlight Cell Rules from the popup menu (shown in
Figure 32-21), and selects the type of rules to be used in
the conditional formatting from the popup menu (shown

TABLE 32-3 Data for Cells

A3 33-100 Water Line

A4 Bedding

B4 23

C4 cyd

D4 19.78

F4 0.30

H4 18.07

J4 50.80

A5 10 water line–
B5 150

C5 ft

D5 12.46

F5 0.26

H5 18.07

J5 50.80

FIGURE 32-21 Conditional
Formatting Pop Menu
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FIGURE 32-22 Cell Rules Popup Menu

FIGURE 32-23 New Formatting Rule Dialogue Box

in Figure 32-22). The user may select from one of the pre-
set rules or create their own rule by clicking on More
Rules... to bring up the New Rule Formatting dialogue box
(shown in Figure 32-23). We will look at creating our own
rules.

From the New Rule Formatting dialogue box, the user
selects the type of rule in the Select a Rule Type: box. We will
limit our discussion to the Format only cells that contain
rule, which is the rule type that is automatically selected

when opening the New Rule Formatting dialogue box in the
manner described above. In the left dropdown box, the user
selects whether he or she wants to compare the cell’s value or
other property. For our example we are going to compare the
cells value. In the next dropdown box (the second box from
the left) the user selects the type of comparison to make by
selecting from the following: between, not between, equal
to, not equal to, greater than, less than, greater than or
equal to, and less than or equal to. Based on the selection in
the second box from the left, one or two boxes will appear to
the right of this box. In these boxes the user enters cells, for-
mulas, or values to be used in the comparison. Next, the user
clicks on the Format... button to bring up the Format Cells
dialogue box shown in Figure 32-24. The user then selects
the desired formatting to use in conjunction with the condi-
tional formatting and clicks on the OK button to close the
Format Cells dialogue box.

Multiple rules for one cell can be written using the
above procedures. To select the order the rules are applied,
edit a rule, or to delete a rule, the user clicks on the Home
menu tab, clicks on the Conditional Formatting button in
the Styles group (shown in Figure 32-20), and clicks on
Manage Rules... from the popup menu (shown in Figure
32-21) to bring up the Conditional Formatting Rules
Manager dialogue box (shown in Figure 32-25). Only the
rules that apply to the selected cell will be shown. From the
Conditional Formatting Rules Manager dialogue box the user
can add a new rule by clicking on the New Rule... button,
edit the selected rule by clicking on the Edit Rule... button,
or delete the selected rule by clicking on the Delete Rule
button. When there are two or more rules, the user can se-
lect the order which the rules are applied by highlight the
rule to move and clicking on the Move Up or Move Down
buttons.
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FIGURE 32-24 Fill Tab of the Format Cells Dialogue Box

FIGURE 32-25 Conditional Formatting Rules Manager Dialogue Box

Exercise 32-6

In this exercise you will set the conditional formatting for
Cell H123 so it turns red if the value in Cell H123 (the sum
of Cells H2 through H122) does not equal the sum of Cells
D123 through G123 using the following steps:

1. Make sure that Chapter 32.xlsm, the workbook modi-
fied in Exercise 32-3, is open. If the Security Warning

appears, click on the Enable Content button to enable
the macro. For Excel 2007, click on the Options... but-
ton next to the warning to bring up the Microsoft Office
Security Options dialogue box, select Enable this con-
tent, and click on the OK button.

2. Select the Summary worksheet.

3. Place the cursor in Cell H123, click on the Home menu
tab, click on the Conditional Formatting button in the



Styles group (shown in Figure 32-20), place the cursor
over the Highlight Cell Rules from the popup menu
(shown in Figure 32-21), and click on More Rules... to
bring up the New Rule Formatting dialogue box (shown
in Figure 32-23).

4. Select Cell Value from the first dropdown box and not
equal to from the second dropdown box and type
=D123+E123+F123+G123 in the text box.

5. Click on the Format... button to bring up the Format
Cells dialogue box (shown in Figure 32-24), click the
Fill tab, select the color red, and click the OK button.

6. The Conditional Formatting dialogue box should ap-
pear as shown in Figure 32-23, with a red background
for the Preview box.

7. Click the OK button to complete the formatting.

In the Summary worksheet there are rows that represent the
division headings. One example is Row 116, which is the di-
vision heading of the Utilities division. As such, costs should
not be entered on this row. If costs are entered on this row,
they will not be totaled in the Total column (Column H) be-
cause the row summing function was not copied to this row.
We will enter a number onto this row to verify the condi-
tional formatting.

8. Enter 22 in Cell D116. Cell H123 should now be red and
with a dash in the cell indicating that it is equal to zero.
Cell D123 should be equal to 22. The spreadsheet
should look like Figure 32-26.

9. Delete the contents of Cell D116 by selecting Cell D116
and pressing the Delete key.

10. Save the workbook.

Data Validation
Data validation allows the user to set limits on the data en-
tered into a cell. For example, using data validation, the
user may limit the values in a cell to a positive number.
The user may limit the cell contents to a whole number, a
decimal number, a list, dates, a time, or a text of a given
length. Numeric data may be limited to values between
two values, not between two values, equal to a value, not
equal to a value, greater than a value, less than a value,
greater than or equal to a value, or less than or equal to a
value. Values may be fixed, be a value located in a cell, or
calculated from a formula.

The user sets these limits by clicking on the Data menu
tab, clicking on the Data Validation button in the Data Tools
group (shown in Figure 32-27) to bring up the Data
Validation dialogue box, and selecting the Settings tab. The
Settings tab of the Data Validation dialogue box is shown in
Figure 32-28.

From the Data Validation dialogue box the user sets the
type of validation to be used in the Allow: dropdown box, se-
lects the type of comparisons to be made in the Data: drop-
down box, and the values, functions, or cells to compare it to
in the remaining boxes, which will change based on what is
selected in the Allow: dropdown box.

In addition to making the comparison, the user may
also create a custom prompt message on the Input Message
tab and create a custom error message on the Error Alert tab.
A custom prompt message, which will appear when the cell
is selected, is created by selecting the Input Message tab,
checking the Show input message when cell is selected
check box, typing the title of the message in the Title: text
box, and typing the message in the Input message: text box.
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FIGURE 32-26 Spreadsheet for Exercise 32-6

FIGURE 32-27 Data: Data Validation Button

A B C D E F G H
1 Code Description Materials Labor Equipment Subcontract Total

116 33-000 UTILITIES 22
117 33-100 Water Line -
118 33-300 Sanitary Sewer -
119 33-400 Storm Drain -
120 33-500 Gas Lines -
121 33-700 Power Lines -
122 33-800 Telephone Lines -
123 SUBTOTAL 22 - - - -
124 Building Permit -
125 Bond 0 0
126 SUBTOTAL 22 - - - 0
127 Profit and Overhead Markup
128 Profit and Overhead - - - - -
129 TOTAL 22 - - - 0
130 22



The Input Message tab of the Data Validation dialogue box is
shown in Figure 32-29.

A custom error message is created by selecting the Error
Alert tab, checking the Show error alert after invalid data is
entered check box, typing the title of the message in the Title:
text box, and typing the message in the Error message: text
box. The user may select between a stop, warning, and infor-
mation error message in the Style: dropdown box. The stop
error message does not let the user enter a value that does not
meet the validation criteria. The warning error message will
ask the user if he or she wants to continue even though the
data does not meet the validation criteria. Although the in-
formation error message will inform the user that he or she
has entered data that does not meet the validation criteria, it
still makes the change. The Error Alert tab of the Data
Validation dialogue box is shown in Figure 32-30.

Exercise 32-7

In this exercise you will limit the profit and overhead markups
on the Summary worksheet to between 0% and 50% using
data validation. This is done by the following steps:

1. Make sure that Chapter 32.xlsm, the workbook modified
in Exercise 32-6, is open. If necessary, enable the macros.

2. Place the cursor in Cell D127, click on the Data menu
tab, and then click on the Data Validation button in the
Data Tools group (shown in Figure 32-27) to bring up
the Data Validation dialogue box.

3. Select the Settings tab, select Decimal from the Allow:
dropdown box, select between from the Data: drop-
down box, and type 0 in the Minimum: box and 0.5 in
the Maximum: box. The Data Validation box should
now appear as in Figure 32-28.

4. Select the Input Message tab, check the Show input
message when cell is selected check box, type Profit and
Overhead Markup in the Title: text box, and type Must
be between 0% and 50%. in the Input message: text box.
The Data Validation box should now appear as Figure
32-29. When the cursor is placed in Cell D127, the mes-
sage in Figure 32-31 will appear next to the cell.

5. Select the Error Alert tab, check the Show error alert
after invalid data is entered check box, select Stop from
the Style: dropdown box, type Error in the Title: text box,
and type Profit and overhead markup must be between 0%
and 50%. in the Error message: text box. The Data
Validation box should now appear as in Figure 32-30.
When numbers greater than 50% (0.50) or less than zero

Converting Existing Forms 311

FIGURE 32-28 Settings Tab of the Data Validation Dialogue
Box

FIGURE 32-29 Input Message Tab of the Data Validation
Dialogue Box

FIGURE 32-30 Error Alert Tab of the Data Validation
Dialogue Box

FIGURE 32-31 Input Message Created in Exercise 32-7



14. Select Cells E127, F127, and G127, right click on the se-
lected cells and, select Paste Special... from the popup
menu to bring up the Paste Special dialogue box.

15. Select the Validation radio button to paste only the data
validation and click on the OK button to complete the
paste.

16. Place the cursor in Cells E127, F127, and G127 one at a
time and verify that the popup box shown Figure 32-31
appears next to each of the cells.

17. Save the workbook.

Protecting the Worksheet
The creator of a worksheet may protect specified cells of the
worksheet against changes. Protecting the cells prevents the
user of the worksheet from accidentally or intentionally
changing a formula or entering data into a cell where data
should not be entered. All estimating worksheets should be
protected.

Before the creator of a worksheet can protect a work-
sheet, he or she must identify which cells the user will be al-
lowed to change. This is done by selecting the cells that the
user will be allowed to change, right clicking on the selected
cells, selecting Format Cells... from the popup menu to
bring up the Format Cells dialogue box, selecting the
Protection tab, unchecking the Locked check box, and click-
ing on the OK button to close the dialogue box. The Format
Cells dialogue box is shown in Figure 32-33. By default, all
cells should have the Locked check box checked.
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are entered into Cell D127, the error message in Figure
32-32 will appear and require the user to enter an ap-
proved value or cancel the attempt to change the value.

6. Click the OK button to complete the data validation.

Next, you will verify that the data validation is working cor-
rectly using the following steps:

7. Place the cursor in Cell D127 and verify that the popup
box shown in Figure 32-31 appears next to the cell.

8. Type 55 in Cell D127 and verify that Figure 32-32 appears.

9. Click the Retry button, type �5 (minus five) in Cell
D127, and verify that Figure 32-32 again appears.

10. Click the Retry button, type 50 in Cell D127, and verify
that the data is accepted.

11. Type 0 into Cell D127 and verify that the data is accepted.

12. Delete the contents of Cell D127.

Finally, copy the data validation from Cell D127 to Cells
E127, F127, and G127 using the following steps:

13. Right click on Cell D127 and select Copy from the
popup menu.

FIGURE 32-33 Protection Tab of the Format Cells Dialogue Box

FIGURE 32-32 Error Alert Created in Exercise 32-7



Once the creator of the worksheet has unchecked the
Locked check box for all cells the user will be allowed to
change, the user may protect the worksheet. This is done by
clicking on the Review menu tab and clicking on the Protect
Sheet button in the Changes group (shown in Figure 32-34)
to bring up the Protect Sheet dialogue box shown in Fig-
ure 32-35. The user then makes sure that the Protect work-
sheet and contents of locked cells check box is checked,
enters a password in the Password to unprotect sheet: text
box, unchecks the Select locked cells check box (so the user
can only select cell that can be changed), makes sure the Select
unlocked cells check box is checked, makes sure all other
check boxes are unchecked, and clicks on the OK button to
bring up the Confirm Password dialogue box shown in Fig-
ure 32-36. The user retypes the password in the Reenter pass-
word to proceed. text box and clicks on the OK button to close
the dialogue box and protect the worksheet. The user may
now only select and change the cells that are not locked. A
worksheet may be protected without a password by leaving
the Password to unprotect sheet: text box blank, but it is not
recommended because anyone can unprotect the worksheet
and make changes.

To unprotect a worksheet, the creator clicks on the
Review menu tab and clicks on the Unprotect Sheet button
in the Changes group shown in Figure 32-37, which has re-
placed the Protect Worksheet button, to bring up the
Unprotect Sheet dialogue box shown in Figure 32-38. The
user types the password used to protect the worksheet in
the Password: text box and clicks on the OK button to close
the dialogue box and unprotect the worksheet. The work-
sheet cannot be unprotected without the password, so it is a
good idea to keep a record of the passwords used to protect
worksheets in a safe place.

Converting Existing Forms 313

FIGURE 32-34 Review: Protect Worksheet Button

FIGURE 32-35 Protect Worksheet Dialogue Box

FIGURE 32-36 Confirm Password Dialogue Box

FIGURE 32-37 Review: Unprotect Worksheet Button FIGURE 32-38 Unprotect Sheet Dialogue Box



CONCLUSION
The steps for setting up an existing form are to create the
form layout, enter the formulas, automate with macros, test
the spreadsheets, and protect against errors. Macros are used
to automate key strokes and cursor movements by recording
the keystrokes and cursor movements as you would record
your voice on a tape recorder. These actions will then be re-
peated each time the macro is used. Error protection may be
added to the worksheet by (1) using conditional formatting
to change the format for a cell when the specified conditions
are met, (2) using data validation to only allow specific types
of data to be entered into a cell, and (3) protecting the work-
sheet so only specified cells can be selected and modified.

PROBLEMS
1. What are the steps for converting an existing form?

2. What is a circular reference?

3. How can Excel solve circular references?

4. What is a macro?

5. What risk do you take if you use macros created by
someone else?

6. How do you change the security level for macros?

7. What must you do to run a macro from the keyboard?

8. What is the purpose of conditional formatting?

9. How can conditional formatting be used to protect
against errors?

10. What is the purpose of data validation?

11. How can data validation be used to protect against errors?

12. What is the purpose of protecting a worksheet?

13. How can worksheet protection be used to protect against
errors?

14. For a worksheet that has been protected by a password,
is there any way you can unprotect the worksheet with-
out a password?

G102, D105 through G114, D117 through G122, D124,
and D127 through G127.

5. Protect the worksheet by clicking on the Review menu
tab and clicking on the Protect Sheet button in the
Changes group (shown in Figure 32-34) to bring up the
Protect Sheet dialogue box (shown in Figure 32-35).

6. Make sure the Protect worksheet and contents of
locked cells check box is checked.

7. Type 1234 in the Password to unprotect sheet: text box.

8. Uncheck the Select locked cells check box.

9. Make sure the Select unlocked cells check box is
checked.

10. Make sure that all other checks boxes are unchecked.

11. Click on the OK button to bring up the Confirm
Password dialogue box (shown in Figure 32-36).

12. Type 1234 in the Reenter password to proceed. text box,
and click on the OK button to close the dialogue box
and protect the worksheet.

13. Verify that you can only select and change the unlocked
cells by placing the cursor in Cell A3 and pressing the
Right Arrow key. The cursor should move to the right
and when it reaches Column G it should return to
Column A. When it reaches Cell G127 it should return
to Cell A3.

14. Save the workbook.
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Exercise 32-8

In this exercise you will protect the Summary worksheet
using the following steps:

1. Make sure Chapter 32.xlsm, the workbook modified in
Exercise 32-7, is open. If necessary, enable the macros.

2. Select Cells A3 through A7, right click on the selected
cells, select Format Cells... from the popup menu to
bring up the Format Cells dialogue box (shown in
Figure 32-33), select the Protection tab, uncheck the
Locked check box, and click on the OK button to close
the dialogue box.

3. Repeat Step 2 for the following: A10, A13 through A20,
A23, A26 through A29, A32 through A38, A41 through
A51, A54 through A60, A62 through A68, A71 through
A74, A77, A80, A83, A86, A89, A92, A95, A98, A101,
A102, A105 through A114, A117 through A122, A124,
and A125. Hint: Multiple cells may be selected at one
time using the Shift and the Ctrl keys.

4. Repeat Step 2 for the following: Cells D3 through G7,
D10 through G10, D13 through G20, D23 through G23,
D26 through G29, D32 through G38, D41 through G51,
D54 through G60, D62 through G68, D71 through G74,
D77 through G77, D80 through G80, D83 through G83,
D86 through G86, D89 through G89, D92 through G92,
D95 through G95, D98 through G98, D101 through



In this chapter you will learn how to create new Excel forms.
This chapter will take you step by step through the creation of a
spreadsheet to calculate the materials, labor, and costs for an
asphalt shingle roof.

Creating spreadsheet estimating forms from scratch
is a more difficult task than creating spreadsheets
from existing paper forms because the user has to

decide what the form is going to accomplish and how it will
be laid out. New forms should be carefully planned before
starting to create them in Excel.

PLANNING NEW FORMS
When creating a spreadsheet form from scratch, it is best to
carefully think through its design before beginning to set it
up. There are five steps in planning a new spreadsheet: (1)
Determine the desired output or results from the spread-
sheet, (2) determine what input data will be entered into the
spreadsheet, (3) solve different sample problems, (4) identify
the steps and equations that were used to arrive at the solu-
tion, and (5) prepare a sketch of the layout for the spread-
sheet. Once the spreadsheet has been carefully planned, it
can be set up using the same process used to convert existing
forms. This process is shown in Figure 33-1. Let’s look at
each of the planning steps.

Identify Desired Results
The first step is to determine the desired output or result from
the spreadsheet. This is what the estimator wants the spread-
sheet to accomplish. This could be a materials list, a cost to
complete an item, a proposal, or a preliminary cost estimate.
The unit of measure associated with each of the results should
be identified. For example, concrete materials should be in
cubic yards, asphalt-impregnated felt in rolls, and so forth.

In this chapter we will prepare a spreadsheet for an as-
phalt shingle roof. The desired results of the spreadsheet are
the quantities of roofing materials needed for the roof in
standard ordering quantities (for example, whole bundles
of shingles), the number of labor hours needed to complete
the roof, and the cost to install the roof. The materials used
on a typical asphalt shingle roof and that need to be in-
cluded in the spreadsheet are bundles of shingles, bundles
of cap shingles, pounds of roofing nails, rolls of underlay-
ment (felt), the number of underlayment nails in hundreds,
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FIGURE 33-1 Process for Creating New Spreadsheets
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pieces of 10-foot-long drip edge, pieces of 10-foot-long
counter flashings, rolls of ridge vent, the number of turtle
vents, the number of HVAC flashings, and the number of
plumbing pipe flashings.

Identify Input Data
The second step is to determine the data the user of the
spreadsheet will input (enter) into the spreadsheet for it to
calculate the desired results. The units associated with each
entry should be identified and should be the same as the
units used in the takeoff or pricing. For example, most con-
crete footings are specified in a combination of feet and
inches or just inches. Footing dimensions are never specified
in yards, which is the unit of measure used in specifying the
quantity of concrete. The spreadsheet should be set up to
make the necessary conversions.

To bid an asphalt shingle roof, the following data
needs to be collected from the plans and specifications: the
slope of the roof (for example, 4:12 or 6:12), the type of
shingle (for example, 25-year architectural), the type of

underlayment (for example, 15-pound felt), the total
length of the ridge(s) in feet, the number of ridges, the total
length of the hip(s) and valley(s) in feet, the total length of
the perimeter of the roof that is horizontal in feet, the total
length of the perimeter of the roof that is sloped in feet, the
total length of counter flashing placed horizontally in feet,
the total length of counter flashing that is along a slope in
feet, the number of HVAC flashings, the number of plumb-
ing pipe flashings, and the type of attic ventilation (for ex-
ample, gable end, ridge, or turtle vent). To determine the
number of labor hours required to shingle the roof, the
labor productivities for the different types of shingles are
needed. To calculate total cost, the pricing for the materials
and labor rates are needed.

For the spreadsheet developed in this chapter, there are
four types of shingles: 20-year three tab, 25-year architec-
tural, 30-year architectural, and 40-year architectural. There
will also be two types of underlayment: 15-pound and
30-pound asphalt-impregnated felt. The pricing for the ma-
terials to be used in the spreadsheet is given in Table 33-1, and
the labor productivity rates are given in Table 33-2. The crew

TABLE 33-1 Material Pricing

Item Price Conversion

Shingles

20-year three tab $12.39/bundle bundle � 1/3 square

25-year architectural $15.98/bundle bundle � 1/3 square

30-year architectural $16.65/bundle bundle � 1/3 square

40-year architectural $17.35/bundle bundle � 1/3 square

Cap Shingles

20-year three tab $15.75/bundle bundle � 21 ft

25-year architectural $31.29/bundle bundle � 21 ft

30-year architectural $33.29/bundle bundle � 21 ft

40-year architectural $35.29/bundle bundle � 21 ft

Underlayment

15-pound felt $14.95/roll roll � 4 square

30-pound felt $13.95/roll roll � 2 square

Flashings and Vents

Drip edge $ 2.99/ea each � 10 ft

Counter $ 3.99/ea each � 10 ft

Ridge vent $42.00/ea roll � 20 ft

Turtle vents (61 sq in) $ 7.00/ea

HVAC pipe flashing $ 9.00/ea

Plumbing flashing $ 4.00/ea

Nails

Roofing nails $ 1.39/lb

Underlayment nails $ 1.00/C (hundreds)
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rate per labor hour is $35. The pricing and productivity data
are set up so they can be easily modified as material costs and
labor rates change. Also given in Table 33-1 are conversion
factors from standard order quantities (for example, rolls) to
common units of measure (for example, feet).

Solve Practice Problems
The third step is to manually solve sample problems that
cover all of the different types of problems the spreadsheet is
to solve. During this process the developer of the spreadsheet
will often discover additional input data that is needed to
complete the calculations; this data should be added to the
list prepared in the second step. For the roofing spreadsheet
being set up in this chapter, sample problems similar to
Examples 9-4 and 9-9 need to be solved. The reader should
review these examples before continuing.

Identify Steps and Equations
The fourth step is to identify the steps and equations taken
to solve the practice problems. Not all problems are solved in
the same manner. For example, if the project specifies that
turtle vents are needed, then the number of turtle vents
needs to be calculated, whereas if the project specifies gable-
end vents (which are not a part of the roofing package), then
nothing would be done. As a result, the steps should identify
any decisions made (such as selecting between two formu-
las) in the process of arriving at the solution.

For the roofing worksheet, the first step is to do a takeoff
for the quantities from the roof. The slope of the roof, type
of shingle, type of underlayment, and type of attic ventila-
tion are read off the plans and specifications. The total
length of the ridge(s), hip(s), valley(s), perimeter, and
counter flashing are measured off the plans using a plan
measurer, thus eliminating the need to add their lengths to-
gether. The drip edge and counter flashing on sloped edges
are measured separately from the drip edge and counter
flashing on horizontal edges so that the slope can be taken
into account. The number of ridges, HVAC flashings, and
plumbing pipe flashings are counted off the plans. The roof
is divided into rectangles and the length and width of each
rectangle is measured; the spreadsheet will need to calculate
the total area of the roof. All of these measurements are mea-
sured in the plan view.

The second step is to calculate the area of the roof in
the plan view. This is done by multiplying the length by
the width of each rectangle taken off the plans and then

adding their areas together. If the user were to use a takeoff
software package, the total area of the roof could be used
in lieu of dividing the roof into rectangles and calculating
the area.

The third step is to determine the quantities of materi-
als. Unless noted, the spreadsheet will need to round all
quantities up to the next whole number.

The quantity of shingles is found by summing the re-
sults of Eqs. (9-5), (9-7), and (9-8) using a standard expo-
sure of 5 inches. The quantity is converted to bundles, where
3 bundles equal 1 square (100 square feet).

The quantity of cap is found by summing the results of
Eqs. (9-9) and (9-10). The quantity is converted to bundles,
where 1 bundle equals 21 lineal feet of 1-foot-wide cap or
0.21 squares of cap.

Based on historical data, 1 pound of roofing nails is
needed for every 3 bundles of shingles, including cap shin-
gles, and is calculated from the ordered quantities of shingles.

The quantity of underlayment is found using Eq. (9-3)
and is converted to rolls. For 15-pound felt there are 4 squares
of felt per roll, and for 30-pound felt there are 2 squares of
felt per roll. The spreadsheet should decide which conver-
sion factor to use.

From historical data, 125 nails are needed for 1 square
of felt; therefore, 250 nails are needed for 1 roll of 30-pound-
felt and 500 nails are needed for 1 roll of 15-pound felt. The
number of nails is based on the order quantity of felt, and
the spreadsheet will need to determine if 250 or 500 nails per
roll will need to be ordered. Nails are ordered in units of
10 nails or 0.1 C, where C is the notation for 100.

The total drip edge equals the sum of the length of the
drip edge placed horizontally plus the sum of the length of
the drip edge placed on a sloped edge. The length of the
drip edge placed on a sloped edge is determined by Eq. (9-1).
The length of the drip edge is converted to 10-foot-long
pieces the length by dividing by 9.8 feet, thus allowing
0.2 foot per lap. The counter flashing is calculated in the
same manner.

If ridge vent is specified, the length of the ridge will
equal the quantity of ridge vent needed. If ridge vent is not
specified, then the length is zero. The quantity of ridge vent
needs to be converted to 20-foot rolls.

If turtle vents are specified, 1 square foot of venting is
required for every 150 square feet of attic, with half of this
required ventilation in the upper portion of the roof and the
other half located in the eaves; therefore, the turtle vents are
required to provide 1 square foot of venting for every 300
square feet of attic space. Each vent provides 61 square
inches (0.42 ft2) of venting; thus 2.38 (1>0.42) vents are re-
quired to for every 300 square feet. As a result one vent is re-
quired for every 126 square feet (300 ft2>2.38).

The quantities of HVAC and plumbing flashings are
taken off from the plans.

All quantities will be rounded up to the next whole or-
dering unit (for example, bundle of shingles).

The fourth step is to determine the material costs. The
cost for each type of material (for example, shingles) is

TABLE 33-2 Labor Productivity

20-year three tab 2.50 lhr/square

25-year architectural 2.80 lhr/square

30-year architectural 3.00 lhr/square

40-year architectural 3.20 lhr/square



determined by using Eq. (26-1) and the previously deter-
mined quantities and the material unit cost for the item. The
subtotal of the material cost is determined by summing
the costs for each type of material. One adds to this subtotal
the sales tax, which is calculated by using Eq. (19-3). The
sales tax rate is 6.5%.

The fifth step is to determine the labor cost. The num-
ber of labor hours is based on the sloped area of the roof,
which is calculated by using Eq. (9-7). The number of labor
hours is calculated using Eq. (20-7) and the productivity
associated with the type of shingle being installed. Two
hours of mobilization time are added to the number of
labor hours, which are rounded to the tenth of an hour.
The labor cost is calculated using Eq. (26-2) and a labor
rate of $35 per hour.

Finally, the total cost is calculated by summing the ma-
terial and labor costs, and the cost per square foot is calcu-
lated by dividing the total cost by the sloped area.

Sketch Spreadsheet Layout
The final step of planning is to sketch a preliminary layout
for the spreadsheet. This helps the developer of the spread-
sheet to plan how the final spreadsheet is to look.

The spreadsheet being developed in this chapter will
consist of three tabs. The first tab will contain the results in-
cluding the quantity of materials to be ordered, the number
of labor hours, and the costs. A preliminary layout for this
tab is shown in Figure 33-2.

The second tab will contain the takeoff information, the
plan view area of the roof, and the cost per square foot for the
roof. A preliminary layout for this tab is shown in Figure 33-3.

The third tab will contain the pricing information and
labor productivity rates. Two columns are used for the price
and labor productivity. The left column will contain the nu-
meric value and be used in the calculations. The right col-
umn will contain the units. A preliminary layout for this tab
is shown in Figure 33-4.
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FIGURE 33-2 First Tab of New Spreadsheet

FIGURE 33-3 Second Tab of New Spreadsheet

Roof Slope: Area Length Width
Shingle Type: 1

Underlayment: 2
Ridge(s): 3

No. of Ridges: 4
Hip(s)/Valley(s): 5
Horiz. Perimeter: 6

Sloped Perimeter: 7
Horiz. Counter: 8

Sloped Counter: 9
HVAC Flashings: 10

Plumbing Flashings:
Vent Type:

Plan View Area:
Unit Price:

Roof AreaRoof Information



SETTING UP THE
SPREADSHEET
Now that the spreadsheet is planned it is ready to be set up. The
setting up of a new form follows the process used to set up ex-
isting forms. The first step in setting up the spreadsheet is to
create the form layouts, which is done in the next two exercises.

Exercise 33-1

In this exercise you will create the layout for the third tab to
be used in the roof-estimating spreadsheet by completing
the following steps:

1. Begin by opening a new workbook.

2. Save the workbook by clicking the Save button on the
Quick Access toolbar or typing Ctrl+S, selecting the
Excel Exercises folder in the Save in: dropdown box,
typing Chapter 33 in the File Name text box, and click-
ing the Save button.

For this spreadsheet three worksheets are needed in the
workbook.

3. If there are more than three sheets, delete the extra
sheets by right clicking on the tabs of the extra sheets
and selecting Delete from the popup menu.

4. If there are one or two sheets, add the needed sheets by
clicking on the Insert Worksheet tab located to the
right of the sheet tabs.

5. Name the left worksheet “Bid” by right clicking the tab
of the worksheet, selecting Rename from the popup
menu, and, with the sheet name highlighted, typing Bid.

6. Rename the center worksheet “Takeoff ” and the right
worksheet “Pricing Data” using the same procedures
used to rename the left worksheet.

Next, you will format and add the pricing data to the Pricing
Data worksheet.

7. Make sure that the Pricing Data worksheet is selected.

8. Change the width of Column A to 20 by right clicking
on Column A, selecting Column Width... from the
popup menu to bring up the Column Width dialogue
box, entering 20 in the Column Width: text box, and
clicking the OK button.

9. Change the width of Columns B and C to 8.

10. Type the text shown in Table 33-3 into the specified cells.
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FIGURE 33-4 Third Tab of New Spreadsheet

Cell Data Cell Data

A1 Item A23 HVAC Pipe Flashing
A2 Shingles A24 Plumbing Flashing
A3 20-year Three Tab A26 Nails
A4 25-year Architectural A27 Roofing Nails
A5 30-year Architectural A28 Underlayment Nails
A6 40-year Architectural A30 Item
A8 Cap Shingles A31 20-year Three Tab
A9 20-year Three Tab A32 25-year Architectural
A10 25-year Architectural A33 30-year Architectural
A11 30-year Architectural A34 40-year Architectural
A12 40-year Architectural B1 Price
A14 Underlayment B3 12.39
A15 15# Felt B4 15.98
A16 30# Felt B5 16.65
A18 Flashings & Vents B6 17.35
A19 Drip Edge B9 15.75
A20 Counter B10 31.29
A21 Ridge B11 33.29
A22 Turtle B12 35.29

TABLE 33-3 Data for Cells in Pricing Data Worksheet

Cell Data Cell Data

B15 14.95 C9 $/bundle
B16 13.95 C10 $/bundle
B19 2.99 C11 $/bundle
B20 3.99 C12 $/bundle
B21 42.00 C15 $/roll
B22 7.00 C16 $/roll
B23 9.00 C19 $/ea
B24 4.00 C20 $/ea
B27 1.39 C21 $/ea
B28 1.00 C22 $/ea
B30 Labor Productivity C23 $/ea
B31 2.50 C24 $/ea
B32 2.80 C27 $/lb
B33 3.00 C28 $/C
B34 3.20 C31 lhr/squ
C3 $/bundle C32 lhr/squ
C4 $/bundle C33 lhr/squ
C5 $/bundle C34 lhr/squ
C6 $/bundle



FIGURE 33-5 Pricing Data Worksheet

A B C
1 Item
2 Shingles
3 20-year Three Tab 12.39 $/bundle
4 25-year Architectural 15.98 $/bundle
5 30-year Architectural 16.65 $/bundle
6 40-year Architectural 17.35 $/bundle
7
8 Cap Shingles
9 20-year Three Tab 15.75 $/bundle

10 25-year Architectural 31.29 $/bundle
11 30-year Architectural 33.29 $/bundle
12 40-year Architectural 35.29 $/bundle
13
14 Underlayment
15 15# Felt 14.95 $/roll
16 30# Felt 13.95 $/roll
17
18 Flashings & Vents
19 Drip Edge 2.99 $/ea
20 Counter 3.99 $/ea
21 Ridge Vent 42.00 $/ea
22 Turtle Vents (61 sq in) 7.00 $/ea
23 HVAC Pipe Flashing 9.00 $/ea
24 Plumbing Flashing 4.00 $/ea
25
26 Nails
27 Roofing Nails 1.39 $/lb
28 Underlayment Nails 1.00 $/C
29
30 Item
31 20-year Three Tab 2.50 lhr/squ
32 25-year Architectural 2.80 lhr/squ
33 30-year Architectural 3.00 lhr/squ
34 40-year Architectural 3.20 lhr/squ

Price

Labor Productivity
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FIGURE 33-6 Auto Fill Options Button

11. Underline Cells A1 through C1 by highlighting A1
through C1 and clicking the Bottom Border button
(shown in Figure 3-46) in the Font group on the Home
menu tab. If another border is shown in the Borders
button, select the correct border by clicking on the small
arrow to the right of the Borders button and selecting
the Bottom Border from the Borders popup menu.

12. Underline Cells A30 through C30 using the same proce-
dure used to underline Cells A1 through C1.

13. Bold the data in Cells A2, A8, A14, A18, and A26 by se-
lecting the cells, selecting the Home menu tab, and
clicking on the Bold button in the Font group (shown
in Figure 3-35).

14. Format the numbers in Column B to have two decimal
places by selecting Column B, selecting the Home menu
tab, and selecting the Comma Style button in the
Number group (shown in Figure 3-41).

15. Center the text in Column C by selecting Column C, se-
lecting the Home menu tab, selecting the Center button
in the Alignment group (shown in Figure 3-31).

16. Merge and center Cells B1 and C1 by highlighting Cells
B1 and C1, selecting the Home menu tab, and selecting
the Merge and Center button in the Alignment group
(shown in Figure 3-39). FIGURE 33-7 Auto Fill Options Popup Box

17. Merge and center Cells B30 and C30.

18. Save the workbook.

The workbook should look like Figure 33-5.

SERIES
Excel will automatically create a series or list of consecutive
numbers (for example, 1, 2, 3, 4, and 5), dates, days, week-
days, months, or other text (for example, #4, #5, #6, and #7).
A series is created by entering a start value in a cell and drag-
ging the little box in the lower right-hand corner of the cell
down or to the right the appropriate number of cells. If Excel
simply copies the cell, it can be changed to a series by click-
ing on the Auto Fill Options button shown in Figure 33-6
that appears at the lower right-hand corner of the filled cells
and selecting Fill Series from the popup box shown in
Figure 33-7.

The series may consecutively number the lists by 10s or
other increments by entering the first two numbers in the se-
ries, selecting both cells, and dragging the little box in the
lower right-hand corner of the cell down or to the right the
appropriate number of cells. In the following exercise a se-
ries is used in the creation of the second tab of the roofing
worksheet:

Exercise 32-2

In this exercise you will create the layout for the first and sec-
ond tabs to be used in the roof-estimating spreadsheet by
completing the following steps:

1. Make sure that Chapter 33, the workbook created in
Exercise 33-1, is open.

2. Select the Takeoff worksheet by clicking on the Takeoff
tab.
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3. Change the width of Column A to 4, of Column B to 18,
of Column C to 1, of Column D to 20, of Columns E
through G to 5, and of Columns H and I to 8.

4. Type the text shown in Table 33-4 into the specified
cells.

Next you will use the series command to create the numbers
1 through 10.

5. Select Cell G4.

6. Drag the little square at the lower right-hand corner of
Cell G4 down to Cell G8 by placing the cursors over the
square, clicking and holding the left mouse button while
dragging the cursor down to the bottom of Cell G8, and
releasing the left mouse button. Cells G4 through G8
should now contain the number 1.

7. Change these numbers to a series by clicking on the
Auto Fill Options button (shown in Figure 33-6) at the
lower right-hand corner of the cells and selecting Fill
Series from the popup box (shown in Figure 33-7).
Cells G4 through G8 should now contain the numbers 1
through 5.

8. Select Cells G7 and G8.

9. Drag the little square at the lower right-hand corner of
Cell G8 down to Cell G13. Cells G4 through G13 should
now contain the numbers 1 through 10.

10. Right justify the text in Column B by selecting Column
B, selecting the Home menu tab, selecting the Align
Text Right button in the Alignment group (shown in
Figure 3-31).

11. Format the numbers in Cells D3 through D15 and D17
to the comma style with no numbers after the decimal
place by selecting the cells, selecting the Home menu
tab, selecting the Comma Style button in the Number

group (shown in Figure 3-41), and clicking the
Decrease Decimal button in the Number group (shown
in Figure 3-44) twice.

12. Format the numbers in Cell D18 to the comma style
with two numbers after the decimal place by selecting
Cell D18, selecting the Home menu tab, and selecting
the Comma Style button in the Number group (shown
in Figure 3-41).

13. Center the text in Cells E3 through E18 by selecting the
cells, selecting the Home menu tab, selecting the Center
button in the Alignment group (shown in Figure 3-31).

14. Center the text in Cells G3 through G13, H3, and I3.

15. Merge and center Cells B2 through E2 by highlighting
Cells B2 through E2, selecting the Home menu tab, and
selecting the Merge and Center button in the
Alignment group (shown in Figure 3-39).

16. Merge and center Cells G2 through I2.

17. Underline Cells B2 through E2 by selecting the cells and
clicking the Bottom Border button (shown in Figure 3-46)
in the Font group on the Home menu tab. If another
border is shown in the Borders button, select the correct
border by clicking on the small arrow to the right of the
Borders button and selecting the Bottom Border from
the Borders popup menu.

18. Underline Cells G2 through I2.

19. Place a thick box border around Cells B2 through E15
by selecting the cells, clicking on the Home menu tab,
clicking on the small arrow to the right of the Borders
button, and selecting the Thick Box Border from the
popup menu.

20. Place a thick box border around Cells B17 through E18.

21. Place a thick box border around Cells G2 through I13.

22. Save the workbook.

The workbook should look like Figure 33-8.
Next, you will create the layout for the first tab.

23. Select the Bid worksheet by clicking on the Bid tab.

24. Change the width of Column A to 2, of Column B to 35,
of Columns C and D to 9, and of Columns E and F to 15.

25. Type the text shown in Table 33-5 into the specified cells.

26. Center the text in Cells D3 through D13, D16, E2, and F2.

27. Right justify the text in Cells E14 and E17.

28. Merge and center the text in Cells C2 and D2.

29. Format Cells C3 through C6 and C8 through C13 to
whole numbers by selecting the cells, selecting the
Home menu tab, selecting the Comma Style button in
the Number group, and clicking the Decrease Decimal
button in the Number group twice.

30. Format Cells C7 and C16 to a number with one number
after the decimal point by selecting the cells, selecting
the Home menu tab, selecting the Comma Style button
in the Number group, and clicking the Decrease
Decimal button in the Number group once.

TABLE 33-4 Data for Cells in Takeoff Worksheet

Cell Data Cell Date

B2 Roof Information E6 ft
B3 Roof Slope: E7 ea
B4 Shingle Type: E8 ft
B5 Underlayment: E9 ft
B6 Ridge(s): E10 ft
B7 No. of Ridges: E11 ft
B8 Hip(s)/Valley(s): E12 ft
B9 Horiz. Perimeter: E13 ea
B10 Sloped Perimeter: E14 ea
B11 Horiz. Counter: E17 sft
B12 Sloped Counter: E18 /sft
B13 HVAC Flashings: G2 Roof Area
B14 Plumbing Flashings: G3 Area
B15 Vent Type: G4 1
B17 Plan View Area: H3 Length
B18 Unit Price: I3 Width
E3 :12
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31. Format Cells E3 through F17 to a number with two
numbers after the decimal point by selecting the cells,
selecting the Home menu tab, selecting the Comma
Style button in the Number group.

32. Underline Cells B2 through F2, B13 through F13, and
B16 through F16.

33. Place a thick box border around Cells B2 through E17.

34. Save the workbook.

The workbook should look like Figure 33-9.

The next step in creating the roofing spreadsheet is to
create the formulas and functions needed for the spread-
sheet to operate. In addition to the functions previously in-
troduced, the roofing spreadsheet uses the naming, concate-
nate, and lookup functions. It will also use dropdown boxes
for entering data. We will begin by looking at the naming
function and the creation of dropdown boxes.

FIGURE 33-9 Bid Worksheet

FIGURE 33-8 Takeoff Worksheet

A B C D E F G H I
1
2
3 Roof Slope: :12 Area Length Width
4 Shingle Type: 1
5 Underlayment: 2
6 Ridge(s):  ft 3
7 No. of Ridges: ea 4
8 Hip(s)/Valley(s): ft 5
9 Horiz. Perimeter: ft 6

10 Sloped Perimeter: ft 7
11 Horiz. Counter: ft 8
12 Sloped Counter: ft 9
13 HVAC Flashings: ea 10
14 Plumbing Flashings: ea
15 Vent Type:
16
17 Plan View Area: sft
18 Unit Price: /sft

Roof Information Roof Area

A B C D E F
1
2 Materials Unit Price Total
3 25-year Architectural bundle
4 25-year Architectural Cap bundle
5 Roofing Nails lbs
6 15# Felt rolls
7 Underlayment Nails C
8 10' Drip Edge ea
9 10' Counter Flashing ea
10 20' Ridge Vent ea
11 Turtle Vents ea
12 HVAC Flashing ea
13 Plumbing Flashing ea
14 Subtotal
15 Tax (6.5%)
16 Roofing Crew lhr 35.00
17 Total

TABLE 33-5 Data for Cells in Takeoff Worksheet

Cell Data Cell Data

B2 Materials D6 rolls
B5 Roofing Nails D7 C
B7 Underlayment Nails D8 ea
B8 10 ′ Drip Edge D9 ea
B9 10 ′ Counter Flashing D10 ea
B10 20 ′ Ridge Vent D11 ea
B11 Turtle Vents D12 ea
B12 HVAC Flashing D13 ea
B13 Plumbing Flashing D16 lhr
B15 Tax (6.5%) E2 Unit Price
B16 Roofing Crew E14 Subtotal
C2 Quantity E16 35.00
D3 bundle E17 Total
D4 bundle F2 Total
D5 lbs
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A series or block of cells may also be named. When the
named cell or the entire block of named cells is selected,
the name appears in the Name Box located at the left of
the Formula bar, which usually contains the cell reference by
column and row. The Name Box is shown in Figure 33-15.
Alternatively, cells may be named by selecting the cells, click-
ing on the Name Box, and typing their name.

The name is inserted into a formula by (1) typing the
name in the formula, (2) clicking on the Formulas menu
tab, clicking on Use In Formula from the Defined Names
group (shown in Figure 33-16), and selecting the name from
the popup menu shown in Figure 33-17, or (3) clicking on the
Formulas menu tab, clicking on Use In Formula from the
Defined Names group, and selecting Paste Names... from
the popup menu shown in Figure 33-17, to bring up the

NAMING CELLS
In lieu of referencing a cell by its column and row number
(for example, C5), one can reference a cell or group of cells by
a name given to the cell or group of cells. Cells are given a
name by selecting the cell or group of cells to be named, click-
ing on the Formulas menu tab, and clicking on Define Name
in the Defined Names group (shown in Figure 33-10) to
bring up the New Name dialogue box shown in Figure 33-11.
The name for the cells is typed in the top text box. The name
can be assigned to the entire workbook or the individual
sheet in the Scope: dropdown box.

The location of the cells named is changed by changing
the reference in the Refers to: box. This is done by typing the
correct reference in the box or by clicking the button at the
right (shown in Figure 33-12) to go to the worksheet and
bring up the New Name – Refers to: dialogue box shown in
Figure 33-13. The user then selects the correct cells and
clicks on the button to the right of the cell reference (shown
in Figure 33-14) to return to the New Name dialogue box.
The New Name dialogue box is closed by right clicking on
the OK button.

Once a cell has been named, the cell may then be refer-
enced by its name rather than its column and row number.
For example, if Cell B12 were given the name “Area,” the
Excel formula

=B12

could be rewritten as follows:

=Area

FIGURE 33-10 Formulas: Define Name

FIGURE 33-11 New Name Dialogue Box

FIGURE 33-12 Click Here to Open New Name-Refers to:
Dialogue Box

FIGURE 33-13 New Name – Refers to: Dialogue Box

FIGURE 33-14 Click Here to Return to the New Name
Dialogue Box
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Paste Name dialogue box shown in Figure 33-18. From the
Paste Name dialogue box, the user selects the name to be
used and clicks the OK button to close the dialogue box.

The advantage of naming cells is that it makes the for-
mulas easier to follow because the cell can be named with a
name that is representative of the data contained in the cells
rather than a nondescriptive cell reference.

Names are edited and deleted by opening the Name
Manager dialogue box (shown in Figure 33-19), which is
opened by clicking on the Formulas menu tab and clicking

FIGURE 33-15 Name Box

FIGURE 33-16 Formulas: Use in Formula

FIGURE 33-17 Paste Name Popup Box

FIGURE 33-18 Paste Name Dialogue Box

on Name Manager button in the Defined Names group
(shown in Figure 33-20). From the Name Manager the user
may create another name by clicking on the New button, edit
a name by highlighting a name and clicking the Edit button,
or delete a name by highlighting a name and clicking the
Delete button. The Name Manager dialogue box is closed by
clicking on the Close button.
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ADDING DROPDOWN BOXES
Dropdown boxes are created using the same data validation
feature that was used to set limits on the data entered into a
cell, which was discussed in Chapter 32. To create a drop-
down box, the user selects the cell where the dropdown box
is to be located, clicks on the Data menu tab, clicks on the
Data Validation button in the Data Tools group (shown in
Figure 32-27) to bring up the Data Validation dialogue box
shown in Figure 33-21. From the Setting tab the user selects
List from the Allow: dropdown box. For the dropdown box
to appear, the user must make sure the In-cell dropdown
check box is checked.

The list of options or cells containing the list of options
for the dropdown box is entered into the Source: text box.
The list may be entered in a number of ways.

FIGURE 33-19 Name Manager Dialogue Box

FIGURE 33-20 Formulas: Name Manager Button

FIGURE 33-21 Settings Tab of the Data Validation Dialogue
Box
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First, the cells containing the list of options are selected
by clicking on the button to the right of the Source: text box
and selecting the cell as was done with the naming function.

Second, the cells containing the list of options are
named and the name of the cells is pasted into the Source:
text box by clicking on the Formulas menu tab, clicking on
Use In Formula from the Defined Names group (shown in
Figure 33-16), and selecting the name from the popup menu
(shown in Figure 33-17) or selecting Paste Names... from
the popup menu (shown in Figure 33-17) to bring up the
Paste Name dialogue box (shown in Figure 33-18), selecting
the name of the cells, and clicking on the OK button.
Alternatively, the name may be typed into the Source: text
box by typing the equals sign and the name of the cells.

Third, the list of acceptable options is typed directly
into the Source: box with a comma separating the items in
the list.

Input messages and error alerts may be added to the
dropdown box as was shown in Chapter 32. The Data
Validation dialogue box is closed by clicking on the OK but-
ton. When the user selects the cell where the dropdown box is
located, an arrow appears to the side of the cell, and the user
can select from the list of options by clicking on this arrow.

Exercise 32-3

In this exercise you will add three dropdown boxes to the
Takeoff worksheet, which will be used to select the shingle
type, felt type, and vent type.You will begin by naming the cells
containing the shingle and vent types by completing the fol-
lowing steps:

1. Make sure that Chapter 33, the workbook modified in
Exercise 33-2, is open.

2. Select the Pricing Data worksheet.

3. Select Cells A3 through A6, select the Name Box at the
left of the Formula bar (shown in Figure 33-15), type
Shingle, and press the Enter key.

4. Select Cells A15 and A16, click on the Formulas menu
tab, click on Define Name in the Defined Names group
(shown in Figure 33-10) to bring up the New Name dia-
logue box, and type Felt in the top text box. The New
Name dialogue box should look like Figure 33-11. Click
the OK button to close the dialogue box.

5. Select the Takeoff worksheet by clicking on the Takeoff
tab.

Next, you will restrict the values in Cell D4 to the values
listed in the cells you named Shingle and add custom input
and error messages to this cell.

6. Select Cell D4, click on the Data menu tab, click on the
Data Validation button in the Data Tools group (shown
in Figure 32-27) to bring up the Data Validation dia-
logue box (shown in Figure 33-21).

7. Select the Setting tab and select List from the Allow:
dropdown box.

8. Place the cursor in the Source: text box, click on the
Formulas menu tab, click on Use In Formula from
the Defined Names group (shown in Figure 33-16),
and select Shingle from the popup menu (shown in
Figure 33-17).

9. Make sure the In-cell dropdown check box is checked.

10. Select the Input Message tab and make sure the Show
input message when cell is selected check box is
checked.

11. Type Shingle Type in the Title: text box and Select shingle
type in the Input message: text box. The Input Message
tab should look like Figure 33-22.

12. Select the Error Alert tab and make sure that the Show
error alert after invalid data is entered check box is
checked.

13. Type Error in the Title: text box and Please select from
dropdown list in the Input message: text box. The Error
Alert tab should look like Figure 33-23.

14. Click the OK button to complete the data validation.

15. Verify that the dropdown arrow and prompt appear
when you select Cell D4 as shown in Figure 33-24.

FIGURE 33-22 Input Message Tab of the Data Validation
Dialogue Box

FIGURE 33-23 Error Alert Tab of the Data Validation
Dialogue Box
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20. From Cell D5, click on the Data menu tab, click on the
Data Validation button in the Data Tools group to
bring up the Data Validation dialogue box.

21. Select the Setting tab and type =Felt in the Source: text
box. Be sure to include the equals sign.

22. Select the Input Message tab.

FIGURE 33-24 Dropdown Arrow and Prompt

16. Verify that when you click on the dropdown arrow the
values in Cells A3 through A6 on the Pricing Data work-
sheet are available for selection as shown in Figure 33-25.

17. Verify that the error message shown in Figure 33-26 ap-
pears when you enter unacceptable data by entering
shake in the cell.

18. Click the Cancel button to close the error message.

Next, you will restrict the values in Cell D5 to the values
listed in the cells you named Felt and add custom input and
error messages to this cell. For this example the error mes-
sage is copied from Cell D4 to Cell D5, and it does not have
to be reentered.

19. Copy Cell D4 to Cell D5. When a cell is copied, the data
validation properties are also copied.

FIGURE 33-25 Dropdown List

FIGURE 33-26 Error Message
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23. Replace the text in the Title: text box with Felt Type and
replace the text in the Input message: text box with
Select felt type.

24. Click the OK button to complete the data validation.

25. Verify that the dropdown arrow, prompt, and error
message are working, and that 15# Felt and 30# Felt are
available for selection from the dropdown list.

Next, you will restrict the values in Cell D15 to gable end, ridge,
or turtle and add custom input and error messages to this cell.

26. Right click on Cell D4 and select Copy from the popup
menu.

27. Right click on Cell D15, select Paste Special... from the
popup menu to bring up the Paste Special dialogue box
(shown in Figure 33-27), click on the Validation radio
button, and click on the OK button to copy the data val-
idation properties from Cell D4 to Cell D15. If the paste
command were used, the border at the bottom of the
cell would be deleted and would need to be replaced.

28. From Cell D15, click on the Data menu tab, click on the
Data Validation button in the Data Tools group to
bring up the Data Validation dialogue box.

29. Select the Setting tab and type Gable End,Ridge,Turtle in
the Source: text box. Do not include a space between the
commas and the words, before Gable, or after Turtle.
The only space should be between the words Gable and
End. Do not include an equals sign.

30. Select the Input Message tab.

31. Replace the text in the Title: text box with Vent Type and
replace the text in the Input message: text box with
Select vent type.

32. Click the OK button to complete the data validation.

33. Verify that the dropdown arrow, prompt, and error
message are working and that Gable End, Ridge, and
Turtle are available for selection from the dropdown list.

34. Save the file.

REFERENCING WORKSHEETS
IN A FORMULA
When one writes a formula on one worksheet, cells on an-
other worksheet may be used in the formula by clicking on
the worksheet where the cell is found and clicking on the
cell or by typing the name of the sheet followed by an ex-
clamation point (!) followed by the cell reference. For ex-
ample, Cell F17 on the Bid worksheet would be referenced
as follows:

Bid!F17

When the worksheet name contains a space, the name of the
worksheet must be enclosed in single quotes. For example,
Cell B20 on the Pricing Data worksheet would be referenced
as follows:

'Pricing Data'!B20

Exercise 32-4

In this exercise you will create the formulas for the Takeoff
worksheet using the following steps:

1. Make sure that Chapter 33, the workbook modified in
Exercise 33-3, is open.

2. Select Cell D17 on the Takeoff worksheet.

The area of the roof in plan view is calculated by multiply-
ing the individual lengths and widths and adding the resul-
tants together. The area may be written by the following
formula:

This formula is written in Excel as follows:

=H4*I4+H5*I5+H6*I6+H7*I7+H8*I8+H9*I9+H10*
I10+H11*I11+H12*I12+H13*I13

3. Type this formula into Cell C17, or select Cell C17 and
type the equals sign (�), select Cell H4, type the aster-
isks (*), select Cell I4, type the plus sign (�), select Cell
H5, and so forth until the formula is complete.

The unit price (found in Cell D18) is the total cost (found in
Cell F17 on the Bid worksheet) divided by the sloped area of
the roof. The sloped area of the roof is calculated from the
area in plan view (found in Cell C17) by Eq. (9-7). The Excel
formula for this is as follows:

=Bid!F17/(D17*(1+(D3/12)^2)^0.5)

4. Enter this formula into Cell D18 on the takeoff work-
sheet. When Cell D17 is zero, “#DIV/0!” will be dis-
played in Cell D18

5. Save the workbook.

� (Length10)(Width10)

Area � (Length1)(Width1) � (Length2)(Width2) � p

FIGURE 33-27 Paste Special Dialogue Box
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CONCATENATE
The CONCATENATE function allows the user to link text,
the results of formulas, and the contents of cells together
into a single string of text. The contents of the cell may be
text or the result of a formula. The CONCATENATE func-
tion is written as follows:

=CONCATENATE(text1,text2,...)

where text1, text2, and so forth are the references of the cells
and text to be linked. The linking occurs without the addi-
tion of any spaces, so the user must add spaces as necessary.
The spaces and text to be added must be enclosed in double
quotes. For example, if B1 were 17, the formula

=CONCATENATE("Cell B1 equals ",B1,".")

would result in the following text:

Cell B1 equals 17.

The space after the equals in the formula provides the space
between the equals and the 17. Alternatively, this CON-
CATENATE function can be setup using the Function
Arguments dialogue box shown in Figure 33-28. The
Function Argument dialogue box for the CONCATENATE
function is opened by clicking on the Formulas menu tab,
clicking on the Text button in the Function Library (shown
in Figure 33-29), and clicking on CONCATENATE in the
popup menu (shown in Figure 33-30).

FIGURE 33-28 CONCATENATE Function Arguments Dialogue Box

FIGURE 33-29 Functions: Text Button

FIGURE 33-30 Text Popup Menu
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FIGURE 33-31 New Formatting Rule Dialogue Box

Alternatively, text, the results of formulas, and the con-
tents of cell can be linked together by the And sign (&).

="Cell B1 equals "&B1&"."

produces the same result as

=CONCATENATE("Cell B1 equals ",B1,".").

Exercise 32-5

In this exercise you will add material names for Cells B3, B4,
and B6 and add the formulas that will calculate the quanti-
ties of materials. The type of materials ordered for the shin-
gles, cap shingles, and underlayment depend on the type of
material specified and will need to change on the Bid work-
sheet to match the items selected on the Takeoff worksheet.
This is done using the following steps:

1. Make sure that Chapter 33, the workbook modified in
Exercise 33-4, is open.

2. Click on the Bid tab and click on Cell B3.

Cell B3 on the Bid worksheet should be the same as Cell D4
on the Takeoff worksheet, unless the Cell D4 is blank, in
which case Cell B3 should be “Select Shingle Type.” This is
done with an IF function, which checks to see if Cell D4 on
the Takeoff worksheet is blank. If it is blank, the cell should
contain Select Shingle Type; otherwise, the cell’s contents
should be the same as Cell D4 on the Takeoff worksheet. A
blank dropdown box carries a numeric value of zero. The
formula is written as follows:

=IF(Takeoff!D4=0,"Select Shingle Type",
Takeoff!D4)

3. Enter this formula into Cell B3 on the Bid worksheet.

Next we will use conditional formatting to change the font of
Cell B3 to red when the shingle type has not been selected.

4. Place the cursor in Cell B3, click on the Home menu
tab, click on the Conditional Formatting button in the
Styles group (shown in Figure 32-20), place the cursor
over the Highlight Cell Rules from the popup menu
(shown in Figure 32-21), and click on More Rules... to
bring up the New Rule Formatting dialogue box (shown
in Figure 33-31).

5. Select Cell Value from the first dropdown box and not
equal to from the second dropdown box and type
=Takeoff!D4 in the text box.

6. Click on the Format... button to bring up the Format
Cells dialogue box (shown in Figure 33-32), click the
Font tab, select the color red in the color dropdown box,
and click the OK button.

7. The New Formatting Rule dialogue box should appear
as shown in Figure 33-31, with red text in the Preview
box.

8. Click on the OK button to close the New Formatting
Rule dialogue box. “Select Shingle” should now be in
red.

Cell B4 should combine the shingle type shown in Cell D4 of
the Takeoff worksheet with the word “cap.” This is done by
using the CONCATENATE function. The Excel function is
written as follows:

=CONCATENATE(Takeoff!D4," Cap")

9. Enter this function into Cell B4. Be sure to include a
space before the word Cap.

Cell B6 on the Bid worksheet should be the same as Cell D5
on the Takeoff worksheet, unless Cell D5 is blank, in which
case Cell B6 should be “Select Underlayment Type.” This is
done in the same manner as was done for Cell B3. The Excel
formula is written as follows:

=IF(Takeoff!D5=0,"Select Underlayment
Type",Takeoff!D5)



10. Enter this formula into Cell B6 on the Bid worksheet.

11. Add the same conditional formatting to Cell B6 as was
added to Cell B3 except type =Takeoff!D5 in the text box
of New Formatting Rule dialogue box.

12. Save the workbook.

The quantity of shingles is determined by the sum of Eqs. (9-5),
(9-7), and (9-8). Equation (9-5) for an exposure of 5 inches
is written in Excel as follows:

=(5/12)*Takeoff!D9/100

Equation (9-7) is written in Excel as follows:

=Takeoff!D17*(1+(Takeoff!D3/12)^2)^0.5/100

Equation (9-8) for an exposure of 5 inches is written in Excel
as follows:

=Takeoff!D8*((1+(Takeoff!D3/12)^2)/2)
^0.5*(5/12)/100

These equations will determine the number of squares of
materials. The number of squares needs to be converted to
bundles before the quantity is rounded up to the next whole
number. This is done by multiplying the sum by 3 because
there are 3 bundles in a square. The sum of these equations,
including the rounding up to the next whole number, is
written in Excel as follows:

=ROUNDUP(3*((5/12)*Takeoff!D9/100
+Takeoff!D17*(1+(Takeoff!D3/12)^2)^0.5/
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100+Takeoff!D8*((1+(Takeoff!D3/12)^2)/
2)^0.5*(5/12)/100),0)

13. Enter this formula into Cell C3 on the Bid worksheet.

The quantity of cap shingles is determined by the sum of
Eqs. (9-9) and (9-10). Equation (9-9) is written in Excel as
follows:

=Takeoff!D6/100

Equation (9-10) is written in Excel as follows:

=Takeoff!D8*(1+(Takeoff!D3/17)^2)^0.5/100

These equations will determine the number of squares of
materials. The number of squares needs to be converted to
bundles before the quantity is rounded up to the next whole
number. This is done by multiplying the sum by 100 and di-
viding by 21, because there are 21 square feet in a bundle.
The sum of these equations, including the rounding, is writ-
ten in Excel as follows:

=ROUNDUP((100/21)*(Takeoff!D6/100+Takeoff!
D8*(1+(Takeoff!D3/17)^2)^0.5/100),0)

14. Enter this formula into Cell C4 on the Bid worksheet.

The number of roofing nails equals the number of bundles
of shingles divided by 3 because 1 pound of nails is needed
for every 3 bundles of shingles. The Excel formula for the
number of nails is written as follows:

=ROUNDUP((C3+C4)/3,0)

FIGURE 33-32 Font Tab of the Format Cells Dialogue Box



15. Enter this formula into Cell C5 on the Bid worksheet.

The quantity of underlayment is calculated using Eq. (9-3).
For a standard 3-foot width and a 6-inch lap, Eq. (9-3) is
written in Excel as follows:

=(Takeoff!D17*(1+(Takeoff!D3/12)^2)^0.5*
(3/2.5)+Takeoff!D8*((1+(Takeoff!D3/
12)^2)/2)^0.5*(3+1)*(3/2.5)+(Takeoff!D6
+Takeoff!D7)*3)

For 30-pound felt, the quantity is divided by 200; for 15-pound
felt, the quantity is divided by 400. This decision is made using
an IF function written as follows:

=IF(Takeoff!D5="30# Felt",200,400)

The IF function does not need to check to see if the cell
contains 15-pound felt because the dropdown box for felt
is only allowed to contain 30-pound felt or 15-pound felt,
if it is not 30-pound felt, it must be 15-pound felt.
Combining these two functions, we get the following Excel
formula:

=ROUNDUP((Takeoff!D17*(1+(Takeoff!D3/
12)^2)^0.5*(3/2.5)+Takeoff!D8*((1
+(Takeoff!D3/12)^2)/2)^0.5*(3+1)*(3/2.5)
+(Takeoff!D6+Takeoff!D7)*3)/IF(Takeoff!
D5="30# Felt",200,400),0)

16. Enter this formula into Cell C6 on the Bid worksheet.

From historical data, 125 nails are needed for 1 square of felt.
The quantity of underlayment nails needed equals the num-
ber of squares of felt multiplied by 125, where there are
2 squares on a roll of 30-pound felt and 4 squares on a roll of
15-pound felt. The quantity is based on the number of rolls
of felt ordered and is divided by 100 to express the quantity
in 100s (C). The quantity is rounded to tens or 0.1 C. The
Excel function is written as follows:

=ROUNDUP(C6*IF(Takeoff!D5="30#
Felt",2,4)*125/100,1)

17. Enter this function into Cell C7 on the Bid worksheet.

The quantity of drip edge equals the length of the horizontal
perimeter plus the sloped perimeter of the roof, where the
sloped perimeter is converted from a plan view to a length
along the slope using Eq. (9-1). The length of the drip edge is
converted to 10-foot-long pieces by dividing by 9.8 feet, thus
allowing 0.2 feet for lap. The Excel function for the drip edge
is written as follows:

=ROUNDUP((Takeoff!D9+Takeoff!D10*(1+
(Takeoff!D3/12)^2)^0.5)/9.8,0)

18. Enter this function into Cell C8 on the Bid worksheet.

Counter flashing is handled in the same manner. The Excel
function for the counter flashing is written as follows:

=ROUNDUP((Takeoff!D11+Takeoff!D12*
(1+(Takeoff!D3/12)^2)^0.5)/9.8,0)

19. Enter this function into Cell C9 on the Bid worksheet.

If a ridge vent is specified, the length of the ridge will equal
the quantity of ridge vent needed. If a ridge vent is not spec-
ified then the length is zero. The quantity of ridge vent needs
to be converted to 20-foot rolls. The Excel function for the
ridge vent is written as follows:

=IF(Takeoff!D15="Ridge",ROUNDUP
(Takeoff!D6/20,0),0)

20. Enter this function into Cell C10 on the Bid worksheet.

If turtle vents are specified, the quantity of turtle vents is cal-
culated by dividing the area of the roof in plan view by 127.
The number of vents must be rounded up. The Excel func-
tion for the turtle vents is as follows:

=IF(Takeoff!D15="Turtle",ROUNDUP
(Takeoff!D17/127,0),0)

21. Enter this function into Cell C11 on the Bid worksheet.

The quantities of HVAC and plumbing flashings are directly
taken off of the plans and are equal to Cells D13 and D14 on
the Takeoff worksheet.

22. Enter =Takeoff!D13 into Cell C12 on the Bid worksheet.

23. Enter =Takeoff!D14 into Cell C13 on the Bid worksheet.

24. Save the worksheet.

LOOKUP AND VLOOKUP
The LOOKUP function is used to select the correct material
price based on the type of shingle or underlayment selected.
This is done by comparing the type of material on the
Takeoff worksheet to the list of materials and their prices on
the Pricing Data worksheet. The LOOKUP function is writ-
ten as follows:

=LOOKUP(lookup_value,array)

where the lookup_value is the value to be looked up (the
type of material in our case) and the array is where the list of
values is stored (the materials and their prices in our case).
The array should be two columns wide with the lookup
value in the left column and the associated value in the col-
umn to the right. The values in the left column of the array
must be in ascending order (�1, 0, 1, 2, ... , A-Z) because the
LOOKUP function will begin comparing the lookup value
to the values in the left column of the array beginning with
the top and working its way down, stopping when it finds a
value equal to or greater than the lookup value. If the
LOOKUP function finds a value in the left column of the
array equal to the lookup value, it will return the value of
the cell to its right. If the LOOKUP function finds a value in
the left column of the array greater than the lookup value
before it finds a value it is equal to, it will return the value of
the cell one column to the right and one row up. For exam-
ple, for the data in Figure 33-33, the formula

=LOOKUP(A1,A3:B6)
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is equal to 2 when cell A1 is equal to b. Alternatively, this
LOOKUP function is equal to 2 when cell A1 is equal to e be-
cause the function finds g (which is greater than e) before it
finds the e. In this case the LOOKUP function selects the
value from the cell to the right and one row up (Cell B4)
from Cell A5, where g is found.

Alternatively, this LOOKUP function can be set up using
the Function Arguments dialogue box shown in Figure 33-34.
The Function Argument dialogue box for the LOOKUP
function is opened by clicking on the Formulas menu tab,
clicking on the Lookup & Reference button in the Function
Library (shown in Figure 33-35), clicking on LOOKUP in
the popup menu (shown in Figure 33-36), clicking on
lookup_value,array from the Select Arguments dialogue
box (shown in Figure 33-37), and clicking on OK.

The VLOOKUP function works in a way similar to the
LOOKUP function, but it allows the user to select between
multiple return values stored in different columns. The
VLOOKUP function is written as follows:

=VLOOKUP(lookup_value,table_array,

col_index_number)
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FIGURE 33-33 LOOKUP array

FIGURE 33-34 LOOKUP Function Arguments Dialogue Box

FIGURE 33-35 Functions: Lookup & Reference Button

FIGURE 33-36 Lookup & Reference Popup Menu

A B
1
2
3 a 1
4 b 2
5 g 3
6 e 4



where the lookup_value is the value to be looked up, the
table_array is where the list of values is stored, and the
col_index_number identifies which column is to be used
for the return values. The table array should be at least two
columns wide with the lookup values in the left column and
the return values in the columns to the right. The lookup
values in the left column must be listed in ascending order
just as they were for the LOOKUP function. The
VLOOKUP function follows the same rules as the LOOKUP
function when looking for the lookup value. A column
index number of 2 selects return values from the second
column of the array, whereas a column index number of 3
selects return values from the third column. The column
index number must be greater than 1 and less than or equal
to the number of columns in the array. For example, for the
data in Figure 33-38, the formula

=VLOOKUP(A1,A3:D6,2)

is equal to 2 when Cell A1 is equal to b. If the column index
number is changed to 3 as follows:

=VLOOKUP(A1,A3:D6,3)

then the function returns 12 when Cell A1 is equal to b. The
VLOOKUP function can be used for multiple pricing lists or
skipping columns when looking up prices. The use of the
LOOKUP function is shown in the following exercise:

Exercise 32-6

In this exercise you will determine the material, labor, and
total costs of the roof by completing the following steps. The
prices in Cells E3, E4, and D6 will need to change based on
the type of materials specified. The prices in Cells E5, and E7
through E13 do not change.

1. Make sure that Chapter 33, the workbook modified in
Exercise 33-5, is open.

2. Begin by entering the formulas in Table 33-6 into the as-
sociated cells on the Bid worksheet.

The materials pricing for the shingles must be selected
from Cells B3 through B6 based on the shingles specified.
This is done by using a LOOKUP function, which is written
as follows:

=LOOKUP(Takeoff!D4,'Pricing Data'!A3:B6)

3. Enter this function into Cell E3 on the Bid worksheet.
The cell will contain #N/A when a shingle type has not
been selected.

4. Enter =LOOKUP(Takeoff!D4,'Pricing Data'!A9:B12)
into Cell E4 on the Bid worksheet.

5. Enter =LOOKUP(Takeoff!D5,'Pricing Data'!A15:B16)
into Cell E6 on the Bid worksheet.

The next step is to calculate the total cost for each type of ma-
terial. This is done by multiplying Column E by Column C.

6. Enter =E3*C3 into Cell F3 on the Bid worksheet.

7. Copy Cell F3 to Cells F4 through F13 without copying
the border by right clicking on Cell F3, selecting Copy
from the popup menu, selecting Cells F4 through F13,
right clicking on one of the selected cells, selecting Paste
Special... from the popup menu to bring up the Paste
Special dialogue box, selecting All except borders, and
clicking on the OK button.

Next, we calculate the total cost of the materials without
sales tax.

8. Enter =SUM(F3:F13) into Cell F14 of the Bid worksheet.

Next, we calculate the tax at a fixed rate of 6.5%.

9. Enter =F14*0.065 into Cell F15 of the Bid worksheet.

The next step is to determine the number of labor hours
needed for the roof, which is determined by multiplying
the labor hours per square for the specified type of shin-
gle by the sloped area of the roof and adding two hours
for mobilization. The labor hours per square is found in
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FIGURE 33-37 Select Arguments Dialogue Box

FIGURE 33-38 VLOOKUP array

A B C D
1
2
3 a 1 11 21
4 b 2 12 22
5 c 3 13 23
6 d 4 14 24

TABLE 33-6 Formulas

Cell Formula

E5 ='Pricing Data'!B27

E7 ='Pricing Data'!B28

E8 ='Pricing Data'!B19

E9 ='Pricing Data'!B20

E10 ='Pricing Data'!B21

E11 ='Pricing Data'!B22

E12 ='Pricing Data'!B23

E13 ='Pricing Data'!B24



Cells B31 through B34 of the Pricing Data worksheet, and
the LOOKUP function is used to select the appropriate
production rate. The Excel formula for the sloped area is
as follows:

=Takeoff!D17*(1+(Takeoff!D3/12)^2)^0.5/100

The Excel function to determine the labor hours is written as
follows:

=ROUNDUP(LOOKUP(Takeoff!D4,'Pricing
Data'!A31:B34)*Takeoff!D17*(1+
(Takeoff!D3/12)^2)^0.5/100+2,1)

10. Enter this function into Cell C16 on the Bid worksheet.

The next step is to calculate the total labor costs by multiply-
ing Column E by Column C.

11. Enter =E16*C16 into Cell F16 of the Bid worksheet.

The next step is to calculate the total costs by summing the
material cost without tax, the sales tax, and the labor.

12. Enter =SUM(F14:F16) into Cell F17 of the Bid worksheet.

13. Save the workbook.

The next step is to automate with macros; however,
macros are not needed in this workbook. The next step is to
test the worksheet. This is done in the following exercise.

Exercise 32-7

In this exercise you will test the workbook as follows:

1. Make sure that Chapter 33, the workbook modified in
Exercise 33-6, is open.

2. Begin by entering the numbers and text in Table 33-7
into the associated cell in the Takeoff worksheet.

The Bid worksheet should appear as it does in Figure 33-39.

3. Exit without saving the worksheet.

The final step is to protect the worksheet against er-
rors. For the roofing spreadsheet, this protection will be in
two forms. First, data validation is used to restrict the val-
ues entered into Cells D3 through D15 and H4 through
I13 on the Takeoff worksheet. This has already been done
for Cells D4, D5, and D15. Cell C3 is limited to a whole
number between 0 and 12. Cells D6 through D12 are lim-
ited to a whole number between 0 and 200. Cells D13 and
D14 are limited to a whole number between 0 and 20.
Finally, Cells H4 through I13 are limited to a whole num-
ber between 0 and 200.

Second, the worksheet is protected so only Cells D3
through D15 and H4 through I13 can be changed. In the
following exercise you will protect the worksheets against
errors:

Exercise 32-8

In this exercise you will protect the worksheet against errors
by using the following steps:

1. Make sure that Chapter 33, the workbook modified in
Exercise 33-6, is open.

2. Click on the Takeoff tab to move to the Takeoff work-
sheet.
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TABLE 33-7 Test Case

Cell Data Cell Data

C3 6 C11 4

C4 25-year Architectural C12 8

C5 15# Felt C13 2

C6 12 C14 4

C7 1 C15 Turtle

C8 91 H4 44

C9 152 I4 32

C10 0

FIGURE 33-39 Bid Worksheet

A B C D E F
1
2 Materials Unit Price Total
3 25-year Architectural 51 bundle 15.98 814.98
4 25-year Architectural Cap 6 bundle 31.29 187.74
5 Roofing Nails 19 lbs 1.39 26.41
6 15# Felt 6 rolls 14.95 89.70
7 Underlayment Nails 30.0 C 1.00 30.00
8 10' Drip Edge 16 ea 2.99 47.84
9 10' Counter Flashing 2 ea 3.99 7.98

10 20' Ridge Vent - ea 42.00 -
11 Turtle Vents 12 ea 7.00 84.00
12 HVAC Flashing 2 ea 9.00 18.00
13 Plumbing Flashing 4 ea 4.00 16.00
14 Subtotal 1,322.65
15 Tax (6.5%) 85.97
16 Roofing Crew 46.1 lhrs 35.00 1,613.50
17 Total 3,022.12

Quantity



First, the data validation for Cell D3 is set up.

3. Select Cell D3, click on the Data menu tab, click on the
Data Validation button in the Data Tools group to
bring up the Data Validation dialogue box (shown in
Figure 33-40).

4. Select the Settings tab, select Whole Number from the
Allow: dropdown box, select between from the Data:
dropdown box, type 3 in the Minimum: text box, and
type 12 in the Maximum: text box.

5. Select the Input Message tab and type Enter a whole
number between 3 and 12. in the Input message: text
box. The Title: text box will remain blank.

6. Select the Error tab, type Error in the Title: text box,
type Enter a whole number between 3 and 12. in the
Error message: text box, and click the OK button to
close the Data Validation dialogue box.

Next, the data validation for Cell D6 is set up.

7. Select Cell D6, click on the Data menu tab, click on the
Data Validation button in the Data Tools group to
bring up the Data Validation dialogue box.

8. Select the Settings tab, select Whole Number from the
Allow: dropdown box, select between from the Data:
dropdown box, type 0 in the Minimum: text box, and
type 200 in the Maximum: text box.

9. Select the Input Message tab and type Enter a whole
number between 0 and 200. in the Input message: text
box.

10. Select the Error tab, type Error in the Title: text box,
type Enter a whole number between 0 and 200. in the
Error message: text box, and click the OK button to
close the Data Validation dialogue box.

Next, copy the data validation from Cell D6 to Cells D7
through D12 and H4 through I13 using the following steps.

11. Right click on Cell D6 and select Copy from the popup
menu.

12. Select Cells D7 through D12, right click on one of the
selected cells, select Paste Special... from the popup
menu to bring up the Paste Special dialogue box, select
the Validation radio button, and click the OK button to
close the Paste Special dialogue box.

13. Repeat this process for Cells H4 through I13.

Next, the data validation for Cells D13 and D14 is set up.

14. Select Cells D13 and D14, click on the Data menu tab,
click on the Data Validation button in the Data Tools
group to bring up the Data Validation dialogue box.

15. Select the Settings tab, select Whole Number from the
Allow: dropdown box, select between from the Data:
dropdown box, type 0 in the Minimum: text box, and
type 20 in the Maximum: text box.

16. Select the Input Message tab and type Enter a whole
number between 0 and 20. in the Input message: text box.

17. Select the Error tab, type Error in the Title: text box,
type Enter a whole number between 0 and 20. in the
Error message: text box, and click the OK button to
close the Data Validation dialogue box.

The final step is to protect the workbook. This is done in two
steps. First, identify the cells that will be allowed to change.
Second, protect each of the worksheets in the workbook.

18. Select Cells D3 through D15 and H4 through I13, right
click on one of the selected cells, select Format Cells...
from the popup menu to bring up the Format Cells dia-
logue box, select the Protection tab, uncheck the
Locked check box, and click the OK button to close the
dialogue box.

19. Protect the Takeoff worksheet by clicking on the Review
menu tab and clicking on the Protect Sheet button in
the Changes group (shown in Figure 32-34) to bring up
the Protect Sheet dialogue box (shown in Figure 32-35).

20. Make sure that the Protect worksheet and contents of
locked cells check box is checked.

21. Type 1234 in the Password to unprotect sheet: text box.

22. Uncheck the Select locked cells check box.

23. Make sure that the Select unlocked cells check box is
checked.

24. Make sure that all other check boxes are unchecked.

25. Click on the OK button to bring up the Confirm
Password dialogue box.

26. Type 1234 in the Reenter password to proceed. text box
and click on the OK button to close the dialogue box
and protect the worksheet.

27. Check to make sure only Cells D3 through D15 and H4
through I13 can be selected by pressing the Down
Arrow key to move through the unlocked cells.

28. Protect the Bid and Pricing Data worksheets using the
same process.

29. Save the workbook.
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FIGURE 33-40 Settings Tab of the Data Validation Dialogue
Box



CONCLUSION
The steps for planning a new form are to identify the desired
results, identify input data, solve practice problems, identify
steps and equations, and sketch spreadsheet layouts. The
steps for setting up a new form are the same as for existing
forms.

PROBLEMS
1. What are the steps for creating a new form?

2. How can a series be created?

3. What is the advantage of naming cells?

4. How are cells named?

5. How do you create a dropdown box?

6. What is the purpose of the CONCATENATE function?

7. What is the purpose of the LOOKUP function?

8. Make a copy of the spreadsheet developed in this chapter.
Modify the copy to use the plan view area from a takeoff
software package in lieu of calculating the area. Add the
needed error protection and protect your worksheets.

9. Make a copy of the spreadsheet developed in this chap-
ter and use it to calculate the cost of the roof shown in
Figure 9-11. The roof is constructed of 30-year architec-
tural shingles over 30-pound felt. Ridge vents are used
and there are four plumbing flashings and one HVAC
flashing. The roof slope is 4:12.

10. Make a copy of the spreadsheet developed in this chap-
ter and use it to calculate the cost of the roof shown in
Figure 9-12. The roof is constructed of 20-year, three-
tab shingles over 15-pound felt. Turtle vents are used
and there are six plumbing flashings and two HVAC
flashing. The roof slope is 6:12.
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In this chapter you will learn how to create a ready-to-sign
proposal and look beyond the Excel spreadsheets presented in
this book.

In the previous chapter, Excel was used to prepare an esti-
mate for an asphalt shingle roof. It is a simple step to con-
vert this estimate into a ready-to-sign proposal.

Exercise 34-1

In this exercise you will convert the spreadsheet from
Chapter 33 into a ready-to-sign proposal by completing the
following steps:

1. Open Chapter 33, the workbook you created in the pre-
vious chapter.

2. Save the workbook as Chapter 34.xlsx by selecting the
File tab (the Microsoft Office button for Excel 2007),
clicking on Save As in the left pane to bring up the Save
As dialogue box, selecting the Excel Exercises folder in
the left pane (Save in: dropdown box for Excel 2007),
and typing Chapter 34 in the File Name text box.

Next, you will add a place on the Takeoff worksheet for the
client and project information using the following steps:

3. Select the Takeoff tab.

4. Click on the Review menu tab, click on the Unprotect
Sheet button in the Changes group to bring up the
Unprotect Sheet dialogue box (shown in Figure 32-37),
type 1234 in the Password: text box, and click on the OK
button to unprotect the worksheet.

5. Select Columns A through D, click on the Home menu
tab, and click on the Insert button in the Cells group
(shown in Figure 34-1) to insert four columns to the left
of the worksheet.

PROPOSALS
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6. Change the width of Columns A and C to 1, of Column
B to 10, and of Column D to 25.

7. Type the text shown in Table 34-1 into the specified
cells.

8. Underline Cells B2 through D2 by selecting the cells
and clicking the Bottom Border button (shown in
Figure 3-46) in the Font group on the Home menu tab.
If another border is shown in the Borders button, select
the correct border by clicking on the small arrow to the
right of the Borders button and selecting the Bottom
Border from the Borders popup.

TABLE 34-1 Date for Takeoff Worksheet

Cell Data Cell Data

B2 Client Information B11 Project Information

B3 Name: B12 Name:

B4 Address: B13 Address:

B6 City: B15 City:

B7 State: B16 State:

B8 Zip Code: B17 Zip Code:

B9 Phone #: B18 Phone #:

FIGURE 34-1 Home: Insert Button



9. Merge and center Cells B2 through D2 by highlighting
Cells B2 through D2, selecting the Home menu tab, and
selecting the Merge and Center button in the
Alignment group (shown in Figure 3-39).

10. Underline Cells B11 through D11.

11. Merge and center Cells B11 through D11.

12. Right justify the text in Column B by selecting
Column B, selecting the Home menu tab, and select-
ing the Align Right button in the Alignment group
(shown in Figure 3-32).

13. Draw a Thick Box Border around Cells B2 through D9
by selecting Cells B2 through D9, clicking the Home
menu tab, clicking on the small arrow to the right of the
Borders button in the Font group, and selecting the
Thick Box Border from the Borders popup menu.

14. Draw a Thick Box Border around Cells B11 through D18.

The next step is to protect the worksheet using the following
steps:

15. Select Cells D3 through D9 and D12 through D18, right
click on one of the selected cells, select Format Cells...
from the popup menu to bring up the Format Cells dia-
logue box (shown in Figure 32-33), select the
Protection tab, uncheck the Locked check box, and
click the OK button to close the dialogue box.

16. Protect the Takeoff worksheet by clicking on the Review
menu tab and clicking on the Protect Sheet button in
the Changes group (shown in Figure 32-34) to bring up
the Protect Sheet dialogue box (shown in Figure 32-35).

17. Type 1234 in the Password to unprotect sheet: text box.

18. Click on the OK button to bring up the Confirm
Password dialogue box (shown in Figure 32-36).

19. Type 1234 in the Reenter password to proceed. text box
and click on the OK button to close the dialogue box
and protect the worksheet.

20. Check to make sure only Cells D3 through D15 and H4
through I13 can be selected by pressing the Down
Arrow key to move through the unlocked cells.

Proposals and Beyond 339

21. Save the workbook.

The worksheet should now appear as shown in Figure 34-2.
Next, you will add a place on the Bid worksheet for the
client, project, and other proposal information using the fol-
lowing steps:

22. Select the Bid tab.

23. Click on the Review menu tab, click on the Unprotect
Sheet button in the Changes group to bring up the
Unprotect Sheet dialogue box (shown in Figure 32-37),
type 1234 in the Password: text box, and click the OK
button to unprotect the worksheet.

24. Select Rows 1 through 9, click on the Home menu tab,
and click on the Insert button in the Cells group
(shown in Figure 34-1) to insert nine rows at the top of
the worksheet.

25. Type the text shown in Table 34-2 into the specified
cells.

Use the Underline Key to create the underlining. Press the
Underline Key 34 times in Cell B30 and 18 times in Cell E30.

26. Merge Cells B2 and C2.

27. Merge Cells B3 and C3.

28. Merge Cells D2 through F2.

29. Merge Cells D3 through F3.

FIGURE 34-2 The Takeoff Worksheet

A B C D E F G H I J K L M
1
2
3 Name: Roof Slope: :12 Area Length Width
4 Address: Shingle Type: 1
5 Underlayment: 2
6 City: Ridge(s):  ft 3
7 State: No. of Ridges: ea 4
8 Zip Code: Hip(s)/Valley(s): ft 5
9 Phone #: Horiz. Perimeter: ft 6

10 Sloped Perimeter: ft 7
11 Horiz. Counter: ft 8
12 Name: Sloped Counter: ft 9
13 Address: HVAC Flashings: ea 10
14 Plumbing Flashings: ea
15 City: Vent Type: 
16 State:
17 Zip Code: Plan View Area: - sft
18 Phone #: Unit Price: #N/A /sft

Roof Information Roof AreaClient Information

Project Information

TABLE 34-2 Data for Bid Worksheet

Cell Data

B2 Bill To:

D2 Ship To:

B28 Half of the payment is due at delivery of materials. The re-
maining payment is due upon completion of the roofing.

B30 By:

E30 Date:
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FIGURE 34-3 The Bid Worksheet

TABLE 34-3 Formulas for Bid Worksheet

Cell Data

B3 =IF(Takeoff!D3=““,””,Takeoff!D3)

D3 =IF(Takeoff!D12=““,””,Takeoff!D12)

A B C D E F

1

2

3

4

5

6

7

8

9

10

11 Materials Unit Price Total
12 Select Shingle - bundle #N/A #N/A
13 Cap - bundle #N/A #N/A
14 Roofing Nails - lbs 1.39 -
15 Select Underlyment - rolls #N/A #N/A
16 Underlayment Nails - C 1.00 -
17 10' Drip Edge - ea 2.99 -
18 10' Counter Flashing - ea 3.99 -
19 20' Ridge Vent - ea 42.00 -
20 Turtle Vents - ea 7.00 -
21 HVAC Flashing - ea 9.00 -
22 Plumbing Flashing - ea 4.00 -
23 Subtotal #N/A
24 Tax (6.5%) #N/A
25 Roofing Crew #N/A lhr 35.00 #N/A
26 Total #N/A
27

28

29

30 By: . Date: .

Ship To:Bill To:

Half of the payment is due at delivery of materials.  The remaining payment is due upon completion of the roofing.

Quantity

30. Enter the formulas in Table 34-3 into the specified cells.

31. Copy Cell B3 to Cells B4 through B9.

32. Copy Cell D3 to Cells D4 through D9.

33. Left justify Cells B2 through F9 by selecting Cells B2
through F9, selecting the Home menu tab, and selecting
the Align Text Left button in the Alignment group
(shown in Figure 3-30).

34. Draw a Thick Box Border around Cells B2 through C9.

35. Draw a Thick Box Border around Cells D2 through F9.

36. Select Cells A1 through F30 and change the font size to 14
point by selecting Cells A1 through F30, selecting the
Home menu tab, and then selecting 14 from the Font
dropdown box in the Font group (shown in Figure 3-34).

37. Merge Cells B28 through F28 and change the font size to 8.

38. If needed, adjust the underlining in Cell B30 so that it
fits in Cells B30 to D30 and the underlining in Cell E30
so that it fits in Cells E30 and F30.

39. Merge Cells B30 through D30.

40. Merge Cells E30 and F30.

41. Protect the Bid worksheet.

42. Save the workbook.

The worksheet should now appear as shown in Figure 34-3.

43. Enter data into Cells D3 through D9 of the Takeoff
worksheet and verify that the data appears in the Bill To:
area on the Bid worksheet.

44. Enter data into Cells D12 through D18 of the Takeoff
worksheet and verify that the data appears in the Ship
To: area on the Bid worksheet.

45. Delete the data in Cells D3 through D9 and Cells D12
through D18.

46. Exit the workbook. There is no need to save it if you
saved the workbook in Step 42.

AND BEYOND
During the course of this book you have been introduced to
Excel as a powerful tool for estimating. You have seen sample
worksheets that can be used for the quantity takeoff, devel-
oped a workbook for use in summarizing an estimate and
documenting the details of the estimate, incorporated error
checking into spreadsheets, automated repetitive tasks with
macros, and set up a workbook to prepare the estimate and
proposal for an asphalt shingle roof. With little effort, an es-
timator can develop a spreadsheet to prepare a conceptual
estimate for specific types of construction projects or pre-
pare more complex quantity takeoff spreadsheets. The possi-
bilities are only limited by the mind and imagination of the
estimator. Enjoy the productivity and time-saving features of
using Excel for estimating.



This appendix is provided as a review of the mathematical
equations and concepts needed to perform the quantity takeoff
for those who struggle with math or just want to review the
necessary mathematical concepts before reading the chapters
covering the quantity takeoff. Do not let the math scare you.
The mathematical principles used in estimating are relatively
simple and can be mastered with a little effort.

In estimating we often need to determine lengths, areas,
and volumes in order to determine the quantities of ma-
terials needed to complete the project. In many cases we

need to convert the quantities from one set of units to an-
other set of units. Each of these topics is discussed in this ap-
pendix. Let’s first look at determining lengths.

LENGTHS
In most cases lengths are determined by calculating the dis-
tances based on dimensions shown on the plans or by mea-
suring the distances using a scale, plan measurer, digitizer,
or takeoff software package. There are cases, such as in a
roof-framing plan, where the distances shown on the draw-
ings are not accurate because the building component is not

parallel to the drawing plane, but instead is being projected
to a horizontal plane. When this occurs the Pythagorean
theorem needs to be used to determine the true distance.
Let’s look at ways to determine distances.

Calculating Distances from Dimensions
To determine distance from the dimensions, we may have to
use two or more dimensions to determine the correct dis-
tance. For example, to find the distance from the corner of
the building to the center of the door (A) in Figure A-1 one
needs to add the distance from the corner of the building to
the center of the window to the distance from the center of
the window to the center of the door. Similarly, to deter-
mine the distance from the center of the window to the
center of the closet wall (B) in Figure A-1 one needs to sub-
tract the distance from the corner of the building to the cen-
ter of the closet wall from the distance from the corner of the
building to the center of the window.

When adding dimensions with feet and inches, the feet
must be added to the feet, the inches to the inches, and the
fractions of an inch to the fractions of an inch. Before
adding the dimensions, one must first make sure that all the
fractions of an inch have the same denominator (the bot-
tom portion of the fraction). This is done by multiplying
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FIGURE A-1 Calculating Distance from Dimensions
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the numerator (the top portion) of a fraction and its de-
nominator by the same number (which doesn’t change the
overall value of the fraction) in such a way that each frac-
tion ends up with the same denominator. After you add the
dimensions together, if the numerator of the fraction is
greater than the denominator of the fraction, subtract the
denominator from the numerator and add 1 inch to the
inches portion of the distance. Repeat this until the numer-
ator is less than the denominator. When the inches portion
exceeds 12 inches, subtract 12 inches from the inches por-
tion of the distance and add 1 foot to the feet portion of the
distance. Repeat this until the inches portion of the distance
is greater than or equal to 0 and less than 12.

EXAMPLE A-1

Determine distance between the corner of the building and the
center of the door (A) in Figure A-1.

Solution: The distance is equal to the distance between the corner
of the building and the center of the window (5 feet 5 1>2 inches)
plus the distance between the center of the window and the center
of the door (3 feet 11 3>4 inches). First, convert the fractions of an
inch to a common denominator, in this case 1>4 inch, by multiply-
ing the numerator (the top) and the denominator (the bottom) of
1>2 by 2 to get 2>4. The feet, the inches, and the fractions of an inch
are added together as follows:

Next, reduce the fraction of inches to less than 1 inch by adding 1 to
the inches and subtracting 4 from the numerator of the fraction as
follows:

Finally, reduce the inches portion of the dimension to less than 12
by subtracting 12 from the inches and adding 1 to the feet as fol-
lows:

The distance is 9 feet 5 1>4 inches. �

When determining the distance between the center of
the wall and the center of the window (B) in Figure A-1, one
needs to subtract the smaller dimension (2 feet 6 3>4 inches)
from the larger dimension (5 feet 5 1>2 inches). Before these
dimensions are subtracted, the fractions of an inch must
have the same denominator. This is done by multiplying
both the numerator and the denominator of the fraction
with the lower denominator by the same number. Next, one
must make sure the fraction of an inch in the larger dimen-
sion is greater than the fraction of an inch in the smaller di-
mension. If this is not the case, one adds the number in the
denominator to the number in the numerator of the frac-
tions of an inch and subtracts 1 from the whole number of
inches. One must also make sure that the number of inches
in the larger dimension is greater than the number of inches
in the smaller dimensions. If this is not the case, 12 must be
added to the number of inches and 1 must be subtracted

Distance � 8¿ 17 1>4– � 9¿ 5 1>4–

Distance � 8¿ 16 5>4¿ � 8¿ 17 1>4–

� 8¿ 16 5>4–
Distance � 5¿ 5 1>2– � 3¿ 11 3>4– � 5¿ 5 2>4– � 3¿ 11 3>4–

from the number of feet. Once this is accomplished, the feet
are subtracted from the feet, the inches from the inches, and
the fraction of an inch from the fraction of an inch, as shown
in the following example.

EXAMPLE A-2

Determine the distance between the center of the closet wall and
the center of the window (B) in Figure A-1.

Solution: The distance is equal to the distance between the corner
of the building and the center of the window (5 feet 5 1>2 inches)
minus the distance between the corner of the building and the cen-
ter of the closet wall (2 feet 6 3>4 inches). First, make sure the frac-
tions of an inch have the same denominator. Do this by multiplying
the numerator (the top) and the denominator (the bottom) of 1>2
by 2 to get 2>4 as follows:

Next, make sure that the fraction of an inch in the larger dimension
is greater than the fraction of an inch in the smaller dimension. In
this example, this is not the case, so in the larger dimension the de-
nominator (4) must be added to the numerator (2) and 1 sub-
tracted from the inches as follows:

Next, make sure the number of inches in the larger dimension is
greater than the number of inches in the smaller dimension. In
this example, this is not the case, so 12 must be added to the
inches of the large dimension and 1 subtracted from the feet as
follows:

Now we can subtract the feet from the feet, the inches from the
inches, and the fractions of an inch from the fractions of an inch
as follows:

The distance is 2 feet 10 3>4 inches. �

SCALING
Another method of determining the distance on the plans is
scaling the distance. Plans are prepared at reduced scale. The
length of components on the plans may be determined by
scaling the length using a scale, plan measurer, digitizer, or
takeoff package. When scaling drawings it is important to
make sure that the correct scale is used and that the drawings
are to scale. This may be done by scaling a known dimension
and verifying that the scaled dimension is the same as the di-
mension shown on the drawing.

A triangular architect’s scale includes the following
scales: (1 inch on the plans equals 1 foot of the build-
ing)

and along with
a standard 12-inch ruler. Most of the sides have two scales,
one reading left to right and the other reading right to left,
with one scale being one-half of the other scale. For exam-
ple, the architect scale shown in Figure A-2 includes two

3– � 1¿3>4– � 1¿,  3>8– � 1¿,  1 1>2– � 1¿,
 3>16–� 1¿, 3>32–� 1¿,1>4–� 1¿,  1>8–� 1¿,1>2–� 1¿,

1– � 1¿

Distance � 4¿ 16 6>4– � 2¿ 6 3>4– � 2¿ 10 3>4–

Distance � 5¿ 4 6>4– � 2¿ 6 3>4– � 4¿ 16 6>4– � 2¿ 6 3>4–

Distance � 5¿ 5 2>4– � 2¿ 6 3>4– � 5¿ 4 6>4– � 2¿ 6 3>4–

Distance � 5¿ 5 1>2– � 2¿ 6 3>4– � 5¿ 5 2>4– � 2¿ 6 3>4–
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scales: reading left to right and read-
ing right to left. For the scale, the feet are read on
the right side of the scale and the inches on the left side of
the scale. The feet for the scale are the numbers
on the scale closest to the edge and increase in increments of
4 from left to right. For the scale, both the long
and short lines represent a foot. For the scale, the
feet are read on the left side of the scale and the inches on
the right side of the scale. The feet for the scale
are the numbers on the scale furthest from the edge and in-
crease in increments of 2 from right to left. For the

scale, the long lines represent a foot and the short
lines represent a half of a foot. The scale is read
by lining up the feet on the right side of the drawing such
that the left side of the drawing falls within the inch marks
on the left side of the scale. The feet are then read off the
right side of the scale and the inches off the left side of the
scale.

The scale is read by lining up the feet on the
left side of the drawing such that the right side of the draw-
ing falls within the inch marks on the right side of the scale.
When reading the scale, care must be taken to line
up with a whole foot mark—the longer marks—rather than
the short marks, which indicate half a foot for this scale. The
feet are then read off the left side of the scale and the inches
off the right side of the scale.

1>4– � 1¿

1>4– � 1¿

1>8– � 1¿
1>4– � 1¿

1>4– � 1¿

1>4– � 1¿
1>8– � 1¿

1>8– � 1¿

1>8– � 1¿
1>4– � 1¿1>8– � 1¿

EXAMPLE A-3

Determine the length of the wall shown in Figure A-3 using the
scale at the bottom of the figure. The figure is drawn at a scale of

Solution: The scale is lined up with a foot mark at the right side
of the drawing, and the left side of the drawing is lined up within
the inch marks at the left side of the scale. The feet and inches are
then read off of the scale. The length of the wall is 28 feet 3 inches
long. �

A triangular engineer’s scale typically has the following
scales: 1:10 (1 inch equals 10 feet), 1:20, 1:30, 1:40, 1:50, and
1:60. Each side has only one scale and is read left to right.
Inches are not included on the engineer’s scale. The engi-
neer’s scale is read by lining up the zero on the left side of the
drawing and reading the feet on the right side of the scale.

EXAMPLE A-4

Determine the length of the building shown in Figure A-4 using the
scale at the bottom of the figure. The figure is drawn at a scale of

Solution: The scale is lined up with the zero; therefore, the feet can
be read off of the right side of the scale. The length of the wall is be-
tween 68 and 69 feet. �

1– � 20¿.

1>8– � 1¿.

FIGURE A-2 Architect Scale

FIGURE A-3 Example A-3

FIGURE A-4 Example A-4
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PYTHAGOREAN THEOREM
The Pythagorean theorem is useful when two dimensions at
right angles are used to describe a construction component.
This is commonly found in roof-framing plans, where the
run of the roof joists is shown on the framing plan and there
is a rise in the joist that is calculated from the slope of the
roof. The Pythagorean theorem is also useful for walls that
are constructed at odd angles to the rest of the building, as
we will see in Example A-5.

The Pythagorean theorem equates the length of the hy-
potenuse (C) of a right triangle, a triangle with one 90-de-
gree (right) angle, to the other two sides (A and B) of the tri-
angle. The Pythagorean theorem states that the square of the
hypotenuse equals the sum of the squares of the other two
sides of the triangle and is written as

(A-1)

where A, B, and C are the lengths of the sides of the triangle
as shown in Figure A-5. It does not matter which of the two
sides adjacent to the 90-degree angle is designated A and
which is designated B.

EXAMPLE A-5

Determine the length of the diagonal wall in Figure A-6.

Solution: Using Eq. (A-1), we get

Taking the square root of both sides to solve for C, we get

The wall is 15 feet 9 3>4 inches long. �

AREAS
Estimators are often required to calculate areas in order to
complete the quantity takeoff. The area of an object is de-
termined by one of two methods: the geometric method
and the coordinate method. Let’s look first at the geomet-
ric method.

C � (250 ft2)0.5 � 15.81 ft � 15 ft 9 3̌>̌4 in

C2 � A2 � B2 � (13 ft)2 � (9 ft)2 � 250 ft2

C2 � A2 � B2

Geometric Method
The geometric method breaks complex shapes down into six
simpler geometric shapes: the circle, the square, the rectan-
gle, the triangle, the trapezoid, and the parallelogram. These
shapes are shown in Figure A-7. The areas of these shapes are
calculated as follows.

Circle The area of a circle is calculated from the radius
using the equation

(A-2)

or from the diameter using the equation

(A-3)

where

R � Radius of the Circle

D � Diameter of the Circle

EXAMPLE A-6

Find the area of a circle whose radius is 12 inches.

Solution: Using Eq. (A-2), we get

�

Rectangle The area of a rectangle is calculated from its
length and width using the equation:

(A-4)

where

L � Length

W � Width

EXAMPLE A-7

Find the area of a rectangle whose length is 24 inches and width is
12 inches.

Area � LW

Area � �R2 � �(12 in)2 � 452 in2

� � 3.14159

Area � �
D2

4

Area � �R2

FIGURE A-5 Right Triangle

FIGURE A-6 Example A-5
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Solution: Using Eq. (A-4), we get

�

Square A square is a special case of a rectangle in which
the length and the width are equal; therefore, all of the sides
are the same length. The area of a square is calculated from its
length using the equation

(A-5)

where

L � Length

EXAMPLE A-8

Find the area of a square whose length is 12 inches.

Solution: Using Eq. (A-5), we get

�

Triangle The area of a triangle is calculated from its base
and height using the equation

(A-6)

where

B � Base

H � Height

The height of the triangle must be measured perpendicular to
the base. This is true for all of the triangles shown in Figure A-8.

Area �
BH

2

Area � L2 � (12 in)2 � 144 in2

Area � L2

Area � LW � (24 in)(12 in) � 288 in2
EXAMPLE A-9

Find the area of a triangle whose base is 12 inches and height is
24 inches.

Solution: Using Eq. (A-6), we get

�

Trapezoid A trapezoid is a four-sided figure with two
parallel sides. The area of a trapezoid is calculated from the
length of the two parallel sides and the perpendicular dis-
tance between the parallel sides using the equation

(A-7)

where

B and C � Lengths of the Parallel Sides

D � Perpendicular Distance between the Parallel
Sides

EXAMPLE A-10

Find the area of a trapezoid whose parallel sides are 12 and 16
inches long with a distance between the parallel sides of 24 inches.

Solution: Using Eq. (A-7), we get

�Area �
(B � C)

2
D �

(12 in � 16 in)

2
(24 in) � 336 in2

Area �
(B � C)

2
D

Area �
BH

2
�

(12 in)(24 in)

2
� 144 in2

FIGURE A-7 Basic Shapes

FIGURE A-8 Triangles
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Parallelogram A parallelogram is a four-sided plane fig-
ure with opposite sides parallel. Because both pairs of oppo-
site sides are parallel, the opposite sides have the same
length. A parallelogram is a special case of a trapezoid in
which B and D are the same length. The area of a parallelo-
gram is determined from the length of one side and the per-
pendicular distance between that side and the side parallel to
it, using the equation

(A-8)

where

B � Length of Each of a Given Pair of Parallel Sides

D � Perpendicular Distance between the Two Sides
That Have Length B

EXAMPLE A-11

Find the area of a trapezoid whose parallel sides are 12 inches long
with a distance between the parallel sides of 24 inches.

Solution: Using Eq. (A-8), we get

�

Now that we have covered the basic geometric shapes,
let’s look at two complex shapes. The area of a complex

Area � BD � (12 in)(24 in) � 288 in2

Area � BD

shape is determined by breaking the shape down into its
basic geometric shapes, determining the area of the basic
geometric shapes, and adding their areas as shown in the fol-
lowing example.

EXAMPLE A-12

Determine the area of the shape in Figure A-9.

Solution: Divide the complex shape into two rectangles and a
square as shown in Figure A-10. The area of the left rectangle is de-
termined from Eq. (A-4) as follows:

The area of the right rectangle is determined from Eq. (A-4) as
follows:

The area of the square is determined from Eq. (A-5) as follows:

The area of the complex shape is determined by summing the areas
of the smaller shapes as follows:

The area of the complex shape is 1,700 square feet. �

Area � 600 ft2 � 200 ft2 � 900 ft2 � 1,700 ft2

Area � L2 � (30 ft)2 � 900 ft2

Area � LW � (20 ft)(10 ft) � 200 ft2

Area � LW � (30 ft)(20 ft) � 600 ft2

FIGURE A-9 Complex Shape

FIGURE A-10 Complex Shape
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Sometimes it is advantageous to make the shape a part
of a larger shape and subtract the missing pieces as shown in
the following example.

EXAMPLE A-13

Determine the area of the shape in Figure A-9.

Solution: Make the complex shape into a 60-foot by 30-foot rec-
tangle less a 10-foot by 10-foot square as shown in Figure A-11. The
area of the rectangle is determined from Eq. (A-4) as follows:

The area of the square is determined from Eq. (A-5) as follows:

The area of the complex shape is determined by subtracting the
area of the square from the area of the rectangle as follows:

The area of the complex shape is 1,700 square feet, which is the
same as the answer from Example A-12. �

Another common example of creating a large shape and
subtracting the missing pieces arises in the case of an outside
radius that creates a complex shape as shown in Figure A-12.
The area of this shape is calculated by taking the area of a
square of length R and subtracting the area of a quarter of a
circle as shown in Figure A-13.

The area is calculated by using the equation

(A-9)Area � R2a1 �
�

4
b

Area � 1,800 ft2 � 100 ft2 � 1,700 ft2

Area � L2 � (10 ft)2 � 100 ft2

Area � LW � (60 ft)(30 ft) � 1,800 ft2

where

� 3.14159

R � Radius of the Circle

The use of this equation is shown in the following
example.

EXAMPLE A-14

Determine the area of the complex shape in Figure A-14.

Solution: Divide the shape into two rectangles and a square-less-a-
quarter-circle as shown in Figure A-15.

The area of the left rectangle is determined from Eq. (A-4) as
follows:

The area of the right rectangle is determined from Eq. (A-4) as
follows:

The area of the square-less-a-quarter-circle is determined from
Eq. (A-9) as follows:

The area of the complex shape is determined by summing the areas
of the smaller shapes as follows:

The area of the complex shape is 3,386 square feet. �

Area � 2,100 ft2 � 1,200 ft2 � 86 ft2 � 3,386 ft2

Area � R2a1 �
�

4
b � (20 ft)2a1 �

�

4
b � 86 ft2

Area � LW � (40 ft)(30 ft) � 1,200 ft2

Area � LW � (70 ft)(30 ft) � 2,100 ft2

�

FIGURE A-11 Complex Shape

FIGURE A-12 Complex Shape

FIGURE A-13 Square-Less-a-Quarter-Circle
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FIGURE A-14 Complex Shape

FIGURE A-15 Complex Shape
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Coordinate Method
The coordinate method is used to calculate the area of a
complex shape in which all the sides are straight by using the
coordinates of the intersections of the sides. The area of an
n-sided shape is determined by the following equation:

(A-10)

The use of this equation is shown in the following
example.

EXAMPLE A-15

Determine the area of the complex shape in Figure A-16.

Solution: Using the intersection in the lower-left corner as Point 1,
proceeding around the complex shape in a clockwise direction, and
using Eq. (A-10), we get

Because Figure A-16 is the same size as Figure A-9, they should have
the same areas, which they do. �

An alternate method for calculating the area using the
coordinate method is to set up the coordinates as shown in
Figure A-17, with the coordinates for the first point at both
the top and bottom.

Starting with the second row, the X-coordinate is mul-
tiplied by the Y-coordinate from the previous row, and the
resultant is entered in the second row of the first column as
shown in Figure A-18. This is repeated for the third
through the last rows. Next, starting with the second row,
the Y-coordinate is multiplied by the X-coordinate from

Area � 0.5[6,000 � 2,600] � 0.5[3,400] � 1,700 ft2

� (0 � 0 � 400 � 400 � 900 � 900 � 0 � 0)] ft2

Area � 0.5[(0 � 600 � 600 � 600 � 600 � 1,800 � 1,800 � 0)

� 60 � 0 � 60 � 0] ft2

� 0 � 30 � 20 � 20 � 20 � 20 � 30 � 30 � 30 � 30

� 30 � 20 � 60 � 30 � 60 � 30 � 0 � 0) � (0 � 30

Area � 0.5[(0 � 0 � 20 � 30 � 20 � 30 � 30 � 20

� (X1Y2 � X2Y3 � p � Xn�1Yn � XnY1)]

Area � 0.5[(X2Y1 � X3Y2 � p � XnYn�1 � X1Yn)

FIGURE A-16 Complex Shape

FIGURE A-17 Table for Coordinate Method

FIGURE A-18 Completed Table for Coordinate Method
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the previous row, and the resultant is entered in the second
row of the fourth column as shown in Figure A-18. This is
repeated for the third to the last rows. Next, the first and
fourth columns are added as shown in Figure A-18.

To find the area, the sum of the fourth column is sub-
tracted from the sum of the first column and the resultant
is divided by two. For the coordinates in Figures A-17 and
A-18, which correspond to the coordinates of Example A-15,
the area is calculated as follows:

This gives us the same area as was found in Example A-15.

VOLUMES
In addition to determining distances and areas, estimators
often must determine volumes. Most volumes are created by
extending a two-dimensional shape along a line perpendicu-
lar to the plane it occupies, as in the case of a cylinder (circle),
a column (a square or rectangle), or a prism (triangle), or
by extending the shape to a point, as is the case with a cone
or a pyramid. The basic volumetric shapes are shown in Fig-
ure A-19. The volumes of these shapes are calculated as follows.

Cylinder
The volume of a cylinder is calculated by multiplying the
area of a circle by the height of the cylinder, where the height
of the cylinder is measured perpendicular to the area of the
circle. The volume of a cylinder is calculated from the radius
by using the equation

(A-11)

or from the diameter, which is twice the radius, by using the
equation

Volume � �R2H

Area � 0.5(6,000 � 2,600) � 0.5(3,400) � 1,700 ft2

(A-12)

where

� 3.14159

R � Radius of the Circle

D � Diameter of the Circle

H � Height Measured Perpendicular to the Area of the
Circle

EXAMPLE A-16

Find the volume of a cylinder whose radius is 1 foot and height is
10 feet.

Solution: Using Eq. (A-11), we get

�

Column
The volume of a column is calculated by multiplying the
area of a rectangle by the height of the column, where the
height of the column is measured perpendicular to the area
of the rectangle. Remember, a square is a special case of a
rectangle in which L and W are equal. The volume of a rec-
tangular column is calculated from its length, width, and
height using the equation

(A-13)

where

L � Length

W � Width

H � Height Measured Perpendicular to the Area of the
Rectangle

Volume � LWH

Volume � �R2H � �(1 ft)2(10 feet) � 31.4 ft3

�

Volume �
�D2H

4

FIGURE A-19 Volumetric Shapes
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EXAMPLE A-17

Find the volume of a column whose height is 10 feet, length is 2
feet, and width is 1 foot.

Solution: Using Eq. (A-12), we get

�

Prism
The volume of a prism is calculated by multiplying the area
of a triangle by the length of the prism (length is used be-
cause height has already been used to describe the triangle),
where the length of the prism is measured perpendicular to
the area of the triangle. The volume of a prism is calculated
from its length, base, and height using the equation

(A-14)

where

H � Height Measured Perpendicular to the Base of the
Triangle

B � Base

L � Length Measured Perpendicular to the Area of the
Triangle

EXAMPLE A-18

Find the volume of a prism whose height is 5 feet, length is 20 feet,
and base is 3 feet.

Solution: Using Eq. (A-14), we get

�

Pyramids and Cones
For any volumetric shape that is created by extending the
shape to a point, such as a cone or pyramid, the volume is
one-third of the area of the base of the object times the
height of the object, where the height is measured per-
pendicular to the area. For a pyramid with a rectangular
base, the volume of the pyramid is calculated by using the
equation

(A-15)Volume �
LWH

3

Volume �
BHL

2
�

(3 ft)(5 ft)(20 ft)

2
� 150 ft3

Volume �
BHL

2

Volume � LWH � (2 ft)(1 ft)(10 ft) � 20 ft3

where

L � Length

W � Width

H � Height Measured Perpendicular to the Area of the
Rectangle

This is true for all of the pyramids shown in Figure A-20,
even though their points are at different locations.

EXAMPLE A-19

Find the volume of a pyramid whose height is 12 feet, length is 2 feet,
and width is 1 foot.

Solution: Using Eq. (A-15), we get

�

The volume of a cone is calculated from the radius
using the equation

(A-16)

or from the diameter using the equation

(A-17)

where

� 3.14159

R � Radius of the Circle

D � Diameter of the Circle

H � Height Measured Perpendicular to the Area of the
Circle

EXAMPLE A-20

Find the volume of a cone whose radius is 1 foot and height is 10 feet.

Solution: Using Eq. (A-16), we get

�

Volume of a Shape with a Constant Area
The volume of any shape with a constant area over a given
length is calculated by multiplying the cross-sectional area of

Volume �
�R2

3
�

�(1 ft)2(10 ft)

3
� 10.5 ft3

�

Volume �
�D2H

12

Volume �
�R2H

3

Volume �
LWH

3
�

(2 ft)(1 ft)(12 ft)

3
� 8 ft3

FIGURE A-20 Pyramids
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the shape by the length of the object over which the cross-
sectional is representative of the shape of the object, using
the equation

(A-18)

where

A � Cross-Sectional Area of the Shape Measured
Perpendicular to the Length

L � Length

The length should be measured along the centerline of the
shape, and the cross-sectional area should be measured
perpendicular to the centerline of the shape. When the cen-
terline of the shape forms a curved line, the volume is an
approximation.

EXAMPLE A-21

Find the volume of a curb and gutter whose cross-sectional area is
1.7 ft2 and whose length is 200 ft.

Solution: Using Eq. (A-18), we get

�

Complex Volumes
Like the areas of complex two-dimensional shapes, the
volumes of complex three-dimensional bodies can be cal-
culated by breaking the complex body into simpler shapes

Volume � AL � (1.7 ft2)(200 ft) � 340 ft3

Volume � AL

for which volume can be calculated. For example, the
complex volume created by a building excavation shown
in Figure A-21 can be divided into four pyramids (one at
each corner), four prisms (one along each side), and one
column (located in the center), as shown in Figure A-22.
The volume of the complex shape is calculated by deter-
mining the volumes for the pyramids, prisms, and column
and adding them together. Additional methods of approx-
imating the volume of complex bodies are discussed in
Chapter 16.

CONVERSION FACTORS
So far all of the example problems have been in the same
units, and we have not had to convert units. Typical unit
conversions are given in Table A-1.

The two most common mistakes when converting from
one set of units to another set of units are (1) using the
wrong conversion factor and (2) multiplying by the conver-
sion factor when one should be dividing or vice versa. The
best way to avoid these mistakes is to include the units in the
calculations and make sure the answer is in the correct units
by canceling out units.

FIGURE A-21 Complex Shape

FIGURE A-22 Complex Shape

TABLE A-1 Conversion Factors

Length Volume

1 mile � 5,280 feet (ft) 1 yd3 � 27 ft3

1 yard (yd) � 3 ft 1 ft3 � 1,728 in3

1 foot � 12 inches (in) 1 ft3 � 7.48 gallons

Area Weight

1 acre � 43,560 ft2 1 ton � 2,000 pounds (lb)

1 yd2 � 9 ft2 1 hundredweight (cwt) � 100 lb

1 ft2 � 144 in2 1 lb � 16 ounces (oz)
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EXAMPLE A-22

Convert 216 square inches into square feet.

Solution: To convert square inches to square feet, we need to di-
vide the square inches by 144 in2/ft2 as follows:

Two hundred and sixteen square inches equals 1.5 square feet. �

In Example A-22, had we tried to multiply by 144 in2/ft2,
we would have ended up with the following:

In this case the inches would not cancel out, leaving us
with in4/ft2 as the units for our answer, not the units we
wanted. Likewise, had we used the wrong conversion factor
and divided by 1,728 in3/ft3, we would have ended up with
the following:

In this case, the inches squared on the top reduce the
inches cubed on the bottom to inches, leaving us with ft3/in
for our units—not the answer we wanted. I cannot empha-
size this enough. Write your units down and cancel the units
out to make sure that your answer is in the units you want!

Dimensional Analysis
In dimensional analysis one writes the equation without the
numbers to make sure the units cancel out. This is useful for
checking your units without having all of the numbers,
which at times can be confusing. Dimensional analysis on
Example A-22 is done as follows:

Board Feet
Lumber, especially random lengths and finish lumber, are
often purchased by the board foot. A board foot (bft) is

in2 �
in2

(in2/ft2)
�

in2 � ft2

in2 � ft2

216 in2 �
216 in2

1,728 in3/ft3 � 0.125
in2 � ft3

in3 � 0.125
ft3

in

216 in2 � 216 in2 � 144
in2

ft2 � 31,104
in2 � in2

ft2 � 31,104
in4

ft2

216 in2 �
216 in2

144 in2
ˇ/̌ft2 � 1.5

in2 � ft2

in2 � 1.5 ft2

defined as the amount of wood contained in a 12-inch by
12-inch by 1-inch nominal board. Figure A-23 shows the de-
finition of a board foot. The nominal dimensions are the di-
mensions used to describe the board, for example, or

. For dimensional lumber, the actual dimensions are
always smaller than the nominal dimensions. A typi-
cally measures inches by inches. The units of
board feet are inches-feet-squared (in-ft2).

The number of board feet in a piece of lumber is calcu-
lated by using the equation

(A-19)

where the nominal thickness and the nominal width are
in inches.

EXAMPLE A-23

Find the number of board feet in a 10-foot long 

Solution: Using Eq. (A-19), we get

There are 6.67 board feet in a 10-foot-long �2 � 4.

�
(2 in)(4 in)(10 ft)

12 in/ft
� 6.67 in-ft2 � 6.67 bft

Board Feet �
(Thickness)(Width)(Lineal Feet)

12 in/ft

2 � 4.

Board Feet �
(Thickness)(Width)(Lineal Feet)

12 in>ft

3 1̌>̌21 1̌>̌2 2 � 4
2 � 12

2 � 4

FIGURE A-23 A Board Foot
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The following is a sample list of standardized job cost
codes for a commercial construction company along
with a list of typical items that would be included in

the cost code. The first two digits of each cost code correspond
to the divisions of the 2010 edition of the MasterFormat. The

last three digits are company specific and are used to collect
cost data in a way that matches the company’s individual work
practices. The cost codes should not be confused with the
numbering of the MasterFormat. For more information on
the MasterFormat visit www.csinet.org/MasterFormat.

SAMPLE JOB COST CODES

APPENDIX B

Code Description Typical Items

01-000 GENERAL REQUIREMENTS

01-300 Supervision Labor for supervision and supervisor’s truck and tools.

01-500 Temporary Utilities Temporary utility bills including electricity, water, sewer, natural gas,
garbage, and propane. Temporary electrical, sewer, water, and gas
lines and connection fees for temporary utilities.

01-510 Temporary Phone Phone bills including long-distance service, mobile phones, and
temporary phone lines.

01-520 Temporary Facilities Temporary office trailer, office furniture, copier, computers, fax
machine, telephone equipment, first aid supplies, and office supplies.

01-700 Cleanup Labor and supplies for general cleanup.

02-000 EXISTING CONDITIONS

02-400 Demolition Demolition of existing structures.

03-000 CONCRETE

03-200 Rebar Rebar materials used in the construction of building concrete and
masonry.

03-300 Footing and Foundation—Labor Labor, forms, ties, tie wire, equipment, and all other items (except
concrete, rebar, and concrete pump) needed to pour footings and
foundations for buildings.

03-310 Footing and Foundation—Concrete Concrete to pour footings and foundations for buildings.

03-320 Slab/Floor—Labor Labor, forms, ties, tie wire, equipment, and all other items (except
concrete, rebar, and concrete pump) needed to pour building slabs
and floors.

03-330 Slab/Floor—Concrete Concrete to pour building slabs and floors.

03-340 Concrete Pump Concrete pump for placement of building concrete.

www.csinet.org/MasterFormat
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03-400 Pre-cast Concrete Pre-cast concrete used in buildings.

03-500 Light-weight Concrete Light-weight concrete and gypcrete.

04-000 MASONRY

04-200 Masonry Concrete Masonry Unit (CMU) and face brick used in buildings.

05-000 METALS

05-100 Structural Steel Structural steel materials including beams, girders, columns,
lintels (not provided by mason), bracing, and bolts through the
structural steel. Excludes installation and bolts not through the
structural steel.

05-200 Joist and Deck Steel open web joists and metal deck. Excludes installation.

05-500 Metal Fabrications Stairs, handrail, decorative steel, pipe bollards, and other
nonstructural steel. Excludes installation.

05-900 Erection Installation of structural steel, joist, deck, and metal fabrications,
including equipment and welding supplies. Excludes installation of
embeds.

06-000 WOOD, PLASTICS, AND COMPOSITES

06-100 Rough Carpentry Labor, nails, and equipment to install wood framing.

06-110 Lumber Rough carpentry materials including lumber, engineered lumber
(glue-laminated beams, wood I-joists, and so forth), wood siding,
framing hardware, bolts, fasteners, and sill seal. Excludes nails.

06-120 Trusses Pre-manufactured wood trusses.

06-200 Finish Carpentry Labor, nails, and equipment to install metal doors, wood doors,
hardware, wood trim, bathroom accessories, fire extinguishers
and cabinets, and roof specialties when not installed by their
suppliers.

06-210 Wood Trim Wood trim, including base, casing, chair rail, and crown molding.

06-400 Cabinetry and Countertops Furnish and install cabinetry and, if included in the bid,
countertops.

06-410 Countertops Furnish and install countertops when not included with cabinetry
bid.

07-000 THERMAL AND MOISTURE PROTECTION

07-100 Waterproofing Furnish and install waterproofing, dampproofing, and drain board.

07-200 Insulation Furnish and install batt and blown insulation.

07-210 Ridged Insulation Furnish and install ridged insulation.

07-220 Stucco Furnish and install synthetic stucco and Exterior Insulation and
Finish System (EIFS).

07-400 Siding Furnish and install vinyl and aluminum siding, soffit, and fascia.

07-500 Roofing Furnish and install asphalt, metal, built-up, and membrane roofing
including metal trim, asphalt-impregnated felt, ice and water shield,
and flashing not provided by other subcontractors. Install flashings
provided by other subcontractors.

07-600 Sheet Metal Furnish and install flashing (excluding roof flashings) and general
sheet metal.

07-700 Roof Specialties Furnish roof hatches, walkways, skylights, and so forth. May include
installation.

07-710 Rain Gutters Furnish and install rain gutters and down spouts.

07-800 Fireproofing Furnish and install fire caulk and fire collars not provided by other
subcontractors.

07-900 Caulking and Sealants Furnish and install caulking not provided by other subcontractors.
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08-000 OPENINGS

08-100 Metal Doors and Frames Furnish hollow-metal doors and frames.

08-110 Wood Doors Furnish wood doors, wood frames, and prehung residential-grade
doors. Prehung doors include butts and thresholds.

08-300 Overhead Doors Furnish and install sectional and coiling overhead doors and coiling
grilles including all necessary hardware.

08-400 Storefronts Furnish and install glass and aluminum storefronts including all
necessary hardware (cylinders by hardware supplier).

08-500 Windows Vinyl, vinyl-clad, wood, aluminum, and aluminum-clad residential
windows.

08-700 Hardware Furnish hardware for hollow-metal and wood doors and cylinders
for storefront doors.

08-800 Glass and Glazing Furnish and install glazing in hollow-metal doors, wood doors, and
window frames.

09-000 FINISHES

09-200 Drywall Furnish and install drywall, drywall draft stops, and, if included in
the bid, nonstructural metal studs.

09-210 Metal Studs Furnish and install nonstructural metal studs, if not included with
drywall bid.

09-300 Ceramic Tile Furnish and install ceramic tile and marble.

09-500 Acoustical Ceilings Furnish and install acoustical ceiling with grid.

09-600 Flooring Furnish and install carpet, vinyl, vinyl composition tile (VCT), wood
flooring, laminate flooring, and rubber base.

09-700 Wall Coverings Furnish and install fabric and paper wall coverings.

09-900 Paint Furnish and install paints and stains for walls, ceilings, floors, doors,
and trim.

10-000 SPECIALTIES

10-100 Signage Furnish and install interior building signage including room numbers,
bathroom signage, Americans with Disabilities Act (ADA) insignias,
and building directories.

10-200 Toilet Partitions Furnish and install toilet partitions and screens.

10-210 Toilet and Bath Accessories Furnish and install toilet and bath accessories, including toilet paper
holders, soap dispensers, paper towel dispensers, built-in waste
receptacles, sanitary napkin dispensers, sanitary napkin disposal
receptacles, baby changing stations, mirrors, shower enclosures, and
medicine cabinets.

10-400 Fire Extinguishers and Cabinets Furnish and install fire extinguishers and fire extinguisher cabinets.

11-000 EQUIPMENT

11-300 Appliances Residential appliances, including dishwashers, ranges, cooktops,
ovens, refrigerators, ice makers, washers, and dryers.

12-000 FURNISHINGS

12-200 Window Treatments Furnish and install blinds and curtains.

14-000 CONVEYING EQUIPMENT

14-200 Elevators Furnish and install elevators, including excavation for hydraulic
ram.

21-000 FIRE SUPPRESSION

21-100 Fire Sprinklers Furnish and install fire sprinkler systems.
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22-000 PLUMBING

22-100 Plumbing Furnish and install building water supply and sanitary sewer systems
to five feet outside the building, plumbing fixtures and garbage
disposals. Provide flashing for plumbing roof penetrations.

23-000 HEATING, VENTILATION,
AND AIR-CONDITIONING

23-100 HVAC Furnish and install heating, ventilation, and air-conditioning
systems. Provide flashing for HVAC roof penetrations.

26-000 ELECTRICAL

26-100 Electrical Furnish and install electrical, including power, lighting, and control
systems. Provide flashing for electrical roof penetrations.

27-000 COMMUNICATIONS

27-100 Communications Furnish and install communication (telephone and data). Provide
flashing for communication roof penetrations.

31-000 EARTHWORK

31-100 Clearing and Grubbing Clearing and grubbing of site.

31-200 Grading and Excavation Mass excavation and rough grading of site, including import or
export of soils. Excavation, backfill, and import or export of soils for
structures.

32-000 EXTERIOR IMPROVEMENTS

32-100 Asphalt Furnish and install asphalt pavement, slurry seals, base under
asphalt, prime coat, and tack coat.

32-110 Site Concrete—Labor Labor, forms, ties, tie wire, equipment, and all other items (except
concrete and rebar) needed to pour site concrete, including
sidewalks, driveways, curbs, gutters, waterways, and slabs outside
the building.

32-120 Site Concrete—Concrete Concrete to pour site concrete, including sidewalks, driveways, curbs,
gutters, waterways, and slabs outside the building.

32-130 Rebar Rebar materials used in the construction of site concrete and
retaining walls.

32-300 Fencing Chain link, masonry (including footings), wood, ornamental steel,
and vinyl fencing, including gates.

32-310 Retaining Walls Furnish and install reinforced concrete (excluding rebar materials),
block, or rock retaining walls, including footings.

32-320 Dumpster Enclosures Furnish and install dumpster enclosures, including footings and
foundation, block wall, cap, and gates.

32-330 Signage Furnish and install traffic signs, permanent project signs, and
monuments.

32-340 Outside Lighting1 Furnish and install lighting mounted on poles and buildings to
illuminate the site, including underground wiring.

32-900 Landscaping Finish grading. Top soil import and placement. Furnish and install
irrigation (sprinkler) systems, plants (trees, shrubs, bushes, and
ground cover), sod, and bark.

33-000 UTILITIES

33-100 Water Line Furnish and install site culinary water lines beginning five feet
outside the perimeter of the building, including gravel and bedding
materials.

1Site lighting is placed here instead of Division 26000 to keep building costs separate from site costs.
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33-300 Sanitary Sewer Furnish and install site sanitary sewer lines beginning five feet
outside the perimeter of the building, including gravel and bedding
materials.

33-400 Storm Drain Furnish and install storm drain, including gravel and bedding
materials.

33-500 Gas Lines Furnish and install site natural gas lines beginning at the low-
pressure side of the gas meter, including any fees charged by the
natural gas provider.

33-700 Power Lines Furnish and install electrical power lines to the meter base, including
transformers located outside the building and any fees charged by
the electrical power provider.

33-800 Telephone Lines Furnish and install phone lines to the building, including any fees
charged by the telephone company.



Sample labor productivity rates are shown in the fol-
lowing table. These rates are for use in classroom
exercises and are based on a review of a number of

published productivity rates and personal experience.
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SAMPLE LABOR

PRODUCTIVITY RATES

Where possible, estimators should use productivity rates
based on the company’s past performance. When this data is
not available, the estimator should consult a current, more
detailed source of productivity rates.

Item Productivity

03-000 CONCRETE

0.13–0.20 lhr/sfca Forms, columns, square to

0.06–0.09 lhr/lft Forms, footings, high

0.09–0.15 lhr/sfca Forms, walls

0.20–0.30 lhr/ea Rebar, continuous horizontal, to #6

0.05–0.07 lhr/ea Rebar, dowel, to #6

0.08–0.13 lhr/ea Rebar, ring tie

0.12–0.20 lhr/ea Rebar, vertical, to high, to #6

0.05–0.10 lhr/ea Anchor bolt

0.25–0.50 lhr/ea Embed

0.40–0.60 lhr/cyd Concrete placement, columns

0.40–0.50 lhr/cyd Concrete placement, continuous footings

0.40–0.60 lhr/cyd Concrete placement, slabs

0.60–1.00 lhr/cyd Concrete placement, spot footings

0.50–0.70 lhr/cyd Concrete placement, walls

0.010–0.015 lhr/sft Concrete finishing

04-000 MASONRY

0.09–0.14 lhr/sft Concrete masonry unit, including rebar

0.16–0.20 lhr/sft Brick facing

05-000 METALS

0.07–0.10 lhr/lft Steel beams

0.90–1.20 lhr/ea Steel columns

12¿

20¿

2 � 12–
24– � 24–
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0.04–0.07 lhr/lft Steel joists

0.007–0.014 lhr/sft Metal deck

06-000 WOODS, PLASTICS, AND COMPOSITES

0.03–0.04 lhr/ft Blocking

0.60–1.00 lhr/ea Columns

0.04–0.06 lhr/lft Fascia

1.0–1.5 lhr/ea Girders and beams, to long

0.015–0.019 lhr/lft Joists

0.02–0.04 lhr/lft Rafters

0.011–0.016 lhr/sft Sheathing

0.02–0.05 lhr/lft Sills and ledgers

0.04–0.06 lhr/sft Soffit

0.60–1.00 lhr/ea Trusses, to span

0.13–0.16 lhr/lft Walls, O.C., to high

0.25–0.50 lhr/ea Add for door opening

0.50–0.75 lhr/ea Add for window opening

0.015–0.040 lhr/lft Trim

0.60–1.00 lhr/ea Cabinetry

0.25–0.33 lhr/lft Countertops, plastic laminate

07-000 THERMAL AND MOISTURE PROTECTION

0.20–0.40 lhr/squ Building paper

0.005–0.008 lhr/sft Insulation—batt

0.010–0.016 lhr/sft Insulation—blown

0.05–0.06 lhr/sft Exterior Insulation and Finish System

1.4–2.2 lhr/squ Shingles, asphalt

0.04–0.05 lhr/sft Fascia, aluminum or vinyl

0.04–0.06 lhr/lft Fascia, wood

0.03–0.04 lhr/sft Siding, aluminum or vinyl

0.020–0.035 lhr/sft Siding, wood board

0.011–0.025 lhr/sft Siding, wood sheet

0.04–0.05 lhr/sft Soffit, aluminum or vinyl

0.04–0.06 lhr/sft Soffit, wood

0.010–0.015 lhr/sft Membrane roofing

0.02–0.03 lhr/lft Sheet metal, drip edge

0.04–0.08 lhr/lft Sheet metal, flashings

3.0–5.0 lhr/ea Roof hatch

08-000 OPENINGS

2.0–4.0 lhr/ea Doors, commercial exterior

1.0–2.5 lhr/ea Doors, commercial interior

1.0–2.0 lhr/ea Doors, residential exterior

0.5–1.0 lhr/ea Doors, residential interior

2.0–4.0 lhr/ea Sectional overhead door

1.0–1.5 lhr/ea Add for opener

0.5–1.0 lhr/ea Add for keyless entry

0.10–0.16 lhr/sft Storefront

10¿16–
40¿

20¿
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0.8–1.0 lhr/ea Windows—residential

0.5–1.0 lhr/ea Hardware, lockset or deadbolt

1.0–2.0 lhr/ea Hardware, panic

0.20–0.40 lhr/ea Hardware, stop

0.40–0.70 lhr/ea Hardware, threshold

1.0–1.50 lhr/ea Hardware, weather stripping

09-000 FINISHES

0.018–0.020 lhr/sft Metal stud wall

0.015–0.020 lhr/sft Drywall, taped and finished

0.08–0.11 lhr/sft Ceramic tile

0.020–0.035 lhr/sft Suspended acoustical ceilings

0.04–0.08 lhr/sft Wood and laminate floors

0.03–0.04 lhr/sft Sheet vinyl

0.015–0.020 lhr/sft Vinyl composition tile

0.25–0.30 lhr/lft Rubber base

0.14–0.17 lhr/syd Carpet and pad

0.004–0.007 lhr/sft Paint, walls, sprayed, per coat

0.006–0.010 lhr/sft Paint, walls, rolled, per coat

0.008–0.015 lhr/lft Paint, trim, brushed, per coat

0.5–1.0 lhr/ea Paint, doors, brushed, per coat

10-000 SPECIALTIES

0.33–0.50 lhr/ea Door signs

0.33–0.67 lhr/ea Grab bar

0.50–1.00 lhr/ea Mirror

0.50–1.00 lhr/ea Paper towel dispenser

3.0–4.0 lhr/ea Shower surround

0.25–0.50 lhr/ea Toilet paper holder

0.25–0.50 lhr/ea Towel bar

2.00–3.00 lhr/ea Fire extinguisher cabinet

21-000 FIRE SUPPRESSION

0.12–0.20 lhr/ft Fire sprinkler, to pipe, includes hangars

0.20–0.25 lhr/ft Fire sprinkler, pipe, includes hangars

0.28–0.32 lhr/ft Fire sprinkler, pipe, includes hangars

0.32–0.38 lhr/ft Fire sprinkler, pipe, includes hangars

0.14–0.33 lhr/ea Fire sprinkler, to fitting

0.33–0.50 lhr/ea Fire sprinkler, fitting

0.40–0.60 lhr/ea Fire sprinkler, fitting

0.50–0.75 lhr/ea Fire sprinkler, fitting

0.50–0.80 lhr/ea Fire sprinklers, sprinkler head and drop

3.0–4.0 lhr/ea Fire sprinklers, standpipe

24–32 lhr/ea Fire sprinklers, valve assembly

22-000 PLUMBING

0.8–1.0 lhr/ea Clean–outs

4.0–5.0 lhr/ea Drinking fountain, rough in supply and waste

2.0–2.5 lhr/ea Drinking fountain, finish

3–
2.5–
2–

1.5–
3–
2.5–
2–

1.5–



1.0–1.5 lhr/ea Floor drain

8.0–10.0 lhr/ea Kitchen sink, rough in supply and waste

2.5–3.5 lhr/ea Kitchen sink, finish

6.0–8.0 lhr/ea Lavatory, rough in supply and waste

2.5–3.0 lhr/ea Lavatory, finish

3.0–4.0 lhr/ea Roof drain, including wye

7.0–8.0 lhr/ea Shower, rough in supply and waste

6.0–8.0 lhr/ea Shower, finish, including shower door

7.0–8.0 lhr/ea Tub, rough in supply and waste

2.5–4.0 lhr/ea Tub, finish

6.0–8.0 lhr/ea Urinal, rough in supply and waste

5.0–6.0 lhr/ea Urinal, finish

0.5–1.0 lhr/ea Valve, to

6.0–8.0 lhr/ea Water closet, rough in supply and waste

3.0–3.5 lhr/ea Water closet, finish

4.0–6.0 lhr/ea Water heater

23-000 HVAC

0.10–0.13 lhr/lft Duct, to 12� � 24�

0.12–0.15 lhr/lft Duct, 12� � 30�

0.05–0.06 lhr/lft Duct, 4�-diameter vent pipe

0.05–0.06 lhr/lft Duct, 6� diameter

0.09–0.10 lhr/lft Duct, 9�diameter

0.13–0.15 lhr/lft Duct, 12�diameter

0.05–0.07 lhr/lft Duct, 16�-wide sheet metal nailed to joists

0.10–0.15 lhr/ea Duct, tee, elbow, transition, or cap, to 12� diameter

0.10–0.15 lhr/ea Duct, tee, elbow, transition, or cap, to 12� � 12�

0.15–0.20 lhr/ea Duct, tee, elbow, transition, or cap, 24� � 12�

0.85–1.00 lhr/ea Diffuser, including drop

6.0–8.0 lhr/ea Furnace and air conditioner, residential, includes plenum

20–26 lhr/ea Package unit

0.30–0.50 lhr/ea Register, including boot or 90-degree elbow

0.30–0.50 lhr/ea Return air grill

1.0–1.5 lhr/ea Thermostat

26-000 ELECTRICAL

0.08–0.10 lhr/lft Conduit, to1�, including fittings

0.40–0.60 lhr/ea Junction or metal box

1.5–2.5 lhr/ea Light fixtures, commercial

0.5–1.0 lhr/ea Light fixtures, residential, including wiring

0.20–0.30 lhr/ea Outlet, commercial

0.40–0.60 lhr/ea Outlet, residential, 110v, including wiring

1.0–2.0 lhr/ea Outlet, residential, 220v, including wiring

8.0–14.0 lhr/ea Panel, commercial

6.0–8.0 lhr/ea Panel, residential

0.20–0.30 lhr/ea Switches, commercial

0.40–0.60 lhr/ea Switches, residential, including wiring

0.02–0.03 lhr/lft Wiring, commercial

2–
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27-000 COMMUNICATION

0.08–0.10 lhr/lft Conduit, to 1�, including fittings

0.40–0.60 lhr/ea Junction or metal box

0.40–0.60 lhr/ea Phone jack, including wiring

0.40–0.60 lhr/ea Television jack, including wiring

31–000 EARTHWORK

0.08–0.10 lhr/cyd Excavation, machine

0.08–0.10 lhr/cyd Footings excavation, hydraulic excavator

0.15–0.20 lhr/cyd Place and compact

0.02–0.03 lhr/sft Rough grading

32-000 EXTERIOR IMPROVEMENTS

0.15–0.20 lhr/cyd Road base, place and compact

0.02–0.03 lhr/sft Asphalt

0.06–0.09 lhr/lft Forms, to 12� high

0.09–0.15 lhr/sfca Forms, 13�to 24� high

15–16 lhr/ton Rebar placement

0.40–0.50 lhr/cyd Concrete placement, curb and gutter

0.40–0.60 lhr/cyd Concrete placement, slab

0.010–0.015 lhr/sft Concrete finishing

0.02–0.03 lhr/sft Finish grade

0.005–0.008 lhr/sft Sod

33-000 UTILITIES

0.15–0.20 lhr/cyd Backfill

0.15–0.20 lhr/cyd Bedding

5.0–7.0 lhr/ea Catch basin

1.0–2.0 lhr/ea Connection to existing manhole or box

0.15–0.20 lhr/lft Pipe, to 4�

0.08–0.10 lhr/cyd Trench excavation, hydraulic excavator

ABBREVIATIONS

ea � each

lft � linear feet

sfca � square-foot contact area

sft � square foot

squ � square (100 ft2)

syd � square yard
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The following are sample scopes of work for multiuse
developments (which includes commercial build-
ings, single-family homes, and twin homes) that

may be used as model scopes of work for other projects. Not
all provisions in these scopes of work will apply to all pro-
jects, and some projects will need additional provisions.

FOOTINGS AND
FOUNDATIONS
Provide all labor, materials, equipment, tools, and supervi-
sion required to furnish and install all footings and founda-
tions and all appurtenances required for a complete installa-
tion in accordance with the contract documents, applicable
codes, and governing agencies. The work includes, but is not
limited to, the following:

1. Installation of all footings, foundations, concrete walls,
and concrete columns

2. Installation of all embeds, anchor bolts, and sleeves,
hold-downs, and post bases that are to be cast in place.
The subcontractor shall supply anchor bolts, hold-
downs, and post bases. Imbeds and sleeves to be pro-
vided by others.

3. Installation of all structural steel anchor bolts that are
installed in the concrete footings, foundations, and
columns. Construct plywood templates as required for
proper bolt placement and alignment. All structural
steel anchor bolts to be provided by others.

4. The subcontractor is to provide window bucks.

5. The subcontractor shall protect all concrete at all times
during installation from weather damage, vandalism,
and all other destructive elements.

6. The subcontractor shall provide layout for the work
contained in this contract.

7. Concrete and rebar is to be provided by the contractor
and installed by the subcontractor.

8. The subcontractor shall ensure that only approved con-
crete mixes from approved suppliers are poured. The
subcontractor shall obtain a list of approved concrete
mixes and suppliers from the project superintendent.

9. Concrete pumping is excluded. The contractor shall pay
for any required concrete pumping. The subcontractor
shall obtain approval to pump concrete prior to doing
so. If the subcontractor fails to obtain approval prior to
pumping concrete, the subcontractor shall pay for the
cost of pumping the concrete.

10. All concrete placed under this contract shall be installed
to avoid thin edges and voids.

11. Any concrete rejected by the owner, contractor, or
building inspector, or concrete that is rejected because
of failure to meet specified strength, shall be replaced by
the subcontractor at its sole expense.

FRAMING
Provide all labor, equipment, tools, and supervision required
to furnish and install all framing and all appurtenances re-
quired for a complete installation in accordance with the
contract documents, applicable codes, and governing agen-
cies. The work includes, but is not limited to, the following:

1. The subcontractor shall install all rough carpentry
members, including, but not limited to, sills, studs,
plates, sleepers, columns, posts, beams, girders, floor
joists, header joists, stringers, risers, treads, trimmers,
backing, headers, blocking, lintels, bridging, firestop-
ping, rafters, purlins, trusses, floor sheathing, wall
sheathing, roof sheathing, and drops.

2. The subcontractor shall install all exterior drywall, all dry-
wall sandwiched between wood walls, and all Fiberbond.

MODEL SCOPES
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3. The subcontractor shall install all framing hardware, in-
cluding but not limited to, nails, shots, pins, expansion
bolts, machine bolts, lag screws, post-to-beam connec-
tions, joist and beam hinges, and straps.

4. The subcontractor shall provide all nails required for
the completion of this contract. All other framing hard-
ware is to be provided by the contractor.

5. The subcontractor shall install all exterior doors, sliding
glass doors, and windows. All doors and windows shall
be hung true and plumb. Windows that line up shall be
hung such that the vertical and horizontal lines are
straight and true. Doors shall be hung such that they do
not bind or swing open or closed by themselves.

6. The subcontractor shall furnish the forklift and/or
crane for use in transporting and placing materials in-
stalled as a part of this contract.

7. The subcontractor shall furnish all tools, saws, cords,
and miscellaneous equipment required for the comple-
tion of this contract.

8. Contractor shall supply temporary power for the sub-
contractor.

9. The subcontractor shall coordinate with the project su-
perintendent to:

a. ensure that correct material sizes and quantities are
ordered;

b. ensure prompt and timely material deliveries;

c. coordinate material distribution and storage;

d. coordinate installation procedures with other trades;

e. set up and maintain inventory control for receiving
and distributing materials;

f. spot-check rough openings and backing requirements.

FINISH CARPENTRY
Provide all labor, materials, equipment, tools, and supervi-
sion required to furnish and install all finish carpentry and
all appurtenances required for a complete installation in ac-
cordance with the contract documents, applicable codes,
and governing agencies. The work includes, but is not lim-
ited to, the following:

1. Installation of all interior doors. All doors shall be hung
true and plumb. Doors shall be hung such that they do
not bind or swing open or closed by themselves.

2. Installation of mirrored wardrobe doors and associated
hardware.

3. Installation of all interior trim, including, but not lim-
ited to, base, casing, chair rail, crown mold, wood
handrail, wood guardrail, and window seats.

4. Installation of fireplace mantels.

5. Installation of wood closet shelving and rods with asso-
ciated hardware.

6. Installation of door hardware and door viewers.

7. Installation of house numbers.

8. Installation of windowsills.

9. Installation of bath hardware, including, but not limited
to, medicine cabinets, grab bars, towel bars, towel rings,
toilet paper holders, and shower rods. All bath hardware
shall be fastened into wood backing or installed with
molly bolts.

10. The subcontractor is to provide nails, shims, and glue.
All other materials are to be provided by others.

11. The subcontractor shall coordinate the location of re-
quired backing with the project superintendent and the
framing subcontractor.

DRYWALL
Provide all labor, materials, equipment, tools, and supervi-
sion required to furnish and install all drywall and all appur-
tenances required for a complete installation in accordance
with the contract documents, applicable codes, and gov-
erning agencies. The work includes, but is not limited to,
the following:

1. Provide and install all interior drywall and associated
components, including, but not limited to, all trim, acces-
sories, corner and edge trims, and reveals as required by
the contract documents and required for a complete job.

2. Provide and install fire walls and draft stops as shown
on the contract documents.

3. Provide and install fire-rated and moisture-resistant
board and compounds where required by code and the
contract documents.

4. Furnish and install all rated enclosures, chases, soffits,
shafts, and so forth for plumbing, electrical, HVAC
ducting and piping, elevators, and other items as re-
quired by the contract documents.

5. The subcontractor shall pre-rock rated enclosures,
chases, soffits, shafts, behind the tub, furnace rooms, and
so forth prior to rough plumbing, rough HVAC, and
rough electrical as directed by the project superintendent.

6. All walls and ceilings are to be taped and textured and
ready for paint or wall coverings.

7. The subcontractor is to provide a complete drywall fin-
ish in the furnace room.

8. The subcontractor is to provide a complete drywall fin-
ish in the garage.

9. Materials shall be stocked by the subcontractor at right
angles to the floor trusses/joists and distributed so the
materials’ weight will not concentrate in any areas that
may cause damage to the structure.

10. The subcontractor shall not cover any areas that require
insulation prior to installation of insulation and will at
all times advise the project superintendent of any defi-
ciencies in the insulation.

11. All drywall shall be screwed into place.

12. The subcontractor shall patch around openings of
pipes, ductwork, electrical, and other openings in a
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workmanlike manner. Patches in fire-rated walls shall
comply with the applicable fire and building codes.

13. All vertical and horizontal external corners shall be rein-
forced with corner bead trim applied in strict accor-
dance with the manufacturer’s recommendations.
Vertical corners shall be straight and plumb. Horizontal
corners shall be straight and level.

14. Joints and screw depressions shall be invisible to the
naked eye when surface is painted. The subcontractor
shall verify that no shadows occur at joints by shining a
lamp on the face of the finished surface to check for
shadows and bad joints.

15. After the initial coat of primer has been applied, the
subcontractor shall touch up all areas for screw pops,
shadows, rough paper, faulty areas, and areas unaccept-
able to the contractor.

16. Care shall be taken and exercised to minimize dropping
joint compound on other surfaces. Droppings shall be
scraped loose before they set up in all areas, including
closets.

17. The subcontractor shall be responsible for the disposal
of all drywall scrap materials. The subcontractor shall
not dispose of drywall scrap materials in the dumpster
supplied by the contractor.

18. Exterior drywall and drywall between the wood framing
of the party walls are excluded from this subcontract.

FLOOR COVERINGS
Provide all labor, materials, equipment, tools, and supervision
required to furnish and install all floor coverings and all appur-
tenances required for a complete installation in accordance with
the contract documents, applicable codes, and governing agen-
cies. The work includes, but is not limited to, the following:

1. Furnish and install all resilient flooring, including sheet
vinyl and vinyl tile.

2. Furnish and install all carpeting.

3. Furnish and install all rubber base.

4. Furnish and install all underlayment.

5. Furnish and install trim metal where carpet or vinyl
meets other flooring materials or the tub.

6. The subcontractor shall prepare and submit seam dia-
grams for the contractor’s review. Installation of carpet
shall strictly follow the approved seaming diagram.

7. The subcontractor shall not combine different lots of
materials within a home or building. This applies to
both carpet and vinyl materials.

8. The subcontractor shall sweep the floors prior to instal-
lation of carpet or vinyl.

9. The subcontractor shall be responsible for any minor
float leveling (1/4 inch or less) that may be necessary
prior to the installation of floor coverings. The subcon-
tractor shall provide and install all items as required for
floor preparation.

10. The subcontractor shall caulk the trim metal to the tub.

11. The subcontractor shall rehang doors after installing
flooring.

PAINTING AND STAINING
Provide all labor, materials, equipment, tools, and supervi-
sion required to furnish and install all painting and staining
and all appurtenances required for a complete installation in
accordance with the contract documents, applicable codes,
and governing agencies. The work includes, but is not lim-
ited to, the following:

1. Furnish and install all paint and stain for the walls, ceil-
ings, doors, interior handrails, interior guardrails, and
interior trim.

2. Prime and seal under wall coverings.

3. Furnish and install concrete floor sealer to interior con-
crete floors as listed on the finish schedule.

4. Furnish and install all painting required to paint the
garage and furnace/utility room.

5. Furnish and install all painting required to paint the ex-
terior wood siding, trim, soffit, and fascia.

6. Furnish and install all painting required to paint the
shutters.

7. Furnish and install all painting required to paint the ex-
terior stairs, stair treads, stair stringers, railings, and
handrails.

8. Furnish and install all painting required to paint the
power meters, gas meters, telephone boxes, cable TV
boxes, and disconnects.

9. Furnish and install all painting required to paint the
vents, roof vents, and roof flashings to match the roof.
The said items are to receive one coat of zinc chromate
primer where needed and one coat of paint.

10. Seal and finish the exposed edges of all metal and wood
doors including the top and bottom when they are visi-
ble from stairs, balconies, and so forth.

11. Paint shall be applied to all drywall surfaces by roller.

12. All surfaces of building components (which are installed
by others) shall be inspected and accepted by the paint
subcontractor prior to start of any work. Application of
subcontractor’s work shall constitute acceptance.

13. Mask, protect, and cover surfaces and items that do not
receive paint, including, but not limited to, door hinges,
fire-rating labels, exposed concrete and masonry, fix-
tures, furnaces, equipment, and so forth.

14. Properly clean and prepare all surfaces before applying
all material and finishes.

15. Fill gouges, fill nicks, fill nail holes, caulk joints, and pre-
pare all surfaces, including spot priming, before pro-
ceeding with the work.

16. The subcontractor shall rehang doors after painting.

17. The subcontractor is to include touch-up of paint and
finishes prior to owner’s walkthrough as required by
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normal damage, splatters, and marring caused by the
process of construction work. Touch-up is to include
minor drywall patching. This touch-up is in addition to
the touch-up that occurs after the owner’s walkthrough.

18. The subcontractor is to include four hours of touch-up
per residence for touch-up after the owner’s walk-
through. This touch-up is in addition to the touch-up
that occurs before the owner’s walkthrough.

FIRE SPRINKLERS
Provide all labor, materials, equipment, tools, and supervi-
sion required to furnish and install all fire sprinklers and all
appurtenances required for a complete installation in accor-
dance with the contract documents, applicable codes, and
governing agencies. The work includes, but is not limited to,
the following:

1. Furnish and install all piping, fittings, heads, supports,
seismic bracing, anchors, backflow preventer stations,
post indicator valves, fire sprinkler risers, fire depart-
ment connections, supervisory tamper/flow switches,
alarm bell/gong, roof manifold, and so forth.

2. The subcontractor shall be responsible for the design
and adequacy of the fire sprinkling system. The subcon-
tract price includes obtaining approved design draw-
ings, professional engineer’s certification or stamp, and
related permit from the local municipality.

3. The subcontractor shall provide trenching, backfill, pip-
ing, fittings, and connections to 5 feet outside the build-
ing line. Site utilities are provided by others.

4. Furnish and install all access doors required for the fire
sprinkling system.

5. Install all heads in the center of the ceiling tiles.

6. Provide all testing, flushing, and so forth required to
comply with the fire marshal’s requirements.

7. The subcontractor shall furnish and install fire stops,
fire-retardant compound, and/or safing to seal all of
the subcontractor’s penetrations through fire-rated
assemblies.

8. The construction of the fire sprinkling system shall
closely follow the construction of the building and shall
be placed in service as soon as applicable laws permit
following completion of each story.

PLUMBING
Provide all labor, materials, equipment, tools, and supervi-
sion required to furnish and install all plumbing and all
appurtenances required for a complete installation in ac-
cordance with the contract documents, applicable codes,
and governing agencies. The work includes, but is not lim-
ited to, the following:

1. Furnish and install all fixtures and piping, including,
but not limited to, water heater, water softener, toilets,

sinks, vanities, shower pans, tubs, washer hookups, ice-
maker boxes, faucets, floor drains, hose bibs, drain pip-
ing, vent piping, and supply piping.

2. The subcontractor shall provide a floor drain by laun-
dry facilities and water heaters.

3. The subcontractor is to connect the water heater to the
gas line. The gas line is to be provided by others.

4. The subcontractor is to connect the dishwasher to the
plumbing.

5. The subcontractor shall provide all trenching required
for their work.

6. The subcontractor shall provide all block-outs and
sleeves through floors, walls, and ceilings required for its
work.

7. The subcontractor shall coordinate with the framing
subcontractor for the location and size of all required
backing for the plumbing fixtures.

8. The subcontractor shall furnish and install fire stops, fire-
retardant compound, and/or safing to seal all of the sub-
contractor’s penetrations through fire-rated assemblies.

9. The subcontractor shall furnish all pipe flashings and
sheet metal jacks for its work. Pipe flashings and sheet
metal jacks are to be installed by others.

HVAC
Provide all labor, materials, equipment, tools, and supervi-
sion required to furnish and install all HVAC and all appur-
tenances required for a complete installation in accordance
with the contract documents, applicable codes, and govern-
ing agencies. The work includes, but is not limited to, the
following:

1. Furnish and install all equipment required to complete
the HVAC system, including, but not limited to, furnace,
fan coil, and condenser.

2. Furnish and install all required ducting, including, but
not limited to, ducting, supply registers, return-air
grilles, combustion air ducting, and weather caps.

3. Furnish and install smoke and fire dampers as required
by code and by the contract documents.

4. Furnish and install ducting for clothes dryers.

5. Furnish and install ducting to all exhaust fans. The ex-
haust fans are provided and installed by the electrician.

6. Furnish and install a setback thermostat and all re-
quired low-voltage wiring. Provide temporary ther-
mostats for use during construction.

7. The subcontractor is to connect electrical power to fur-
nace and air-conditioning units from the outlet box or
disconnect provided by others.

8. Furnish and install all refrigerant lines. Provide protec-
tion from nail punchers for all lines.

9. Furnish and install all condensate drain lines and piping
for all mechanical equipment.
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10. Furnish and install all natural gas lines including gas
line service to gas ranges, gas dryers, gas fireplaces, and
water heaters.

11. The subcontractor is to connect gas dryers and gas
ranges to gas lines after appliance installation.

12. Connect water heater to gas lines. Water heater to be
provided by others.

13. The subcontractor shall furnish all pipe flashings and
sheet metal jacks for its work. Pipe flashings and sheet
metal jacks are to be installed by others.

14. The subcontractor shall provide all block-outs and sleeves
through floors, walls, and ceilings required for its work.

15. The subcontractor shall coordinate with the framing
subcontractor for location and size of all required back-
ing for the HVAC.

16. The subcontractor shall furnish and install fire stops, fire-
retardant compound, and safing to seal all of the subcon-
tractor’s penetrations through fire-rated assemblies.

17. The subcontractor shall work with the contractor to
provide an early operation of the furnace to be used as
temporary heat in the building.

18. The subcontractor shall replace all furnace filters just
prior to the building being turned over to the owner.

ELECTRICAL
Provide all labor, materials, equipment, tools, and supervi-
sion required to furnish and install all electrical and all ap-
purtenances required for a complete installation in accor-
dance with the contract documents, applicable codes, and
governing agencies. The work includes, but is not limited to,
the following:

1. Furnish and install all electrical fixtures, switches, meter
bases, breaker boxes, and wiring.

2. Provide one meter base per unit and one house meter
per apartment building.

3. Furnish and install all exhaust fans. Ducting of the ex-
haust fans is to be by others.

4. Furnish, install, and provide power to the disconnect for
the air-conditioner condenser.

5. Furnish, install, and provide power to an electrical box
for the furnace.

6. Provide electrical hookup of the dishwasher and disposal.

7. Install range hood or space-saver microwave.

8. Install pigtails on range and electrical clothes dryers.

9. Furnish and install wiring, jacks, boxes, a terminal box,
and other items required to prewire the telephones.

10. Furnish and install wiring, jacks, boxes, a terminal box,
and other items required to prewire the cable television.

11. Furnish and install wiring, door and window contacts,
and an outlet required to prewire the security system.
The key pad, motion detectors, and equipment are pro-
vided and installed by others.

12. Furnish and install wiring, jacks, boxes, equipment, and
other items required to complete the intercom/sound
system.

13. Furnish and install wiring, jacks, boxes, and other items
required to prewire the home theater system.

EARTHWORK AND UTILITIES—
ROADS AND PARKING LOTS
Provide all labor, materials, equipment, tools, and supervi-
sion required to furnish and install all earthwork and utili-
ties and all appurtenances required for a complete installa-
tion in accordance with the contract documents, applicable
codes, and governing agencies. The work includes, but is not
limited to, the following:

1. Furnish and install sanitary sewer lines, associated
manholes, and so forth to complete the sanitary sewer
system.

2. Furnish and install sanitary sewer laterals for all lots.
The subcontractor shall furnish and install one sewer
lateral per lot. The sewer laterals shall be constructed
from the sanitary sewer in the road to a point 10 feet
inside the lot boundaries. The locations of the sewer
laterals are to be coordinated with the site superinten-
dent. The subcontractor shall mark the end of each
sewer lateral in such a manner that it can be located for
future connection.

3. The subcontractor shall make all required connections
to connect the sanitary sewer lines to existing utilities.

4. Furnish and install the water lines, fittings, valves, hy-
drants, washouts, boxes, covers, and so forth to com-
plete the water system.

5. Furnish and install water laterals, including, but not
limited to, the water meter yoke and meter box for all
lots. The subcontractor shall furnish and install one
water meter yoke per lot. The water laterals shall be con-
structed from the water line in the road right-of-way to
the water meter locations shown on the plans. Water
meters are excluded from this contract.

6. The subcontractor shall make all required connections
to connect the water lines to existing utilities. Utility
company’s connection, impact, and review fees are ex-
cluded from this subcontract.

7. Furnish and install storm drain piping, catch basins,
clean-out boxes, manholes, and so forth to complete the
storm drain system.

8. The subcontractor shall construct the detention and re-
tention ponds shown on the plans.

9. The subcontractor shall excavate and backfill the trench
required for the placement of power lines. The power
lines shall be furnished and installed by others.

10. Furnish and install conduits for phone and cable televi-
sion. The phone and cable television conduits may be
placed in a joint trench with the power lines. The phone
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and cable television wiring shall be furnished and in-
stalled by others.

11. Furnish and install conduits for site lighting. The site
lighting conduits may be placed in a joint trench with
the power lines. The site lighting and its associated
wiring shall be furnished and installed by others

12. The subcontractor shall clear and grub the site.

13. The subcontractor shall provide the rough grade for the
roads and parking lots and their associated gutters, side-
walks, and curb walls within the road right-of-way.

14. Furnish and install base for all gutters, sidewalks, and
curb walls required for completion of all concrete
within the road right-of-ways and parking lots.

LANDSCAPING
Provide all labor, materials, equipment, tools, and supervi-
sion required to furnish and install all landscaping and all
appurtenances required for a complete installation in accor-
dance with the contract documents, applicable codes, and
governing agencies. The work includes, but is not limited to,
the following:

1. Furnish and install the landscaping including hy-
droseeding, sod, trees, shrubs, and bedding plants.

2. Furnish and install an irrigation system with automatic
controls and pop-up heads. The electrical supply to con-
trol locations shall be furnished by others. The subcon-
tractor shall coordinate with the project superintendent
and electrical subcontractor to ensure proper location of
the automatic controls and electrical supply.

3. The subcontractor shall adjust all sprinkler heads and
set automatic controllers prior to completion of each
building or residence.

4. The subcontractor shall place all sleeves, pipes, and con-
duits required to complete the sprinkling system under
roads, driveways, walks, curbs, and other hard surfaces
prior to the construction of the said surfaces.

5. Preparation of the soil.

6. Finish grade to foot. Rough grade to foot to
be provided by others.

7. Disposal of rock uncovered by installation of the irriga-
tion system.

8. The subcontractor is to warranty all trees and shrubs for
one year.

9. The subcontractor is to warranty all hydroseeding and
sod for 90 days.

10. The subcontractor shall maintain the landscape for 90
days after final acceptance.

�0.2�0.1
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A

Absolute Reference All or part of an Excel cell’s reference
that does not change as the cell is copied, which is designated
by a dollar sign ($) in front of the row and/or column desig-
nation for the cell.

Addenda A construction document, issued before the bid,
that changes the scope of work for a construction project.

Add-On Costs that are added to the cost of the bid, such as
bonds, building permit, and profit and general overhead.
Also known as a markup.

AGC Associated General Contractors of America.

AIA American Institute of Architects.

Air Handler An HVAC component that combines a heat
exchanger and a fan.

Alternate Bid Item A bid in which the contractor provides
alternate or optional pricing for specific bid items in addi-
tion to the base bid. Also known as an optional bid item.

American Standard Beam An I-beam designated with the
prefix S.

American Standard Channel A steel channel designated
with the prefix C.

Anchor Bolt A bolt used to connect steel or wood to con-
crete or masonry.

Angle or Angle Iron An L-shaped steel member desig-
nated with the prefix L.

Annual Contract A contract for materials that is set up for
a period of time (often 1 year), which covers multiple con-
struction projects.

ANSI American National Standards Institute.

Architect’s Scale A scale or ruler that allows the user to
read dimensions from plans drawn at common architectural
scales.

ASTM American Society for Testing and Materials.

Avoidable Waste Waste that can be avoided by careful or-
dering, storage, and use of materials.

B

Bank Cubic Yards The volume of soil in cubic yards before
it has been excavated in its natural or in situ condition.

Beam A horizontal member that supports a load and
transfers the load to girders or columns.

Bedding Gravel or sand that provides a place for under-
ground pipe to rest and may surround the pipe to protect it.

Bid The amount that the contractor charges the owner for
the work.

Bid Bond A bond issued by a surety guaranteeing that the
bidder, if successful in winning the bid, will execute the con-
tract and provide payment and performance bonds.

Bid Documents Forms used for the submission of the bid,
which may include bid forms, bid-bond forms, a schedule of
values, and contractor certifications.

Bid Form The construction document on which the bid or
price is submitted.

Bid Instructions A construction document that provides
bidders with a set of instructions that must be followed to
prepare a complete bid.

Bid Package The construction documents that define the
scope of work for a construction project, on which bids are
prepared.

Billable Hours The number of hours that an employee
can be billed to projects during a year.

Block Concrete masonry unit used to construct structural
walls.

Blocking A small piece of wood used to strengthen struc-
tural members or fill the space between members, as is the
case with fire blocking.

Boiler A closed vessel used to heat a liquid.

Bond See Bid Bond, Payment Bond, and Performance Bond.

Bond Beam A horizontal row of concrete blocks or bricks
reinforced with rebar and grout, used to add structural
strength to a wall.

GLOSSARY
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Bonding Limit The maximum dollar value for a single job
and total work in progress a contractor may be bonded for.

Bottom Plate The bottom framing member in a wood
wall.

Brick A masonry unit made from clay or shale.

Brick Facing A nonbearing layer of brick on the face of a
block or wood wall. Also known as brick veneer.

Brick Ties Corrugated metal ties used to connect brick ve-
neer to masonry or wood walls.

Brick Veneer A nonbearing layer of brick on the face of a
block or wood wall. Also known as brick facing.

Budget The target cost set for a project or portion of a
project.

Building Paper Asphalt-impregnated felt, often used as a
vapor barrier.

Bullnose A rounded outside corner.

Burden The costs that must be added to an employee’s
wages to determine his or her total cost, which includes cash
equivalents and allowances paid to the employee, payroll
taxes, unemployment insurance, workers’ compensation in-
surance, general liability insurance, insurance benefits, re-
tirement contributions, union payments, vacation, sick
leave, and other benefits paid by the employer. Commonly
referred to as labor burden.

Butts A common type of hinge.

Buyout The process of hiring subcontractors and procur-
ing materials and equipment for a construction project.

C

Cell (1) A location on an Excel spreadsheet designated
by a row and column. (2) The hollow space in a concrete
masonry unit.

Certifications A construction document that the contrac-
tor signs certifying that it meets specified criteria.

Change Order A construction document that is issued
after the bid and changes the scope of the work and/or the
contract amount for a construction project.

Channel American Standard Channel, a steel channel des-
ignated with the prefix C.

Check Valve A valve that allows a fluid to flow in one di-
rection only.

Chiller An HVAC unit used to cool water.

Close-Out Audit A review of all activities completed dur-
ing the construction process, including the estimating
process, which occurs after the project is complete.

CMU Concrete masonry unit.

Coil An HVAC component consisting of a coil of pipes
used to transfer heat from the air to a refrigerant or from the
refrigerant to the air. Also known as a heat exchanger.

Collar Ties A wood member connected to two rafters used
to prevent the wall supporting the rafters from spreading
apart due to the forces on the rafters. Also known as rafter
ties.

Column A slender vertical structural member.

Compacted Cubic Yards The volume of soil in cubic yards
after it has been excavated, placed, and compacted, and is
used to measure the volume of fill.

Competitive Bidding The bid process in which two or
more contractors compete for the bid based on price and/or
other criteria.

Composite Slab A structural slab that derives its strength
from structural steel beams in combination with a concrete
deck.

Concrete A mixture of cement, large aggregate, fine aggre-
gate, and water.

Concrete Masonry Unit Wall constructed of concrete
blocks and mortar.

Condenser An HVAC component consisting of a com-
pressor and a heat exchanger, used to cool and compress a
refrigerant.

Continuous Footing A long, narrow footing used to sup-
port walls and columns.

Contract A legally binding agreement between the pro-
ject’s owner and a contractor for the work done on a con-
struction project.

Cost Codes A code for the logical grouping of items sepa-
rated by supplier or installer type. Cost codes are often based
on the MasterFormat.

CPVC Chlorinated polyvinyl chloride, a pipe used for
water lines.

Crew Rate The hourly or daily cost of labor and equip-
ment for a construction crew.

Cripple Stud A short stud used below windowsills and in
other areas.

Cycle Time The time it takes to complete one cycle of a
repetitive task.

D

Damper A blade or louvers in an air duct used to control
the airflow.

Dampproofing A water-resistant material applied to
foundations.

Davis-Bacon Wages Wage rates that must be used on con-
tracts with federal funding.

Design Professional The architect or engineer responsible
for the design of a project.

Dialogue Box A small box in Excel that allows the user to
make choices.

Diffuser An air distribution component located on the
ceiling used to direct the airflow into a room.

Digitizer A device used to measure distances and areas off
of plans.

Dimensional Analysis A mathematical procedure in
which only the units of an equation are written to verify that
the equation produces an answer with the correct units.

Direct Costs Costs that can be specifically identified with
the completion of a task. For example, for the task of in-
stalling windows the direct cost includes the material cost for
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the windows (including sales tax and delivery),the labor cost
(including labor burden), and the cost of any equipment
used to install the windows.

Drain Board A material used to allow water to freely drain
vertically down the face of a wall.

Drawings A graphical representation showing the dimen-
sions of the project and where different construction materi-
als are used on the project. Also known as plans.

Dropdown Box A box in Excel that allows the user to se-
lect among a list of preset choices with only one choice being
visible until the user selects the arrow to the right side of the
box.

Dry Unit Weight The density of the solid portion of a soil,
usually measured in pounds per cubic foot.

Drywall Preformed sheet of gypsum.

Drywall Compound The material used to tape the joints
of the drywall.

Durable Wood Wood that is naturally protected against
decay and termites; for example, redwood.

E

EIFS Exterior insulation finish system.

End Condition The need to add a repetitive member to
the beginning of a wall.

Engineer’s Scale A scale or ruler that allows the user to read
dimensions from plans drawn at common engineering scales.

Escutcheon A decorative cover around plumbing and fire
sprinkler pipes.

Estimated Cost The projected cost of the work including
the cost of labor, materials, equipment, and markups. The
estimated cost should not be confused with the bid or selling
price.

Estimating Estimating is the process of determining the
expected quantities and costs of the materials, labor, and
equipment for a construction project.

Estimating Software Package High-end software pack-
ages that combine a spreadsheet with a database.

Estimator A person responsible for preparing cost esti-
mates regardless of his or her job title.

Ethics (1) A set of principles or rules by which members of
a group agree to abide. (2) A set of values or a guiding phi-
losophy of a person.

Excel A spreadsheet program developed by Microsoft.

F

Fascia A vertical board running perpendicular at the end
of the rafters or trusses.

FICA Federal Insurance Contributions Act, which requires
the collection of Social Security and Medicare taxes.

File A uniquely named storage unit containing contents
of a computer spreadsheet, drawing, or other computer
document.

Fillet Weld A triangular weld used to connect two steel
members together at a right angle.

Fire Department Siamese A wye fire hose connection lo-
cated outside a building and connected to a fire sprinkler
system for use by the fire department.

Flow Alarm An alarm that goes off when flow occurs in a
pipe.

FOB Free on board. The point where ownership and re-
sponsibility for materials transfers from the supplier to the
contractor.

Folder A location on the computer used to organize files
and subfolders.

Footing A structural member used to transfer the loads
from a column or wall to the ground.

Forms Temporary structures used to support concrete
until it has cured and can support its own weight.

Foundation The concrete or masonry structure below the
first floor of a building, including the footing.

Foundation Wall The wall portion of the foundation,
which often acts as a retaining wall.

Framing Anchor A light-gage metal connector used to
connect two or more wood members together or connect
wood members to concrete and masonry.

Function A computer instruction that selects a value
based upon a specified set of requirements and the values lo-
cated in other cells. For example, the MAX function selects
the largest value from a series of cells.

Fusible Link A metal link that melts when exposed to fire
conditions, opening a fire sprinkler head or closing a fire
damper.

FUTA Federal Unemployment Tax Act.

G

Gable-End Truss A nonbearing truss installed over walls
to construct the gable end of the building.

General Conditions A construction document that iden-
tifies the relationships among the owner, design profession-
als, and the contractor and addresses provisions that are
common to the entire project. Typically, this is the standard
document used for many different projects.

General Decision A document containing the Davis-Bacon
labor rates, which is published by the U.S. Department of
Labor.

General Overhead Costs that cannot be identified with a
project, for example, main-office expenses and accounting
costs. Also known as indirect costs.

Girder A horizontal structural member used to transfer
loads from beams to columns.

GLB Glue lam beam.

Glue Lam Beam A beam constructed by laminating with
glue a number of smaller wood members parallel to each
other into a larger beam.

Grille An HVAC component consisting of horizontal slots
used to cover an air duct.

Grout A mixture of cement, fine aggregate, and water used
to fill the cells of blocks or bricks.
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H

Header A horizontal structural member used to transfer
vertical loads from above an opening to the vertical mem-
bers located at the sides of the opening.

Heat Exchanger An HVAC component consisting of a coil
of pipes used to transfer heat from the air to a refrigerant or
from the refrigerant to the air.

Hip Rafters The rafters located at the junction of two in-
clined roof planes where the exterior surfaces of the planes
intersect at an angle greater than 180 degrees.

Hold-Down A structural metal connector used to provide
resistance against uplift.

HVAC Heating, ventilation, and air-conditioning.

I

Icon A computer image used to represent a command, file,
or folder.

I-Joist An engineered wood joist with an I-shaped cross
section.

Included by Reference Documents that are included in
the contract documents by referencing them in the contract
documents rather than physically attaching them.

Indirect Costs Costs that cannot be identified with a pro-
ject, for example, main-office expenses and accounting costs.
Also known as general overhead.

Indirect Project Costs Costs that can be identified with a
construction project but are not identifiable with a specific
task. Most Division 1 (for example, supervision, jobsite
trailer, and temporary utilities) costs fall into this category.
Also known as job overhead.

In Situ Soil in its natural condition.

Invitation to Bid A construction document that invites
contractors to bid on a project.

J

Jack Rafters A shortened rafter in a hip roof that is con-
nected to a hip or valley rafter.

Jack Stud A short stud used to support a header.

Jamb The exposed side of a door or window.

Job Overhead Costs that can be identified with a con-
struction project but are not identifiable with a specific task.
Most Division 1 (for example, supervision, jobsite trailer,
and temporary utilities) costs fall into this category. Also
known as indirect project costs, which are different than in-
direct costs.

Joist A horizontal wood or steel member used to frame a
floor or ceiling.

Joist Girder A joist used to transfer loads from joists to
columns.

Joist Hangar A light-gage metal connector used to con-
nect joists to joist headers and rim joists.

Joist Header A joist used to transfer loads from joists in-
tersecting an opening in a floor or ceiling at a right angle to
the joist trimmers.

Joist Trimmer The joists running parallel to a side of an
opening.

K

King Rafters A full-length rafter that runs from the eave of
the roof to the peak of the roof.

King Stud A full-length stud located at the side of an
opening.

L

Labor Burden The costs that must be added to an em-
ployee’s wages to determine his or her total cost, which in-
cludes cash equivalents and allowances paid to the employee,
payroll taxes, unemployment insurance, workers’ compensa-
tion insurance, general liability insurance, insurance bene-
fits, retirement contributions, union payments, vacation,
sick leave, and other benefits paid by the employer.

Labor Hour One employee working 1 hour.

Labor Hours The total number of labor hours it takes to
complete a task.

Labor Productivity A measure of how fast construction
tasks can be performed, which is reported as the number of
units performed during a labor hour or crew day (output) or
the number of labor hours required to complete one unit of
work.

Labor Rate The hourly cost of an employee per billable
hour including wages and labor burden, which is calculated
by dividing the annual cost of the employee by the number
of billable hours.

Landscape When specifying a page layout for printing, the
paper orientation that has the long side horizontal.

Left Click Pressing the button on the left side of the
mouse.

LHR Labor hours.

Line Set The copper lines used to connect a condenser
with a coil in an HVAC system.

Lintel A structural member used to support the wall above
an opening. See also Header.

List Box A box in Excel that allows the user to select from a
list of preset choices, with multiple choices being visible in
the box.

Lookouts Short wood members supporting a roof over-
hang.

Loose Cubic Yards The volume of soil in cubic yards after
it has been excavated but before it has been placed and com-
pacted, which is used to measure the volume of soil being
transported.

Lump Sum Bid A bid in which the contractor provides a
single price for the construction work.

M

Man Hours See Labor hours.

Markup Costs that are added to the cost of the bid, such as
bonds, building permit, and profit and general overhead.
Also known as an add-on.
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Membrane Roofing A roof constructed of an imperme-
able flexible plastic membrane.

Metal Deck Formed sheet metal used to support a roof or
floor.

MHR Man hours. See Labor hours.

Mono Truss A truss with a single pitch or slope.

Mortar A mixture of cement, lime, fine aggregate, and
water used to adhere brick or block together.

Mullion A member that separates the glazing panels in a
window.

N

Nominal In name only. Lumber is often specified in nomi-
nal dimensions, which are larger than the actual dimensions.

Nonresponsive Bid An incomplete bid, which is disre-
garded.

O

Optional Bid Item A bid in which the contractor provides
alternate or optional pricing for specific bid items in addi-
tion to the base bid. Also known as an alternate bid item.

Oriented Strand Board A panel of wood created by gluing
wood chips together.

OSB Oriented strand board.

Output Labor productivity measured in the number of
units performed during a labor hour or crew day.

Overbuild A portion of a roof built over the top of a roof
structure, often used to create the appearance of a dormer.

P

Package Unit An HVAC unit that incorporates the heating
and cooling equipment into a single unit.

Paid-When-Paid Clause Language in a contract that ties
the payment of the subcontractor to the receipt of payment
from the owner.

Path The computer location of a file that includes the
drive designation and all folders from the drive to the file.

Payment Bond A bond issued by a surety guaranteeing
that the contractor will pay for the labor, materials, and
equipment used on the project.

Performance Bond A bond issued by a surety guaranteeing
that the contractor will complete the work and that, should
they fail to do so, the surety will step in and complete the work.

Pex A plastic pipe used for water lines.

Pipe Hanger A device used to support a pipe from a struc-
tural member.

Plan Measurer A device that allows the user to measure
distances from plans by rolling the wheel of the device along
a line.

Plans A graphical representation showing the dimensions
of the project and where different construction materials are
used on the project.

Plate Steel Flat sheet of structural steel used to make con-
nectors and bearing plates.

Plenum (1) The space between a dropped ceiling and the
structure above. (2) The ductwork above a residential furnace.

PO Purchase order. A legally binding agreement used to
order materials or work on a project.

Portrait When specifying a page layout for printing, the
paper orientation that has the short side horizontal.

Post A secondary column.

Pressure-treated Wood Wood that has been treated to
prevent rot and insect infestation and/or fire by forcing
chemicals into the wood under pressure.

Progress Payment A payment made from the owner to the
contractor or from the contractor to the subcontractor be-
fore the project is complete as payment for the work com-
pleted to a specified date.

Project Manual A bid document that contains the invita-
tion to bid, bid instructions, bid documents, bond and con-
tract forms, general and special conditions, technical specifi-
cations, and other contract documents.

Proposal A letter or document from a contractor to an
owner (or from a subcontractor to a contractor) in which
the contractor (subcontractor) proposes to perform a speci-
fied scope of work for a set price and set conditions.

PRV Pressure-reducing valve.

P-Trap A P-shaped pipe used to prevent sewer gasses from
escaping from the sewer system.

Purchase Order A legally binding agreement used to order
materials or work on a project.

PVC Polyvinyl chloride.

Q

Quantity Survey or Quantity Takeoff The process of con-
verting the building dimensions and details into estimated
quantities.

R

Rafter A sloped wood member used to frame a roof.

Rafter Ties A wood member connected to two rafters,
used to prevent the wall supporting the rafters from spread-
ing apart due to the forces on the rafters.

Raised Slab A slab that does not bear on the ground.

Random Length A bundle of lumber with differing
lengths.

Rate of Progress The speed at which a linear task (for ex-
ample, paving roads, installing pipes, painting striping on
roads, installing curbs, and so forth) proceeds.

Rebar Steel bars used to reinforce concrete and masonry.

Register A diffuser combined with a damper to direct and
control the flow of air into a room.

Relative Reference All or part of an Excel cell’s reference
that changes as the cell is copied.

Request for Material Quote A written request for pricing
on materials.

Retention Funds withheld from a payment to ensure that
a contractor completes a construction project.
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Ridge Board A board located at the ridge of a roof used to
support the rafters.

Right Click Pressing the button on the right side of the
mouse.

Rim Board or Rim Joist The board or joist located at the
perimeter of a wood-framed floor or ceiling.

Ring Shank Nail A nail with rings around its shank to in-
crease its resistance against pullout.

Ring Ties Round rebar ties used to tie the vertical rebar to-
gether in a round column.

Rise (1) The change in height from the supporting mem-
bers to the ridge for a truss or rafter. (2) The vertical distance
between stairs.

Roof-Top Unit An HVAC unit that incorporates the heat-
ing and cooling equipment into a single package and is de-
signed to be placed on the roof of a structure.

RTU Roof-top unit.

Run The distance between the outside of an exterior wall
and the ridge or peak of a roof.

Runner A metal channel used at the top and bottom of a
wall to support the metal studs.

S

Schedule of Values A list of values used to determine the
amount of the progress payments.

Scope of Work “The construction and services required
by the Contract Documents . . . and includes all other
labor, materials, equipment and services provided or to be
provided by the Contractor to fulfill the Contractor’s
obligations” (General Conditions of the Contract for
Construction, American Institute of Architects, AIA
Document A201-1999, p. 9.)

Second-Tier Subcontract A subcontractor to a subcon-
tractor to the general contractor. The contractual relation-
ship of second-tier subcontractors passes through a subcon-
tractor on the way to the general contractor.

Selling Price The amount that the contractor charges the
owner for the work. More commonly known as the bid or
bid price.

Shear Panel A structural panel used to resist horizontal
(shear) forces.

Sheathing A panel of wood used to cover walls, floors, and
roofs.

Shrink The relationship between the bank and compacted
condition of soil.

Siamese A wye fire hose connection located outside a
building and connected to a fire sprinkler system for use by
the fire department.

Sill The bottom horizontal member of a window.

Sill Plate The bottom framing member in contact with
concrete or masonry.

Sill Seal A foam material used to prevent air infiltration
between the sill plate and the foundation.

Slab on Grade A slab supported by earthen materials.

Slope The relationship between the rise and run of a rafter,
truss, or side of an excavation.

Soffit The underside of a roof overhang.

Soils Report A document that describes the soil condi-
tions and water table at the construction site.

Special Conditions A construction document that identi-
fies conditions, in addition to the general conditions, that
apply to a specific project.

Specifications (1) The technical specifications. A con-
struction document that identifies the quality of materials,
installation procedures, and workmanship to be used on the
project. (2) Incorrectly used to refer to the project manual,
which contains the invitation to bid, bid instructions, bid
documents, bond and contract forms, general and special
conditions, and other contract documents, in addition to the
technical specifications.

Spread Footing A square or rectangular footing used to
support a column. Sometimes referred to as a spot footing.

Sprinkler Head The portion of a fire sprinkler system that
sprays water to suppress a fire and often includes a fusible
link or liquid filled vial to release the water.

Stirrups U-shaped rebar located near the end of concrete
beams to resist shear and diagonal tension.

Structural Brick A masonry unit made from clay or shale
that may be used as structural support.

Structural Tee A steel shape made by cutting an I-beam in
half, which is designated with the prefix T.

Structural Tubing A hollow square or rectangular steel
shape.

Stud (1) A wood member used to frame walls, most com-
monly 2 � 4s. (2) A metal bolt with one end securely fas-
tened to a deck or steel member, for example, a Nelson stud.

Subcontract A legally binding agreement between the
contractor and a subcontractor for the work done on a con-
struction project.

SUTA State Unemployment Tax Act.

Sweating The process of connecting copper pipe using
heat, flux, and solder.

Swell The relationship between the bank and the loose
condition of soil.

T

T&G Tongue and groove.

Tail Joist A short joist that ends at an opening.

Takeoff Software A software package used to measure dis-
tances, areas, and volumes from a set of digital plans.

Task A discrete segment of the scope of work that con-
sumes time and resources.

Technical Specifications A construction document that
identifies the quality of materials, installation procedures,
and workmanship to be used on the project. Often referred
to as specifications.

Tempered Glass A form of safety glazing in which the
glass has been heat-treated to resist breakage.
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Text Box A box in Excel where text is typed.

Thickened Slab An area of a slab-on-grade where the
thickness has been increased to provide greater strength or
to act as a footing.

Ties Round, rectangular, or square rebar ties used to tie the
vertical rebar together in a column.

Tongue and Groove Sheeting that has a tongue on one
side designed to fit into a groove on the opposite side of an
adjoining sheet.

Top Plate The top horizontal framing members in a wood
wall.

Transom A window located above a door.

Truss A wood-framing member composed of multiple
structural members, which often form smaller triangles, and
which is used to support a floor or roof.

U

Unavoidable Waste Waste that cannot be avoided because
of the design of the project.

Unit Pricing Bid A bid in which the contractor provides
unit pricing for each bid item.

Unit Weight of Water The weight of the water in the soil,
expressed in pounds per cubic foot.

V

Valley Rafters The rafters located at the junction of two
inclined roof planes where the exterior surfaces of the planes
intersect at an angle of less than 180 degrees.

Vapor Barriers Building papers and plastics used to pre-
vent the infiltration of water vapor.

VAV Box Variable-air-volume box.

VCT Vinyl composition tile.

V Weld A V-shaped weld used to weld the end of struc-
tural steel members together.

W

Waste Materials lost during the construction project,
which equals the difference in the quantities of materials or-
dered and the calculated quantities of materials to be placed
on the project.

Water Content The relationship between the solids and
the water in soils, which is the weight of the water (not
volume) expressed as a percentage of the weight of the
solids.

Waterproofing A water-resistant material applied to
foundations.

Web Stiffener A piece of steel or wood used to stiffen the
webs of an I-beam or I-joist; prevents the beam’s or joist’s
web from buckling.

Welded Wire Fabric A series of wires welded at right an-
gles in a grid to form rolls or sheets of reinforcement for use
in concrete slabs. Also known as wire mesh.

Wet Unit Weight The density of soil, both the solids and
the water, usually measured in pound per cubic foot.

Wheel Plan measurer. A device that allows the user to
measure distances from plans by rolling the wheel of the de-
vice along a line.

Wide-Flange Beam An I-beam with wider flanges than
an American Standard Beam, which is designated with the
prefix W.

Wire Mesh A series of wires welded at right angles in a
grid to form rolls or sheets of reinforcement for use in con-
crete slabs. Also known as welded wire fabric.

Work “The construction and services required by the
Contract Documents . . . and includes all other labor, ma-
terials, equipment and services provided or to be provided
by the Contractor to fulfill the Contractor’s obligations”
(General Conditions of the Contract for Construction,
American Institute of Architects, AIA Document A201-
1999, p. 9.)

Workbook An Excel file containing one or more work-
sheets.

Worksheet The pages within an Excel workbook or file.

WWF Welded wire fabric.

X

xlsx File extension for a 2007 or 2010 Excel file.

xlsm File extension for a 2007 or 2010 Excel file that con-
tains macros.
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401(k) 245
A
Absolute reference, 302–3, 370
Accident history 244
Accounting

style 33
system 65, 228, 235, 243, 249, 259

Accrued cost 240
Accuracy 277, 295
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ceilings 165–6, 174
tile 165–6

Addenda 15, 370
Add-on 15–6, 261–5, 370, 373
Adjustment factor 235
Admixtures 67
AGC 289, 292, 370
Aggregate 67
AIA 2, 9, 289, 292, 370
Air-conditioning 181–6, 189, 367–8
Air

chamber 176
entrainment 67
handler 370
infiltration 108

Alarm
check-valve assembly 172
flow 172
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Align text right button 31
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Alternate bid item 370
Alternatives 285, 289
Aluminum siding 143
American Institute of Architects 2, 9, 289, 292, 370
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American National Standards Institute 6, 370
American Society for Testing and Materials 6, 370
American Society of Professional Estimators 8–9, 295–6
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ANSI 6, 370
Appliances 189
Arbitration 291
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Auto fill 320
Autosum button 43
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Avoidable waste 370

B
Back charge 290
Backer board 164
Backfill 210–1, 225
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Bank 200–2, 210
cubic yards 370

Bankruptcy 3
Base 214–5, 365

plate steel 98
rubber 168

Batten strip 146
Beam 78, 98–100, 370

American standard 98
wood 364
wide-flange 98

Bearing walls 110, 117–8
Bedding 223–4, 370

plants 369
Benefits 240, 245
Bid 370

best 259
bond 4, 10–1, 282, 370
checklist 282
competitive 10
courtesy 264–5
date 257, 264
deadline 14
documents 4, 210, 282, 370

preparation 14
form 4–5, 282, 370
instructions 4, 370
nonresponsive 282
package 4–7, 370
planning 10
preliminary 283
review 16–7
rigging 296
scheduling 10
selection 259
shopping 296
subcontractor 172, 283
submission 16, 282–8
time 257

bid-day activities 14–6
bidding

fair 296
practices 296
rhythm 264
warming up 264

Billable hours 370
Billing disputes 289
Birds mouth 120
Block 89–93, 370

bond-beam 89–90
bullnose 90–1
lintel 90–1

Blocking 110–1, 117–8, 364, 370
Block-out 367–8
Board feet 108, 110, 113, 353
Bodily injury 244
Boiler 370
Bold 32

button 32
Bolts 98, 100

expansion 365
molly 365

Bond 270,
beam 89–90, 370
bid 4, 10–1, 282, 370
capacity 285
cost 15, 299–300
limits 11, 371
payment 4, 263, 270, 374
performance 4, 263, 270, 290, 374
schedule 300

Borders 28, 34, 307
button 34
popup menu 34–5

Bottom plate 371
Branch lines 172–3
Brick 371

facing 89, 93–4, 371
lintels 93
structural 89–93
ties 371
veneer 89, 93–4, 371

Bridges 214
Budget 3, 371
Build in mind 56, 59, 66, 293
Building

code 67, 115, 261
paper 134–8, 141, 371
permit 15, 261, 263, 270, 285, 299

Bullnose 371
Burden 240–1, 371
Butt joint 61–3, 145
Butts 371
Buyout 17, 289–92, 371

C
Cabinets 124–5

base 181–2
medicine 365

Cable TV 366, 368–9
Calculations 278
Calculator 8
Caret (ˆ) 39
Carpentry finish 365
Carpet 168, 366
Cash equivalents 240–2
Casing 365
Catalogue cut sheets 282–3
Catalogue of Standard Specifications and Load Tables for Steel

Joists and Joist Girders 101
Catch basins 368
Caulk 366
Ceiling

dropped 185
function 42–3, 366
joists 119, 121
painting 168

Cell 371
combining 33
formatting 31
merging 33
naming 323–5
unmerge 33

Cement powder 67
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Center button 31
Centerline method 75
Ceramic tile 164–5
Certifications 4, 282, 371
Certified payroll 290
Chair rail 365
Chair rebar 67
Change order 3, 10, 258, 290, 371
Channel American standard 98, 371
Chases 365
Check

joint 290
valve 172, 371

Chiller 371
Chimney 141
Circle 344–5

quarter of 346
Circular reference 299, 301
Clarifications 258, 283, 286
Cleanouts 177–8
Clean-out boxes 368
Cleanup 5, 291
Clipboard 27–8
Close-out audit 17, 371
Closet rod 365
CMU 371
Coil 371
Collar ties 119, 121, 371
Color 307
Column 69–71, 98–100, 203, 350–2, 371

headings 47
widths 28, 30

dialogue box 30–1
minimum 30

wood 364
Combining cells 33
Combustion air 367
Comma style button 33
Comments 28
Commercial storefront 155–6
Commitment 295
Communication 17, 257, 357

productivity 363
verbal 2–3
with field 58–9
written 2–3

Compacted 200–2, 210
cubic yards 371

Competitive bidding 371
Competitors tracking 264–5
Completeness 277, 295
Complex

shape 346–50
volumes 352

Composite slab 371
Composites 355
Compression fitting 176
Computers 8
Concatenate 329–30
Conceptual estimate 3–4
Concrete 66–85, 183, 225, 354–5, 371

admixtures 67

chilled water 67
columns 364
curb 214–5, 237
curing 78
design-based specification 67
finishing 66, 68, 78
footings 364
forms 66–7, 215

life of 67
reuse 66

foundations 364
gutter 214–5
hot water 68
ice 67
masonry unit 371
material 67–8
mixes 364
performance-based specification 67
placement 66, 68
productivity 359
protection 68
pump 68, 364
short loads 67
site 215
slump 67
stairs 81–2
strength 67
truck 68
walls 364
waste 68
weight 81

Condenser 367, 371
Conditional formatting 307–10

button 307
rules manager dialogue box 308–9

Cone 350–1
Conferences 295
Confirm password dialogue box 313
Conflict of interest 296
Connectors steel 98, 102
Constant area 351–2
Construction

cost 263–4
documents 230, 289, 295
methods 2, 58, 293–4

Construction Specifications Canada 9
Construction Specifications Institute 9
Contact information 285
Continuous

footing 371
improvement 17

Contour lines 206
Contract 4, 371

alternatives 289
annual 228, 230
assignment 289
change order 290
documents 258, 264
general provisions 291
inspections 290
materials 228, 292
parties 289



INDEX 381

payment 290
price 290
project identification 289
quality 290
quantities 289
retention 290
schedule 290

of values 289–90
submittals 290
termination 291
testing 290
voiding 291

Convection 185
Conversion factors 278, 317, 352–3
Conveying equipment 356
Cooktop 189
Coordinate method 349–50
Coordination 290

special 293–4
Copper pipe 176
Copy 28

button 28
worksheet 25

Corner
piece siding 143
trim 146

Cost
accrued 240
actual 228
code 10, 17, 52, 57, 267, 270, 277, 279, 354–8, 371
construction 263–4
controls 3–4, 16
equipment 57, 248–52
escalation 230
labor 2, 9, 12–3, 57, 60, 254, 268–70, 318
large 277
material 2, 12, 57, 60, 267–70, 317–8
operating 248, 250
ownership 248–9
shipping 229, 267
square foot 279
storage 267, 230
total 269–70
tracking 228

Counted items 60
Countertops 124–5
Coverage rate 64, 140
CPVC 176, 371
Crane 365

sizing 98
Crawl space 181
Crew 13

day 233
in-house 257
makeup 255, 293
rate 254–6, 316–7, 371
size 234–5

minimum 290
Cripple stud 371
Cross bracing steel 98
Cross section 220–1

area 81

Cross-sectional method 204–9
Cross tees 165
Crown molding 365
CSI 9
Ctrl key 25
Curb 369

walls 369
Current

date button 37
time button 37

Cushioning 167
Cut 27

button 27
Cwt. 229
Cycle time 235–7, 371
Cylinder 350

D
Damage 230
Damper 371

fire 367
smoke 367

Dampproofing 134–5, 371
Data

entry 26–30
historical data 64–6, 81, 139–40, 163–4, 168, 228–9, 235, 238,

257, 259, 296, 317
manufacturer’s 64, 110, 139–40, 163–4, 168, 250–1
validation 310–2, 325–6, 335

button 310
dialogue box 310–1, 325–6

Database 9, 17
Davis-Bacon wages 240, 371
Deck

metal 102
wood 113

Decrease decimal button 34
Deflection 81
Delays 58, 60, 234
Delete

button 24
popup menu 25

Delivery 229
Depreciation 248–50
Design

information 234
professional 4, 67, 115, 165, 168, 210, 258, 282,

286, 371
Design-build 283

subcontract 172
Desired results 315–6
Detail worksheet 29, 267–70, 272–4, 298, 301, 304
Detailed

estimate 3–4, 10, 277–8
oriented 3

Detention ponds 368
Dialogue box 371

column 30–1
conditional formatting rules manager 308–9
confirm password 313
data validation 310–1, 325–6
format cells 32, 34, 309, 312
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Dialogue box (Contd.)
function argument 42–4
insert 23–4

function 41
launcher 19
macro 305
move or copy 26
name manager 324–5
new

formatting rule 308
name 323

open 19–20
options 22, 302
page setup 48–9
paste

name 324
special 28

picture 37
print 46–7
protect worksheet 313
recent files 21
record macro 303
save as 20–1
security options 301–2
trust center 302–3
unprotect worksheet 313
warning 25, 33
zoom 35

Diffuser 165, 371
Digitally signed 301–2
Digitizer 7, 61, 75, 77, 341–2, 371
Dimensional analysis 353, 371
Dimensions

adding 341–2
subtracting 341–2

Direct
costs 371–2
overhead defined 56

Disconnects 366
Dishwasher 367–8
Disposal 368
Dispute resolution 291
Dollar sign 40
Door 153, 365–6

access 367
cylinder 155–6
exterior 365
frame 157

wood 162
jamb 117, 153
mortising 153
opening 93, 113, 115
painting 168
predrilled 153, 157
prehung 57, 157
schedule 153–4, 157
sliding glass 153, 365
stop 155–7
swings 153
wood 153

Double check 278–9
Dowels 71

Draft stops 365
Drain

board 134, 372
pipe 176–9
valve 172

Drainage system 134
Drawings 4, 11, 60, 258, 264, 278, 285–6, 316–7, 367, 372,

374, 377
as-built 290

Drip edge 141–3
Driveway 183, 369

excavation 210
Dropdown box 325–6, 372
Dry

density 200
unit weight 200, 372

Dryer 189, 367–8
Drywall 162–4, 364–6, 372

compound 162–3, 372
fasteners 162–3
fire-rated 163, 365
moisture-resistant 365
patching 366
scrap 366
tape 162–3
trim 162–3
water-resistant 163

Duplication 277
Durable wood 372
DWV 176–179

E
Earthquakes 117
Earthwork 9, 200–11, 357, 368–9

productivity 363
Economy 230
Effective

length 61–2
width 62

Efficiency system 235–7
EIFS 140–1, 372
Electrical 183, 189–96, 357, 365, 368

box 190
junction 190–1

breaker 189, 192–3
box 368

commercial 190–3
conduit 189, 190–3
controls 189
disconnect 368
distribution 191
fixtures 368
fluorescent light 190
light fixture 165, 189–91
meter 191–2

base 368
motors 189
outlet 189–90
panel 189–90
panelboards 191–3
plan 189, 191
productivity 362
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raceway 190
Romex 189

starters 189
switches 189–90, 368
transformer 189
wire nuts 190
wireway 192
wiring 191, 368

commercial 190–3
diagram 191
residential 189–90

Elevators 365
E-mail 286, 288
Embed 364
Employee

annual cost 245
class 240, 254
cost 240
death 244
exempt 241
injury 244
occupational illness 244

End condition 60–1, 71, 78, 84, 114, 372
Engineer 258
Engineer’s

estimate 11
scale 7, 343, 372

Environmental inspections 6
EPDM 146
Equations identifying 315, 317
Equipment 293–4, 356, 366

bucket teeth 250
costs 2, 9, 12–3, 57, 248–52, 254, 268–70
cutting edges 250
damage 251
depreciation 248–50
different 58
expected life 248
filters 248, 250–1
fuel 248, 250–1
insurance 248–9, 251
interest 248–50
leased 248, 251
license 248–9, 251
life 248
lubricants 248, 250–1
maintenance 251
overhaul 251
owned 248
price 13, 15, 248
procurement 17, 289
quantities 2, 12
rented 248, 251
repair 248, 251

reserve 251
sales tax 248
salvage value 248
setup 248
storage 248–9, 251
taxes 248–9, 251
tire 248–9, 251

repair 250

transportation 248
use 58
value 249
wear 251

items 248–9, 251
Error

alert 310–2
canceling 278
checking 8, 16
protection 298, 307–14

Errors 8, 277–9, 335
identification of 17

Escalation 267
Escutcheon 174, 372
Estimate

accuracy 17
architect’s 11
complete 14
conceptual 3–4
detailed 3–4, 10, 277–8
engineer’s 11
errors 16
final 3–4
preliminary 3–4, 10
review 279
too high 2
too low 2
types of 3–4

Estimated cost 372
Estimating 372

art of 3
computerized 8–9
database 9, 17
department 2
fundamental principles 3
inaccuracies 4
math 2, 341–53
poor 14
practice 3
process 10–7
software 8

package 372
tools 7–8

Estimator 2–3, 372
skills of 2–3

Ethics 295–6, 372
dilemmas 296

Ethylene propylene diene monomer 146
Excavation

average-end method 203–4, 209, 220–2
modified 204, 209, 220, 222

average-width-length-depth method 203, 209
backfill 210–1, 225
base 369
basement 204
building 208, 210
clear and grub 369
comparison of methods 208–9
contour lines 206
costs 6
cross sections 203–4
cross-sectional method 204–9
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Excavation (Contd.)
cut 203–9
driveway 210
fill 203–8
footing 210–1
foundation 210–1
geometric method 202–3, 209, 222–3, 344–8
grade

existing 206
proposed 206

grading data 210
gravel underslab 211
grids 204–5
rough grade 369
sidewalk 211
site 204
trench 220–3
zero line 205, 207

Excel 3, 8, 18–52, 372
advanced options 26–7
asphalt 215
average-end method 222

modified 222
base 215
batt insulation 139
bedding 224
block 92–3
board foot 110
bond cost 263
brick 94
building permit 262
ceramic tile 165
column

rectangular 70
round 71

competitor tracking 265
continuous footing 75–6
crew rates 255–6
cycle time 236–7
decking 113
detail worksheet 269
drywall 164
equipment costs 251–2
floor sheathing 112–3
foundation wall 78
geometric method 223
icon 18–9
insulation batt 139
joists 112
labor rate 246–7
metal deck 102
rafters 122
rate of progress 237
request for material quote 231
roofing

felt 138
shingles 142

siding 144–5
slab

on grade with rebar 79–80
on grade with wire mesh 80
raised 81

spread footings 69
structural steel 100
studs 117
summary worksheet 271
trench excavation 222–3
waterproofing 135

Exclusions 15, 258, 283
Executable code 301
Exhaust fan 184, 367–8
Existing conditions 354
Expense additional 58
Experience modifier 244
Export 210, 225
Exterior improvements 214–6, 357

productivity 363
Exterior insulation finish system 140–1, 372

F
F4 key 40
Fan 185

coil 367
Fascia 121–4, 143–6, 366, 372
Faucets 179, 367
Federal Insurance Contributions Act

242, 372
Federal unemployment tax 242–3
Fence 214
Fiberbond 364
FICA 242, 372
Field measure 155–6
File 372

name button 37
path button 37
type 18

Fillet weld 372
Final estimate 3–4
Finish carpentry 124
Finishes 162, 356

productivity 361
Fire

blocking 111, 117–8, 364
department

connections 172–3
Siamese 172–3, 372, 375

prevention 111, 117–8
sprinkler 367

drop 173
heads 172–4

suppression 172–4, 356
productivity 361

treated wood 162
walls 122, 365

Fireplace 368
gas 184
mantels 365

Fire-rated labels 366
Fit selection 35
Fittings 368

compression 176
Fixtures 366–7
Flashing 141, 146, 366, 368

HVAC 183
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pipe 367
plumbing 177, 179

Floor
covering 366
drains 179, 367
function 42–3
opening 110–1
painting 168
sheathing 112–3
wood 108–13, 166–7

Flooring
carpet 168, 366
laminate 166–7
pad 168
trim 168
vinyl 167–8, 366

composition tile 168
waste 167
wood 108–13, 166–7

Flow alarm 172, 372
Fly ash 67
FOB 229, 372
Folder 372
Font 37, 307

dialogue box launcher 32
dropdown box 31
size 31–2

dropdown box 31–2
style 31

Foolproof 50
Footers 36–8
Footing 364, 372

centerline method 75
continuous 71–6
corners 71–2, 75
excavation 210–1
intersection 71, 75
spot 68
spread 68–9

Forklift 365
Form layout 298
Format

button 25, 31
cells 31

dialogue box 32, 34, 309, 312
picture button 37–8
popup menu 24

Formatting 28
Forms 66–9, 71, 76, 78, 81, 372

converting 298–314
new 315–36
planning 315–9
supporting 78, 81

Formula 8–9, 28, 298–301
bar 19, 40
copying 301
editing 40
selecting between two 317
testing 278–9, 298, 301
wrong 278

Foundation 364, 372
end condition 78

wall 76–8, 372
corners 76

Framing 364–5
anchor 110, 372
plan 59

floor 109
joist 100–1
roof 123
steel 99

Free on board 229
Freight 15
Fringe benefits 241
Frost wall 84
Function 41–5, 372

argument dialogue box 42–4
library 41, 44

Furnace 181–2, 365–8
filters 368

Furnishings 356
Fusible link 174, 372
FUTA 242–3, 372

G
Gable

ends 119, 122–3, 142
truss 372

roof 141
Garage 365–6
Gas

line 183–4, 220, 367–8
meters 366

Gasket 225
General

conditions 4–5, 372
decision 240, 372
liability insurance 240–2, 244
overhead 372
requirements 354

Geographical area 264
Geometric method 202–3, 209, 222–3, 344–8
Girder 98–100, 372

wood 110
Glass 156–7
Glazing 154–7

safety 154, 156
tempered glass 154, 156, 375

GLB 110, 372
Glue

carpet 168
lam beam 110, 372
thinset 164
VCT 168

Go-footer button 38
Go-header button 38
Grab bars 117, 365
Grade finish 215
Grading 68
Grammar 295
Gravel 68, 223
Gridlines 48
Grille 165, 181, 185, 367, 372
Groups in Excel 19
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Grout 89–91, 164, 372
Gutters 214–5, 369
Gypcrete 183
Gypsum board 162–4

H
Handrail 365–6

steel 102–3
Hardibacker 164
Hardiplank 145
Hardware 365

butts 157
closers 157
cylinder 157
doorstop 155–7
hinges 155–7, 366
locksets 157
panic 155–7
pulls 157
schedule 155
silencers 157
threshold 155–7
weather stripping 155–7

Hanger pipe 173, 374
Head storefront 155–6
Header 36–8, 373

metal studs 162
wood 109, 115, 117–8, 364

Header and footer
button 36
tools design menu 37

Heat
exchanger 373
loss 134
temporary 368

Heating, ventilation and air-conditioning 181–6, 258, 357, 365,
367–8, 373

air
conditioners 181–6, 189, 367–8
ejector 183
filtration 181
handler 185

boiler 183, 185
cap termination 183
chillers 185
coil 181–2
combustion gasses 181
commercial 184–6
condenser 181
controls 184
damper 185
dehumidifying 181
diffusers 165, 371
ductwork 181, 185
electric baseboard 184
exhaust fans 184, 367–8
expansion tank 183
fan 185
fin-tube convector 185–6
flashing 183
flexible duct 185

furnace 181–2, 365–8
grille 165, 181, 185, 367, 372
heat

exchanger 185
pump 184

heaters 189
humidifying 181
line sets 181, 373
package unit 185, 374
plenum 182, 185
productivity 362
pump 183
radiant heat 183–4
registers 165, 181–2
residential 181–4
return

air 181–2, 185
manifold 183

rooftop 184
supply 181–2

manifold 183
thermostat 183, 185, 367
trunk line 181–2
valves 183
variable-air-volume box 185
VAV box 185, 376
vents 181–2

Heavy Construction Systems Specialists Inc. 8
Heavy timber construction 113
Heavybid 8
Height dropdown box 48
High dollar items 10–1
Highlighter 278
Hinges 155–7, 366
Hip

rafters 373
roof 120–2, 136–8, 141–2

Historical data 64–6, 81, 139–40, 163–4, 168, 228–9, 235, 238, 257,
259, 296, 317

Hold down 116–7, 364, 373
Holidays 240–1
Hollow metal 153–4, 156
Honesty 296
Hose bibs 367
Hours

billable 240, 245, 249
unbillable 245

Hundredweight 229
HVAC 181–6, 258, 357, 365, 367–8, 373

air
conditioners 181–6, 189, 367–8
ejector 183
filtration 181
handler 185

boiler 183, 185
cap termination 183
chillers 185
coil 181–2
combustion gasses 181
commercial 184–6
condenser 181
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controls 184
damper 185
dehumidifying 181
diffusers 165, 371
ductwork 181, 185
electric baseboard 184
exhaust fans 184, 367–8
expansion tank 183
fan 185
fin-tube convector 185–6
flashing 183
flexible duct 185
furnace 181–2, 365–8
grille 165, 181, 185, 367, 372
heat

exchanger 185
pump 184

heaters 189
humidifying 181
line sets 181, 373
package unit 185, 374
plenum 182, 185
productivity 362
pump 183
radiant heat 183–4
registers 165, 181–2
residential 181–4
return

air 181–2, 185
manifold 183

rooftop 184
supply 181–2

manifold 183
thermostat 183, 185, 367
trunk line 181–2
valves 183
variable-air-volume box 185
VAV box 185, 376
vents 181–2

Hydrants 368
Hydroseeding 369

I
Ice and Water Shield 136, 138, 141
Ice-maker boxes 367
Icon 373
If function 44–5

nested 45
I-joist 373
Illegal behavior 296
Imbeds 89–90

steel 103
Import 210, 225
Improvement constant 3
In situ 200, 373
Included by reference 6–7, 373
Increase decimal button 33
Indirect

costs 373
project costs 373

Inflation rate 230

Information proprietary 296
Input data 317

identifying 316–7
message 310–1

Insert
button 23
dialogue box 23–4
function

button 41
dialogue box 41

picture dialogue box 29
popup menu 23
worksheet tab 19, 23

Inspections 290, 293–4
Instructions to bidders 4, 370
Insulation 89–90, 138–40, 365

batt 138
blown 138–9
fiberglass 138
paperbacked 138
ridged 140

Insurance
benefits 240, 244–5
certificates 290
dental 244
disability 244
equipment 248–9, 251
health 244
life 244
requirements 290
workers’ compensation 290

Insured additional 290
Intercom 368
Intermediate mullion storefront 155–6
Internal Revenue Service 242, 247
International Building Code 152, 156, 161
International Code Counsel 152, 156, 161
Interpolation 206
Interruptions 234
Inventory control 365
Invitation to bid 4, 373
Invoice 228–9
Irrigation systems 214–5, 369
IRS 242, 247
Isometric drawing 177
Iteration 262–3, 299–300

J
Jack

rafters 373
stud 373

Jamb 373
storefront 155–6

J-molding 143, 163
Job

overhead 373
title 285

Jobsite overhead defined 56
Joist 173, 181–2, 373

girder 100–2, 373
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Joist (Contd.)
hangar 373
header 373
steel 100–2
trimmer 373
wood 109–12, 364

K
Key

shortcut 303
word search 41

Keyless entry 157
King

rafters 373
stud 373

L
Labor 289, 293–4

breaks 236
burden 240–1, 371, 373

markup 245
class 234
cost 2, 9, 12–3, 57, 60, 254, 268–70, 318
hour 233, 235, 238–9, 254, 268, 293, 315, 318, 373

tracking 235
pricing 13, 15
productivity 9, 233–8, 254, 359–63, 268, 277, 316–9, 373

factors affecting 233–5
field observations 235–8

quantities 2, 12
rates 9, 240–7, 268, 277, 316–8, 373
skill of 2

Laminate floors 166–7
Laminated lumber 117
Landscape page orientation 47, 373
Landscaping 214–6, 369, 373

plan 216
plants 215–6

Lap joint 61, 63, 67, 89, 135
Lateral forces 117
Lavatory 176, 179
Layout 364
Learning curve 234
Ledger steel 93, 98
Left click 373
Length 341

effective 61–2
Letter

business 285–7
formats 286–7
proposal 282

Lhr 373
License requirements 290
Lien waivers 290
Light fixtures 165, 189–91
Limitations spreadsheet 50
Line set 181, 373
Linear components 61
Link 28
Lintel 373

masonry 89
steel 89, 93, 98

Liquid damages 264
List box 373
Lists 320
Loan 248
Locksets 157
Logical operators 44
Long-lead 293–4
Lookouts 122–3, 373
Lookup 332–4
Loose 200–2, 210

cubic yards 373
Lost cost factor 244
Loyalty 296
Lumber 108–26, 355

backing 117, 162, 364–5
beam 364
blocking 110–1, 117–8, 364, 370
ceiling joists 119, 121
collar ties 119, 121, 371
columns 364
decks 113
doors 153
fascia 121
fire blocking 111, 117–8, 364
fire-treated 162
floor 108–13, 166–7

joist 110–2, 364
sheathing 112–3
squeaks 112
trim 167

framing 156
girder 110, 364
gluing 112
header 109, 115, 117–8, 364
I-joist 110
joist 109

ceiling 121
header 109, 110–1
tail 111
trimmers 110–1

laminated 117
lintels 364
naturally durable 113
package 108
paneling 124
plate 109, 113–4, 364
plywood 112–3, 117–8
post 110, 364
pressure-treated 108, 113, 374
productivity 360
purlins 364
rafter 119–22, 364, 374

common 121
hip 120–1
jack 121
king 121
valley 120–1

random lengths 108
ridge 137–8, 141–2

board 121
rim board 110
ring-shank nail 112, 375
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risers 364
roofs 119–24
shear panels 117–8, 375
sheathing 109, 112–3, 364

roof 123
waste 112

shelving 124, 365
sill 108–9, 364

plate 109
window 116

sleeper 364
slip-resistant nail 112
stingers 364
stud 109, 113–7, 162, 364

cripple 116
jack 109, 115–7
king 109, 115–6
precut 114

treads 364
trim 124, 146
trimmers 364
trusses 109, 119, 122–3, 364

tails 122
walls 113–119

corners 114, 116
ends 114
hold-downs 114, 117
intersections 114–5
openings 114

web stiffeners 110, 376
Lump sum 56

bid 373

M
Macro 278, 298, 301–5

button 303
dialogue box 305
recording 302–4
security

level 301
warning 301–2

settings 302
stop recording 304

Main
lines 172–3
tees 165

Maintenance equipment 251
Man hours 239, 373 see labor hours
Manholes 368
Mantels 365
Manual of Steel Construction 97
Manufacturer’s data 64, 110, 139–40, 163–4,

168, 250–1
Marking off items 60
Markups 15–6, 261–5, 370, 373
Masonry 89–94, 355

bond beam 89
cells 89
insulation 89–90
lintels 89
openings 90–2
productivity 359

ties 89, 93
waste 90

Masterformat 5–6, 9, 55, 354
Material 2, 292–4

contract 228, 292
costs 2, 12, 57, 60, 267–70,

317–8
damage 230
different 58
fob 229, 372
free on board 229
improper use 64
installation 5
invoice 228–9
long-lead 293–4
loss 64
orders 3–4
pricing 12–3, 15, 228–31, 316
procurement 17
protection 230
purchase 289
quantities 2, 5, 12
safety data sheets 290
scrap 64
testing 5
theft 230
use 4, 58, 65
wrong 58, 60

Math 2, 341–53
Mediation 291
Medicare 242
Meeting pre-bid 10
Membrane roofing 146, 374
Menu tab 19
Merge and center button 33
Merging cells 33
Metal

deck 80, 102, 374
grid 165
productivity 359–60
stud 162

header 162
jack stud 162
king stud 162
opening 162

Metals 97–103, 355
Method of construction 58
Mhr 374
Microwave 368
Miscellaneous steel 103
Moisture 163, 167

productivity 360
protection 134–48, 355

Moldings wall 165
Mono-truss 374
Mortar 89–90, 93, 374

thickset 164
Move after typing 26–7
Move or copy

dialogue box 24, 26
sheet 24

MSDS 290
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Mullion 374
Multiple cells selecting 25

N
Nails 365
Name

box 19, 323
cells 323–5
manager

button 324–5
dialogue box 324–5

Naming cells 323–5
National Council on Compensation Insurance 244
National standard books 229, 238
Naturally durable wood 108
NCCI 244
Nested if functions 45
New

folder button 22
formatting rule dialogue box 308
name dialogue box 323

Nominal 374
Noncontiguous cells 43
Nonresponsive bid 374
Normal view 49

button 38, 49
Notice-proceed 290
Number

dialogue box launcher 34
of pages button 37

Numbers consecutive 320

O
Occupational Safety and Health Act 290
Office trailer rental 56
On Center Software 7
On-Screen Takeoff 3, 7–8
Open dialogue box 19–20
Opener overhead door 157
Opening 93, 153–7, 356

door 117–8, 113, 143, 145–6
floor 110–1
productivity 360–1
window 117–8, 143, 145–6

Operation and maintenance manuals 290
Operating cost 248, 250
Operators 39

logical 44
Optional bid item 374
Options dialogue box 22, 302
Order of operation 39
Orientation button 47
Oriented-strand board 112–3, 117–8,

123–4, 374
OSB 112–3, 117–8, 123–4, 374
OSHA 290
Output 233, 374
Overbuild 119, 374
Overhead 263–5

checklist 14–5
direct defined 56
door 157

general 15, 263
jobsite defined 56
main office 263
markup 15, 270–1
project 13–5, 259

Overtime 234, 290
Owner 2, 4, 282
Ownership cost 248–9

P
Package unit 185, 374
Pad 168
Page

break
preview 49
button 49
setting 49
view button 49

layout 47
button 19, 36
view 36

number button 37
orientation 47
setup dialogue box 48–9

launcher 48–9
Paid-when-paid 290, 374
Paint 168, 365–7
Paneling wood 124
Panic hardware 155–7
Paper forms 8
Parallelogram 344–6
Parapet wall 146
Parenthesis 39
Parking lots 368–9
Partitions

fire-rated 163
non-bearing 162

Password 313
Paste 27–8

button 27–8
name dialogue box 324
special 28

dialogue box 28
popup menu 28

Path 374
Pattern 307

match 167–8
Paving 214, 237
Paydirt 7
Payment

bond 4, 263, 270, 374
final 290
progress 290
terms 283, 286, 290

Payroll taxes 240–2
Peer review 279
Penetrations 141, 146
Pennies dropping 279
Pension plan 245
Percent style button 33
Performance bond 4, 263, 270, 290, 374
Pergo 166



Perlite 90
Permit 367
Personal

injury 244
title 285

Pex 176, 374
Phone quote 15–6, 228
Picture

adding 29
button 29, 37
dialogue box 37

Pipe 237, 367
copper 176
CPVC 176, 371
drain 176–9
hanger 173, 374
Pex 176, 374
steel 98
vent 141, 176–9
waste 176–9

Plan
and profile 220
measurer 7, 61, 75, 77, 190, 317, 341–2, 374, 376
view 317

Plans 4, 11, 60, 258, 264, 278, 285–6, 316–7, 367, 372, 374, 377
framing 59

Plastic
laminate 125
sheet 138
tubing 183

Plastics 355
Plate

wood 109, 113–4, 364
steel 98, 100, 374

Plenum 374
Plumbing 176–9, 258, 357, 365, 367

air chamber 176
bushing 179
cleanouts 177–8
equipment 179
faucet 179, 367
flashing 179
floor drain 179, 367
flush valve 179
lavatory 176, 179
pressure reducing valve 176, 374
productivity 361–2
p-traps 176–7, 179, 374
sanitary tee 179
shutoff valve 172, 176, 179
sink 176, 179, 367
stub-out fitting 176
test cap 179
toilet 176, 179, 367

flange 179
urinal 176, 179
water

closet 176, 179
heater 176

Plywood templates 364
PO 3, 17, 291–3, 374
Polyvinyl chloride 146, 374

Portrait page orientation 47, 374
Post 374

base 110, 364
cap 110
wood 110, 364

Post-bid activities 16–7
Post-it 14, 282
Power 39

lines 220, 368
meters 366
temporary 365

Pozzolan 67
Practice problems 315, 317
Preliminary estimate 3–4, 10
Prequalification package 10
Presentations 3
Pressure test 176
Pressure-treated wood 108, 113, 374
Price 259, 277, 283, 286

breakdown 282
combining 15
extensions 267–76
too high 17
too low 17

Pricing
database 9, 17
materials 12–3, 15, 228–31, 316

Primer 366
Print 37, 46–9

button 46
dialogue box 46–7
entire workbook 46
gridlines 48
landscape 47
number of copies 46
portrait 47
range 46
scale 35

to fit 48
selection 46
setting

page breaks 49
scale 48–9

settings 46
titles button 47–8

Printer 8
properties 46
selection 46

Prism 203, 350–2
Production

daily 238
time 237

Productivity
communication 363
concrete 359
earthwork 363
electrical 362
exterior improvements 363
finishes 361
fire suppression 361
HVAC 362
labor 9, 233–8, 254, 359–63, 268, 277, 316–9, 373

INDEX 391
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Productivity (Contd.)
factors affecting 233–5
field observations 235–8

masonry 359
metals 359–60
openings 360–1
plumbing 361–2
rates 13
specialties 361
thermal and moisture protection 360
utilities 363
woods 360

Profit 263–5, 270–1, 277
margin 2
markup 15

Progress payment 4, 283, 374
Project

buyout 17, 289–92, 371
layout 235
location 289
management team 17
managers 2, 17
manual 4–7, 11, 258, 264, 286
overhead 13–5, 259
size 233–4, 259, 264
type 264

Property damage 244
Proposal 257, 282–5, 338–40, 374
Protect worksheet

button 313
dialogue box 313

Protection of work 235, 290, 364
PRV 176, 374
P-trap 176–7, 179, 374
Public agencies 4
Purchase order 3, 17, 291–3, 374

log 291–2
Purlins 364
PVC 146, 374
Pyramid 203, 350–2
Pythagorean theorem 119–20, 122–4, 341, 344

Q
Quality 4, 9, 259, 290, 295

actual 228
survey 56, 374
takeoff 4, 12–3, 228, 277, 374

defined 56
fundamentals 56–65
package 7–8, 61, 75, 77, 190
performing 56–7
quick-and-dirty 278
software package 317, 341–2, 375

Quantity-from-quantity goods 64
Quick

access toolbar 19, 46
customizing 46

print 46
Quotes

e-mailed 15
faxed 15
phone 15–6, 228

R
Radiant heat 183–4
Rafter 119–22, 364, 374

ties 374
Raised slab 374
Random length 374
Range 189, 368

hood 368
Rate of progress 237, 374
Rebar 66–7, 69, 71, 76, 78, 89–90, 374

dowels 68–9
epoxy coated 67
shop fabricated 67
size 67
ties 68–9
weight of 67

Recent files dialogue box 21
Record macro dialogue box 303
Rectangle 344–6
Redlining 59
Redwood 108, 113
Reference

absolute 40, 302–3, 370
books 64
relative 40, 302–4, 374

Register 374
Reimbursements 242
Reinforcing 67

lap 67
Relationships working 296
Relative reference 40, 302–4, 374
Repair multiplier 250
Repetitive members 60
Request

for materials quote 228–9, 268–70, 291, 374
for proposal 257
for quote 11–2, 257–8

Resilient floor 366
Retaining walls 214
Retention 290, 374

ponds 368
rate 283

Retirement contributions 240, 245
Return line 185
RFP 257
RFQ 11–2, 257–8
Ridge board 375
Right click 375
Rim

board 375
joist 375

Ring-shank nail 112, 375
Ring ties 375
Rise 120, 375
Riser pipe 172–3
Risk 12, 264–5, 277
Roads 368, 368–9
Rock ballast 146
Rod threaded 173
Roll goods 61–3
Romex 189
Roof 344
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framing plan 123
hip 120–2, 136–8, 141–2
joist 344
lookouts 122–3, 373
overhang 120, 122
ridge 137–8, 141–2
sheathing 123
shingle 141–3

cap 141–2
exposure 141

slope 120–1, 124
span 120
starter row 141–2
valley 136–8, 142
waste 123, 136

Roofing
asphalt shingle 315
membrane 146

Roof-top unit 375
Rough carpentry 108–26
Round function 41–2
Rounddown function 42
Rounding 60–1, 63
Roundup function 42
Row and column method 63
Row heights 31
Rows repeating at top of page 47–8
RTU 375
Rubber base 168, 366
Run 120, 375
Runner 162, 375

S
Safety 235, 244, 290

glazing 154, 156
meetings 290
plan 290
regulations 220

Sag 80–1
Sales tax 15, 229–30, 248, 267
Sample

durations garage 294
takeoff garage 82–5, 125–6, 146–8, 157, 169, 193–6, 210–1, 216,

272–6, 294
Samples 282
Sand 223
Sanitary sewer 220
Save as dialogue box 20–1
Scale 7, 61, 190, 341–3, 370

to fit 48
Scaling 342–3
Schedule 57, 66, 259, 264, 282, 285, 290, 293–4

durations 293–4
of values 4, 6, 14, 282–3, 289–90, 375

Scope of work 2, 4–5, 10, 14, 257–9, 283, 285, 289, 375
model 364–9

Scrap 64
Screws 365
Scroll bar 19
Seaming diagram 366
Search key word 41
Second-tier subcontract 375

Security 230, 249
options dialogue box 301–2
systems 368

Seismic straps 58
Selecting multiple cells 25
Self-adhering bitumen 136
Selling price 375
Series 320
Setting page breaks 49
Severe weather 285
Sewer

gas 176
lines 368

Shafts 365
Shear panel 117–8, 375
Sheathing 118–9, 375

wood 109, 112–3, 364
Sheet

goods 61–3
metal 182
name button 37
tabs 19
vinyl 167–8, 366

Shelving 124, 365
Shift key 25
Shimming 117
Shingles 141–3
Shipped lapped 145
Shipping cost 229, 267
Shop drawings 97
Shortcut key 303
Shower pans 367
shrinkage 200–2, 225, 375

percentage 201–2, 210
Shrubs 369
Shutoff valve 172, 176, 179
Shutter 366
Siamese connection 172–3, 372, 375
Sick leave 240–1, 245
Sidelight 156
Sidewalk 183, 369

excavation 211
Siding 143–6, 366

aluminum 143
board 145
sheet wood 146
vinyl 143
waste 143
wood 145

Significance 42–3
Sill 108–9, 375

plate 375
Seal 108, 113, 375
storefront 155–6

Sink 176, 179, 367
Siphoned 177
Site lighting 369
Slab

composite 81
on grade 78–80, 375
raised 80–1

Sleeper 364
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Sleeves 364, 367–9
Slope 120–1, 124, 375
Social security 242
Sod 369
Soffit 143–6, 365–6, 375

vented 143
Soil

bank 200–202, 210
characteristics 200
compacted 200–2, 210
compaction 200
conditions 220
dry

density 200
unit weight 200, 372

excavation 200
export 210, 225
import 210, 225
in situ 200, 373
loose 200–2, 210
report 6, 210, 375
shrinkage 200–2, 225, 375

percentage 201–2, 210
swell 200–2, 225, 375

percentage 200, 202, 210
transportation 200
unit weight of water 200, 376
water content 200
wet

density 200
unit weight 200, 376

Soldered 176
Solvent weld 176
Sonotube 66
Sound

attenuation 167
system 368

Spaced joint 63
Spacing 60–1
Special conditions 5, 375
Specialization 234, 264
Specialties 356

productivity 361
Specifications 5, 11, 229, 285, 290,

316–7, 375
sample 283–4

Spelling 285, 288, 295
Splice 63
Spot footings 68
Spread footings 68–9, 375
Spreadsheet 8–9, 18, 278

layout 315, 318–9
limitations 50
setup 319
testing 8, 49–50

Sprinkler head 375
Sprinkling system 369
Square 344–6

root 39
Stain 366–7
Stairs 366

concrete 81–2

nosing 167
steel 102–3
stringers

steel 98
wood 118

Standardized form 277
Starter strip 143
State unemployment tax 242–3
Status bar 19
Steel 97–103

angles 89, 93, 98, 100, 103
base plate 98
bolts 98
connections 97–9, 101–2
dimensioning 97
fabrication 97
framing plan 99
handrails 102–3
imbeds 103
Joist Institute 100–1
joists 100–2
ledger 93, 98
lintels 89, 93, 98
miscellaneous 103
pipe 98
plate 98, 100, 374
prime 97
shapes 97–8
stairs 102–3
structural 90
timber brackets 103
truss 102–3
types of 97
welds 102

Steps identifying 315, 317–8
Stick framed 119, 122
Stirrups 78, 375
Storage costs 267, 230, 248–9, 251
Storefronts 153, 155–6
Storm drain 220, 368
Striping 237
Structural

brick 375
engineer 67, 97
steel 90
tee 98, 375
ties 89, 93
tubing 98, 375

Stucco 140
Stud 109, 113–7, 162, 181, 364, 375
Subcontract 3, 17, 258–9, 289–91, 375

design-build 172
pricing 257–9

Subcontractor 4, 11–2, 17, 286
bid 172, 269–70
past experience 15
performance 259
pricing 14–5
selection 14–5

Subgrade 68
Subject line 285
Submittals 5, 290



Sum function 43
Summary worksheet 12–3, 50, 52, 267, 269–71, 275–6, 298–9
Superintendents 17
Suppliers 228–9, 286
Supply

line 185
registers 367

Surety 4, 11
SUTA 242–3, 375
Swamp cooler 184
Sweated 176
Sweating 375
Swell 200–2, 225, 375

percentage 200, 202, 210
Synthetic stucco 140
System efficiency 235–7

T
T&G 112, 123, 375
T1–11 143
Tabs sheet 19
Tackless fastening strips 168
Tail joist 375
Takeoff 4, 9, 259, 290, 295

defined 56
fundamentals 56–65
package 7–8, 61, 75, 77, 190
performing 56–7
quick-and-dirty 278
software package 317, 341–2, 375

Task 293, 375
assignment 10
linear 237
relationships 293–4
repetitive 235

Tax
advisor 242
equipment 248–9, 251
property 249

Technical specifications 5, 11, 229, 285, 290,
316–7, 375

Tee
suspended ceilings 165
steel 98

Telephone 368–9
boxes 366
lines 220

Tempered glass 154, 156, 375
Templates 364
Temporary fencing 230
Testing 290

spreadsheets 49–50
Text

box 376
button 329
string 329
wrapping 33

Theater system 368
Theft 290
Thermal protection 134–48, 355

productivity 360
Thermostat 183, 185, 367

Thickened slab 376
Thickset mortar 164
Thinset glue 164
Threaded rod 173
Threshold 155–7
Ties 376
Tile

acoustical 165–6
ceramic 164–5
grout 164

Timber brackets 103
Timberline Precision Estimating 8
Time curing 294
Toilet 176, 179, 367

paper holder 365
Tongue and grove 112, 167, 376
Top plate 376
Topsoil 215–6
Towel

bars 365
rings 365

Tracking
competitors 264–5
worksheet 37

Trade
journals 295
magazines 230
publications 295

Transom 156, 376
profile 155–6

Transpose 28
Trapezoid 344–5
Travel time 237
Trees 369
Trenching 220, 367–8
Triangle 344–5
Trim 124, 146, 365–6
Trimble 7
Truss 376

wood 109, 119, 122–3, 364
steel 102–3

Trust 296
center dialogue box 302–3

Trusted sources 301
Tubing steel 98
Tubs 365–7
Typographical errors 285, 288
Tyvek 89

U
U.S. Department of Labor 240
Unavoidable waste 376
Uncertainty 264
Underground service 172
Underlayment 141, 167, 366
Unemployment

claims history 243
insurance 240–3

Unethical behavior 296
Uniform Building Code 261
Union 245

contracts 240
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Union (Contd.)
dues 245
payments 240, 245

Unit 278, 315–7
pricing bid 376
weight of water 200, 376

Unmerge 33
Unprotect worksheet

button 313
dialogue box 313

Use relative reference button 303
Utilities 172, 220–5, 357–8, 368–9

productivity 363
Utility

boxes 220, 224
conduit 224
lines 224–5
manhole 220, 224
pipe 224
room 366
valves 224
wire 224

V
V weld 376
Vacation 240–1, 245
Validation 28
Valley 136–8, 142

rafters 376
Valve 183, 368

check 172, 371
drain 172
flush 179
pressure reducing 176, 374
shutoff 172, 176, 179
utility 224

Vandalism 290, 364
Vanities 367
Vapor barriers 135–8, 167, 376
Variable-air-volume box 185
Variables 39
VAV box 185, 376
VCT 168, 376
Vendors 4, 12
Vent 366

pipes 141, 176–9
Ventilation 181–6
Vinyl

composition tile 168, 366
flooring 167–8, 366
siding 143

Viruses 301
Vlookup 332–4
Volumes 350
Volumetric goods 63–4

W
Wage rate 240
Wages 240–1

bonus 240
overtime 240

raise 240
weekends 240

Walks 369
Wall 366

bearing 110, 113, 122
coverings 365–6
fire 122
foundation 76–8
moldings 165
painting 168
wood 113–9

Warning dialogue box 25, 33
Warranty 290
Washer hookups 367
Washout 368
Waste 63–5, 68, 376

actual 68
percentage 64–5

avoidable 4
control of 64
definition 64
tracking 64

controlling 68
factor 64
flooring 167
pipe 176–9
roof 123, 136
unavoidable 4, 63

definition 64
wood sheathing 112

Water
closet 176, 179
content 200, 376
heater 176, 367–8
infiltration 134
lines 220, 368
main 172
meter 368
softener 367
supply 176–7
table 6

Waterproofing 134–5, 376
Weather 234–5

barrier 89, 93
caps 367
stripping 155–7

Web stiffener 110, 376
Weld field 97
Welded wire fabric 66–7, 78, 80, 376
Welds 100, 102
Wet

density 200
pipe fire sprinklers 172
unit weight 200, 376

Wheel 7, 61, 75, 77, 190, 317, 341–2,
374, 376

Wide-flange beam 98, 376
Width

dropdown box 48
effective 62

Wind forces of 117



INDEX 397

Window 153–5, 365
bucks 364
fixed panels 154
opening 93, 115–6
operable 154
safety glazing 154, 156
schedule 153–4
seats 365
sills 365
sliding residential 154
tempered glass 154, 156, 375

WinEst 8
WinEstimator Inc. 8
Wire mesh 66–7, 78, 80, 376
Wiring

diagram 191
low voltage 183, 367

Wood 108–26, 355
backing 117, 162, 364–5
beam 364
blocking 110–1, 117–8, 364, 370
ceiling joists 119, 121
collar ties 119, 121, 371
columns 364
decks 113
doors 153
fascia 121
fire blocking 111, 117–8, 364
fire-treated 162
floor 108–13, 166–7

joist 110–2, 364
sheathing 112–3
squeaks 112
trim 167

framing 156
girder 110, 364
gluing 112
header 109, 115, 117–8, 364
I-joist 110
joist 109

ceiling 121
header 109, 110–1
tail 111
trimmers 110–1

laminated lumber 117
lintels 364
naturally durable 113
package 108
paneling 124
plate 109, 113–4, 364
plywood 112–3, 117–8
post 110, 364
pressure-treated 108, 113, 374
productivity 360
purlins 364
rafter 119–22, 364, 374

common 121
hip 120–1
jack 121
king 121
valley 120–1

random lengths 108
ridge 137–8, 141–2

board 121
rim board 110
ring-shank nail 112, 375
risers 364
roofs 119–24
shear panels 117–8, 375
sheathing 109, 112–3, 364

roof 123
waste 112

shelving 124, 365
sill 108–9, 364

plate 109
window 116

sleeper 364
slip-resistant nail 112
stingers 364
stud 109, 113–7, 162, 364

cripple 116
jack 109, 115–7
king 109, 115–6
precut 114

treads 364
trim 124, 146
trimmers 364
trusses 109, 119, 122–3, 364

tails 122
walls 113–119

corners 114, 116
ends 114
hold-downs 114, 117
intersections 114–5
openings 114

web stiffeners 110, 376
Word processing 3, 8
Work 376

complexity 259
duplication 258
ethic 295–6
package 57–8, 257–9
protection of 290
scope of 2, 4–5, 10, 14, 257–9, 283, 285, 289, 375

model 364–9
Workbook 376

creating 18
macro-enabled 304
management 18–22
new 19
opening 18–20
saving 20

Workers’ compensation insurance 240–2, 244
Workmanship 5
Worksheet 376

adding 23
copying 24
default number of 22–3
deleting 24–5
detail 26
formatting 30–9
organizing 25–6
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Worksheet (Contd.)
protecting 312–4, 335
referencing 328–9
renaming 25
summary 12–3, 26, 50, 52
testing 306–7
tracking 37
working with 22–6

Wrap text button 33
Wrapping 33
Writing formulas 39–41
WWF 66–7, 78, 80, 376

X
xls 18
xlsm 18, 304, 376
xlsx 18, 376

Z
zoom 34–5

button 35
controls 19
dialogue box 35
level 35
selection button 35
slider 34–5
to fit 35
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